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Welcome 
 

This manual is written for WinPOS version 10 or later. 

Welcome to WinPOS®, the premiere Windows-based POS system for single store or multiple 
location specialty stores, bridal shops, formalwear retailers and rental stores from BBL Systems 
Inc., the makers of The Bridal Profit System. 

 
WinPOS - Windows Point-Of-Sale 
WinBPS - Windows Bridal Profit System 
WinTPS - Windows Tuxedo Profit System 
WinTPOS - Windows Tuxedo Profit Point of Sale System 
 
BBL Systems, Inc. 
6021 Sandy Springs Circle 
Atlanta, GA  30328 
VOICE: (800) 587-7277 
FAX: (770) 234-4223 
E-MAIL: support@bblsystems.com 
WEB SITE:  www.bblsystems.com 
 
Copyright Notice 2000 and beyond: 
 
BBL Systems, Inc. makes no representations or warranties with respect to the merchantability 
or fitness of the Windows Point-Of-Sale (WinPOS), Windows Tuxedo Point of Sale (WinTPOS) 
and Windows Tuxedo Profit System (WinTPS) for any particular purpose. Further, BBL 
Systems, Inc. reserves the right to revise this publication and accompanying software without 
obligation to notify any person or organization of such revision. 
 
Trademarks:  Tuxedo Profit System, TPS, Bridal Profit System and BPS are trademarks of BBL 
Systems, Inc  

WinPOS©, WinTPS©, WinTPOS© Help Copyright ©2000-2011 BBL Systems, Inc. All rights 
reserved. 
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Getting Started 

Using Help 

How to get Help with WinPOS® 

This documentation contains everything you need to know to use WinPOS®.  Press F1 within 
WinPOS® to view this document. You can also click on the Help menu and select Contents. 
 Help is searchable by keyword.  Please become familiar with the help organization.  It is very 
useful as a reference tool. 

Please review the list of frequently asked questions for step by step how to of common 
operations.. 

This help document is also available in PDF format, which you can print out. You’ll find it on 
your Start Menu, Programs, in the BBL Systems ProfitSystem folder. To view the PDF version 
of this document you will need Acrobat Reader from Adobe. Acrobat Reader is automatically 
installed when you install WinPOS®. Also, you can download Acrobat Reader from Adobes web 
site. 

http://www.adobe.com  

The PDF file is called WINPOS.PDF. To print it out, click Start Button->Programs->BBL 
Systems->WinPOS® Manual. When the manual displays on the screen, click the Printer icon to 
print it. 
 

Printing a Help topic in the on-line help 

To print the current topic 

1. Click the Print button in the help. 

2. Select the printing options you want.  

Contacting BBL Systems 

BBL Systems, Inc. 
6021 Sandy Springs Circle 
Atlanta GA 30328 
Phone: 800-587-7277 
Fax: 770-234-4223 
Office Hours: Monday to Friday 9:00 A.M. to 6:00 P.M. Eastern Standard Time 

 

World Wide Web: www.bblsystems.com  
Sales email: sales@bblsystems.com  
Support email: support@bblsystems.com  

At BBL Systems, we work hard to provide you with intuitive technical products. Additionally, we 
try to provide superior online and print documentation to enable you to work independently in 
running your store with WinPOS®. If you have a technical question that you can’t answer with 
the provided tools, please contact our Technical Support department. All of our Technical 
Support representatives are eager to answer your questions. 

Note: You must have a current support contact to access BBL Systems support services. BBL 
Systems support services are subject to BBL Systems prices, terms, and conditions in place at 
the time the service is used.  
 

Help Us Help You 
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When contacting Technical Support via phone, email, or fax, please provide the following 
information for the fastest possible service:  

• Product serial number (registration number)  

• Your name, company name, and phone number 

• Exact product name and version number 
 
From the main menu, click on the help menu at the top of the screen and select 
“About TPS/BPS Windows”. A splash screen will appear and give you the version of 
the program you are running, the location of the data directory and who the software 
is licensed to. This is the same screen that comes up when the program is started 
for the first time. 

• Type of operating system (e.g., Windows 2000) 

• Complete description of the issue, including steps to reproduce it 

• Exact wording of any messages displayed when you encountered the problem 

• Steps taken to resolve the problem 

• All previous email messages with BBL Systems about the issue, if any 
 

Email  

Ask questions and receive detailed answers from Technical Support by addressing your email 
message to: 

support@bblsystems.com  

Please make sure to include the information listed above. You will receive a response via email. 
 

Fax 

Ask questions and receive detailed answers from Technical Support by sending a fax message 
to:  

1-770-234-4223 

Please make sure to include the information listed above. You will receive a response via fax. 
 

The current version of this manual in Windows Help format and Adobe Acrobat format can be 
found on our web site at www.bblsystems.com. 
 

Telephone 

You can reach BBL Systems Technical Support by phone Monday through Friday (excluding 
holidays) at:  

1-800-587-7277 or 1-404-978-0137 

Please make sure to include the information listed above. Calls are returned on a first come, 
first served basis. 

Terms & Concepts 

It will help you to understand this document if we cover some terms and concepts first. Don’t 
worry if this all sounds complicated. WinPOS® leads you through the process of entering 
prospects, and creating customers and events. 
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A prospect is someone who might purchase something from your shop and is entered within the 
prospect module. They may have items selected as favorites and also may have actions to be 
completed. 

A customer is someone who has or is purchasing something from your shop. 

An event is a wedding, prom, social event, etc. and allows customers to be grouped together as 
a unit. 

A ticket is the ledger that contains their purchases, payments, adjustments and other financial 
transactions and is assigned to a customer. A customer may have an unlimited number of 
tickets. Normally, you create a new ledger for each new set of purchases. If they buy a prom 
dress, then buy shoes for it, you keep it all on one ledger. If they come back two years later to 
buy a bridesmaid dress, you create a new ticket. For example, all the purchases by the 
customer for a specific wedding are in a ticket. 

Normally, a person first becomes a prospect, then a customer. They visit your shop, interested 
in some dresses, but haven’t made up their mind to purchase. You enter them in as a prospect 
so you can follow up with mailings, sale announcements, etc. 

If they decide to buy, you create a customer card for them. As a customer, they can be a 
member of an event. As a matter of fact, they can be a member in multiple events at the same 
time. In either case, there is only one customer card. That single customer card is linked to all 
events that customer is a member of.  

For example, let’s say Suzy Smith is a bridesmaid in Fishbine wedding in 1999. She would get a 
customer card, and her customer card would be linked to the Fishbine event card. In 2000 she 
gets married. Since she already has a customer card, you just create an event card for the 
Smith wedding (her wedding) and link her existing customer card to it. 

This diagram shows how the prospect, customer, event cards, and ticket are linked together. 

Diagram 
 

 

 
 

Terms used in this manual 

Default: When WinPOS® fills in something for you, and you have the option of changing it. For 
example, when WinPOS® is installed, the default tax rate is 5%, but you can (and should) 
change it to your tax rate. 
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Revenue realized: This is the date when WinPOS® actually “books” the revenue for a sale. 
Many shops do not count a sale as revenue at sale time. Your Accounting Method controls 
when it becomes revenue. Your accounting method can be Ticket Zero, Pickup, or Cash. For 
Ticket Zero, WinPOS® will show the sale as revenue when the customer’s entire balance due is 
zero. On Pickup, the sale becomes revenue when they pick up the item. On Cash, the sale is 
shown as revenue the moment the sale is rung up. 

Event: A general term used to refer to weddings, proms, social events, etc. 

Group: A general term that refers specifically to an organization that buys items from a shop, 
and is sometimes invoiced for purchases. 

Wedding/Event Date: The day of the wedding. If the event is other than a wedding (a prom, for 
example), enter the date of the prom in this space instead. 

Register Date: The day a prospect comes into your shop and is first recorded in the system as 
a customer. 

Pick Up Inventory: Temporary inventory. Pick up inventory refers to merchandise that has 
been ordered and received for special orders. Think of it as a virtual “Lay-Away room”. You 
store and track pick-up inventory until the customer pays any balance and removes the 
merchandise from your shop.  

Inventory: This term is used to refer to your sample and stock inventory. Retail (or permanent 
inventory) consists of any item or service sold by the shop. It includes samples, services (like 
shoe dying) and stock items (discontinued items, shoes, garters ...etc.). You can also input 
items that you do not have in stock as retail inventory. These items are shown with a zero 
quantity on hand.  

This term is also used to refer to inventory that you rent. This term only applies if you have the 
WinTPS module. 

Enter: This term refers to the key on your computer's keyboard labeled "Enter" NOTE: on some 
keyboards, this key may be labeled “Return”, but it means and works the same.  

Password: A password is a special code made up of characters or numbers, or both, that 
protects the system's data from people who should not have access to it. Each computer user is 
assigned a password. You must then enter the password before you can use a part of the 
system. 

By assigning passwords the system can track/record all sales ticket activity by individual and 
limit access to specific parts of the program to those people who have appropriate passwords. 

Note that when you type in your password, it is replaced with asterisks on the screen. This 
prevents anyone else from reading your password. 

Purchase Orders: Those items that are special ordered from the store. POs can be 
automatically generated by sales tickets. Also, they can be created in the Purchase Order 
program in WinPOS®. Stock PO’s are items that are ordered for use in your store. 

Housekeeping: The "Housekeeping" portion of the program refers to a series of programs that 
allow you to manage the data entered into the program. This includes purging, indexing & file 
maintenance. 

Click: When you place the mouse pointer over an option and press the left mouse button. This 
is the most common way to select items. 

Right-click: When you place the mouse pointer over an option and press the right mouse 
button. 

Form: A WinPOS® data entry screen, such as the Event form. 

SA: Sales associate, which is any employee that in for the business. 
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SC/Plant: Service Center/Plant. In WinTPS© Plant Management provides DC/Plant production 
management capability. WinTPOS Point of Sale software terminology usage refers to any rental 
inventory supplier. The supplier does not have to be company owned. 

 

Installing WinPOS 

A note before you install WinPOS®… 

The most important job of working with a computer is to back-up it's data on a daily basis. 
Computers are mechanical and thus can break ANYTIME! This is usually not a problem 
because they can be repaired quickly and easily. However, a breakdown can cause data loss. 
Data CANNOT be replaced quickly and easily. For this reason you must BACKUP the data on 
the computer every day.  

BBL suggests backing up to removable media. Examples are CDRW, DVD RW and/or to BBL 
Titan Backup Services. 

The proper routine is to have separate Media (i.e. CDRW) for each day of the week that you are 
open. Then every day back-up to that day’s cartridge, i.e.: every Monday backup to the Monday 
media, Tuesday to Tuesday media ..etc. Place the media in a safe place like a fireproof safe or 
take them home. This method provides plenty of protection and security. 

If you don’t know how to get your backup set up, contact a computer consultant or computer 
store. You should back up the entire \TPSWINS folder and everything inside it on your server. 
 

Consider this: If your hard drive fails and you have no backup, you now have no record of who 
paid you money, who still owes you money, what gowns you need to special order, what you 
have in inventory, etc. 

Most people experience a computer failure of some sort at one time or another. The difference 
between an inconvenience and a disaster is whether or not you have a good backup! 
 

REMEMBER: Don’t take chances with your shop’s precious customer and 
inventory information.  

Back up your system EVERY DAY! 
 

On with the installation… 
 

Insert the BBL WinPOS© installation CD into your CD-ROM drive. After a few seconds, the 
WinPOS® Installation Menu screen should appear: 

If the WinPOS® Installation Menu does not appear, click on the start button on your taskbar. 
Choose RUN. In the dialog box, type (without the quotes) “D:\splash.exe” (where D: is the drive 
letter for your CD-ROM drive.) and click on OK. The WinPOS® Installation Menu screen will 
then appear. 

The WinPOS® installation is made up of two parts: 1) WinPOS® Server, and 2) Instal 
WinPOS® Workstation. The installation steps required depend upon whether you are a first 
time installer or a current user upgrading. 
 

NEW USERS: 

Single Users (those who will run the WinPOS® program on only one computer) must install both 
the WinPOS® Server and the WinPOS® Workstation portion of the installation onto their 
computer. 
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Multi Users (those who will run the WinPOS® program on two or more computers) must 
configure their computer network before installing any of the WinPOS® software (consult your 
Windows or Networking Professional for assistance in configuring your network). One computer 
will be configured as the ‘main’ computer (called the Server) and will serve as the host for the 
WinPOS® data. both the WinPOS® Server and the WinPOS® Workstation portion of the 
installation must be installed on this computer. The remaining computers will be configured as 
“Workstations”. Each of these workstations must have only the WinPOS® Workstation installed. 
DO NOT INSTALL THE WinPOS® SERVER ON THESE WORKSTATIONS! 
 

CURRENT USERS UPGRADING: 

DO NOT INSTALL WinPOS® SERVER! THIS INSTALLATION CAN DELETE YOUR EXISTING 
DATA FILES. REMEMBER TO BACKUP ALL YOUR DATA BEFORE RUNNING THE UPDATE. 
FURTHER INSTRUCTIONS WILL BE PROVIDED IN YOUR UPGRADE INSTRUCTIONS. 
 Users upgrading from a WinPOS© installation CD should only install the Workstation on each 
computer currently running WinPOS©. 

 

Installing WinPOS® Server software 

The server is the computer that will control the WinPOS data files.  In single user installs the 
server & workstation are the same computer, so both installations would take place on the one 
system. 

Insert the BBL WinPOS installation CD into your Computer/Server's optical drive.. 

Click on “Install WinPOS® Server” and confirm the single prompt for default folder destination 
(accepting the folder default is recommended (unless under the direction of a computer 
technician).  Run this installation ONLY on one computer in the network.   

Note for multi-user installations 

Install the WinPOS workstation software onto your server, even if the program will not 
normally be ran on the server.  Start the WinPOS application.  WinPOS will automatically 
mark the permissions Read/Write access for everyone in the network for the server's 
WinPOS data folders, thus allowing remote access of other workstations for multi-user 
installations.  These permissions may be set manually if preferred.  Just do not install the 
workstation software on the server.  Remember to the folder must be shared before installing 
WinPOS on any remote workstations, otherwise their installations will fail..  Sharing is NOT 
required in Single user implementations. 

 

Installing Workstation software 

Insert the CD into a workstations optical drive. 

Click on “Install Workstation” and follow the instructions on the screen.  and confirm the single 
prompt for default folder destination (accepting the folder default is recommended (unless under 
the direction of a computer technician).   

Once the installation is complete, run the workstation software.  The first time a WinPOS 
dialogue form will appear asking for data folder destination and workstation/Register name. 

Single User 

On a single user install or if installing the workstation software on the data file folder location will 
be automatically completed.   

Multiuser 

Installing WinPOS on a Remote workstation, the dialogue form prompts for  
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"Computer with shared data files"...  Enter the computer name with the data files, no special 
syntax is needed.  If the files are found the system allows the user to continue.  If files are not 
found an error alert will appear.  For non standard folders the user may enter the true UNC path 
to the data files.  Remember: Permission on the data folder must be before the workstation 
installation may be competed. 

Name... WinPOS is requesting for the workstation's Register name.  The Register name is how 
WinPOS identifies the workstation.  A Name is usually preferred that describes the location of 
the workstation, , i.e. BACKROOM, POS1, OFFICE, CASHWRAP2.. etc.  The name for the 
Register should be unique for NEW Registers/workstations.  If this a re-install for a older or 
replacement workstation the same name may be entered.  WinPOS will display a a warning that 
the Name exists, but provide an option to accept. 

Once the dialogue form is properly completed WinPOS will start and provide a warning if it is not 
authorized yet.  Please refer to your BBL welcome letter for authorization instructions.  Once 
authorized BBL will display the main menu.  From the main menu go to Register Setup and 
complete the setting for this new Register.   

If you require assistance in installing the WinPOS® software, please contact BBL Systems 
Technical Support. 

 

Program file and Data file folders 

WinPOS 
v7 & 
Younger 

Files Written Vista XP or Server 2003 Comments

 Program Files, 
TW.EXE 

contact BBL \tpswinw\  

 Workstation 
configuration 
files: TPSWIN.INI 
& 
ERRORLOG.DBF 

contact BBL \tpswins\  

 Data contact BBL \tpswins\livedata\ should 
have 
read/write 
access for 
all users 

WinPOS 
v8 & 
older 

    

 Program Files, 
TW.EXE 

\programfiles\profitsystem\ \programfiles\profitsystem\  

 Workstation 
configuration 
files: TPSWIN.INI 
& 
ERRORLOG.DBF 

\programdata\profitsystem\ 

 

\document and settings\all 
users\application 
data\profitsystem\ 

 

 Data \programdata\profitsystem\livedata \document and settings\all 
users\application 

should 
have 
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data\profitsystem\livedata read/write 
access for 
all users 

 

 

Temporary Files 

Portions of the WinPOS© program will have to create temporary files for processing. Once 
WinPOS is completed with the temporary file, the file is deleted. WinPOS will use the operating 
system temporary file folder location by default  (this location may be changed by trained 
operating system technicians if necessary).   

WinPOS© will request the location of a temporary file folder from the operating system. 
However, this may be over written on a Register by Register basis by entering the location of 
the temporary folder on the Register setup form for each register. 

Users/Registers must have Read/Write/Delete permissions on the temporary folder used. 
Individual program/data files may be marked Read/Write only to protect them from deletion by 
users if management is concerned about a folder used. 

 

Folders and their contents created by the WinPOS installation 

Version 7 and older installations for Windows XP and older version of OS 

\TPSWINS is the WinPOS Server folder, installed on the data server.  It contains the 
files/data shared by all workstations. 

\TPSWINW is the WinPOS Workstation folder, installed at each workstation (or once on a 
terminal server), and contains the files/DLLs/OCXs that are installed at each workstation. 

\TPSWINS contains 

\ICR – Only used for handwriting recognition order entry. 

\IMPORT – Only used for handheld order entry. 

\LIVEDATA – WinPOS data files live in \TPSWINS\LIVEDATA.  TRAINING – A separate 
copy of the data is installed in TRAINING for training and testing purposes. 

\USER  – Contains custom tag/label layout files, and layouts for user created reports. 

\SUPPORT – Holds a few support utility files. 

a) andale32.exe – Installer for Andale Mono font used by receipts. 

b) ar405eng.exe – Installer for Acrobat 4.05 

c) foxcmd.exe – Command line tool to manipulate data files. 

d) Pkzip25.exe – Command line ZIP file tool. 

\PATCHES – Contains WinPOS© upgrade files in the form of patch files and/or TW.EXE. 
 WinPOS checks this directory for upgrade patches at startup.  If it finds a patch that applies 
(based on the version number) it applies the patch automatically.    Once all the patch files 
are checked/applies WinPOS© will review any TW.EXE program file found and compare it's 
version to the version of the program running.  If newer WinPOS© will replace the currently 
running program with this one automatically.  

Once patch files are stored in this folder do not delete them.  Until sure they will not be 
needed in the future, i.e. a new installation CD is received from BBL containing a version of 
the software exceeding the version of the patch files. 
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This feature is not normally used for terminal server users since the TW.EXE may be easily 
replaced on the application server for new a program version when available. 

 

Version 8 and younger installations for Windows Vista and newer OS 

Vista 

C:\Programdata\ProfitSystem\LIVEDATA\    (data, same as TPSWINS above) 

C:\Program Files\ProfitSystem\      (program files, same as TPSWINW above) 

 

XP 

C:\Documents and Settings\All Users\Application Data\ProfitSystem\LIVEDATA\     (data, 
same as TPSWINS above) 

C:\Program Files\ProfitSystem\      (program files, same as TPSWINW above) 

 

Oplocks 

Windows 7 and Server 2008 use a Microsoft technology called Oplocks (opportunistic locks) to 
accelerate file access for networked file servers.  If a Windows 7 computer, or a Server 2008 
computer is configured as a WinPOS© server, then Oplocks will normally be enabled 
automatically by Windows.  However, using Oplocks can cause data corruption problems with 
WinPOS© data files.  For this reason, WinPOS© will disable Oplocks during server installation, 
and also when the program is run for the first time. 

It disables Oplocks by updating the following registry keys: 

 

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\MRXSmb\Parameters\OplocksD
isabled=1 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\LanmanServer\Parameters\En
ableOplocks=0 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\LanmanServer\Parameters\S
MB2=0 

 

It does this by running a small program called oplocks.exe, which is installed in the Program 
Files\ProfitSystem folder. 

 

 

Getting Started with WinPOS 

If WinPOS is being started for the first time on a new day, it performs the following actions. 

1. If it’s configured to open/close registers then it prompts first to open the register, 
then the store. 

2. Prompts to confirm the current date. 

3. Prompts to reset month to date and/or year to date totals if it is a new month or year. 

4. Verifies that the data files are in good working order.  

5. Updates the back date for overdue rental items, if the WinTPS Production module is 
installed. 
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Follow the checklist outlined within this topic to begin using WinPOS®. 
 

WinPOS Setup Checklist 

Install the BBL POS software 

1. Configure basic settings in System/Store Setup., at Main->Housekeeping->General 
Setup->System Setup. Required. 

2. Configure settings & taxes for EACH store within the Store/Accounts form  Main-
>Housekeeping->General Setup->Stores.. Required. 

3. Configure in GL Accounting Setup your store's Accounting Method and Payment 
types accepted settings. Housekeeping-> Accounting Setup-> Accounting Setup 
(required) 

4. Configure register settings in Register Setup, at Main->Housekeeping->General 
Setup->Register Setup. Required. 

5. Add all your employees using the Sales Associates form, at Main->Housekeeping-
>General Setup->Sales Associates. Optional. 

6. Create Inventory Categories, at Main->Inventory->Inventory Categories. A default 
set of categories are included. Any may be edited or removed or more added. 
 Required. 

7. Add Vendors, at Main->Inventory->Vendors. A default set of vendors/manufacturers 
are included. Any may be edited or removed or more added. Required. 

8. Add Color/Size/Width charts for matrixes, at Main->Inventory. Required if you want 
to use stock purchase orders.  

9. Add Markdown codes (optional) at Main->Inventory->Mark down codes. Optional. 

10. Add Season Codes. Main->Inventory->Season Codes.  Optional 

11. Go through your accounting classes in GL Account Setup, at Main-
>Housekeeping->Accounting Setup->Accounting Classes. (check whether or not 
they will be taxable, allow price changes, and be commissionable) Required.  

12. Add Inventory, Sizes, and Receive History at Main->Inventory->Inventory. 
Required. 

13. Setup Security, at Main->Housekeeping->General Setup->Security Groups 
Permissions. Optional. 

14. Enter your sales contract to print on receipts in Document Terms, located at 
Main->Housekeeping->General Setup->Document Terms. Required. 

15. Select your printers at Main->Housekeeping->General Setup->Printers. 
Required. 

16. Customize Letters, Tag, Mailing Labels at Main->Housekeeping->Letters, Tags, 
Mailing Labels. Optional. 

17. Add Customers via Main->View/Change Customers. Required. 

General Overview of Data Setup steps 
 

STEP 1 - System Setup 

From the main menu select Housekeeping.  Choose Housekeeping, General Setup then 
System Setup pressing the button.  Complete all tabs of this form.  When done with System 
Setup choose stores and visit each tab for each company owned store.  A entry exists for your 
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first store. Just modify the address/tax information and visit each tab to insure your options are 
set.  Some key info to enter is: 

• Enter a unique store number for each location  (01 is the first location's ID by 
default)   (NOTE: Once saved the store number can not be modified again.) 

• Enter store address and phone number in appropriate fields. 

• If you have purchased the on-line credit card authorization option choose which 
credit card processing software you are using, the name of the bank processor, your 
merchant ID, and the location of the credit card processing software on your 
computer. 

Step 2- Store/Account Setup 

 

Enter Stores/Accounts setup and complete all data as sales tax rates.  Found at Main-
>Housekeeping->General Setup->Stores 

 

STEP 3 – GL Account Setup 

From the main menu select Housekeeping then choose Accounting Setup then choose 
Accounting Setup again -GL Accounts/Setting tab.. 

There are currently three accounting methods supported in WinPOS®.  

• Cash - If you pay the full tax amount on a sale whenever a deposit has been taken 

• Ticket zero - If you don’t pay the taxes on a sale until the item has been paid for in 
full 

• Pickup - If you don’t pay the taxes on a sale until the item has been delivered to the 
customer 

Select the appropriate accounting method.   All of the remaining fields can be left at their 
defaults.  Read the HELP section on GL Account Setup if you want to know exactly what each 
field does. 

Press the Done button to close the Accounting Setup form. 

From the Accounting Setup menu, choose Accounting Classes.  You’ll need to review each 
accounting class.   

As you enter your Retail Inventory, you’ll need to choose an accounting class for each item you 
will sell.  We’ve supplied almost 30 pre-defined accounting classes.  The description of each 
one gives you an idea of what it would be used for.  By default, all accounting classes are set up 
as non-taxable, no commissions.  You’ll want to look at each accounting class and make the 
following decisions: 

• Should it use the Rental or Retail tax rate?  In some areas, these rates are different. 

• Will items sold using this accounting class be taxable?  If checked, WinPOS will 
automatically add tax to sales that use this accounting class.  A user can also 
change the taxable status manually at sale time if they like. 

• Will you pay commission on the sale of items using this class?  If checked, WinPOS 
will include sales of this item on the commission reports. 

• Will you allow price changes to items using this class?  If checked, the user can 
overwrite the selling price of this item at sale time.  In most cases, you don’t want to 
do this.  Users should use an adjustment to change the selling price for an item so 
there is an audit trail.  The only exceptions are items where the selling price varies 
all the time (shipping charges, alterations, etc.) 

Press the Done button to close the Accounting Classes form. 
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From the Accounting Setup menu choose Taxes. 

Click on the RETAIL tax rate.  Enter your tax rate in the tax rate field and press the Save button 
to save the information you entered. 

If you have the WinTPS module, click on the RENTAL tax rate.  Enter your tax rate in the tax 
rate field and press the Save button to save the information you entered. 

Press Done to continue. 

NOTE:   

We recommend that steps 1 through 7 be completed before entering any retail inventory 
items.   

 

Step 4 - Register Settings 

Each store contains a number of workstations (registers).  Each register may have specific 
operation characteristics different from other registers.  Set each register's features within this 
form. Main->Housekeeping->General Setup->Register 

 

 

STEP 5 - Sales Associates 

From the main menu select Housekeeping and choose General Setup  then choose Sales 
Associates. 

Every user of WinPOS® system must be identified in the system. The first page of the Sales 
Associate setup is a list of current users. 

• To modify detail for an existing entry click on the users name in the list, then click on 
the Details tab.  

• To add a new user press the Add button then enter the appropriate information on 
the detail form. 

In addition to entering in the sales associates name, phone, etc. you will need to assign them a 
security group.  The security group controls what this user has access too.  For now, just click 
on Add Item to add a blank entry to the security groups list, then select Manager or Sales 
Associate. 

When finished press Save to save the information you entered. Continue adding all your sales 
associates and managers, then press Done when you are finished. 

NOTE:   

The Login ID is the ID specified above.  Once a sales associate is entered, his/her ID cannot 
be changed.  The ID will print on all transactions, included sales reports.   

 

 

STEP 6 - Inventory Categories 

From the main menu select Housekeeping then Inventory Setup then choose Inventory 
Categories. 

For each item you have in inventory, you will specify a category (i.e. Bridal gowns, Veils, shoes, 
etc.) Categories are referenced by a category code. Each category code must be unique. Press 
the Add button to enter a new category and enter the appropriate information on the detail form. 

• A Retail factor % ( or ‘Markup %’) and additional dollar amount can be specified for 
each category.  This factor is multiplied by an items reorder cost to suggest a selling 
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price.  To keystone an item, enter 200.  Retail factors may entered at the Vendor. 
 Factors assigned to vendors override retail factors assigned at the Category. 

• Sub-classes can be entered for this category (i.e. formal, informal, etc.) for reporting 
purposes. Press the Add item button to add a new sub-class, or the Delete item to 
remove a sub-class.  Example: WEDGOWN could be a category, and the sub-
categories could be W1, W2, W3, where W1 means < $600, W2 means $600-
$1200, W3 means > $1200. 

When finished press Save to save the information you entered. Continue adding all your 
categories, then press Done when you are finished. 

 

STEP 7 - Vendors 

From the main menu select Housekeeping then  Inventory then choose Vendors. 

For each item you have in inventory, you will specify a vendor. A vendor code references a 
vendor. Each vendor code must be unique. Press the Add button to enter a new vendor and 
enter the appropriate information on the detail form. 

When finished press Save to save the information you entered. Continue adding all your 
vendors, then press Done when you are finished. 

 

 

STEP 8- Size, Color, Width Charts 

From the main menu select Housekeeping then  Inventory Setup then Size, Color or Width form. 

Size, Color, and Width charts are used for reference and allow the creation of size matrixes for 
inventory entry and ordering. For each chart follow the instructions below to bring up the 
appropriate chart maintenance form then press the Add button to add a new chart.  

• Enter a unique name for the chart.  

• Specify which vendor this chart is for (WinPOS will allow a user to apply a 
size/color/width chart to inventory items from the Inventory form.  The vendor 
assigned to a Size/Color/Width chat does not have to match the vendor assigned to 
the inventory item.  This is helpful when GENERIC charts are used.) 

• Press the Add item button to add a new size, color, or width. Then fill in the 
appropriate information in the chart. 

When finished press Save to save the information you entered. Continue adding all your charts, 
then press Done when you are finished. 

 

STEP 9 - Markdown Codes 

From the main menu select Housekeeping, choose Inventory Setup then choose Markdown 
Codes. 

Markdown codes are a way to identify the different reasons you gave a customer a discount at 
sale time. Each time a sales associate gives a discount, they will supply a code explaining why 
the discount was given. You can then run reports showing how much discounts were given and 
why. Examples of markdown codes include competitive price match, damaged merchandise, 
and special promotions. Press the Add button to add a new markdown code. Enter a unique 
code to identify the markdown and a short comprehensive description of the markdown. Press 
the Save button to save the information you entered. When you’ve finished entering all your 
markdown codes, press the Done button to continue. 
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Step 10 - Accounting Classes 

 

An accounting class is a term to describe how inventory is processed from an accounting 
perspective thru the WinPOS system.  Accounting classes are auto created when a inventory 
category is created.  There are some options on how an accounting class is handled, iei is it 
taxable.  Please visit each accounting class to check it's settings.  Main->Housekeeping-
>Accounting Setup->Accounting Classes 

 

STEP  11 - Inventory  

Before entering your inventory, we recommend you read the Retail Inventory section of the Help 
manual for more details. 

From the main menu select Housekeeping then Inventory Setup then choose Inventory. 

The first page of the Inventory form lists all styles in the system. There are a few styles that are 
shipped with the software. These styles are needed by certain functions of WinPOS® and 
should not be altered or deleted. Press the Add button to add new inventory. This will bring up 
the second page on the Inventory form - the Details tab. 

Enter the inventory item detail in the appropriate fields.  

Now that you’ve entered the main style information you need to enter the sizes, colors and 
widths (if used). Press the SCW button. This brings up the Inventory SCW form.  Again, click 
add and enter the inventory size detail in the appropriate fields. When done adding all sizes for 
this style press the Done button to return to the Inventory form. 

The third page of the Inventory form is the statistics page.  As items are sold this page will be 
automatically updated by WinPOS®.   Important performance statistics include month-to-date, 
year-to-date, and lifetime sales, as well as the revenue and gross margins generated. 

The TPOS/TPS optional modules add a fourth form called Rental.  Use this form to classify an 
item as rental and to enter the appropriate detail. 

When finished press the Done button to close the Inventory form and return to the menu. 

 

Step 12 - Security 

WinPOS allows forms and features to have controlled access by each user of the system. 
 Create security groups and their permissions, then assign store personnel to those groups. 
 Main->Housekeeping->General Setup->Security Groups Permissions 

 

Step 13 - Document Terms 

You may want to have specific terms print on receipts and other documents.  These may be 
entered once and used each time a receipt is printed.  Main->Housekeeping->General Setup-
>Document Terms 

 

Step 14 - Printers 

A shop may have multiple printer locations for workstations/registers to use.  When multiple 
print options exist they may defined as a default print location for each workstation/Register. 
Housekeeping->General Setup->Printers 

 

Step 15 - Form letters and tags 



Getting Started 

17 

You may create form letters and print price tags or mailing labels.  These may be customized as 
needed when needed. Main->Housekeeping->Letters, Tags, Mailing Labels 

 

Step 16 - Customers 

Begin using the system by entering customer, events and creating sales. 

Using WinPOS 

 

Usage Concepts 

WinPOS® is a Windows application, which means that you’ll be using both a mouse and a 
keyboard to work with it. You should be comfortable with Windows in general before trying to 
learn WinPOS®. 

All WinPOS® data entry forms follow the same basic look and feel. Each will vary as to the 
number of tabs and/or buttons they contain. Most forms have more than one tab, some do not 
have any tabs.  

Forms can be resized by grabbing an edge of the form, or using the Maximize button in the 
upper right corner. 

 

Application main title bar. 

The Application Title bar provides important information concerning the system.  It shows three 
pieces of information. Application name (WinTPS/WinBPS). Following the name is the register 
name of the workstation, in this case EDDIE. Next, the current business date, then store 
location of the register (helpful in multi-store implementations) and finally word DEVELOPMENT 
(only displayed when the application mode is in development).  See the Title Bar menu topic for 
more information of the options found within this menu bar. 

       

 

 

 

Data Form Example 

This image is the Retail Inventory form, which will be used as an example.  Data forms operate 
in the same consistent manner.  

The leftmost tab is the List tab. This shows all the items in the retail inventory. You can click on 
a record to select it, or double-click to select it and go to the Details tab. Use the scroll bar on 
the right side of the list to scroll the list up and down, or click in the list and use the arrow keys. 
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The list is sorted by the leftmost column. In this case, it’s the store style number. To search for a 
store style code, click on field next to Search for: and start typing the store style code. As you 
type, WinPOS® will locate the style code that matches what you’ve typed.  

If you instead wanted to search on the vendor style code, you would click on the column 
heading for vendor style code. That column will move over the left, indicating that it is now the 
search column This will now sort the list by vendor style code. Then as you type it will locate the 
matching vendor style code. You can only search on columns that are shown with bold black 
headings. 

 

Once you have located the inventory item you want to see, double-click on it in the list, or press 
Enter on it, or click on the Details tab. This will display the Details tab. 

Common buttons found on data entry forms 

Save... Saves any changes made to the data of a form. 

Cancel... Throws away any changes made to the data of a form. 

Delete... Deletes the current displayed data.  Deleted data cannot be recalled.  Cannot be 
selected while data changes are pending.  Data changes must be SAVED or 
CANCELLED before. 

Add... Adds a new set of information to the form.   Cannot be selected while data changes are 
pending.  Data changes must be SAVED or CANCELLED before. 

Done... Exits the form and returns to the previous form or menu.   Cannot be selected while data 
changes are pending.  Data changes must be SAVED or CANCELLED before. 
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Printing 

Reports may be output 1) printed 2)  to the screen 3) printer 4) a text file or 5) an Excel 
spreadsheet file.  Text file or Excel output files are automatically stored in the WinPOS data 
user folder.  Review the topic Installing WinPOS for a description of standard folder locations. 

 

 

Title Bar Menu - Simple 

This menu is displayed when the Profit System is not using the Comprehensive menus. 
Comprehensive menus are turned off and on from the System Setup form, Toolbar/Desktop 
form.  Here are the options. 

File menu... 

  

 

• Switch Register/Store: Only available if you have the WinPOS© Multi-Store 
Integration. Lets a user temporarily change the identity of the current register s/he is 
logged into to the identify of another register. This new identity is maintained until 
the user switches back to the original identity OR the user exits WinPOS©.  It 
prompts first for a store id  then a register within that store.  Stores have to be 
created via the system setup and registers have to be created via the Register form. 
 The register identity is used for receiving inventory, sales ticket transactions and 
certain reports. 

• Pickup Notifications:  The Pickup Notifications form is a tool designed to be utilized 
as an organized method to notify customers that special order merchandise is in the 
shop and ready for pickup.  See the Pickup Notification topic for more operation 
information. 

• BM Follow Up: This tool is used by bridesmaids sales consultants to follow up on 
prospective sales and close existing sales. 

• Bridal Follow Up: This tool is used by bridal sales consultants to follow up on 
prospective sales and close existing sales. 

• Rental Follow Up: This tool is used by formal wear rental consultants to follow up on 
prospective sales and close existing sales. 

• Logoff:  Not used in WinPOS. 

• Change Password.  WinPOS users may quickly and easily change their passwords 
via this selection.  Frequent password changes is a great security preventative fraud 
habit. 

• Exit: Exits from WinPOS© 

Edit... 

• Undo: Undo your changes to the field you are currently editing, without discarding 
any other changes you’ve made to other fields. 

• Redo: Redo the changes that you just undid. 

• Cut: Cut the highlighted information into the Windows clipboard. 

• Copy: Copy the highlighted information into the Windows clipboard. 

• Paste: Paste the information from the Windows clipboard into the current field. 

• Clear: Blank the current field. 
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• Select all: Highlights the current field. 

• Find: Not available in WinPOS®.  

• Replace: Not available in WinPOS®. 

Locate... 

• View Inventory F4: Lets you quickly browse retail inventory by store style or vendor 
style or internet style.  This lookup feature allows a user to see all Size/Color/Widths for 
each style and the total quantity on hand, as well, as quantity on hand for each store 
location (when the multi-store feature is on).  Also color charts and picture of the style 
can be viewed when available.  Available Extra Charge selections entered for a style 
can be view when needed by the user via the Extra Charge button.  This inventory 
lookup feature will not display rental styles entered in via WinTPS/TPOS© optional 
modules.  Finally, via the ADD button, a Quick-Add  inventory function is available for 
authorized users.  This Quick-Add permits retail inventory to be created with Vendor 
Style, Vendor code (new vendors may be created on the fly), Category (new categories 
may be created on the fly), sub-category (new sub-categories may be created on the 
fly), Retail price 1 and reorder cost). 

• Inventory by Size/Category F5:  This function is a quick tool to lookup Styles by either a 
Size or Category & sub-category.  It also can show on-hand quantities for all stores with 
the optional BBL Multistore module installed.  This function will not display rental styles 
entered in via WinTPS/TPOS© optional modules.  Select this option or press F5 from 
main menu. 

• Inventory by Serial/Control F6: Lets you quickly look up the details for either a serial 
number or control number for a tracked rental inventory item.  Available with WinTPS© 
optional module.  Select this option or press F6 from main menu. 

• Check Availability F3: Lets you check the availability of rental inventory items by size 
and/or style. Only available if you have WinTPS module.  Select this menu option or 
press F3 from main menu for quick access. 

Quick Availability will use the entered data to show rental availability.  All field data is NOT 
required.  A style OR size is required, but NOT both. 

Data Fields 

Style Code... Optional.  Enter a style without a size and all the style's sizes will be shown with 
available rental quantity.  Enter a style and size to see that size and 5 smaller sizes and 5 
larger sizes.  

Size code... Optional.  Enter a size without a style and see all style's with that size and the 
availability. Enter a style and size to see that size and 5 smaller sizes and 5 larger sizes.  

Type... Optional.  May be entered when the style field is left blank.  This is the rental item type, 
example is COAT.  Enter a size and COAT item type to see availability of ALL coats for 
the entered size. 

Pickup... Enter the order's pickup location.  The default will the store the user is logged in as. 
 Used to determine assembly & back dates. 

Use date... The use date availability is being checked for,  The system auto determines the 
asseble and back dates upon the entered use date and order pickup location entered. 

Assemble... The assembly date.  Auto determined by the system based upon the entered use 
date and pickup location.  The assemble date may be manually modified. 

Back... The back date.  Auto determined by the system based upon the entered use date and 
pickup location.  The back date may be manually modified. 
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Check Availability button...  Once the fields are completed with the data, click this button for the 
system to locate and display the availability information. 

 

• Ticket by Number:  Allows a ticket to be displayed by entering it's number.  See View 
Ticket by Number topic for more information. 

• Ticket by Credit Card:  Displays all sales tickets that a entered credit card number has 
been used to pay and allows the operator to see & edit a selected ticket. This reports 
prompts for the last four digits of the card.  This feature is available when the shop uses 
the credit card integration option. 

• Ticket by Style Code:  Displays all tickets the entered style code was sold on and allows 
the operator to see & edit the selected ticket. 

• eMail address:  Enter a email address and the system will search for it across 
prospects, customers and appointments.   It is usually used when you need to remove 
an email address from the records.  Enter the email address and click Search.  It will 
display the customers, prospects, and appointments where that address appears. 

Transfer... 

This menu option lets you jump directly to another form in WinPOS® without having to go 
through the menus. It is useful if you want to quickly jump to another part of the system without 
exiting from the form you are on. For example, you are entering a customer on the Customer 
form, and someone wants to quickly get the phone number for a vendor. You can click this 
menu option and select the vendor form. WinPOS® will display the vendor form on top of the 
customer form, You can then locate the vendor, get the phone number, and close the vendor 
form. You will then be back at the customer form right where you left off. You can find the form 
name by looking in the upper right hand corner of the form itself.  

 

Tools... 

• Calendar:  Selection to Pop-up a calendar to quickly see days/dates 

• Keyboard:.Displays an on-screen keyboard. If you are on a field you can type into, 
you can click this menu option to display a keyboard. You can then click on the 
letters you want to type into the field. 

• Assign Pager to User: Optional feature installed with the BBL Appointment module 
to assign pager IDs to Sales Associates.  Supports the use of a in-house alpha 
numeric paging system to send messages. 

• Send Page: Optional feature installed with the BBL Appointment module to send a 
55 character alpha numeric message to a Sales Associate or ALL Sales Associates 
assigned pagers. 

• Backup Alt-B: Allows you to easily make a copy of your data to a Flash drive, CD-
RW, or other drive location. Before using this option, a default backup path should 
be set in System/Store Setup, located at Main->Housekeeping->System/Store 
Setup.  The path may be changed by clicking the file selector icon next to the 
backup path field. This option is also compatible with BBL's online Backup System 
called Titan Backup®.  It will initiate a session with Titan when that software is 
installed.  Visit the topic Off-Site Backup for more information.  All users should be 
exited from the WinPOS© system during the backup process.  WinPOS© will warn 
the user that files are in use during the backup.  The backup function will backup all 
system & data files and store them in a single compressed file.  This file should be 
moved or created on storage media that can be removed from the computer, like a 
CDRW. Review the topic "How do I backup WinPOS©" for further explanation. 
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• Upgrades: WinPOS© will connect to the internet and check to see if there are any 
upgrades available to WinPOS©. You must have an internet connection available 
from the computer to use this feature. 

• PDA Physical: Starts the PDA Physical application that supports certain Wireless 
Portable Scanners for direct counting of inventory into WinPOS© via the use of 
Terminal Services. 

• PDA Check Serial: Starts the PDA application that supports certain Wireless 
Portable Scanners for checking inventory by scanning barcodes via the use of 
Terminal Services.  Once a valid barcode is scanned or typed information 
concerning price, on hand quantity ..etc is displayed. 

• Move Server: The Move Server menu option on the Tools menu is used to move the 
data files from an old server to a new one.  

Move Server Steps 

This option will help setup a new file server for WinPOS.  Use this when an existing server 
is being retired.  See the FAQ Upgrade Server for more information. 

 

Lock station... 

This will lock the workstation so it cannot be used. To unlock the workstation you will have to 
enter the unlock password (UNLOCK, by default) You can change the unlock password in Main-
>Housekeeping->General Setup->System/Store Setup->Other Settings Tab. If no password is 
set, the Lock Station option will not work. 

 

To-Do...  

A module that provides software tools to manage actions/tasks for prospects & customers.  This 
option starts the To-Do module and allows a user to see TO-DOs assigned directly to them or 
for their department.  See the TO-DO topic for more information. 

 

Help... 

• Contents: Displays the WinPOS® on-line help. 

• Unlock options:  Displays the Program Options form. This form is used to activate 
and deactivate WiPOS on your computer network, turn on or off optional software 
modules in WinPOS® and to extend service dates. This may be utilized to update 
your license via the internet or when talking to BBL Systems technical support. 
 Available options are: 

• Automatically via the internet 

• Using an upgrade key via the internet 

• By installing a new license file received on disk or via eMail 

• Over the phone 

• Disable Security: Used by BBL Customer Service to disable the security for 
troubleshooting. 

• Remote Helpdesk:  This function will visit the BBL web-site and start the Remote 
Helpdesk software that allows BBL technical support to see your computer desktop. 

• About: Displays the WinPOS® About form. It tells you what version of WinPOS® you 
are using, where the data files are located, your registered name and company, and 
your serial number. 
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Quick Launch... 

This is a feature set-up via the Housekeeping->General Setup->Actions/Transfer Table form to 
allow users to quickly access applications or web-sites outside of WinPOS©.  WinPOSv main 
menu will re-display when a user exits the application/site that Quick Launch can transferred 
them to.  Its a great way to allow users to access other applications and web-sites without 
exiting from WinPOS© to the desktop. 

 

Daily Activities 
 

Daily Activities 

Everyday you would:  

• Open your Register and the Store. 

• Input Permanent (Sample) inventory changes, i.e.: New Samples, price changes, 
item discontinue dates, etc. 

• Add new events, prospects, and customers. Modify existing registration cards.  

• Create/Update Tickets, i.e.: Payments, Sales, Special Orders, print sales receipts 

• Maintain Purchase Orders. Review Purchase Order/Item Work form to determining 
which orders are ready to be printed. Print POs for orders that are ready (correct 
size, color & deposit). Print/Review Open PO Listings (many to choose from) to see 
which orders need to be checked with the manufacturer. 

• Maintain Pick-Up inventory, i.e.: receive special orders into Pick-Up, print ID tags, 
notify customers via letters, phone or post cards & mark items taken if picked up by 
the customer. 

• Print Revenue Report and bank deposit slip at closing. Use the report to see sales 
information, sales tax collected and accounting information, etc. 

• Close your Register and the Store. 

Print sales analysis reports periodically (monthly). Sales by category, vendor, and sales person, 
Inventory analysis by Vendor & Inventory analysis by Category. 

 

Existing Customer Conversion 
Customer Conversion to WinPOS© 

It is important to input your existing customer data into WinPOS® right away, which includes 
their account balances.  In this way two sets of books will not have to be kept (one manual & 
one on the computer). 

It is very important to set a COMPLETION date to have the data converted to the computer.  A 
good period would be 4 to 5 weeks.  Publicize the date so everyone in the shop can work as a 
team to get the data in.  In addition, the COMPLETION date can generate some pressure on the 
employees be active in learning the WinPOS® basics for preparation of going LIVE. 

To speed the customer data conversion process, we have found the following method a quick 
and easy way to input your existing bridal accounts and balances.  It is called the BALANCE 
FORWARD method.   

The method requires that ONLY a customer's balance be entered into the computer.  All the 
transactions that created the balance are NOT entered.  This means that shop personnel will 
continue to rely on the customer file folders for the history information.  This method 
accomplishes TWO goals.   
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1. The existing customers are VERY QUICKLY entered (1 to 2 weeks).   

2. You do not have to go Cold Turkey away from the paper files.  

Once the customer balances are entered this way, ALL new transactions, including sale and 
payments, are entered on the computer.  This way Daily Sales Reporting can be done and the 
shop will begin to realize the full benefits of the computer. 

Follow the instructions below depending on how your shop pays sales tax: 

 

Shops that wait until balance is paid ($0): 

Pull your files out by order (usually by Bride name or Wedding Date).  Select the bride to enter 
onto the computer.  Compute her balance and the balance of each the attendants.  Also 
compute the total unpaid sales tax for the bride and each attendant.   

Within WinPOS® fill out a registration card for each event following the instructions in the 
Operation section of the Quick Start manual. Then add each member of the event.   On the 
Sales Slip when WinPOS® prompts for STORE STYLE number enter the BF code.  When the 
system asks for an amount enter her balance that you have computed less the sales tax 
amount.  The 2nd transaction will be the same except enter TF for Tax Forward.  When the 
system prompts for an amount enter the sales tax due.  For both codes leave Color & Size 
prompts empty. Leave the items STATUS as Taking. 

For example if the person had purchased a $1000 item and had paid a $500 deposit, her 
balance would be $500 plus sales tax.  Assume a tax rate of 5%, the sales tax due would be 
$50.  Her total balance is $550, $500 on the item, $50 tax.  Her ticket would contain two SALE 
transactions: 

BF $500.00 

TF $50.00 

Each attendant will also have a sales ticket.  Enter the BF and TF codes with the proper amount 
for each individual IF the items have already been SPECIAL ORDERED. 

If all individuals of an attendant party have NOT ordered, DO NOT USE the BF or TF codes. 
 Instead enter the exact transactions for those members that HAVE been in to place deposits. 
 Tell WinPOS® to SPECIAL ORDER the items on those tickets (remember: WinPOS® will place 
those items marked to be ordered into a pending Purchase Order state).   When the other 
members come in to place deposits you will enter their exact transactions into WinPOS® . 
 When the order is complete you can release it to the manufacturer.  The benefit is that you will 
have attendant groups enter into WinPOS® the same way and you can quickly start using the 
Purchase Order functionality. 

 

Shops that pay all sales tax when a partial payment is made, i.e. a balance is still due: 

Pull your files out by order (usually by Bride name or Wedding Date).  Select the bride to enter 
onto the computer.  Compute her balance and the balance of each the attendants.  

Within WinPOS® fill out a registration card for each event following the instructions in the 
Operation section of the Quick Start manual. Then add each member of the event.   On the 
Sales Slip when WinPOS® prompts for STORE STYLE number enter the BF code.  When the 
system asks for an amount enter her balance that you have computed. Leave Color & Size 
prompts empty. Leave the items STATUS as Taking. 

For example if the person had purchased a $1000 item and had paid a $500 deposit, her 
balance would be $500 plus sales tax.  Assume a tax rate of 5%, the sales tax due would be 
$50.  Her total balance is $550.  Her ticket would contain one SALE transaction: 

BF $550.00 
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After the bride is registered and her balances entered.  Fill out the registration card for each of 
the attendants  (WinPOS® will ask you to add new attendants).  Each attendant will also have a 
sales ticket.  Enter the BF code with the proper amount for each individual IF the items have 
already been SPECIAL ORDERED. 

If all individuals of an attendant party have NOT ordered, DO NOT USE the BF code.  Instead 
enter the exact transactions for those members that HAVE been in to place deposits.  Tell 
WinPOS® to SPECIAL ORDER the items on those tickets (remember: WinPOS® will place 
those items marked to be ordered into a pending Purchase Order state).   When the other 
members come in to place deposits you will enter their exact transactions into WinPOS®. 
 When the order is complete you can release it to the manufacturer.  The benefit is that you will 
have attendant groups enter into WinPOS® the same way and you can quickly start using the 
Purchase Order functionality. 

 

Shops that pay sales tax on the payment amount: 

First a change has to be made to the BF code entered into WinPOS®.  The accounting class for 
BF has to be changed to taxable. See Accounting Classes for details on how to do this. 

Pull your files out by order (usually by Bride name or Wedding Date).  Select the bride to enter 
onto the computer.  Compute her balance and the balance of each the attendants.  

Within WinPOS® fill out a registration card for each event following the instructions in the 
Operation section of the Quick Start manual. Then add each member of the event.   On the 
Sales Slip when WinPOS® prompts for STORE STYLE number enter the BF code.  When the 
system asks for an amount enter her balance that you have computed. WinPOS® will calculate 
the tax. Leave Color & Size prompts empty. Leave the items STATUS as Taking. 

For example if the person had purchased a $1000 item and had paid $525, her balance would 
be $500 plus sales tax (this example assumes a tax rate of 5%).  The deposit was $500 on the 
item and $25 sales tax.  The shop reported and paid $25 sales tax.  For this balance on the 
computer her ticket will contain one taxable SALE transaction: 

BF $500.00 (taxable = Y) 

WinPOS® will compute the $25 Sales Tax automatically and the computer will show a total 
balance on the person's account of $525. 

After the bride is registered and her balances entered.  Fill out the registration card for each of 
the attendants  (WinPOS® will ask you to add new attendants).  Each attendant will also have a 
sales ticket.  Enter the BF code with the proper amount for each individual IF the items have 
already been SPECIAL ORDERED. 

If all individuals of an attendant party have NOT ordered, DO NOT USE the BF code.  Instead 
enter the exact transactions for those members that HAVE been in to place deposits.  Tell 
WinPOS® to SPECIAL ORDER the items on those tickets (remember: WinPOS® will place 
those items marked to be ordered into a pending Purchase Order state).   When the other 
members come in to place deposits you will enter their exact transactions into WinPOS®. 
 When the order is complete you can release it to the manufacturer.  The benefit is that you will 
have attendant groups enter into WinPOS® the same way and you can quickly start using the 
Purchase Order functionality. 

Once the customer accounts are entered you can begin using WinPOS® to its fullest capability. 

 

Windows Setting - Time & Date  

It is crucial that all the computers using WinPOS® are set to the correct date and time. The date 
& time are used to date/time stamp many types of information in WinPOS© like time cards, 
sales transactions ..etc.   
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You can see the current time in the lower right corner of the screen. You can double-click on the 
time to see the current date.  

To change your computer's date  

 You will need to open the Date/Time Properties dialog box.  

(The Start button is located in the lower left corner of the Windows Task Bar) 

1. On the Windows Task Bar, click Start->Settings->Control Panel  

2. Double-click TIME/DATE 

Under Date, select the item you want to change:  

• To change the month, click the month list, and then click the correct month.  

• To change the year, click the arrows in the year list, or type the correct year.  

• To change the day, click the correct day on the calendar. 

• Under Time, use the up and down arrows to change to the current time. 

NOTE: For further Windows Setup options, click START and select HELP. 
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General Setup 

Sales Associates 

Switchboard: Main->Housekeeping->General Setup->Sales Associates  

Menu: Setup->General Setup-Sales Associates 

Action: EMPLOYEE 

 

This form maintains the list of all Sales Associates (current & terminated), which are also known 
as employees. Sales Associate is abbreviated as SA throughout this help manual and in many 
areas of the WinPOS software. 

You can delete a sales associate. However, the sales for that SA will no longer appear on the 
SA sales reports.  It is a good practice to just mark the SA as inactive/terminated by entereing a 
TERMINATED DATE on the SA form for the specific SA  and keep them on file for 1 to 2 years 
after they leave. 

There exists an system required Sales Associate called DEFAULT.  This SA is required by the 
system and should NOT be modified or deleted.  It does not appear in reports and most SA 
lookups. 

By default, SAs with a terminated date do not appear in the SA grid. 

List tsb 

SA's may be searched by ID or Last name. 

Show Terminated? (checkbox)... unchecked the system will display SA's with a BLANK 
termination date field.  Checked it will include terminated SA's within the grid. 

 

Detail tab 

Fields 

ID...ID is a code used to identify this SA. This is the code they will use to log into WinPOS®, this 
code will print on sales receipts to identify the sales person, etc. We recommend you use 
initials for this code. This code is also used to track which transactions were performed 
by which user. 
 
Once you save the information for an employee, this code cannot be changed. 

Password...This is the password for this employee to log into WinPOS®, if security is activated. 

Hint 

Employees may change their individual password any time from the main menu of WinPOS. 
 Simple select File-> Change Password. 

First Name...SA's first name. 

MI...SA's middle initial. 

Last name...SA's last name. 

Phone...SA's home phone. 

SSN...The employees social security number. 

Payroll ID...A reference to the Sales Associates ID that could be in a payroll computer system. 
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Perform fittings & alterations (checkbox)... Checked it indicates this associate provides custom 
fitting services and will be an available tailor in the optional Fitting Alteration module. 

Date terminated…If filled in, the SA will not show up in SA pick lists but is available for reporting. 
 If the "Date terminated" field on the Sales Associates form is filled in, then those SA are 
filtered on the List tab of the Sales Associates form.  Checking this box will display those 
SA's.  Terminated SA's are automatically filtered from the SA lookup form, used 
throughout the system. 

Date Created... Date employee was added to the system. 

 

Pay (optional data) 

Standard rate...The employees standard pay rate. Not currently used by WinPOS®, for 
reference only. 

Overtime rate...The employees overtime pay rate. Not currently used by WinPOS®, for reference 
only. 

Commission %...The employees commission %. Not currently used by WinPOS®, for reference 
only. 

 

Department...The department this employee is assigned too.   The available departments must 
be pre-entered in the Department maintenance form.  This is used by some reports, as 
Time Cards & Sales by Sales Associate  to limit it's data to employees that are members 
of the selected department. 

Round time (checkbox?)...If checked WinPOS® will round this employees time based on the 
setting in Main->Housekeeping->General Setup->System/Store Setup->Options Tab. 

Enroll fingerprint / Fingerprint...Allows the user to register their fingerprints for use with a 
fingerprint scanner. Only applicable if you have the fingerprint reader integration. 

 

Security 

Security Groups...This is the list of security groups that this employee should be a member of. 
To add a new security group, click the Add Item button. A blank entry will appear at the 
end of the Security Groups list. Click on the blank entry and select the correct security 
group. To remove a user from a Security Group, select the Security Group in the list and 
click Delete Item. You can add more than one security group to an employee. The 
allowed actions that employee can perform will be cumulative for all groups they are a 
part of. 
 
By default each Sales Associate is automatically a member of the Everyone group. 
 This group does not have to be selected in this grid.  

 

Appointment Integration 

The following fields only appear if you have the Appointment Integration. 

Skills…One or more skills from the SA Skills form. These skills control which appointment types 
the SA can perform. 

Skill ranking…How this employee ranks among all the employees with this skill (1-999, 1 being 
the best) used exclusively by the optional appointment management module. There can 
only be one employee for each ranking. When showing SAs who can perform an 
appointment, WinPOS® will display the SAs sorted by this ranking. 
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Pager ID…The seven digit cap code for the pager the SA is currently carrying. Only applicable if 
you have an in-house paging system. This number can usually be found on the back of 
the pager.  Contact  BBL for compatible paging systems. 

 

Buttons 

Work schedule button…Displays the Work Schedule form the current employee when the 
optional Appointment module is installed. 

Schedule exceptions button…Displays the Schedule Exceptions form for the current 
employeewhen the optional Appointment module is installed. 

Enroll fingerprint button...Allows the user to register their fingerprints for use with a fingerprint 
scanner. Only applicable if you have the fingerprint reader integration. 

Notes button...Allows for an unlimited amount of general information to be stored concerning this 
SA for reference. 

Delete... Delete the displayed SA record. 

Add... Adds a new record for a SA 

Done... Closes the form and returns to the previous form. 

Save... Saves all edits. 

Cancel... Cancel any edits and returns form to previous state. 

 

Operation Information & Options 

System Setup 

Switchboard: Main->Housekeeping->General Setup->System/Store Setup  

Menu: Setup->General Setup->System/Store Setup  

Action: SETUP 

This form lets you customize the behavior of selected WinPOS® features and crosses all stores 
(if more than one is configured) 

System Setup - Setup Tab 

Switchboard: Main->Housekeeping->General Setup->System/Store Setup->Setup Tab  

Menu: General Setup->System/Store Setup->Setup Tab 

Action: SETUP 
 

The System/Store set-up allows the customization of how WinPOS implements specific 
features.  Set these options to best accommodate your store operational requirements. 

Ticket 

Short ticket format...If checked, WinPOS® will hide all the line item detail on the Ticket form and 
increase the size of the line item grid to fill up the space. This lets you see as many line 
items as possible, with less detail for each line item. When the user creates a sale, an 
adjustment, etc. WinPOS® will automatically display the detail as needed. This option 
makes the Ticket form look less cluttered. You can display the line item details of the 
ticket at any time by clicking the show details button on the ticket screen. 
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Allow sale of item not in inventory...If the user tries to sell a style code that is not found in 
inventory, WinPOS® will change the style code to NoSKU if this option is checked. If this 
option is not checked, WinPOS® will not allow you to sell a style code that is not found in 
inventory. 
 
If you check this option and sell items using the NoSKU style code, you will have to put 
the item description/style code in the reference field. You will be unable to create PO’s 
using the NoSKU style code. Also, the sales reports will not be able to break down sales 
of these items, since they will all show up on the sales reports as style code NoSKU. For 
these reasons, this option is not normally checked.  

Leave default sales item status blank...When checked, the user will be prompted for the status 
of a sold item at sale time (Pickup Now, Pickup Later, Special Order). If unchecked, 
WinPOS® will default the item status to Taken. 
 
This would only be checked if most of your business is stock sales that customers take 
with them. At sale time, you can override the default Taken status if need be. 

Default to stock piece...At sale time, the item that is being sold will be taken from stock unless 
the clerk selects Special Order or Pickup Later. If only one size record exists within the 
retail inventory for the style being sold, WinPOS® will automatically fill in the size, color 
and width on the Ticket form. 

Allow stock sale of item not in stock...If checked, you can sell items even though the size and 
color do not appear in retail inventory. If not checked, the user may only select special 
order if a size/color combo does not exist in the inventory SCW form for the style being 
sold. 

Insert measurements into special instructions for Special Orders...If checked, WinPOS® will 
automatically insert the customers measurements into the special order instructions for 
any special ordered items. 
 
An Insert Measurements button also appears on the special instructions entry form so 
you can insert the measurements manually if you like. 

Show 2
nd

 and 3
rd

 salesperson on ticket…If checked, up to 3 salespersons can be entered on 
each sale. If not checked, only one salesperson can be entered per sale. This is in 
addition to the Clerk. You would want to display them if you split commissions between 
sales associates. 

SA 1 required…If checked, the user will be forced to enter at least one salesperson for a sale 
before it can be saved. 

Clerk required…If checked, the user will be forced to enter the clerk for a sale before it can be 
saved. 

Warn user if QOH going below zero at sale time…If checked, WinPOS will display a warning 
message during the sale on a ticket when a certain set of criteria is met.  The warning will 
appear, but let the user continue with the sale when selling a inventory item from stock 
with zero Quantity on Hand & the item's 'Allow quantity on hand to go negative' setting is 
NOT set on it's inventory record. 

Require size/color/width to appear in charts?...This setting will validate a Size, Color & Width 
combination being sold on a sales ticket against the Size, Color & Width charts that may 
be entered on the inventory style.  If a chart is not entered, the system will accept any 
value entered by the user.  To check the Size/Color/Width entries on the Inventory SCW 
form against any entered Chart(s),the system has an inventory report called SCW not on 
Chart that will list entries in the SCW form that are not on the Style's chart.  Management 
should make sure the SCW form and Size, Color, Width Charts agree. 
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Adj amounts must be entered via markdown codes?...by default adjustments may be enter 
onto tickets to reduce the price of an item.  When this option is DISABLED, a user may 
enter a markdown amount and optionally a markdown code (reason). Enabled (checked) 
a user must first enter a markdown code which in term automatically applies the 
markdown amount.  Markdown codes and amounts are created in the Markdown Code 
form. 

Exclude extra charges from adjustments?... Adjustments / Markdowns are computed on the 
current net price of the sales transaction.  Extra Charges affect the sales's net price. 
Checked this setting will exclude any extra charges from the adjustment calculation.  For 
example.  A bride purchases a size 22 gown for $1000, the extra size charge adds 
another $200 for a $1200 total.  Now you wish to give the bride a 10% adjustment / 
markdown on the dress.  When extra charges are excluded the 10% discount would be 
$100 in this example. 

 

Receipt 

Suppress header on receipts...When checked, all receipts will drop with a 2” header margin and 
will not print company name, address, logo, on the receipts. This would be checked if you 
have company letterhead that your shop prints it’s receipts on. 

Print measurements on receipts...If checked, the customer’s measurements will print on sales 
receipts. 

Print special instructions on receipts...If checked, the special instructions entered for special 
orders will print on the sales receipts. 

Print QTY@Price on receipt...If checked, the quantity purchased at the price will print below 
each line item on the sales receipt. 

Print clerk and all salespeople on receipt...If checked, the ID of the clerk and all the 
salespeople for each transaction will print on the sales receipt. 

Print width column on receipt...If checked, the width will print on the sales receipt. 

Print reference for ticket line item of receipt...If checked, the reference entered on the Ticket 
form will print below the line item on the sales receipt. 

Prompt to print receipt...If checked, WinPOS® will prompt to print the receipt rather than 
printing it automatically each time a ticket is changed. 

Right justify the statement summary on receipt...If checked, the statement summary will be 
moved over to the right side of the sales receipt. By default it prints on the left side of the 
receipt. 

Use narrow format receipt...If checked, WinPOS® will limit the amount of information on the 
receipt to make it narrower. This option is only used for stores with special pre-printed 
format receipts. We do not recommend using pre-printed forms, so most shops would not 
use this option. 

Hide “store credit created” on receipt...This option suppresses all the store credit created 
messages that appear on a receipt. You would normally not use this option, it is only 
provided for customers with special needs. 

Only print receipt if it contains a sale?…When using WinTPS, a ticket can contain a rental 
transaction and no sale transactions. In this case, if this option is checked, WinTPS will 
not print the standard receipt when the ticket is created or saved. When using this option 
you would normally print a Reservation Receipt instead. 

Prompt for summary only receipt?... Checked, the WinPOS system stop and ask user to print 
a summary or standard receipt. A summary receipt will only print the receipt grand totals. 
 It omits all line item details. 
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Message for receipt if customer has a store credit (use NONE for no message)…When a 
customer has a store credit a short message prints at the top of the sales receipt along 
with the store credit. If this is left blank WinPOS will use it's default message 
"CUSTOMER STORE CREDIT (MAY BE REFUNDED OR USED AS PAYMENT)". To 
completely suppress the store credit message enter NONE. 

System Setup - Other Settings Tab 

Switchboard: Main->Housekeeping->General Setup->System/Store Setup->Other Settings Tab 

Menu: Setup->General Setup->System Setup->Other Settings Tab 

Action: SETUP 
 

Customer form captions 

Customer form captions...There are four general purpose fields on the Customer form, called 
Alternate ID’s. You can enter anything you like in these fields. For each of these alternate 
IDs, you can enter a caption here that will appear on the Customer form. For example: 
Driver’s License, Social Security Number, Credit Card. 

Req?...If checked, the corresponding general purpose field will be required to save a customer’s 
file. 

 

Track Gift Card Balances…when enabled, WinPOS® provides the tools for a shop to offer Gift 
Card/Certificate services. It will provide a balance tracking feature whereby the system 
will maintain a balance by gift card/certificate ID code.  

This option, when checked, will prompt for the ID Code when a user purchases a gift 
card/certificate & automatically maintains a balance for that ID code.  Users may use the Gift 
ID code to place payments against sales tickets via the Gift Card tender type. 

BBL optionally offers Gift Cards with ID Codes recorded on magnetic stripe, like a credit 
card, that may be utilized.  

Expired Gift Card IDs may be purged via the WinPOS™ Purge functions. 

 

Style code prompt for ticket...Caption that will replace the Style prompt on the Ticket form.  

Screen lock password...The password needed to unlock the station. This field is blank by 
default and the feature will not become enabled unless you actually put a word in this 
field. The station can be locked by pressing F12 or selecting Lock station from the menu. 
This option locks the station so WinPOS® cannot be used. You would use this if you 
have a workstation positioned so that a customer or other unauthorized person could 
easily use it. You could lock the workstation each time you walk away by pressing F12. 
 
If the password is blank, the screen lock will be disabled. 

PO Detail...The level of detail on the PO. Each level builds on the lower level.. High format prints 
the event date and the event name; Medium format prints the event name; Low format 
prints neither. 

 

Receipt format...The format of the receipt. Select 80 column for a receipt designed for an 8 ½ by 
11 page (most common). Select 40 column for a receipt designed for a special receipt 
printer. 

Inventory costing...Select either LIFO (last in first out) or FIFO (first in first out). LIFO means 
that newer inventory is sold first. FIFO means that older inventory is sold first. Each time 
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you sell an item, WinPOS® will decrement the quantity on hand for a Receive History 
entry. Which receive history entry gets decremented depends on this inventory costing 
method. 

First appt time...Only applicable if using the optional Appointment module. This is the time of day 
when your first appointments will start. WinPOS® will adjust the appointment display to 
start at this time. 

Pager path...Only applicable if using the Appointment Integration. If you are using the WinPOS® 
PageLink program to integrate with an in-house paging system, you must enter the path 
to the PageLink directory here. When you send a page from WinPOS®, WinPOS® will 
create a page request file in the specified directory. 

 

 

Warn user if PO is un-issued an the event is less than x days away...WinPOS® will display a 
!DANGER! message on the Purchase Order/Item Work form if the event date is less than 
the specified number of days away. 

For tuxedo special orders: Issue PO ...WinPOS® will display an “!ISSUE!” message on the 
Purchase Order/Item form when the PO is ready to issue. A PO is ready to issue when 
each ticket that is part of the event has a down payment percentage paid. For male 
members of the event, the percentage specified here is used to compute the minimum 
down payment that must be paid on each ticket. 

For bridal special orders: Issue PO ...WinPOS® will display an “!ISSUE!” message on the Un-
issued PO form when the PO is ready to issue. A PO is ready to issue when each ticket 
that is part of the event has a down payment percentage paid. For female members of 
the event, the percentage specified here is used to compute the minimum down payment 
that must be paid on each ticket. 

Default payment amount to x% of...When taking a payment from the customer, WinPOS® will 
suggest an amount. This amount is computed as this percent of the total due. The 
amount can be overwritten when the payment is made. 

Days to add to confirmed ship date on PO for est. ready for pickup date on Myinfo page... 
See marketing MyInfo topic for more information on this customer service web feature. 
 This option appears when the Myinfo service is turned on via the Housekeeping-> 
System Setup-> Stores-> Options tab-> Enable on-line MyInfo?  This number value is the 
number of days to add to the Customer's purchase order confirmed shipping date that 
appears online for the customer.  Many shops wish to pad the shipping date to insure the 
item arrives within the customer's expectations. 

 
 

Backup path...Enter the directory where data copy files should be saved. You can access the 
backup command from the file menu. You can use this to make a backup of your data. 

# of copies...Print the specified number of copies for each document type (PO, Rental 
Agreement (in WinTPS/TPOS© optional modules), event card, invoice, deposit slip, 
receipt) This is a system wide setting and applies to all workstations. Individual 
workstations may override these settings via the Register setup form.  The field value 
should contain the number of 1 copies needed for each document type, i.e., 1 for 1 copy. 
0 will NOT print any copy.   

 

Size chart measurements...There are 3 extra measurements on a size chart, normally called 
Measurement 4, 5, and 6.  These measurements can be renamed using the Caption 4, 
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Caption 5, and Caption 6 fields.  The value for Caption 4 will appear on the Size Chart 
form, and on the printed size chat. 

System Setup - Options Tab 

Switchboard: Main->Housekeeping->General Setup->System/Store Setup->Options Tab  

Menu: General Setup->System/Store Setup->Options Tab 

Action: SETUP 
 

General 

Don’t allow movement or resizing of forms...In a Windows environment, any displayed form 
can normally be moved, resized, maximized, minimized, etc. When this option is 
checked, WinPOS® will prevent the movement and resizing of it’s forms. This can 
prevent an inexperienced user from accidentally moving things around. 

Enhance the cursor...If checked, the active field (where the cursor is flashing) will be highlighted 
using the color specified in the Register setup 

Beep when searching and entry not found...When checked, WinPOS® will beep and display a 
short message if a name or number is not located when the user is using a search field 
on any of the List tabs in WinPOS®. 

Don’t show printer options dialog when printing?...Normally, when a report is printed and the 
user selects Printer versus Screen or Disk, the user has the option to select the 
destination Windows printer. If this option is checked the report will go directly to the 
WinPOS defined report printer (as set on the PSETUP form) without displaying the printer 
selection dialog. 

Don’t allow credit card to be saved…WinPOS® with the optional credit card integration 
software module has the option to save the customer’s credit card number, expiration 
and billing address. This is useful when the customer OKs a payment when not in the 
store. The operator can simple recall the information and re-use it for the new payment. 
Enabled the credit card information will not be saved and must be re-entered each time. 

 

Don’t ask for invoice number on stock PO receive …WinPOS normally prompts for the 
vendors invoice number when a stock PO is received, and that invoice number is stores 
in the Receive History. If this option is checked WinPOS will not prompt for the invoice 
number. 

Don’t update cost/price on stock PO receive…Enabled will allow system to automatically 
update the reorder cost (if different on PO) and compute a new retail price during the 
receive stock order process. 

 

Don’t prompt user to confirm date at startup…If enabled WinPOS™ will NOT ask the first user 
starting the WinPOS™ application to confirm the accounting date. Normally, as WinPOS 
is started it checks the computer date and compares it to the last date when WinPOS 
was run. If the date has changed, WinPOS asks the user to confirm the date. This 
prevents a problem where one of the computers on a LAN has the computer date set 
incorrectly. In that case, WinPOS detects that the date has changed and asks the user to 
confirm it, and the user will notice the date is incorrect and fix it. With this setting enabled, 
WinPOS will automatically use the computer date as the accounting date with no user 
confirmation required. Consequently, this setting is normally only used in a controlled 
computer environment, such as a terminal server. 
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Require registers to be opened and closed...If checked you will have to close each register 
within the store each night, and re-open it the next day. If un-checked, WinPOS® will only 
ask you to confirm the date the first time you open the program each day. 

Close and open all registers together...When checked, WinPOS® will automatically close all 
registers and the store when any register is closed. WinPOS® will also open all the 
registers and the store as soon as any register is opened. 

 

Enable Australian tax-inclusive pricing and phone numbers?...This option is used when 
sales tax is to be included directly in sales prices and not disclosed separately to the 
customer. When checked WinPOS no longer display the sales tax separately on the 
receipt. The sales tax will be automatically rolled into the selling price of an item. On the 
ticket form the sales tax subtotal will no loner appear and the selling price in the grid will 
include the sales tax. In the detail section of the ticket form the sales tax will still be 
shown separately. Also, the sales tax will be automatically included in the price on the 
style code lookup. On the retail inventory form (RETLINV) the sales price with tax and 
without tax will be shown separately.  Also, phone numbers will be formatted 
automatically for Australia. 

WinPOS© has special support Australian users.  When checked, the following changes 
occur in WinPOS: 

• WinPOS will modify the phone format to XX-YYYY-ZZZZ.    

• Tax will be included (tax inclusive) in the selling price on the sales ticket and when 
the system displays the selling price options,i.e. Price 1 or Price 2, on a sales ticket.. 

• Cents will be rounded to the nearest nickel (.05). 

• The register 'Cash Calculate' function found in Register functions-> Register Totals-
>Cash Calculate will include all Australian currencies. 

• Tax is included on Rental/Hire Agreements 

 

Prospect email is required to save…The prospect for contains a email address field for bride & 
groom. This setting, when enabled will require an entry into each before the form will be 
saved. A NA may be entered when the prospect does not have an email address. 

Require prospect when an appointment is completed?... Only applicable if using the 
Appointment Integration. When checked, WinPOS® will force an appointment to be 
linked to a prospect when you hit the Complete button on the appointment form. 

 

Show Print button on RETLINV form...If checked, WinPOS® will display the Print button on the 
Retail Inventory form, used to print tags for a style code. Normally, this button is hidden 
since most users print tags from the Retail Sizes form. 

Automatically create revenue accounts for new Inventory Categories...If checked, each time 
you add a new inventory category, WinPOS® will create an accounting class, GL account 
number, and line item on the Revenue Report. This means that you will get a revenue 
line on the revenue report for each inventory category automatically. Keep in mind that as 
you create new inventory categories, you will need to go into the accounting class to 
mark whether it is taxable, pays commissions and allows price changes. If you want to 
manually create accounting classes and configure the revenue report, uncheck this 
option. Most shops leave this option checked. 

Hide sizes statistics and prices for performance?...When checked, WinPOS will not display 
the MTD, YTD, and life sales figures on the Retail Sizes form initially. This will cause the 
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form to appear more quickly. A checkbox will appear on the form that will allow you to see 
the statistics if you like. 

Make sequence numbers store specific?...Only applicable if using the WinPOS Multi-Store 
Integration. If checked, WinPOS will generate ID numbers in sequence for each store. 
For example, the first ticket created in store #100 will get sequence number 100-1. The 
second ticket will have number 100-2. The first ticket created in store #200 will get 
number 200-1. If this option is not checked, WinPOS would generate ID 200-3 for store 
#200. 

Add dash after store ID in sequence numbers...WinPOS® puts the store ID in front of all 
sequence numbers is generates. If this option is checked, WinPOS® separates the two 
with a dash. You would use this option if you need to guarantee that the sequence 
numbers generated by WinPOS® are unique from store to store. Applicable if you have 
the multi store module. 
 
Example: Store ID is 01, sequence number is 100: 01-100 

No store ID or dash in style codes?…If WinPOS® is set to generate style codes (option below) 
this option controls whether or not WinPOS put the store ID and dash in those generated 
style codes. 

Don’t allow direct price changes to inventory…If enabled the system will automatically 
compute retail price #1 from the reorder cost, cost factor & Plus information entered on 
the inventory record. The reorder cost, retail factor and Plus information CAN be modified 
by the operator. When enabled the Inventory Maintenance – Mass Update feature can be 
used to modify retail selling price # 1 when costs or retail price changes are needed. 

Generate sequential style codes for new inventory…If checked, WinPOS® will generate 
sequential style codes for new retail inventory items. Otherwise you must create a 
method for assigning store style codes to your inventory. 

Require reason when changing QOH?... This setting applies to manually modifying the quantity 
on hand for an inventory style from the inventory SCW form.  When a user manually 
modifies the quantity on handy by changing a Receive History entry the system will log 
the modification and optionally prompt for a reason by providing a text box whereby the 
user may type in the circumstances of the change. 

Allow editing of accounting classes...If enabled, the WinPOS© account numbers can be 
changed.  Normally, WinPOS automatically creates WinPOS© account numbers and 
accounting classes as Inventory categories are created, so there is no need to edit them 
directly.  Changing these numbers incorrectly can cause erroneous revenue/tax postings, 
so they should only be changed by users with a complete understanding of the WinPOS© 
financial posting and revenue process. 

 
General 
 
Default gender when adding new customer... When adding a new customer the customer 

gender is important for proper size/measurement headings.  Choose Male, Female or 
Automatic.  Automatic is utilized for WinBPS (bridal) installations.  Automatic will default 
to the FEMALE gender for new customers. 

 
 
Hide items out on RCR on cust/evnt/pick notify?...Special orders or other merchandise that 

has ben sold may be need to leave the store for returns, cleaning or repair (RCR). 
  WinPOS provides a software module to track this merchandise. When this option is 
ENABLED (checked) the items out via RCR will not display to customer service clerks on 
Events, Customer and Pickup notifications forms so they do not tell customers their 
merchandise is in the store, when in fact it is not. 
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Apply vendor discount to cost on special orders?... This is a option that affects cost and 

margin calculations on reports.  When adding an item to inventory, a option exists to 
enter a vendor prompt pay discount.  Checked, this option will apply the prompt payment 
discount to the item's cost when it is sold irregardless if it is sold from stock or special 
ordered.  ALL reports that display cost of sales will now will reflect cost less this prompt 
payment discount.  Enabling or disabling this option is NOT retroactive, meaning past 
cost of sales figures are not affected. 

 
Disable Sharing Store credits across event... checked, a store credit found on any member of 

the an event cannot be used to pay on a ticket by another member of the same event. 
 Un-checked the credit can be used by any other member of the same event which is 
helpful when brides or mothers make a large payment given her a store credit so a 
portion of it may be applied to members as they register in the event. 

 

Time Clock 

Use fingerprint reader for time clock...If checked, WinPOS® will use a fingerprint reader for 
time clock in and clock out. Only applicable if you have the fingerprint reader integration. 

Use fingerprint reader for all logins except time clock...If checked, WinPOS® will use a 
fingerprint reader for all logins instead of prompting for passwords, except for time clock 
in and clock out. Only applicable if you have the fingerprint reader integration. 

Show time as decimal on time clock reports...When displaying time worked, show it as 
fractions of an hour, rather than hours and minutes. 
 
For example: 8 hours and 45 minutes would show as 8.75. 

Round to x minutes on time clock reports...When displaying time in the time clock, round to 
the nearest x minutes.  This setting will cause the time to be rounded up or down to the 
nearest number.  
 
For example: If x is 15, and the clock in time is 2:25pm, the time will round forward and 
display as 2:30pm or if the clock in time is 2:20pm it would round back and display as 
2:15pm. 

User can review and print time card at clock in/out... Enabled, the user can choose to print or 
review their time card or review their clock in/out history when they actually perform a 
clock in or out. 

 

Special Alert Wav file…WinTPS feature. Some production management events will cause an 
alert message to appear on the screen. Optionally a sound can play thru the computers 
sound card and speakers to grab the operator attention. Any so8nd file in the Windows 
WAV format can be played for alerts. Type in the path and file name or use the BROWSE 
button to navigate to the file and select it. 

 

System Setup - Rental Tab 
 

This tab is only enabled for WinTPS/WinTPOS© software installations.  
 

Allow store credits on rental tickets.. If checked, WinPOS will allow a Ticket that contains a 
rental to also have a store credit. Normally, WinPOS will force the user to refund the store 
credit, or otherwise use it before allowing the Ticket to be closed.  
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Create new ticket for retail late and lost fees?… If checked, WinPOS will create a new Ticket 
for late fee charges resulting from a rental order being returned late. If not checked, 
WinPOS will simply add a late fee charge to the existing rental order ticket. Late fees are 
actually a sale of style code LATE FEE.  This optiona applies only to Retail customers. 
 WinTPS Wholesale accounts will always have a new ticket/invoice for Late or Lost fees. 

Auto-run sat/sun closing reports?...If checked, WinPOS® will run the following reports 
automatically when the store is closed. 
 
On Saturday: Rental Orders Upgrade (RP_RENTUPG), Revenues By Associate 
(RP_REVASC), Rental Registrations (RP_RENTREG), Formalwear Sales Pricing 
(RP_FWSALPRI), Invitation Sales Pricing (RP_INVSALPRI), Rental Orders Pricing 
(RP_RENTORDPRI) 
 
On Sunday: Rental Orders Upgrade (RP_RENTUPG) 

 

Allow “No charge for order” to be used…If checked, the “No charge for order” on the Rental 
Order form and “Free” checkbox on the Member Wizard cannot be used. When creating 
a rental order, there are two ways to make it a free order. The user can check the “No 
charge for order” checkbox on the Rental Order form, or the “Free” checkbox on the 
Member Wizard. Or, they can use a markdown to adjust the price to zero. If this box is 
checked, the user must use an adjustment to mark the price down to zero. This is 
normally done to establish an audit trail, since markdowns can be reported and queried 
on easily. 

Deny sales on tickets containing a rental… When checked, users cannot add a Sale 
transaction to a ticket containing a rental order transaction. 

Always recap rental on ticket?...WinTPS will always include the rental details on the receipt 
printed from the Ticket form. 

 

No order change history for exchanges…If checked, WinPOS will not prompt for the reason a 
rental order is being changed when performing an exchange. 

Visit price field on order entry…If checked, the cursor will jump to the Price field on the Rental 
Order form when the user is tabbing from field to field during entry of the style/size on the 
Items tab of the Rental Order form. This would be enabled if the rental prices need to be 
overridden often. Otherwise it will slow down data entry. 

 

Allow additional items to be added to fixed format rental orders...On a fixed format rental 
order there are slots for each item type, and at the bottom are extra slots for more style 
codes. If this option is checked, the user will be able to add extra style codes in these 
slots. If this option is not checked, the user cannot add any extra items to the rental order. 

Force rental orders option enabled by default?...If checked, the force rental order check box 
on a rental order will be checked by default. 

Require confirmation numbers for orders...A WinTPOS featured.  Should be utilized when the 
optional WinTPS production management software is not installed.  If checked, 
WinTPOS® will confirm rental orders when the confirmation number is entered not when 
created.  The feature will force new rental orders to be saved to a WAIT CONFIRM 
status. The orders are confirmed once an confirmation number is manually assigned to 
the order.   Confirmation numbers may be entered directly onto the Rental Orders-> 
Orders tab or via the Enter Confirmation Numbers form. 
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Add damage waivers to free rentals...If checked, WinTPOS© will add a damage waiver sale 
transaction to the ticket containing the rental charge for orders marked FREE on the 
Event - Register Members form.  Unchecked, the system will not automatically add a 
Damage Waiver to orders marked FREE. 

WinTPOS© will automatically default to adding a DAMAGE WAIVER charge to each rental 
order when a Price 1 - Base Price amount is entered for the Inventory style code DMG 
WAIVER. 

Note  

For Damage Waivers are automatically added to RETAIL customer rental orders created via 
the Customer form and Event - Rental tab (the operator may Cancel the charged if needed) 
when the system is configured to do so.    See the Damage Waiver topic for additional 
configuration information. 

WinTPS production management with the optional accounts receivable feature may have 
damage waivers added to wholesale account orders for inclusion on invoices by checking 
the 'Damage Waiver?' checkbox on the Order - Items tab when the order is created/saved 
the first time.  

Keep order change history...If checked, the user must enter change comments to a rental order 
each time it is changed after it has been created.  A change history entry is not created 
when the order is created or when any item on the order does not have a size and a size 
is entered. 

Detail level… options are: High or Low. When set to HIGH a prompt for Sales Associate and 
reason is required for any change to a rental order.  

A LOW setting requires Sales Associate and reason when dates, pickup locations, styles or 
sizes are modified. 

A Blank setting never requires Sales Associate and reason for modifications. 

No quick-fill on style code on Rental Order...If checked, the quick fill will be disabled when 
entering a style code on the Items tab of the Rental Order form.  Quick-fill automatically 
tries to complete the style code as it is entered. 

 

Allow any size on rentals...If checked, WinPOS® will not validate the size on rental orders 
against the WinTPS rental inventory. If integrated using the Link and the rental order has 
for "Confirm order regardless of availability" option checked, and the Auto Add Sizes 
option is enabled in TPS Link, then the size will be automatically added to the TPS Plant 
inventory, and the item will be set for sub-rental. If the "Confirm order regardless of 
availability" is not checked, or the Auto Add Sizes option is not enabled, the order will be 
rejected by the TPS Link and not confirmed. 

Role is required on Rental Order...Checked the user must enter a Customer role on a rental 
 order.  A order created from the WinTOPS® event registration will default to the 
customer's role. 

Put bride first on event/prospect card...If checked, the bride will be first on the event & 
prospect forms when new events or prospects are created.. If not checked, the groom will 
come first. 

Adjustment code is required to save event…If checked, the user must enter an Adjust amount 
and Adjust code on an event before it can be saved. That adjustment code is then 
automatically applied to all rental orders for that event. 

Sort by Names on Rental Tab of Event form…If checked, WinPOS will organize the members 
of the event on the Rental Tab by name. Otherwise they will be sorted by role. 
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Leave SA blank on new rental created from event… Checked, this option will NOT 
automatically copy any of the possible two Sales Associate (SA) assigned to an event on 
a newly created member’s rental order. It forces the operator to enter an SA code on 
each rental order created for the event.   

Checked, this option will carry over a Sales Associate's code form the Event Card.  The 
Event Card contains two Sales Associate's codes, SA (bridal SA) & Rental SA.  The setting 
allows one or the other to be carried over to the rental order.  Please choose the one to 
move over via the drop down. 

Go to Rental when create order from Rental tab of Event?...When the Create Order button is 
used on the Rental tab of the Event form, WinTPS can either go to the newly created 
Customer form, or the Rental Order form. If this option is checked WinTPS will go to the 
rental order. If unchecked, WinTPS will go to the Customer form. 

Show event wizard styles on Rental tab of Event even if order present?...If a member of an 
event has a rental order and also had styles entered on the Event Wizard, WinTPS will 
display the styles from the event wizard instead of the actual styles on the rental order. 

Every x formalwear order is free...If non-zero, every xth order on an event will be free. This 
option will only work when using the Register Wedding (or Register Members) form from 
the Event form to enter multiple event members. The “no charge for order” option will be 
checked on the rental order, which shows in the Free column on the Register Wedding 
form.  Main Menu-> Reports-> Customer/Event/Prospect-> Rental Event report provides 
options to audit Free orders. 

Deny changes for statuses...WinTPOS/TPS© will not allow for a order to be modified once it's 
status has become PICKED UP, RETURNED, SHIPPED BACK, WAIT LAUNDRY, 
LAUNDRY, DONE, LOST  or CANCELLED.  This may be limited even more by entering 
additional order STATUSES in this field.  The REVSTAT security setting allows a user to 
override the statuses and make changes to the order. Check the Order item Status topic 
for more information on rental statuses and a list of available statuses. 

 

Automatically save order check-in...If checked, WinPOS® will check-in a rental order as soon 
as the order number is entered. If not checked, the user must click the Save button on 
the Check-In form to actually check-in the order. 

Require serial numbers on order check-in...If checked, WinPOS® will force entry of a serial 
number for every tracked item on a rental order when the rental order is checked in using 
the Check-In form (CHECKIN).  

Check-in exchange order automatically?...Checked,  ALL exchange orders associated with a 
order will be checked in automatically when the order with the exchange orders 
associated is entered/scanned 'checked-in'. 

 

Go to payment window on pickup...If checked, and a customer picks up a rental order with a 
balance, the user will be taken to the payment screen. 

Print pickup receipt?...If checked, WinTPS will print a pickup receipt for each order as it’s 
picked up using the Pickup form (PICKUP). The receipt recaps the order and includes the 
return receipt Document Terms. 

Confirm pickup of order...If checked, WinPOS® will display a confirmation message each time 
a rental order is picked up. 

Pick up all orders using Pickup from Event?...There is a Pickup Order button on the Rental 
tab of the Event form.  If this option is checked, using that button will pickup all rental 
orders for the event that are ready for pickup.  If this option is not checked, only the order 
selected on the grid will be picked up. 
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Automatically ship back orders on return...If checked, orders will be marked as shipped back 
at return time. If not checked, orders are marked as returned at return time. You will then 
need to use the Ship Back form to actually ship the orders back to the service center. 

Serial numbers must be scanned to ship back…If checked, the user must scan the serial 
numbers of each item to enter it into the Ship Back form (used to ship items back from a 
retail POS location to the plant.) If not checked, all items that are ready to be shipped 
back are automatically shipped back when the user chooses Ship Back. 

Print return receipts...If checked, WinPOS® will print a return receipt as orders are returned. 

Serial numbers must be scanned for Return...When using the Return form (RETURN) the user 
must scan the serial number for each tracked item. The user can check the Present? 
checkbox for non-tracked items, however. 

 

No quick-fill on checkin/pickup/returns/ship back…If checked, the user will have to enter the 
entire order number on the Check-In, Pickup, Return, and Ship Back forms, instead of 
WinPOS©automatically completing a partial entry for the user. This can be turned on if 
order numbers are normally scanned instead of being entered to speed scanning. 

Suppress late fees cancelled from revenue report?...By default WinTPS/TPOS© will print a 
Late Fee cancellation details when the revenue report is printed.  This is for the audit of 
these cancellations.  This option will suppress this portion of the report. 

 

Charge for extra rental periods...WinTPS can automatically add a markup to orders where the 
term exceeds a standard rental term. 
 
For example, assume the standard rental period is 3 days, and the adjust amount is 30%. 
For an $89.95 rental with a rental term of 4 days, a $26.99 markup will be added to the 
rental ticket (1 extra term @ 30% of 89.95) If the rental term were 7 days, the markup 
would be $53.97 ($26.99 times 2 additional rental periods) 
 
The adjust amount can be a percentage (10%), or a fixed markup (10) In either case the 
amount is added to the rental order, rather than being deducted.  

• Standard rental period…Enter the standard rental period in days. 
• Markdown code for adjustment…The markdown code to be added to the rental ticket. 
• Adj amount for each addtl. period…The actual adjustment amount to be added to the 

rental ticket for each additional rental term. 

 

Maximum order line items…The total number of line items that can be added to a rental order. 
Defaults to 99. 

Late fee method...The method used to compute late fees for rental orders. It is used for WinTPS 
Plant Production and WinTPOS Point of Sale software modules. Late fee transactions 
are automatically created when the item(s) on a order are returned.  

Daily – By Order. A late fee transaction is created upon return of the last item of a order, if the 
order was returned past it’s stated return date [shown on order entry screen]. The late fee 
is added to the sales ticket in WinTPOS or to a unprinted invoice in WinTPS. The 
calculation is: daily late fee amount times the number of days the order was late (actual 
return date – order return date). 

Retn – By item. Late fees are charged on individual items at return time and are added to the 
sales ticket or unprinted invoice. Late fees for individual Item Types are entered on the 
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Item Type Maintenance form. The calculation is: Item Type late fee amount times the 
number of days the item was late (actual return date – order return date). 

None – No late fees transactions are created for late orders. 

Daily late fee for Retail orders...The daily late fee for retail rental orders, used if the Late fee 
method is Daily. 

Daily late fee for Wholesale orders...The daily late fee for wholesale rental orders, used if the 
Late fee method is Daily.  This option is only utilized with the optional Production 
Management software with the Accounts Receivable wholesale rental order module. 

 

When saving an order...When a rental order is created and saved the shop may want the 
system to perform a specific task to reduce the operator's key clicks.  The options are:  

Prompt: Ask the operator what they would like to do next 

Save:  Save the order and exit the order form 

Hold:  Mark the order as HOLD and exit the form. 

Payment: Display the payment form so a partial payment may be applied to the order's ticket 

Security Deposit:  Display the payment form for a security deposit 

Minimum    _______     $ _______ ...The shop may require a minimum financial transaction be 
made on a order's ticket, before it is considered an valid order.  This financial transaction 
may be in the form of a partial PAYMENT or SECURITY DEPOSIT.  In addition a 
minimum dollar amount may be enforced, i.e. $20.  The order is not valid until the 
minimum dollar amount is received. 

Reports or Views that indicate whether a security deposit has been paid will enforce the 
minimum security deposit rule set here, even if the net price of the rental order is $0.00  For 
minimum price setting, the payment must be equal the min payment set here or equal the 
price of rental order, whichever is  lower for the order to be considered valid. 

The payment form will automatically ask the user apply a portion of a payment to a security 
deposit when a security deposit (in this option) is required and the order's ticket does not 
contain a security deposit.  For example, a rental order is created for $100 and the business 
requires a $20 security deposit.  When the order is SAVED the operator requests the 
payment form and enters a $50 cash payment.  The payment form would then ask the 
operator if they would like to apply $20 of the payment to the security deposit, if the operator 
answers YES then the $50 payment would be $30 partial payment on the order's ticket and 
a $20 security deposit. 

 

System Setup - Rental Production Tab 

This tab is only enabled for WinTPS software installations.  
 

Prompt for tracking number at shipping… Will ask for the shipper’s tracking number for the 
shipment batch. The trqcking number can be manually entered or scanned. The tracking 
number will be automatically entered for each order within the shipment and is available 
to see on the rental order details screen. 

Prompt for location at laundry return… Defaults the Return Items from Laundry "Prompt for 
Location?" to enabled.  This prompt allows the printing of Laundry id tags and the 
changing of the item's location information. .  The laundry tag is a ID tag that contains the 
style, size ID/Serial number, Location 1 & Location 2 plus any comments. The tag can be 
attached to items as they are returned from laundry. Useful for production clerks to see 
the proper location of the item in the warehouse. The comments are good for current 
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measurement information or other helpful details.  , i.e. warehouse location and/or 
outseam length etc.   

Check on-hand qty for pick tickets…At picking ticket print time the system can check to insure 
the quantity of items printed on pick tickets is currently in inventory available for 
assemble. If not, the pick ticket will not print when this option is enabled. 

Print sub-rental return packing slips…WinTPS can track the serial/control numbers of sub-
rented items that have been returned to vendors, via the Sub-Rental Return form 
(SUBRET form). If this option is checked, WinTPS will print a packing slip each time a set 
of items is returned using the Sub-Rental Return form 

Print pick ticket from order form?.. WinTPS feature. Controls whether WinTPS asks to auto-
assemble an order on the Rental Order form (RESVMAST) If saving a rental order on the 
Rental Order form (RESVMAST), and the order is to be assembled within 7 days, and the 
status is Confirmed, WinTPS will prompt to print a picking ticket for the order. 

Allow Rental Qty to greater than on-hand qty?... A rule of the system is that Rental inventory 
quantity on hand should equal or be less than the quantity in the inventory SCW form for 
each size. WinPOS will display a message and stop the user with this setting unchecked 
when a larger quantity is entered for the rental size.  Checked this rule may be ignore and 
the user is not stopped.  It is important, for inventory value computations, to manually 
synch the quantities to insure they match via the Rental Inventory synch in Inventory 
Maintenance. 

Apply late fees to retail accounts when returning in production?... Enabled, WinTPS will 
charge late fees to retail store customers when Returning an order from the production 
switchboard via Return by Serial or Return by Order, and the orders pickup location is a 
retail store/account. 

User must enter rental order number on wholesale orders?... Normally, WinTPS 
automatically generates all rental order numbers in a sequence. When this option is 
enabled the user will be prompted to enter the rental order number for wholesale orders 
when a new wholesale order is created from the Production Wholesale Order Entry form. 
 This number will automatically be pre-pended with the wholesale account's account 
number, an account with number 300 would result in a order # of 300-XXXXXX.  Order 
numbers may be a maximum of 19 alpha-numeric characters including the account 
number.  Wholesale order entry is an optional feature of the WinTPS production software. 

Retail accounts can view wholesale orders via the Orders form?... Checked, a user using a 
register assigned to any Retail type store can view rental orders with a Wholesale 
store/account type assigned as the Pickup location via the Rental Orders form found on 
the main menu.  The Store/Account type is set within the Housekeeping-> General 
Setup-> Stores-> Rental tab-> Pricing/Type field.  This setting is usually utilized by single 
store operators. 

Use DOW picking ticket printers?... This option, when checked will allow a operator to setup up 
to seven (7) printer destinations for the printing of Production Tickets, i.e. a printer for 
each Day Of the Week.  Some operators like to print a different color Production Ticket 
for each day as a tool to manage the warehouse production. 

Print Laundry Return Report ? (drop down)… This option allows for a audit report to be printed 
of all items returned within the WinTPS production module via the Return by Item function 
during a single session. 

Never – Never print a report. 

Prompt – Prompt the user to print the report. The user can choose not to print. 

Always – Always print the report.  
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Sort Pick Tickets… WinTPS feature. Allows production picking tickets to be sorted by a 
specified bit of information. Use the fields drop down to locate and select the sort order of 
all production tickets. Use to more efficiently perform production. 

Laundry Days…WinTPS feature. The number of days the system needs to use for reserving the 
inventory items on rental orders. See What is Availability for more information. 

Payment terms (days) for statement aging...The number of days used for aging on wholesale 
account statements. For example enter 30 for:, Current, 30 days, 60 days, 90 days aging 
on statement or 15 for: Current, 15 days, 30 days, 45 days aging. 

 

 

Invoice…WinTPS feature. Selects the invoice format to use. By default, WinTPS uses Standard. 

Invoice copies... Place a default value for the number of invoice copies needed with printing 
wholesale account invoices. 

Packing slip copies...Place a default value for the number of packing slip copies needed with 
printing packing slips during the process of shipping rental orders. 

Recap rental order on invoice... Enabled, each order's detail  is recapped on the invoice that 
contains that order.  The order's style, description, serial number assigned and size are 
printed. 

 

Statement…WinTPS feature. Selects the statement format to use. By default, WinTPS uses 
Standard.  

 
The standard statement when printed from the menu Rental Production->Print Statements 
batch function will automatically print in detail and include the Invoice number, rental order 
numbers on each invoice and the rental items contained on each order.  However a 
Summary statement is printed when the Standard Statement is printed from the Rental 
Production->Store/Accounts->Invoices->Reprint Statement function.  This summary DOES 
NOT include the rental items contained on each order. 
 
Also available are Aging, and Age/Paid.  Aging shows outstanding invoices, aged according 
to the number of days set in Payment terms (days) for statement aging.  Age/Paid does the 
same, but includes invoices with a zero balance. 

Picking ticket…Used to select an alternate picking ticket, if alternate picking tickets are installed. 
By default WinTPS uses “Built-In Single Page.“ 
 
Alternate picking tickets are installed in the WinPOS data USER folder. They consist of 
two files, where the filenames start with RP_PICK and one file has an extension of FRT 
and the other FRX.  
 
For example, a 2 per page picking ticket might consist of the two files: 
RP_PICK_TWO_PER_PAGE.FRT and RP_PICK_TWO_PER_PAGE.FRX. 
 
A fixed format picking ticket will have a –F at the end of the filename, for example: 
RP_PICK_FIXED-F.FRT and RP_PICK_FIXED-F.FRX.  Fixed format picking ticket has a 
specific line position for rental item types.  For example the COAT may always appear 
first on the picking ticket, no matter what position is shows on the on-screen rental order. 

 

Shipping Methods… WinTPS feature. Rental orders are shipped to stores/accounts by some 
method, i.e. Van, UPS, FedEx, Greyhound bus ..etc. These methods and ship times need 
to be defined so WinTPS can compute how long a rental order’s inventory items will not 
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be available for other orders.  Asm is  total days needed to assembly a order including 
days in transit to reach a account for a specific ship method.  Ret days is the total time, 
including shipping, to receive the order back from the store/account.   

Ship methods may also be entered for each specific store/account on the Stores form.  Ship 
methods entered on the store/account form for an store/account  override these system ship 
methods.  Please see the What is Availability topic for additional information. 

Description: A name for the shipping method. 

Asm Days: This is the number of days required to assemble and ship the order to the 
account. The system automatically applies the ASM days when an order entry operator 
chooses a shipping method for the order.  

RetDays: This is the number of days required to receive the order from the account, 
including shipping, time after the Return Date.  

Default: Only one method can be checked. All rental orders, when first created, will first 
have the default shipping method automatically entered.  The user may select a 
different shipping method while on the order if needed. 

Sat:  Can this ship method be used on Saturday shipping?  Enabled it can. 

Sun: Can this ship method be used on Sunday shipping?  Enabled it can. 

Register Setup 

Switchboard: Main->Housekeeping->General Setup->Register Setup  

Menu: Setup->General Setup->Register Setup 

Action: REGSETP 

 

This form lets each register within a store(s) to be customized. Each computer/terminal is 
considered a register. The register is added automatically when the application is started for the 
first time on each computer in a Peer to Peer network implementation by WinPOS® as it asks 
for a Workstation name. This form has an add button and is used most often in thin client 
network implementations to pre-add the login accounts of terminals that will access WinPOS©. 

In terminal server/multi-user installations the workstation name (peer to Peer networks) or login 
user name (thin client networks) is the value that WinPOS© will match within the Register 
database.  A error message will result to the user, "Name is not found with finstate", when a 
match cannot be made. 
 
Fields 

WinPOS® Data Directory...Shows the data path for the WinPOS® data files. 

Register is located at store number…This field appears when the optional WinPOS® Multi-
store feature is installed. Store locations are created within System/Store Set-up & 
Stores/Accounts Maintenance. Registers are assigned to stores when the Register is 
created. This allows WinPOS© to identify which store sales, events & customers are 
created. This field is required to have a valid store id entered for proper system operation 
in a multi-store installation. 

With adequate security privileges a user logged onto a register can temporarily change that 
register’s location & name by using the File->Switch Register/Store function.  

Department...The department where this register is located. Most shops don’t need to use this. 

Credit Card ID...This is a sequential number that identifies the workstation to IC Verify or PC 
Charge for Credit Card Integration. Both ICVerify and PC Charge (the two supported 
credit card processing software packages) are licensed by the number of registers that 
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will be using the software. It is a good idea to start numbering the registers at 1. This 
number must be unique for each workstation, and this number cannot exceed the number 
of licenses for ICVerify or Go. So, if you had a five user license for ICVerify, your 
workstations would be numbered 1-5. A register numbered 6 would not work with 
ICVerify. See the Optional module Electronic Payment integration topic for more 
information. 

Station name...The name that uniquely identifies this computer/workstation. This name prints on 
the receipt, and is logged to every transaction rung up on this workstation. After the 
register name is the status (Opened or Closed) and the date/time and the sales associate 
ID who opened or closed it. 

 

Taller grid rows (for Touch screen)...If Yes, WinPOS® will adjust the size of some of the fields 
on the forms to make it easier to use with a touch screen. 

Use popup keyboard...Future Feature. If Yes, WinPOS® will display an on-screen keyboard if 
you click on a text field on the screen. This is used with touch screens if you don’t have a 
keyboard. The on-screen keyboard is not as practical is a physical keyboard. 

Disable special effects...Disables desktop themes in XP & Vista that causes intermittent display 
issues within WinPOS©.  Recommended setting is checked. 

Maximize important forms...Causes the Customer,Event,Prospect, and Appointment forms to 
display at full screen size automatically. 

 

Do not check indexes at startup...If No, WinPOS® will check all it’s index files once per day, as 
part of the startup routine. This is a good preventative measure to take. 

Show Production Only switchboard? (checkbox)...A security feature that when a user is 
logged into this register they will only be presented the optional WinTPS© production 
menu & allowed only to access functions pertinent to rental production.. 

 
Remember login name at main menu? (checkbox)...A timesaving feature to reduce the system 

prompts for user name & password when moving about WinPOS©.  When a user is 
logged into a register with this setting enabled the system will remember user 
name/password once it is entered.  Thus, when the user moves about the system it will 
not prompt again, UNLESS the user's current user name/password does not have 
adequate security level to access the selected form. 

Validate city, state, zip (requires internet access)? (checkbox)...Feature that may be utilized 
within the Shipping module.  Enabled, WinPOS© will access the UPS™  computers via 
the internet and pass the address info.  UPS™ will provide an alert when they believe the 
address is not a good one. 

 
 
 

Receipt copies...The number of receipt copies to print at this register. If this is blank, or set to –1, 
WinPOS® will use the number of copies set for the store in System/Store Setup, located 
at Main->Housekeeping->General Setup->System/Store Setup->Other Settings Tab. 

Prompt for # of copies...If the number of receipts this register prints is set to 2 but you often only 
want one you can check this box and the program will prompt you for the number of 
receipts you want to print every time you print receipts from this register.  

Receipt format...WinPOS may use print a 40 or 80 column receipt format on a register by 
register basis.  Choose SYSTEM to use the receipt format set within the System/Store 
Setup. 
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Fitting ticket copies...The number of copies to print for fitting tickets. Only applicable if you have 
the Custom Fitting optional module. 

Highlight cursor color...A number that specifies the color to use if Highlight cursor color is 
checked on Housekeeping->General Setup->System/Store Setup->Setup Tab. Use the 
lookup button (binoculars) to select a color. 

 

 

Credit cards only...If Yes, this workstation can only ring up credit card tender types. No cash, 
checks, etc. 

 

Cash drawer...If Yes, this workstation has a serial cash drawer attached. The cash drawer can 
be opened from Register Functions->Cash Drawer Open, or using the No Sale button on 
the Ticket form. The Cash drawer port must be set as well. 

Cash drawer port...The port ID determines the type of drawer that this register will be using and 
the physical PC's I/O port the cash drawer is attached.   

There are three type of drawers that WinPOs is capabile of using,  

1. Those that work off serial communications ports, i.e. com1, com2 ..that is direclty 
attached to a PC.    WinPOS supports up to communications (Com) port  9. 
 WinPOS can support many manufacturers f these drawers.    

2. Those that attached to a USB port.   USB port drawers use a proprietary program 
that is installed with WinPOS.  WinPOS supports three major manufacturers: APG, 
 MMF and MS.   For MMF choose either MMFUSB0 or MMFUSB1.  For MS choose 
either  MSUSB0 or MSUSB1 based on the dip switches on the drawer used.  For 
APG look for APGUSBn, where n is 1 thru 10 for the USB port number auto 
assigned by Windows.  MS USB drawers require MSPOS_USB.DLL to be present 
in the WinPOS© program folder.  USBCR.DLL is required for MMF USB drawers 
and USB554.DLL for APG drawers.  These files are installed with WInPOS©. 

3.  Those that are networked based (TCP/IP) and are not directly attached to a PC or 
terminal, but are attached to a network switch.  Networked drawers must be 
assigned a static IP number.  These type drawers also use proprietary commands 
and  WinPOS supports only the AGP manufacturer.   No software is installed.  AGP 
offers a Windows setup program, APGCdRelUtil.EXE,  for it's configuration to the 
store's network which is available on a CD or from BBL's website.  Instructions for 
it's setup & use are: 

1. Connect the cash drawer to the subnet 

2. Connect the power adapter to the cash drawer 

3. Launch APGCDRelUtil.EXE 

4. Click 'Scan' to discover each cash drawer on the subnet 

5. Select the cash drawer. 

6. Click 'Monitor' to run the basic cash drawer functions of  

• Open Drawer 

• Get Status 

• Get Log 

• Clear Log 

7. Click 'Details' to reveal: 

• IP Address 
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• SubNet Mask 

• GateWay 

• MAC Address 

8. Click 'Configuration' to change the IP Address to static 

 

Baud...Used for serial cash drawers (not a USB or TCP/IP), you can specify the baud rate to 
communicate with the cash drawer. If left blank, WinPOS® will use a default value of 
9600. 

ASCII char...The DEC ASCII value of the character to send to a serial cash drawer. If left blank, 
WinPOS® will default to @. See charts at the end of this topic. 

# of chars...The number of characters to send to a serial cash drawer. If left blank, WinPOS® will 
default to 5. 

Cash Drawer IP... Used with networked cash drawers.  This is the static IP number assigned to 
the drawer.   

Force user to close cash drawer (checkbox)... Available when using a USB or Network TCP/IP 
cash drawers.  Checked, WinPOS© will NOT continue when cash payments are tendered 
until the drawer is closed.  As a cash payment is entered the cash drawer will auto open 
so the cash may be placed in the drawer.  WinPOS will not continue, clear the screen 
and print a receipt until the drawer is closed. 

Open Drawer button... Will open the Cash Drawer to insure the settings entered are working. 

View Drawer Log...  For Networked TCP/IP printers.  This function will display a list of messages 
including when the cash drawers was opened and closed & how long the drawer was left 
open. 

Pin pad com port... WinPOS supports the Verifone PP1000SE & PP1000USB pin pads for debit 
card transactions via the optional PC Charge or IP Charge software.  USB devices are 
traditionally converted via the device's USB driver to appear to the computer and 
WinPOS as com ports.  The USB driver DLL is MsPorts.dll.  Technical information on 
Verifone products ma be found at: http://www.verifone.com/technical-support.aspx 

Pole Display com port... Logic Control LT9000 series displays (like the  LT9900-GY) are 
supported.  These displays do not require any special software or drivers to be installed. 
 WinPOS communicates directly to the display with Logic Controls own command 
language via the selected PC com port. 

 

Temp path…The directory where WinPOS® will save it’s temporary files. If left blank, WinPOS® 
will use the default Windows temporary directory. You would only need to change this 
under the direction of customer service. 

 
Plant Rad File...  Path to BBL's DOS TPS© program for status updates.  Used only when using 

WinTPOS© with DOS TPS©. 

 

 

ASCII VALUE CHARTS for serial cash drawer setup reference  
 

Char Dec Comments Char Dec Comments Char Dec Comments 

NUL 00  NAK 21 ^U No 
acknowledge 

* 42 asterisk 
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SOH 01 ^A (control 
A) 

SYN 22 ^V + 43 plus sign 

STX 02 ^B ETB 23 ^W , 44 comma 

ETX 03 ^C CAN 24 ^X - 45 dash/hyphen 

EOT 04 ^D EM 25 ^Y . 46 period 

ENQ 05 ^E SUB 26 ^Z / 47 slash 

ACK 06 ^F 
Acknowledge 

ESC 27 ^[ Escape 0 48 zero 

BEL 07 ^G Bell or 
tone 

FS 28 ^\ 1 49 one 

BS 08 ^H 
Backspace 

GS 29 ^] 2 50 two 

HT 09 ^I Horizontal 
Tab 

RS 30 ^carat 3 51 three 

LF 10 ^J Line Feed US 31 ^_ 4 52 four 

VT 11 ^K Vertical 
Tab 

SP 32 Space 5 53 five 

FF 12 ^L Form 
Feed 

! 33 exclamation point 6 54 six 

CR 13 ^M Carriage 
Return 

" 34 double quote 
html: &quot; 

7 55 seven 

SO 14 ^N # 35 pound or number 
sign 

8 56 eight 

SI 15 ^O $ 36 dollar sign 4 9 57 nine 

DLE 16 ^P % 37 percent : 58 colon 

DC1 17 ^Q & 38 ampersand 
html: &amp; 

; 59 semicolon 

DC2 18 ^R ' 39 single 
quote/apostrophe 

<  60 

 

less than 
html: &lt; 

DC3 19 ^S ( 40 open parenthesis = 61 equal sign  

DC4 20 ^T ) 41 close parenthesis >  62 greater than 
html: &gt; 

 

 

 

Char Dec Comment Char Dec Comments Char Dec Comment 

? 63 question 
mark 

T 84  i 105  

@ 64 at symbol U 85    j 106  

A 65    V 86    k 107  

B 66    W 87    l 108  

C 67    X 88  m 109  

D 68    Y 89    n 110  

E 69    Z 90    o 111  

F 70    [ 91 left bracket p 112  

G 71    \ 92 backslash q 113  

H 72    ] 93 right bracket r 114  

I 73  ^ 94 caret s 115  

J 74    _ 95 underline t 116  
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K 75  ` 96 grave accent u 117  

L 76    a 97  v 118  

M 77    b 98  w 119  

N 78  c 99  x 120  

O 79    d 100  y 121  

P 80    e 101  z 122  

Q 81  f 102  { 123 left brace 

R 82    g 103  | 124 vertical line 

S 83  h 104  } 125 right brace 

 

Char Dec 

~ 126 

DEL 127 

© 169 

™ 153 

® 174 

 

 

Stores/Accounts 

Switchboard: Main->Housekeeping->General Setup->Stores 

Menu: Setup->General Setup->Stores 

Action: STORES 
 

Overview 

The Store/Account form twos three purposes.   

1) Create and maintain a location code and setup information for every company owned store. 
 Even REQUIRED for one location implementations. 

2) Create and maintain a location codes and account  information for rental wholesale accounts. 
 This feature is needed with the OPTIONAL WinTPS rental production software module with 
accounts receivable. 

Information needed are tax rates, address, integration options and other operational data. 

This form must contain an entry for each store location owned. Use of this Stores/Accounts form 
can be restricted via the RESVCHNG security.  

Note 

For WinTPS implementations.  It is HIGHLY recommended that Service Center/Warehouse 
Registers (workstations) should be set to the Service Center/Warehouse production 
store/account location code created in this form and this store/account location should be set 
to a Pricing/Type of WHOLESALE.  This is to allow the Service Center to have it's own 
inventory, notably the rental inventory.  Additionally some forms (programs)  behavior is 
altered when the register/workstation performing the task is set to a location with a 
Type/Pricing setting of WHOLESALE.  See Type/Pricing field definition within this topic for 
more information. 

 

Retail Info 
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The information on the form's Detail and Options tab must be completed for retail only stores 
even if you have only one location. Rarely will this information have to be modified once this 
information is entered.  So visits to this form will be infrequent.  Ignore all rental information if 
the WinTPOS or WinTPS options were not purchased. 

 

Rental Info 

Stores are company owned retail locations that sale and/or rent inventory items to retail 
customers that may or may not be part of events and pay via retail sales tickets. Accounts are 
other companies that rent or purchase inventory items and pay via invoice or COD (wholesale). 
In addition, this form will contain those retail customers whom are invoiced for their rentals and 
purchases. 

The information on the form's Detail, Rental, Rental Addresses and Options tab must be 
completed. 

Creating a rental order requires the order PICKUP store/account (where order needs to be sent 
for the customer to pickup) and order ORDERED AT store/account (the location that took the 
rental order) to be entered. The PICKUP and ORDERED AT store/accounts may be different 
locations and are selected from the store/accounts created within this form. 

The Pickup store/account entered for an rental order controls the characteristics of the order, 
i.e. pricing, shipping methods, status changes, rental taxes etc. 

Hint: 

Rental Orders may be created for company owned stores by the Service Center or by the 
store itself via the optional WinTPOS Point of Sale software or by just entering them in the 
included Rental Order entry form from the main menu.  

BBL recommends wholesale Account rental orders to be entered from the Stores/Accounts 
form (this form being described within this topic). 

Wholesale Account Support 

The Stores/Accounts form will be the screen for ALL wholesale order entry and wholesale 
account management. The form allows existing invoices to be viewed & printed/re-printed, 
sales to be created, existing rental orders to be reviewed, new rental orders created and 
payments processed. This form becomes the central focal point for wholesale account 
customer service. 

Use of the Stores/Accounts form can be restricted via the RESVCHNG security. A user can 
click the New Sale, New Rental, or View Rentals button without any special security. 
However, it requires RESVCHNG security to click Payments or Invoice, and to make any 
changes to the store/account information. 

Field Definitions 

 

List tab 

Lists all the stores/accounts entered within the system and provides the mechanism to locate & 
highlight the needed location. By default the location can be found by typing in it’s name. 
Optionally the Account number may be used to locate the store/account by double 
clicking and it moving to the leftmost column. Once the desire store/account is highlighted 
the form’s tabs displays that accounts information. 

  

Details tab 
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Store number...A unique code that identifies this store or account that is manually created by the 
operator. 

Store name…The name of the store/account 

Address 1 & 2, City, State, Zip…The mailing address of the store/account. 

Phone… Phone number 

Fax… Fax number 

Contact name…The primary contact’s name. 

Email… The primary contact email address. Double click the email address to automatically bring 
up your computer’s defined email client software with the email address already entered 
in the TO field. 

PO Ship to Address 1 & 2, City State, Zip… Option for optional multi-store module. The 
shipping address for this store location that will be printed on Purchase Orders as they 
are created within the system. 

Account/routing number...Enter the bank account and routing number that you want to print on 
the deposit slip. The deposit slip is for reference only, a bank cannot actually use it to 
make the deposit. 

Store open cutoff time...If the store is opened for a particular Business Date, and it’s after the 
time specified here, WinPOS® will warn you that you may have forgotten to close the 
store for the prior date. 
 
For example: The store is open for a Business date of 1/15/2001, and the store open 
cutoff time is set to 3:00 (3am). If you start WinPOS® at 3:25a on 1/16/2001, the program 
would warn you that the store is still open for the Business date of 1/15/2001. If you start 
WinPOS® at 1:30am it would not warn you because it is not yet 3am. 

Disable open Close for this store? (checkbox)...This settings will not require this store to 
perform a store Open/Close routine irregardless of the system's open/close setup 
requirements as defined in the System Setup - Options Tab. 

Notes Button…A place to type in any information about the store or account. 

Region...Region is a geographical code that may be assigned to this store.  Some reports may 
be filtered by Region code, which would includes data for all stores that are assigned to 
that Region code. Optionally a Region may be assigned to a store.  See Region Topic for 
more information. 

Group... Group is a tool of the optional multi-store module to relate a group of stores (like a 
franchise).  Stores of an assigned group can view, edit and sell inventory of the same 
group.  Employee Time Clock entries can be edited from Store Registers of the same 
group register where the employee clocked in.  See Store Groups Topic for more 
information. 

Taxes, Retail 1, Retail 2, Rental 1, Rental 2, Wholesale 1, Wholesale 2...Enter up to two tax 
rates for retail sales or rental orders (only available for WinTPOS or WinTPS modules) or 
Wholesale (only available for WinTPS) module.  When two rates are entered both tax 
rates will be applied to sales.  Taxes collected/charged are shown on the Revenue 
Report and Sales Tax report.   
 
For each retail tax rate entered, the program creates a tax rate record, where the name is 
the store id, plus R1 or R2 for retail rate 1 or 2 respectively.  For rental, it is N1 or N2, and 
for wholesale it's W1 or W2.  It also creates a GL account with the same name, and links 
the GL account to the tax record. 

Note: 
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Additional rates (more than two) may be created via WinPOS Tax Rate and Tax Group 
forms.  Please contact BBL for assistance in setting these up when needed. 

Special Tax selection..  Several states have special tax requirements and  WinPOS can handle 
those when needed.  Currently MA, NY & VT has special routines for sales tax.  All 
others would select NONE. 

None:  No special tax computations 

Massachusetts:  only computes tax on the portion of the sales price greater than $175. 

New York:  will not charge tax on any item with a sale price of less than $110. Tax will be 
calculated on the full amount of the selling price for an item sold for $110 or more. 

Vermont:  will not charge tax on any item with a sale price of less than $110. Tax will be 
calculated on the full amount of the selling price for an item sold for $110 or more. 

See the topic Tax Rates for information on specialized sales tax computations. 

  

Rental Tab 

Pricing/Type.… Rental order pricing. Options are: Retail or Wholesale.  

Pricing is set for each item within Inventory - Details tab and the Catalog Codes (As 
Pictured) setup. WinTPS/TPOS allows for two rental price levels to be assigned to Inventory 
styles and Catalog Codes, described as Retail and Wholesale.  

The option selected in this field determines which price is applied to the order, Retail or 
Wholesale for this specific store/account. 

The assumption is that Retail will be for company owned stores who typically are renting to 
retail customers whom will be paying via a retail ticket. Wholesale is normally considered for 
accounts that are invoiced for their rentals & purchases, however you may setup a 
store/account that will be charge at retail pricing and invoiced for the rentals/purchases.  For 
example, the rental shop may have an relationship with a local hotel that sends employees 
over to rent or purchase items from time to time and wished to be invoiced for those 
purchases.   Typically you may charge the hotel retail and provides a markdown at invoicing. 
 This can be easily handled thru this setup. 

Additional discounts may be automatically applied to invoiced store/accounts via the 
Markdown codes & percentages described later in this topic. 

The pricing applied on an rental order is determined by the Pick-Up location entered on the 
rental order. NOT the location where ordered. 

The retail pricing is determined by the register's store id where the retail sale was created. 
 Store retail pricing on rentals is set via Inventory Rental Tab & Store Rental Pricing forms. 

 

Class… The class is the field that is used to categorize stores/accounts. Classes must first be 
defined using housekeeping-> General Setup-> Store/Account Classes.  Used with some 
reports and the printing of Picking Tickets. 

Retail Invoicing checkbox)?... Enabled allows rental orders and sales to be created via the 
WinTPOS© Main menu-> Retail Invoicing option  to these designated store/accounts. 
This is ideal for allowing retail sales personnel to create rental orders and retail sales to 
accounts that will be invoiced. As with all invoiced accounts the terms must be set and 
cannot be TICKET or NONE.  The pricing type may be WHOLESALE or RETAIL. 

Assemble orders to… WinTPS feature. Status that rental orders will become for the pickup 
location of the order when last item on the order is assembled. Stores that are co-located 
with the Production Warehouse will usually assemble to Received because the orders do 
not need to be shipped.  This status is assigned based upon the Pickup Location.  For 
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example, if this store is indicated as the Pickup Location, then the orders status will 
become what is entered in this field. 

Ship orders to… WinTPS feature. Status that rental orders will become when they are shipped 
to the pickup location of the order. A feature used for a co-located retail store that allows 
store personnel to skip the order receiving/QC step. This status is assigned based upon 
the Pickup Location.  For example, if this store is indicated as the Pickup Location, then 
the orders status will become what is entered in this field. 

Return order to… WinTPS feature. This setting applies to the location where items are being 
returned and is the Status that rental orders will become when they are returned.  The 
Register/Workstation performing the actual return is assigned to a store in the Register 
form.  This store code controls what status the rental order will become when returned. 

There exists two status selection options within this field that require explanation. They are: 
Laundry by Type & Wait Laundry by Type. Each of these options will check the Item Type of 
the item being returned and determine if the item should be cleaned upon returned from a 
order. When the Item Type laundry setting Auto-Launder item? Checkbox is enabled 
(checked), WinTPS will modify the order status of the item being returned to Wait Laundry or 
Laundry, depending on the selection otherwise the status will become Done. 

 The other status options for this prompt will force the item’s status to the status entered. 

Hint: The Store/Account where the terminal/PC is located that is performing the item 
return will determine the Return to status of the item(s) being returned. WinTPS looks 
up the Return to rule for the location of the terminal/PC performing the return.  For 
example, if register PROD1 is assigned to store/acct 01 and that register is returning an 
order, then the status setting for the order being returned is set to the RETURN 
ORDERS TO status defined for store/acct 01 

Print pack slip?…If checked, WinTPS will automatically print a packing slip when rental orders 
are shipped to this store/account (pick-up location on a rental order).  

Print Invoice at Ship time?… If checked, will print an invoice when rental orders are shipped to 
this store/account. Accounts with COD, Cash Only terms and accounts whom have 
exceeded their credit limit automatically print invoices at shipping. Enabled, this option 
will print the invoice at shipping irregardless of the terms or credit limit. 

Require Customer Card for orders, checkbox… Only Stores/Accounts assigned terms of 
Ticket or NONE can have this option checked. Rental Orders cannot be created without 
assigning an existing customer to the order. Assigning an Event is optional.  Terms of 
Ticket require Customer Cards and this option will automatically be enabled by 
WinTPS/TPOS  

Force return date to Mon if pickup, Wed, Thr, Fri, Sat. on single rental orders… This feature 
when enabled by checking will default all rental order Return date to Monday following 
the USE weekend if the pickup is Wednesday or after. 

Damage Waiver (checkbox)...  Checked (enabled) a damage waiver will be charged to each 
rental order placed to a Wholesale pricing type store/account.  Used in WinTPS for 
optional wholesale accounts. See the Damage Waiver topic for more information on the 
setup & use of damage waivers. 

Terms…Terms indicate how the store/account will be charged for the rental and sales 
transactions. Invoice, Retail Ticket or None (no financial transaction). 

Invoice Terms creates invoices for store/accounts that include descriptive information about 
prompt payment discounts & due dates (wholesale) OR  

Ticket creates retail sale tickets (for on-line retail stores with optional multi-store module) and 
REQUIRES "Require customer cards for orders?" option to be enabled (checked). 
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None will not create any financial transactions (used for remote stand alone stores manually 
entering their own rental orders). 

The terms that will create Invoices are: 

Cash Only (COD), COD, Credit Card (processed like Cash or COD), Net, X% EOM, Net 10 
EOM, Net 30, X% net 30,  

X% 10 Net 30, X% 20 Net 30, Custom 

 

WinTPS prints the payment terms on the invoice will age open balances on the Accounts 
Receivable Statement per the terms.  

Cash Only & COD Terms will create & automatically print a invoice when any rental order 
shipment is processed for the store/account.  

The Term None will indicate to WinTPS to NOT create a Sales Ticket & financial transation 
for a rental order. This is typically utilized for company owned stores where their rental 
orders are manually entered. This scenario is where the store is creating paper based rental 
orders. Operators would eventually enter the orders into WinTPS, but will not utilize it’s 
customer tracking capabilities. 

The Term Ticket is for company stores using WinTPOS software for customer tracking. This 
option will create the Sales Ticket and order transaction used to process payments and 
additional sales. 

 

Days… … Used by WinTPS for the Custom terms option. Prints the payment term days on the 
invoice for the account & uses the day for aging the statements. 

Discount… Used by WinTPS for the Custom and X% terms options. Prints the payment term 
discount on the invoice for the account. 

Credit Limit… WinTPS wholesale feature that allows a maximum credit limit to be created for 
this account. Once created the system will monitor and not allow shipping to continue to 
the account if the credit limit is exceeded.  

Rental markdown/Rental adj amt … The markdown code and adj. amt entered will be applied to 
every rental created for this store/account. The markdown will be applied when the 
invoice is created for the customer. The markdown code/adj amt is optional.  Leave blank 
for no discounts. 

Applies to... Options are Sales, Rentals or Both.  Instructs the system to what type of invoice 
transactions to apply the markdown discount to. 

Linked to Customer...(hidden) WinPOS© automatically creates a customer card for a 
Store/Account when the Store/Account is created.  This card may be viewed and 
modified by double clicking the displayed number code.  In most cases the customer 
record should be left un-changed. 

Credit (Display Only)… WinTPS© wholesale feature. This is the total credits due the account. 
This happens when the account has paid more that what they owe. Typically it appears 
when an adjustment was made to an invoice that was already paid. The credit can be 
used via the Payments form to apply the credit to other invoice balances or given as a 
refund to the account. 

Un-invoiced...WinTPS© wholesale feature. The total charges for all transactions that have not 
been invoiced.  This includes future rental orders that has not been shipped. 

Invoiced total...WinTPS© wholesale feature. The total amount of all invoices on file for this 
store/account. This total includes invoices paid as well as un-paid/open invoices. 

Invoice balance...WinTPS© wholesale feature. The total amount open on invoices from the 
store/account.   
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Balance (Display only)…WinTPS© wholesale feature. This is the total amount of all rental 
orders and retail sales that may or may not be delivered yet. The total includes rental 
orders not shipped. 

Total Retail purchases (Display only)…WinTPS wholesale feature. The total of all retail sales 
to this account since it’s creation. 

YTD Retail purchases (Display only)… WinTPS wholesale feature. The total of all YTD retail 
sales (a year is defined as Jan 1 to Dec 31) to this account. 

Last retail sale (Display only)… WinTPS wholesale feature. The last retail sales date to this 
account. 

Total rental (Display only)… WinTPS wholesale feature. The total of all rental revenue to this 
account since it’s creation. 

YTD rental (Display only)… WinTPS wholesale feature. The total of all YTD rental reveneue (a 
year is defined as Jan 1 to Dec 31) to this account. 

Last rental (Display only)… WinTPS wholesale feature. The last rental order created for this 
account.  

 

Shipping Method Grid … How will rental orders be transported to each store or wholesale 
account?  The shipping grid must contain the valid ship methods with the transit duration 
(in days) and whether the method may be utilized on Saturday or Sunday. 

Based upon pickup account, WinTPS will go to the shipping methods defined for the pickup 
account and select the method checked as the default.  When a default method is not 
defined, the user must select the shipping method from the list of methods entered in this 
grid for the pickup account.   

Once a ship method is selected WinTPS takes the order's pickup date and subtracts the 
assembly days defined for the shipping method to arrive at a order's Asm/Ship on date (this 
is the date the order must leave the service center to arrive at the store/account to meet the 
order's Pickup date (the date the customer will be taking the order)). When the Asm/Ship 
on date is a Saturday or Sunday, WinTPS will look at the shipping method's Sat & Sun 
settings.  When the Sat or Sun shipping method is disabled,  WinTPS will begin subtracting 
days from the Asm/Ship on date until it reaches a Non Saturday or Non-Sunday date. 
WinTPS next looks at the Non-Business Days defined (Non-business days are the dates that 
shipping will NOT take place) and continues backing up the Asm/Ship on date until the date 
is a good working date. 

When a store/account does NOT have any shipping methods defined within this grid the 
WinTPS system will check to see if system wide shipping methods are set.   System wide 
shipping methods to may be created in System Setup - Rental Tab.  

Shipping Method Grid 

Description: A name for the shipping method. 

Asm Days: This is the number of days required to assemble and ship the order to the 
account. The system automatically applies the ASM days when an order entry operator 
chooses a shipping method for the order.  

RetDays: This is the number of days required to receive the order from the account, 
including shipping, time after the Return Date.  

Default: Only one method can be checked. All rental orders, when first created, will first 
have the default shipping method automatically entered.  The user may select a 
different shipping method while on the order if needed. 

Sat:  Can this ship method be used on Saturday shipping?  Enabled it can. 
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Sun: Can this ship method be used on Sunday shipping?  Enabled it can. 

Grid Buttons 

Add Item button (Shipping Grid)…Allows a new shipping method to be created. 

Delete Item button (Shipping Grid)…Allows a shipping method to be deleted. 

 

Rental Addresses Tab 

 
Packing slip ship-to 
 
The address that will appear on a packing slip printed for this store/account. 
 
Address1,1 City, State, Zip...Enter the complete address info. 
 
Invoice remittance 
 
The address that will appear on a invoice as the remittance address when/if this store/account 

prints an invoice. 
 
Address 1,2,City, State, Zip...  The complete invoice remittance address. 

  

Options Tab 

Optional setup.  Used when electronic payments, like credit card processing, are integrated with 
WinPOS. 

 

Fields 

Credit card processing...The software you are using for credit card processing, only applicable 
if you have the credit card processing integration. Select IC-Verify, IC-Verify3 (if you are 
using IC-Verify version3 or later), or Go (PC Charge) or IPCharge/Payware Connect or 
Authorize.net.  Otherwise, select None. 

 

IC-Verify and IC-Verify3 

Processor...Select your processor from the list.  Additional processor codes may be added to the 
system when needed from the Credit Card Processors form. 

Merchant ID...RIFY by default. 

Credit card processing path...The PCCharge folder location where PCCharge is configured to 
look for it’s request and response files. Typically this is in the \PROGRAM FILES\PCCW 
folder. 

 

GO (PC Charge) 

PC Charge is installed locally and processes credit cards on behalf of the Profit System. 

Processor...Select your processor from the list.  Additional processor codes may be added to the 
system when needed from the Credit Card Processors form. 

Merchant ID...Enter your merchant ID.  
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Credit card processing path...The folder where IC-Verify looks for request files. 

Cashier...The cashier user name from PC-Charge 

Password...The cashier password from PC-Charge. 

Req file prefix...By default, the integration will create a request file called STA[work station 
number].INX.  For example, if the workstation number is 1, then the request file name is 
STA1.INX.  This setting allows the STA prefix to be replaced.  Enter the alternate prefix 
(such as USER) 
 
In PC-Charge the request file name must match a username.  So, if the request file name 
was STA1.INX, then there must be user STA1 in PC-Charge.  If, however, the user in 
PC-Charge was USER1, then this field should be set to USER, so the request file name 
would be USER1.INX 

Test CC integration...For ICVerify & PCCharge software integration testing.  The credit card 
integration should be tested after it is set up for the first time, or if any changes are made. 
 This button will test the integration by sending a credit card charge to the processing 
software.  If successful, a message will appear: "RESPONSE:", followed by the actual 
response from the processing software.  The credit card will actually be declined because 
it is invalid.  However, if the response is received it means that the communication 
between WinPOS and the processing software is working.  If a "NO RESPONSE:" 
message is shown, it means that the request file created by WinPOS is not being 
processed by the processing software. 
 
WinPOS will display a message as it is waiting for a response from the processing 
software, once it creates the request file.  This message will show the path where the 
request file is created.  This is useful to troubleshoot problems. 

 

IPCharge (Payware) 

IPCharge is an internet based payment service and it requires login information.  These fields of 
information will be provided by the bank processor and should be completed for each store that 
will be using IPCharge for electronic payments. 

User Name... 

Password... 

Merchant ID... 

Merchant Key... 

 

Auth.Net (Authorize.net) 

Obtain your account by signing up for service at this url: 
 http://reseller.authorize.net/application/?id=5555631     Authorize.net can provide a merchant 
account or you may use an existing merchant account.   When selecting an account type select 
CARD NOT PRESENT account.  The provides several benefits  1) you may use authorize.net 
for WinPOS to process cards in the store  2)  You may use the account on a eCommerce site to 
process cards and 3) You may save customer credit cards for later use by adding the Customer 
Information Manager option to the service. 

Authorize.Net is an internet based payment service and it requires login information.  These 
coded fields of information can be retrieved from the Authorize.net web console.    Once Logged 
in, choose Accounts-> Settings-> API Login ID and Transaction key to acquire the needed 
info.    

Login... 



General Setup 

59 

Trans Key... 

 

Shipping Tab 

Optional setup.  The ProfitSystem can ship directly with UPS, and through ShipRush for UPS or 
Fedex. 

 

UPS Integrated Shipping 

UPS Registration...This will bring up the UPS Shipping Registration form.  UPS requires 
registration via this form in addition to having an existing UPS shipping account and shipper 
number.  Once the process is completed shipments can be created via UPS Integrated 
shipping. 

 

ShipRush 

BBL offers the optional capability to interface directly with the UPS & Federal Express carrier’s 
computer systems. This interface requires the installation of the Shiprush Fedex & UPS 
software modules. The account numbers assigned to the shop/company by the Shipper (Fedex 
or UPS) and the Shiprush license code  numbers must be entered here for this software module 
to properly operate. 

The Shiprush software must be installed and setup on the shipping station that is also running 
the WinPOS© software.  The Shiprush software must be running and visible within the 
computers task tray.  WinPOS© will talk directly to the Shiprush software when shipments are 
processed via the WinPOS© shipping module. 

Once the optional Shiprush software module is purchased (two separate modules, one for 
Fedex & one for UPS) you will be provided a license code and serial number for each.  Install 
the Shiprush software, during which it will prompt for the serial number.  Once install enter it's 
license code number here.  Start the Shiprush software module, (Fedex or UPS) on the 
computer were the actual shipping will be performed and configure the software via it's setup 
menu.  Restart WinPOS© and attempt to process a shipment.  When all are properly configured 
the Shiprush system will display a shipping record (requests address, weight, service ..etc) 
 when WinPOS© is processing a shipment via the WinPOS© Shipping module.  

The Shiprush software requires an annual renewal.  This entitles the user to available Shiprush 
updates which includes carrier shipping rate modifications. 

Your  company must have a valid shipper’s account number with UPS and/or Federal Express 
to ship packages. Please contact those companies directly to sign up for account numbers.   

Note 

Remember to close the daily shipments via Shiprush's own management console, 
accessible via right clicking the Shiprush program in your computer's task tray. 

UPS Shipper number…Company’s account number with UPS. 

Fedx Shipper number… Company’s account number with Federal Express. 

UPS Shiprush serial number…Serial/Code number for Shiprush UPS software. 

Fedx Shiprush serial number… Serial/Code number for Shiprush Fedx software. 

Prompt for declared value checkbox…The Shipping module will prompt for the shipment’s 
declared value when the SHIP button is clicked. The value will default to the value 
entered within the optional Ship Rush module.  
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 Third party package insurance is available at a significant rate savings over the carrier’s 
insurance offering. The operator should not enter a declared value with the optional ShipRush 
software when third party insurance is utilized. This is because the carrier (UPS or Fedex) will 
automatically bill for the insurance when entered into the ShipRush module.   However, a value 
must be entered when prompted by WinPOS©.  This value will print on the WinPOS© shipping 
report which would be provided to the third party insurance company for computing a premium 
payment. 

Hint:  

The company should not use the ShipRush multi shipment feature when sending multiple 
packages to the same destination and using third party insurance. Each package must have 
a individual shipment entry within WinPOS®. This allows each shipment to have a separate 
tracking number and declared value within WinPOS® which satisfies the Third Party 
Insurance reporting requirements. 

  

Internet Tab 

 

Email Integration 

Optional setup.  Used when email is integrated with WinPOS. 

This section of the form accepts the company’s internet connection and mail service 
information. These details must be completed before the email features of WinPOS® will 
operate properly.  Email is an optional feature & must be activated by BBL prior to it's use. 

To test the information once entered, simply send a email letter to an employee’s (yours) 
personal email account and check to make sure the email was received properly. To this from 
the Word Processor form. 

SMTP mail server…The server address/name of your email service provider.  An example could 
be mail.bblsystems.com. 

Sender name…The name that should appear on the emails being set. Can be the company 
name. 

Sender email…The return email address of the sender. Some services providers require a valid 
sender email address, as an anti-spam control. 

Username…The log in name of the email account being used. 

Password…The password of the email account being used. 

Port... The port your email server works with.  The default is 25. 

Use SSL?... The ProfitSystem will use SSL to connect to the SMTP server. 

PO sender email... An alternate sender (from) email address used when emailing purchase 
orders. 

 

SMS Integration 

The ProfitSystem sends SMS message via email.  Normally, the email addresses will come from 
the sender name and email address above, under Email integration.  If the SMS 
message should come from another email account, enter those details here.  If these 
fields are left blank, the ProfitSystem will use the Email integration settings. 

Sender name…The name that should appear on the emails being set. Can be the company 
name. 
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Sender email…The return email address of the sender.  

Username…The log in name of the email account being used. 

Password…The password of the email account being used. 

 

Enable on-line MyInfo?…Turns the MyInfo integration on or off.  When checked, the 
ProfitSystem will send event and customer updates to the MyInfo data warehouse via the 
CM program running locally. 

Bridesmaids Self-Register URL?....The fully qualified URL to the bridesmaids self-registration 
page.  This can inserted into emails using the RegisterURL merge code for Customer 
emails.  This URL, when clicked, will allow the recipient to enter the members for their 
event.  Usually sent to the bride to register the bridesmaids.  The ProfitSystem 
automatically adds URL variables as follows: 
eventid=[base64 encoded event id number] 
bstyle=[BM style as specified on Extra tab of event form] 
bcolor=[BM color as specified on Extra tab of event form] 
 
This URL can be created by the shop, or hosted at BBL Systems, Inc. 

 

Buttons  

Delete Button...Deletes the selected store/account with the invoice balance is zero.  It’s linked 
customer record remains as well as orders and tickets/invoices for the deleted 
store/account.  Delete the linked customer record to delete orders & invoices. 

Add button…Allows a new store/account to be created. 

Save...  Save any edits made to the form. 

Cancel... Discartds any edits made to the form. 

Done button…Exits the form and returns to the previous screen. 

 

Printers 

Switchboard: Main->Housekeeping->General Setup->Printers  

Menu: Setup->General Setup->Printers 

Action: PRINTERS 

With WinPOS® you can specify a different Windows printer for each of the output types listed 
within this topic for each registered defined within WinPOS® .  

Select the correct printer from the drop-down list. The drop list contains all the printers installed 
for the PC/Terminal the user is currently logged on as. The printers selected are specific to the 
Register the user is logged in on. Printers should be defined for each Register. WinPOS® will 
use the system’s default printer for ALL print jobs where a printer is not assigned to the print 
function. 

NOTE to WinPOS® ASP customers 

When using BBL’s ASP service you must use Windows 2000 supported printers.  

If you are using Terminal Server, and your printers are automatically re-mapped at connection 
time, your printer names will change slightly each time you connect. This will cause a problem 
for WinPOS® since it will not be able to match the printer name the next time you connect. In 
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this case, when selecting your printers in WinPOS®, choose a word that appears in your printer 
name, and enter an “*” followed by that word for the printer in WinPOS®.  

For example, assume you have two printers, an HP Laserjet and an Eltron Zebra. One printer 
name is HP LaserJet 4L on LPT1/FRONTDESK/Session 2, and the other is Eltron Zebra on 
LPT2/FRONTDESK/Session 2. You would then enter *LaserJet as your Receipt and Report 
printer names in WinPOS®, and *Zebra for your Label and Tag printers. Now, the next time you 
connect, your printer names are HP LaserJet 4L on LPT1/FRONTDESK/Session 13, and Eltron 
Zebra on LPT2/FRONTDESK/Session 13. When WinPOS® starts, it will look for a printer that 
contains the word LaserJet, use that as your Receipt and Report printer, and the printer name 
that contains Zebra will be your Tag and Label printer. 

 

Note: 

There are two sections to the printer selection screen. On the left is a list of the CURRENT 
PRINTERS (Currently selected) for each print job type. The right side is the SET PRINTER 
where changes are entered by the user.  Always click CANCEL if no changes are to be 
made when the form is displayed.  If changes are being made click OK 

If the SET PRINTERS side is blank the system will always attempt to print all output to your 
windows default printer. 

Terminal Services 

When using print redirection software programs like Thinprint© or Screwdriver with Terminal 
Services  WinPOS© may start up before the printers are set.  When this occurs WinPOS© 
will display an error that no printers are configured and thus will only print to the default 
printer for that user.  This can be overcome by creating a system wide environment variable 
on the server.  In computer properties-> Advance Tab->  Environment Variables-> (in 
System Variables) create a variable called PRINTERWAIT and start with a 5 value ( = 5 
second wait) 

Fields 

Receipts...Receipts printed from the Ticket form. 

Tags...Garment and pickup inventory tags. 

Labels...Customer and prospect labels. 

Reports...All reports. 

Rental agree...The rental agreement is printed using the Print button on the Rental Order form 
(RESVMAST) (Available for WinTPSO® & WinTPS® optional software) 

Pickup rcpt...A pickup receipt can be optionally printed at rental order pickup time, from the 
Pickup (PICKUP) form. The pickup receipt is enabled or disabled using the “Print pickup 
receipts?” option on the Rental tab of the System/Store Setup form. (Available for 
WinTPOS® & WinTPS® optional software) 

Return rcpt... A return receipt can be optionally printed at rental order return time, from the 
Return (RETURN) form. The return receipt is enabled or disabled using the “Print return 
receipts?” option on the Rental tab of the System/Store Setup form. (Available for 
WinTPOS® & WinTPS® optional software) 

Picking ticket…Picking tickets printed from the Print Picking Tickets (PICK) form. (Available for 
WinTPS® optional software) 

Pick Ticket Option 

The Printer assigned to print Picking Tickets within WinPOS© is defined in the  Main-
>Housekeeping->General Setup->Printers form.  This setting may be overwritten by 
inserting a weekday name within the name of the printers available to the station printing 
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Picking tickets.  When a printer is available that contains a weekday in it's name WinPOS© 
will print the Picking Tickets to that printer WHEN the day of assembly matches the weekday 
name of the printer.  For example, say the operator is printing Picking tickets for the 
upcoming week.  Picking Tickets are being printed for a Monday assemble date.  WinTPS© 
will automatically  print those production tickets to an installed printer where it's name 
contains MONDAY.  WinTPS© will do this for each day of the week.  WinTPS© will print to 
the printer defined in the Printer Form when printers DO NOT contain the day of week within 
their name for the day being printed. 

The Day of Week option may be overwritten via the NoDOWPickPrint=YES setting in 
TPSWINS.INI file.  It will not use the day of the week printer with this setting. 

 

Invoices…Invoices for stores/accounts set up for invoice terms. (Available for WinTPS® optional 
software) 

Packing slips…Packing slips printed from the Shipping form (SHIP.) (Available for WinTPS® 
optional software) 

 

Security & Actions 

Security Groups 

Switchboard: Main->Housekeeping->General Setup->Security Groups/Permissions  

Menu: Setup->General Setup->Security Groups/Permissions  

Action: SECGROUP 

 

Overview 

This form lets you maintain Security groups and the group's permissions.   It is optional to use, 
but highly recommended for larger stores. 

Once security groups are created they are assigned to employees in the Sales Associate (SA) 
form.  Every SA added in the Sales Associate form are automatically made a member of the 
EVERYONE group.  The EVERYONE group does not have to be listed in the SA's security grid. 
 Any other security group the employee will be a member of must be listed within the Security 
Groups grid found on the Sales Associate form. 

What are Security Groups and Permissions?   A security group is a set of permissions.  A 
security group can be assigned to a Employee within the Sales Associate form and thus give 
him/her the permissions of the Group.  Multiple groups may be assigned to a employee if 
necessary.   

A User ID & password is requested when user moves thru out the system when security access 
is in effect.  Security is in effect when one or more employees do not have access to all parts of 
the WinPOS program. 

With security in effect a  user may be prompted for their ID and password.  As a valid 
id/password is entered WinPOS® will remember it as they move from form to form. If they reach 
another form that requires an ID/password, WinPOS® first checks to see if the remembered 
ID/password has permission to access the form. If so, it does not ask again. If their ID/password 
does not have access, WinPOS® tell them that they do not have access and prompt for another 
ID/password to see if a employee with access can enter their ID/Password. 

Once a user re-visits the main menu the User/ID is discarded. 

Note 
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Registers that have the setting "Remember login name at main menu?" enabled on the 
Register form will not have the Id/Password reset at the main menu.  This is a tool for office 
Registers so the user does not continually have to supply their ID/Password to move about 
the system 

 

List Tab 

The list tab displays within a grid the current security groups.  Groups may be added to deleted 
at any time.  (DO NOT DELETE the EVERYONE group).  Highlight the group to edit 
permissions for then click the Permissions tab. 

Example groups may be: 

Everyone:  The everyone group will have the least amount of access. All employees are 
automatically a member if the Everyone Group.  NEVER DELETE THE EVERYONE GROUP!  It 
is required by WinPOS. 

Sales Clerk:  Has customer & ticket access, but limited inventory capabilities and no reporting. 

Manager:  Has daily close access and some reporting access. 

Owner:  Can do everything. 

 

The default security group called Everyone and this group must NEVER be deleted. If this 
group has permission to perform an action, then WinPOS® will not ask for a password when 
someone tries to perform that action. If you want to restrict access to an action, revoke 
permission in the Everyone group, then grant permission in a different group.  WinPOS will warn 
the user when they try to click Done on the Security Groups form and there is an Action that no 
Security group has permission to perform. 

As a user moves through WinPOS® the program checks to see if the Everyone group has 
permission to perform each thing they do. If it does, WinPOS® will let them in. If not, WinPOS® 
will prompt them for an ID/password. It then checks to see which security groups that employee 
belongs to. Finally, it checks if any of those security groups have permission to access that 
action. If so, it lets them in. If not, access is denied. 

 

Permissions Tab 

Permissions are the specific program actions, menus forms and reports.  For example, the 
permission ACCTCLAS is a form name.  This is the name for  account classes editing form. 
 Each form displays it's name in it's top right corner.  When the name is not self explanatory use 
the WinPOS TRANSFER feature to jump to the  form the Security Groups Permissions tab to 
see what it is.   You can also click on the permission and a short description will appear in the 
memo box found on the bottom of form.   Enabled (checked) will allow access for the group.  If 
you know the name of what you are looking for, enter in the FILTER box found near the top of 
the form and click LIMIT to quickly jump to it.  Click clear to erase the filter to access any other 
security item. 

Note on Permissions 

Permissions that begin with SW_ are menus.  Permissions that begin with RP_ are reports 
 All others are form names or actions.  

 

Current Permission ACTIONS (most have descriptions in the Actions grid) are: 

 

CODE  DESCRIPTION 
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ALLSTORES  Multi-store optional module 
feature.  Allows access to all 
stores data across any store 
group. 

ADJCANC Adjust or Cancel on 
Tickets  

 

ALTPICKUP Pickup at Alternate 
Location 

Allows on rental orders for 
the order to be picked up at 
an alternate location (not 
your location) 

APPTNSHOW   

 

Process Appointment 
No-Shows 

Switch appointments to No-
Show if the customer never 
showed up. 

APPTSTAT Change Appointment 
Status 

Manually force a status 
change 

ASMSERLKP Use Serial Lookup on 
Assembly 

Use the serial number 
lookup on the assembly form 

BDATEBACK Set business date 
back 

Allows user to set business 
date to date previous than 
the current date at program 
startup 

CANCISSPO Cancel sale when PO 
is issued 

Allow user to cancel sale on 
a ticket, if item to be 
canceled has a PO issued 
for it 

EDITCREDIT Edit Store Credit for 
Customer  

Allow user to 
add/delete/modify transfer 
customer store credits.  All 
store credit transfers are 
logged 

EDITTICK Edit Ticket Line Item Allows editing of ticket line 
items directly 

EVDATEPO Update Event Date on 
All PO 

 Maintenance function to 
insure current wedding date 
is entered on any POs for 
the event 

EVENTDATE Change Event Date Allow event date to be 
changed 

EVENTDEL Delete Event  Permission to delete an 
event 

FITSTAT Change Fitting Status  Manually modify status of 
Fitting Ticket in optional 
Custom Fitting module 

FLORCECLOSE Force Closing Force all registers close 

HIDELINE Hide Receipt Line 
Items 

Allows user to use the Hide 
Line Items option on the 
tucket, located on the 
Adj/Canc/Extra Charge 
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button. 

HISTQTY Change Recv Hist 
QOH  

Allow add/edit/delete in 
inventory receive history 

HQMANAGE HQ Management  Controls whether user can 
change the customer for a 
rental after order is created, 
change event on rental after 
order is created, use receipts 
only mode(checkbox) for 
Revenue report, change 
customer for ticket. 

INVADD Add Permanent 
Inventory 

Allow inventory to be added, 
only! 

NVDEL  Retail Inventory 
Delete 

Allow inventory to be deleted 

INVPMT  Invoice Payments Controls ability to take 
payments on invoices, via 
the Stores form. 

INVRENTEDIT Edit Rental Inventory Controls access to the 
Rental tab of the inventory 
form 

INVUPDATE  Update/Delete Retail. 
Inventory 

Allow Add/Edit/Delete to 
inventory 

ITEMSTAT Rental Item Status  Access to directly edit the 
status of a rental item on the 
order 

LOGVIEW View Log View the rental order change 
history via the History button 
on the rental order form 

OPENDATE Set Date on Store 
Open 

Allow user to set business 
date when store opens 

OPENDRAW Open Cash Drawer  Allow for an attached 
electronic cash drawer to be 
forced open 

PICKSTORE  Pickup Inventory 
Store ID 

Allow the user to modify a 
the store id assigned to a 
physical inventory item 

POSCW Stock PO Line Items Allows whther stock PO line 
items may be directly edited 
using the View/Edit SCW 
button on PO Item 
maintenance 

PRINTFILE  Print to File/Excel  Allow reports to be exported 
to Excel 

PROSDEL Delete Prospect  Allow a prospect to be 
deleted 

PROSSA Change SA for a 
Prospect 

Allow the current SA 
assigned to prospect to be 
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modified 

PVCOSTUPD  Pickup Inv Item Cost 
Update  

Allows editing of the unit cost 
on a pickup inventory item 

QADDSTYLE Quick Add Style from 
Ticket  

Use the + button on the 
Ticket, which is the Quick 
Add Style. 

REFUND Refund on Ticket Allows a customer refund to 
be issued 

REGOPEN Register Open  allow user to open store 

RENTINV Rental Inventory  Access to the rental tab of 
inventory 

RESVCHNG Change Resv  Allows changes to a rental 
order's ASSEMBLY DATE or 
BACK DATE or SERIAL 
NUMBER (for quick 
exchanges) and the status of 
any line item may be forced 
to any other via the order's 
Change Status function. 

RESVDEL Delete Rental Order  Controls whether the user 
delete rental orders via the 
Delete button on the Rental 
Order form. 

RESVFORC Force Overbooking  Allows user to force a rental 
order to be confirmed even 
one or more items on the 
order is overbooked. 

RESVPRIC Allow Price Changes 
on Rental  

Allows the user to make 
price changes to a rental 
order. 

RESVSTAT  Change Order For 
Any Status  

WinTPOS/TPS© will not 
allow for a order to be 
modified once it's status has 
become PICKED UP, 
RETURNED, SHIPPED 
BACK, WAIT LAUNDRY, 
LAUNDRY, DONE, LOST  or 
CANCELLED.  This may be 
limited even more by 
entering additional order 
STATUSES in this field.  The 
REVSTAT security setting 
allows a user to override the 
statuses and make changes 
to the order.  REVSTAT will 
log order modifications under 
the RESVEDIT name 

RETLEDIT  Edit 
Style/Size/Color/Width 

Allow inventory edits on the 
SCW form 
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RNTPRCUPD Rental Pricing Update Controls whether user can 
view/edit the base prices for 
Rentals, Retail inventory 
items, or catalog codes. 

TAKEUNPAID  Take Unpaid Items Allow items with balance to 
be marked taken, override 

TICKPRICE  Change item price on 
Ticket 

Allow items price on sales 
ticket to be modified ast 
creation time overwriting 
Accounting Class setting: 
ALLOW PRICE CHANGES 

TICKSALES  Change SA on ticket Allow SA entered on sales 
ticket to be modified 

TICKTAX  Change Taxes on 
Ticket  

Controls whether the clerk 
can use the Taxes button on 
the ticket to change taxes. 

TRACKSTAT Change Tracked Item 
Status  

Limits access to Inventory-> 
Rental tab-> Rental Sizes-> 
View Serial Numbers  form 
for tracked rental Inventory 
Status changes and/or 
Available for Rental 
checkbox.  Enabled, a user 
can make those 
modifications. 

TRANSTAT  Change Transfer 
Status 

 Force inv. Transfer status to 
be force modified 

UPDISSUED  Update size/color 
ticket PO 

Update the size/color/width 
and special instructions on 
the ticket if the PO is issued 

UPDPICK Update Pickup 
Inventory  

Controls whether the user 
can update pickup inventory. 

UPDPOITEM Update PO Item  Controls whether the user 
can update the PO Item. 

UPDSERIAL  Update Serial  Controls the ability to change 
a serial number on rental 
inventory, on Rental Items 
form, located at Main-
>Housekeeping->Inventory 
Setup->Inventory->Rental 
Sizes button->View Serial 
Numbers button 

UPDSHIP Update Customer 
Shipping 

Allow user to change status, 
release for shipping, delete, 
update a shipped item, or 
change address confirm or 
docs info for a Customer 
Shipping item. 

UPGRADE  Upgrade WinPOS Allows the user to check for 
upgrades via the menu or 
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Upgrades button in 
housekeeping, and also to 
use the Update License 
menu option. 

USESECDEP Use Security Deposits  Allow use of security 
deposits 

VIEWCCARD  View Credit Card  Controls whether user can 
view credit card from ticket 
or event 

VIEWSTORES  View Data from All 
Stores  

 Multi-Store feature.  Allows 
access to all stores 
information within their 
terminal / register's  store 
group (if utilized) in multi-
store implementations.   

VOID   Void Ticket Allows user to 
delete tickets or ticket line 
items. 

   

 

Fields 

Security group name...A unique name for the group. 

Permissions...This is a list of all the actions in WinPOS® that can be secured. If Allow? Is 
checked, then the Security group can perform this action. 

Notes... Most actions are self explanatory.  A detailed description of the action may often be 
found in the notes box below the action list. 

 

Buttons 

Un-Check All...A short-cut to un check all the actions for the displayed Security Group. 

Check All...A short-cut to check all the actions for the displayed Security Group (make 
permission = Yes). 

Save... Save any edits made. 

Cancel... Discard any edits made to any data. 

Delete... Delete the selected Group. 

Add... Add a new group. 

Done... Exit the form and return to the previous form. 

 

 

 

Actions/Transfer table 

Switchboard: Main->Housekeeping->General Setup->Actions  

Menu: Setup->System Maintenance->Actions/Transfer 



WinPOS Version 11 

70 

Action: ACTIONS  

This is the master list of all the operations that WinPOS® performs. Many of these actions 
appear in the Permissions tab of the Security Groups/Permissions form.  There is normally no 
reason to add or delete or edit any actions from this list.  

This form allows users transfer to a form, menu or program within WinPOS.   It also may be 
used to allow users to perform specific sensitive tasks or start external programs from the Quick 
Launch menu from the WinPOS main menu. 

Actions may be optionally logged for user activity tracking.   

Use this form tell WinPOS® to track each time an action is performed.   You will need to locate 
the action CODE of the action you wish to log. 

For example, you want to track whenever someone deletes a ticket line item or a ticket. The 
action code is VOID, and the description is Void Ticket. Locate the action in the list and check 
the “Log successes to access this” option. Now, when you go to Log form you’ll see entries 
each time someone deletes a line item or ticket.   

WinPOS can include a special menu with links to external programs (such as Windows 
calculator, etc.)  To add programs to this Quick Launch menu, click Add on the Actions form and 
fill in the fields as follows: 

• Action code: 10 character code that describes the program (CALC for the calculator, 
for example) 

• Description: Description of the program. 

• Name: The full path to the EXE file (C:\WINDOWS\CALC.EXE) 

• Type: External App 

• Allow Transfer: None 

• Quick launch: Checked 

• Allowable operations: X 

• Show for: 96 

• Notes: Description concerning the action and it's features. 

 

Fields 

The actions/transfer form has two checkboxes "Log successes to access this?" and "Log 
failures to access this?".  Successes are logged as "Access" and failures as "Auth failure" for 
the Action/Task the options are checked for. 

Log successes to access this...If checked, WinPOS® will put an entry in the Log each time 
someone performs this action. 

Log failures to access this ...If checked, WinPOS® will put an entry in the Log each time 
someone tries to perform this action, but was unable to supply the correct SA ID and 
password. 

Action code...The code shown when setting up security, and on the username/password prompt 
if security is enabled. 

Description...What the action is. 

Name...Either the action code, or the full path and name of an EXE file to be run when the action 
is invoked. 

Type...Either Form, Application, Program, Function, or External App. 
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Allow Transfer...Either WinBPS, WinTPS, Neither or Both.  Controls whether this action appears 
on the Transfer form. 

Quick Launch...If checked, the option shows up on the Quick launch menu. 

Allowable operations...Should be an X if you can set security for this action. 

Show for...Controls whether the option will show up.  Should be 96 for most options. 

Notes...Longer description of the action. 

 

Log 

Switchboard: Main->Housekeeping->General Setup->Log 

Menu: Setup->System Maintenance->Log 

Action: LOG 

WinPOS® creates a log of system events that you can view from here. You can use the Actions 
form to indicate which actions you want logged. 

Time stamp...The date and time it occurred. 

Table...Only applicable to certain log entries. 

User code...The SA ID of the user. 

Description...A description of what occurred. 

Comments...More description. 

Type...The type of log entry. Some of the more common log entry types are documented here. 

• VOIDTICK...Someone used the Delete button on the ticket form to delete a ticket or 
ticket line item. 

• Access...If the “Log successes to access this” option on an action is checked, 
WinPOS® creates this type of log entry when the user accesses it. 

• Auth failure...If the “Log failures to access this” option on an action is checked, 
WinPOS® creates this type of log entry when the user tries to access it and fails. 

• EDITTICK... Logged as COSTTICK if the wholesale cost of a sale item on a ticket is 
changed. 

• Rental Serial numbers are manual changed in inventory 

• MTDRESET  - logs the Reset month to date / year to day function 

• EDIT... Changes to Timeclock entries 

• EDITEXTRA.. Logs any edits to a ticket's extra charges and private instructions or 
public instructions.  Includes changes to  price & cost.  

• DELEXTRA.. Logs any deletions to a ticket's extra charges and private instructions 
or public instructions.  Includes changes to  price & cost.  

• TICKSA: Code that record changes to a ticket's assigned Sales Associate (SA) 
fields.  A ticket may have up to three SAs assigned. 

• DELEVENT: Code where event deletions are logged. 

• COSTTICK: Code used when a operator edits the cost from a customer's sales 
ticket from the ticket. 

• EDITTICK:  Code used when a operator edits any details of customer's sales ticket 
from the ticket. 

• APPTEDIT: Any changes made to an appointment after it has been created. 
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Key...If the event affected a specific customer, ticket, etc. the customer ID, ticket ID are shown 
here. 

Letters, Email, Terms, Tags & Labels 

Letters, Tags, Mailing Labels 

Switchboard: Main->Housekeeping->Letters, Tags, Mailing Labels 

Menu: Setup->Letters, Tags, Mailing Labels 

Action: LETTERS 

 

WinPOS provides for  the use of  form text letters with data/merge, price tags / labels & mailing 
address labels to be utilized throughout the system.  In addition, with the BBL WinPOS 
marketing option, users may generate email letters utilizing the form text letters with data merge 
and HTML (Hyper Text Markup Language). Users may create new documents or edit existing 
ones to meet unique needs. 

Letters/Emails, tags and mailing labels are printed for customers, prospects, mailing list entries, 
appointment prospects and inventory. Tags are printed for retail, rental (laundry tag) and pickup 
inventory. You can create as many letters, HTML(eMail)  pages, tags, and mailing labels (also 
called documents) as you like. 

• Mailing labels are printed for customers and prospects. 

• Customer letters/emails/sms are used to communicate important information to 
customers and prospects. 

• Prospect letters/emails/sms are used to draw prospects back into the store. 

• Appointment letters/emails/sms are used to qualify, confirm and remind appointment 
prospects. 

• Garment/Price tags are printed to tag retail inventory.  

• Pickup tags are printed to tag pickup (or layaway) inventory. 

• Laundry Tags are printed by the optional WinTPS application during the laundry 
return of tracked items. This can be feature may turned off/on with the System/Store 
Set-up – Rental Production Tab. 

• Custom Fitting tags are printed within the optional BBL Custom Fitting module to be 
attached to item being altered.  

To print labels or letters for a single customer or prospect, click the Print button on the Customer 
form or Prospect form. WinPOS® will display a list of all the letters and labels defined with a 
source of Customer or Prospect, respectively. To print a garment tag, click the Print button on 
the SCW (size/color/width) form. To print a pickup tag, click the Print button on the Pickup 
Inventory form. To print a Fitting ticket select Print from the Custom Fitting form. Laundry Tags 
will print automatically, when the option is enabled within the WinTPS module, when items with 
Serial/ID codes are returned from laundry. 

A tag, letter or label is comprised of two parts.  

1. The WinPOS definition. This component defines what & where the Tag Label or Letter 
will be used. It is the Source, Type, Description & Subject (for emails). To create a new 
WinBPS definition click on the Add form button and enter the information. Once 
entered click Save and the information will display within the grid.  

2. The Tag/Label or Letter content definition. This is the actual content/information that 
will be the output. To create a new ‘content file’ highlight a Tag, Letter or Label within 
the grid and click the file button – Create Letter/Tag/Label. WinPOS® will prompt for a 
file name. Once the name is saved entered the Label Designer will be displayed for 
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Labels & Tags or the Word Processor will display for Letters. The operator will create 
the desired content within the editor. 

Form Fields 

Source...Select the source from where a document will be used in WinPOS®.  When a user is in 
the SOURCE form, i.e. Prospect or Customer or Appointment  ..etc) 
letters/labels/tags/emails/SMSs available will be displayed for that source so the user 
may select there one to use.  If only one entry for that source is created then WinPOS© 
will automatically select it.  Each source can be used with specific letter/tag types which 
are documented below.  A email/sms/label/tag will not perform properly when the source 
or type is not correctly set.. 

• Customer  (printer/(type: Letter or Labe, email or SMSl) Printed for customer.data 

• Prospect: (printer/(type: Letter or Label, email or SMS) Printed for a prospect. 

• Retail style (InvHeader) (printer/ type: Tag) DISCONTINUED FEATURE, SHOULD 
NOT USE 

• Retail size (InvDetail) (printer/type: Tag): Printed from the SCW (size/color/width) form, 
printed for a style, size, and color. Most shops use this source for garment tags. 

• Pickup (printer/type: Tag): Printed for an item in pickup inventory. 

• Retail Store (printer/type: Tag): Available for printing from View Store Statistics 
inventory form and required for Print Tag mass tag printing with optional multi-store 
feature turned on.  It can include store specific information as quantity and store 
statistics. 

• Fitting  (printer/(type: Tag): Available with the optional Custom Fitting software module. 
This source would make the document available thru the print option of the Fitting 
software. 

• Laundry (printer/(type: Tag): Available with the optional WinTPS Plant software 
module. This document would automatically print when items are returned from 
laundry (option must be enabled when WinTPS is installed). 

• Mailing (printer/ type: Letter or Label, eMail Printed for contacts contained within a 
mailing list. 

• Appoint (printer/type: Letter or Label, eMail or SMS)  Available with optional BBL 
Appointment module.  Users can send followup communication from the appointment 
form to the customer of the appointment. These documents  

Printer/Type...The printer field instructs WinPOS for the type of editor to utilize for 
add/modifications as well as the printer to use.  Printers for documents are setup in the 
Printer form within Housekeeping.  The document's printer defines which dedicated 
printer to use for printing for letters, tags and labels. Printers have to be assigned to each 
terminal/PC (in multi-user installations) for specific print job types in Housekeeping-
>Printers. 

• Letter: A mail-merge letter or Email (with optional email integration).  This will allow 
editing with the built-in WinPOS  word processor. It does default to a particular printer. 

• Tag: A pickup inventory ID tag, fitting ticket, WinTPS™ laundry or retail inventory 
garment tag are the examples of software  features that utilize labels. It will use the 
WinPOS built-in label/tag editor for modifications.  Ttags automatically print to the TAG 
printed defined in the Printer form. . 

• Label: A mailing label for a customer or prospect.  It will use the WinPOS built-in 
label/tag editor for modifications.  Labels automatically print to the LABEL printer 
defined in the Printer form. . 

• eMail: A HTML page for sending eMail messages directly from within WinPOS to 
prospects or customers or appointments.  With this printer/ type selected,  WinPOS 
will turn on it's WYSIWYG HTML editor for the creation of the document.  It will use the 
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WinPOS built-in HTML editor for modifications.  eMail does not automatically print to 
any  printer. eMails created here will become templates when choosing to send eMail 
to customers and may be chosen from the editor when sending the eMail from the top 
right template dropdown. 

• SMS: Maximum 160 characters of text.  The created SMS text becomes a template for 
the chosen source.  When requesting to send a SMS the user may type in any text 
then select the template text to be appended.  The templates are available from a 
dropdown in the top right corner of the form. 

Description...A descriptive name for the document. 

Subject (email)…Letters & eMail types may be sent as emails via the BBL Marketing option. 
 They will be sent with the subject entered here. 

File...Labels, tags, and letters are actually stored in separate files.  Letters have the HED 
extension and labels are two files with the FRX (the file selected for this form) & FRT 
extensions. These files should be saved in the WinPOS data USER folder. This field will 
display the name of the separate file selected for the highlighted Tag, Label or Letter. 

The system can also accept a file with the HTM or HTML extension.  This is a internet type 
HTML file that can be created with a program like Microsoft Frontpage to be used for eMails. 
 This file can contain graphics that are hosted at a web site and look like any other web 
page.  This file must also be stored in the WinPOS data USER folder. 

Emails sent from letters edited in WinPOS© will be converted to a TEXT only message with 
the font being Courier 10, underlining, bolding & other formatting ..etc will be lost when 
delivered to the recipient. 

 

File Buttons 

Select tag button...Use this button to select an existing Tag, Label or Letter file to be used for 
the highlighted WinPOS definition. This button will display a Windows file select dialog. 
Locate the content file to use and select it. It’s name will then appear in this field. 

Create tag/letter button...To create a new tag, letter or label file, click this button and enter a file 
name. Use a short, descriptive name such as ProspectOneMonth.   Once entered you 
will be taken to the Word Processor to create the letter or the Label Designer for Tags & 
Labels. 
 
Once a new tag, label or letter is created and saved it’s name should display within the 
FILE field. If it does not, select it via the Select Tag button for it to be inserted for use 
within the highlighted tag, label or letter. 

Edit tag button...Edits the highlighted Tag, Label, Letter or eMail content file. For labels, this will 
take you to the Label Designer to edit the label or tag. For letters, this will show the Word 
Processor to edit the letter. For TXT format letters, it will start the appropriate editor on 
the computer. For HTML documents the system will start the WinPOS HTML editor.  See 
the HTML manual for specific instructions on use.  

WinPOS will display a menu when creating a new eMail HTML page.  Once the Add/Edit 
button is clicked the system will present a sub-menu asking for a selection.  The options are 
designed to allow the new email to be created from an existing email page whereby the user 
could just do the minimum edits 

Existing eMail:  The system will display a Selector box of all the existing eMail documents 
to allow for the user to pick an existing eMail.  Once selected it's copied contents will be 
displayed within the WinPOS HTML editor whereby the user would edit appropriately. 

HTML File:  The system will display a Windows File Selector box allowing the user to 
navigate to any HTML file.  Once selected it will be copy the contents of the file and 



General Setup 

75 

displayed them within the WinPOS HTML editor whereby the user would edit appropriately. 
 Merge codes may be inserted into the HTML email. 

No Template:  This option will display the HTML editor with a BLANK page, allowing the 
user to create any page required. 

Graphic Note 

Graphics for HTML pages are stored on internet web servers.  Web servers include the 
server that hosts a bridal shop's web-site and also include servers from services like 
Shutterfly, Google Picasa and many others (many free, some paid).  Any that allow you to 
link to a stored image will work within the eMail document created from the WinPOS HTML 
editor. 

 

In versions up to WinPOS v9, a letter could be a HTML file.  In v10 and after this is not 
suggested.  The type of those Letters should be changed from Letter to eMail.  Once done, 
click Edit, the program will copy the HTML file from the hard drive into the eMail table and 
store it internal HTML page.  If will then rename the HTML file on the hard drive by adding 
.BAK to the filename.  (TrunkShow.HTML becomes TrunkShow.HTML.BAK)  Also, the field 
"File" is cleared on the Letters record so it's not confusing. 

 

Review the Special instructions for tag printing topic for more details on label & tag content. 

 

Form Buttons 

Delete…Deletes the highlighted WinPOS® tag, label or letter definition. Does not delete the 
content definition file. 

Add… Creates/Adds a new WinPOS® tag, label or letter definition. Does not add/create a 
content definition file. 

Done…Exits the screen. 

Tag printing Overview 

WinPOS® will allow you to use a variety of printers for your garment tags, pick-up tags, and 
mailing labels. We recommend using dedicated tag/label printers such as the Eltron or Zebra. 
These dedicated printers are designed to easily print one tag/label or a hundred tag/labels at a 
time.  While WinPOS® will support dot matrix or laser printers for tag/label printing, it can be 
problematic to get acceptable output. Since dot matrix are low resolution printers and are 
designed to print a line at a time they often have difficulty printing clear bar codes. Laser printers 
have higher resolution, but can only print a page of labels at a time, so you end up wasting 
labels unless you print a full page each time. 

The standard tags/labels come configured to print using a Eltron or Zebra tag printer. Here are 
some of the standard sizes. 

H = Height, W = Width 

• 1”H  X 3”W self-adhesive accessory label 

• 2”H X 4”W tag for garment tags and labels, in pink, blue, or white 

• 3”H X 4.25”W self-adhesive pickup label 

• .5"H X 2.2"W self-adhesive bell shaped jewelry label 

• 1"H X 2"W 4 up (divided into four .5"H X 1"W labels) self-adhesive accessory label 

If you want to edit the standard tags/labels, or use non-standard tags or labels you must 
configure the Windows print driver for your tag/label printer for the exact size of the tag/label you 
wish to print. See Print configurations within Letters, Tags, Labels. 
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Bar-code Readers 

Most tag/labels print a bar-code which utilize bar-code reader equipment.  Readers 
manufacturers use different technologies to read & interpret bar-codes.  As a result, a reader 
from a manufacturer may read a specific bar-code, but a read from another manufacturer 
scanner may not.   The good news is that WinPOS offers flexibility in how a bar-code prints out, 
i.e. density and size. As a result, the reader purchased by a store must be tested against the 
tags being printed to insure the reader can read the bar-code.  If it can't, the tag/label bar-code 
format must be edited and reprinted, then re-tested until the reader can read the bar-code 
reliability.  

Print configurations within Letters, Tags, Labels 

If you wish to edit the standard tags and labels, or you wish to use non-standard sized tags or 
labels, you will have to configure your tag/label printer driver for the correct form size. This is an 
advanced feature and a knowledge of basic programming (specifically, xBase programming) is 
very helpful. The standard tags and labels come pre-configured to work with Eltron or Zebra 
printers. 

Each time you edit a tag or label, you must confirm that the correct printer and paper size is 
selected (step 4 through step 11 below) 

1. Install your printer in Windows. Confirm that you can print a test page before 
continuing. If you cannot print a test page, WinPOS® will be unable to use the 
printer. 
 
To print a test page, click Start->Settings->Printers to display the Printers folder. 
Right-click on the printer and select Properties. On the Properties page click the 
Print Test Page button. 

2. Go to Main->Housekeeping->General Setup->Printers. Select the correct printers for 
Tags and Labels. Tags and labels will use the same printer. You will need to 
completely close the program and re-start it for the printer settings to take affect. 

3. Go to Main->Housekeeping->Letters, Tags, Mailing Labels and select the tag you 
wish to edit. 

4. Select the File Menu->Page Setup->Print Setup. 

5. Select the correct printer from the drop-down list. 

The following steps work for most print drivers. If your print driver is different you will have to 
contact your printer manufacturer and inquire as to how to set up custom form sizes. 

6. Click Properties. On the Paper tab of the Properties form, double-click the Custom 
or User-Defined paper size. 

7. Enter the width and height of the tag or label. 

8. Click Ok to close the Properties form. 

9. On the Print Setup form select the Custom or User-Defined paper size. 

10. Click Ok to close the Print Setup form. 

11. Click Ok to close the Page Setup form. 

12. Select the File Menu->Close. Confirm you want to save your changes. 

 

Standard tag/label sizes are as follows: 

                 Height x Width 

Pickup Tag = 3 in x 4.25 in 

Accessory Tag = 1 in x 3 in 
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Garment Tags = 2 in x 4 in 

Fitting Label 6" x 4" 

Bell Jewelry labels .5" x 2.2" 

Small 4 up Jewelry/Accessory Label 1" x 2.4"  (each label is cut in 4 smaller labels, so when 
printed the SKU of the inventory item is printed 4 times, great for higher volume) 

 

 

Label Designer 
Switchboard: Main->Housekeeping->Letters, Tags, Mailing Labels->Edit Tag/Label button  
Menu: Setup->Letters, Tags, Mailing Labels 
Action: LETTERS 

The label designer is a WYSIWYG editor &  lets the user make changes to the layout of 
garment tags, pickup tags, and mailing labels. You can add text to your labels, or add other 
fields. The Label designer is an advanced feature and requires a good understanding of 
graphical concepts and program logic. BBL is available on a consulting basis to help design & 
create the desired output. 

To change the contents of a field on the label, double-click on the field. The Report Expression 
dialog appears. You can then change the field name to the new one. Here are of the more 
common field names and their meaning. 

Within this topic is a explanation of a few of the more common field values customers like to 
print on tags.  Also within this topic are some program logic explanations. 

Fields from the Retail Inventory form 

DESCRIPTION FIELD NAME TYPE LEN 

Style code SISTYLECODE C 25 

Manufacturer 
style 

SIMANSTYLE C 15 

Stocked in store? SISTOCKED L 0 

Description SIDESC C 30 

Advertised SIADVERTISED L 0 

Location in store SILOCATION C 10 

Comments SICOMMENTS C 40 

Comment 2 
(Notes) 

SINOTES M UNLIMITED 

Vendor number SIVENDNO C 10 

Date discontinued SIDISCONTINUED D 0 

Accounting class SIACCTCLASS C 10 

Inventory class SIINVCLASS C 10 

Inventory sub-
class 

SINVSUBC C 10 

Date received ISDATERECV D 0 

Reorder quantity ISREORDQTY N 0 

Manufacturers 
discount (%) 

ISMANDISC N 0 

Retail factor % ISRETLFACT N 0 

Retail factor plus 
$ 

ISRETLFACTPLUS N 0 

Spiff amount ISSPIFFAMT N 0 
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Spiff type ISSPIFFTYPE C 6 

Activity ISACTIVITY N 0 

Retail price 1. 
Base sales price 
of the item. 

ISRETAIL1 N 0 

Retail price 2. 
Base sales price 
of the item. 

ISRETAIL2 N 0 

Markdown retail 
price 1. Retail 
price 1 including 
any promotional, 
markdowns & 
extra charge base 
price 
modifications. 

SSMKDNRETL1 N 0 

Markdown retail 
price 2. Retail 
price 2 including 
any promotional, 
markdowns & 
extra charge base 
price 
modifications. 

SSMKDNRETL2 N 0 

SSRETAIL1/2 & 
SSMKDNRETL1/2 
are tax inclusive 
when used with 
the 'Include tax 
with price, system 
setting". 

   

MTD Sold 1 ISMTDSOLD1 N 0 

MTD Sold 2 ISMTDSOLD2 N 0 

MTD revenue ISMTDREV N 0 

MTD cost of sales ISMTDCOSTSALES N 0 

YTD sold 1 ISYTDSOLD1 N 0 

YTD sold 2 ISYTDSOLD2 N 0 

YTD revenue ISYTDREV N 0 

YTD cost of sales ISYTDCOSTSALES N 0 

Total sold 1 ISTOTSOLD1 N 0 

Total sold 2 ISTOTSOLD2 N 0 

Life revenue ISTOTREV N 0 

Life cost of sales ISTOTCOSTSALES N 0 

Season code ISSEASON C 10 

Cost factor ISCOSTFACT N 0 

Cost creator ISCOSTCREATOR C 5 

Date last sold ISLASTSOLD D 0 

Last sold to store ISLASTACCT C 15 

Last invoice ISLASTINVOICE C 15 

Size chart ISSIZECHART C 10 

Color chart ISCOLRCHART C 10 
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Width chart ISWDTHCHART C 10 

Inventoried? ISPHYSINV L 0 

System defined 
item 

SISYSTEM L 0 

Allow qty to go 
negative 

SIALLOWNEG L 0 

Qty on hand SIQTYONHAND N 0 

Sample cost SISAMPLECOST N 0 

Reorder cost SIREORDERCOST N 0 

E-commerce URL SIECOMMURL C 254 

Modified SIMODIFIED L 0 
 

Fields from the Retail Sizes form 

DESCRIPTION FIELD NAME TYPE LEN 

Style code SSSTYLECODE C 25 

Size SSSIZECODE C 7 

Color SSCOLOR C 10 

Width SSWIDTH C 10 

SKU SSSKU C 20 

User/Barcode 
ID number 

SSUSERID C 20 

UPC code SSUPC C 13 

Qty on hand SSQTYONHAND N 0 

MTD sold SSMTDSOLD N 0 

YTD sold SSYTDSOLD N 0 

Total sold SSTOTSOLD N 0 

Date last 
received 

SSDATERECV D 0 

Reorder 
quantity 

SSREORDQTY N 0 

Reorder cost SSREORDRCOST N 0 

Cost of sample SSSAMPLECOST N 0 

Retail price 1. 
The markdown 
retail price 1 
from the retail 
inventory 
including extra 
charges for 
sizes/colors. 

SSRETAIL1 N 0 

Retail price 2. 
The markdown 
retail price 2 
from the retail 
inventory 
including extra 
charges for 
sizes/colors. 

SSRETAIL2 N 0 

Markdown 
retail price 1 

SSMKDNRETL1 N 0 

Markdown SSMKDNRETL2 N 0 
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retail price 2 

MTD revenue SSMTDREV N 0 

MTD cost of 
sales 

SSMTDCOSTSALES N 0 

YTD revenue SSYTDREV N 0 

YTD cost of 
sales 

SSYTDCOSTSALES N 0 

Life revenue SSTOTREV N 0 

Life cost of 
sales 

SSTOTCOSTSALES N 0 

Last sold SSLASTSOLD D 0 

 

Fields from the Prospect form 

DESCRIPTION FIELD NAME TYPE LEN 

Prospect 
number 

PRPROSNUM C 15 

Groom's first 
name 

PRFNAME C 15 

Groom's last 
name 

PRLNAME C 15 

Groom's 
middle initial 

PRMINIT C 1 

Groom's 
salutation 

PRSALUTATION C 4 

Groom's 
address line 1 

PRCADDR1 C 30 

Groom's 
address line 2 

PRCADDR2 C 30 

Groom's city PRCCITY C 30 

Groom's state PRCSTATE C 4 

Groom's zip PRCPOSTCOD C 10 

Groom's 
country 

PRCCOUNTRY C 20 

Groom's home 
phone 

PRHOMEPHO C 14 

Groom's work 
phone 

PRWORKPHO C 14 

Groom's fax 
number 

PRFAXPHO C 14 

Groom's pager 
number 

PRPAGEPHO C 14 

Groom's 
mobile number 

PRCELLPHO C 14 

Bride's first 
name 

PRFNAME2 C 15 

Bride's last 
name 

PRLNAME2 C 15 

Bride's middle 
initial 

PRMINIT2 C 1 

Bride's PRSALUTATION2 C 4 



General Setup 

81 

salutation 

Bride's 
address line 1 

PRCADDR12 C 30 

Bride's 
address line 2 

PRCADDR22 C 30 

Bride's city PRCCITY2 C 30 

Bride's state PRCSTATE2 C 4 

Bride's zip PRCPOSTCO2 C 10 

Bride's country PRCCOUNTR2 C 20 

Bride's home 
phone 

PRHOMEPHO2 C 14 

Bride's work 
phone 

PRWORKPHO2 C 14 

Bride's fax 
number 

PRFAXPHO2 C 14 

Bride's pager 
number 

PRPAGEPHO2 C 14 

Bride's mobile 
number 

PRCELLPHO2 C 14 

Event name PREVENTNAME C 30 

Event type PRTYPE C 10 

Event date PREVNTDATE D 0 

Event time PREVNTTIME C 7 

Date added PRCREATED T 0 

Notes PRNOTES M 0 

Last activity PRLASTACT D 0 

Source of 
prospect 

PRSOURCE C 30 

Next action PRNEXTACT C 40 

Date for next 
action 

PRACTDATE D 0 

Customer 
number 

PRCUSTNUM2 C 15 

Individual? PRINDIVIDUAL L 0 

Sales 
Associate 

PREMPNUM C 8 

 

Fields from the Pickup Inventory form 

DESCRIPTION FIELD NAME TYPE LEN 

PO item 
number 

PVITEMNUM C 15 

PO number PVPONUM C 15 

Style code PVSTYLECODE C 25 

Description PVDESC C 15 

Size PVSIZE C 7 

Color PVCOLOR C 10 

Width PVWIDTH C 10 

Category PVINVCLASS C 10 

Sub-category PVINVSUBC C 10 
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Event number PVEVENTNUM C 15 

Customer 
number 

PVCUSTNUM C 15 

Date in PVDATEIN D 0 

Date notified PVDATENOTIFY D 0 

Special 
instructions 

PVSPECINST M 0 

Unit cost PVUNITCOST N 0 

Extended cost PVEXTCOST N 0 

Quantity PVQTY N 0 

Due date PVDATEDUE D 0 

Vendor 
number 

PVVENDNUM C 10 

Ship? PVSHIP L 0 

Oversold PVOVERSOLD N 0 

Store number PVACCTNUM C 6 

Date of fitting PVDATEFIT D 0 

Fitting 
comments 

PVFITCMNT M 0 

Invoice 
number 

PVINVNUM C 15 

 

Fields from the Customer form 

DESCRIPTION FIELD NAME TYPE LEN 

Customer 
number 

CUCUSTNUM C 15 

First name CUFIRSTNAM C 15 

Last name CULASTNAME C 20 

Middle name CUMIDDLE C 1 

Address line 1 CUADDR1 C 20 

Address line 2 CUADDR2 C 20 

City CUCITY C 25 

State CUSTATE C 4 

Zip CUPOSTCOD C 10 

Home phone CUHOMEPHON C 14 

Work CUWORKPHON C 14 

Fax CUFAXPHONE C 14 

Pager CUPAGEPHON C 14 

Cellular CUCELLPHON C 14 

Measured by CUMEASBY C 3 

When 
measured 

CUMEASWHEN T 0 

Alternate ID 1 CUALTID1 C 30 

Alternate ID 2 CUALTID2 C 30 

Alternate ID 3 CUALTID3 C 30 

Alternate ID 4 CUALTID4 C 30 

Comments CUCOMMENTS M 0 

Height CUHEIGHT C 7 

Weight CUWEIGHT C 5 



General Setup 

83 

Coat size CUCOATSIZE C 5 

Blouse size CUBLOUSSIZ C 5 

Chest size CUCHESTSIZ C 5 

Bust size CUBUSTSIZE C 5 

Waist size CUWAISTSIZ C 5 

Hip size CUHIPSIZE C 5 

Inseam CUINSEAM C 5 

Outseam CUOUTSEAM C 5 

Overarm CUOVERARM C 5 

Neck size CUNECKSIZE C 5 

Sleve length CUSLVELEN C 5 

Shoe size CUSHOESIZE C 4 

Retail balance CURETLBAL N 0 

Rental balance CURENTBAL N 0 

Last 
transaction 

CULASTTRANS D 0 

Last rental CULASTRENT D 0 

Last retail sale CULASTRETAIL D 0 

Total rental CUTOTRENT N 0 

Total retail 
purchases 

CUTOTRETLP N 0 

YTD rental CUYTDRENT N 0 

YTD retail 
purchases 

CUYTDRETLP N 0 

Customer 
source 

CUSOURCE C 10 

Customer 
entered on 

CUCREATED T 0 

Pant size CUPANTSIZE C 5 

Shirt size CUSHIRTSIZ C 5 

Off the floor CUOFFFLOOR C 5 

Heel height CUHEELHGHT C 5 

Floor length CUFLOORLEN C 5 

Gown size CUGOWNSIZE C 5 

Birth date CUBIRTHDATE D 0 

Group CUGROUPNUM C 15 

Notes CUNOTES M 0 

Show notes 
when visit 
order 

CUORDRNOTES L 0 

Salutation CUSALUTATION C 4 

Unapplied 
payment 

CUUNAPPPMT N 0 

 

Laundry Tag – From the Rental Inventory Item 

DESCRIPTION FIELD NAME TYPE LEN 

Style code IVSTYLECODE C  

Size IVSIZECODE C  

Serial/ID IVSERIAL C  
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Rentalble? IVAVAILRENT L  

Comment IVCOMMENT C  

Status IVSTATUS C  

Retired Date IVRETIRED D  

Location 1 IVLOCATION1 C  

Location 2 IVLOCATION2 C  

Tag 
Description 

IVTAGDESC C  

Control 
Number 

IVCONTROL C  

Total Revenue IVTOTREV N  

YTD Revenue IVYTDREV N  

MTD Revenue IVMTDREV N  

Total Turns IVTOTTURNS N  

YTD Turns IVYTDTURNS N  

MTD Turns IVMTDTURNS N  

Date entered 
into inventory 

IVCREATED D  

 
 
Fields from Mailing List 

DESCRIPTION FIELD NAME TYPE LEN 

First Name MMFNAME C 15 

Last Name MMLNAME C 15 

Age MMAGE N 2 

Address line 1 MMADDRESS1 C 30 

Address line 2 MMADDRESS2 C 30 

City MMCITY C 30 

State MMSTATE C 4 

Zip MMZIP C 10 

Day Phone # MMDAYPHONE  C 14 

Evening Phone 
# 

MMEVEPHONE  C 14 

eMail MMEMAIL C 80 

Groom's first 
name 

MMGFNAME C 15 

Groom's last 
name 

MMGLNAME C 15 

wedding date MMWEDDDATE D 8 

city of wedding 
location 

MMWEDDCITY C 30 

 

Program logic Notes: 

If you are printing a character type field (TYPE is C), you can add text to the field by typing: 
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“Stock Number: ” + ALLTRIM(SSSTYLECODE) 

This only works on C TYPE fields. 
 

If you are printing a dollar amount, type the following in the Format field: 

$$$,$$$,$$$.99 

This will put a dollar sign to the left of the value, and round to two decimal places. 
 

You can also use the following format to print a dollar amount with text: 

"RETAIL PRICE "+ALLTRIM(TRANSFORM(ssmkdnretl1, "$$$,$$$.99")) 

In this case, you don’t need to use the $$$,$$$.99 format. 
 
Some shops like to include a code that represents the receive date of the item being printed and 
the real vendor style.  This logic will print the 1st 3 characters of a vendor style number, then the 
last 2 digits of the year, then the month, then the remaining characters for the vendor style # if 
any.  example : 
 
vendor style ABCDEFG last received 09/25/2007.   
 
The code printed on the tag would be ABC0709DEFG.  The program logic is: 
 
LEFT(SIMANSTYLE, 3) + RIGHT(TRANSFORM(YEAR(GetLastRecvDate(sistylecode))), 2) + 
TRANSFORM(MONTH(GetLastRecvDate(sistylecode)), "@L@R 99") + 
SUBSTR(SIMANSTYLE, 4) 
 

Most common bar-code types printed on labels/tags. 

The first is BC 3 of 9. This type is good for codes that will contain letters (A – Z and 0 – 9) & 
numbers.  This barcode type is a larger type. 

The second is Interleave 2 of 5. This type can only print an even number of numbers (0 –9), i.e. 
99, 9999, 9999 …etc up to 12 digits. This type can print a very small barcode. 
 

For 3 of 9 codes use the font called BC C39 3 to 1 HD Wide, regular font style and 42 points. 
The maximum length of barcode is 12 characters for a 4” wide tag/label.  

Put an “*” before and after a barcode:  

“*” + ALLTRIM(SSUSERID) + “*” 

 

For Interleave 2 of 5 codes use the font called BCI25 Medium, regular font style and 12 points. 
This can produce a small barcode The maximum length of barcode is 12 numeric characters (0 
– 9, no spaces or hyphens) and must have an even number of digits. WinPOS® will not print a 
barcode if the data being printed is invalid for this barcode type. 

I2of5(ALLTRIM(SSUSERID)) 

 

QR codes can be printed for any alphanumeric information.  The most common use is to include 
a URL to information about the product.  The Profit System has a E-commerce URL field on the 
Retail Inventory form.  This is filled in automatically when the inventory item is uploaded to 
BigCommerce.  Also, the field can be filled in manually.  To print a QR code, add a Picture/OLE 
bound control to the label and set the Control source type to "Expression or variable name"  For 
the Control source, use 
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QrCodePath(SIECOMMURL, SISTYLECODE) 

This will create a QR code for the SIECOMMURL field, which is the e-commerce URL for the 
style.  Any inventory field can be substituted for the SIECOMMURL. 

 

 

 

Worth Data Tricoder Alert 

The smallest tag readable by the Tricoder’s scanner is a I2of5 medium, regular font, set to 5 
point size.  It must be dark & clear enough for the read.  If he scanner cannot read the bar-
code adjust the printer’s heat setting & speed settings via the print driver (when using a 
thermal printer like a Zebra) and test until you are able to read the bar-code.  Please test 
before printing large quantities. 

Bar-codeNote: 

Barcode scanners from multiple vendors will have different read characteristics. The 
barcodes produced from WinPOS® should be tested with the reader being used for 
compatibility. It may require some trial & error testing with different barcode densities and 
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point sizes before they may be read. Do this testing prior to printing a large number of 
barcode tags. 

 

BBL has created special functions for some information to make it as easy as possible for the 
data to be placed on tags & labels. Use these special functions in place of a field name. You 
can only use the function on the tag/labels shown after Usage. 

GetCustName() ...Prints the full customer name. Usage: 

• GetCustName(PVCUSTNUM): For pickup 
tags. 

• GetCustName(CUCUSTNUM): For customer 
labels. 

GetEvDate()...Prints the event date. Usage: 

• GetEvDate(PVEVENTNUM): For pickup tags. 

GetVendorName()...Prints the event date. Usage: 

• GetVendorName(SIVENDNO): For invDetail 
tags. 

• GetVendorName(PVVENDNUM): For pickup 
tags. 

GetEventBride()...Prints the event date. Usage: 

• GetEventBride (PVEVENTNUM): For pickup 
tags. 

GetEventName()...Prints the event name. Usage: 

• GetEventName (PVEVENTNUM): For pickup 
tags. 

GetCustInfo()...Prints any field from the Customer form. 

• GetCustInfo(PVCUSTNUM, [customer field 
name]): For pickup tags. 

GetTableInfo()...Prints any data from any table. This is a special purpose function that takes four 
parameters: table name, tag name, key value, field to return. It goes to the record 
identified by the key value using the index tag named, in the specified table. It then 
evaluates the field to return and returns that value. 

   

For example: GetTableInfo(“CUSTOMER”, “CUSTNUM”, PVCUSTNUM, “CUHOMEPHO”) will 
return the customers home phone number, using the customer number from the pickup 
inventory table. 
 
For example: GetTableInfo(“ACCTCLAS”, “NAME”, SIACCTCLASS, “ATREVENUE”) will 
return the revenue GL account number for a style code. 

   

For example: GetTableInfo(“CUSTTYPE”, “TYPE”, GetTableInfo(“PROSPECT”, “CUSTNUM”, 
PVCUSTNUM , “PRCUSTTYPE”) , “CTDESC”) will return the description for the prospect 
type for the prospect what was used to create the customer for a pickup inventory item. 

GetBalance()...Prints the ticket or line item balance for a purchase order item. 
 
For example: GetBalance(PVITEMNUM, .T.) will return the total balance for the ticket for 
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that pickup inventory item. 
 
For example: GetBalance(PIITEMNUM, .F.) will return the balance only for the PO item. 

Word Processor 
Switchboard: Main->Housekeeping->Letters, Tags, Mailing Labels->Edit Letter button  

Menu: Setup->Letters, Tags, Mailing Labels->Edit Letter button  

Action: WORDPROC 
 

You can create mail merge letters to print or email. Letters are for mailing lists, customers & 
prospects and can be printed from the prospect form, customer form, pick-up inventory form and 
Query report writer. Sample documents are included to help you learn it's capabilities. The word 
processor operates like Word for Windows from Microsoft. 

The system has the ability to insert/merge information about the person the letter is being 
written to. The available merge fields are determined by the SOURCE of the letter/label.  The 
merge is automatically completed by WinPOS® when the letter is printed/emailed.  

Functions 

Cut button (scissors icon)...Cuts the currently selected text from the letter into the clipboard. 

Copy button (clipboard page icon)...Copies the currently selected text from the letter into the 
clipboard. 

Paste button (two pages icon)...Pastes the clipboard text into the letter . 

Undo button (backwards arror icon)...Will undo the last change you made to the letter. 

Sel All button…Will select entire document. 

Insert field button...Lets you insert a merge field into the document from a list of available merge 
fields. The merge field is a place holder that indicates where actual 
list/customer/prospect/pickup inv. information will be placed in the letter. The merge field 
could be first name, last name, address, etc. When the letter is printed, WinPOS® will 
substitute the actual name, address, etc. You would use this to personalize the letter to 
the customer.  The insert field button will list ALL the available merge information for 
SOURCE of the letter being created. 

Insert picture button...Prompts you for a picture file (BMP, PCX, GIF, TIF, TGA, WMF formats 
are supported) and inserts the picture into your letter. You could use this to insert a logo. 

Show Header/footer button...Displays or hides the header and footer for your letter. Anything 
you type in the header is printed at the top of the letter, and anything in the footer is at the 
bottom. 

Formatting toolbar...This toolbar has buttons to change the formatting of your letter. The buttons 
are as follows (from left to right) 

• Font 

• Font size 

• Left justify 

• Center justify 

• Right justify 

• Paragraph justify (left and right justify) 

• Boldface 

• Italics 
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• Underline 

• Strikeout 

• Super
script

  

• Subscript 

• Single spacing 

• 1.5 line spacing l 

• Double line spacing 

• Change color of text, text should be highlighted first 

Show field values button...WinPOS® can show you the field names you’ve added this 
document, or the values of the fields. Click this button to show the values.  

Show field names button...Click this button to show the names.  

Print button...Prints the displayed letter. 

Print preview button...Displays the letter on-screen as it will look when printed. 

Send Email button…Will prompt for recipient email address and subject of email and then 
automatically send email. The email features requires the email/internet information to be 
entered in the System/Store Set-up - Integration Tab form and the computer being used 
to be connected to the internet. 

Email HTML editor 
 

The eMail editor is a very powerful HTML editor for creating eMail web pages.  These pages 
may incorporate media in the form of graphics and video.  Media must be hosted on an web 
server before a user can see it.  Multiple media servers are available including YouTube, 
Snapfish, Shutterfly, Acrobat, Photobucket, flickr, Webshots, Kodak EasyShare Gallery, 
Google's Picasa and many others. 

A complete manual of the included PinHead HTML editor is on your WinPOS CD.  Or you can 
click this web-link to display the manual in PDF form. 

 

Pinhead HTML Editor User Guide 

 

Support files - Reporting, Customer Type etc 

Customer Types 

Switchboard: Main->Housekeeping->General Setup->Customer Types  

Menu: Setup->General Setup->Customer Types  

Action: CUSTTYPE 

 

The type code is used to identify different groups of customers or prospects. Customers and 
prospects may be selectable by type for marketing and reports in Query, letters, mailing labels, 
etc.  Each customer form contains a lookup field for customer type. 

WEBREQUEST is a system defined type that WinPOS will utilize when a prospect is added to 
the system via the Marketing Web Forms processing to indicate the prospect was added this 
way.  To not delete this code.  If the code is accidentally deleted please re-create it. 
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Type...The type code. The code must be unique. 

Description…A detailed description of the customer/prospect  type code. 

 

Customer Source 

Switchboard: Main->Housekeeping->General Setup->Customer Source  

Menu: Setup->General Setup->Customer Source  

Action: PROSTYPE 

Overview 

This form lets you maintain the list of Customer Sources. Customer Sources are the advertising 
methods that draw customers into your store. When creating customer or prospects, you can 
enter the customer source. You can then run reports as the Customer Source Analysis and 
queries that analyze how well each source is working. 

Hint 

WEBREQUEST is a source code used by the BBL marketing module when inserting web 
form prospects into the prospect.  This code should appear in your source file so you may 
report on those prospect entries created by the marketing web forms.  If it does not please 
add it to this form. 

 

Fields 

Customer source...The customer source must be unique. 

Roles 

Switchboard: Main->Housekeeping->General Setup->Roles  

Menu: Setup->General Setup->Roles 

Action: ROLE 

 

Overview 

This form lets you maintain the list of Roles. When adding people to an event, you can select 
the role they will perform (Bride, Bridesmaid, etc.) The Roles form displays the list of valid roles. 

WinPOS comes with many pre-defined roles, such as Bride, Groom, and Maid of Honor. You 
can add other roles to the list as the need arises. 

 

Fields 

Role...The name of the role. 

System defined (no editing)...If checked, you cannot change the name of the role. Certain roles, 
such as Bride, need to be present for WinPOS® to work correctly. These roles have the 
option checked. If you add a role and check this option, you will not be able to edit that 
role later. 

Gender...Select Male or Female. When adding a member to an event, this field controls whether 
to prompt for female or male measurements. 

Departments 

Switchboard: Main->Housekeeping->General Setup->Departments  
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Menu: Setup->General Setup>Departments 

Action: DEPT 

Overview 

Departments are used to group Sales Associates and Registers into logical groups for reporting. 
Several sales reports utilize departments, such as Sales by Category or Sales by SA.  

Departments are optional.  

You can select a department for each SA on the Sales Associates form and/or a department for 
each Register. 

Fields 

Department...A code that represents the department. 

Description...A short description of the department. 

 

Zip Codes 

Switchboard: Main->Housekeeping->General Setup->Zip Codes  

Menu: Setup->General Setup->Zip Codes 

Action: ZIP 

 

Overview 

As you enter customer and prospects into WinPOS®, it will learn which zip codes go with each 
cities. That’s why the customer, prospect, and event form prompt for the zip code before the city 
and state. You can edit the zip codes and cities and states that WinPOS® has learned. 

Zip codes that cover multiple cities will enter the last city entered for that zip code. 

Store/Account Classes 

Switchboard: Main->Housekeeping->General Setup->Store/Account Classes  

Menu: Setup->General Setup->Store/Account Classes 

Action: STORCLAS 

 

Overview 

A featured via the optional Multi-store or WinTPS® Rental Production management modules. 

Store/Account Classes are optional. 

Store/Account Classes are used to categorize stores into logical groups. Store/Account Classes 
are set up using this form, and then a store/account class can be assigned to each 
store/account on the Stores/Accounts form.  
 
Picking tickets can be printed by Store/Account class, so for example, there might be three 
classes Platinum, Gold, and Silver. Each store/account would be assigned one of these classes, 
and Platinum picking tickets would be printed first, then Gold, and finally Silver, giving the 
Platinum stores first pick of the inventory. Also, the Account Shipping Report can be run via 
Store/Account class. 
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Fields 

Class... This is the code to identify the class and would be assigned to the appropriate 
store/account. 

Region Codes 

Housekeeping->General Setup-> Regions (REGIONS) 

 

Overview 

A featured for the optional Multi-store management modules and only visible when multi-store is 
on. 

Region codes use are optional. 

A Region is usually utilized to set of related Store/Accounts together as a geographical group. 
 These codes are in turned assigned to each store/account entered into the system via the 
Stores/Accounts form. 

All reports that may be filtered by store/accounts can utilize the region code to automatically 
select ONLY those stores assigned to the Region code. 

 

Fields 

Class... This is the code to identify the region and would be assigned to the appropriate 
store/account. 

Event Types 

Switchboard: Main->Housekeeping->General Setup->Event Types  

Menu: Setup->General Setup->Event Types 

Action: EVT_TYPE 

Wedding, school, and social are event types. The term “event” refers generically to an event 
that occurs on a specific date. Events also has members. Members are customers who are 
purchasing or renting items. The event become the method to access those customers & their 
purchases in an efficient method.   

Fields 

Event type...A unique descriptive name for the event type. 

Pre-days...When automatically computing the pickup date, subtract this many days from the 
event date.  Used with option WinTPS© & WTPOS© modules 

Post-days...When automatically computing the return date, add this many days to the event 
date.Used with option WinTPS© & WTPOS© modules. 

Allow Overbook (checkbox)?...Set the default rental order Overbook permission on new orders. 
  When checked, operators may over book rental inventory.  Use in conjunction with the 
System Setup->Rental Tab->Force rental orders option enabled by default?.   

Like a... A drop down selection box used when adding a new event type.  It must mimic the event 
registration form behavior of one of  the default system event types of Wedding, School 
or Social.  Each of these formats the Event form in it's unique way.  Add a new event 
using each one of these event types to see the formatting differences. 

Group/Accounts 

Switchboard: Main->Housekeeping->General Setup->Groups  
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Menu: Setup->Groups 

Action: GROUP 

 

Overview 

This form is obsolete.  It's functionality is now handled by Retail Store Invoicing as set in the 
Store/Accounts form.  This form will be removed in WinPOS version 12. 

 

Document Terms 

Switchboard: Main->Housekeeping->General Setup->Document Terms 

Menu: xxx 

Action: none 

Document terms are the standard contracts and “fine print” that appears at the bottom of 
receipts, PO’s, event cards and others. You can have more than one set of terms for each form. 
If you have more than one you will be asked to select the one you want from a list when you 
print that form.  

Print terms on...Select the document that these terms are to print on. You can select from: 

• Rental Agreement: Printed from the Rental Order form when an rental order is 
printed and also prints on the ticket receipt when an rental order transaction appears 
on the receipt.. 

• Event Card: Printed from the Event form and prints when Event card, Event 
Summary, PO Summary  

• Invoice Terms: Not used / future expansion 

• Receipt Terms: Printed on a customer's receipt/ticket from the Ticket form (multiple 
terms may be created and the system will prompt the user to choose from the 
available choices when the receipt is printed) 

• Special Order: Printed on a receipt when the ticket contains any special ordered 
item. These will show before the receipt terms. 

• Purchase Order: Prints on a PO when it is Issued. 

• Charge Sale: Printed on a ticket receipt when the receipt contains a credit card 
charge via the optional integrated credit card processing. 

• Charge Refund: Printed on a ticket receipt when the receipt contains a credit card 
refund via the optional integrated credit card processing. 

• Customer Statement: Customer Statements 

• Event Statement: Not used 

• Pickup: Printed on a pickup receipt for a rental order when it is marked Pickup from 
WinTPOS.. 

• Return: Printed on a return receipt for a rental order. 

• SS Web Terms:Self Service terms are used to create the Self Service My Info web 
pages that customers would utilized to check balances, request receipt copy and 
order status.  See My Info topic for more information.  These terms are included on 
the pages and HTML codes ar permitted. 

• Email Receipt: When emailing an receipt from the ticket these terms will 
automatically be inserted into the body of the email.  The user may modify for add 
additional info before sending the receipt. 
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Description...You can enter a description for the terms if you like. This is only used if more than 
one set of terms is entered for a document. In this case, WinPOS® prompts you for the 
terms to use, and displays this description. For example, if you have two sets of terms for 
Receipt, WinPOS® will display the descriptions of both of them whenever it has to print a 
receipt so you can select the correct one. 

Message...The actual terms. You can enter as much text as you like there. Do not hit enter at the 
end of each line, only hit enter at the end of a paragraph. This way, WinPOS® can word-
wrap the terms to fit on any size paper. 
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Accounting Setup 

Accounting Setup Form 

Account Setup Overview 

WinPOS© performs a series of internal accounting functions that is subsequentially output on 
the Revenue Report and Sales Tax report.  Revenue and sales tax is realized based on a 
system setting.  The shop has three options for setting an accounting trigger that indicates to 
WinPOS© when to realize revenue & tax. These reports provide the information needed for 
most accountants to create any additional necessary financial reports.   

With the integration of the optional accounting integration module the revenue report is suitable 
for exporting to a third party general ledger software package for additional reporting, such as 
Balance & Income statements. 

The Account Setup is where WinPOS© account codes (internal ID numbers) of WinPOS® that 
are used for the revenue & tax reports may be seen and/or modified. These are pre-set by BBL 
and normally there is no reason to change any.  They are on this form for reference.  In addition, 
this section allows for the activation/de-activation of various tender types that will be used for 
payments within WinPOS©. 

The optional BBL Accounting Integration module allows the user to relate WinPOS® internal 
account codes to the GL Accounts utilized in the customer’s Ledger software. This is 
accomplished on the Chart of Account set-up form 

Sales Ticket account postings may be modified via the Register Functions->View Ticket by 
Number editor.  These edits directly affect the revenue & tax reports. 

BBL recommends that a customer only add new WinPOS Account numbers and not change 
existing ones. There are five forms that may need to be modified to reflect the addition of new 
WinPOS® internal account numbers. The revenue tracking within WinPOS® is very powerful 
and can handle most any need. Contact BBL for extensive modifications to Account Codes 
when needed. 
 

Set-up diagram: 



WinPOS Version 11 

96 

 

Account Setup GL Accounts 

Switchboard: Main->Housekeeping->Accounting Setup->Accounting Setup  

Menu: Setup->Accounting Setup->Accounting Setup  

Action: ACCTSETP 
 

This form consists of three tabs of information that is utilized to turn on/off payment tender types 
used via the ticket Payment form,  Paid -In/Out accounts description editing utilized via the Paid 
in Paid out forms and the option to modify WinPOS© account numbers for specific WinPOS© 
Revenue report detail lines (please coordinate with BBL Tech Support BEFORE making any 
changes to existing WinPOS account names/numbers) .  In addition, via the 'accounting 
method'  field,the timing of revenue/sales tax realization is set. 

 

Setup Tab 

Payments accepted section.  In this section check the tender types that will be accepted for 
payments.  Un-check those that will NOT be accepted.   
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Next to each tender type is a check box in the Open cash drawer column.  If a cash drawer is 
attached to the register, it will only open if the corresponding option is checked for the tender 
type. 

Cash... 

Visa... 

Discover... 

AMEX... 

Optima.... 

Other credit cards...Other credit card receipts. This can be used for any tender type not defined 
elsewhere. 

Master Card...Master Card receipts. 

Gift certificate...If accepted customers must be able to redeem & WinPOS allows redemption via 
the payment form. 

Checks... Standard paper checks that are deposited in the store's bank deposit.  

Electronic Checks... Electronic Checks or Electronic Deposit checks are checks that are 
processed thru a check terminal which reads the check and makes an electronic deposit 
to the stores business account.  The paper check may be returned to the customer. 

Store Checks...A check the store may write to a customer for a refund.. 

Debit.. Debit card tendor. 

Extra Payment Types (Two allowed)...Simply type in a short description of the tender type 
being accepted.  For example,  Store Card.  A WinPOS account number must be 
assigned to the optional Payment Types on the WinPOS accounts tab.  Two default 
WinPOS account names/numbers exists for this use, User 1 & User 2. 

 

Accounting method...The accounting method controls when WinPOS® realizes a sale as 
revenue, and consequently when taxes and cost are realized. WinPOS® comes with the 
Cash accounting method selected. As part of the installation and authorization process, 
you can select a different accounting method. Changing the accounting method after 
WinPOS® has been in use requires assistance from BBL Customer Service. WinPOS® 
supports three different methods of accounting. 

• Cash: The Cash method will accumulate all revenue (sales), taxes and costs as the 
items are sold, regardless of the balance of the transaction. The ticket balance does 
not have to be zero in order for the sales figures to be accounted for.  Balances are 
considered Receivables. 

• Ticket Zero: This is the opposite of Cash. The ticket balance must be zero before 
any revenue, taxes or costs are accumulated. This method treats payments on 
tickets as sale deposits.  Once the item is paid in full, all previous payments 
(deposits) are released. 

• Pickup: This is similar to Ticket Zero, except that revenue, tax, and costs are 
released and accounted for when the customer takes the merchandise out of the 
store.   

Pickup Accounting Notes 

This method requires operator discipline since ticket items must be manually marked with a 
TAKEN status when the customer removes the item from the store. If sales are not marked 
taken by a operator then revenue will not be realized.   
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Also, users may mark an item taken before it is paid for.  The system provides a warning that 
this is occurring, but most users over-ride this warning.  In this case of the item being 
TAKEN before being paid, WinPOS will not realize the revenue until the balance of the item 
is paid. 

Note: 

This balance paid requirement also applies to Rental revenue for rental orders created with 
the optional WinTPOS module.  Revenue  will not be realized at pickup time if it has a 
balance due. It will  realize the revenue once the ticket is paid in full after it is marked picked 
up by the customer. 

 

The Revenue Report is the WinPOS accounting report that totals the store's revenue, taxes, 
money. 

Cash to retain in drawer...Obsolete and not used. 

 

When Accounting Integration is enabled, the Accounting Integration option fields are available. 
See Accounting Integration Setup for more details. 

Accounting Integration... accounting integration setup fields will appear whey the optional 
accounting integration module is installed.  Please review Quickbooks Setup or 
Peachtree Setup for more information on how to utilize these fields. 

Suffix for all Accounting Integration export GL Numbers…The number entered here will be 
appended to the GL export number defined in the Chart Of Accounts when a GL export is 
performed using the WinPOS Accounting Integration. When exporting GL figures using 
the WinPOS Accounting Integration, WinPOS uses the Export GL numbers defined in the 
Chart Of Accounts. Additionally, WinPOS will append the number entered here to the 
export GL number. This is done when the GL numbers used for export need to be 
different for each store performing an export.  

Flip sign on QB deposits... When exporting the total for a WinPOS accounting class, the system 
looks to see if  WinPOS Chart of Accounts account code  being exported  is assigned to 
any Accounting Class as a AR/Deposit account.  This setting applies to these AR/Deposit 
assigned WinPOS Chart of Account codes and are referred to as deposit accounts. 

By default (unchecked) the deposit dollar amount is exported as a positive number when 
collected and a negative number when released.  Depending how the QuickBooks account 
is utilized within QB (an accountant setup decision for QB) the accountant may prefer for the 
collected total to be negative and the released total to be positive.  Checking this option 
would accomplish that. 

 

Paid In/Out Tab 

This tab allows management to dictate the descriptions of Paid In and Paid Outs.  A Paid In or 
Paid Out should be logged via the WinPOS© Register->Paid In and Register->Paid Out forms. 
 This is a software tool to track money going in or coming out of the store's cash drawer for 
authorized reasons.  Paid In/Outs are listed on the Revenue report. 

For most users, there is no reason to change the paid-out account numbers, or the paid-in 
Account/GL number. 

Paid out 1-10 description...When you choose to do a paid out via the Paid-Out form (located at 
Main->Register Functions->Paid-Out PAIDOUT) you have to select what the paid-out is 
being used for. The names of those paid-outs are defined here. You can change the 
names, as you need to. 
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Paid-out 1-10 Account...When you do a paid-out, WinPOS® deducts the amount of the paid-out 
from the Cash account, and adds it to the account code for the paid-out selected.  

Paid-in GL/Account...When you do a paid-in, WinPOS® adds the amount of the paid-out from 
the Cash account, and deducts it from the account for the paid-in account. 

 

WinPOS© Accounts Tab 

WinPOS© account numbers are created within the Chart of Accounts form.  A system setting in 
Main->Housekeeping->General Setup->System/Store Setup->Options called Allow editing of 
WinPOS account numbers? must be checked to allow modifications to the WinPOS© account 
codes.  

The following accounts are linked to tender types for store receipts. Each corresponds to a 
tender type button on the payments form (SELEPMTS). When you take a payment (or give a 
refund) a posting are made to the specified account. These accounts are totaled at the top of 
the Revenue report, in the Receipts section.  

Note 

If you choose to change the account numbers for tender types, you must be sure not to use 
the same account for two tender types. If you do so, payments taken for either tender type 
will show up under both tender types on your revenue report, overstating your receipts for 
the day. 

 

Miscellaneous Accounts 

Cash Over/Short...If you are closing a register and you enter a cash count which differs from the 
cash count shown, WinPOS® will make a posting to the account specified for the 
over/short account. This provides a record of the fact that the cash was off for the day, 
even though this posting does not affect your receipts for revenue for the day. 

Returned checks...If you use the Returned check tender type on the payments screen, the 
monies are posted to this account and shown in the receipts section of the Revenue 
report.  

Damage Waiver...Revenue realized from rental damage waivers will be posted to this WinPOS© 
account number. 

Store credits (unapplied payments)...When you attempt to save a Ticket that has a negative 
balance (that is, you owe the customer money), WinPOS® converts the balance into a 
Store Credit. When this occurs, WinPOS® makes a posting to this account code. This 
account is shown on your Revenue report in the Cash Register section along with other 
deposits/revenue. 

Security deposit...When you take a security deposit from a customer, using the Security Deposit 
button on the Ticket form, the amount is posted to both the receipts account for the 
tender type used, and this account. This account is shown on your Revenue report in the 
Cash Register section along with other deposits/revenue. 

Security deposit revenue...When a customer forfeits a security deposit, using the Security 
Deposit button on the Ticket form, the security deposit becomes revenue for your store. 
The monies are removed from the Security Deposit account and are posted to this 
account. It is shown on your Revenue report in the Cash Register section along with 
other deposits/revenue. 

Security deposits used as payments...If a customer chooses to use their security deposit as a 
payment toward a balance due, which is done the Security Deposit button on the Ticket 
form, the monies are removed from the Security Deposit account and are posted to this 
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account. It is shown on your Revenue report in the Cash Register section along with 
other deposits/revenue. 

Store credits used as payments...If a customer chooses to use a Store Credit as a payment 
toward a balance due, the monies are removed from Store credits account and are 
posted to this account. This account is shown on your Revenue report in the Cash 
Register section along with other deposits/revenue. 

 

When Accounting Integration is enabled, extra fields are displayed. See Accounting Integration 
Setup for more details. 

 

Accounting Classes 

Menu->Setup->Accounting->Accounting Classes 

Switchboard Main->Housekeeping->Accounting Setup->Accounting Classes 

Accounting classes directs the postings of sales to the proper WinPOS account 
names/numbers. The Revenue Report Setup dictates the section where the totals for each 
account appear. 

Accounting classes also control applicable  tax rates via the tax group, wher a user may 
manually change the price on a ticket for an inventory item assigned to this class and whether 
or not the sale is considered commissionable. 

Every retail inventory item in WinPOS® has an accounting class assigned. When the item is 
sold, WinPOS® looks at the accounting class to decide which WinPOS accounts to use for 
deposits, revenue, etc. 

The accounting classes, Chart of Accounts form, and Revenue Report Setup form all work 
together to produce the Revenue Report which shows your sales, receipts, etc. For a detailed 
description, see How does the accounting work? 

For most users, there is no need to add new accounting classes, or change the default 
accounting classes or the WinPOS account names/ numbers used for each one. WinPOS® will 
automatically create Accounting classes for each Inventory Category. 

You can easily break your revenue report by making an incorrect change here. Also, 
modifications to account classes are NOT retroactive to past postings. 

By default, WinPOS will automatically create an Accounting Class for each new Inventory 
Category created naming it the same a the new category, then add the account numbers to the 
Revenue Report.  This is done as a convenience and allows the category name and acconting 
class name to be the same when inserting new inventory.  It also prints the revenue by category 
on the Revenue Report thus making it easy to see.  

Fields 

Accounting class...A descriptive name for the class. 

See WinPOS Revenue Report Posting for additional information on these accounts. 

AR/Deposit account...The WinPOS®/GL account number where sales deposits will be posted. 
On ticket zero or pickup accounting methods, these are any payments made before the 
ticket goes to zero, or before the item is picked up. On cash accounting, the full selling 
price is posted to this account at sales time (as a receivable.) These deposits print on the 
Revenue Report. 
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Sales/Revenue account...When revenue is realized for the sales item, it is posted to this 
WinPOS®/GL account number. Revenue is realized at different times depending on your 
accounting method. 

• Cash: At sale time. 

• Ticket zero: When the total ticket balance goes to zero. 

• Pickup: When the item is marked as taken on the ticket. 

Refund account...If a sale is cancelled, the revenue is moved from the AR/Deposit or 
Sales/Revenue to this account. In most cases, this account is usually the same account 
as the Sales/Revenue account above. 

Tax Group…For simple sales tax tracking, a user simply enters the tax rates on the 
Store/Accounts form for their store and NO additional entry or setup is required.  This 
field is automatically set from the store form. 

For simplicity, tax groups & rates are automatically created when a sales tax rate is added 
directly on the Store/Accounts form.  More complex sales tax tracking may be implemented, 
but will require BBL Tech support for assistance. 

In some circumstances a user may want to manually setup the tax rate structure.  In this 
case a Single Store’s may utilized the default tax groups of Retail & Rental.  Select the Retail 
Tax group for retail type merchandise and Rental for Rental merchandise.  The tax rates of 
the groups use defined under the Tax Group form and is comprised of tax rates which are 
created within the tax rate form.  

 

Taxable…Checked, taxed using tax group information otherwise ignored. 

Pay Commission… Checked, Sales of inventory items assigned to this accounting class will be 
included in the Sales by SA report for commission reporting. 

Allow Price changes… Checked, clerks can modify the retail selling price on Sales Tickets of 
inventory items assigned this accounting class as they are being sold on a sales ticket. 
 Once the item's  ticket sales transaction is saved the system requires the security action 
setting of  TICKPRICE to be enabled for a user to be able to modify an item's price. 
 When a user is allowed to modify a price then a simply double click on the price field will 
allow edits. 

 

Accounting Integration Account Section 

Default WinPOS accounts are included and automatically inserted into this section when new 
inventory categories are added. A user must visit this form to modify the default names/numbers 
when needed. A WinPOS account exists, but  new ones may be added for the inventory GL 
posting via the Chart of Account setup form where the shop's accounting software's export GL 
names/numbers are assigned.  Then use that WinPOS account here.  See Accounting 
Integration Setup topic for more information. 

Purchase, Cost and Inventory account postings are exported to the chosen Accounting 
Integration package.  Cost & Inventory go with the GL Export.  Purchase account amounts go 
with the Invoice export. 

Purchase account...For invoice exporting.  Receiving inventory, invoice entry form, defaults to 
this account number.  Merchandise total of invoice posts to this account.  Non 
merchandise total posts to shipping freight (found in Main->Housekeeping->Accounting 
Setup->Accounting setup form) 

Inventory… Credit entry to the Cost of Sales. WinPOS automatically  posts a transactions to this 
account name/number that will equal the cost of sales. 
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Cost of sales account...The WinPOS®/GL account number where the cost of the item is posted. 
Sales cost are captured from inventory for the item/service being sold and recorded on a 
ticket.  When the sale item's revenue is posted (based upon the accounting method 
chosen in WinPOS) it's cost is posted to this account and the counter entry posted to the 
Inventory account.  Cost postings can be reported by using the Costs By Class report. 
 They can also appear on the Revenue Report with the cost WinPOS account numbers 
are added to Section 5 with the Main->Housekeeping->Accounting Setup->Revenue 
Report Setup function.  The default cost accounts are set to print on the Revenue report 
without additional setup.  Changes to these accounts will result in needed changes to the 
Revenue Report setup.  By default all costs are totalled under one WinPOS account.  

Adding New Categories 

As Inventory Categories are created, the WinPOS program creates a accounting class to match 
the new category.  It also creates an WinPOS account code to hold the revenue for sales of the 
category.  The account is named the same as the category, and is automatically added to the 
Chart of Accounts, and the Revenue Report. 

The accounting class is created as follows: 

Name: Same as inventory category 

AR/Deposit account: PARTIAL PAYMENTS 

Sales/Revenue account: Same as inventory category 

Refund account: Same as inventory category 

Tax group: RETAIL 

Accounting integration purchase account: Same as inventory category + EP (ex. 
BRIDALEP) 

Accounting integration inventory account: Same as inventory category + EI (ex. BRIDALEI) 

Accounting integration cost account: Same as inventory category + EC (ex. BRIDALEC) 

The accounting integration cost and inventory accounts are added to the Revenue Report, so 
they will be exported if the accounting integration is used. 

 

Revenue Report Setup 

Switchboard: Main->Housekeeping->Accounting Setup->Revenue Report Setup 

Menu: Setup->Accounting Setup->Revenue Report Setup 

Action: REVRSETP 

The revenue report is automatically configured with the installation of WinPOS. It may be 
customized under BBL tech support direction.   

The WinPOS Revenue Report is a detailed accounting report designed to recap the day's 
business.  It is suitable for accountants to make postings into a general ledger. 

WinPOS is installed with pre-set standard WinPOS account names/numbers and the Revenue 
Report is set to use these default accounts.  In most business situations the detail of the report 
is adequate. 

Accounting Classes are also preset.  Accounting classes are assigned to inventory.  When an 
inventory item is sold, postings are made to the WinPOS account numbers assigned to the 
accounting class. 

Tender types are assigned WinPOS account names/numbers in Accounting setup form, so 
when payments are made the proper postings are created.   
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The Revenue Report simply scans thru the postings file for the date range requested by the 
user and totals the amount for each WinPOS account name/number and prints that total on the 
Revenue Report in the section it is instructed to within this form. 

Due to overall system ramifications BBL recommends that a store does not modify any existing 
accounts, but only add to the Chart of Accounts and Accounting Classes on file. For extensive 
modifications the customer should consult with BBL for customization services. 

 

The Revenue section of the report is divided into eight groups.  

1 - Header, One Receipt Group.  Non Customizable 

2 thru 5 - Middle, Five Customizable Groupings 

7- Tax, One group for tax total, Non Customizable 

8 - Footer, One Section, Non Customizable 

For each middle customizable grouping specify which WinPOS account names/numbers should 
be totaled for that grouping. Each grouping is then sub-totaled on the report, and the total of all 
the groups is printed at Grand Total Revenue report line. 

Tip 

In groups 2 - 5 do not duplicate Account numbers in the report.  Insure Account numbers are 
NOT duplicated in setup, example the same Account number used for CASH tender 
payments and Check tender payments.  This will double count the money collected. 

 

Each Group Includes 

Grooup 1: Header - Receipts (non customizable) 

Receipts by tender type 

Remote payments (multi-store feature) 

Security Deposits as payments 

Receipts total 

 

Group 2 - 5: General Report Sections (Revenue & Non Revenue - customizable) 

Section 1 

sub-total 

Section 2 

sub-total 

Section 3 

Sub-total 

Section 4  

sub-total 

Section 5  (good section for non-revenue accounts) 

sub-total 

Sections 1-5 total (sub-total) 

Auto configured section entries 
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Inventory (default in section 2) 

Cost (default in section 2)  Inventory & Cost postings should balance to 0 (zero)  See 
accounting class topic for more info. 

Un-Applied payments  (default in section 5) Money collected but not applied to any sale item, 
usually creates a store Credit with the customer, Positive money going into a store credit, a 
negative is where a store credit is being used as a payment on a ticket. 

Deposit/Receivables (default in section 5), Deposit or Receivables.  Based upon Accounting 
method chosen in Accounting Setup. 

 

Group 6: Sales Tax Group (non-customizable) 

Fixed, cannot be modified.  List all tax rates and their total for period. 

Tax Total 

 

Group 7:  Grand Total of Groups 2 - 6 (non-customizable).   

This Grand total number should equal the total Receipts total number. 

 

Footer, Fixed Report ending 

• Footer will automatically insert helpful information. 

• It will print Taxable/ Non-Taxable Sales with tax collected for each by category 

• When printed in DETAIL MODE, i.e. show ticket details, Deleted ticket line item alert 
message will print indicating a clerk has deleted ticket transactions. 

• With WinTPS optional software installed- Canceled Late Fees will print.  A system 
setting exists to disable this feature. 

• Paid In & Paid Outs are listed. 

 

Group Customization 

Report Section to view box 

Report section to view, Section 1 thru 5...You can specify up to 40 WinPOS account 
names/numbers to include in each section. Select the section you wish to work with here. 

Grid 

WinPOS account names/numbers to include in selected Section...Enter the Account 
names/numbers to be listed and totalled within this selected section. 

• To add a Account, find the first blank entry, click in the WinPOS account 
names/numbers column, and enter the Account name/number. You can also press F2 
to bring up the pick list of WinPOS account names/numbers. 

• To remove a Account, simply clear it from the list. 

• Show +/- checkbox: instructs  WinPOS® to show both inflows and outflows to this 
account on the Revenue Report, or just print the net total. Checked  WinPOS® will 
show inflows and outflows as separate negative and positive totals for this Account on 
the Revenue Report. 

General 
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Show account numbers on revenue report?...Normally unchecked. If checked, WinPOS® will 
print the actual GL account numbers on the revenue report, in addition to the descriptive 
names from the Chart of Accounts form. 

Show accounts with zero totals?...If unchecked, WinPOS® will suppress lines on the Revenue 
Report with zero totals. For example, if you had no AMEX receipts for a day, the AMEX 
line would not appear on the revenue report. If you check this, the revenue report will 
include every line. 

Show +/- on receipts?...If checked, WinPOS® will show both inflows and outflows to each 
receipt account on the Revenue Report. If un-checked, WinPOS® will only show the net 
total.  

 

Chart Of Accounts 

Switchboard: Main->Housekeeping->Accounting Setup->Chart of Accounts  

Menu: Setup->Accounting->Chart of Accounts  

Action: COASETUP 

The chart of accounts (many times referred to as General Ledger (GL) numbers or accounts by 
WinPOS®) lists the WinPOS® account numbers and their descriptions. The account numbers 
are used internally by WinPOS® via Accounting Classes.  

Do not confuse these account numbers with your accounting software’s general ledger account numbers. They are not 
the same thing & your accounting program' GL accounts do NOT have to match WinPOS Account codes/names! 

BBL recommends that end users do not modify existing account numbers. Contact BBL tech 
support for help in making modifications to WinPOS® account numbers. 

Account numbers are utilized by the WiPOS system for the posting of Point 0f Sale transaction 
amounts to be printed/displayed by the Revenue Report. These postings can be reviewed & 
edited via the GL Transactions View/Change function. ONLY CHANGE THOSE POSTINGS 
WHEN YOU HAVE A COMPLETE UNDERSTANDING OF THE RESULTS. Also the postings of 
an individual ticket may be modified via the View Ticket by Number function. 

You can add, delete & change WinPOS® account numbers from this form 

WinPOS® account numbers contained with this form is utilized by several WinPOS® set-up 
forms, some of which are: Revenue report, Accounting Classes, GL Account Set-up, Taxes and 
Tax Groups. 

Fields 

GL account number...The GL/WinPOS® account number can be any combination of letters and 
numbers. 

Description...This description prints on the Revenue Report & Tax Report. 

 

Tax Rates 

Switchboard: Main->Housekeeping->Accounting Setup->Taxes  

Menu: Setup->Accounting->Taxes  

Action: TAXES 
 
Utilize this form for very specialized sales tax tracking needs.   Most businesses will not have to 
edit tax rates within this form. 
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WinPOS version 9 introduced a simple tax rate maintenance  capability found in the 
Store/Accounts form. Simply enter the tax rate percentages on that form for the business 
location.   It can also handle some specialized sales tax computations.  A few states have 
unique tax calculation requirements.  BBL has developed Tax functions to handle these 
scenarios.  See the section within this topic called: Special Tax Computations for more 
information. 

 

Tax Rate Detail 

This provides Tax Rates (names & percentages) maintenance in WinPOS
®.

 Most customers will 
simply select the RETAIL and Rental tax rate name (included with WinPOS™) from the search 
list and change the tax rate to the local tax rate.  

Tax Rates may be added and deleted at will. However, the system requires for two rates with 
the name of 1) RETAIL and 2) RENTAL to be in the Tax form at all times. 

Most local governments require only one Tax Rate, so the user would simply change the 
percentage to the local tax rate percentage for the Tax Rates called RETAIL and RENTAL. 
Some areas have a different rate for items being rented vs sold, so the user can simply change 
the RENTAL Tax Rate to the necessary percentage. 

WinPOS® supports an unlimited number of tax rates, and can charge one or more tax rates at 
sale time automatically.  

Create a descriptive name and enter the tax rate percentage for each rate required. 

Some areas require that multiple tax rates be applied to a sale. To charge multiple rates utilize 
the Tax Groups form to group multiple rates together. 

Do this by assigning the tax rates created in this form to Tax Groups.  Multi-store installations 
must create a tax group for each store.  Single store setups are NOT required to use tax groups 
when only one retail or rental tax rate is needed.  When multiple tax rates are required a tax 
group will be necessary. 

Tax Group names are placed with Accounting Classes that are assigned to inventory items 
added in the retail inventory form. At sale time, WinPOS® retrieves the item from Inventory, 
looks up the accounting class for it and retrieves the Tax Group name where it finds each tax 
rate it should apply. 

Accounting Tax Flow Diagram: 
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An example tax group: 

You have 2 tax rates: ABC at 5%, and XYZ at 7%. For most sales items, you charge both taxes. 
For certain sales items, you only charge ABC. So your taxes would be set up like this: 

 

Tax Group Name Tax Rate Name        Tax Rate 

BOTH ABC                         5% 

 XYZ                         7% 

ABCONLY ABC                         5% 

  

 
 

You would then select the BOTH tax group for the accounting class used by sales items that 
need both tax rates. You would select the ABCONLY tax group for the accounting class used by 
items that need the ABC tax only. 

Special Tax Computations 

WinPOS™ currently has three custom tax rate computations for states that require it. The first is 
MASSTAX originally developed for the state of Massachusetts. The second is NEWYORK and 
originally developed for the state of New York. The third is VERMONT. 

MASSTAX only computes tax on the portion of the sales price greater than $175.  

NEWYORK will not charge tax on any item with a sale price of less than $110. Tax will be 
calculated on the full amount of the selling price for an item sold for $110 or more. 

VERMONT will not charge tax on any item with a sale price of less than $110. Tax will be 
calculated on the full amount of the selling price for an item sold for $110 or more. 
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To use these special tax computations, enter the tax computation name (MASSTAX, 
NEWYORK, or VERMONT) into the Tax Rate name field and enter the tax rate percentage. 

Canadian customers should review the topic How to set up Canadian sales tax for additional 
information. 

 

Fields 

Tax rate name...A unique name that identifies the tax rate. If you have to charge more than one 
tax rate, enter each rate in separately with a unique descriptive name.  

All Tax Rate names entered are viewable on a Sales Ticket when the Taxes button on the Ticket 
form is clicked, allowing a user to remove or add taxes charged. 

Tax rate...The actual tax rate. Enter 5 ½ % as 5.5. 

Tax group...Available when the multistore module is NOT installed. For multistore installations 
Tax Groups are defined in the Tax Groups form.  

Tax Group is a means to create Tax Rate combinations. The tax rate combination is 
accomplished by entering any Name/Description within the Tax Group field for this Tax Rate, 
then providing the same Tax Group Name/Description to another Tax Rate(s). 

WinPOS™ includes two default Tax Group Name/Descriptions, RETAIL and RENTAL. 
These two are adequate for most installations.  

Tax Groups allow for tax rate combinations to be charged when an item/service is sold and 
for those rates to be totaled separately on the WinPOS™ Revenue and Tax reports. 

Each accounting class requires a Tax Group.  

Jurisdiction 1-3 description, rate...This is simply a way of breaking a tax rate down into sub-
rates. The total of the rates on the jurisdictions should total the tax rate. At the end of the 
revenue report, WinPOS® will print the total taxes collected broken down by the 
percentages specified here. 

Tax revenue GL...When the revenue is realized for a sales item, the taxes are posted to the Gl 
account.  Required information. 

Tax deposit GL...When payments are taken towards a sales item, and the revenue has not been 
realized, payments that would apply to the taxes are placed in this account. When the 
revenue is realized for the sales item, the taxes are moved from this account to the tax 
revenue GL account.  Required information. 

Transactions View/Change 

Switchboard: Main->Housekeeping->Accounting Setup->Transactions View/Change  

Menu: Setup->System Maintenance->Account Postings 

Action: GLTRANS 

 

This form shows the WinPOS© account transaction postings. WinPOS© account transaction 
postings are created each time you entries are placed upon a SALES TICKET, i.e. take a 
payment, realize revenue for an item, taxes and deposits/receivables.. These transaction 
postings are grouped and  totaled by WinPOS account number and accounting date to create 
the Revenue Report. This form is provided if you need to review or edit the transaction postings. 

You can easily cause your revenue report to go out of balance by incorrectly changing the 
transaction postings, so it is important to edit the postings with care. 

Edits to postings are automatically logged with the GLEDIT code. 
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Closing View/Change 

Switchboard: Main->Housekeeping->Accounting Setup->Closing View/Edit  

Menu: Setup->System Maintenance->Closings 

Action: CLEDIT 

 

This form is active when the System Setting "Require registers/store to be closed?" is on. 
 Within this form a user may review and modify daily closing money tendered details for a 
particular store.  Once modifications are complete a new revenue report may be ran. 

This form may be password secured via the CEEDIT. 

 

 

Tax Groups 

Switchboard: Main->Housekeeping->Accounting Setup->Tax Groups  

Menu: Setup->Accounting->Tax Groups  

Action: TAXMETH 
 

This form is only used with complex tax requirements.  Generally, most store's sales tax 
requirements can be handled via the tax rates found on the Store/Accounts form. 

This form is used in multi-store installations OR when a single store must charge multiple tax 
rates & wish for the rates to be listed on reports separately.   

See the Tax Rates topic (see Taxes topic for defining percentage rates). Tax Groups are 
 required in multi-store or WinTPS® Plant wholesale installations.  

A tax Group must be createed for EACH store location in multi store implementations. 

WinPOS® ships with the tax Method named RETAIL assigned to each Accounting Class. It is 
suggested that Tax Group name be used first when creating Tax Groups for each store. 

Why 

Defining Tax Groups for each store in multistore installations is required for proper tax 
computations within WinPOS™. When setting up taxes in multi-store, you have to choose which 
tax rates are automatically applied for each store.  These are the tax rates that are shown when 
you use the Taxes button the ticket.  There is a "Show all?" checkbox at the top of the Ticket's 
Taxes selection dialog box.  If checked, it will show all the tax rates for all the stores.  You can 
then select any tax rate to apply to the ticket. 

Tax Groups are a means to build Tax Rates combinations on a store by store basis. The Tax 
Group is a descriptive name given to an individual Tax Rate or Tax Rate combinations and are 
assigned to a specific store location. 

How does it works 

The same Tax Group name may be given to multiple stores, and can contain different Tax Rate 
combinations for each store it is given.  

A Tax Group name assigned to the same store more than once will be charge the Tax Rate(s) 
within the Tax Group for each time the Tax Group was assigned to that store. Typically, a store 
will have a particular Tax Group name assigned once. 

Each Accounting Class will have a Tax Group assigned to it. Finally each Inventory Item/Service 
setup will have an Accounting Class assigned. 
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WinPOS™ will retrieve the Tax Group name from the Accounting Class assigned to the 
inventory item/service sold. It then will then locate the Tax Group name assigned to the store 
where the sale is taking place and charge the Tax Rate(s) selected. 

Setup 

First, use the Taxes form to set up all your tax rates.  

To add Tax Groups for each store, click the large add button at the bottom of the form and enter 
a tax group name (such as RETAIL) and the store ID where the tax rate(s) should be used.. 
After pressing the Save button, click Add item and either enter or select a tax rate name (press 
F2 for a lookup). This links the selected Tax Rate to the Tax group.  

In most cases, you will have a minimum of one RETAIL tax group for each store, and this 
RETAIL tax group will have one Tax Rate. 

Steps 

1. First, set up a tax rate for every rate you charge using Main->Housekeeping-
>Accounting Setup->Taxes 

2. Go to the Tax Group form, click Add, and enter a tax group name.  

3. For retail sales, use Retail. For rentals, use Rental. 

4. Click Add Item, then click in the Tax Rate Name column, and type the tax rate name. 

5. If there are more tax rates that need to be charge for this store, click Add Item and 
enter another tax rate name. 

6. Repeat steps 2 – 5 for each store. 

 

Fields 

Tax Group...A short, descriptive name, such as RETAIL. 

Store...The store that this tax group applies to. 

Taxes list...The list of tax rates that apply to this tax group. To add a new tax rate, click the Add 
Item button. A blank entry will appear at the end of the list. Click on the blank entry and 
enter the tax rate name. To remove a tax rate, select the tax rate name in the list and 
click Delete Item. 

• Tax rate name: You can look up a tax rate name by pressing F2. 

• Rate: The tax rate is filled in automatically. 

 

Tax Computation Flow diagram 
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Inventory 

Inventory Creation & Maintenance 

Inventory Retail & Rental 

Inventory Overview 

The Inventory list form can display the entire inventory and provides tools for inventory 
maintenance.  

Note: 

In optional multi-store implementations, retail inventory quantity on hand can be seen for 
each store location for each style, size, color combination across all stores.   

The Store Group feature allows inventory and Terminals / Registers, in multi-store 
implementations, to be registered to a GROUP.  The only Terminals / Registers of the same 
inventory Store Group can see or sell that inventory.  

Inventory contains all the style codes, sku, prices, costs, on hand quantities, locations, 
descriptions … etc of all items and services that a store will sale or rent. 

The shop should input all items or services that will be rung up on customer tickets into 
inventory.  This insures the ability to perform sales analysis and inventory control. 

Inventory should contain services (like shoe dying or alteration charges).  These items may be 
marked as a service and will not have a quantity on hand.  When sold these items will be given 
a TAKEN status. 

Inventory should also contain normally stocked items, samples, accessories and items that are 
not owned but can be special ordered or rented.   

Style codes of items that are sold, but the store(s) does not have quantity on hand should still 
be in inventory. These items are shown with a zero quantity on hand. Add ALL items that you 
will attempt to sale through the sales ticket into inventory. 

Inventory items may be created (ADDED) via the Inventory Forms, via the Sales Ticket 
Inventory Quick Add form when performing a SALE and via the Inventory Import function 
(normally used for new users when initially creating the inventory file). 

 

Security 

Some stores may want to limit access to the data contained within these forms.  Access is 
controlled by the INVUPDATE, RETLEDIT, RETLINV RENTINV, RENTSCW and 
RENTITEM, INVRENTEDIT security codes. 

Users must be assigned a security group with security action INVUPDATE  enabled to edit 
any inventory (does not allow for deletion).  Disabled for a operator, allows the operator to 
view the inventory minus COST and other key information. INVUPDATE disabled, a user 
can access the Inventory-> Style and SCW forms but cannot see sensitive information as 
cost, nor are capable of making any modifications.  

Security action INVDEL when enabled for an operator, allows the operator to delete any 
inventory item.  Only owners and inventory managers should have deletion access. 

The security action INVRENTEDIT allows operators access to rental tab for edits of rental 
item details. 

Disable RENTINV to stop user access to the inventory->Rental Tab..  RENTSCW stops 
access to Rental sizes and RENTITEM stops access tor rental bar-code/serial id statistics 
forms.  NVRENTEDIT must also be enabled to edit the rental tab info. 
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The Inventory form is comprised of four tabs and two primary entry screens for size, color 
widths (SCW) sold and rented: 

Tab Forms 

List  

Details  

Statistics  

Rental  

Images 

WebStore 

 

SCW Entry Forms 

SCW  

Rental Sizes  
 

Every inventory item is assigned a store style code (referred to as style code within the system).  

The store style code can be automatically created by the program (defined with the setting 
“generate sequential style codes for new inventory” located at Main->Housekeeping->General 
Setup->System/Store Setup->Options Tab, System Setup - Options Tab) as a sequential 
number. Store management may choose instead to implement a coding system for assigning 
the ‘store style codes’ which would manually be entered for each new item. Both style code 
creation techniques may be interchanged, i.e. the sequential numbering could be enabled, but 
when a new style is created the sequential number could be replaced with a manually entered 
code. 

Any style entered into inventory may used as a rental item with the option WinTPOS or WinTPS 
modules.  However it is STRONGLY suggested that inventory used for RENTAL inventory 
should have a different style code than inventory used for RETAIL, even if the same inventory 
item is both used for retail and rental.  It would be a best practice to set aside an a quantity for 
retail entered for the retail code then the quantity reserved for rental under the rental style code. 
 This implementation is easier for your personnel to manage and to keep the quantities 
organized.  

Note to DOS BPS users: 

The WinPOS® store style code is different than the DOS BPS style code. In BPS, the style 
code identified a specific style and a specific size and color. In WinPOS®, the style code just 
identifies the style. The SCW Detail form is utilized to enter all size, colors and optionally 
width the style comes in. 

 

Note: 

WinPOS© contains a set of pre-defined 'system' style codes that are automatically used by 
the WinPOS© in specific instances.  The 'system' style codes should not be deleted.  The 
default Accounting Class and/or Category and Pricing may be modified by a operator for the 
needs of the shop.  The system codes may also be utilized by users if needed.  Each code 
uses the vendor code of STO.  This is a generic vendor code representing the Store as the 
vendor since the inventory style codes it applies to are primarily services provided by the 
store.  Codes and their uses are: 
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Style Code Description 

BF Balance forward.  Used when entering existing customers that already 
have balances.  The customer is sold a BF style for a price equal to 
their balance. 

BPSCONVADJ BPS Conversion Adjustment. Used only when importing BPS data via 
the built-in BPS Data Conversion.  WinPOS will automatically add a 
BPSCONADJ sale to a ticket if the ticket balance in WinBPS does not 
match the balance in BPS. 

DMG WAIVER Damage waiver.  Added automatically to tickets that contain a rental. 
 Damage Waivers may automatically be added to rental order charges 
by simply entering a price on the Inventory-> Rental Tab.  See Damage 
Waiver topic for more information. 

LATE FEE Late fee for optional rental software..  Added automatically to tickets 
containing a rental order if the rental order is returned late. 

NOSKU No SKU.  Used when selling a style code that does not appear in 
inventory.  When using NOSKU for sales you will not see detailed 
sales analysis on the reports or be able to special order items.  For this 
reason, it is recommended that you enter all styles to be sold into 
inventory. 

TF Tax forward.  Used when entering existing customers that already have 
balances.  The customer is sold a tF style for a price equal to their 
taxes due. 

LOST ITEM Lost item charge for optional rental software..  Automatically added to a 
rental ticket if items are returned via the Return function, but some 
items are not checked as Present.    The selling price is the 
replacement cost for the lost item, entered on the Inventory - Rental 
Tab. 

GIFTCERTIFICATE Gift certificate. Should be used when collecting for gift card/certificate 
sales. 

RENTAL Rental transaction, created on a sales ticket by creating a new 
WinTPS/TPOS© rental order.  Not found in Inventory as a style code. 

CANCWEDD 
                 

Fee for a cancelled wedding.  When a customer cancels their wedding 
with the shop their dress sale will cancelled.   However, a CANCWEDD 
would be sold to them as a cancellation fee, and the balance then 
refunded. 

SHIPPING Shipping charges for the rental wholesale module.  Added 
automatically to tickets/invoices during the shipping process for rental 
orders. 

 

Each inventory style is comprised of a minimum of three required data entry steps and three 
optional steps: 1) style code - required, 2) size/color/width (SCW) - required, 3) receive history - 
required, 4) store QOH from within the SCW form – optional feature, required when MultiStore 
module is installed, 5) Rental item type & price – optional feature required for rental styles when 
WinTPS or WinTPOS modules installed 6) Rental Sizes – optional feature, used when WinTPS 
is installed,  
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Steps 

1. (REQUIRED), is the style code is entered on the RETLINV form, along with all the 
information that is common to this style, regardless of size or color, such as vendor, 
reorder cost, description, etc. This form will show a QOH, this QOH is the grand total for 
all the sizes/colors this style comes in.  The size, color and widths for a inventory item is 
entered on the inventory SCW form. 

2. (REQUIRED) is the SCW or size/color/width. Using the RETLSCW form, you enter each 
size/color/width that you carry for a style code. You can also enter a SKU or UPC code 
for the SCW. You cannot directly enter a QOH here, the QOH is computed 
automatically based on the receive history, explained below. 

3. (REQUIRED) is the receive history (RETLHIST form), which is a log that shows how 
many of each item your shop received, and when. As you sell inventory, WinPOS tracks 
how many of the items are left so it knows what your QOH is at all times. 

4. (available in the multi-stores optional software module)  the store QOH 
(RETLSTOR form), which tracks the QOH at each store in a multi-store chain. This form 
is only visible if you have Multi-Store. 

5. Rental details (available with the optional WinTPS or WinTPOS rental software 
module) and is required for any style that will be used for rental orders. An item type 
and pricing must be entered. This feature only available witn WinTPS or WinTPOS 
modules. 

6. RENTAL SIZE (RENTSCW form) (available with the optional WinTPS or WinTPOS 
rental software module) where operators would enter the rental ID/Serial numbers by 
size for each tracked style OR an available quantity by size for ‘non-tracked’ rentable 
styles. This feature is required when the WinTPS module is installed. 

7. Images, import images of the intvenory item. 

8. WebStore,  where operators would enter the information needed for exporting the 
inventory item to the shop's online BigCommerce web store.  

 

STORE GROUP:   

multistore on 

ss store group on 

Inv belongs to a group 

stores belong to a group 

filter on inv to see only your store's inv 

only store that created a ticket can edit a ticket 

 

Inventory Data Diagram 
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WinTPS Rental Note: 

1. Inventory styles that will be rented cannot contain a color or width entry in the SCW 
Form.  

2. In multistore installations, the rental inventory availability is maintained on a corporate 
basis, which is how most companies assembly rental orders, i.e. inventory is housed 
and orders assembled within a central production facility.  

 

For example, this chart shows how a sample inventory might be broken down. 

RETLINV 
form 

RETLSCW 
form 

RETLHIST 
form 

Style: 
ABC0100 

Size: 10, 
Color: 
WHITE 

Received: 
5 on 
10/1/2001 

  
Received: 
2 on 
8/2/2002 

 

Style: 
ABC0100 

Size: 
11, 
Color: 
WHITE 

Received: 
6 on 
9/6/2001 

  
Received: 
3 on 
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9/4/2002 

  
Received: 
1 on 
10/1/2002 

 
 
 

Rentable Style 

RETLINV 
form 

RETLSCW 
form 

RETLHIST 
form 

RETLINV 
form 

RENTALSZ 
form 

Style: 
C100 

Size: 44R 

Qty 15 
available to 
sale  

(items 
designated 
for rental 
may be sold, 
if 
management 
desires) 

Received: 
1 on 
8/2/2000 

Item 
type: 
Coat 

Rental $: 
$100 

ID/Serial 
Numbers 
for 44R, 
Qty 5 of the 
15 owned 
are 
available to 
rent 

01000001 

  
Received: 
5 on 
1/7/2001 

 
01000002 

  
Received: 
2 on 
8/1/2001 

 
01000003 

  
Received: 
5 on 
10/1/2001 

 
01000004 

  
Received: 
2 on 
8/2/2002 

 
01000005 

 
 

To enter inventory the RETLINV form must completed with the style info, then the sizes/colors 
data for the item using the RETLSCW form, and finally at least one receive history entry for 
each size/color using the RETLHIST form. With a multi-store installation, the Quantity on hand 
(QOH) for each store using the RETLSTOR form must be entered. 

Styles that will be rented will require the Rental detail on the Rental Tab to be completed (for 
WinTPS & WinTPOS modules) and the available rental quantities on the Rental Sizes 
(RENTSZ) form must be entered (for WinTPS module). 

For any inventory to be created, specific supporting data must be completed prior: 

1. Set up your inventory categories  

2. Set up your accounting classes  

3. Set up your vendors  
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4. Create size charts. Optional. 

5. Create color charts. Optional. 

6. Create Item Types. (WinTPS or WinTPOS) 

7. Create size conversion charts. (optional with WinTPS or WinTPOS) 

 

Example Diagram 

 

 

 

Retail Inventory Import Overview 

Switchboard: Main->Housekeeping->System Maintenance->Import Inventory  

Menu: Setup->Import Data->Import Inventory  

Action: INVIMPORT 

 

WinPOS offers a tool to quickly add retail inventory in bulk.  This software tool is ideal for new 
stores to quickly get retail inventory, vendors and categories loaded so they may begin quickly 
using WinPOS. 

Fast Start 

The best way to import inventory is to create a separate Excel spreadsheet for each vendor and 
category.  So, you'd have one spreadsheet for Amsale bridal, and a separate spreadsheet for 
Amsale bridesmaids, for example. 

Make sure the spreadsheet has these columns, in this order: 

Vendor style 

Size 

Color 

Description 

Price 1 

QOH 
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Reorder cost 

The spreadsheet file MUST be saved as an "Excel 5.0/95 Workbook" file format.  You can easily 
do this by loading your spreadsheet into Excel, selecting "Save as...", then selecting "Excel 
5.0/95 Workbook (*.xls)" as the file format. 

Also, the Color field in WinPOS is 10 characters long.  If the name of the Color in your 
spreadsheet is longer than 10 characters, the name will be truncated upon import.  You may 
wish to abbreviate your longer Color names in your spreadsheet prior to importing. 

Now, in the Profit System, go to Main->Housekeeping-> System Maintenance->Import Data-
>Import Inventory. 

Click Load Excel File and select your spreadsheet. It will loaded into the grid.   

You can use the Delete Selected Row button to remove any bad rows.  Make sure everything 
looks Ok, and click Add to Inventory.  It will prompt for the Category and Vendor, which the user 
must enter and then OK to add the inventory to the Profit System. 

You can then repeat the process for the other spreadsheets. 

More Info 

Please review the Import Inventory topic for more detailed  instructions on how to use this 
powerful import feature. 

 

 

Inventory List Tab 

Switchboard: Main->Inventory->Inventory and Main->Housekeeping->Inventory Setup-
>Inventory 

Menu: Inventory->Retail Inventory- 

Action: RETLINV 
 

The List tab of the Inventory form displays inventory information sequenced in a specified order 
as an aid for the operator to locate specific items.  

The list may be searched and filtered. 

Filter by Vendor via the vendor field or rental Type via the Type field.  Simply select the vendor 
in the Vendor field and the form is automatically filtered.  With the optional WinTPOS/WinTPS 
software modules the list may be additionally filter by rental item type via the Type field.  Select 
the item type and the list is automatically filtered. 

The list initially displays in Store Style order for searching, but may be changed to Vendor Style 
or by Internet Style by the user.  Any bolded column may be searched by simply clicking the 
column header.  

The list is used to locate the inventory style that is needed for review or edits.  Highlight the 
desired inventory item and the inventory tabs are active for that item. 
 

Filter 

Limit Inventory from vendor field… Enter a vendor code and the search list will only show 
inventory styles from that vendor. Double click the Vendo Style heading and the list will 
be filtered by Vendor Code, sorted by vendor style code. Begin entering the vendor style 
code and the system will find the match of your entry. 

Type... For WinTPS/WinTPOS rental inventory.  Select a rental item type to limit the list by. 
 Select ALL ITEMS to list ALL inventory, select RENTALS ONLY to see all inventory 
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marked as rental (via the presence of an item type on the rental tab) or select a specific 
rental item type (as COATS) to see only those rental types. 

 

Buttons 

SCW (sz/clr/wdth) button… This will take you directly to the form that shows you all of the sizes, 
colors, widths, quantity on hand and receiving history for the selected style code. 

SCW statistics button… This will take you directly to the form that shows you all of the the MTD, 
YTD, and life sales figures for all of the size,color and width entries. The figures 
correspond to the highlighted line in the list.  

Lookup SKU button… This will display the SKU search form. You can use this to locate a 
specific item by SKU, barcode, or UPC code. Once you have located the item on this 
form, click Ok to go directly to Sizes form for that item. Note : if you have converted from 
BPS, the SKU will be your old store style number. This feature allows you to search by 
that number. 

Rental Sizes button…. Available with the optional WinTPS/WinTPOS optional software module. 
 Displays the Rental Sizes form for the selected item. 

Pictures button...Displays the Images module to allow pictures to be viewed, replaced or added 
for the selected style. 

Delete button...You can delete and inventory style if you have INVDEL security access. When 
you delete a style you also delete every size for the style, every receive history entry, and 
every inventory transfer.  Caution:  Data is deleted and cannot be recalled. 

Note:  

Print tags from the Retail Inventory form or from the Retail Sizes form. When you print from 
the Retail Inventory form, you cannot print the size, color, barcode, or SKU on your tag. You 
can, however, include this information if you print tags from the Retail Sizes form. Tags 
printed from the Retail Sizes form can include any information from Retail Inventory forms. 
For this reason, we recommend only printing inventory tags from the Retail Sizes form. See 
Letters, Tags, and Mailing Labels for more details. 

Inventory - Details/Style Tab 

Switchboard: Main->Inventory->Inventory->Details Tab and Main->Housekeeping->Inventory 
Setup->Inventory->Details Tab  

Menu: Inventory->Retail Inventory->Details tab 

Action: RETLINV 
 

This form is where inventory information pertinent across all SCW (SKUs), retail & rental, is 
maintained. 

 

Fields 

Style code...This is a unique number you assign each inventory item in your store. When 
entering new inventory items into WinPOS®, this will be the first piece of information 
requested. This is also known as store style number. The style code for an item must 
exists in  inventory before you can sell the item. This style code will be printed on sales 
receipts, reports, etc. WinPOS® will auto-generate sequential style codes if the option 
“Generate sequential style codes for new inventory” is checked in System/Store Setup - 
Options Tab.  When the system generates style codes, it will insure that the style code 
does not match an existing one, or a barcode, UPC, or SKU. 
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We do not recommend using the manufacturers style code for your store style code since 
multiple vendors may use the same style code and the WinPOS® code must be unique. 
 
A style code can only contain letters, numbers, and $, %, *, -, +, /. It cannot contain “, ‘,[ 
or ]. 

Note 

For NON WinTPOS customers (those running just WinBPS). You may offer tuxedo rentals, 
but do not wish to invest in the full tuxedo WinTPOS rental POS tracking module.  However, 
these customers would like to perform some tracking of the rental customers.  Refer to the 
topic "How do I rent Tuxedos" with WinBPS for information concerning this process. 

Description...A general description of the inventory style. We do not recommend that you put 
color or size information in the description, since this style code and description will be 
used for sales of any size and color. This description will be printed on reports, sales 
receipts, purchase orders, etc. 

Vendor style...The number placed on the purchase orders by WinPOS®. This is the number that 
the vendor understands and recognizes as a number for his or her merchandise. It is the 
manufacturer's stock number. A vendor style code can only contain letters, numbers, and 
$, %, *, -, +, /. It cannot contain “, ‘,[ or ]. 

Location...The store number where  the inventory item was created. The store is the Store 
Number code entered in the System/Store Setup - Setup Tab. When you add inventory 
items, the store where the item was created is entered automatically.  

Comments 1 & 2...You can add comments for each style code entered. The Ticket form will 
display the information for Comment 1 entered for an item when sold. This is helpful in 
reminding the consultant of any particulars concerning the item being sold. For example, 
you may wish to enter the available colors for an item in the Comment 1 field.  

Clicking the Comment 2 button will allow an unlimited number of details to be entered 
about the item.  Comments 1 and 2 may be printed on price tags. 

 

Note: 

Some shops sale SERVICE styles (non-tangible items) and add those items to Pickup 
Inventory as a lay away item.  This is done for very specific accounting purposes.  They wish 
to control the exact time when the revenue of those services are realized.  However, if a 
pick-up inventory physical is done, those items will not be counted since they are not 
physically present.  To solve this issue a user can enter in the style's Comment 2 line the 
characters PUPNODELETE.  The will prevent these styles to be automatically removed from 
pickup inventory when a pickup physical is applied.  

Vendor...This is the unique code you assigned each vendor in your vendor file. WinPOS® will not 
let you save the retail inventory item without a vendor code. If you've forgotten a vendor 
code, press the lookup button when the field is highlighted to have the system display all 
the vendors and their codes. 
 
Vendor information must be entered prior to entering your retail inventory. 

Qty on hand...A calculated field.  This will show your total quantity on hand, which is the total of 
the quantity on hand for all the sizes/colors/widths and stores. You cannot change this 
quantity here, you must change the quantity on hand for a specific size/color/width, and 
this qty will be updated automatically. When items are sold from stock on the sales ticket 
the qty on hand is automatically reduced by the number sold.  The inventory QOH will 
never enter into a negative amount. 

Qty on stock orders...This will display your total quantity for this style that is pending (PO items 
created but not ordered) or outstanding on stock purchase orders.  Double click the field 



Inventory 

121 

to display the PO item form for the details of what specific SCWs are on order or listed to 
be ordered. 

Date discontinued...Upon notification from a vendor that an item has been discontinued, you 
can enter the discontinued date in this field to indicate that this particular item has been 
or is soon to be discontinued. If a consultant sells an item that has had a discontinued 
date entered for it, the Ticket form will display a message indicating the item being sold 
has been discontinued. 

When a inventory item is discontinued, it will not be listed in inventory style lookups for entry 
onto rental orders, however the style may be manually entered.  This is effective with the 
integration of the optional WinTPS/WinTPOS rental modules 

Accounting class...The accounting class tells WinPOS® how to account for the money related 
to this item. Ultimately, it controls how revenue appears on the Revenue Report. The 
revenue numbers from the Revenue Report then correspond to entries in your accounting 
software. Accounting classes are not meant to be used to break down your sales for 
analysis purposes. If you want to analyze your sales, you can use Inventory Categories, 
discussed below.  
 
You may have one accounting class for Bridal, which tells WinPOS® that revenue from 
sales of Bridal items shows under bridal on the Revenue Report, partial payments should 
show under Deposits, and that these items are taxable. You may have another 
accounting class for Freight, which indicates that revenue for shipping charges shows 
under Miscellaneous on the Revenue Report, partial payments show under Deposits, and 
that it is not taxable. 
 
Accounting classes must be entered prior to entering your retail inventory. WinPOS® will 
automatically created accounting classes for each inventory category you create, so you 
should create your inventory categories before entering your retail invnentory, then 
simply use the same code for the inventory category and accounting class. 

Inventory category...Categories are used to group inventory items by their “type”. Examples of 
categories would be: Bridal gowns, bridesmaid dresses, shoes, jewelry, alterations, etc. 
Several sales reports will show sales by category. Also, the Revenue Report uses the 
category code. Sub-categories are further breakdowns of a main category. For example, 
you may have a main category for bridesmaid dresses with sub-categories representing 
different “value levels” of bridesmaid dresses. 
 
Inventory categories must be entered prior to entering your retail inventory. 
 
The category RENTAL is a system defined category used for rental transactions. It 
cannot be assigned to any retail inventory items. 

Season Code...Many vendors ship items that are specific to a particular season. You can create 
a code for each season and enter it here.  The season code must had been previously 
created in the Season Code form. 

Date last received...The date when you last received any of these items 

Retail factor % and plus...The retail factor percent will determine the retail selling price of this 
inventory item. For example, if you want to double an inventory item’s cost, enter 200 in 
this field. WinPOS® will take the number entered into the Cost of Sample (or Reorder 
Cost, if present) and multiply it by the retail factor. The result will become the retail selling 
price for that item. This field's default value is determined by the retail factor percent for 
the category OR vendor, either entered previously, but may be overwritten with any 
amount you like. A Retail Factor entered for the vendor will overwrite any factor entered 
for the category.  The optional Plus field lets you add a specific amount to the retail 
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selling price for this item. For example, if an item’s cost is $50.00, the retail factor is 
200%, and the Plus entry is $1.99, the system will create a retail selling price of $101.99. 

Internet Style Code...Many manufacturers provide an online/internet catalog of their styles. 
 Often they include an internet style code to identify the images.  This internet code may 
be associated to the real inventory style. WinPOS© allows for inventory lookup by this 
internet style code.  This field is optional and may be left empty. 

Store Group... Optional multi-store feature that allows inventory to be seen and sold by stores 
assigned to the same group as the inventory styles.  See Store Groups topic for more 
information. 

Markdown date...This date is manually entered to indicate when a markdown was created for the 
inventory item.  The markdown can be in the form of a never ending Promo Price or by a 
Direct change of the Retail Selling price 1 or 2.  The Inventory Not Sold report can utilizes 
this date. 

Size/color/2nd color/width chart...These fields are the vendor size, color, and width charts that 
apply to this item.  
The 2nd color chart is usually used for an accent color.  Use of these charts is optional. 
However, charts are tools for 1) Displaying on hand quantities in a spreadsheet format 2) 
Allows users to pick items to be sold from a spreadsheet format while in a Sales Ticket 3) 
To order stock merchandise in the PO module and 4) Enforce valid Size, Color & Widths 
are sold on a sales ticket. The utilization of charts is a time saver and can reduce errors. 

Size, color, and 2nd color charts are used for the e-commerce upload.  The options in the 
charts become the options a customer can select when ordering the style on the e-commerce 
site. 

There are several System Setup options that effect chart use.  Also review the topic Ticket 
Details - Grid for more information. 

Note: 

To save time with initial inventory set-up, create a size chart by category.  The category 
chart would contain all the sizes any item could have within the category.  This reduces the 
number of uses of the size chart, but still provides some benefit until more accurate charts 
for each vendor and/or style may be created. 
 
Size, color, and width charts can be added to inventory styles anytime. 

Vendor discount (%)...The discount percentage that the manufacturer allows on this item for 
prompt payment. If you plan to take this discount percentage, enter it in here. If not, enter 
a zero. This number helps you to more accurately track your inventory value & is used in 
WinPOS© to calculate the inventory Netcost value found on the Inventory form Statistics 
Tab. 

Reorder quantity...The Reorder quantity is an amount that can enter for some items (it may not 
be necessary for all). The Inventory Reorder report will list styles items that the Quantity 
on Hand has fallen below the Reorder quantity.  This provides a handy guide for 
reordering merchandise that may turn over quickly, such as certain accessories. The 
Reorder quantity, if entered, on the SCW form supercedes the Reorder Quantity on the 
Style level.   

Notes, show at sale?...Click the Notes button to enter notes about this style code. You can enter 
an unlimited amount a text regarding this style code here. If you want these notes 
displayed at sale time, check the Show at sale? checkbox. This is similar to Comments, 
except that comments are always displayed. 

Spiff amount, type...This is a sales person dollar bonus incentive for selling an item. If there is a 
dollar amount in this field when the item is sold, it is registered to the consultant who sold 
the item. If commission splits are activated, the Spiff will split equally among the 
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consultants entered when the item is sold. The type field lets you select 
Order/Stock/Either, which determine whether the spiff will be given when the item is sold 
from a special order only, sold from stock only, or both. Spiff amounts are printed on the 
Sales Analysis Reports, such as the Sales by Sales Associate report (located in the 
Reports menu). An individual Spiff audit report is printed by consultant when the 
commission report is printed. 

Avg. unit cost...The average cost for a quantity one of these items. This is computed 
automatically, by taking Quantity on Hand * Unit Cost for each receive history record in 
the Receive History form then totalling the product for ALL receiving records, then 
dividing the total by the total quantity on hand for the style. 

QOH * Unit Cost added together for each receive record for the style / QOH for the style 

 

Manufacturing cost...The cost for manufacturing one of these items. This field is for reference 
only and is used by large stores that manufacture their own inventory. 

Reorder cost...This is wholesale cost to reorder a new item. This amount can be different from 
what was originally paid for the sample or 'in-stock' item. When you sell an item, the 
reorder cost is used for the cost if it is a special order. If it is a stock sale, the receive 
history is consulted to determine the cost. If inventory costing is set to FIFO, then the cost 
of the oldest item still in inventory is used. If it is set to FIFO, then the cost of the most 
recently received item is used stock sales. If, according to the receive history, there are 
no more items in inventory WinPOS will use the reorder cost. 

Sales Cost Tip 

 WinPOS will record the cost of sale on a SALE of a item two different ways based upon a 
system setting. 

1)  The Default method (no setting required) is:  a) A item sold from stock will record the Unit 
cost of the item found on it's receiving as the cost of sale.  b) A item special ordered will 
record the reorder cost as the cost of sale.  c) A item sold from stock with a $0 unit cost will 
record the reorder cost as the cost of sale (if you prefer for the reported cost to be $0 then 
enter a cost of $.01 (1 cent)). 

2) A setting in Housekeeping-> General Setup-> System Setup -> Options Tab-> Apply 
Vendor discount to cost at sale time?.  Checked this option will apply the vendor discount to 
the both reorder cost for special orders and the Unit Cost of stock sales for recording the 
cost of sale. 

 

Base price 1 & 2...Retail is the retail selling price of this inventory item. The system calculates 
this number for you by multiplying the Retail Factor Percent times the Cost of Sample (or 
Reorder Cost, if present), then adding the dollar amount in the “Plus” field, if any. You 
can overwrite this number if you wish however, if you go back to this item,change 
something and press the save button, WinPOS® will recalculate the base price using the 
default calculation. WinPOS® allows two retail prices for each inventory item. When the 
item is being sold to a customer and has two retail prices entered, the consultant will be 
prompted for the correct one to charge the customer.  
 
The price must be rounded to .05 if the option “Include tax in price on style lookup, ticket 
grid, and receipt” is checked on the Options tab of System/Store Setup. This is normally 
only enabled for Australian users. 

Markdown Price 1 & 2...When there are promotional prices in effect the resulting new selling 
price will be displayed in the Markdown Retail Price 1 & 2 fields. You can double click on 
this field to show how WinPOS® is computing the markdown price. 

 See How do I adjust selling price for more information. 
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Gross Margin 1 & 2...WinPOS® tracks the gross margin of an inventory style. This number is 
automatically calculated for you. The formula for computing gross margin is:  

(Markdown price - Cost) / Markdown Price * 100 

 

Check boxes 

Stocked in store?...If checked, this setting indicates this item is normally stocked.  

Service/not inventoried? (checkbox)...If checked, this setting indicates that this item is not a 
tangible item that can be counted for inventory physicals. Quantities not required, but still 
requires that a size is entered, i.e. NA. During a physical items with this field checked 
does not show up on the exception report as not counted. 

Hide on Sales Reports? (checkbox)...If checked, This item will not be included in the Sales by 
Category, Sales by SA, Sales by Vendor & Sales by Vendor Style sales reports. 

Inactive? (checkbox)...If checked, does not allow a user to sell this item on a sales ticket. 

Advertised? (checkbox)...If checked, indicates that this item is advertised by your shop or you 
are listed in a magazine for the dress. This feature allows analysis of the effectiveness of 
your advertising. You would need to run the customer source analysis report to analyize 
your advertising success. 

Notes, show at sale?... Enabled, this option will display the entered notes (if any) when this stye 
is entered onto a ticket. 

 

Buttons 

Picture button...You can store pictures of your inventory items. This button displays the Images 
form, where you can insert pictures, view them, and delete them if you need to.  Pictures 
may be acquired via various methods.  Examples are: use a TWAIN compatible device 
connected to the computer like a camera or scanner to capture the pictures OR download 
pictures off the internet from magazines like Brides or The Knot (make sure all copyright 
laws are obeyed). 

Size matrix button...Displays a matrix using the sizes and colors of the selected charts OR if no 
charts are entered, the system will create a matrix using the SCW sizes, colors & widths 
entered for the style.  The matrix then shows the quantities on hand for each 
size/color/width. You cannot change or add to the existing quantities in the matrix. This 
button is only enabled if you enter a size, color, and/or width chart for this item. 

Inventory creation Hint 

Retail Inventory  

A user may quickly add the sizes and colors and quantities when adding a style for the first 
time.  Add the style and include it's size and color chart.  Click the SIZE MATRIX button and 
the style's matrix will appear.  Click into the size/color cell and enter the quantity on hand for 
each size / color combination.  WinPOS will automatically add the size & colors with the 
quantity entered into the styles SCW form.  This is available only once.  After the initial load, 
new sizes & colors with quantity are added via the style's SCW form. 

Rental Inventory 

The Size Chart may be used to add Rental inventory size scales quickly with the optional 
WinTPOS software module installed.. It will create a size and a single receive history entry 
for every size in the size chart entered for this style. The QOH will be set to zero for the new 
sizes added via the Inventory-> Rental tab-> Create Sizes from Chart button 

SCW button...Displays the SCW form, which shows you all the sizes/colors/widths available for 
this style code and the receiving history for each size/color/width. 
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SCW statistics button… This will take you directly to the statistics form that shows all of the 
MTD, YTD, and life sales figures for all of the size, color and width entries. The figures 
correspond to the highlighted line in the list.  

Transfers button... Only available with WinPOS ® Multi-Store Integration. Displays the Inventory 
Transfers form, only showing transfers for this style code.  This button will turn BLUE 
when ANY transfers are on file for the style. 

Extra Charges button...Displays the Extra Charges form, only showing extra charges for this 
style code & allowing new extra charges for this style to be created. The extra charges 
can be selected from a list or automatically applied at the time of sale. 

Receiving History button...Displays the Receive History form, showing all entries for this style 
code only. 

Promotional Pricing button...Displays the Promotional Pricing form, only showing pricing 
promotions for this style.  Allows new promotions to be created. 

Notes button...  Displays a note window where miscellaneous information pertaining to this style 
may be created. 

 

Inventory - Retail Statistics Tab 

Switchboard: Main->Inventory->Inventory->Statistics Tab and Main->Housekeeping->Inventory 
Setup->Inventory-> Statistics Tab  

Menu: Inventory->Retail Inventory->Statistics Tab 

Action: RETLINV 
 

The Statistics tab of the Retail Inventory form shows you how this style code is performing 
across ALL sizes. Colors and widths entered for the style. These numbers are style totals. 
 

Net Inventory Cost...This is a auto calculated field for display.  The formula is  

Average Unit Cost - the vendor discount percentage (contained on the Inventory - Details tab..  

Inventory Value...This is a auto calculated field for display or inventory report printing and it is 
the total value of this inventory item. The formula for computing the value for the style is: 

 (Quantity on Hand * Unit Cost) * Cost Factor - Vendor Discount for each Receive History entry, 
then totalled for all. 

Average Unit Value.. This number is computed automatically and uses the formula: 

 Inventory Value / Total Quantity on Hand for the style 

Many of the inventory reports utilizes this number in computing the inventory value. 

Activity...The number in the activity field indicates the number of times the item has been placed 
in the prospect’s favorites file as an item a liked. 

Sold 1 & Sold 2 totals for MTD, YTD and Life are the total times sold for Price 1 & Price 2 
respectively.  The cost of sales is computed differently depending on whether this item is 
sold from STOCK or SPECIAL ORDERED on a Sales Ticket. STOCK sales cost is 
computed with this formula: Quantity Sold * ( Receive History Cost - Vendor Discount % -
Cost Factor %).  SPECIAL ORDERED sales cost is computed with this formula:  Quantity 
Sold * Reorder Cost 

Pricing 1 & 2 MTD Sold...Every time the WinPOS® program is started, it checks the current 
date. If WinPOS® sees that a new month has started, it will ask the user to reset the 
MTD totals. If you choose to reset them, WinPOS® will reset the following MTD (Month to 
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Date) figures to zero, like a trip odometer on your car. In order for WinPOS® to track 
these figures accurately, the MTD totals must be reset to zero at the beginning of each 
month. 
 
MTD Sold is the total number of times the item has been sold since the last time the MTD 
counter had been reset to zero. WinPOS® records this information automatically. 

MTD revenue...This is the amount of total revenue this inventory item has generated since that 
last time the MTD counter had been reset to zero.  

MTD cost of sales...This is the total cost of sales for this item since that last time the MTD 
counter had been reset to zero. WinPOS® records this information automatically. 

MTD gross margin...MTD Gross Margin % is similar to the gross margin percentage shown on 
page 1 of the inventory, except that the number shown here is a month to date total. 
Again, it shows the total since last time the MTD counter had been reset to zero. 
WinPOS® records this information automatically. 

Pricing 1 & 2 YTD Sold...These figures are identical to the month to date fields, except these 
figures are accumulated on a year to date basis. When the program is first started on 
January 1st, the system will prompt the user if she/he wishes to reset the YTD numbers 
in addition to the MTD numbers. 

YTD revenue, sales, gross margin...These figures are identical to the month to date fields, 
except these figures are accumulated on a year to date basis. 

Pricing 1 & 2 Total Sold...These figures are identical to the month to date fields and year to date 
fields, except these figures are accumulated on a lifetime basis, i.e. since the day they 
were entered into WinPOS®. These figures cannot be reset to zero. WinPOS® records 
this information automatically. 

Total revenue, cost of sales, gross margin...These figures are identical to the month to date 
fields, except these figures are accumulated on a year to date basis. 

Date last sold...Each time the item is sold WinPOS® will automatically insert the date into the 
inventory file. This date is important in quickly determining the item's recent sales activity. 

Last sold to customer...Displays the last customer account number the item was sold to. 
Double-click on the customer number and to display the Customer’s form for that 
customer. 

Web Catalog Description...This is the description used by the Create Web Catalog function 
when any Size, Color, Width of this style is selected to be place in the web catalog.  The 
description is place in the HTML (web) page for this style. 

 

Inventory - Rental Tab 

Switchboard: Main->Rental Production->Inventory->Inventory->Rental Tab and Main-
>Housekeeping->Rental Setup->Inventory->Rental Tab 

Menu: Rental Inventory->Rental tab->Rental Sizes button  

Action: RETLINV 

 

Overview 

The rental tab is available with the optional WinTPS and WinTPOS software rental modules. 

Any style entered into inventory may used as a rental and/or a retail inventory.  However it is 
STRONGLY suggested that inventory used for RENTAL inventory should have a different style 
code than inventory used for RETAIL, even if the same inventory item is both used for retail and 
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rental.  It would be a best practice to set aside an a quantity for retail entered for the retail code 
then the quantity reserved for rental under the rental style code.  This implementation is easier 
for your personnel to manage and to keep the quantities organized.  

Hint 

When necessary management can allow the retail sale of used rental inventory using the 
current Rental style code. 

Three inventory set-up actions must be in place to activate a style as a rental: 

1. The inventory style can only have sizes entered within the SCW form (omit colors & 
widths).  

Hint: 

The style code can represent a style & color combination. For example, say there exists a 
Blue Vest style 100. The style code entered into the inventory could be V100B and it’s sizes 
could be S, M, L, XL, XXL. 

2. The rental tab must be completed with the minimum information,i.e. item type and 
base rental price 

3. This step is only available/required with WinTPS Production Management module. 
The quantity available to rent must be entered. For tracked items (those that are being 
assigned ID/Serial numbers) the ID/Serial numbers for each item available for rental 
must be entered into the Rental SIZES form. 

Fields 

Item type...You must enter an item type for this style code. You can create your own item types 
using the Item Type form. Some item types are system defined and cannot be deleted. 
Style codes with item types can be used for rental orders. 

Default catalog code...If this style code is normally sold as part of a package, create a catalog 
code for that package and enter the catalog code here. Then, when the user enters this 
style code on the order form WinTPS will automatically stop when the style is typed on to 
a order and suggest to the operator hat the catalog code may be used instead.  The user 
may accept and the remaining styles of the catalog )if any) will be added to the order 
along with the catalog price OR reject it's use to continue entering each style manually. 

Price group code... Assign a optional package price group code for this field.  Assign a COAT 
Package price code to coat item types and an accessory package code to non-coat item 
types.  Package pricing is assigned to Package Codes and provide flexible pricing 
options.  The package price is displayed when a code is assigned and is the price that 
will be applied to a rental order when the item qualifies for package pricing. The Package 
discount codes with it's style contents is created via the Coat & Accessory Price Group 
forms. 

Replacement cost...The cost to charge a customer if they lose the item.  Replacement costs 
may be automatically applied to retail customers when items are not returned. 

Size conversion for whole size...You can specify a size conversion that applies to sizes for this 
item created during order entry.. If you enter a size conversion chart name within this 
field, WinPOS® will take the size entered on the actual order and try to convert it as a 
whole. If you specify this conversion, you cannot specify a left/right conversion. 

Size conv. for left of hyphen...WinPOS® will take the part of the size to the left of the hyphen 
and convert it using this size conversion. It will also convert the right side of the size 
(using Size conversion. for right of hyphen), and concatenate the results to create the 
converted size. 
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For example: 32-34 could become M4, if the left side conversion converts 32 to M, and 
the right side converts 34 to 4. 

Size conv. for right of hyphen...The conversion for the right side of the size entry field on a 
order entry screen. 

Swap sizes on conversion? (checkbox)...If checked, WinPOS® will take the results of the size 
conversion and swap them before concatenation. 

Example: 32-34 could become M4, if the left side conversion converts 32 to M, and the right 
side converts 34 to 4. With this option enabled the system would swap the two sides and the 
size would become 4M. 

 

Total, YTD, MTD Revenue...The dollars earned for rentals of this style code. Total dollars refers 
to the total revenue from this item since it was entered into WinPOS®. The MTD and 
YTD counters are reset automatically by WinPOS® at the start of each month and year, 
respectively. 

Total, YTD, MTD times used...The rental turns for this style code. Total times used refers to the 
total rentals from this item since it was entered into WinPOS®. The MTD and YTD 
counters are reset automatically by WinPOS® at the start of each month and year, 
respectively. 

 

Rent Price w/coat…Display only. This calculated field takes the base price entered for the rental 
style and applies any specific stores pricing. It displays for the logged in store & displays 
the retail or wholesale price determined by the Price/Type field setting in the 
Stores/Accounts form. 

Rental Price w/o coat…Display only. This calculated field takes the base prices entered for the 
rental style and applies any specific stores pricing. It displays for the logged in store & 
displays the retail or wholesale price determined by the Price/Type field setting in the 
Stores/Accounts form. 

 

View / Change Base Prices 

These four price fields appear when the View/Change Base Prices function button is clicked. 

 

Rent price w/coat...The rental price for this item to a customer if on a rental order that includes a 
style that is a COAT item type OR if the style being edited is a Item Type of COAT. 

Hint: 

The COAT item type is system defined and cannot be modified within the item type 
maintenance form.  If modified the with w/ coat, w/o coat pricing will NOT work! 

Rental price w/o coat... The rental price charged to a customer for this item if it is on a rental 
order that does not include a style that is a COAT item type.  Is the PRICE of a coat when 
no other rental items are on the order (Coat only price). 

Wholesale price w/coat… Available only for WinTPS Production Management installations with 
wholesale accounts. The rental price charged to a WHOLESALE account for this item if 
on a rental order that includes a style that is a COAT item type. If the item being edited is 
rental item of COAT, this field is the rental price for this item.  

 See Store/Accounts Maintenance form section for more information. 
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Wholesale price w/o coat… Available only for WinTPS Production Management installations 
with wholesale accounts. The rental price charged to a WHOLESALE account for this 
item if it is on a rental order that does not include a style that is a COAT item type.  

 

Important Pricing Note: 

Rental Orders that contain only a COAT can utilize Coat Only pricing.  Orders with only a 
Coat rental will use the price in the without (w/o) price field for the coat's rental price.  When 
the order contains a coat and any other rental item(s) the price field with (w/ ) Coat will be 
used for the coat rental price. 

 

Buttons 

Rental Sizes button...Displays the Rental Sizes form for this style code. The Rental Sizes form 
shows the rental quantities and rental statistics for each rentable size. The form also 
allows deletions of Rental Sizes, be careful because a deletion will permanently remove 
all rental history for that size. In addition, items of tracked item types, will have the 
ID/Serial numbers listed for each rentable size.  

Access to rental statistics for each ID/Serial number is available from the form. 

The entry of quantities and ID/Serial numbers is for the use of the WinTPS Production 
Management module only! 

Creating rental sizes is optional for WinTPOS ONLY! The “Allow any size on rentals” option 
in System/Store Setup - Rentals Tab must be checked when no sizes are identified as 
rentable. In this case, WinPOS® will allow any size to be entered on the Rental Order form. 

Store Pricing button… Available with multistore or Wholesale optional software modules. This 
feature allows for each store/account to have different prices for the same rental style. 
See Store Pricing for more information. 

View/Change Base Prices…Displays and allows edits of the retail and wholesale pricing for the 
rental style. The user must have adequate security privileges to edit.  Four fields appear. 

Create Sizes from Chart button...This option is used to add inventory size scales quickly. It will 
create a size and a single receive history entry for every size in the size chart entered for 
this style. The QOH will be set to zero for the new sizes added. Click the Rental Sizes 
Button to add rental quantities OR Barcode/ID numbers for the new sizes.  This function 
can be re-used when new sizes are added to a Size chart.  It will only add the new sizes 
to the SCW & Rental Size forms.   

Save... Save edits. 

Cancel... Cancels / Discards edits. 

Delete... Deletes the selected style and ALL associated information.  CAUTION:  Data is deleted 
and cannot be recalled. 

Add... Add a new style. 

Done... Exits this form and displays previous form. 

 

 

Inventory - Rental Sizes Form 
 

Switchboard: Main->Rental Production->Inventory->Inventory->Rental tab->Rental Sizes button 
and Main->Housekeeping->Rental Setup->Inventory-> Rental tab->Rental Sizes button  
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Menu: Inventory->Rental Inventory->Rental tab->Rental Sizes button  

Action: RENTSCW 
 

This form is for WinTPOS and WinTPS optional software modules only. 

The Rental Sizes form shows the rental quantities and rental statistics for each size created 
within the Inventory SCW form. 

Two classifications of rentable inventory is supported, 1) Tracked 2) Non-Tracked. The Item 
Type assigned to this Inventory item indicates it’s classification.  

Non-tracked inventory will be assigned a rentable quantity to each size. This quantity is the 
maximum number available for the assembly of orders. 

Tracked inventory is assigned Serial/ID numbers to each piece for each size. The total pieces 
entered for each size and marked available will become the maximum number available for 
assembly of orders. 

This form allows additions, deletions and modifications to the quantities available for tracked & 
non-tracked inventory. 

The entry of quantities or ID/Serial numbers is for the use of the WinTPS Production 
Management module only! This module requires the entry of sizes and quantities. 

WinTPOS only users do not have to be concerned with the quantity available for order 
assembly. 

Creating rental sizes is optional for WinTPOS ONLY!  The “Allow any size on rentals” option in 
System/Store Setup - Rentals Tab must be checked when no sizes are identified as rentable. In 
this case, WinPOS® will allow any size to be entered on the Rental Order form. 
 

Fields 

Quantity available for rental… This feature is used with the WinTPS Production Management 
software module only.  

This number represents to the WinTPS™ production management software the total number 
of units for the style & size that are available to be assembled at one time. 

For non-tracked (defined in Item Type maintenance) rental item type, the total quantity 
available for rental is manually entered.  

For tracked rental item type inventory, the total quantity available for rental is is a total of 
items entered within the View Serial Numbers from that is marked Available.  

The total quantity shown must equal the current on hand quantity of the size (found in the 
Inventory SCW form). If the total quantity for the style/size entered does not match the total 
style/size quantity found on the SCW form then WinTPS will enforce this rule and 
automatically make an adjustment entry within the newest RECEIVE HISTORY entry in 
order to make the quantities match.  If no receive history entries exist for the style/size then 
the  system will automatically create one. The system utilizes the quantity on hand total 
within the Inventory SCW form for many reports and inventory valuation. Inventory value is 
available on printed inventory reports and in the Inventory Maintenance->Display Inventory 
Value function. 

 

WinTPS™ offers the Rental Inventory w/Low QOH report as a tool to help insure the 
quantities showing here are equal or less than the total found on the Inventory SCW form. 
This report can produce a list of styles & sizes where the rental total exceeds the Inventory 
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SCW total. It would be up to management to determine why the discrepancy appears and to 
adjust either the Inventory SCW quantity of rental quantity accordingly. 

Hold back... Allows a user to enter a hold back % (fractions allowed) or whole number.  When a 
fraction is used,  the system would compute the holdback quantity). The holdback Qty is 
deducted from that style/size availability quantity. So when users request availability via 
the Availability lookup or during order entry the holdback quantity is deducted from the 
total quantity.  Example, own 50, holdback is 10%, and then availability to rent is 45. 
 (Only used for quick avail and availability from rental form).  This is a tool to help 
manage the rental inventory, allowing a buffer for late order returns and other over 
booking requirements.   

The Check Overbookings form would ignore the HOLDBACK in determining the inventory 
items overbooked.  Why, you would not want to show overbooked and then purchase or sub-
rent, when inventory quantity exists to fill orders. 

Allow sale of rental items? Checkbox…WinTPS users may sale tracked rental inventory by 
entering the item’s serial/ID number into the style field on a ticket. This is allowed when 
this option is enabled by checking. 

Note: 

Rental Items sold by scanning serial/ID number will be automatically marked as unavailable 
for rental/assembly, Sold will be entered into the status field and the current date will be 
placed in the date retired field of the View Serial/ID numbers form. Attempting to sell a rental 
inventory item via the 'Store Style' code INSTEAD of the serial/ID will not update the rental 
status and quantity. 

 

Total, YTD, MTD Revenue...The dollars earned for rentals of this specific size. Total dollars 
refers to the total revenue from this size since it was entered into WinPOS®. The MTD 
and YTD counters are reset automatically by WinPOS® at the start of each month and 
year, respectively. 

Total, YTD, MTD times used...The rental turns for this specific size. Total times used refers to 
the total rentals from this size since it was entered into WinPOS®. The MTD and YTD 
counters are reset automatically by WinPOS® at the start of each month and year, 
respectively. 

 

Grids 

Size Grid...The size gride lists the sizes entered within the Inventory SCW form.  

Serial Numbers Grid… This feature is used with the WinTPS Production Management software 
module only. For a tracked rental item type, the total quantity available for rental is 
computed by summing the ID/Serial numbers entered on the Rental Size Serial Number 
Form.  

This quantity can equal or be less than the current on hand quantity of the size. Once entered the 
WinTPS production management software will utilize the number for computing 
availability for each style/size. 

 

Buttons 

View Serial Numbers button…Available for tracked Rental inventory. It Displays the Serial/Id 
form. 

Delete Size button…Permanently deletes the selected size in it’s entirety. Data deleted includes 
Inventory SCW information, Store Transfers and Serial/Id numbers and all statistics. 
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Once deleted it cannot be retrieved. It is always a good practice to back up data prior to 
making permanent deletions. 

Print... Prints a laundry tag for the currently selected serial number. 

Add New Rental Sizes... Displays the Inventory SCW -> Receive History form and allows a new 
Style / Size entry to be created.  The Rental Sizes form can immediately utilize the new 
style / size created. 

Done button….Exits the form and returns to the calling form. 

Inventory - Rental Size Serial Numbers 

Switchboard: Main->Rental Production->Inventory->Inventory->Rental Sizes button->View 
Serial Numbers and Main->Housekeeping->Rental Setup->Inventory-> Rental Sizes button-
>View Serial Numbers  

Menu: Inventory->Rental Inventory->Rental Sizes button->View Serial Numbers  

Action: RENTITEM 
 

Overview 

This form is available only to the WinTPS software module. 

This form is utilized to maintain the ID/Serial numbers for the tracked rental inventory.  

ID/Serial numbers are assigned to inventory of a specific style & size combination. The available 
rental quantity available for rent by a tracked style/size is determined by the number of ID/Serial 
numbers entered and that also are checked as ‘Currently Available’.  

For example: 15 ID/Serial numbers entered & checked ‘Currently Available’ will produce 15 
available to rent. Un-checking the ‘Currently Available’ checkbox of three of the entered items 
will indicate to the system that only 12 of the 15 are available for rental. See the What is 
Availability topic for more information. 

Grid 

The ID/Serial # grid automatically displays the ID/Serial number, Rent? (Available, checked = 
YES) and Status description that are manually entered in the form’s fields. The grid becomes a 
fast & easy reference for the entered information. The grid automatically sorts the ID/Serial 
numbers to easily locate a ID/Serial number for review. 
 

Fields 

Style Code… The selected inventory style code that is displayed automatically by the system. 

Size Code… The selected size code displayed automatically by the system. 

Serial… The ID/Serial number of the inventory item.  

Hint: 

A ID/Serial Number can be any unique code to identify a item. Tuxedo rental garments, 
like coats, traditionally have bar-code tags included by the manufacturer. These tags 
are typically eight character numbers (utilizing the interleave 2 of 5 bar-code 
symbology) and usually do not overlap numbers provided by other manufacturers. 
However, these tags do not have to be used. Many companies enter their own ID 
numbers or replace tags with new ones if/when they fall out of the item. 

ID/Serial numbers can also be written into the item. Many call this a Control Number. 
They do not have to be bar-codes.  
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However, bar-codes are preferred since they speed up the production process and 
reduce errors by allowing the utilization of bar-code scanning equipment eliminating the 
need for manually entry. 

Hint: 

Double-Click the ID/Serial number field to enter into ‘Edit’ mode. This will allow 
for any data on the screen to be edited, including the ID/Serial numbers & Control 
numbers.  When a serial number is modified/changed the software system 
automatically logs this change, so if ever necessary, a user could determine the 
previous bar-code/serial number of a tracked inventory item. 

 

Control…Control numbers are unique numbers like a ID/Serial number. This feature is optional 
for tracked items but many companies find the feature useful when they are using bar-
code tags that may separate from the item attached to. When this problem occurs, a 
operator finds it almost impossible to identify the item. A control number is traditionally 
hand written onto the item and can be used during the production process in place of the 
ID/Serial number. Once the item is identified a new bar-code tag could be applied and the 
number in WinPOS® modified to match the new ID/Serial number on the new label. 

Currently available, checkbox?… This checkbox is manually checked as an indication to the 
system that the item may be rented and counted for availability. If unchecked the item is 
NOT counted as available for rental. Situations may arise when an item may be in the 
system, but cannot be rented. Examples of not available for rental situations are in repair, 
lost, sold, retired ..etc.  

Comment…A 20 character note field which allows any information to be entered. May be used 
action notes, for example, do not delete prior to a date, what item requires for repair ..etc. 

Status…A description of the items’s status. The descriptions have to be pre-created by 
management during system set-up and are used as visual reference and reporting. 
Example statuses are display, repair, lost, sold, retired.. etc. See the Item Status topic for 
more information. 

Hint:  

The operator should check or un-check the Currently available? selection to indicate to the 
system a status that is available or not for rental. 

 Hint:  

Items may be LOST or RETIRED (and possibly other statuses), but should not be 
immediately deleted from the system. BBL recommends items to be kept in the system for a 
minimum of 12 months to preserve the statistical information. 

Date Retired…Date manually entered by a operator indicating the item was retired from further 
rentals. The Currently available? checkbox should be unchecked. WinTPS offers an 
Rental Inventory Purge feature that is based upon the Retired Date. 

Location 1… Rail position 1. Will be printed on Laundry Tag to identify where item should be re-
hung. Great for temporary workers who may not be familiar with warehouse layout. 

Location 2… Rail position 2. Will be printed on Laundry Tag to identify where item should be re-
hung. 

Tag Description… Printed on Laundry tag. Description may be entered during laundry return of 
item. Example of a description: the out-seam of pants. Makes for faster assembly when 
clerk can pull pants hemmed to correct length. 
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Created… The date the item was added into inventory. This date is automatically filled in by the 
system. 

Last rented…Automatically entered by system when item is assembled on a order and shipped.  

Last Location…The Store/Account code of the last location to receive this item as part of a 
rental order. 

Last Order… The last order number this item was assembled onto. 

Last Status…The current status of the line item on the last order this item was assigned to.  

Last Physical...The date of the last rental physical update that included/counted this serial/ID. 

Life, YTD, MTD Revenue...The dollars earned for rentals of the highlighted serial number. Life 
dollars refers to the total revenue from this size since it was entered into WinPOS®. The 
MTD and YTD counters are reset automatically by WinPOS® at the start of each month 
and year, respectively. 

Life, YTD, MTD times used...The rental turns for this specific serial number highlighted within 
grid. Life times used refers to the total rentals from this size since it was entered into 
WinPOS®. The MTD and YTD counters are reset automatically by WinPOS® at the start 
of each month and year, respectively.  WinBPS automatically maintains the turns of a 
rental garment and increments/decrements when it is assigned to a order.  Turns may be 
re-calculated if ever needed via the Inventory maintenance - Recalculate Rental 
MTD/YTD function. 

 

Buttons 

Add…This button will add a new item for the Style and Size selected on the Retail Sizes Form.  

Add by Scanning...Is a fast way to enter multiple new Serial/ID numbers for the selected rental 
item.  Select this function and start scanning, one after another.  Once the last item is 
scanned, click the Cancel button. 

Delete…This function will delete the displayed item and all of it’s information including statistics.   

Done…Exits the form and returns to the calling form. 

Print…Prints a laundry tag for the current tracked item. 

Inventory - Store Rental Pricing 
 

Switchboard: Main->Rental Production->Inventory->Inventory->Rental Tab and Main-
>Housekeeping->Rental Setup->Inventory->Rental Tab  

Menu: Inventory->Rental Inventory->Rental Tab 

Action: RENTPRIC 

 

This form is available with the MultiStore and WinTPS or WinTPOS software modules. It will 
allow a rental prices to be established on a store by store basis.  

The system will default to the Base Rental price of the style if a entry does not exist modifying 
the price for a particular store. 

To enter a price different from the base, a operator simply displays the form and adds a entry for 
the location. 

 

Fields 
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Style… The inventory style that the rental pricing applies to. The style must exists in inventory. 

Store…. The store code that the pricing is for. The code must exist in the store/account file. 

 

Rental price w/ coat...The rental price for this item to a customer if on a rental order that 
includes a style that is a COAT item type. If the item being edited is rental item of COAT, 
this field is the rental price for this item.  
 
Hint: The COAT item type is system defined and cannot be modified within the item type 
maintenance form. 

Rental price w/o coat... The rental price charged to a customer for this item if it is on a rental 
order that does not include a style that is a COAT item type.  

 

Wholesale price w/coat… Available only for WinTPS Production Management installations with 
wholesale accounts. The rental price charged to a WHOLESALE account for this item if 
on a rental order that includes a style that is a COAT item type. If the item being edited is 
rental item of COAT, this field is the rental price for this item.  

 See Store Maintenance form section for more information. 

Wholesale price w/o coat… Available only for WinTPS Production Management installations 
with wholesale accounts. The rental price charged to a WHOLESALE account for this 
item if it is on a rental order that does not include a style that is a COAT item type.  

Inventory - SCW 

Switchboard: Main->Inventory->Inventory->SCW (size,color,width) and Main->Housekeeping-
>Inventory Setup->Inventory->SCW (size,color,width) 

Menu: Inventory->Retail Inventory->SCW (size,color,width) button 

Action: RETLSCW 
 

WinPOS® tracks inventory on style and size/color/width levels for each store in your chain 
(available in the optional multi-store version). This capability include maintaining a complete 
receiving and inventory movement history. This allows for statistical information at each of these 
levels allowing the user to easily know how many of each size sold, how many are owned, when 
it was received, etc, at each store location. 

There is a SCW size description called OTHER. OTHER is a system defined SCW. Each 
inventory style contained within the system will have a SCW called OTHER and it’s entry cannot 
carry a quantity on hand. OTHER cannot be deleted or edited and is automatically created by 
WinPOS® when a new store style is created. Price tags should not be printed for the size 
OTHER. 

The OTHER SCW is a used by the system to hold sales information about the style it is 
assigned to. An option within WinPOS® is the ability for a operator to sell any size or color or 
width of a entered inventory style, even if that size or color or width is not found under the 
inventory style. Basically the operator is allowed to enter ANY size, color or width for the style 
when that option is set within General Setup. This is called an un-validated entry. 

DO NOT add an another size called OTHER when adding new SCW items. Quantities of ANY 
SCW with a size called OTHER will be automatically deleted by the Physical Inventory module. 

All retail sales statistics are accumulated under the SCW OTHER in the instance that the 
Housekeeping->General Set-up->System Store/Set-up Option Tab in Tickets Section ‘Allow 
sale of item not in inventory (checked = YES) and the operator sales an item on a Ticket with a 
Size or Color or Width that is not in the inventory file for that style. 
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Fields 

Size, Color, Width, QOH grid ...Using this list grid you can select the size, color, and width you 
want to work with. The last column is the quantity you currently have on hand. This 
quantity is maintained automatically. It is the total of the QOH for every Receive History 
entry for this size/color/width. If you need to manually change the QOH, change the QOH 
via the Receive History form. 

Receiving History grid…This grid shows the receive history for the selected size/color/width. 
You can select an item and click the Edit Receive History button to display the Receive 
History (RETLHIST) form which shows all the details for the receive entry. 

SKU…The SKU is automatically generated when you add a new SCW using the Add New SCW 
button. You can also edit it here. At sale time you can enter the SKU on the Ticket form to 
sell the item. 

Barcode…The barcode uniquely idenfies the item and is automatically assigned by WinPOS. 
You cannot change the barcode. At sale time you can enter the barcode on the Ticket 
form to sell the item.  Bar-codes should have a even number of digits.   

Note: tags with barcodes for reading with barcode scanners should barcode this barcode 
number. The barcode number is automatically generated by WinPOS® with new inventory 
style/size/color/widths are added.  

Note: If the barcode number generated by WinPOS™ is not an even number of digits, contact 
BBL for support. Barcode number are more flexible when they contain an even number of 
digits. 

UPC…You can enter the UPC code of the item here if you wish. At sale time you can enter the 
UPC code on the Ticket form to sell the item. 

Average Unit Value... The system will automatically calculate the per unit average cost for this 
SCW item utilizing the System Setup-> Other Settings-> Inventory Costing LIFO /  FIFO 
setting.  The formula is simple:  QTY Left * Unit Cost (for each receiving history) / Total 
quantity on hand 

Qty on Hand...Total quantity on for the selected Size, Color, Width of this style. 

Qty on stock orders...This will show your total quantity for this style, size, color, and width that is 
outstanding on stock purchase orders. 

Reorder Quantity... When your quantity on hand falls below this number, you typically reorder. 
This is used by the Reorder Report, at Main->Reports->Inventory Reports->Reorder 
(RP_INVRE) to show you the items you should reorder.  The quantity entered here will 
supersede any quantity entered inn the Reorder field on the Style - Details Tab.  The 
Inventory Reorder report will list styles SCW items that the Quantity on Hand has fallen 
below the Reorder quantity.  

Date of Last Physical...This is the date of the last physical that counted this selected Size, 
Color, Width inventory item. 

 

Checkbox 

Show in Web Catalog? (checkbox)...This indicates to the system to create a HTML (web) page 
for this Size, Color, Width item when the Create Web Catalog function is ran. 

 

Buttons 
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Print button...Allows you to print price Tags for the selected inventory item. At least one 
inventory Tag must have been created  in the Housekeeping->Letters/Tags/Mailing 
program.  When clicked, a list of the Tags that are set up for printing will be displayed for 
one to be selected. When a single inventory tag is defined WinPOS© will print it 
automatically.  Also, fir items that have a quantity on hand greater than one the system 
will stop and ask you for the number of tags to print.  Just enter 1 or the total quantity to 
print. 

Add Qty for this SCW button…Click this button when additional inventory quantities for the 
selected size/color/width should be added. WinPOS will display the Receive History form 
so you can enter the quantity received, date received, PO number, and other relevant 
information. Remember, you cannot change the QOH directly on the RETLSCW form, 
you can only affect the QOH by adding Receive History entries, or changing existing 
receive History entries. 

Edit Receive History button…Displays the Receive History form for the selected entry in the 
Receiving History grid. 

Add New SCW button…Allows you to enter a new size/color/width. Actually displays the 
Receive History form so you can enter the size/color/width, quantity on hand, quantity 
received, date received, unit cost, etc.  
 
When you are entering a new SCW, you should always enter at least a size code. Even if 
the item does not come in sizes, use NA or NONE. A size, color, or width code can only 
contain letters, numbers, and $, %, *, -, +, /. It cannot contain “, ‘,[ or ]. 

Transfers... Optional multi-store module feature.  Creates a transfer document for the currently 
selected SCW item. 

Store QOH / STATS... Optional multi-store module feature.  Allows operator to view each store's 
sates statistics and view/edit each store's quantity on hand. 

Delete...Deletes the currently selected SCW record, it's receiving history and store stats. 
 Caution, data cannot be recalled. 

Save... Save the edits. 

Cancel... Cancel / Discard session edits. 

Done... Exit to previous from. 

 

 Rental Inventory Hint: 

The WinTPS Rental Production Management software option cannot designate any style as 
an rental style if the style has a color or width entered. 

 

 

 

Inventory Receive History 

Switchboard: Main->Inventory->Inventory->Details Tab->Receiving History and Main-
>Housekeeping->Retail Inventory->Inventory->Details Tab->Receiving History  

Menu: Inventory->Retail Inventory->Details Tab->Receiving History 

Action: RETLHIST 
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This form allows for the review and entry of important data when inventory is manually created, 
modified or received via Stock Purchase Orders. There will be a entry created each time you 
receive or add items of a certain style, in a particular size, color, and width. 

A operator with adequate security may change the quantities of a existing receive history 
record. WinPOS® will track this change in a Action Log as an audit trail. 

Each time you receive via Stock PO or manually add inventory, WinPOS® will track the date, 
the total quantity received, along with the cost. Then as items are sold, WinPOS® removes 
items from inventory according to your inventory costing method, LIFO or FIFO (inventory 
costing is a General Setup option). With LIFO, the items received most recently are the first 
sold. With FIFO the oldest items are sold first. 

WinPOS® uses this information to compute the average unit cost, which is used for the 
inventory value computation. For this reason, it’s important to either receive items via a stock 
PO, or manually create a receive history record when items are received. You can manually add 
receive history records by pressing the Add button. You would do this if you are not creating 
stock purchase orders but still want to track quantities received and costs. You can also edit 
receiving history entries. When you change a receiving history entry you will be prompted for a 
sales associate ID and the reason for the change. You will not be able to save the change 
without entering both the ID and the reason. This will then keep a log of all the changes that 
have been made to the receiving history for use in other reports such as the inventory 
movement report. 
 
WinPOS© provides an editing option within the Purchase Order Maintenance module to Un-
Receive a PO after it was previously received.   When this function is preformed, a new 
RECEIVE History entry is created deducting the quantity being removed with the code: UN-
RECV PO entered in the invoice number field. 
 
Automatic Receive History entries are created in specific scenarios 1)  Un-Receive POs  2) 
Manual store quantity edits in multi-store View Store QOH/Stats from  3) Rental quantity 
adjustments from Rental Sizes form  4)  Physical inventory variances from Update physical 
count.  Each is designed to synchronize  on hand quantities. 

Hints: 

When creating a new SCW entry, you should always enter at least a size code. Even if the item 
does not come in sizes, use NA or NONE. A size, color or width code can only contain letters, 
numbers, and $, %, *, -, +, /. It cannot contain “, ‘,[ or ]. 

The WinTPS Rental Production Management software option cannot designate styles as a 
rentable style if the Size contains color or width. Size only is allowed! 
 
Fields 

Style/size/color/width...For the item received.  Defaults to selected SCW unless the Add a new 
SCW was chosen. 

Store ID…This is the store where the item was received, not where it is located.  

Date received...The date you received this batch. As you enter receiving history entries, the 
current day’s date will be auto entered. If you update this to a date later than the date last 
received on the Retail Sizes and Retail Inventory form the date last received will updated 
on those two forms as well. Otherwise it will not. 

Qty received…The total quantity that was received. 

Qty left (on hand)…Out of the total quantity received, this is the quantity left on hand after sales, 
returns, etc. It is important that this number is accurate, since this number is used to 
compute inventory value. 

PO number/item…From the PO that ordered this item. 
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Received by…The employee who received the items. 

Invoice number…The invoice that the items were received on. 

Unit cost…The unit cost for this item. It is important that this number is accurate, since this 
number is used to compute inventory value and to record cost of sales. 

 

Buttons 

Save... Save the sessions edits. 

Cancel... Cancel / Discard this sessions edits. 

Delete... Delete the selected history entry.  Caution, data cannot be recalled. 

Add... Adds a new SCW history entry for the selected SCW inventory item.  The size, color and 
width defaults to the currently selected item.  The quantity on hand is added to the 
register's store location performing the addition.  The item(s) must be transferred to 
another store via the TRANSFER function OR the QOH manually modified via the Store 
QOH/Stats from (available  with the WinPOS multi-store software option). 

Done... Exit this form and display previous form. 

 

Inventory - SCW Retail Statistics 

Switchboard: Main->Inventory->Inventory->SCW Statistics button and Main->Housekeeping-
>Inventory Setup->Inventory->SCW Statisitcs button ( 

Menu: Inventory->Retail Inventory->SCW Statistics button  

Action: RETLSIZE 
 

WinPOS® accumulates sales statistics for each inventory item owned. Companies have a 
choice to utilize size, color & width for inventory items. WinPOS® will maintain sales statistics at 
that level very well. 

There are two choices for seeing the sales statics for a inventory style. The first is the Statistics 
Tab and the second is the SCW Statistics button. 

The SCW Statistics button will display the retail sales totals by the inventory size, color, width 
(SCW) breakdown created by the shop. 

Hint: 

There is a SCW description called OTHER. OTHER is a system defined SCW. Each inventory 
style contained within the system will have a SCW called OTHER and it cannot carry a quantity 
on hand. OTHER cannot be deleted or edited. 

The OTHER SCW is a used by the system to hold sales information about the style it is 
assigned to. An option within WinPOS® is the ability for a operator to sell any size or color or 
width of a entered inventory style, even if that size or color or width is not found under the 
inventory style. Basically the operator is allowed to enter ANY size, color or width for the style 
when that option is set within General Setup. This is called an non-validated entry. 

All retail sales statistics are accumulated under the SCW OTHER in the instance that the 
Housekeeping->General Set-up->System Store/Set-up Option Tab in Tickets Section ‘Allow 
sale of item not in inventory (checked = YES) and the operator sells an item on a Ticket with a 
Size or Color or Width that is not in the inventory file for that style. 
 

The form displays all the sizes, colors & widths entered for the selected style 
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The information currently displayed is for the highlighted SCW. 
 

Show Stats & pricing? … When unchecked the form does NOT display the MTD, YTD and Life 
sales totals. This option exisits to speed the display of the other information on the form 
when skipping from one SCW to another. The MTD, YTD and Life totals are dynamically 
calculated from the ticket data and can take a few moments to complete for each SCW. 

Size, Color, Width...The size, color, and width of the item. You should enter at least one size, 
even for items that are not sized. You can use FA (for fit all) or NA (not applicable.) 
 
A size, color, or width code can only contain letters, numbers, and $, %, *, -, +, /. It 
cannot contain “, ‘,[ or ]. 

Qty on hand...The quantity you currently have on hand. This quantity is maintained 
automatically. It is the total of the QOH for every Receive History entry for this 
size/color/width. If you need to manually change the QOH, change the QOH via the 
Receive History form. 

Qty on stock orders...This wil show your total quantity for this style, size, color, and width that is 
outstanding on stock purchase orders. 

Reorder cost...This is wholesale cost to reorder a new item. This amount is calculated 
automatically, based on the reorder cost for the style plus any costs for extra charges that 
apply to this size. 

Last received...The date you last received this item, either via a stock PO or by changing the 
quantity on hand directly. You cannot change this date directly. However, if you update 
the last receive date on the Receive History form, and that date is later than the date 
here, the date last received on the Retail Sizes and Retail Inventory will be updated. 

Retail price 1 & 2...Retail is the base retail selling price of this size. It is the same as the 
markdown price from the style.  

Mkdn Retail Price 1 & 2...If there are any promotional prices, or extra charges that apply to this 
size, the resulting new selling price will be displayed in the Markdown Retail Price 1 & 2 
fields. You can double click on this field to show how WinPOS® is computing the 
markdown price. 

Gross Margin 1 & 2...WinPOS® tracks the gross margin of an inventory size. This number is 
automatically calculated for you.  

MTD Sold...Every time the WinPOS® program is started, it checks the current date. If WinPOS® 
sees that a new month has started, it will ask the user to reset the MTD totals. If you 
choose to reset them, WinPOS® will reset the following MTD (Month to Date) figures to 
zero, like a trip odometer on your car. In order for WinPOS® to track these figures 
accurately, the MTD totals must be reset to zero at the beginning of each month. 
 
MTD Sold is the total number of times the SCW has been sold since the last time the 
MTD counter had been reset to zero. WinPOS® records this information automatically. 

 Sold 1 & Sold 2 totals for MTD, YTD and Life are the total times sold for Price 1 & Price 2 
respectively. 

MTD revenue...This is the amount of total revenue this size has generated since that last time 
the MTD counter had been reset to zero.  

MTD cost of sales...This is the total cost of sales for this size since that last time the MTD 
counter had been reset to zero. WinPOS® records this information automatically. 

MTD gross margin...MTD Gross Margin % is similar to the gross margin percentage shown on 
page 1 of the inventory, except that the number shown here is a month to date total. 
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Again, it shows the total since last time the MTD counter had been reset to zero. 
WinPOS® records this information automatically. 

YTD Sold...These figures are identical to the month to date fields, except these figures are 
accumulated on a year to date basis. When the program is first started on January 1st, 
the system will prompt the user if she/he wishes to reset the YTD numbers in addition to 
the MTD numbers. 

YTD revenue, sales, gross margin...These figures are identical to the month to date fields, 
except these figures are accumulated on a year to date basis. 

Total Sold...These figures are identical to the month to date fields and year to date fields, except 
these figures are accumulated on a lifetime basis, i.e. since the day they were entered 
into WinPOS®. These figures cannot be reset to zero. WinPOS® records this information 
automatically. 

Total revenue, cost of sales, gross margin...These figures are identical to the month to date 
fields, except these figures are accumulated on a year to date basis. 

Print button...Allows you to print Tag(s) for the selected SCW inventory item. When you click it, 
you see a list of the tags that are set up to print for Retail Size (InvDetail) will display, and 
you can select one to print. If you only have one designed, it will print that one 
automatically. 

Retail Inventory Stores 

Switchboard: Main->Inventory->Inventory->SCW->Store QOH/Stats and Main->Housekeeping-
>Inventory Setup->Inventory->SCW->Store QOH/Stats 

Menu: Inventory->Retail Inventory->SCW->Store QOH/Stats 

Action: RETLSTOR 

 

This feature is available with the optional WinPOS® Multi-Store integration WinPOS®. This 
feature maintains retail inventory SCW statistics and on hand quantities on a store by store 
level. 

The SCW form will display quantity on hand by SCW with the mult-istore option installed. By 
selecting the View Stores Statistics button the screen will display sales statistics (MTD, YTD, 
Totals) and quantities on hand at the store level.  

This form also provides the variance from what the computer believed to be Quantity on hand to 
what was physically counted at the last physical (if any) and the date the style, size, color & 
width was last physically counted. 

Each store's on hand quantity (QOH) for the SCW may be manually modified on this form. 
 QOH changes will automatically adjust the Receive History to match the manually QOH edit, 
when different.  As an aid for QOH edits, the system display two values in top right corner, 1) 
Total QOH for all stores (based upon the values entered in this form) 2) Total QOH for receive 
history (total QOH entered in the receive history). 

Note 

The preferred method for updating store quantities is via the TRANSFER form.  This 
requires the transfer out and receipt steps and thus provides a great audit trail.  Edit store 
quantities directly on this form bypasses the audit trail, but is a very quick way to correct 
entry errors.  All manual quantity modifications are logged. 

Hint: 

The totals shown on the SCW statistics and Statistics Tab are calculated on-the-fly by 
summing the quantities for each store. 
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Fields 

Store...The store where this inventory is located.   Click a store in the grid to see a specific 
store's stats. 

Qty on hand…The total quantity on hand at this store.  

   

To make a change to this field, double-click on it. If security is enabled (the security option 
that controls access to this field is HISTQTY) the user will be prompted for a username and 
password.  
 
The total QOH for all stores must match the total QOH for the receive history. When you 
change the QOH and close this form, WinPOS will change the total QOH for the Receive 
History for this style/size/color/width to match the total QOH here for all stores after providing 
a warning. For this reason, it is important that he total QOH for all the stores is correct when 
the Save button is clicked. 

With the optional WinTPS rental production module the system warns the user when the 
manual quantity adjustment makes the total on hand quantity fall below the rental quantity on 
the Rental Sizes form.  The Rental Sizes form show a quantity equal to or less than the total 
on hand quantity.  A user must correct this error condition by increasing the on-hand quantity 
on the stores form or the Rental Sizes quantity. 

 

Sales statistics…These are the sales statistics for this specific store. The type of statistics are 
documented in detail on the Sizes form. 

Variance from last physical…The total quantity over/under during the last physical. A positive 
number means that the quantity actually counted during the physical was more than the 
quantity on hand in the computer. A negative means you counted less than the computer 
thought was on-hand. 

Date of last physical…This date indicates the date that the selected  Size, Color, Width was 
counted for the selected store. 

 

Buttons 

Save... Save this session's edits. 

Cancel...  Cancel / Discard  edits. 

Delete... Delete the currently selected store's SCW quantities and stats.  CAUTION, data cannot 
be recalled.  If unsure, DO NOT delete. 

Done... Exit this form and return to previous form. 

Extra Charges 

Switchboard: Main->Housekeeping->Inventory Setup->Extra Charges and Main-
>Housekeeping->Inventory Setup->Vendors->Extra Charges Button (EXTRA) and Main-
>Housekeeping->Inventory Setup->Inventory->Style Tab->Extra Charge Button (EXTRA) 

Menu: Setup->Retail Inventory Setup->Extra Charges and Setup->Retail Inventory Setup-
>Retail Inventory->Style Tab->Extra and Setup->Retail Inventory->Vendors->Extra Charges 

Action: EXTRA 
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Overview 

Creating Extra Charges for items special ordered is an important feature.  It allows for codes & 
instructions to be attached to the items being ordered making it easy for the supplier to 
understand what is being ordered as well as capturing the correct costs for each added charge. 
 This information is printed on the Purchase Order and on the customer's sales receipt as an 
agreement of what is being ordered for how much, as well as maintained with the SALE of the 
item so the proper sales reporting and accounting/auditing may be performed.  Extra Charges 
may be listed separately on Sales Reports with their own selling price, cost & gross margin.   

Extra charges for sales transactions that have a special ordered status  will automatically 
appear on Purchase Orders as separate line item(s) directly below/associated with the item they 
are applied to. The cost of the extra charge will be listed with each. 

Extra Charges may be predefined (when they are known in advance, i.e. large sizes or extra 
length) or they may be ad-hoc.  Meaning they may be added to the SALE at point of sale and 
repeatedly used 

Extra charges may be manually applied at Point of Sale by the operator OR set to automatically 
apply when an item is sold with specific parameters.  This is all created/maintained within the 
Extra Charge form explained in this topic. 

Extra charges entered may be applied to any sale transaction for any store in Multi-Store 
installations (not store specific). 

Deleting an extra charge from this setup form has no effect on tickets that may have used the 
extra charge being deleted.  It will stay on the tickets and POs that it was utilized on. 

 

Creating Pre-Defined Extra Charges 

 

Inventory - Details Style tab 

Extra Charges may be set to only be applied to specific inventory styles, and entry form is 
located at: 

Retail Inventory form on the Style Tab using the Extra Charge Button or 

From a customer's sales ticket by selecting the ticket SALE item and clicking 
Adj/Cancel/Extra Chrg-> Add Extra Charge-> Add Perm Extra Charge  (EXTRA)  

Displays the Extra Charges form, only showing extra charges for the selected/displayed style 
code & allowing new extra charges for this style to be created.  These extra charges may 
only be applied to this style when sold on a sales ticket and will print on POs. 

 

Vendor - Extra Charges 

Extra Charges may be set to only be applied to all styles of a specific vendor, and  entry 
form is located at: 

Vendor form, Extra Charges Button or 

Allows for vendor specific extra charges to be maintained.  Extra charges set up from this 
form apply to the selected/displayed vendor only. Thus, when adding a extra charge on a 
ticket to an inventory item manufactured by this vendor, the charges entered here will be 
included within the extra charge list.  Additionally, the user can enter a manufacturers style 
code, and/or category within this form to further limit which items from this vendor the extra 
charge may be applied to.  These will print on POs. 

 

Inventory Switchboard 

Extra Charges may be set to apply to all styles and all vendors, and entry form is located at: 
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Extra Charges form 

This form lets the operator to maintain extra charges for the store.  The charges entered 
from this menu function with a BLANK Vendor style & Category cross over all vendors & 
inventory items. These are pre-defined prices for extra charges to any inventory items sold 
on sales tickets. Extra charges created on this form can apply to any item sold.   

Extra charges created here with no vendor or vendor style are not style or vendor specific 
and later applied to items on sales tickets will not print on POs. 

Optionally, this form also allows for the entry of a vendor style and/or category which make 
the extra charge applicable to a matching category/style inventory item when sold. 

Ad-Hoc 

To manually add an extra charge to a sales ticket, first, display the ticket & select the item to 
apply the extra charges to. Then, click the Adjust/Canc/Extra Chrg. transaction button on the 
ticket form and then click Add Extra Charges.  A menu of existing pre-defined charges will 
appear for the operator to choose.  Now, the operator may use an existing extra charge or may 
click the Add Perm Extra Charge to create a new pre-defined charge for the selected style & 
vendor.  This extra charge will be saved and can be re-used for later SALE transactions for the 
same style/vendor.  The operator may alternately choose Quick Add Extra Charge which 
allows for a 'one time use' (temporary) extra charge to be added to the ticket for the selected 
sales transaction.  This charge is NOT saved in the Extra Charge database for later use. 

The  Quick Add Extra Charge form allows for a charge description retail price and wholesale 
cost to the entered.  In addition the operator may enter the item's PO private instructions which 
allows for significant comments to be entered describing the specific extra charge details.  All 
this information is printed onto the PO when issued.  Private instructions do not print on the 
customer's receipt whereas the description & retail price will. 

 

Using Pre-Defined Extra Charges 

To manually add an extra charge to a sales ticket, first, display the ticket & select the item to 
apply the extra charges to. Then, click the Adjust/Canc/Extra Chrg. transaction button on the 
ticket form and then click Add Extra Charges. You will then see a list of the extra charges 
defined for that item. This list will include 1) Extra Charges defined to be store wide, 2) Extra 
Charges defined to be specific of the vendor that manufactures the selected item and 3) Extra 
Charges entered to be specific to the highlighted inventory item.  Select the extra charge from 
the list and it will be added to the sales ticket. 

Extra charges can also be automatically added to tickets in specific circumstances. See 
Automatically apply this extra charge section below. 

Extra Charges show on a ticket with a transaction code of Extra Chg. 

 

Editing Extra Charges 

Once an extra charge is added onto a customer's sales ticket it may be edited.  Extra Charges 
may be edited from the customer's sales ticket that contains the extra charge or from the PO 
Item Maintenance form of the sales transaction, if special ordered. 

From PO Item Maintenance 

Locate & select the PO item (the PO item is found on the sales ticket and from the PO 
reports).  Once selected click the Details Tab.  The Extra Charge button letters will display in 
BLUE when Extra Charge transactions are present.  Click the extra charge button to see a 
list of Extra Charges attached to this item.  Double click the Extra Charge to edit.  Once 
selected the Extra Charge may be deleted or any of it's details modified which will be 
reflected on the PO when printed and customer sales receipt. 
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From Ticket 

From the ticket simple highlight the Extra Charge line needing editing and click the 
Adjust/Cancel/Extra Charge transaction button.  The Extra Charge details will appear for 
editing.   

Hint: 

Be careful of editing extra charges for special orders once POs are printed.  The ordering 
information may be with the vendor and cannot be changed.  Extra Charge wholesale costs 
may be changed at any time, even when it a PO is printed.  This is helpful when adding a 
extra charge to a customer's ticket and the wholesale cost is not known.  Later when the 
cost is learned, a user may enter it within the system form the customer's ticket or from the 
PO Item Maintenance form. 

Extra Charge edits or deletions, including edits to special or private instructions are logged 
for security purposes. 

 

Extra Charge form Fields 

Code...A alphanumeric code that identifies this extra charge (does not have to be unique).  

SmartLink code...A single letter code that identifies this extra charge to the vendor.  Only used 
for vendors that support SmartLink, when purchase orders are sent electronically to the 
vendor.   

Description...A unique description that identifies this extra charge. 

Category...If you enter an inventory category here, this extra charge will only apply to retail 
inventory of this category. 

Manufacturers style...if you enter a manufactures style number, this extra charge will only apply 
to sales of that specific manufacturer style code. 

Cost 

Cost $...The fixed vendor cost for this extra charge. 

or 

Cost %...Instead of a fix cost the cost may vary.  WinPOS© will dynamically compute a cost 
based on the setting below.  This is computed as a positive adjustment, versus a normal  

Compute cost % on...When using the cost % option you can now select what number WinPOS 
computes the percentage on.  The options are:  
 
Style cost: Computes the extra charge cost as a % of the cost of the style sold.  
Style price: Computes the extra charge cost as a % of the price of the style sold.  
Extra charge price: Computes the extra charge cost as a % of the price of the extra 
charge itself.  

Note: 

If the Cost $ & Cost % fields are left empty, WinPOS© will prompt the operator for the cost of 
the Extra Charge when it is applied to the sale item on the sales ticket. 

Retail 

Retail $...The standard/fixed Retail price charged to customers for this extra charge. 

or 

Retail %...Instead of a standard Retail price the Retail charge may vary.  WinPOS© will 
dynamically compute a Retail price based on the selling price entered for the item the 
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extra charge is being applied to.  Note that this is entered as a % markdown (10% for 
example) but will be computed as a positive amount. 

If Retail $ is 0 and Retail % is blank, prompt for the retail price of the extra charge at sale 
time (checkbox)?... If the Retail $ & Retail % fields are left empty, WinPOS© will prompt 
the operator for the retail selling price of the Extra Charge when it is applied to the sale 
item on the sales ticket, if this option is checked.  Otherwise, WinPOS will leave the price 
zero. 

Compute retail % on gross price?... If a Retail % is entered for the retail price of the extra 
charge, it is normally computed on the net retail price.  That is, the retail price with all 
discounts and adjustments applied.  If this option is checked, then the retail % is 
computed on the gross price, with no adjustments or discounts.. 

Hint: 

The Extra Charge transaction is like an adjustment on a sales ticket, however it's retail price 
and cost are stored on the Extra Charge transaction and cost is POSTED to the revenue 
report as a separate entry..  These costs are reflected in the inventory statistical information, 
sales reports and accounting type reports like cost of sales. 

 

Sizes…A list of sizes that this extra charge applies to. Separate sizes with a comma. This is used 
to automatically apply extra charges to items. For example, if you sell a size 15, and an 
extra charge has 15 in it’s list of sizes (and the Automatically apply this extra charge 
option is checked) the retail price & cost for the extra charge will be added to the sales 
ticket. 
 
Sizes do not have to be entered in as an exact size.  For example, when the extra charge 
should be applied to a range of sizes the entry 20-26 is accepted and the charge will 
apply to any size between & including 20 thru 26.  Enter 20-26, WinPOS will 
automatically expand the number to 20,21,22,23,24,25,26 automatically when the form is 
saved. Try not to include spaces when entering sizes. 
 
You should never enter letters in the size field.  For example, 20W will not work.  If the W 
is required for the extra charge, then it should be entered in the Code field.  The 20 part 
then goes in the Size field. 

Automatically apply this extra charge (checkbox)?...If checked, WinPOS® will automatically 
add this extra charge to a sales ticket when an inventory item is sold when this option is 
checked and the "Auto apply if" selection is valid 

Auto Apply if (select one)...  

• Code or Size Matches: The extra charge Code matches part of the size of an item. 
For example, the code is EX and the size of an item being added to a sales ticket is 
12EX. The code is case sensitive and must match the letters in the size exactly. 

• Code and Size Matches:  both a numeric size from the size list and the code on the 
extra charge must match the size and code sold.  For example, if the size was 
16EX, then the extra charge code would have to be EX, and 16 would have to 
appear in the list of sizes. 

• Size matches only:  Only the numeric size is checked against the list of sizes on 
the extra charge.  If the size sold was 16EX, and the extra charge code was EX, but 
the sizes were 8,12,14, then the extra charge would not apply. 

 

 

Cost Factors 
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Switchboard: Main->Inventory->Inventory->Cost Factors  

Menu: Setup->Retail Inventory->Cost Factors 

Action: COSTFACT 
 

Overview 

Cost factors are percentages used to automatically compute the value of all the inventory 
owned.  The inventory value is computed by (Quantity on hand * (Average Cost - Vendor 
discount %)) * Cost Factor 

A company could establish inventory depreciation criteria with the help of an CPA. The criteria 
are then entered within the Cost Factor form. WinPOS® automatically applies the Cost Factor 
value criteria to each inventory item and utilize the cost Factor in real time, meaning the moment 
a rule applies to an inventory entry the factor will be used to compute it's value.   

 

Criteria 

Category…This cost factor applies only to items in this category. 

Sub-category... The sub-category of the item 

Discontinued (checkbox)…If checked, this cost factor applies only to discontinued items. If not 
checked, this cost factor applies only to non-discontinued items.  Important:  The 
presence of a discontinued date on an inventory item does not automatically qualify for 
this option.  The date on the inventory item must be in the past of the current date when 
this is checked. 

Age in days…The cost factor will apply only to items older than the age in days (as measured 
from the last receive date) 

Received between... The inventory item's last received date must fall within the range entered. 
 Leave blank to ignore this criteria, thus make all items qualify. 

Cost factor...Enter a whole number representing the cost factor. If you want to carry this 
inventory item at 100 percent of cost, enter 100. If you want to carry it at 50 percent, 
enter 50. Example: The shop has a quantity on hand of 1. The netcost of the item is 
$300. The item meets a set of Cost Factor rules that uses a cost factor of 25%. In this 
case the item would report a inventory value of $75. 

 

Inventory Categories 

Switchboard: Main->Housekeeping->Inventory Setup->Inventory Categories 

Menu: Setup->Retail Inventory->Inventory Categories 

Action: INVCLASS 

This form lets you maintain inventory categories. Inventory categories are codes that you assign 
to inventory that let you group inventory into logical sets; bridal gowns, veils, bridesmaid 
dresses, coats, pants etc. Many of the sales and inventory reports will break down by 
categories, and can also be filtered to show selected categories. When you add retail inventory, 
you must assign a category to it. If you try to delete an inventory category a warning box will 
appear letting you know which styles are using that category and asking if you are sure you 
want to delete it. 

As new inventory categories are created, WinPOS® automatically creates Accounting Classes 
and GL Account Numbers, and adds a line item for the new inventory category to the Revenue 
Report Setup. 
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WinPOS includes some pre-defined categories that should NOT be deleted.  These categories 
have been assigned to default pre-defined inventory styles that are used automatically by the 
system in specific circumstances on sales tickets.  The default category codes are: 

BF (Balance Forward), BPSCONVADJ (DOS BPS conversion entry), DMGWAIVER (rental 
damage waiver), LATEFEE (rental late fee), NOSKU (no style code in inventory for item being 
sold), TF (tax forward), LOSTITEM (rental lost item), GiftCert (Gift certificate/Card), Shipping 
(rental shipping charge), Misc (a general category)  and RENTAL (Rental transaction on Sales 
Tickets, created rental orders).  

Note 

With the optional WinTPOS module rental orders place charge on an associated ticket with 
the RENTAL transaction type.  All rental transactions on tickets, and their associated 
adjustments and cancelations all use the RENTAL inventory category. 

Fields 

Category...An alphanumeric code that identifies this category. A category code can only contain 
letters, numbers, and $, %, *, -, +, /. It cannot contain “, ‘,[ or ]. 

Description...A descriptive name. 

Retail factor % and plus...The retail factor percent will determine the retail selling price of an 
inventory item. For example, if you want to double an inventory item’s cost, enter 200 in 
this field. WinPOS® will take the number entered into the Cost of Sample (or Reorder 
Cost, if present) and multiply it by the retail factor. The result will become the retail selling 
price for that item. The optional Plus field lets you add a specific amount to the retail 
selling price for this item. For example, if an item’s cost is $50.00, the retail factor is 
200%, and the Plus entry is $1.99, the system will create a retail selling price of $101.99. 
 
This percentage is carried into the retail inventory automatically when the associated 
category is used on an inventory item. It can then be overridden on the retail inventory 
form if you like. The plus amount is carried into the retail inventory automatically when the 
associated category is used on an inventory item. It can then be overridden on the retail 
inventory form if you like. 

Commission percentage...Commission percentage paid on sales of retail inventory that use this 
inventory category. 

Sub-category...Sub-categories let you break this inventory category down into more detail. For 
example, you could have a category for wedding dresses (WG), and sub-categories for 
sub $500 prices (<500), $500-$1000 (500-1000), $1000 and up (>1000) To add a sub-
category, click the Add Item button. A blank entry will appear at the end of the sub-
category list. Click on the blank entry and enter the sub-category. To remove a sub-
category, select the sub-category in the list and click Delete Item. 

Register Sales (checkbox)?...Checked, this will cause the Register Sales checkbox? on a sales 
ticket to be automatically checked when an item is sold of this category.  By enabling this 
checkbox the items being sold will be registered allowing for quick searches and to auto 
alert the operator when like items are being sold to members of the same event.  See the 
Events Overview topic for more information on Registering Sales. 

 

E-Commerce integration 

The following fields apply only the BigCommerce e-commerce integration.  These fields are set 
on the category and used for all products in this category as they are uploaded to e-
commerce. 

Weight...Each product has a weight used for shipping calculations.  Weight is required for 
BigCommerce.  The unit of measure is set on BigCommerce, either lbs or kgs. 
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Width...Package width.  The unit of measure is set on BigCommerce, either in. or cm. 

Height...Package height.   

Depth...Package depth.   

Extra option set...The option set for each product is created automatically, based on the 
size/color charts, and extra charges.  However, more options can be added to the option 
set for products in this category.  For example, for prom dresses, a shop may want to add 
an option that lets the customer select their school in addition to the size and color of the 
dress.  The procedure is as follows: 
 
1. Create a new Option in BigCommerce, with Option Values for each separate value. 
 For example, the Option might be called "High Schools", and the Option Values would 
be the school names, such as "Northside,Mountain,Kell,Midtown"  
2. Create an Option Set that uses the new Option. For this example, the Option Set might 
be "High School" and would contain the Option called High Schools. 
3. Within the Profit System, click the binoculars button next to Extra Option Set. It will 
display a list of all Option Sets defined on BigCommerce. 
4. Finally, select the High School Option Set from the list. 

   

Now, when products for this category are uploaded to BigCommerce, the Options in this Option 
Set will be merged into the Option Set automatically created for the product.   

Adding New Categories 

As Inventory Categories are created, the WinPOS program creates a accounting class to match 
the new category.  It also creates an WinPOS account code to hold the revenue for sales of the 
category.  The account is named the same as the category, and is automatically added to the 
Chart of Accounts, and the Revenue Report. 

The accounting class is created as follows: 

Name: Same as inventory category 

AR/Deposit account: PARTIAL PAYMENTS 

Sales/Revenue account: Same as inventory category 

Refund account: Same as inventory category 

Tax group: RETAIL 

Accounting integration purchase account: Same as inventory category + EP (ex. 
BRIDALEP) 

Accounting integration inventory account: Same as inventory category + EI (ex. BRIDALEI) 

Accounting integration cost account: Same as inventory category + EC (ex. BRIDALEC) 

The accounting integration cost and inventory accounts are added to the Revenue Report, so 
they will be exported if the accounting integration is used. 

 

Vendors 

Switchboard: Main->Housekeeping->Inventory Setup->Vendors  

Menu: Setup->Retail Inventory->Vendors 

Action: VENDOR 
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This form lets you maintain the list of retail inventory vendors. For each item you have in 
inventory, you must specify a vendor. A Vendor Number references each vendor and each 
vendor number must be unique.  

Note 

A 'system' vendor is pre-defined in WinPOS© by BBL, called STO. This is a generic vendor 
code representing the Store as the vendor since the inventory style codes it applies to are 
primarily services provided by the store.  This Vendor code may be used for any inventory 
style created. 

The vendor form is comprised of several tabs of information. 

List Tab 

The search grid allows vendors to be sorted & searched by name or code. 

 

Retail Factors...The retail factor percentage, i.e. selling margin, may be assigned on a vendor by 
vendor basis.  This handles the situation where your margins are based on the vendor. 
 Retail factors assigned at the vendor level will overwrite factors assigned at the category 
level.  When a vendor does not have a Retail Factor assigned the category factor will be 
used.  Of course the user can overwrite the retail factor suggested when adding 
inventory, but it is NOT recommended. 

Extra Charges...The EXTRA CHARGES button refers to the extra charges/fees that may to be 
added at time of sale to a particular item(s), which you will order from the vendor. The 
extra charges can be an extra size or more fabric.  The extra charges created from the 
vendor form will be available to be applied to all inventory assigned to the selected 
vendor.  

Store Acct Numbers...The optional multi-store module will allow the vendor to assign a different 
account number to each store.  When a store prints a Purchase Order, WinPOS© will 
automatically insert the account number assigned by the vendor for that store on the PO. 

Print...The functions prints a vendor listed that may be sorted by Vendor Name or Vendor Code. 

 

Details tab 

Vendor number...A unique alphanumeric code to identify this vendor. A vendor code can only 
contain letters, numbers, and $, %, *, -, +, /. It cannot contain “, ‘,[ or ]. 

Vendor name...The vendors name. 

Corporate, Returns/RMA, Billing Address…WinPOS® will print the Returns/RMA address on 
Returns/RMA forms printed from the RCR module. The other addresses are for your own 
reference. Simply click/select the tab of the address needed. 

 

Account number...The account number the vendor assigns your shop. 

Email address…The email address for the vendor. You can send an email by double-clicking on 
the email address. If nothing happens when you double-click on the email address you 
need to configure Windows with for default email client. Consult your Windows 
documentation for more details. 

Web Site…The website for the vendor. You can go directly to the vendors website by double-
clicking on the web address. If nothing happens when you double-click on the web 
address you need to establish a connection to the internet. Consult your internet service 
provider’s documentation for more details. 
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Sub rent? … This is a WinTPS© only option to indicate that this vendor is a supplier of rental 
items (not a manufacturer). When checked this will allow the vendor to display when 
ordering overbooked rental items from within WinTPS© View Sub-Orders module in 
Rental Production. 

Sub-Rental Returns button…WinTPS© can track the return of sub-rental items to vendors. 
Using the Sub-Rental Return form, located at Main->Rental Production->Return Sub-
Rentals, serial/control numbers of sub-rented items are scanned as they are returned to 
the vendor. This button will display a list of the items returned to this vendor. 

 

Create Shipment button…This function will create a shipment record for this vendor using the 
currently displayed address. The shipment can be processed via the Shipping software 
module. 

Notes button...This button displays the notes for this vendor. If notes have been entered the 
lettering on the button will be blue. 

 

Last activity… This is a WinTPS© feature only. This field displays the date that this vendor was 
used to supply rental inventory to meet a overbooked situation with WinTPS. 

Total spending… This is a WinTPS© feature only. This field will display the total amount of 
spending with this vendor to supply rental inventory for overbooked situations. 

 

Integration Tab 

Accounting Integration  

Terms…Only available with WinPOS® Accounting Integration. Here you can enter default 
payment terms for invoices from this vendor. When you receive a purchase order and 
enter the invoice details, WinPOS® will automatically suggest the terms entered here. 

Discount %…Only available with WinPOS® Accounting Integration. Here you can enter a default 
discount % for invoices from this vendor. When you receive a purchase order and enter 
the invoice details, WinPOS® will automatically suggest the discount % entered here. 

Days…Only available with WinPOS® Accounting Integration. Here you can enter default days for 
the discount for invoices from this vendor. When you receive a purchase order and enter 
the invoice details, WinPOS® will automatically suggest the days entered here. 

Export vendor number…Only available with WinPOS® Accounting Integration. When you 
export invoices you include a vendor number. You can enter an alternate vendor number 
here if you like and WinPOS® will use that number for exports rather than standard 
vendor number.  

 

E-Commerce 

Delivery time-frame...The standard delivery time frame for special orders from this vendor.  On 
e-commerce, this is displayed on the product page for any products from this vendor. 

Alt. name...This name is used instead of the real vendor name for products from this vendor on 
the e-commerce site.  Normally, the customer never sees the vendor name in the 
ProfitSystem.  However, the vendor name becomes part of the description on e-
commerce so search engines can find the product. If the vendor is well-known, then the 
shop would want it displayed and searches to find it.  However, if the shop prefers that 
the customer not see the vendor name, they can substitute something else here.  This 
only affects products uploaded to e-commerce. 
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SmartLink 

Provider...The SmartLink vendor name.  A shop may have multiple vendor records for the same 
vendor, if the vendor sells their products under various line names.  In this case, the 
SmartLink Provider is the same for all these vendor records. 

Username...The username for Smart Link integration. If the vendor supports Smart Link, they will 
provide the username and password that will be entered here.  At PO issue time, the user 
will be prompted to send orders electronically if this username is filled in. 

Password...Smart Link password. 

 

When a PO for this vendor is issued or reprinted, also email to...When printing purchase 
orders, you can choose to email PO's to vendors.  When the email service is enabled, 
and an email address is entered here, the program will prompt to email PO's during the 
issue process. Answering Yes will cause an email to be sent to each vendor, using this 
address, where the PO is attached as a PDF. 

 

Season Codes 

Switchboard: Housekeeping-> Inventory Setup-> Season Codes 

Menu: Setup->Retail Inventory->Seasons 

Action: SEASONS 

 

Season codes are used within the Inventory to identify what retail season an item was 
purchased for and may be used for inventory analysis reporting. The season field is an alpha 
numeric 10 character field is found on the Inventory-> Style tab.  Example codes can be 
 SPG2012, FALL2012, SUM2012, WINT2012  ..etc 

When a season code is entered onto an inventory item it is  validated against the season code 
database to insure consistent codes are utilized.  If the season code is not present the system 
will not accept it.  Season codes are created & maintained on the Season Code form, located on 
the Inventory switchboard. 

Season codes cannot be deleted if in use on any inventory items. 

 

Print Tags 

Switchboard: Main->Housekeeping->Inventory Setup->Print Tags 

Menu: Inventory->Print Tags 

Action: none 
 

This is a program that allows mass tags (batch set) for multiple inventory styles to be quickly & 
easily printed. To print tags for a single style use the Print button on the inventory SCW form. 

This function allows for up to seven selection criteria to limit the tags printed. To enable a 
criteria, check the checkbox next to it. Most are self-explanatory.  

The print criteria  “have been modified“ or “have not been modified” concerns the state of a 
SCW item.. When  new retail inventory item is created, or an existing SCW item is edited, 
WinPOS© will change the state to modified. So, to print tags for any new or changed items, 
use this criteria and select “have been modified”. 
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Some inventory styles may have quantities on hand greater than 1.  The Print Tag function 
offers an option to either print tags for the total on hand quantity for each item OR only one tag 
per item irregardless of it's on-hand quantity.  Choose the option required. 

After the selection criteria is complete, press the Print Tags button. Make sure a adequate 
number of tags/labels are the tag printer for the job being started. 

After tags are printed WinPOS® prompts to reset the “Modified flag” This will set the flag back to 
unmodified so the next time this function is used to print tags the system can print only for newly 
modified tags. 

Also see Print Tags - Query Chapter for additional printing options. 

 

 

 

Print Tags - Query 

Switchboard: Main->Reports->Query 

Menu: Reports->Query 

Action: none 
 

The report Query program allows for a Mass Tagging of inventory (batch set) of tags to be 
printed for inventory styles.  The Query provides the maximum flexibility in choosing the 
inventory styles to print because you have the power of the Query program in selecting exactly 
which styles to print tags for.  This is due to the fact that the user can select inventory styles 
based on any inventory field. 

When creating a Query for inventory tag printing remember to select the Inventory Receive 
History file & include the User ID Number field (this is the barcode number on the inventory 
SCW form)  in the Output fields (along with any other information that might be needed on the 
tags). 

Query allows only one tag per SCW to be printer, irregardless of the on hand quantity. 

Please review the Query Chapter for information on using Query. 

Also see Print Tags Chapter for additional printing options. 

Images 

This form is used to add, edit or remove images from a customer, inventory item, or color chart. 

Delete image button...Deletes the currently displayed image. 

Add new image button...WinPOS® will prompt you to add an image or video. 

• Video: You will be prompted for the filename of the AVI file. 
• Image: You will be prompted for the filename, or you can select New. If you select 

New, WinPOS® will display a list of all the video capture and scanning devices 
available on that computer. Select a device and capture the image and WinPOS® will 
import it. 

Replace image button...You can also replace an existing image. 

Quick Add Image buttons... This feature is designed to allow the user to quickly add an image 
from an installed TWAIN device like a camera or scanner.  It skips all of the dialogs of the 
Add New Image function described above.  The user will receive a TWAIN error if there 
are no compatible devices installed. 

Rotate Left & Rotate Right buttons... These function will turn (rotate) the displayed image 90°.. 
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First, previous, next, last button...If you can have multiple images these buttons will navigate 
through them. 

A user may also perform special tasks by right clicking the image.  A Right Click which you 
mouse is over the image will pop up a menu of special functions.  These include printing, 
zooming & exporting the image to disk. 

Retail Sales Support Data 

Promotional Pricing 

Switchboard: Main->Inventory->Inventory->Promotional Pricing  

Menu: Setup->Retail Inventory->Promotional Pricing  

Action: PRICING 

Located at Main->Housekeeping->Inventory Setup->Inventory->Promotional Pricing (PRICING) 

Promotional pricing is used to discount or mark down the retail prices of certain styles by 
category or other criteria. Additionally, you can specify a date range of when the promotional 
markdown is in effect. The promotion will apply to any style which matches all items specified in 
the “Applies to” section, when the current date is within the date range for the promotion. If there 
are two of more promotional prices that could apply WinPOS® will use the one that gives the 
most benefit to the customer and ignore the rest. 

A manual ticket level discount will override a promotional price, meaning the promotional price 
will be removed if a adjustment on the ticket is manually entered. 

Fields 

Description…A short description of the promotion. 

Adj. amount…The adjust amount, -10, 10%, etc. See Using Markdowns for more information. 

Markdown code…A code to represent the specific reason why an item is marked down in price. 
See Markdown codes for more information. 

Stores…A list of store ID’s that this promotion applies to. Separate the store ID’s with commas. 

 

Store style…The single store style code that this promotion applies to. If you specify the store 
style code, you don’t need to specify the vendor, category, or vendor style. 

Vendor…This promotion will apply to items from this vendor. 

Inventory category…This promotion will apply to items from this vendor. 

Vendor style…The vendor style code that this promotion applies to. 

Season... The season code of inventory items  to apply the markdown to.  Discount will only 
apply to inventory that is of the season entered here. 

 

Change price via an Adjustment?…If checked, WinPOS® will add an adjustment to the ticket at 
sale time to reflect the promotional pricing which is a great audit trail. If not checked, 
WinPOS® will simply change the selling price making it inclusive of the markdown. 

Pricing applies from…The date range for which this promotion applies. 

 

Markdown Codes 

Switchboard: Main->Inventory->Mark down codes  



Inventory 

155 

Menu: Setup->Retail Inventory->Markdown codes 

Action: MARKDOWN 

 

The Markdown Codes are codes that a shop can enter to represent specific reasons why an 
item is marked down in price.  Markdowns may be applied at the time of a sale (on the Ticket 
form either on a per transaction basis or for the ticket markdown), pre-set for a VIP customer 
(Customer Markdown) or on the Retail Inventory form via Promotional pricing.  With the 
optional WinTPOS rental point of sale module a event may have a rental markdown assigned. 
 When assigned, the initial rental order will default to the markdown amount & reason.  

Two Markdown modes are offered and are controlled by the Housekeeping-> General Setup-> 
System Setup-> Setup Tab: Adj amounts must be entered via markdown codes.   

• When enabled, the operator must enter a markdown code on the ticket or event form. 
 The markdown amount is automatically entered from this form.  The system will then 
check to see if the markdown is available for the current date and if so, automatically 
apply the markdown amount which cannot be modified.  In this mode the Adjustment 
amount, Applies from and Store fields are used in this form. 

• When disabled, the operator may enter a markdown amount, then optionally enter the 
reason code.  A operator would first enter a markdown amount (see Using Markdowns 
topic for more information)), next the system will stop and ask the operator to enter a 
Markdown Code, i.e. the system wants to know the reason why the operator is reducing 
the price. At this time the operator would enter the appropriate markdown code.  

Reports of items sold that were marked down include, Markdowns by Code, Markdowns by SA, 
and others. 

Please review the topic, Using Markdowns for more information. 

 

Fields 

Markdown code...Code to identify the markdown. 

Description...More detail of the markdown. 

Adjustment amount... Enter the adjustment amount for this code.  See Using Markdowns topic 
for how to enter markdown amounts 

Applies from... Enter the date range for when this markdown is effective.  Leave dates blank for 
always active. 

Stores... In multi-store implementations, enter the store locations that may utilize this markdown. 
 Leave blank for any store. 

Physical Counts of Inventory 

Physical Inventory Overview 
 

Introduction 

WinPOS© offers three inventory types that may be reconciled via a physical count of the items. 
 Each one may be performed independently of the other and may be counted manually or via a 
barcode scanner when barcoded inventory/price tags have been printed from within WinPOS©. 

Each bar-code scanner utilizes differing technology to read bar-codes.  A bar-code read by one 
scanner may not be able to be read by another scanner.  For this reason price/inventory tags 
may have to be adjusted to accommodate the bar-code reader equipment installed. 
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Test the tag barcodes to insure they can be read by the scanner.  The smallest tag readable by 
the Tricoder’s scanner is a I2of5 medium regular font set to 15 point size as an example.  It 
must be dark & clear enough for the read.  If the scanner cannot read the barcode adjust ithe 
printer’s heat setting & speed settings via the print driver (when using a thermal printer like a 
Zebra) and test until you are able to read the barcode.  The standard tags shipped with the 
WinPOS program may not be readable.  Please test before printing a large quantity of tags. 

 

Inventory items that may be counted 

Pick-UP Inventory 

See the Pick Up Inventory Physical chapter for information on performing a physical for Pick-Up 
Inventory. 

Rental Inventory 

See the Rental Inventory Physical chapter for information on performing a physical for Rental 
Inventory (available with optional WinTPS© Rental Production Management software). 

Retail Inventory 

Every retail operation needs to perform a physical count of their inventory periodically to 
maintain accurate inventory quantities.  

 

Overview 

WinPOS® offers tools for performing a physical inventory count, reconciling the physical count 
prior to posting and then permanently posting the count to the inventory along with storing a 
variance between the physical count and WinPOS reported quantity on hand. 

Physicals counts may be performed store wide or by inventory category (categories are defined 
by the user within WinPOS©). The department or store must be closed for business during the 
total physical count process. 

The general process is the same for all count collection methods and involves three steps: 

Step 1: 

Reset from any previous physical and freeze the inventory quantities. 

Step 2: 

Count the inventory for WinPOS via manual entry or scanner.  Once counted you can view & 
edit data in the Physical Inventory Entry form. 

Step 3: 

Run the Physical Inventory Listing & Exceptions Reports to double check the count. 

Step 4: 

Permanently post the count to inventory via Update Inventory .   

 

Inventory physical counts may be entered into WinPOS via four different methods. 

 Method 1) Manually entered 

 This method has three steps. 

  Step 1: 

A shop’s employee(s) manually counts each item, document the item’s SKU/ID number 
and the count on paper Each like item does not have to be counted at the exact time.  
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For example if you have widgets in two areas of the store. Count them in the first area 
by entering their inventory number and physical count. Then, later when area two is 
being counted you can list them the widget’s inventory id number again and the count 
from that area. These two separate listings can be entered separately into WinPOS. 
WinPOS knows how to process multiple entries/counts of the same item. 

Step 2: 

Manually enter the counts into the computer form the paper. 

Step 3: 

Test/Permanently post counts to inventory 

 

Method 2) Scanned via handheld Portable Scanner - Batch (MOST POPULAR method, 
equipment is available thru BBL) 

This method involves three steps. 

  Step 1: 

A employee will walk around the business with a portable bar-code scanner. Each 
item’s barcode is scanned (assumes items are price ticketed and bar-coded from within 
WinPOS) and a quantity entered. 

  Step 2: 

The Portable Reader is attached to the appropriate PC and the counts are automatically 
uploaded. This method is much faster and accurate than performing the count 
manually. However, this method does not validate the barcodes scanned, meaning 
erroneous items can be introduced when bar-codes do not scan properly. This bad data 
must be corrected when a test inventory posting is performed. 

Step 3: 

Test/ Permanently post counts to inventory 

Method 3) Scanned via handheld Personal Data Assistant (PDA) handheld Scanner Batch 
(equipment is available thru BBL) 

There are four steps to this approach. 

  Step 1: 

A inventory item validation file is created within WinPOS and downloaded to the PDA 
scanner. 

  Step 2: 

The employee(s) perform the physical by moving about the store and scanning each 
item and entering the count. Each item’s barcode is scanned (assumes items are price 
ticketed and bar-coded from within WinPOS) and a quantity is manually entered. 

The item number scanned is validated against the ‘validation table’ created in step 1 
above and if correct, the item’s description, vendor and price(s) are displayed to have 
the employee insure the price tag attached is current.  

This validation saves additional time in the posting step. 

Step 3: 

The PDA is then attached to a PC that has access to the WinPOS data and the count 
file is manually copied to the PC utilizing MicroSoft’s ActiveSynch software. Finally in 
WinPOS import the physical count file.  
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This is faster then simulated keyboard input as with the Portable Scanner (method 2). 

 Step 4: 

Test/ Permanently post counts to inventory 
 

Method 4) Scanned via handheld Notebook PC or PDA Scanner Online (equipment is available 
thru BBL) 

There are two steps to this approach! This method requires an 802.11b wireless network to be 
installed within the business. 

Step 1: 

The employee(s) perform the physical by moving about the store or by bringing the 
inventory by a computer workstation.  Scan each item and enter the actual count. Each 
item’s barcode is scanned (assumes items are price ticketed and bar-coded from within 
WinPOS) and a quantity entered. 

The item number scanned is validated against the ‘production’ inventory table and if 
correct, the item’s description, vendor and price(s) are displayed to have the employee 
insure the price tag attached is current.  

This validation saves additional time in the posting step. 

Step 2: 

Test/ Permanently post counts to inventory 

This method is the fastest of all physical inventory taking methods and allows for the 
most time savings. 

 

Methods to Count Inventory 

Physical Inventory - Portable Scanner 

Physical Inventory - Portable Tricoder 

Refer to Programming a Tricoder for information concerning the programming of the portable 
bar code reader. 

There are a few steps involved, explained within this topic, to update the computer's inventory 
with the Reader's count information. 

Note:  

The following instructions assume that you are using a Worthington Data Solutions’ TriCoder to 
perform your physical inventory.  

Do the physical inventory with the reader (assume Tricoder is programmed by BBL). 
 
1)  Disconnect the reader from the computer (if it is connected) and turn it on. Press the F1 
key until it asks: 
  

DATA COLLECTION? 
KEY [YES/NO]?_ 
Press the YES key. It will ask: 
PROGRAM NO? 
The system is asking you for a program number. 
KEY [0-3]?_ 
Press 2.  
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The Tricoder will prompt for a inventory Style/Sku code. 

You are now ready to collect data with the reader. During the physical inventory the reader 
will be asking for two bits of information. The item code of the inventory and the quantity on 
hand. You can quickly enter the item number by scanning the wand over the bar code found 
on the garment tag. Enter the quantity by pressing the appropriate number on the reader's 
keypad, then pressing Enter on the reader's keypad.  

You may have several inventory entries of the same item number. Just move the wand over 
each one separately (with quantity of 1), or move the wand over the first item and key in the 
correct quantity. Either way, the computer will update the permanent inventory properly. 

Once you have completed the physical inventory data collection, press F1 on the reader's 
keypad at the reader's Enter Item No. prompt. This action will exit you out of data collection 
where you can turn the reader off or proceed with transferring the data to the computer. 

It is not necessary to complete the physical inventory data collection in one session. You 
could do it over several days if the store is closed for that period. The reader maintains the 
data with its batteries until you are ready to upload the data to the computer and delete the 
data in the reader. 

To resume data entry with the reader from where you left off, just turn it on. Press the 
reader's F1 key until it asks: 

DATA COLLECTION? 

KEY [YES/NO]?_ 

Press YES on the reader. It will say: 

DATA FILE EXISTS 

HIT ANY KEY_ 

Press the YES key. You are now ready to resume the count. 

 

2)  Once the physical inventory is collected with the portable reader, plug the reader into the 
computer. We assume here the reader has previously been installed on your computer. 

 

3) Go to Main->Housekeeping->Inventory Setup->Physical Inventory->Physical Inventory 
Entry ( if  Program 1 was used).  Go to Main->Housekeeping->Inventory Setup->Physical 
Inventory->Import Physical Count (if you used Program 2, the newer batch count update 
program).  
 
You upload the portable reader's inventory information into the computer via the Virtual 
TriCoder Utilities. 
 
To upload the data, turn on the portable reader and press the F1 key until it asks you: 

DATA UPLOAD? 

KEY [YES/NO]?_ 

Press the YES key. The reader will say: 

UPLOADING DATA 

PLEASE WAIT_ 
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Once the data entry is completed, the portable reader will ask: 

END OF TRANSMIT 

DEL FILE [Y/N]?_ 

 

The reader is asking you to delete the data file that was collected with the reader. 

Press the YES key. The reader will ask: 

ARE YOU SURE? 

KEY (YES/NO)?_ 

Press the YES key.  

Once the data has been uploaded, proceed to Step 2 of the Physical Inventory topic to run 
the exception reports. 

Physical Inventory - American Microsystems Ltd 

 

The AML 5X00 will read I2of5 and 3of9 barcodes from WinPOS© .  The font used on the tag 
 must be: 

I2of5  = BC I25 Medium , 12 points 

3of9 = BC C39 3 to 1 HD Wide, 42 points 

If you are unsure of the font used, attempt reading some samples printed from WinPOS©.  If the 
barcodes DO NOT scan, contact BBL support and we will help you modify the tags to the proper 
barcode font. 

 

Programming 

Locate the AML Barcode Power software (BCP) CD and install the M5000 Programmer 
Software.   

This program is used to create/modify data collection programs for the M5000 series 
portable readers.  Customers may obtain the WinPOS.PGx  (x = first number of series model 
the program is designed for) or WINPOSTXT.PGx from BBL for modification/use. 
 WINPOSTXT.PGx is used by the scanner to perform a physical for WinPOS©. 

This Programmer software is also utilized to transfer programs like WINPOSTXT.PGx from 
your PC to the portable scanner.  

This can be accomplished by connecting the reader to an available serial port on your PC 
and then selecting Communications->Send File in the software.  Then on the Portable 
reader select Communications->Receive. 

The program can be ran via the INPUT menu selection on the portable reader once the 
program file has completed the transfer. 

 

Getting Started 

1) The AML Mxx00 Portable reader acquires power from 3 AA batteries.  The batteries are 
under a battery cover on the backside of the reader.  Make sure you have a supply of new 
batteries for long scanning jobs. 

2) Connect the AML Portable Reader to the PC via the supplied 9 pin serial cable OR with 
the Keyboard interface adaptor (no software required). 
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3) Install the SoftCom32 PC keyboard emulation (serial to keyboard) software from the AML 
Barcode Power software CD when the 9 serial cable will be the only interface.  SoftCom32 
cannot be used on Terminal Service configurations.  The keyboard wedge must be used in 
those environments.  

SoftCom32 software is not needed when the keyboard interface adaptor is used. 

4) Once SoftCom32 is installed, start it.  It will appear as an icon in the PC’s task tray.  Right 
click the icon to access configuration menus.  No configuration is required in most 
installations where the AML Reader is connected to COM1 except that the Communications-
>Comm. Setup->Protocol on the reader must be set to NONE.  This software is not needed 
when the keyboard interface adaptor is used. 

5) To test the serial keyboard interface to insure proper operation, right click the SoftCom32 
icon and select TEST.  The software will display a window on the PC that will allow the user 
to read barcodes via the AML Portable Reader.   This software is not needed when the 
keyboard interface adaptor is used. 

6) Place the Portable reader in Non-Portable mode by turning it on and using the arrow 
keyboard to select this option from it’s menu.  Scan barcodes and see if the data appears.  If 
not, modify SoftCom32’s configuration until the reader can successfully read barcodes (This 
software is not needed  when the keyboard interface adaptor is used). 

 

WinBPS Physical Inventory 

1) The BBL WINPOS (use for WinPOS© version 6 or greater) or WINPOSTXT 
(WINPOSTXT is used in WinPOS© version 7 or greater) physical inventory program must be 
installed on the M5x00 portable reader to properly collect data for upload to WinPOS©. 
 These programs are normally installed for you by BBL prior to shipping the reader. 

2) Turn on the AML portable reader.  Press the EXIT key until it’s Main Menu is displayed. 
 Select INPUT and choose the WinPOS or WinPOSTXT program. 

3) The user will have the option to Create a new Data file or to choose an existing one. 
 Obviously the user would NOT want to choose an existing file from a past physical count. 
  Past Physical files should be deleted upon completion of the Physical.  Do this via the 
Reader.  From it’s Main Menu select ERASE.  Choose DATA FILES, then Program 
WINPOS.  Finally choose the DATA FILE to delete from the displayed list. 

BBL suggests that a new file is created for a new physical.  You have the option to append 
to this file for each scanning session for the current physical.   

A name must be given to a newly created file.  Try to give the file a meaningful name, 
example use the date of the physical, i.e. 01122005.  Use the keys on the reader to name it. 
 The BLUE Alpha key toggles the number pad to number or letters. 

4)  Once the program starts the user will be prompted to scan the SCW barcode.  The 
barcode will appear directly below the prompt when successfully scanned.  The user may 
also manually type the barcode number by using the reader’s keypad.  Remember:  Use the 
blue ALPHA key on the reader to toggle between letter or number entry for it’s keypad. 
 When a SCW code is scanned the reader will automatically advance to the QTY prompt. 
 When the SCW code is entered via the reader’s keypad the user must press the RED Enter 
key to advance to the QTY field. 

The barcode scanned/entered will remain on the reader’s screen until the quantity is 
accepted.  Once the quantity is entered the SCW code will disappear & await the next entry. 

The QTY field auto defaults to a quantity of 0.  The user must hit the RED Enter Key to 
accept the quantity.   Otherwise the user may enter the appropriate quantity form the 
reader’s numeric keypad OR by scanning a number. 

When scanning is completed the user may upload the data to the WinPOS© program. 

Press the readers EXIT key until the Main Menu is displayed. 
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Upload to WinPOS© 

1) Ensure the SoftCom32 software is running OR the Keyboard adaptor is installed.  Check 
your PC’s task bar for the SoftCom32 icon.  Hover your mouse pointer over the icon.  It 
should display ‘SOFTCOM ENABLED’.  This software is NOT needed when the keyboard 
interface adaptor is used.  In a wedge setup the scanner must connect between your PC and 
keyboard by using the provided Y cable adaptor. 

2) Ensure the communications setting is correct on the M5x00 portable reader.  On the 
reader Main Menu->Setup->Comm. Setup.  The Protocol should be set to NONE and the 
Char. Delay should be around 3 ms.  Press the EXIT key until the Main Menu appears.  This 
step may be omitted when the keyboard interface adaptor is used. 

3) When ready, go to the WinPOS© Retail Physical Inventory Entry form (in version 6 or 
lower) or to the Upload Physical Count form (version 7 or higher).  Enter into the form. 
 WinPOS© is ready to accept data from the reader. 

4) From the Main Menu of the Portable Reader select Communications->Send->Data Files-
>Program WINPOS or WinPOSTXT.  Then from the list select the data file to send.    

5) Finally select the communications method.  Select RS232 Serial when the 9 pin serial 
cable is plugged into the PC com port and the SoftCom32 software is used.  Select 
Keyboard wedge when the keyboard interface adaptor is used. 

The data should immediately begin appearing within the selected WinPOS Physical form.   

6) The portable reader will display 100% complete, press any key to continue when the 
upload is finished. Once a key is pressed the reader will ask for the data files to be deleted. 
 Answer Yes or No to the question.  Toggle between YES & NO by using the arrow keys on 
the reader’s keypad.  You should answer NO.  You can delete/erase the data later once you 
are completed with this physical. 

7) Once the file upload is complete, the user should review the uploaded counts via the 
review window in Upload Physical Count when this upload method is chosen.  The user 
shoulc click IMPORT once satisfied with the uploaded data.  The Upload function imports the 
count information into the Physical Inventory Entry form. 

 

Physical - Using Notebook PC 

Switchboard: Main->Housekeeping->Inventory->Physical Inventory->Validated Physical 
Inventory  

Menu: Setup->Retail Physical Inventory->Validated Physical Inventory Entry 

Action: LIVEPHYS 

 

The live physical option requires that WinPOS© be run on a computer that can be physically 
moved around the store to scan or manually key inventory into the system, while still being 
connected to the live WinPOS© data. Typically this is accomplished with a laptop computer on a 
cart and a wireless network connection.  

An alternative is for the inventory to be to a workstation and scanned. 

This feature provides instant feedback to the operator concerning the item entered. WinPOS© 
will verify that the barcode is valid, and can optionally, print a new garment tag if the attached 
one is damaged. This feature could also be useful inventory needs to be re-tagged.  

 

See the topic Validated Physical Inventory Entry for more information. 
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Physical Inventory - Generic Scanner 

Switchboard: Main->Inventory->Import Physical File and Main->Housekeeping->Inventory 
Setup->Import Physical File  

Menu: Setup->Retail Physical Inventory->Import Physical File 

Action: PHYIMPORT 

 

The Import Physical File function allows WinPOS© to accept a standard ASCII text file 
containing the physical counts of inventory.   

WinPOS© supports two simple formats.  Any portable scanner should be able to create one of 
these two formats and place the file containing the count on the computer system running 
WinPOS©.  The file name may be anything. 

WinPOS© will allow the user to select the ASCII file containing the count information via the 
Windows file selection dialog box.  Once selected, WinPOS© will automatically import the count 
data into the Physical Inventory Entry form. 

 

Format 1: Place one inventory barcode per line.  The quantity counted is assume to be one.  It 
is OK to scan multiple identical barcodes.  WinPOS© will total the quantity for the number of 
times the same barcode was scanned.  For example if 000001 was scanned 5 times WinPOS© 
would apply a total of 5 for that barcode. 

Barcode, Qty 

########## 

########## 

########## 

 

Format 2:  Contains two bits of data on each line.  The WinPOS© barcode number of the item, 
a comma, then the quantity to be applied.  The same barcode may be scanned multiple times 
and the quantity will be totaled for the item, for example 

Example Scans 

0000001,2 

0000001,1 

0000001,5 

This would apply a physical count of 8 for item 0000001. 

The file format is. 

Barcode, Qty 

##########,1 

##########,1 

##########,1 
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Physical Inventory Steps 

Physical Inventory Process 

Switchboard: Main->Inventory->Physical Inventory and Main->Housekeeping->Inventory Setup-
> Physical Inventory 

Menu: n/a 

Action: none 

The process can be summarized into several steps that will be performed to accomplish a 
physical inventory. 

1. Print Price tags via WinPOS® and tag the entire inventory. Insure that the price tags 
contain a barcode of the barcode number from the Retail SCW form, NOT the Store 
Style number. 

2. Close the location and manually count or scan inventory. The count can include all 
items OR by category/class of merchandise within a store. If by all items, the entire 
store’s inventory must be counted. If by category, the entire category must be 
counted. 

3. Start a new physical within WinPOS. 

4. Enter the count into the WinPOS Physical count file. This could be done manually or 
by using a portable device like a Portable Scanner or PDA sold by BBL..  See below. 

5. Run the Physical Inventory Exception Report to check the count.  This report will 
indicate how the inventory will be permanently modified by the Update function in 
the following step.  Use this report as a worksheet to fix any miscounts before 
applying.  This report may be ran multiple times. Once satisfied with the report 
information, perform the update in the next step. 

6. Using the WinPOS Physical module, click the UPDATE Inventory button. The 
Physical count UPDATE process automatically cycles thru a series of inventory 
updating steps that permanently modifies the inventory with the new counts. 

Input Counts 

There exists several methods to input a physical count into the WinPOS system.  The methods 
are:  

Physical Entry 

Validated Physical Inventory Entry 

PDA Physical 

Import Physical Count File 

Upload Physical Count 

 

Start New Physical 

Switchboard: Main->Housekeeping->Inventory Setup->Clear Current Physical 

Menu: Setup->Retail Inventory->Start New Physical 

Action: none 
 

Use this function to begin a new physical count for a specific store.    

This function will zero/blank out any previous inventory physical counts and prepares the 
physical count file to accept a new count.  It also 'FREEZES' the inventory quantity on hand for 
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each style/size/color/width for the current store (the store the register performing the Start 
Physical function).   

It is important to complete a physical count as quickly as possible.  It is best to close the store to 
perform the actual physical count.   

Once the count is completed the FREEZE feature allows the store extra time to run the 
EXCEPTIONS report and make corrections to the count from that report.   When the UPDATE 
function is preformed the system will take into consideration items sold and new quantity 
received since the physical count to arrive at the correct new quantity on hand. The update will 
first archive your physical count file, PHYSYRMODAY.DBF (profitsystem\user file folder) then 
Erase any previous physical counts that may still be in the file. 

 

When calculating the new QOH from the freeze the function uses the formula: 

Physical count + (Current QOH - Freeze QOH) 

Physical Count Entry 

Physical Inventory Entry 

Switchboard: Main->Inventory->Physical Inventory Entry  and Main->Housekeeping->Inventory 
Setup-> Physical Inventory Entry 

Menu: Setup->Retail Physical Inventory->Physical Inventory Entry   

Action: PHYINV 

 

Several methods exist for  

This form is used for any of three tasks:  

1) To manually enter physical inventory counts  

2) Edit count data that was manually entered via this form or the Validated Phys Inventory Entry 
form or from Import or Upload physical count. 

3) Upload (data enter) a physical count from a portable Tricoder or PDA via a keyboard wedge 
(emulation of data being typed in via a keyboard), See the Tricoder Topic for more information.  

 

Fields 

Style code, qty list...This list shows you all the styles/SKUs/barcodes/UPC codes and quantities 
that have been uploaded to WinPOS®. 

Style code...A style code/SKU/barcode/UPC code that has been uploaded. 

Quantity...The quantity counted. 

 

Buttons 

Update Inventory...Non-Functional button.  It will display a message to update the inventory from 
the Main->Housekeeping->Inventory Setup->Update Inventory function 

Start upload button...Click this button prior to starting a automatic keyboard entry upload via a 
Worthington Data TriCoder portable scanner. 

Save... Save any data adds or edits. 

Cancel... Abort, do not save any data edits. 
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Delete... Delete the selected inventory barcode and count 

Add... Add a new item. 

Done...  Exit the form. 

Validated Physical Inventory Entry 

 

Switchboard: Main->Housekeeping->Inventory->Physical Inventory->Validated Physical 
Inventory  

Menu: Setup->Retail Physical Inventory->Validated Physical Inventory 

Action: LIVEPHYS 

 

This form allows  inventory counts to be directly entered into the system.  Typically this is 
accomplished with a laptop computer on a cart and a wireless network connection. This feature 
provides instant feedback to the operator concerning the item entered. WinPOS© will verify that 
the barcode is valid, and can optionally, print a new garment tag if the attached one is damaged 
or incorrect.  

 

Form Fields 

Bar code, qty list...This list shows you all the bar-codes and quantities that have been uploaded 
to WinPOS®. 

Bar code ...The bar code to be counted. You can also enter/scan a style code. In this case, 
WinPOS© will display a list of valid sizes/colors/widths so you can pick one. You can also 
enter/scan a UPC or SKU number. In this case, WinPOS translates it to a bar code. 

Quantity...The quantity counted. 

Assume qty of 1 (checkbox)?...Since most of the time you’ll be scanning a quantity of 1, you 
can check this box and WinPOS© will assume a quantity of 1 and not ask you for the 
quantity. 

 

Displayed Data 

For the barcode id entered the system will display the following data for reference so in the 
situation where an item is mis-tagged the operator could catch it and then use the print button to 
re-tag the item with the correct tag. 

Style #, Description, Size, Color, Vendor. Name and Vendor Style. 

 

Buttons 

Save... Save any edits or additions. 

Cancel... Cancel/Discard any edits. 

Print... Print a price/inventory tag. 

Delete... Delete the displayed entry. 

Add... Add a new item. 

Done... Exit and return to the previous form. 
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PDA Physical 

Switchboard: Main->Tools->PDA Physical 

Menu: Tools->PDA Physical 

Action: none 

 

PDA online builds the physical count file in real time and does not require the copying of 
validation or counts files to/from the PDA device & PC.  

This method is the fastest of all physical inventory taking methods and allows for the most time 
savings. 

This method requires Terminal Services, 802.11b wireless network and a Pocket PC PDA 
device with scanner and wireless card. Contact BBL Support for additional help in 
understanding the set-up.  The online form is available from the WinPOS© main menu under 
the File menu selection. 

Three steps are required to process. 

Step 1: 

Start a New Physical 

Step 2: 

The employee(s) perform the physical by moving about the store and scanning each 
item and entering the count Each item’s barcode is scanned (assumes items are price 
ticketed and bar-coded from within WinPOS) and a quantity entered. 

The item number scanned is validated against the ‘production’ inventory table and if 
correct, the item’s description, vendor and price(s) are displayed to have the employee 
insure the price tag attached is current.  

This validation saves additional time in the posting step. 

Step 3: 

Run the Physical Inventory Listing & Exceptions Reports to double check the count. 

Step 4: 

Permanently post the count to inventory via Update Inventory  

 

Import Physical Count 

Switchboard: Main->Housekeeping->Inventory->Physical Inventory->Import Physical File 

Menu: Setup->Retail Physical Inventory->Import Physical Count File 

Action: PHYIMPORT 
 

This function is used to import the physical count captured on a portable scanner that is 
programmed to create a TEXT or ASCII file of the count.  Please review the topic Physical 
Inventory - Generic Scanner for more information on file layout requirements. 

The text/ascii file must be copied from the device to the WinPOS server computer using the 
device's manufacturer's provided software & interface cables.  The copy process typically allows 
the operator to name the count file and to place it in the folder of choice.. 

This function will display a file selector dialog box and allow the operator to navigate to the 
location of Text/ASCII file.  Select it and WinPOS® will import the count. 
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Three steps are required to process. 

Step 1: 

Start a New Physical 

Step 2: 

The employee(s) perform the physical by moving about the store and scanning each 
item.  Copy the Text/ASCII file to the computer and import it via this function 

Step 3: 

Run the Physical Inventory Listing & Exceptions Reports to double check the count. 

Step 4: 

Permanently post the count to inventory via Update Inventory  

This feature may be utilized with Windows CE devices to collect the count.  See PDA Set-Up & 
Operation for more information. 

Upload Physical Count 

Switchboard: Main->Housekeeping->Inventory->Physical Inventory->Upload Physical Count 

Menu: Setup->Retail Physical Inventory->Upload Physical Count 

Action: none 
 

This function is used to capture the physical count captured on a portable scanner that is 
programmed to upload the count data as keyboard input.  This is useful in installations where 
the WinPOS software does not have access to com or USB devices and can only accept the 
data as keyboard input. 

The format options the data should be keyed as are: 

Format 1: Place one inventory barcode per line.  The quantity counted is assume to be one.  It 
is OK to scan multiple identical barcodes.  WinPOS© will total the quantity for the number of 
times the same barcode was scanned.  For example if 000001 was scanned 5 times WinPOS© 
would apply a total of 5 for that barcode. 

Barcode, Qty 

########## 

########## 

########## 

 

Format 2:  Contains two bits of data on each line.  The WinPOS© barcode number of the item, 
a comma, then the quantity to be applied.  The same barcode may be scanned multiple times 
and the quantity will be totaled for the item, for example 

Example Scans 

0000001,2 

0000001,1 

0000001,5 

This would apply a physical count of 8 for item 0000001. 

The file format is. 
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Barcode, Qty 

##########,1 

##########,1 

##########,1 

 

Three steps are required to process. 

Step 1: 

Start a New Physical 

Step 2: 

The employee(s) perform the physical by moving about the store and scanning each 
item.  Choose this function and set the scanner to upload the data as keyboard input. 

Step 3: 

Run the Physical Inventory Listing & Exceptions Reports to double check the count. 

Step 4: 

Permanently post the count to inventory via Update Inventory  

 

 

Update Inventory 

Switchboard: Main->Inventory->Physical Inventory->Update Inventory and Main-
>Housekeeping->Inventory Setup->Physical Inventory->Update Inventory 

Menu: Setup->Retail Physical Inventory->Update Inventory 

Action: UPDINV 
 

This form is used to update the inventory QOH based on a physical count. .  

All users should be out of the system when an physical Update is applied. 

Automatic steps of the Update function 

a. Sets a Flag in the Physical Count file and Inventory file that nothing has been counted 
yet.   

b. Clears log entries of any prior physicals. (A Log entry is generated when a STYLE code 
is barcoded rather than the SKU/Barcode/UPC. When this occurs WinPOS will have to 
zero the Quantity on Hand for the SKUs of that style.).  Also the OTHER size quantity 
on hand of all inventory items will be set to 0 (zero) by the update process. The 
OTHER size description is a WinPOS reserved size description and should not contain 
a quantity greater than 0. 

c. Using the Physical count file, the system steps thru each item and attempts to locate 
the counted item within the Retail Inventory file. It first tests to see if the item is a Style 
code. When this is the case it updates the Quantity on Hand (QOH) of the first SKU in 
the file for that style, sets the Last Physical Date to the current day and then zeros the 
QOH for the remaining SKUs. Otherwise it locates the item via SKU, UPC or 
BARCODE number and if found updates (QOH) then sets the Last Physical Date to the 
current day.  

d. Then it marks the item in the physical file to indicate if the item was found or NOT 
found in the Retail Inventory. 
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NOTE: An item could appear multiple times in a Physical count file. As a result, the first 
time an item is located in the Retail inventory file, it’s QOH is zeroed and the QOH 
goes up by the count in physical. Also, the current QOH (prior to physical) is copied to 
the VARIANCE field. This number will be used later to compute the actual Variance, 
i.e. what you counted vs what the computer system showed you originally had prior to 
the physical. The following times the same item is found in Retail Inv. during the same 
Physical, it’s QOH is added to by the count in the Physical count file. 

e. Once all Physical count items are processed the system will: 1) the system will replace 
the QOH of SKUs NOT counted during the physical with a zero. This zeroing step is 
limited to the Category and sub-category entered   2) cycle thru the Inventory file once 
to compute the Variance between what was counted in the Physical to what the 
computer showed you having prior. The Variance number is computed then viewable 
form the Retail Inventory Size/Color/Width (SCW) screen or the View Store Statistics 
form when multi-store is installed. 

f.  WinPOS will next take a snapshot of the New Retail Inventory by copying certain 
information to a new file. The snapshot copies Style, Size, Color, Width, current date, 
current QOH (after physical count is applied).  This can be used via built in Inventory 
Maint. utilities to recreate inventory quantity on hand from the last physical. 

g.  WinPOS will then adjust each item’s RECEIVE HISTORY to match the physical count. 
This history is adjusted based upon the retail inventory cost averaging selected in 
general set-up, i.e. LIFO or FIFO.  
 
The system first zeros all QOH numbers for the Receive History for the item being 
processed. Once the transactions are zeroed the system will add quantity back to each 
transaction, up to the maximum that was received in that transaction based upon 
FIFO/LIFO. Once the maximum received in the transaction is reached it moves to the 
next History transaction until the QOH from the physical count is exhausted. 
 
NOTE: Receive History is enterprise wide, not on a store by store basis. Also, QOH 
can be higher than the maximum received due to Retail Inventory added by an 
operator outside the Receive History module. 

h. The last step is the LOGGING within the WinPOS(c) log file of SKUs (SCW) that 
were zeroed  

The update is completely automatic and requires NO operator intervention other than the count 
and Update settings/criteria. 

 

Fields 

Limit to category/sub-category...If you are choosing to zero the QOH for all items not counted, 
you can specify a category/sub-category and only items not counted in that category/sub-
category will be zeroed. 

Date of physical…This date uniquely identifies the physical. Only one physical can be run for 
each date. This date is used to select the physical to report on when running the 
Variance Report.  

Export unknown SKU’s checkbox…If checked, WinPOS will create a text file listing all the 
SKU’s that were scanned but were unknown to WinPOS.  

Buttons 

Update button…Applies the quantity update from the physical count to the inventory data. 

Cancel button…Returns to the previous form without making any changes. 
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Physical Inventory - Reports 

Physical Inventory Exceptions Report 

Switchboard: Main->Inventory->Physical Inventory->Exceptions and Main->Housekeeping-
>Inventory Setup->Physical Inventory->Exceptions  

Menu: Setup->Retail Physical Inventory->Exceptions Report 

Action: RP_EXCEPT 

 

This report shows you where you may potentially have problems in the physical count.  Any 
inventory items entered within Retail Inventory checked as 'Service/not inventoried?' will not be 
included on physical exception reports.  Any inventory items classified as rental (with optional 
WinTPS© module, will not be listed on this exception report.  Use Rental Physical for performing 
counts of rental inventory. 

 

The last four columns on the report are: 

Qty: The net change that will occur to the style/size/color.  The difference between the New and 
Old quantities below. (New - Old) 

Old: The current QOH according to the retail inventory file. 

New: What the QOH will be after Update Inventory is used.  This can differ from the quantity 
scanned if units were sold or received during the physical. 

Qty * Unit cost: The net change to the value that will occur when the inventory is updated. 
 Computed as Qty multiplied by the Average Unit Cost. 

 

This report contains four (3) sections that indicates how a physical count will permanently 
modify the retail inventory. 

• Section 1:: Sizes zeroed because only style was scanned: It is possible that a 
user inputs the Inventory Style code instead of the SKU or Barcode or UPC code of 
the SCW item.  The style code does not tell the computer the Size / Color of the item 
being counted and will result in an improper QOH of the Style listed. All report Qty 
columns = 0 

• Section 2: Styles Listed in inventory NOT counted: This prints Retail Inventory 
SCW item(s) that were not counted, but the computer showed QOH. This is an 
indication that items were missed during the count. The items can be added to the 
Physical count and the Inventory updated again or correct it manually within the 
retail inventory receiving history. A manual correction will not update the variance 
numbers.  Qty column = WinPOS QOH for SCW item,  Old/New Qty columns = 
  (does not apply in this section) 

• Section 3: Variances: This section will list all SCW inventory where the physical 
count does not equal the QOH number shown in WinBPS© inventory.  Qty column = 
is the variance + / - between the physical count and the WinPOS© QOH,  Old Qty = 
WinPOS© QOH prior to applying count, New Qty = is the new QOH after applying 
physical count. 

Criteria 

Limit report to this category...You can limit the report to a specific category, if you like. Leave 
blank for all categories.  

Limit report to this sub-category...You can limit the report to a specific sub-category. Leave 
blank for all sub-categories. 
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Physical Inv. Listing 

Switchboard: Main->Inventory->Physical Inventory->Physical Inv. Listing and Main-
>Housekeeping->Inventory Setup-> Physical Inventory->Physical Inv. Listing 

Menu: Setup->Retail Physical Inventory->Physical Inv. Listing  

Action: RP_PHYS 

 

This report lists all entries in the physical count file. It allows an operator to check for obvious 
mistakes, particularly in the quantity entered. It is easy to spot 111 for 1 ..etc. Once a mistake is 
identified the operator may display the record to the screen and correct it prior to the physical 
UPDATE process. 

Criteria 

Radio Button 

Show All:  Selected, will list all items counted. 

Show Know SKUs:  Selected, will list only items counted/scanned that can be located 
within the inventory file. 

Shown unKnown SKUs: Selected, will list only items counted/scanned that CANNOT be 
located within the inventory file. 

Physical Inventory Variance 

Switchboard: Main->Inventory->Physical Inventory->Update Inventory and Main-
>Housekeeping->Inventory Setup->Physical Inventory->Update Inventory 

Menu: Setup->Retail Physical Inventory->Exceptions Repiort 

Action: RP_VARIANCE 

 

This report shows the variances from the date selected.  

Each time a Physical Update is ran the system will store the current date to all inventory SCW 
items that are being counted.  It also memorizes the QOH of each SCW prior to the physical. 
 Once the physical is applied via the Update function the system can see if the prior QOH is the 
same or different from the resulting current QOH.  A difference translates into a variance.  This 
report will list those items where an variance exists. 

The report will show the quantity prior to applying the physical and the quantity after applying 
the count. 

Criteria 

Physical run on...Select the date of the physical to use.  The Date of the Physical is the method 
used by WinPOS to identify a specific physical.  The date is set when the Update 
Inventory function is ran. 

Size, Color, Width Charts 

Size, Color, Width Charts Overview 

WinPOS© allows for the entry of size, color, and width (SCW) charts into the system for 
reference. The charts may be generic and used across multiple inventory items or specific to 
vendors. 
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The entered charts may printed and/or assigned to inventory styles where they may be used to 
for the initial retail quantity on hand load or for creating all rental sizes (for optional WinTPS© or 
WinTPOS© modules) on he initial load.  When charts are assigned to inventory styles they are 
utilized to create size, color, width matrixes to easily view inventory quantity, used to create 
stock POs and for size/color/width selection when adding a sales transaction to a ticket. 

For example, assume a vendor has a shoe style 100X that uses size chart named SZCHT and 
color chart named CLRCHT. You would first create these charts in WinPOS® (on the Size Chart 
and Color Chart form, respectively), and then on the retail inventory form, specify that style code 
100X uses size chart SZCHT and color chart CLRCHT. Now, when you sell a style 100X, you 
can press the size lookup button, and WinPOS® will display a matrix, with all the sizes in size 
chart SZCHT down the side, and all the colors in color chart CLRCHT across the top. You then 
click on the matrix cell to select the specific size and color being sold..  

Also, if you want to special order those shoes for stock you use the matrix to create the order. 
The matrix is displayed, and you simply enter the quantities you wish to order directly into the 
matrix. WinPOS® then creates the stock PO’s automatically. The use of size, color, and width 
charts is optional. 

A SCW  matrix is constructed on user demand by WinPOS.  A matrix can contain a maximum of 
255 colors and 255 sizes and 255 widths, however a SCW chart may contain over 255 items.  In 
the case that the chart exceeds the 255 limit, a matrix will not be able to be constructed for that 
chart.  When creating charts the allowed characters are A - Z, a - z, 0 - 9.  

The presence of a size chart on an inventory style and the entering of customer measurements 
onto the event or customer card will cause the system to suggest a size for a customer based 
upon the chart measurements and actual customer measurements.  See the Size Chart topic for 
more information. 

Matrixes 

A matrix is made up of a size chart, and optionally a color chart, and optionally a width chart. A 
matrix shows all of the sizes in a size chart down the left side, and the colors in a color chart 
across the top. It’s an easy way to show all the sizes/color combinations an item is available in. 
In most cases, a matrix is made up of one size chart and one color chart.  A SCW cannot 
exceed 255 sizes or colors or widths for a matrix to be constructed. 

Matrixes may be used to sale items on a Ticket form simply by clicking on the cell of the size, 
color, and width or clicking the binoculars lookup icon for those fields. 

Matrixes may be utilized to view on hand inventory quantities from the Retail inventory form and 
to add inventory when initially creating an inventory style from the inventory form. 

Also a matrix can be used to create stock purchase orders. Display the matrix and enter the 
quantity to order within the cells. 

Size Charts 

Switchboard: Main->Inventory Setup->Size Charts and Main->Housekeeping->Inventory Setup-
>Size Charts 

Menu: Setup->Retail Inventory->Size Charts 

Action: SIZECHRT 

This form lets you maintain the list of vendor size charts. Size charts are used for reference, and 
to create size/color lookup matrixes which are used for a variety of purposes. Create the size 
chart using the Size Chart form, then enter the size chart name on the Retail inventory form for 
the style that uses it. 

It is recommended that you create your size charts before entering your retail inventory. You 
can enter up to 254 sizes in each size chart. 
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The presence of a size chart on an inventory style and the entering of customer measurements 
onto the event or customer card will cause the system to suggest a size for a customer based 
upon the chart measurements and actual customer measurements. 

How does Size Suggestion work 

When the style is sold and the size lookup button is selected on the Ticket, the size/color 
matrix is displayed if the style sold has a size and optionally a color matrix.  The size 
suggestion only works if a size chart is added to the inventory style code.  The size 
suggestion works as follows:  The bust, waist, and hip measurements for the customer are 
retrieved.  The measurements fields will accept numbers & characters, so they are 
converted to numeric values before lookup.  Then, the system scans through the sizes on 
the size chart, from top to bottom, and locates the first entry where the customers bust, 
waist, and hip measurements are smaller than the bust, waist, and hip for a size in the size 
chart.  This size is then displayed at the top of the size/color matrix.   

Example:  Customer's actual measurements are 36, 24, 38.  The size chart contains size 
measurements of: 

Size 08 = 36, 24, 36 

Size 10 = 38, 26, 38 

The size suggestion would be a size 10. 

 

Fields 

Size chart name...You must name the size chart with a unique alphanumeric code. This is how 
you will select the size chart from the Retail inventory form, so we recommend a 
descriptive code. For example: If you add a size chart for Alfred Angelo you could name 
the chart AASZ1. AA would identify Alfred Angelo as the vendor and SZ1 would tell you 
that it is size chart number 1 for this vendor. 

Description... Create a short description of the chart and enter it within this field.  This field will 
print on the chart printout. 

Vendor...The vendor to whom this size chart applies. If this is a general size chart, create a 
vendor called SHOP (which will represent your shop) and use that vendor for general 
size charts. To select a vendor from a list simply click on the binoculars and a list of all 
the vendors you have entered into the system will appear. 

Size, Bust (Meas 1), Waist (Meas 2), Hip (Meas 3), Meas 4-6...These are the actual sizes and 
measurements that make up the size chart. The Size & Meas 4, 5  & 6 columns will 
accept letters and numbers. Bust, Waist & Hip (Meas 1-3) columns are numeric only. To 
add a size, click the Add Item button. A blank entry will appear at the end of the sizes list. 
Click on the blank entry and enter the size and measurements. To remove a size, select 
the size in the list and click Delete Item.   The headings for measurement columns 4, 5 & 
6.may be changes to any description.  This is accomplished in Main-> Housekeeping-
>System Setup-> Other Settings tab. 

Upcharge...The upcharge for this size, if any.  This is uploaded to the e-commerce web site 
along with the size chart. 

 

Size Entry Hint 

Enter the all sizes as two digits.  Example,  00, 02, 04, 06 ,08, 10, 12, ...etc.  This allows for 
proper size sorting on lookup grids and in reports. 

Buttons 

Print... Prints the chart out.  Suitable for placing in a notebook.  Includes an option to print the 
size chart notes and extra charges for size chart. 
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Add Same...Creates a new size chart that contains all the sizes in the displayed size chart. 
 Useful when the vendor has similar size charts as it saves having to re-enter all the 
duplicate sizes. 

Color Charts 

Switchboard: Main->Inventory Setup->Color Charts  

Menu: Setup->Retail Inventory->Color Charts 

Action: COLRCHRT 

Switchboard: Main->Housekeeping->Inventory Setup->Color Charts  

Menu: xxx 

Action: COLRCHRT 

This form lets you maintain the list of vendor color charts. Color charts are used for reference 
and for matrixes. A color chart contains a list or colors, and optionally images of the color charts. 
After entering the names of the colors in the color chart, you can scan an image of the chart 
itself and add it to the color chart. You first create the color chart using the Color Chart form, 
then enter the color chart name on the Retail inventory form for the style that uses it. 

If you select a color chart for a particular style code on the Retail inventory form, you can press 
the Color chart button to view the images associated with that color chart. If you sell a style 
code that has a color chart you can also press the Color chart button on the Ticket form to view 
the images for the color chart. 

It is recommended that you create your color charts before entering your retail inventory. You 
can enter up to 254 colors in each color chart. 

A image (picture) can be inserted representing the chart. Colors on computer screens do not 
match the actual colors, but offer close representations. It does not replace the physical color 
chart. 

Color chart name...You must name the color chart with a unique alphanumeric code. This is how 
you will select the color chart from the Retail inventory form, so we recommend a 
descriptive code. For example: If you add a color chart for Alfred Angelo you could name 
the chart AASPG02. AA would identify Alfred Angelo as the vendor and SPG02 would tell 
you that it is the spring 2002 color chart for that vendor. 

Description... Create a short description of the chart and enter it within this field.  This field will 
print on the chart printout. 

Vendor...The vendor to whom this color chart applies. If this is a general color chart, create a 
vendor called SHOP (which will represent your shop) and use that vendor for general 
color charts. To select a vendor from a list simply click on the binoculars and a list of all 
the vendors you have entered into the system will appear. 

 

Color chart grid 

Color...The name of the color. 

Hex code...The hexadecimal color code for the color.  This is used by the e-commerce upload. 
 When color options are displayed on the e-commerce site, these hex codes are used for 
the swatch colors. 

Swatch...Approximate color of the hex code.  Due to differences in monitors, this color may not 
always exactly match the real color. 

 

Buttons 
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Print... Prints the chart out.  Suitable for placing in a notebook. 

Add Same...Creates a new color chart that contains all the colors in the displayed color chart. 
 Useful when the vendor has similar color charts as it saves having to re-enter all the 
duplicate colors. 

 

Width Charts 

Switchboard: Main-> Inventory Setup->Width Charts  

Menu: Setup->Retail Inventory->Width Charts 

Action: WDTHCHRT 

Located at Main->Housekeeping->Inventory Setup->Width Charts (WDTHCHRT) 

This form lets you maintain the list of vendor width charts. Width charts are used for reference 
and for matrixes. A width chart contains a list of widths that an item can come in . You first 
create the width chart using the Width Chart form, then enter the width chart name on the Retail 
inventory form for the style that uses it. 

Width charts are not used very often, mostly just for shoes. Usually, you can use a size chart 
and/or color chart. You can enter up to 254 widths in each width chart. 

Width chart name...You must name the width chart with a unique alphanumeric code. This is 
how you will select the width chart from the Retail inventory form, so we recommend a 
descriptive code. 

Description... Create a short description of the chart and enter it within this field.  This field will 
print on the chart printout. 

Vendor...The vendor to whom this width chart applies. If this is a general color chart, create a 
vendor called SHOP (which will represent your shop) and use that vendor for general 
width charts. To select a vendor from a list simply click on the binoculars and a list of all 
the vendors you have entered into the system will appear. 

Buttons 

Print... Prints the chart out.  Suitable for placing in a notebook. 

 

Shipping 

Shipping 

Switchboard: Housekeeping->Inventory Setup->Inventory-> Ship Customer Items 

Menu: PO/Ship->Ship Customer Items 

Action: SHIPPINV 
 

This form is the primary form used to process the shipments created for customer sales ticket 
items, vendors and other parties.  Shipping request may be created from 1) a Sales Ticket via 
the Adjust/Cancel/Extra Charge transaction button, 2) the Vendor's Maintenance form via the 
Create Shipment button & 3) the Shipping form via the Add button. 

This form will allow a operator to display shipment entries within the shipment grid based upon 
specific criteria entered. Once shipments are displayed within the grid, the operator may 
review, edit, print and process/ship. 
 

Display Criteria 
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Receive Date Range…The date range the shipment has to reach it’s destination. 

Event…The event the shipment may be associated with. A event is automatically associated with 
a shipment if the shipment is created from a sales ticket and that ticket ticket is marked to 
an event. 

Shipment Status (checkbox)… A shipment may have one of three statuses, Ready Ship, Wait 
Ship or Shipped. Check the status of the shipments to view. 

Category...Only shipments of the selected category will be displayed. 

Search button…Sets the search criteria and displays those shipments that match the criteria 
within the grid. 

Grid Columns 

Search for… The shipments will be sorted by the Event name, Customer name, or Item number. 
The Sort order depends on the column that appears in the leftmost column of the grid. To 
change the sort from one to another, drag or double click the column name to move it to 
the leftmost position. 

The user will type in data within this field and he system will attempt to locate a match within the 
data of the leftmost column. 

Customer…Name shipment is being sent to. 

Style…Style of item within the shipment. This is only available when the shipment is created from 
a sales ticket. 

Size… Size of item within the shipment. This is only available when the shipment is created from 
a sales ticket. 

Color…Color of item within the shipment. This is only available when the shipment is created 
from a sales ticket. 

Ship Date…The date the shipment was given to carrier. 

Event date…The event date of item within the shipment. This is only available when the 
shipment is created from a sales ticket and the ticket is tagged with an event. 

Status…The current status of the shipment. 

Item Number… The item number of item within the shipment. This is only available when the 
shipment is created from a sales ticket. 

Grid Fields 

Shipping Method…A description of the shipping method to use with the carrier.  

Name… Name shipment is being sent to. 

Address…The street address shipment destination. Remember Fedx or UPS do not ship to PO 
Boxes. 

City, State, Zip…The city, state & zip of the shipment destination. 

Notes…Free form notes/comments about the shipment. 

Item Balance... Displays the ticket balance for the highlighted item shipping record.  

Buttons 

Copy Address... A time saving feature to allow the operator to copy the address from one 
shipping record and paste to another.  To use check the checkbox on the shipping to 
copy the address from then highlight the shipping record to copy to.  Once the Copy to 
ship reocrd is highlight click the Copy Address button.  This will perform the copy/paste. 
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Ticket button…Function to display the sales ticket associated with the item on the shipment. 
This is only available when the shipment is created from a sales ticket. 

Pickup Inventory button…Function to display the item within Pickup Inventory. This is only 
available when the shipment is created from a sales ticket. 

Ship Info button…Display the Shipping Details form for this shipment. 

Print button…Prints a detailed report of the shipments displayed within the grid.  

This printout can be utilized to report shipments with status ‘Shipped’ for a specified date range to 
third party insurance providers. See the Third Pary Insurance topic for more information. 

Ship button…Function that will change the shipment’s status to Shipped. It also inserts the 
current date as the shipment date and prompt for the shipments tracking number that 
may be manually keyed in or scanned. The system can also prompt for the shipment’s 
declared value when that option is set in Main->Housekeeping->General Setup-
>System/Store Setup->Integration Tab ‘ Prompt for declared value’ as a reminder to 
enter this important information. 

The tracking number, declared value and estimated shipping cost can automatically be saved into 
the WinPOS® system with the optional shipping integration software module. 

Add Same button...Will create a new shipment request and default the information to the same 
as the highlighted shipment (including ship method,notes , SA id ..etc) within the grid. 
 This is a shortcut to speed the creation of new shipments going to the same 
location/customer. 

Add button…Allows a shipment request to be created and displays a blank Shipping Details 
form. 

Done button…Exits this form. 

Shipping Details 

Located from Main->View/Change Customer->Sales Ticket Detail->Status 

Located from Housekeeping->Inventory Setup->Inventory-> Ship Customer Items->Shipping 
Info 

Located from Housekeeping->Inventory Setup->Inventory-> Ship Customer Items->Add 

Located from Housekeeping->Inventory Setup->Vendors-> Create Shipment 
 

This form allows for the entry and editing of shipping information.  

Shipping can be done for items on sales tickets module, as well as anything going to Vendors 
or other entities. The system module is design to improve organization and efficiency.  

The information contained within the Shipping module is used by a company’s shipping 
department to package, label and ship the requested items. 

The shipping module may be optionally integrated to United Parcel Service (UPS) and Federal 
Express Air/Ground. The integration saves time and reduces errors in the shipping process. 
Shipping information and tracking numbers are automatically transferred to/from. See Shipping 
Integration to UPS & Fedx for more information.  

Save money by insuring the shipment with a third party insurance provider instead of with the 
carrier. See Shipping Insurance for more information. 

When viewing the Shipping Details form, a Shipping menu option will appear at the top of the 
main ProfitSystem window.  This menu will have one option, Close Ground Batch.  This is only 
enabled when using the Integrated Shipping function with FedEx. 

Fields 

Status…The status of the shipment. Three statues exists:  
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1. Wait Ship: Definition, the shipment has not been released for shipping. A 
shipment is released when a user clicks the Release for shipping button OR a 
user manually changes the shipment status OR for four actions to be completed. 
When released the status will be Ready Ship. Actions:  

a. The item to have a status of IN (in pickup inventory), if the shipment 
was created from a sales ticket 

b. The item to have a zero sales ticket balance, if the shipment was 
created from a sales ticket  

c. The Paperwork confirmed by field completed with a Sales Associate 

d. The Address confirmed by field completed with a Sales Associate 

2. Ready Ship: The item is ready to be shipped. 

3. Shipped: The item has been process for shipment. 

Created…The date the shipping request was created. 

Store ID...The store location that created the shipment request. 

Ticket…The ticket number the item appears on, when the shipment is created from a sales ticket. 

Line… The line number of the ticket the item appears on, when the shipment is created from a 
sales ticket. 

SA ID…The sales associate that created the shipment request. 

Name…The name the shipment is being sent to. 

Address… The address the shipment is being sent to. 

City… The city the shipment is being sent to. 

State… The state the shipment is being sent to. 

Zip… The zip the shipment is being sent to. 

Phone…The recipient’s phone number. 

Email…Email address of the person the shipment should be confirmed to. The carriers will send 
the email address a shipment confirmation when the email address is provided to them 
as part of the shipment information. 

Cust. To receive by…The date the shipment needs to reach it’s destination. 

Requested Ship method…How the person receiving the shipment has requested it to be sent. 

Notes…Misc. Details/Comments about the shipment. 

Paperwork confirmed by & date…The sales assocate’s code that has approved that all 
documents, i.e. terms of sale, credit card approvals, etc have been signed/received. 

Address confirmed by & date…The sales associate that has confirmed the shipping address 
with the person requesting the shipment. 

Carrier…UPS, Federal Express or Other. 

Tracking…The tracking number of the shipment with the carrier entered by the operator or 
automatically completed with the optional shipping integration software. 

Ship Date…The date the shipment was processed. 

Shipping Cost…The estimated shipping costs entered by the operator or automatically 
completed with the optional shipping integration software. 

Delivered…The date the item was delivered, entered by the operator. 
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Declared value…The declared value of the shipment, entered by the operator or automatically 
completed with the optional shipping integration software 

Weight…The weight of the shipment, entered by the operator. 

Service Used… The actual shipping service used, entered by the operator or automatically 
completed with the optional shipping integration software 

Reference… A shipment comment, entered by the operator or automatically completed with the 
optional shipping integration software 

Buttons 

Release for shipping button…Function to immediately release shipment and to change it’s 
status to Ready Ship. 

Track button…Function to automatically track the shipment with the carrier. This function 
requires the station to have internet access. 

Cancel shipment button…If the package was shipped using the integrated shipping module (not 
ShipRush) and a tracking number is present in the Tracking field, the this button will 
attempt to cancel the shipment with the carrier.  Normally shipments can only be 
cancelled if they have not been picked up. 

Reprint label button…If the package was shipped using the integrated shipping module (not 
ShipRush) then this button will reprint all the labels associated with the shipment. The 
actual label files are stored in a folder called ShippingForms, located in your live data 
folder.  The files are in Zebra EPL format. 

Reprint forms button…If the package was shipped using the integrated shipping module (not 
ShipRush) then this button will reprint all the international shipping forms associated with 
the shipment.  The actual form files are stored in a folder called ShippingForms, located 
in your live data folder.  The files are in PDF format. 

Delete button…Deletes the shipment and all of it’s details. 

Print...Prints a recap of the displayed shipping request. 

Done button…Exits the form. 

Pickup/Customer Inventory 

Pickup Inventory 

Switchboard: Main->Inventory->Pickup Inventory and Main->Housekeeping->Inventory Setup-
>Pickup Inventory 

Menu: Inventory->Pickup Inventory  

Action: PICKINV 

 

Pick-Up Inventory is inventory in the shop that belongs to customers. In other words, you hold 
items for your customers in Pick-Up Inventory until they eventually come in, pay off their item 
and “Pick it Up”. You may also think of it as your “Layaway Inventory”. 

All items Special Ordered and received or sold from Stock with a selected item status of pick up 
later will be kept in this file until the item is marked taken. When a special order item is received 
you can add the item directly into Pick-Up Inventory. However, receiving it via the Purchase 
Order Maintenance form is the recommended procedure. Items sold from Stock are 
automatically entered into the Pick-Up Inventory from the Ticket form if they are sold with a 
status of In by selecting “pickup later” on the ticket screen. 

UPDPICKNV security is required to edit, add, or delete a pickup inventory item. 
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Fields 

PO item number...The PO item number is a sequential number automatically generated by 
WinPOS® and assigned to individual inventory items. 

PO number...If this was a stock order item, the PO number for the stock PO will appear here. 
WinPOS® generates this number automatically when the PO is created. 

Event info...If this was a special order for an event (wedding, prom, etc.) this will show the event 
number, name, and date. Double-click to display the Event form for this event. 

Customer info...If this item was ordered for a customer (it’s not a stock order) the customers 
number and name will appear here. Double-click to display the Customer form for this 
event. 

Primary & work phone...For the customer. 

Quantity...The quantity of this item. 

Style, size, color, width...The store style number and size, color, and width of this item. 

Vendor number...The unique vendor code for the vendor supplying this item. 

Manufacturer style...The vendors style code. 

Description...The description for this item. This comes from the Retail Inventory. 

Category, sub-category...The inventory category and sub-category for this item. This comes 
from the Retail Inventory. 

Unit cost, Extended cost...Your unit and extended cost for this item. 

Store number...Only applicable to the WinPOS Multi-Store Integration. Indicates the current 
location of this item. This is set automatically when the item is received from the PO, or 
placed into pickup inventory via being sold with a status of In. You can change the store 
location if you have PICKSTORE security access. 

Invoice number...The invoice number from the manufacturer that was entered when you 
received the item. 

Date received...The date that the item was placed into pickup inventory. This date is filled in 
automatically when a PO is received, or when an item sold from stock and has it’s ticket 
line item status set to In. 

Received by.. The ID of the person who physically received the item (if it was a Special Order). 

Scheduled Notification ... Enter a date that this customer should be notified that the item has 
been received.  This date may also be edited via the pickup notification form.  Also 
controls when the item will appear on the Self Service web site, indicating to the 
customer the item is available for pickup. 

Notified by ...  Enter a SA whom notified the customer that the item is awaiting pickup.  This info 
may also be edited via the pickup notification form. 

Date notified...This space is provided for entering the date when you last notified the customer 
about this item. To quickly enter the current date, click the right mouse button. To view a 
calendar, double-click. 

Date of fitting...The date that the item left your store to be fitted.  

Date due...The date that the item is to be returned to your store. 

Date last taken out ... The date the last time the was taken out of store by the customer. 
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Date brought back...If the item was taken from the store, then returned using the Pickup/Spec 
Order/Return button on the Ticket form, the date returned will appear here. 

Fitting comments...This is for you to describe the results of the fitting. 

Special instructions...These are the special instructions entered when the item was originally 
special ordered. You can edit the special instructions here if you need to add to them and 
then re-print the PO. 

 

Buttons 

Notes ... Available to quickly access the event notes for the item when the sales ticket it was sold 
on is linked to an event..  When notes exist  for the displayed item the lettering will be 
blue. 

RCR…Displays the Returns/Cleaning/Repair form. Any RCRs entered for this item will be shown 
in the grid.  A new RCR may be added or the RCR report printed. When an RCR record 
is present for the displayed item the lettering will be blue. 

Receive ... This function will start the PO Receive function to allow the user to receive an 
issued/open Purchase Order. 

Print button...Allows you to print a Letter, Tag, or Mailing Label for the selected pickup inventory 
item. When you click it, you see a list of the letters, tags, emails,SMS or mailing labels 
that are set up to print for pickup inventory, and you can select one to print. If you only 
have one set up, it will print automatically.   Much of the customer information and pick-up 
inventory information is available to be merged into the letters printed here.  The merge 
information is set when the letter is created.  Letters may be emailed or a text message e 
sent with the optional email marketing service. 

Delete button…Allows you to delete a pickup inventory item. Normally, pickup inventory items 
are automatically deleted when the customer picks up the item via the Ticket form, or if 
you use the Mark Items Taken form (located at Main->Inventory->Mark Items Taken) If 
you choose to delete a pickup inventory directly, you will be prompted “Mark item as NOT 
received on PO?” You would answer yes if the item had not really been received, and 
you want it to be marked as open on the PO. Answer no if the item was received and is 
now no longer in your store. 

Add ... Add/Create a new pickup inventory item. 

 

 

Mark Items Taken 

Switchboard: Main->Housekeeping->Inventory Setup->Mark Items Taken  

Menu: Sales->Mark Items Taken 

Action: TAKEN 

This feature provides a quick way to mark several items as picked up by customers. This 
process will remove them from the Pickup Inventory and insert a date taken in the sale ticket file 
for review by shop personnel. The item status will be displayed as Taken on the customer’s 
ticket. It is especially important for shops that use the Pick-up accounting method to mark items 
taken. 

Items with a status on IN on sales tickets can be marked taken from the sales ticket itself. 

Enter item number...Simply enter the PO item number of the item being taken and press Enter. 
If you are using the standard Pickup Inventory tags the PO item number is bar coded on 
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the tag. You can read this barcode with a scanner to quickly and accurately enter the PO 
item number. 

Pickup Notification Form 

Switchboard: Main->File->Pickup Notifications 

Menu: Sales->Pickup Notifications 

Action: PICKNOTI 

The primary purpose of Pickup notification tool/form is to be utilized as an organized & 
systematic method to notify customers that their special ordered merchandised is ready for 
pickup.  

A secondary use of this form is to identify items that may have not been charged sales tax when 
they should have or a customer has been charged shipping but does not have a shipping record 
in the shipping module or was not charge for shipping, but does have a shipping record in the 
shipping module.  It identifies these items by placing a message in the description field found 
within the grid.  See description field information below for more details. 

The form is comprised of a grid that contains by default ALL of the un-notified pickup inventory. 
 Each inventory item must be marked as customer notified before the system will omit if from the 
grid. Click anywhere on the row containing the item to work with.  WinPOS© will select it making 
that item active allowing all information fields & functions/buttons to pertain to just it.  

By At the top of the list tab is a set of search fields. You can fill in one or more of these fields 
and press the LIMIT button. WinPOS® will then filter the list to show only the pickup inventory 
items that match the data in the fields entered. To  cancel the filter & show all un-notified pickup 
inventory appointments, press the Clear button. 

The grid may be sorted by scheduled notification date or customer name.  Sort is controlled by 
the rightmost column. 

Criteria 

Received...The pickup inventory received date. 

Notified...The pickup inventory notified date.  Entering a date range within this field will allow 
pickup inventory to display that has a notified date entered indicating the customer has 
been notified of it's availability for pickup. 

Scheduled Notification...The pickup inventory scheduled notified date. 

Notified by...The pickup inventory notified by field. 

Category... The pickup inventory item category. 

SA...The sale ticket's number one sales associate. 

Show Messages Only (checkbox)...This will filter the items within the grid to only those that 
have shipping/tax messages. 

Show items sold from stock (checkbox)... Checked, this option will only show items in pickup 
meeting the entered criteria that were sold from stock (not special ordered). 

 

Grid Fields 

Scheduled notification date...The date that has been entered to notify the customer. 

Style...The store style of the pickup item. 

Size...The size of the item. 

Color...The color of the item. 
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Name...The customer who purchased the item. 

Balance...The remaining ticket balance for the item 

Description...The description of the item that originated from retail inventory.  In the case when 
certain ticket criteria is met the description will be replaced with an message.  The 
message and their meanings are: 

*SHIP BUT TAXABLE...-Ship record exists and item has been charged tax.  Many shops DO 
NOT charge sales tax when items are shipped out of state.  Each state's sales tax 
requirements are different so check before you add/remove sales tax. 

*SHIP BUT NO FREIGHT...Ship record is on file for item, but no freight charge has been 
added to the customer's ticket  

*NO SHIP BUT NO TAX...No shipping record is found and item is not being charged tax but 
it's accounting class is taxable, indicating it should have been charged sales tax. 

Note: 

For WinPOS© to know that a shipping freight charge has been added to a customer's ticket 
the store style must start with FREIGHT. 

Event name...The name of the event the items was sold under. 

 

Info Fields 

Address 1, Address 2, City, State, Zip...The customer's address found on the customer record. 

Home, Work, Pager, Mobile Phone...The contact phone numbers for the customer found on the 
customer record. 

Event date... The event date of the event the item was sold under.  This is the event the 
assigned to the ticket the item was sold from. 

 

Editable Fields 

Scheduled notification date...The earliest date the custom should be notified that the item is 
ready for pickup.  In addition, this date controls when the item will be placed on the 
customer service web site as being available for pickup. 

Notified by...The sales associate or clerk that notified the customer.  

Date Notified...The date the customer was notified the item was ready. 

 

Buttons 

Limit button…This button will filter the list to show only appointments that match your fields. 

Clear button…Clears the filter and shows all appointments. 

View Pickup Inventory...Displays the pickup inventory form for the selected item.  On the pickup 
form, letters, labels or email may be created to notify the customer.  (integrated email via 
WinPOS© requires the optional email integration module). 

View Ticket...Displays the sales ticket the item was sold on. 

View Customer...Displays the selected item's customer. 

View Event...Displays the event registration (if any) that the ticket is assigned to that the item 
was sold on. 

Print... Prints a list of items contained within the grid that may be used as a worksheet. 
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Save...Saves any edits. 

Cancel...Cancels/discards any edits. 

Done.. Exits the form returning to the previous screen. 

 

Pick-Up Inventory Physical 

Pick-Up Physical Overview 

WinPOS© maintains the Pick-Up inventory automatically as users receive Purchase Orders, 
sale items to customers on tickets and indicate to the system that the store will keep for 
customer until a later pick-up and change items on tickets to the status of Taken as those items 
are removed from the store.  However many times, for whatever reasons, this process is not 
performed.   This will cause the Pick-Up inventory to report incorrect in-store quantities. 

A physical count will easily correct inaccurate Pickup Inventory quantities. Obviously, it is 
important to have a accurate count of items contained within a shop’s Pick-Up Inventory, 
particularly when the shop is on a Ticket Zero or Item Pick-Up revenue accounting method. With 
either accounting method the Pick-Up Inventory value, in most states, must be reported to the 
state government for tax purposes. 

To perform a Pick-Up physical, the item’s ‘Item Number’ assigned to it by WinPOS© when it is 
sold must be physically on the item. This is how the WinPOS© physical module identifies the 
item. 

The 'Item Number' may be a handwritten note attached to the garment.  Preferably, the Pick-Up 
tag produced by WinPOS© & contains the ‘Item Number’ in bar-code format.  Utilizing a 
barcode reader the Item Numbers may be quickly read.  Bar-codes are the fastest method to 
complete a physical count. 

Note: 

Some shops sale SERVICE styles (non-tangible items) and add those items to Pickup 
Inventory.  This is done for very specific accounting purposes.  They wish to control the 
exact time when the revenue of those services are realized.  However, if a pick-up inventory 
physical is done, those items will not be counted since they are not physically present.  To 
solve this issue a user can enter in on the Inventory Style tab-> Comment 2 line the 
characters PUPNODELETE.  The will prevent these styles from being removed from pickup 
inventory when a pickup physical is applied.  

Pick-Up Physical, Performing the Count 

 

The Pick-Up Physical count process is very simple. A item’s ‘Item Number’ should be entered 
within a text document, one Item Number per line.    

A text Document can be created with any of Microsoft's programs included with Windows, 
NotePad, WordPad or Word.  Just remember to save the file as a TEXT (.TXT) file, not a .DOC 
file. 

The text document does not have to be given a special name (however, a name like 
PUCount100104.txt is suggested, where the numbers are the date of the physical).  This 
naming convention makes it easier to organize and find the file later. 

The contents of the document may look like this: 
 
123011 
123412 
123567 
123765 
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To create a text documents in Windows, simply right click on your desktop & select NEW, then 
TEXT DOCUMENT. Provide a name, double click the new Icon & start entering the Item 
Numbers one per line. 

Entry of the Item Numbers can be manually, or via an attached scanner (scans may be used 
when bar-coded item numbers are on the tags) or use a portable scanner. 

The data must be checked for errors then imported into WinPOS©. See Pick-Up Physical - 
Apply the count topic for more information. 

Pick-Up Physical, Apply the Count 

Pick-Up Inventory Exception Report 

Switchboard: Main->Inventory->Physical Inventory->PickUp Inv. Exceptions and Main-
>Housekeeping->Inventory Set-UP-> Physical Inventory-> PickUp Inv. Exceptions 

Menu: Setup->Pickup Physical Inventory->Pickup Inventory Exceptions 

Action: none 
 

A Exception Report should be reviewed prior to permanently updating (modifying) the Pick-Up 
Inventory.  The Pickup Inv Exception report will provide a list of the changes that will be made to 
the Pick Up Inventory and provide operators an opportunity to identify problems and correct 
those before making a permanent change.   

Update the Pickup Inventory once the Exception report is satisfactory. 

The Exception report will ask for the location of the text file containing the actual Item Numbers 
of the Pick-UP Inventory counted. Once found it will compare the data within the text file to the 
Pick-up inventory file and print a report of the exceptions.  

The report contains multiple sections: 

Added from Fittings: 

This section appears when the optional Fitting Module is used.  If a fitting is linked to a pickup 
inventory item, and the fitting has a status of OUT, and it's ticket is found but there is no entry in 
the Pickup Inv. file for the item.  The Update function will add this item back to the Pickup 
Inventory file and change the ticket status to In. 

Deleted: 

If a Item Number is exists in the pickup inventory, but was not scanned as part of the physical 
and not found within the Fitting module, or in the Fitting Module but not OUT, then the item's 
ticket status is set to Taken and it is deleted from the pickup inventory. 

If the status on it's sales ticket is In, and Item number was not scanned as part of the physical 
and not in the Fitting module, or in Fittings but does not have a status of OUT, then it's ticket 
status is set to Taken and the pickup inventory item is deleted. 

Added from tickets: 

An item is added to Pickup Inventory when it is counted as part of a physical but not found 
within the Pickup Inventory.  WinPOS will locate the ticket it was sold on and change the status 
to In and add it to Pickup Inventory. 

UnKnown: 

The report will show Item Numbers counted, but NOT found within the Pickup Inventory or ticket 
file.  
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Update Pick-UP Inventory 

Switchboard: Main->Inventory->Physical Inventory->Update Inventory and Main-
>Housekeeping->Inventory Set-UP-> Physical Inventory->Update Inventory  

Menu: Setup->Pickup Physical Inventory->Update Inventory  

Action: none 

This function will permanently apply the count of the items within the text file by deleting those 
items not counted AND are not out of the store via the optional Custom Fitting software module 
or RCR module .  It will ask for the location of the text (TXT) file and a received date.  It will 
ignore pickup inventory past the entered received date (If there are Pickup Items marked In, but 
they're not counted, they will NOT be deleted if they were received after the cutoff date entered). 

Please review the Pickup Inventory Exception report help topic before updating the Pickup 
Inventory file.  You must be satisfied with this report BEFORE making a permanent change with 
this function. 

This function will permanently delete pickup inventory items from the Pickup File they were not 
counted.   

Note: 

It is recommended that a BACK-UP of WinPOS© is performed before applying the count in 
case a error is found soon after the update. 

Criteria 

Don't affect pickup inventory received after this date ... Items added to pickup inventory after 
this date will be ignored and left in the system. 

 

 

Returns/Cleaning/Repair 

Returns/Cleaning/Repair Overview 

Switchboard: Main->Housekeeping->Inventory Setup->Returns/Cleaning/Repair 

Menu: PO/SHIP->RCR 

Action: RCR 

The Returns/Cleaning/Repair (RCR) system tracks inventory items sent out for RMA’s, cleaning, 
repairs, etc. It is important to know the location of inventory at ALL times. 

After you create an RCR it’s considered active until the Return/receive date is filled in. It’s 
important that you update WinPOS® when the item is returned so that the all RCR reports will 
be accurate. 

 

Items RETRUNED via this RCR module that were ordered for customers are marked with a 
message or code, indicating that they have been returned and are out of the store. Forms that 
indicate an RCR is: 

Main-> View / Change Events-> Spec Orders / Pickup tab  (Item may show with RCR code by 
customer name or be removed from the list based upon system setting in Housekeeping-> 
General Setup-> System Setup-> Options Tab-> Hide Items out on RCR) 

Main-> Housekeeping-> Inventory Setup->  Pickup Inventory Form (indicated by the RCR 
button being displayed in BLUE) 
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Main-> File-> Pickup Notifications (Item may show via RCR code in item's DESCRIPTION or 
be removed from the list based upon system setting in Housekeeping-> General Setup-> 
System Setup-> Options Tab-> Hide Items out on RCR 

Main-> Purchase Orders-> View PO Items-> Details Tab  (message "This item is out on an 
RCR") 

Main-> Purchase Orders-> View Purchase Orders-> Item Detail (message "This item is out on 
an RCR") 

Sales Ticket:  item status is ORDER, if it had been received then RCR'd.  Until RCR is closed it 
shows out ORDER on ticket. 

 

 

 

Returns/Cleaning/Repair Form 

Switchboard: Main->Housekeeping->Returns/Cleaning/Repair->Returns/Cleaning/Repair  

Menu: PO/Ship->RCR->RCR 

Action: RCR 

Show for vendor…Select a vendor to only show entries for that vendor. 

Show items not returned/receiving only?…If checked, only show items where the 
return/receive date is blank. 

RCR number…This the ID number is automatically generated by WinPOS®. The first part of the 
number is your store number (as set in Main->Housekeeping->General Setup-
>System/Store Setup->Setup Tab) followed by a sequence number. You cannot change 
this number. 

Created by…The SA who created the fitting, followed by the date and time it was created. 

Type…Select a RCR type code from the RCR Types form. 

Pickup item number…If this RCR regards a pickup inventory item, the item number appears 
here. If you select a pickup item, the style/size/color/width are filled in automatically. 

Style code/size/color/width…If the item comes from retail inventory, enter the 
style/size/color/width here. If you enter the style/size/color/width you cannot enter a 
pickup item number. 

Vendor…If the item is sent to vendor, select the vendor here. 

RMA…Enter the vendor RMA here. 

PO number…You can enter a PO number here. If you select a pickup inventory item the PO 
number is filled in automatically. 

Invoice…You can enter an invoice number here. If you select a pickup inventory item the invoice 
number is filled in automatically. 

Cost…The cost, (if any) for the work. 

Due…The date the item is due back. 

Wear date…The date the item will be worn. 

Return/receive date…The date the item was actually received back from the vendor. 

Comment…You can enter any comments here. 
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RCR by Type Report 

Switchboard: Main->Housekeeping->Returns/Cleaning/Repair->RCR by Type Report  

Menu: PO/Ship->RCR->RCR by Type Report  

Action: RP_RCR 

 

Vendor…You can select a vendor and only items to that vendor will be shown. 

Type…You can select a type from the RCR Type form and only items with that type will be 
shown. 

Select return/cleaning/repairs – between…You can select one of the date ranges and enter a 
date range and only items within that date range will be shown. 

RCR Types 

Switchboard: Main->Housekeeping->Returns/Cleaning/Repair->RCR Types  

Menu: PO/Ship->RCR->RCR Types 

Action: RCRTYPE 

Task codes are used on fittings to indicate the work performed. 

Type…A unique code to represent the type (RMA, Cleaning, Repair, etc.) 

Description…A description of the work. 

Web Catalog 

Web Catalog Overview 

Switchboard: Main->Housekeeping->Create Web Catalog 

Menu: Inventory->Create Web Catalog 

Action: WEBCREATE 

WinPOS© offers a feature to create web pages (HTML) files from inventory that may be posted 
to a web site for the world to see.  The web pages may include descriptions, price and up to 4 
pictures of the item.  A person browsing the web catalog may request more information 
concerning an item via the click of a email button.  This email function will ask for contact 
information, include the inventory item information and send the email to the shop. 

There are several steps involved in the set-up of the Web Catalog: 

Step 1: Identify the inventory style size/color/widths to include in the catalog.  Mark these items 
by checking the 'Show in web catalog' checkbox on the Inventory - SCW form. 

Step 2: Insert pictures/images of the inventory style into the Image database of the Inventory 
Details/Style form.  The first four (4) pictures added will be used in the Web Catalog.  If a 
picture file is larger than 16.7 megabytes, it will not be uploaded. 

Step 3: Change the Retail Selling Price 1, if needed, since this is the price placed in the Web 
Catalog.  Next insert a detailed description in the Web Catalog Description field on the 
Inventory - Statistics Tab.  

Step 4: Execute the Web Catalog function located at Main Menu-> Housekeeping-> Create 
Web Catalog 

Step 5: Copy or FTP all the Web Catalog pages to the web site.  Link to the Web Catalog from 
your existing site. 
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There are several options that are configured on the Create Web Catalog form prior to 
creating a web catalog. 

 

Web site HTML templates folder...Specifies the directory where the web templates are located. 
 Should be \TPSWINS\WebTemplate\ by default. 

URL to shop home page...The URL for the web site for your store.  A link is included on the 
main page of the web catalog site to go to your main site.  For example: 
http://www.thebridalshop.com 

Shop name on web site..The name of your shop.  This is included on the main page of the web 
catalog.  For example: The Bridal Shop 

Web site title...The name for the web catalog site.  For example: The Bridal Shop Outlet Store 

Email address for 'Request more info'...The email address that request more info emails 
should be sent to.  For example: sales@thebridalshop.com.  From the web catalog 
customers by default can request addition info from each item's web page.  This request 
is sent by email via the email info entered on this form. 

The Request more info template utilizes a free CGI mail program included with WinPOS 
 called Mailform.  The template has been created to work with this program.  For 
programming details see the section below, 

When setting the "Request more info via" to Mailform, the Mailform program requires the that 
SMTP service be running on the same computer as the web server. Also, MailForm does not 
support authentication with the SMTP server.  MailForm must be able to use the SMTP via 
the web server's 127.0.0.1 IP address, with no username or password. 

Create web site...The site can be created locally on a computer, or it can be created and 
automatically uploaded to a web server at BBL Systems, Inc.  If On My Computer is 
selected, the following four options are enabled.   

Create web site in folder...Specifies the directory where the web site will be created.  For 
example: \INETPUB\WWWROOT\ 

Home page file name..The filename to use for the main page of the web site.  If the web catalog 
is a sub-part of a bigger site, then typically you will already have a default.html or 
index.html as a main page.  In this case, you'll want the web catalog main page to have a 
different name, and the main web catalog page will be linked to from your main site.  For 
example: INDEX.HTML 

Request more info via..Simple Email is the only option.  When Simple Email is selected and the 
user enters their contact info into the Request More Info block for a dress, an email is 
composed on the users computer which contains the details of the dress and is 
addressed to you.  It is up to the user to actually send the email.   
 
In either case the email will be sent to "Email address for 'Request more info'" 

URL to web site...The full URL to the web site where it will be hosted.  For example: 
http://outlet.thebridalshop.com 

 

Create web site..If Hosted by BBL Systems, Inc, is selected, the following two options are 
enabled.  

Shop ID...Specifies the directory where the web site will be created.  For example: 

Password...Specifies the directory where the web site will be created.  For example: 
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Web Catalog Customization 

The web site is created by combining templates with the WinPOS inventory data.  The process 
is similar to mail merge.  There is a set of template files that contain the HTML for each page on 
the web site, such as the home page, the page showing the details for an item, etc.  These 
template pages contain merge codes (such as <%ITEM1%>)  When the web site is created, 
WinPOS processes the template file by substituting the correct HTML code for each merge 
code.  The end result is a page that contains the default template HTML (layout, formatting, etc.) 
with the information specific to that page merged in. 

These template files can be modified to change the layout of the web site.  If the template files 
need to be restored to their original state they can be found on the WinPOS distribution CD in 
\SERVER\TPSWINS\WEBTEMPLATES   

Font and color changes should be made to the STORE.CSS cascading style sheet, instead of 
making changes directly to the template pages.  Font and color changes made there affect all 
the pages automatically. 

Web Site Creation Process 

1. The destination directory is created if it does not exist. 

2. A directory called itemimages is created in the destination directory, if it does not exist. 

3. All the JPG files are copied from the webtemplates directory to the destination directory. 

4. The STORE.CSS file is copied from the webtemplates directory to the destination 
directory. 

5. The LOGO.BMP located in the WinPOS data directory is converted to a JPG file and 
copied to the destination directory. 

6. The homepage is created by processing the DEFAULT.HTML file, which includes the 
COPYRIGHT.HTML and MENUBAR.HTML files.  Any merge codes are also 
processed.  The file is created in the destination directory using the Home page file 
name specified. 

7. The THANKS.HTML file is processed and created in the destination directory. 

8. The Vendor file in WinPOS is scanned.  A page for each vendor is created, using the 
ITEMLIST.HTML template.  The name of the created page is VENDOR[vendor 
number].HTML.  This page displays all the styles for that vendor.  This page is 
displayed when the user clicks a vendor name on the vendor menu on the left side of 
the page. 

9. A page called ALLVENDORS.HTML is created, using the ITEMLIST.HTML template.   
This page displays all the styles.  This page is displayed when the user clicks selects All 
Vendors on the vendor menu on the left side of the page. 

10. The inventory is then scanned.  Each item that has the "Show in web catalog?" option 
checked is processed.  For each item a page called ITEM[stylecode].HTML is created 
from the ITEM.HTML template file. If Request More Email is set to Simple Email, then 
the FORMHEADERSM.HTML page is merged in, which causes the Request More 
Information form on the page to use simple email to send the results to the email 
address specified in "Email address for request more info".  If it is set to MailForm, then 
the FORMHEADERMF.HTML page is merged in instead.  This form uses the 
MAILFORM.EXE cgi program to send the results.  Also, up to four image thumbnails 
are created in the ITEMIMAGES sub-directory for the first four images on the style 
code. 

Layout of Created Web Site: 
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• DEFAULT.HTML is the home page.  It shows the introduction for the site and has a 
list of all the vendors.  

• Each vendor has a page called VENDOR[vendor number].HTML, which displays all 
the styles for that vendor. This page is displayed when the user clicks a vendor 
name on the vendor menu on the left side of the page. 

• ALLVENDORS.HTML is a special page that lists all the styles.  It is displayed if the 
user selects All Vendors from the vendor menu on the left side of the page. 

• Each item has a page called ITEM[style code].HTML  This page displays the details 
for an item, it's pictures, and also includes the form that allows the user to request 
more information.  It is displayed when the user clicks a specific item on the 
VENDOR.HTML or ALLVENDORS.HTML page. 

• THANKS.HTML is displayed after the user requests more information. 

• STORE.CSS is a cascading style sheet used for the colors and fonts on the web 
site. 

• Thumbnails of the item images are stored in a folder called itemimages. 

Request More Information Methods 

The request more information form works in one of two ways, either simple email or mail form. 
 With simple email the user fills out the form on the web site and clicks submit.  The uses email 
program is started and an email is composed that contains the information entered on the form.  
The user then has to click Send in their email program to send the mail.  This method requires 
no special CGI or programs on the web server, so it can be used with almost any web host.  
However, it looks less professional than the mailform method to users. 

Mailform uses a special CGI program on the web server called MAILFORM.EXE.  This program 
must be present on the web server, in a folder called _vti_bin that allows CGI programs to be 
run.   

Templates 

By default, these templates are stored in \TPSWINS\WebTemplate\  folder. The templates may 
be edited using a HTML editor.    

Some of the template files are HTML fragments instead of full pages.  This is because the files 
are inserted into a larger pages.  For example, the COPYRIGHT.HTML template file is added at 
the bottom of each page. 

The template files contains merge codes, as outlined below. 

The HTML files are located in \TPSWINS\WebTemplate\  The files are as follows 

File name Description 

COPYRIGHT.HTML This is an HTML fragment and is included at the 
bottom of each page on the site.  It should contain the 
copyright message for the site. 

DEFAULT.HTML This is the first page displayed as the site starts up.   

ITEM.HTML This page is displayed when the user selects a 
specific item.  It shows all the details and images for a 
single style, and also contains a form used to request 
more information.  The posting method of the form is 
either simple email or mail form.  Either the 
FORMHEADERMF.HTML or 
FORMHEADERSM.HTML file is inserted into this 
page at merge time to create the correct form posting 
method. 
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FORMHEADERMF.HTML This is an .HTML fragment that is inserted into 
ITEM.HTML if mailform is the selected Request More 
Information method. 

FORMHEADERSM.HTML This is an .HTML fragment that is inserted into 
ITEM.HTML if simple email is the selected Request 
More Information method. 

ITEMLIST.HTML This page is displayed when the user selects a vendor 
and all the styles for that vendor are listed. 

MENUBAR.HTML This is an HTML fragment and is included at the top of 
each page on the site.  it contains the navigation 
menu. 

STORE.CSS This is a Cascading Style Sheet file that contains the 
styles for the site. 

THANKS.HTML This page is displayed after the user requests more 
information. 

 

The image files are located in \TPSWINS\WebTemplate\ 

File name Description 

cccards.jpg This logo displays the credit cards accepted, used on the 
DEFAULT.HTML page. 

gradbar.jpg A horizontal dividing line, used on various pages. 

heading.jpg A logo file, 450x78, that is displayed at the top of each page. 

logo.jpg A logo file, 400x137, that is displayed in the copyright 
message at the bottom of each page. 

 

Merge codes 

Code Inserts into the web site 

<%TITLE%> The web site title, set on the configuration page. 

<%HOMEPAGE%> The actual file name of the home page. 

<%SITEURL%> The full URL to the web site where it will be 
hosted. 

<%MENUBAR%> Inserts the MENUBAR.HTML file. 

<%VENDORLIST%> A table containing the list of vendors. 

<%VENDORNAME%> The name of the vendor that's currently being 
processed. 

<%MOREINFOEMAIL%> The email address for request more info. 

<%SHOPWEBSITE%> The name of the shop. 

<%SHOPWEBSITENAME%> The URL for the shop web site. 

<%YEAR%> The current year. 



WinPOS Version 11 

194 

<%ITEMLIST%> A table containing the list of styles for a vendor. 

<%DESCRIPTION%> Description for the current style, used on the style 
detail page. 

<%PRICE%> Price for the current style. 

<%NOTES%> Notes for the current style. 

<%STYLECODE%> Style code. 

<%ITEM1%> Picture #1 for style. 

<%ITEM2%> Picture #2 for style. 

<%ITEM3%> Picture #3 for style. 

<%ITEM4%> Picture #4 for style. 

<%COPYRIGHT%> Inserts the COPYRIGHT.HTML file. 

<%FORMHEADER%> Inserts the FORMHEADERSM.HTML or  
FORMHEADERMF.HTML, if Request More Info is 
set to Simple Email or MailForm, respectively. 
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Prospects 

Prospect Overview 

Switchboard: Main->Prospects and Housekeeping->Prospects 

Menu: Sales->Prospects 

Prospects are tracked by WinPOS® so the shop can keep track of prospective customers. By 
doing so, you will be able to accomplish effective follow-up and generate prospect/sales 
analysis reports to help you make decisions. 

Prospects should be entered when they are well-qualified, which means they have interacted 
with the shop directly. This mean visiting the shop, or filling out "More Info" form on the shop 
web site, for example.  Lists of brides from trade shows are not well-qualified, as they have not 
shown direct interest in the shop. 

 

Show only prospects who have not become customers?...Normally, this is checked so that 
WinPOS® will only show you prospects who are still prospects. That is, prospects who 
have not become customers. 

Appointments...Available with the optional Appointment management system is activated.  This 
function will display the Appointment form and allow lookups and/or for new appointments 
to be created.  When a appointment is created the appointment customer info will default 
to the prospect data (including notes)form where the appointment originated to save time. 

Print button...This button will print documents for the currently selected prospect. You can print a 
letter (email), mailing label, or worksheet. 

Create event button...You can create an event for this prospect by clicking this button. 
WinPOS® will create the event and display the Event form in edit mode.  If the event type 
is not specified on the prospect, the event type will auto default to Wedding. If the Link to 
Event field is filled in on the Details tab, then a new Event is not created.  Instead, the 
prospect is linked to the existing event selected.  Delete...Deletes the highlighted 
prospect. 

Add button...Create a new prospect using the Add Wizard. 

Done...Exits the form. 

Prospect Form - Details Tab 

Switchboard: Main->Prospects->Details Tab 

Menu: Sales->Prospects->Details Tab 

Action: PROSPECT 

This tab contains information about the prospect. 

 

Bride contact information...The prospect information will be more useful if it is complete. By 
filling in the primary phone number you will be able to use the Add Wizard when creating 
customer, events, and other prospects. 

Contact phone numbers. (Primary, Alternate, Work, Fax, pager).. The primary number is usually 
their mobile phone number.  The primary number is utilized by WinPOS to compare when 
adding new customer entries to help prevent duplicate customer entries. 

SMS Alerts?...If a mobile phone carrier is selected, WinPOS® will be able to send SMS 
messages to this prospect.  SMS messages will be sent to their primary phone number. 
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Receive 3
rd

 party info?…Check this box if the customer agrees to receive email/postal mail from 
your business partners. You can query on this field to show prospects whose names you 
can share with your vendors, and other partners. 

Groom contact information...This information is optional. You may want to enter it if you cross-
sell formalwear or groom items. 

Event date, time, type...The event details are useful so you can follow up with the prospect 
based on this criteria. 

Event name...A descriptive name for the event. Make sure that you use a good name for the 
event, since this it what appears on reports, PO’s etc. For weddings, we recommend 
using the brides last name/grooms last name. For a school or social event, the name of 
the event. This field can be skipped and WinPOS® will auto-create a event name using 
the last name of the bride and groom once they are entered and the data saved.  By 
default the automatic event name will be bride's last name/groom's last name.   

When TPOS© or TPS© optional modules are activated the default automatic event name will be 
Groom's last name/Bride's last name unless a system setting is modified. A system setting 
controls whether the Groom's last name or the Bride's Last name goes first in the Event 
name.  Housekeeping->General Setup->System Store Setup->Rental Tab - 'Put bride first 
on Event/Prospect' controls the sequence.  

Individual?...Is this an individual buyer who is not part of an event? 

Prospect source...The prospect source codes are created by the shop and entered into 
WinPOS®, see Customer Source form. 
 
This source code represents an activity (advertising) (i.e., yellow pages, word of mouth, 
etc.) that caused the prospect to visit your shop. By using this code, you will be able to 
generate analysis reports that will provide information indicating your most powerful form 
of advertising. 

Hint 

WEBREQUEST is a source code used by the BBL marketing module when inserting web 
form prospects into the prospect.  This code should appear in your source file so you may 
report on those prospect entries created by the marketing web forms.  If it does not please 
go to that form and add it.  Found in Housekeeping-> General Setup-> Customer Source 

Prospect type...The prospect type codes are created by the shop and entered into WinPOS®, 
see Customer Type form. 
 
This type code represents a grouping of prospects. By using this code, you will be able to 
generate analysis reports that will provide information indicating the breakdown of 
prospects into the groups you’ve defined. 

Created...The date and time this prospect was created. 

Notes button...You can enter any notes you would like about the prospect. These will print on 
the worksheet. If they are interested in certain styles, use the Interests on the 
Interests/History tab. If you have action items, or to-do items for this prospect, use the 
Action list on the Interests/History tab. If you create an event for any prospect the notes 
will be copied from the prospect into the event notes. Notes only may be printed by 
clicking the Notes button and then clicking the Print button.  The Notes printout will 
include the prospect name and store location (store that entered the prospect) and the 
current store address. 

Camera button...You can take pictures of prospects and store them on the prospect card. This 
button displays the Prospect Images form, where you can take these pictures, view them, 
and delete them if you need to. 
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Last activity...The last date this prospect was in the store. This date is filled in automatically. 

Event number, event created...If you have created an event using the prospect, the event 
number and date/time created is shown here. 

Sales associate...The SA ID of the sales associate who helped this prospect. 

Email address…The email address for the prospect. You can send an email by double-clicking 
on the email address when the optional email feature is activated. If nothing happens 
when you double-click on the email address you need to configure Windows with for 
default email client in Housekeeping->General Setup->System/Store Setup->Integration 
tab.  Consult your Internet Service Provider (ISP) for email setup information. 

 

Events 

A prospect can be associated with an existing event prior to becoming a customer.  This way, 
when the prospect becomes a customer, they are automatically linked to the event.  This 
is done for prom prospects.  First, an event should be created for each high school prom 
in the area.  Then, when the prom prospect visits the store a prospect record is created 
and the correct high school prom event is selected.  At this point, they are still a prospect. 
 When the prospect decide to buy, locate the prospect and use the Create Event button. 
 Instead of creating an event and making the prospect the bride, it will create a customer 
for the prospect and add them as a member to the event. 

Alternately, the event details can be entered on the prospect prior to the event being created. In 
this case, the event details from the prospect are used to create the event when the 
Create Event button on the Prospect is used. 

 

Link to event…An existing event that this prospect should be linked to when the become a 
customer. 

Event date…If the prospect is being linked to an existing event, this is the event date for that 
event.  If they are not linking to an existing event, then this will become the event date. 

Event time…If the prospect is being linked to an existing event, this is the event time for that 
event.  If they are not linking to an existing event, then this will become the event time. 

Event name…If the prospect is being linked to an existing event, this is the event name for that 
event.  If they are not linking to an existing event, then this will become the event name. 

Event type…If the prospect is being linked to an existing event, this is the event typefor that 
event.  If they are not linking to an existing event, then this will become the event type. 

 

 

Prospect Form - Interests/History 

Switchboard: Main->Prospects->Interests/History Tab 

Menu: Sales->Prospects->Interests/History Tab 

Action: PROSPECT 

 

This tab contains the retail or rental (rental if the optional Tuxedo POS module is installed) 
styles that the prospect was interested in, as well as any to-do or action items for sales 
associates to perform. The interests and the actions print on the Prospect Worksheet. 

Interest Section 



WinPOS Version 11 

198 

The interests’ section is where the styles, sizes & colors the prospect was interested in are 
recorded. Each time a style is entered the system automatically increments the activity count on 
the style in retail inventory, Retail Inventory form.  Activity is a great way to see the interest in 
each style. 

Fields 

Retail style...The store style number of the item they were interested in. 

Rental style...The rental style number of the item they were interested in. Only available if you 
have WinTPS. 

Sales associate...The SA who showed them the item. 

Style list Grid...This list shows all the styles they were interested in, the sales associate who 
showed it to them, and the date the styles were entered. 

Delete item button...Select an interest from the list and click this button to delete it from the list. 
The item is not actually removed from the list, but is marked with an asterisk. This is done 
so if the prospect later decides she does not like the item, it will still show that she did like 
it at one time. 

 
TO-DO Section 

The TO-dos section is where you see/review current or completed TO-DOs for the prospect. 
 TO-DOs are actions/tasks that must be performed for the prospect. 

Show Competed? (checkbox)... Checked only completed TO-DOs will appear within the grid. 

Called Button... Creates a completed TO-DO with the action description set to Called with 
current date/time.  User should enter additional description of call result. 

eMailed Button... Creates a completed TO-DO with the action description set to eMailedd with 
current date/time.  User should enter additional description of email details. 

SMS Button... Creates a completed TO-DO with the action description set to SMS with current 
date/time.  User should enter additional description of SMS. 

Add T0-DO button... Add a new TO-DO for the prospect. 

Existing TO-DOs within the grid may be double-clicked to display details of the task.  New 
information may be appended, the TO-DO reassigned or marked completed. 

Checking the box next to an existing TO-DO displayed within the grid under the Done grid 
column will mark the TO-DO completed. 

See the To-Do topic for additional information concerning TO-DOs. 

Add Wizard - Creating New Prospects, Customers, Events 

Switchboard: Main->View/Change Event->Add button and Main->View/Change Customer->Add 
button and Main->Prospect->Add button 

Menu: Sales->Events and Sales->Customers and Sales-Prospects 

Action: none 

 

Once the Add button is clicked The Search form will appear and prompt a customer's primary 
phone number (usually the cell). We use the phone number to check to see if the contact is 
already on file as a prospect, customer, or already has an event. This way, you won’t 
accidentally create two prospect cards, customer cards, or weddings for the same person. 
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Enter the phone number and press Enter, or click Search. WinPOS® will then list all of the 
phone number matches for prospects, customers, and existing events. You can select a match 
and then click on one of the four buttons at the bottom of the Search form. 

Hint: 

You must select a person in the Grid for the buttons to become active (available to use) when a 
phone number match is found. 

 

Buttons 

Go to Event/Customer/Prospect...This button will display the event, customer, or prospect card 
for the selected match. You would use this to see the details of the match to verify that 
you’ve found the correct person. 

Create Event for this Customer/Prospect...This button will create a new event, using the 
details of the selected match (either a customer or prospect.) You will then be taken to 
the members tab of the Event form to enter the event details. 

Create A New Event/Customer/Prospect...This button will create a new event, customer, or 
prospect, depending on which form you were on when you pressed the Add button. You 
will be filling in all the details from scratch. 

 

Once the appropriate button is chosen the data entry form will appear with the phone number 
entered.    

When adding customers to the Customer Details Tab, the operator may swipe the Drivers 
License via a card swipe for the following states: Arkansas (AR), Mississippi (MS), Louisiana 
(LA) & Florida (FL). which will auto insert the customer's address information. 

Prospect Worksheet 

Switchboard: Main->Prospects->Print button 

Menu: Sales->Prospect->Print button 

Action: PROSPECT 

This report contains all the prospect contact information, as well as their interests and past and 
future appointments. 
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Customers 

Customer Overview 

Switchboard: Main->View/Change Customer  

Menu: Sales->Customer 

Action: CUSTOMER 

Each person doing business with you is considered a customer. This includes brides, grooms 
and any member registered within an event. 

WinPOS® has one “built-in” customer, called Walk In. Their customer number is Walk-In, their 
first name is Walk and their last name is –In. You cannot delete this customer. When you ring 
up a quick sale (by selecting Main->Sale->Quick Sale) a sales ticket is created and added to 
this customer. Note that you cannot special order items or place items in layaway for the Walk-
In customer, and you cannot save a ticket for the Walk-In customer that has a balance. 

Each customer is assigned a Customer Card where his or her details are contained. Customer 
cards are created automatically when you add members to an event via the Event form. You 
would normally only create customers directly from the Customer form if they are not part of an 
event. Customer details are accessed from within the View/Change Event module on the 
Members tab or from the Customer module on the List tab. 

The Customer form has four tabs 

• List tab: Used to locate the correct customer. 

• Customer tab – Displays the Customer card, used to enter and show personal 
details about a customer, including address and phone numbers, birth date, ID 
information, and ticket balances or credits. 

• Details tab – measurement dates, size details, and purchase information. 

• Spec Orders/Layaway tab – shows purchased items that are pending Special 
Orders or items that have been received into the Pickup Inventory. 

• Interests/History - Product interest and TO-DOs are found on this tab 

• Images - Any image may be attached to a customer card.  This tab displays the 
images and allows new ones to be added. 

Print button...Allows you to prints a Letter, eMail,  Tag, or Mailing Label for the selected 
customer. When you click it, you see a list of the letters, tags, or mailing labels that are 
set up to print for customers, and you can select one to print. If you only have set up, it 
will print automatically.  eMails sent here are automatically entered in the TO-DO history 
for the customer. 
 
A worksheet can also be printed that lists the customer interests, as well as past and 
future appointments. 

Delete button...Deletes the selected customer. If the customer has any tickets with outstanding 
balances you will not be able to delete them. You will be warned if the customer is a 
member of an event, but you will still be able to delete them in that case. Requires 
CUSTDELE security. 

Add from prospect...You can create a new customer using a Prospect card, rather than entering 
all the details directly. Click this button and then select a prospect from the pick list 
displayed. WinPOS® will create a new customer using the details from the Prospect card. 
Using the Add button on the Customer form will check if the customer is a prospect 
automatically, so it is recommended that you use the Add button rather than the Add from 
Prospect. 
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Add button...Create a new customer using the Add Wizard. 

 

Diagram 
 

 

Customer Form - Customer Tab 

Switchboard: Main->View/Change Customer->Customer Tab  

Menu: Sales->Customer->Customer Tab  

Action: CUSTOMER 

The Customer tab contains personal data about the selected customer. 

Customer...This the unique customer ID automatically generated by WinPOS®. The first part of 
the number is your store number (as set in Main->Housekeeping->General Setup-
>System/Store Setup->Setup Tab) followed by a sequence number. You cannot change 
this number. 

Name, Salutation, Birth date, Address ...This is the demographic information for the customer. 
 
As you are entering the contact information, enter the zip code before you enter the city 
and state. If WinPOS® has the zip code on file, it will fill in the city and state for you. As 
you enter zip codes, WinPOS® will learn which zip codes are associated with which cities 
and states. You can view/modify the zip code WinPOS® has learned on the Zip Code 
form (at Main->Housekeeping->General Setup->Zip Codes (ZIP)) 

Store...The store that created this customer. Normally, this is your store unless you are using the 
Multi-Store Integration. 

Contact phone numbers. (Primary, Alternate, Work, Fax, pager).. The primary number is usually 
their mobile phone number.  The primary number is utilized by WinPOS to compare when 
adding new customer entries to help prevent duplicate customer entries. 

SMS Alerts?...If a mobile phone carrier is selected, WinPOS® will be able to send SMS 
messages to this customer.  SMS messages will be sent to their primary phone number. 

Customer source...The customer source represents an activity (advertising) (i.e., yellow pages, 
word of mouth, etc.) that caused the customer to visit your shop. By using this code, you 
will be able to generate analysis reports that will provide information indicating your most 
powerful form of advertising. You can define your sources using Main->Housekeeping-
>General Setup->Customer Sources. These same sources are also used with Prospects. 
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Customer type...The type code is used to identify different groups of customers. You can 
analyze your customers by type, and print letters, mailing labels, etc. You can define the 
types you need using Main->Housekeeping->General Setup->Customer Types. 

Alternate ID 1-4...These four fields are provided for you to enter any information you need. You 
can change the captions for these fields in Main->Housekeeping->General Setup-
>System/Store Setup->Setup Tab. 

Female/Male...This is used to display the correct measurements on the Details tab, and the 
Members Tab of the Event form. You can also use this field in queries to analyze your 
customers. 

Shoe notes on new order? checkbox...WinTPOS optional module feature.  Checked this will 
display the customer notes when a new rental order is created for this customer. 

Tickets list...This list shows you all the Tickets for this customer. You can double-click on a ticket 
in the list and WinPOS® will show you the ticket itself. You could then sell an item on that 
ticket, take a payment, make a refund, etc. The list is sorted in reverse chronological 
order (most recent first) The date in the list is the date the ticket was created, not the 
event date.  

Orders list... WinTPOS optional module feature. This list shows you all the Orders for this 
customer. You can double-click on a order  in the list and WinPOS® will show you the 
ticket itself. You could then sell an item on that ticket, take a payment, make a refund, 
etc. The list is sorted in reverse chronological order (most recent first) The date in the list 
is the date the ticket was created, not the event date.  

Email address…The email address for the customer. You can send an email by double-clicking 
on the email address. If nothing happens when you double-click on the email address 
you need to configure Windows with for default email client. Consult your Windows 
documentation for more details. 

Buttons 

Notes button...Enter any general notes about the customer. 

Show events button...Displays a list of the all the events that this customer is in. Remember, 
there is only one customer record, even if the customer is in multiple events. 

New ticket button...Creates a new ticket for this customer. You would use this if the customer is 
making a brand new purchase is not related to an event. If they are purchasing 
something related to an event, you should ring up the sale through the Members tab of 
the Events form (at Main->View/Change Event->Members Tab) If you do use the New 
Sale button here, and the customer is in any events, WinPOS® will still ask you if this 
purchase is for any of those events, just to be sure. 

Camera button...You can take pictures of customers and store them on the customer card. This 
button displays the Images form, where you can take these pictures, view them, and 
delete them if you need to. 

Find Style button…Only available on the Walk-In customer. This option is used to locate the 
ticket that contains a specific style code. You will first be prompted for the style code to 
search for, then WinPOS® will display all the tickets that contain that style code.  
 
This is usually used to ring up a return for an item sold using the Quick Sale. 

Appointments button…Displays the Appointments form, only showing appointments for this 
customer. On the Appointments form WinPOS® will indicate the the list is being limited to 
appointments for this customer by showing “Limit to customer” in the Limit criteria box. 

Fittings button…Displays the Fittings form, only showing fittings for the current customer. 



WinPOS Version 11 

204 

Orders list...This list shows you all the rental order on file for this customer. You can double-click 
on an order in the list and WinPOS® will show you the rental order itself.  

Order functions button...This button displays a menu of order WinTPOS optional module 
 functions, which are: 

• View Order: Displays the rental order currently highlighted in the orders list. 

• New Order: Creates a new rental order for the customer.  

• Pickup: When the customer arrives to take the rental order, use the Pickup button to 
mark the selected order taken by the customer. If the rental order has a balance due 
the payment form will be displayed to collect the payment due. You can also pickup 
a rental order by using the Pickup button on the main switchboard. It is important to 
pickup the rental orders so WinTPS can track order status accurately, and report on 
delinquent orders and also compute late fees correctly. 

• Return: Click this button to return the highlighted rental order. You can also return an 
order via the Return form from the main switchboard. Again, it is important process 
Pickups and Returns via WinTPS so the statuses in WinTPS will be accurate. 

• Plant Status: Only available if you have the WinTPS Link Integration, and if the 
Communications Method is set to Realtime. Clicking this button will display the order 
status in TPS Plant. After the order is confirmed in WinTPS, it will pass through a 
variety of statuses in TPS Plant (WT ASM, IN ASM, WT SHP, SHIP) During this 
time, the status is WinTPS will remain Confirmed. In this case, knowing the TPS 
Plant status can be useful. 

• Cancel: Exit menu & return to previous form. 

Customer Form - Details Tab 

Switchboard: Main->View/Change Customer->Details Tab  

Menu: Sales->Customer->Details Tab  

Action: CUSTOMER 

The Details tab contains additional details concerning the selected customer, including sales 
history, measurements, rental order sizes and statistical information. 

Measurements 

Measured by...The sales associate who measured this customer. 

When measured...The date and time they where measured. 

Measurements...Men’s or women’s measurements will be displayed depending on the gender 
chosen on the Customer Tab. These measurements can be printed on the receipt and/or 
inserted into special instructions. The settings are in Main->Housekeeping->General 
Setup->System/Store Setup->Options Tab. 

Order Sizes 

WinPOS optional module feature. 

This section will display the first ten (10) rental item types defined within the system and provide 
a SIZE (first field) and size REFERENCE (second field) for each item type.  As a new rental 
order is created, the system will automatically insert the customer's sizes onto the order as each 
style of an item type found here, is added (if sizes are present on this form).  If sizes ARE NOT 
present in this form the WinTPOS system will attempt to locate a previous rental order for this 
customer.  If an older order is found the system will default the sizes from that order as the new 
order is created.  If the customer's order sizes are empty on this form or different than the sizes 
entered onto a new order, WinTPOS will prompt the user and if approved by the user update the 
size with the new size entered onto the order.  
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Applied to all sales on future tickets 

This is a customer level markdown and will automatically apply to any sale made on this 
customer's ticket.  Customer Markdowns may be temporarily suspended  from the ticket by 
clicking the Adjust/Cancel/Extra Charge button-> Ticket Adjustment-> Clear. 

Adjust Amount...  The amount of the automatic customer markdown.  Enter whole dollars or 
percentages. 

Adj code... The reason code for the adjustment.  Used for report analysis. 

Review the topic Using Markdowns for more information. 

 

Other Details 

Store credit...The dollar amount of store credit this customer has. Store credits are created when 
you cancel a sale and choose not to give the customer a refund. The money owed the 
customer becomes a store credit. This store credit can be used for other purchases, or 
refunded to the customer. 
 
You can edit this number directly if you have EDITCREDIT security. 

Balance...This is the customer’s total balance for all tickets. This field is maintained automatically 
by WinPOS®. 

Total retail purchases...This is total of all purchases by this customer. This field is maintained 
automatically by WinPOS®. 

YTD retail purchases...This is total YTD purchases by this customer. This field is maintained 
automatically by WinPOS®. When the program is first started on January 1st, the system 
will prompt the user if she/he wishes to reset the YTD numbers. This field is maintained 
automatically by WinPOS®. 

Last retail sale...When the customer last purchased anything. This field is maintained 
automatically by WinPOS®. 

Customer entered on...The date/time the customer was entered into WinPOS®. This field is 
maintained automatically by WinPOS®. 

Last retail sale... Date/Time of last retail sale transaction  to the customer. 

Total rental... WinPOS feature.  Total rental sales made to customer. 

YTD rental... WinPOS feature.  Year To Date Rental revenue. 

Last Rental...  WinPOS feature.  Date of last rental order created for this customer. 

Last transaction...The last time this customer had any ticket transaction. 

 

Buttons 

Transfer Store Credit button...Used to transfer some or all of the store credit for this customer 
to another customer. You will be prompted for the customer and the amount of store 
credit to transfer. WinPOS® will make a log entry with the details of the transfer.  The 
transfer cannot exceed the total amount of the existing store credit. 

 

Customer Form - Special Orders/Layaways 

Switchboard: Main->View/Change Customer->Spec Orders/Pickup tab 
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Menu: Sales->Customer->Spec Orders/Pickup tab 

Action: CUSTOMER 

 

The Special Orders/Pickup Tab is used to review the items On Order and in Pickup Inventory for 
the selected customer.  The system will allow you to visit the PO Item Maintenance or Pickup 
Inventory data forms of each to review/make modifications. 

Order Grid 

On Order Grid...Lists all the items that have been special ordered for this event. Only items that 
were sold on tickets for this event will appear here. If you sold an item on a ticket that 
was not linked to this event the item will not appear here. If you accidentally sold an item 
on a ticket that was not linked to this event, you can retroactively assign that ticket to the 
event. See How do I assign a ticket to an event?  
 
Any special ordered item, regardless of event, will always appear on the Spec 
Orders/Pickup Tab on the Customer card.  The grid will scroll to the right to display more 
information concerning the selected item. 

The PO Confirm shipping date incorporates the same date padding rules as the customer 
MyInfo web pages so store personnel will provide the same info to customers when they call 
as if they were viewing the dates online in MyInfo. 

Buttons 

Go to PO Item...Select an item in the On Order list and click this button to go to the Purchase 
Order Item Maintenance form to view PO item. 

Go to PO...Select an item in the On Order list and click this button to go to the Purchase Order 
Maintenance form for the purchase order this item appears on. 

Go to Ticket... Will display the sales ticket the selected items was sold on. 

Note: 

The system will Display the code (RCR) in the customer name field of an item when the item 
has an RCR entry within the  RCR form created and it does not contain an Return Date 
(must be out).  This should indicate to the user that the item is NOT available for customer 
pickup. 

 

Pickup Grid 

Pickup Inventory list...Lists all the items currently in pickup inventory for this event. An item 
must have been received via the PO Maintenance form to appear here. 

 

Buttons 

Mark all Notified...Puts today’s date in the Notified field for all items in pickup inventory for this 
event. 

Go to Pickup Inventory...Select an item in the Pickup Inventory list and click on this button to go 
to the Pickup Inventory form to view this item. 

Go to Ticket... Will display the sales ticket the selected items was sold on. 

 

Note: 
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The system will Display the code (RCR) in the customer name field of an item when the item 
has an RCR entry within the  RCR form created and it does not contain an Return Date 
(must be out).  This should indicate to the user that the item is NOT available for customer 
pickup. 

Enabling the System Setup-> Options Tab->  Hide Items out on RCR on 
Cust/Event/pick notify? will HIDE (not display) the items out on RCR. 

Customer Form - Interests/History Tab 

Switchboard: Main->View/Change Customer->Interests/History Tab 

Menu: Sales->Customer->Interests/History Tab 

Action: CUSTOMER 

This tab contains the styles that the customer is  interested in, as well as any to-do or action 
items for someone to perform.  
 

Interest Section 

The interests’ section is where the styles, sizes & colors the prospect was interested in are 
recorded. Each time a style is entered the system automatically increments the activity count on 
the style in retail inventory, Retail Inventory form.  Activity is a great way to see the interest in 
each style. 

Fields 

Retail style...The store style number of the item they were interested in. 

Rental style...The rental style number of the item they were interested in. Only available if you 
have WinTPS. 

Sales associate...The SA who showed them the item. 

Style list Grid...This list shows all the styles they were interested in, the sales associate who 
showed it to them, and the date the styles were entered. 

Delete item button...Select an interest from the list and click this button to delete it from the list. 
The item is not actually removed from the list, but is marked with an asterisk. This is done 
so if the prospect later decides she does not like the item, it will still show that she did like 
it at one time. 

 
TO-DO Section 

The TO-dos section is where you see/review current or completed TO-DOs for the prospect. 
 TO-DOs are actions/tasks that must be performed for the prospect. 

Show Competed? (checkbox)... Checked only completed TO-DOs will appear within the grid. 

Called Button... Creates a completed TO-DO with the action description set to Called with 
current date/time.  User should enter additional description of call result. 

eMailed Button... Creates a completed TO-DO with the action description set to eMailedd with 
current date/time.  User should enter additional description of email details. 

SMS Button... Creates a completed TO-DO with the action description set to SMS with current 
date/time.  User should enter additional description of SMS. 

Add T0-DO button... Add a new TO-DO for the prospect. 

Existing TO-DOs within the grid may be double-clicked to display details of the task.  New 
information may be appended, the TO-DO reassigned or marked completed. 
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Checking the box next to an existing TO-DO displayed within the grid under the Done grid 
column will mark the TO-DO completed. 

See the To-Do topic for additional information concerning TO-DOs. 

Add Wizard - Creating New Prospects, Customers, Events 

Switchboard: Main->View/Change Event->Add button and Main->View/Change Customer->Add 
button and Main->Prospect->Add button 

Menu: Sales->Events and Sales->Customers and Sales-Prospects 

Action: none 

 

Once the Add button is clicked The Search form will appear and prompt a customer's primary 
phone number (usually the cell). We use the phone number to check to see if the contact is 
already on file as a prospect, customer, or already has an event. This way, you won’t 
accidentally create two prospect cards, customer cards, or weddings for the same person. 

Enter the phone number and press Enter, or click Search. WinPOS® will then list all of the 
phone number matches for prospects, customers, and existing events. You can select a match 
and then click on one of the four buttons at the bottom of the Search form. 

Hint: 

You must select a person in the Grid for the buttons to become active (available to use) when a 
phone number match is found. 

 

Buttons 

Go to Event/Customer/Prospect...This button will display the event, customer, or prospect card 
for the selected match. You would use this to see the details of the match to verify that 
you’ve found the correct person. 

Create Event for this Customer/Prospect...This button will create a new event, using the 
details of the selected match (either a customer or prospect.) You will then be taken to 
the members tab of the Event form to enter the event details. 

Create A New Event/Customer/Prospect...This button will create a new event, customer, or 
prospect, depending on which form you were on when you pressed the Add button. You 
will be filling in all the details from scratch. 

 

Once the appropriate button is chosen the data entry form will appear with the phone number 
entered.    

When adding customers to the Customer Details Tab, the operator may swipe the Drivers 
License via a card swipe for the following states: Arkansas (AR), Mississippi (MS), Louisiana 
(LA) & Florida (FL). which will auto insert the customer's address information. 

Images 

This form is used to add, edit or remove images from a customer, inventory item, or color chart. 

Delete image button...Deletes the currently displayed image. 

Add new image button...WinPOS® will prompt you to add an image or video. 

• Video: You will be prompted for the filename of the AVI file. 
• Image: You will be prompted for the filename, or you can select New. If you select 

New, WinPOS® will display a list of all the video capture and scanning devices 
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available on that computer. Select a device and capture the image and WinPOS® will 
import it. 

Replace image button...You can also replace an existing image. 

Quick Add Image buttons... This feature is designed to allow the user to quickly add an image 
from an installed TWAIN device like a camera or scanner.  It skips all of the dialogs of the 
Add New Image function described above.  The user will receive a TWAIN error if there 
are no compatible devices installed. 

Rotate Left & Rotate Right buttons... These function will turn (rotate) the displayed image 90°.. 

First, previous, next, last button...If you can have multiple images these buttons will navigate 
through them. 

A user may also perform special tasks by right clicking the image.  A Right Click which you 
mouse is over the image will pop up a menu of special functions.  These include printing, 
zooming & exporting the image to disk. 

Customer Service Self Service Web (MyInfo) 

Main->Housekeeping->Create Self Service Site 

 

Self -service web site: (Why would you use it?)  WinPOS© creates a web site that customers 
can access to view their balance, status of orders, request receipt copies and other details of 
their event.  This could save the shop a lot of time answering simple questions concerning a 
customer's account.  Just direct customers to the web site to review their information.   

Information found on the web-site is: 

• Current Event date 

• Balance 

• List of Sale items and pickup availability.  Availability is determined by it's 
 scheduled notification date found within Pickup Inventory.  The date must be the 
same or a date prior to the date the site was generated. 

• Member list with individual total spending & Balance  (for bride customers who 
access their event) 

• Ability to request their receipt to be emailed to them in  PDF format 

 

Each WinPOS customer ticket contains a web key, which is a ten character unique code the 
customer can use to access their self service page.  This key will automatically start appearing 
on receipts once the Self Service setup form is completed with the necessary setup data. 

 

To generate and publish the information on the World Wide Web. 

1. Go to Housekeeping->Create Self-Service Web Site. 

2. Make sure the fields are filled out with the URL to the web site, etc. 

3. Click Build and Publish Web Site. 

4. Copy or FTP all the generated pages to the web server.  Link to the self service Home Page 
name (supplied in the dialog below)  from your existing store site. 

5. It is a good practice to update the self service website via Publish Web Site once a date to 
update customer information. 
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WinPOS© will display a dialog form that will need to be completed once the Create Self Service 
Site function is clicked. 

Web site HTML templates folder... Specifies the directory where the web templates are located. 
 Should be C:\TPSWINS\WebTemplate\ by default. 

URL to shop home page... The URL for the web site for your store.  A link is included on the 
main page of the web catalog site to go to your main site.  For example: 
http://thebridalshop.com) 

Shop name on web site.. The name of your shop.  This is included on the main page.  For 
example: The Bridal Shop 

Web site title... The name for the web catalog site.  For example: The Bridal Shop Customer 
Service 

Home page file name.. The filename to use for the main page of the web site.  If the web catalog 
is a sub-part of a bigger site, then typically you will already have a default.html or 
index.html as a main page.  In this case, you'll want the web catalog main page to have a 
different name, and the main web catalog page will be linked to from your main site.  For 
example: INDEX.HTML 

URL to web site... The full URL to the web site where it will be hosted.  For example: 
http://outlet.thebridalshop.com 

Terms button... The document terms that will be included on the generated receipts.  Many 
shops use special document terms for PDF receipts, instead of the standard terms used 
on printed receipts. 

 

Create web site 

Option 1 

On my computer... The site can be created locally on a computer or on a computer in the 
local network. 

Create web site in folder... Specifies the directory where the web site will be created.  For 
example: C:\INETPUB\WWWROOT\ 

Option 2 

The information it can be created and automatically uploaded to a web server at BBL 
Systems, Inc.  or FTPed to any remote site. 

Hosted at BBL Systems Inc...  Select when BBL will host the customer data 

Upload to FTP site... Select when the data will be hosted at a remote locations web server. 

 

FTP Server, Directory, Username and Password... This information will be provided by 
the location that will be accepting your customer self serve data. 

Note on data transmission 

The data to be transmitted could be a large volume of data and thus be time consuming to 
transmit.  The more customers the more data.  A fast internet upload connection is desirable. 
 Example, 100  megabytes of data uploaded on a 512kb line would obtain approximately 
50,000 bytes per sec of upload speed which would equal an approximatel33 minute upload 
time. 

 

Note on search engine crawlers 

It is HIGHLY recommended that a special self service folder is created on your web-site and 
that customer self-service info is placed there.  Then instruct web search engine crawlers to 
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skip those folders/pages.  This can be accomplished via the ROBOTS.TXT  file, Google Web 
Master tools and SITEMAP.XML file. 

 

Buttons 

Save Settings... Saves the settings typed into this dialog for later recall.  

Build/Publish Site...A page is generated for each ticket that is active, or has had some activity in 
the last 6 months.  If the customer on the ticket is a bride, a special page is generated. 
Remember, a page is generated for each ticket, so a single customer can have more 
than one page if they have multiple tickets.  Each page will have a different web key, 
since each ticket has a different web key. 

Cancel...Cancel the operation & do not create the site.  Returns to previous menu. 

 

Templates 

The web site is created by combining templates with the WinPOS ticket data.  The process is 
similar to mail merge.  There is a set of template files that contain the HTML for each page on 
the web site, such as the home page and the page showing the details for a customer.   

These template pages contain merge codes (such as <%CUSTNAME%>)  When the web site is 
created, WinPOS© processes the template file by substituting the correct HTML code for each 
merge code.  The end result is a page that contains the default template HTML (layout, 
formatting, etc.) with the information specific to that page merged in. 

These template files can be modified to change the layout of the web site.  If the template files 
need to be restored to their original state they can be found on the WinPOS distribution CD in 
\SERVER\TPSWINS\WEBTEMPLATES   

Font and color changes should be made to the DEFAULT.CSS cascading style sheet, instead 
of making changes directly to the template pages.  Font and color changes made there affect all 
the pages automatically. 

 

Web Site Creation Process 

The destination directory is created if it does not exist. 

All the JPG files are copied from the webtemplates directory to the destination directory. 

The DEFAULT.CSS file is copied from the webtemplates directory to the destination directory. 

The homepage is created by processing the DEFAULT.HTML file..  Any merge codes are also 
processed.  The file is created in the destination directory using the Home page file name 
specified. 

The tickets file in WinPOS is scanned and each ticket with a balance, or any activity in the last 
six months is processed.  If the ticket does not have a web key, a web key is generated and 
assigned to the ticket. 

If the customer is a bride, then the SSBRIDE.HTML page is merged, creating a page named the 
same as the customers web key.  Also, a PDF version of the receipt is generated, using the web 
key as the file name, and a link to it is placed on the web page. 

If the customer is not a bride, then the SSCUSTOMER.HTML page is merged, creating a page 
named the same as the customers web key.  Again, a PDF version of the receipt is generated, 
using the web key as the file name, and a link to it is placed on the web page. 

 

Layout of Created Web Site: 
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DEFAULT.HTML is the home page.  It introduces the site and prompts the user for their web 
key.  The page contains a short javascript program that takes the web key and navigates to the 
 correct customer page. 

Each ticket has a page called [web key].HTML  This page displays the details for the customer 
ticket.  The page also contains a link to a PDF version of the receipt.  The receipt is named [web 
key].PDF. 

DEFAULT.CSS is a cascading style sheet used for the colors and fonts on the web site. 

 

Templates 

By default, these templates are stored in \TPSWINS\WebTemplate\  folder. The templates may 
be edited using a HTML editor.    

The template files contains merge codes, as outlined below. 

The HTML files are located in \TPSWINS\WebTemplate\  The files are as follows 

File name ....  Description 

SSBRIDE.HTML... This page is displayed for a customer that is a bride for an event. 

SSCUSTOMER.HTML...This page is displayed for a customer that is not a bride for an event. 
 Remember, a page is generated for each ticket, so a single customer can have more than one 
page if they have multiple tickets. 

SSDEFAULT.HTML... This page is the initial site page.  It contains a form to prompt for the web 
key and a short javascript program to navigate to the correct page. 

   

Merge codes used within the template HTML pages 

Code  - Inserts into the web site 

 <%TITLE%> ...  The web site title, set on the configuration page. 

<%HOMEPAGE%> ... The actual file name of the home page. 

 <%SITEURL%> ... The full URL to the web site where it will be hosted. 

 <%SHOPWEBSITE%>...  The name of the shop. 

 <%SHOPWEBSITENAME%> ...  The URL for the shop web site. 

 <%YEAR%> ...  The current year. 

 <%DATETIME%> ... The current date and time when the page was generated. 

<%CUSTNAME%> ...  The customers first and last name. 

<%EVENTDATE%> ... The event date, for the event linked to the ticket, if any. 

<%TICKBALANCE%> ... The balance on the ticket. 

<%PICKUPCUST%> ... A table listing all the items in pickup inventory for the customer. 

<%MEMBERS%> ... A table listing all of the members of the event. Only applicate to brides. 

<%RECEIPTLINK%> ... A hyperlink to the PDF version of the receipt. 

<%TERMS%> ... The selected document terms. 
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Events 

Events Overview 

Switchboard: Main->View/Change Event  

Menu: Sales->Events 

Action: EVENT 

General Information 

The concept of an event is central to WinPOS®. An event is a wedding, a social event, a prom, 
etc. that will contain multiple members/customers. The customers are related to each other via 
the event. If a bride or groom comes in to your shop to purchase/rent anything, you should 
create an event. The event is what ties all the members of the event together (the bridal party). 
You must create an event to be able to track all the members as a unit. Also, an event must exit 
to issue a single PO for a group of customer/event member items, like bridesmaids gowns. 

Creating a new event is easy.  There are multiple methods to create events and are: 

• Click the ADD button from the Event Form.  The system will ask for a PRIMARY 
phone number & attempt to locate the phone number in the Event file, Customer 
File, Prospect File and Appointment File (optional module) to see if the phone 
number is already in use to provide the user the opportunity to select one of the 
existing entries to be utilized for this new event. Otherwise, If the phone number has 
not been previously entered, the user can simply create the event and enter all the 
necessary data. 

• There is an Add from Prospect button on the Event form, but it requires that you 
know for sure that the bride or groom has been previously created as a  prospect in 
WinPOS®. Using the Add button instead will check if the bride or groom  is a 
prospect automatically via the Primary Phone number request,, so it is 
recommended that you use the Add button. 

• From the Prospect form click the Create Event button while on the prospect record 
that you wish to create the event for. 

 

Sales Registration 

With some events, like proms, it may be important to quickly locate items sold to any member of 
an event.    It may also be important for the system to auto alert the operator when a items is 
being sold to a member of the event that has also been previously sold to an member of the 
same event. For these needs WinPOS© offers sales registration. For example a shop may wish 
to register sales of gowns to a high school for prom or debutantes. 

To register sales for an event is easy.  Simply remember to check the Register Sales 
checkbox? on the ticket sales line of the item wished to be registered.  This may be manually 
checked even after the sale.  As an aid to the user, the store may designate a category of items 
to be registered automatically by enabling the  Register Sales checkbox? on the category 
form.  With this category option on, the ticket sales transaction Register Sales checkbox? is 
auto checked when it is of a inventory category that has this option turned on.  This prevents the 
user from having to remember to check the option manually. 

Once an item is marked Registered, it may be displayed via the Show Reg Sales and Serach 
Reg. Sales functions located on the Event Form - List tab.  In addition, when a user sales an 
item to a member of an event and the items sold was previously sold to another member of the 
same event then WinPOS© will display an message alert to the user indicating such. 
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Upon a sales item being registered, WinPOS will automatically alert the operator at SALE time it 
the item style or style & color have been previously sold to another member of the event. 

 

Buttons available to all Event Tabs 

Print button...Prints either an Event Card or PO Summary for the selected event.  The Rental 
Performance and Event Summary rental reports are included with the optional WinTPOS 
module. 

Add from Prospect...You can create a new event using a Prospect card, rather than entering all 
the details directly. Click this button and then select a prospect from the pick list 
displayed. WinPOS® will create a new event using the details from the Prospect card. 
Using the Add button on the Event form will check if the bride is a prospect automatically, 
so it is recommended that you use the Add button rather than the Add from Prospect. 

Add...Creates a new event using the Add Wizard.  Once the Add Wizard completes, WinPOS will 
prompt the user to identify the new contact for the event as a BRIDE or as a GROOM. 
 For Non-Wedding events select BRIDE, which would cause this contact to be placed in 
the primary contact position. 

Delete... CAUTION, this feature will delete the highlighted event and it's notes.  All members, 
their tickets and POs will be unlinked from the event. The event's customers, and their 
tickets, PO items and pickup inventory will not be deleted ONLY unlinked.  Once the 
event is deleted, it cannot be recalled.  Events deletions are logged in the WinPOS Log 
file.  Security may be set to allow specific employees to DELETE events - EVENTDEL.  

 
 

Event, Customer, Ticket Relationship diagram 

 

 

 

 

Event Form - List Tab 

Switchboard: Main->View/Change Event->List Tab 

Menu: Sales->Events->List Tab 

Action: EVENT 
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The Event list tab is used to locate an existing event.  

Once the desired event is selected, the remaining event tabs will reflect information for that 
event. 

 

Fields 

Search for...Enter the search value.  Any column with bold heading may be moved to the 
leftmost column and used to search by clicking the column header.. 

Only show current events? checkbox... Unchecked this option will search ALL events. 
 Checked it allows searching on current events, a much smaller list.  A Current event is 
 two weeks prior to the current date and any date into the future.  When an event is not 
being located, just un-check this option to search the entire list.  

Store... This is a filter option found in multi-store installations.  By default the system will display 
current events created at all stores.  To limit events created at a specific store enter that 
store's location id and click LIMIT.  To clear the filter and return to seeing all events 
created at all stores, click CLEAR. 

 

Buttons 

Show Reg. Sales...If the Register sales? option is checked for the sales transaction on a ticket, 
WinPOS® will track the sale items and allow for a quick search of it.. This button will display the 
list of all non cancelled registered items that have been sold to members of the selected event. 
This feature is great for prom & pageant events where the shop would prefer not to sell the 
same gown to different members of the same event. 

Search Register Sales...This function will display a search dialog form to search across ALL 
events, past & present.  The operator would enter a store style, SKU, Barcode or UPC (UPC is 
an additional ID that must be previously entered onto the SCW form in inventory)  for the item 
being searched) of the item to search).  The system will display all events where the item was 
sold (Note: if the Register sales? option is checked for the sales transaction on a ticket). 

Review the Events Overview topic for additional information. 

Event Form - Event Tab 

Switchboard: Main->View/Change Event->Event tab 

Menu: Sales->Events->Event tab 

Action: EVENT 

Overview 

The Event tab allows for the editing of the primary event information, like contact information, 
event type, location, special pricing …etc. Each event will have some number of members, 
which will be entered on the Event-> Members tab. 

The prompts on the event tab change slightly depending on the type of event being entered, i.e. 
wedding type, prom type or social type. Additional type may be defined in the Housekeeping-> 
General Set Up -> Event Types maintenance form. 

Wedding Event Hint 

When creating a new wedding event and the user enters either the bride's and/or groom's 
last name or both.  They  are automatically added as event members with the their 
respective roles & customer cards created.  This auto member creation only happens if no 
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members exist for the event. Once any member exists, the auto bride / groom insertion 
feature is disabled for that event. 

 

When an event is created, the contacts entered for WEDDING type events will automatically 
have customer cards created by WinPOS™ with the data entered on the this form and their 
names are entered onto the Members Tab as a time saving convenience. From the members 
tab, a user can access a member’s customer card information where additional detail can be 
entered about them. 

Members are really WinPOS™ customers. Each member will have a corresponding customer 
card in WinPOS™. 

Note: 

Modifications to customer data on this event tab will NOT update the customer detail on the 
customer card.  They are treated as separate entities. 

Fields 

Event type...Select Wedding, School (prom), or Social (Additional Event Types may be created 
when needed).  For Weddings, you can enter the bride and groom below. For School 
events, you can enter the school contact and customer who set up the event. For Social 
events, you enter the social event contact and the customer who set up the event. 

SA...The sales associate who created this event and that has primary responsibility for customer 
satisfaction.  SA1 on ticket  will default to this consultant for accumulating sales volume. 
Exception are BM SA will default to sales to members with Bridesmaid roles and Rental 
SA will default to any rentals made to any member of event. 

BM SA... The sales associate who is responsible for the bridesmaid members.  Insuring orders 
are entered properly and POs are placed in time for the event. Also this person will 
default for SA1 on ticket for sales credit.  

Event name...A descriptive name for the event. Make sure that you use a good name for the 
event, since this it what appears on reports, PO’s etc. For weddings, we recommend 
using the brides last name/grooms last name. For a school or social event, the name of 
the event plus the year of the event. For NON-WEDDING type events create event 
names that are the same year to year EXCEPT they end in the year of the event.   For 
example:  for a 2007 prom enter North Central Prom 2007, in in 2008 create the event 
8North Central Prom 2008. 

This field can be skipped for WEDDING type events and WinPOS® will auto-create a event 
name using the last name of the bride and groom once they are entered and the data saved. 
 By default the automatic event name will be bride's last name/groom's last name.   

When TPOS© or TPS© optional modules are activated the default automatic event name 
will be Groom's last name/Bride's last name unless a system setting is modified. A system 
setting controls whether the Groom's last name or the Bride's Last name goes first in the 
Event name.  Housekeeping->General Setup->System Store Setup->Rental Tab - 'Put bride 
first on Event/Prospect' controls the sequence.  

Event date/time...The date and time the event occurs. The date is required, the time is not. 
 Event dates may have security set via the EVENTDATE action, whereby a user would 
have to have security access to change it. 

Register sales?...If checked, WinPOS® will track all sales to this event. As you sell items to 
customers for this event, WinPOS® will ask if you want to register the item. Then, if you 
attempt to sell the same item to two members of this event you will receive a warning at 
sale time. This is used with proms and social events to insure that two members don’t 
wear the same item. A button will appear on the Members tab, “Show Reg. Sales” which 



Events 

217 

will show you all the items sold to members of this event. The same button also appears 
on the Ticket form. 

Pickup date...This field is used in the optional WinTPOS© optional module.  This date will 
become the default date that all rental orders will be PICKED UP for members of this 
event.  The operator may change the PICKUP date for specific members if needed when 
those rental orders are created. 

Return date...This field is used in the optional WinTPOS© optional module.  This date will 
become the default date that all rental orders will be RETURNED for members of this 
event.  The operator may change the RETURN date for specific members if needed 
when those rental orders are created. 

Rental SA...This field identifies the consultant that register the event for rentals.  New rental 
orders created for this event can automatically default to the SA code entered here based 
on the System - Rental Tab 'Leave SA blank on new rental created from event" setting. 
 SA codes on Rental Orders or sales Tickets are used for accumulating rental and sales 
volume. 

Rental Registration Date...This is the date that the first rental member was register as part of 
this event.  It is used by the Used by Detailed Rental Event List and Future Rental Orders 
report for determining rental statistics. 

 

View Files button... This function displays a list of files that have been attached to the event. 
 Double click the file and Windows will attempt to open it for viewing. 

Add Files button... WinPOS allows any file type to be attached to the event and then viewed by 
the View Files button.  This is handy when important emails are created/received, 
agreements, photos ..etc are communicated and a easily accessible record should be 
maintained.  Click this ADD FILE button and select the file thru the Windows Exploer. 

 

Manager reviewed?... This field is used in the optional WinTPOS© optional module.   Checked 
indicates that a manager has reviewed the details of the rental event registration for 
errors.   WinTPOS©  offers a report that may be used to see Events NOT reviewed. 
 Reports-> Cist/Event/Pros Reports-> Rental Events. 

Catalog code/Pictured As...This field is used in the optional WinTPOS© rental module.  This is 
a data entry time saving tool.  A Catalog Code may be assigned to the event and when 
the first member is added via the Events-> Rental tab->  Register Member Wizard, the 
member's rental styles will default to the catalog code styles.  The operator may change 
any style as needed prior to the order being created.  The default price will be the 
standard individual style pricing less any catalog code discount.   As additional members 
are added via the Register Members Wizard their default styles will be copied from the 
preceding member and then modified as needed.  The Catalog Code discount overrides 
any event markdown discount that may be entered in the Adjust Amount field described 
next. 

Adjust amount...This field is used in the optional WinTPOS© optional module. Many times a 
event may arranged for special pricing.  The DISCOUNT amount may be placed in this 
Adjust field.  For example say a $15 discount is to be given to all members.  This 
discount can be entered in this field, 15.00.  Now as each member is registered via the 
Register Member Wizard, the discount will be assigned to their future rental order. 

 

Adj. code...This field is used in the optional WinTPOS© optional module.  Assign the reason 
(Adjustment/Markdown Code) for the discount given to members of this event.  As each 
member is registered via the Register Member Wizard, the discount, adjust. code, will be 
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assigned to their future rental order and the code with description will automatically 
appear on the ticket linked to the order. 

Note: 

Adjustment amount and code are not retroactive.  Adjustment amount & code when 
assigned to the event will not be applied to members previously entered. 

Price Groups?... Checking this option instructs WinPOS to attempt to use rental price groups on 
the rental orders entered for this event.  When checked the system will attempt to locate 
any special promotions for the merchandise registered.  If found the discount is applied. 
 This feature only activates as members & their orders are registered via the Rental 
Registration function found on the event rental tab.  This option may be checked or un-
checked.  Orders created with order numbers are not affected by this option.  This option 
may be enabled/disabled for each order by visiting the order and checking/un-checking 
the option found on the Order's items tab. 

Bride contact information...You can optionally enter the brides contact information here, but it is 
not required that you do so. It’s better to enter the brides name on the members tab, and 
then use the Go to Customer button to go to their customer card, and enter their contact 
information there. 
 
As you are entering the contact information, enter the zip code before you enter the city 
and state. If WinPOS® has the zip code on file, it will fill in the city and state for you. As 
you enter zip codes, WinPOS® will learn which zip codes are associated with which cities 
and states. 

Groom contact information...You can optionally enter the grooms contact information here,  A 
member with the role Groom is auto created when Groom name is completed on event 
registration during creation (during the ADD).  If the event is added, but the groom info is 
not completed, then a groom member cannot be created.  To create a Groom member 
just go to the members tab and add a new member with the role of groom. 
 
Note 

As you are entering the contact information, enter the zip code before you enter the city and 
state. If WinPOS® has the zip code on file, it will fill in the city and state for you. As you enter 
zip codes, WinPOS® will learn which zip codes are associated with which cities and states. 

Buttons 

Notes button...A place to make notes about this event. 

Rental Styles...Rental style information may be entered on an event  for default use by each 
member. Each member may also store Rental Style information, different than the event 
default styles.  These rental styles can then be inserted into the special instructions for a 
special order for a sale item placed on the member's sales ticket.  This style information 
will subsequentially be placed on a purchase order.    This facilitates basic rental order 
processing using the base WinBPS© functions & does not require WinTPS© or 
WinTPOS© optional modules.  

Event Form - Members Tab 

Switchboard: Main->View/Change Event->Members tab 

Menu: Sales->Events->Members tab 

Action: EVENT 

Overview 
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The Members tab shows you all the members (customers) of the event. Members may be 
assigned roles like, bride, bridesmaids, groom, etc.. Available Roles may be modified in the 
Housekeeping-> General Set-up-> Roles maintenance form. 

The bride & groom entered onto the event tab for wedding events will automatically be created 
as members of the event.  The operator will be able to access their customer card and other 
customer functions once the event is SAVED by clicking the Save button found on the bottom of 
the form. 

Member information is actually being accumulated from two modules of WinPOS™. The 
information is retrieved from the Customer Card form & Sales Tickets form. WinPOS™ pulls this 
iformation and displays this in an form as a convenience to the user.  

For example, when you add members to the Members list on this tab, WinPOS® will 
automatically create the Customer card for each one. WinPOS® stores their name, 
measurements, etc. on the Customer card, not on the Event card. This is an important point. 
Information changed on the members tab is actually modifying information on that member’s 
customer card. A user can access the member’s customer card to enter more information about 
a new member, like address, email …etc. 

The Event card contains the details of the wedding itself. Customer cards contain the contact 
information for members. Tickets contain the sales and payments for customers. 

Members are sorted in chronological order for Wedding & Wedding Type events.  For all other 
events they are sorted by customer LAST name. 

Grid 

Members of the group...This list shows you all the members of the event. You should add all the 
members to the event even if you don’t have all their contact information yet. For 
example, assume the bride knows she is going to have 5 attendants, but she only knows 
the names of two of them. You should enter the names of the two she knows, and enter 
TBA for the last names of the other 3. This way, you can tell on PO reports, event card, 
etc. that there are really 5 attendants, even though you only know of 2 so far. 

Fields 

   

To add more members, simply locate the first empty slot and enter the member information. 

• Role: Select the role from the drop-down list. This role prints on the PO reports, etc. 

• First name, MI, Last name: You must enter at least the last name of the member for 
the member to be saved with the event. If you don’t enter the last name, WinPOS® 
will not add the member to the event.  Once saved double clicking a members last 
name will display their sales ticket when one exists. 

• Bal due: Display only. The members total balance due for this event. This is total 
balance due for all the tickets for this event. Note that a member can have tickets for 
other events, and tickets that are not associated with any event. Only tickets for this 
specific event are shown in this total. You can tell which event a ticket is associated 
with by looking at the Event field at the top of the Ticket form. This field is 
maintained by WinPOS® automatically. 

• Spending: Display only. The members total spending for this event. See the Bal due 
field for an explanation of which tickets are included in this balance. This field is 
maintained by WinPOS® automatically. 

Event totals...Display only. Total balance due and spending for this member. 

SA...The sales associate who created this event. 

Event name...A descriptive name for the event. Make sure that you use a good name for the 
event, since this it what appears on reports, PO’s etc. For weddings, we recommend 
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using the brides last name/grooms last name. For a school or social event, the name of 
the event. 

Event date/time...The date and time the event occurs. The date is required, the time is not. 

BM expected...The total number of bridesmaids expected.  This is not required.  This number is 
displayed on the BM Followup form so the bridesmaid consultant can tell if all the 
bridesmaids have registered. This number is also printed on the un-issued PO report so 
the person issuing PO's can tell if everyone has been registered before issuing the PO. 

Home phone...This is the home phone number for the member currently selected in the 
Members list. This phone number is stored on the customer card. If you change it here, 
the change is carried through to the customer card. It is not carried back to the Event tab 
of the Event form. 

Measured by...The sales associate who measured the customer. 

Measurements...The customers measurements, stored on the Customer card. 

Notes...Notes for this customer, stored on the Customer card. These notes do not print on the 
PO or Receipt. 

Email... The customers email address, stored on the Customer card. 

Cust balance for all tickets...Display only. The members total balance due. This is total balance 
due for all the tickets in WinPOS®, regardless if they are for this event or not. Note that a 
member can have tickets for other events, and tickets that are not associated with any 
event.  

Cust spending for all tickets...Display only. The members total spending. This is total spending 
for all the tickets in WinPOS®, regardless if they are for this event or not. Note that a 
member can have tickets for other events, and tickets that are not associated with any 
event.  

Last transaction...Display only. The date this member last made a payment or purchased 
something on a sales ticket. 

 

Select customer/member task: 

Go to Customer...This button will display the Customer card for the selected member. This is 
used to view/edit additional customer details. 

Go to Ticket...This button will display the Ticket for the selected customer. If there is more than 
one ticket, you will see a list of tickets for the customer and you can select one you want 
to view. It is recommended to add new sales to an existing ticket for the event, versus 
creating a new ticket for each new sale. This is easy & FAST method to see all the 
transactions for that member/customer for that event. 

New Ticket...This button will take you to the Ticket form, to create a brand new ticket for this 
customer. This new Ticket will be linked to this event. 
 
If the BM style field is filled in on the Extra tab, the style will be automatically added to 
any new ticket created for a bridesmaid.  A sale transaction is automatically added to the 
ticket, using the BM style and color specified.  If the Price entered on the event does not 
match the retail selling price, and adjustment is added to the ticket as well to make the 
price match.  The sale status is automatically set to Order.  If a BM SA is set on the Event 
then that SA is used for the sales person for the sale.  If the BM SA is not set, it will 
prompt for the SA to use for the event. 

Add Existing Customer...This will let you select an existing Customer card and make that 
person a member of this event. You would use this if you know that the customer already 
has a customer card and you want to just add them to the event. It is suggested to add 
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existing customers to an event instead of creating a duplicate customer card. Customers 
can be members of different event concurrently and have multiple tickets/rental orders 
active for those events.  

Remove Selected Customer...This will remove the selected member from this event. This will 
not remove their customer card from WinPOS®, it will just remove the link from their 
customer card to this event. 

Go to Appointments…Displays the Appointments form, only showing appointments for the 
selected customer on the Member tab. On the Appointments form WinPOS® will indicate 
the the list is being limited to appointments for this customer by showing “Limit to 
customer” in the Limit criteria box. Optional software module.   

Go to Fittings…Displays the Fittings form, only showing fittings for the selected customer on the 
Member tab. Optional software module. 

Send Email…Prompts for an HTML email to send to the selected member. 

New To-Do…Creates a new to-do, linked to the selected member.. 

Customer Rental Styles...Copies the rental styles entered on the Event tab under Rental Styles 
to the selected member.  Customer rental styles are used for non Tuxedo Profit System 
customers to handle customer rentals. 

 

Buttons 

To-Dos for Event..Shows all the open to-dos for the members of this event. 

Event Notes...A place to make notes about this event. 

Show Event Reg. Sales... With some events, the store may wish to track the sale of 
merchandise to the event so a sales associate within the store may quickly see a list of 
registered sale items, styles & colors,  for the event.  This is desirable with Prom Events 
and other socials.  This button will quickly display a list of register sales to this event. 
 Sales may be setup to be automatically registered when sold via the Inventory Category 
form and/or a user may manually register a sales when it is being made on a event 
 member's ticket by checking the "Sale Registered?" checkbox.  When sales are marked 
registered on the ticket, the WinPOS ticket will automatically alert the operator when an 
item of the same style and color are being sold to the event. 

Event Payments...This function will display the Payments form that will permit multiple tickets to 
be paid on with the entry of one (1) payment.  WinPOS© will pre-select tickets with 
balances assigned to this event for the members of this event. 

Called...Creates a completed todo for the selected member indicating that they were just called. 
 Used to quickly create a todo rather than manually creating one. 

Emailed....Creates a completed todo for the selected member indicating that they were just 
emailed.  

SMS sent....Creates a completed todo for the selected member indicating that they were just sent 
an SMS message.  

 

Event Form - Rentals Tab 

Switchboard: Main->View/Change Event->Rentals tab 
Menu: xxx  

Action: xxx  

This tab is only available with the optional WinTPOS™ Rental Point of Sale software. 
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The Rentals tab displays all the members of the event that have been added for rental via the 
rental Register Members button, or New Single Order button, including their rental order details. 
To do this, it pulls together information from a variety of places in WinPOS® (Customer card, 
Tickets, Rental Order) and shows it in one place. The information is actually stored in a variety 
of places. 

If a member was first registered via the Event Wizard and now has a rental order, WinTPS will 
display the styles from their actual rental order, versus the styles that were used when they 
were registered on the Event Wizard. This is what most shops would want. However, WinTPS 
can be configured to display the styles that were used on the Event Wizard instead by checking 
the “Show Event Wizard styles on Rental tab of Event even if order present?” option, located on 
the Rental tab of the System/Store Setup form. This would only be done if the Event Wizard 
contained the actual styles rented, and the rental order itself did not. 

The Event card contains the details of the wedding itself. Customer cards contain the contact 
information for members. Tickets contain the sales and payments for customers. Rental Orders 
contain the details of a rental transactions. 

Grid...This list shows you all the members of this event that have rental orders.  For the selected 
member the row contains the following information: 

• Role: This member’s role in the event. 

• Name: Customer name. 

• Order #: The rental order number. This number is auto-generated by WinPOS® and 
cannot be changed.  A blank number indicates that an rental order does not exist for 
the member within this event. 

• Status: The current status of the rental order. See Rental Process Overview for 
more details. This field is maintained by WinPOS®. 

• Deposit?: Follows the deposit rules set in the System Setup-> Rental tab.  YES will 
appear in the cell when the user has met/paid the minimum deposit amount. 
 Otherwise a NO will appear.  IMPORTANT: With the optional WinTPS production 
software, Picking Tickets will not print for orders that do not meet their minimum 
deposit.  This setting may be OVERWRITTEN on the Order Form-> Items tab via the 
No sec dep/payment req? checkbox setting.  Checked, the system will bypass 
the deposit settings and print the Picking Ticket normally. 

• Balance due:  Balance due on the rental order's ticket. 

• Pickup at: The store number and name where this rental order is to be picked up. 

• Rental styles: The next set of column headings will depend on your actual item 
types. These columns will contain the style codes for this rental order. 

• List price: The total price for the rental order, prior to any adjustments given on the 
Ticket form. 

• Special price: The net price for the rental order, after any adjustments given on the 
Ticket form. 

• Damage waiver: The price charged for the damage waiver on the rental order. 

• Total price: The special price plus the damage waiver. 

Buttons 

Pickup Order button...Go to the rental order Pickup form.  WinPOS can either pickup all orders 
ready for pickup, or only the selected order. This is controlled via the Pick up all orders 
using Pickup from Event? option on the Rental tab of System/Store Setup.  This is used 
when the customer comes in to pickup up their rental order. It is important to perform this 
step so WinPOS® can accurately report on rental order statues. 
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Return Order button...Changes the selected rental order status to Returned. This is used when 
the customer comes in and returns their rental order. It is important to perform this step 
so WinPOS® can accurately report on rental order statues including overdue rental 
orders. 

Go to Customer button...This button will display the Customer card for the selected member. 
This is used to view all the customer details, and make changes, such as a phone 
number change. 

Go to Order button...This button will display the Rental Order for the selected member. This is 
used to view all the details of the rental order, and make changes to it. It is only enabled if 
the select member has a rental order. 

Go to Ticket button...Displays the Ticket for the highlighted rental order. The Rental Order 
contains the details of the rental, and the Ticket contains the financial charges for the 
order, and any payments taken, adjustments, sales of other items, etc. You would use 
this if you wanted to check on the status of payments, or to sell the customer additional 
items. It is only enabled if the selected member has a ticket. 

Create Order button…This button will create a rental order and ticket for the selected member, 
using the styles displayed in the grid. The button is only enabled if the member does not 
have a rental order. After the order is created, the user it taken to either the ticket or 
rental order, depending on the setting “Go to Rental when create order from Event 
Wizard?” which is located on the Rental tab of the System/Store setup.  

Optionally, the system can ask for a ticket number and rental order price, depending on the 
setting “User must enter rental order number? AND User must enter rental price when using 
wizard?'  which are located on the Rental tab of the System/Store setup. 

Remove Customer button…Removes the selected member from the grid. This can only be 
used if the rental order has not yet been created. This would be used if all potential 
members were entered during the creation of the event record, and later the list was 
pared down. 

Register members button...Displays the Register members wizard form for this event. Use this 
powerful form to quickly pre-register event members. This form works well for events 
where the members are known in advanced, liked WEDDINGS. Members added within 
this form are automatically provided a rental order, sales ticket, customer card and added 
to the event’s member tab once the customer enter's the store and the store's sales 
associate clicks the Create Order button on this form for this customer. Review the 
Register Members Wizard topic for more information.  This function is typically used with 
the registration of Wedding Parties or any event where customer will be pre-assigned 
styles prior to them actually placing the order. 

New Event Order button... Adds a new rental member to this event.  Allows for a new customer 
to be created or an existing customer to be added to the event. When the member being 
added is a New customer, the New Event Order form is displayed, which contains the 
minimum data required for the customer, so the store's sales associate may quickly enter 
the customer's contact information and sizes.  Once completed, this information is stored 
onto the customer's customer card, so it may be later recalled for editing & additions. 

The New Event Order form contains a size section.  This section will display the first ten (10) 
rental item types defined within the system and provide a SIZE (first field) and size 
REFERENCE (second field) for each item type.  As a new rental order is created, the system 
will automatically insert the customer's sizes onto the order as each style of an item type 
found here, is added (if sizes are present on this form).  If sizes ARE NOT present in this 
form the WinTPOS system will attempt to locate a previous rental order for this customer.  If 
an older order is found the system will default the sizes from that order as the new order is 
created.  If the customer's order sizes are empty on this form or different than the sizes 
entered onto a new order, WinTPOS will prompt the user and if approved by the user update 
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the size with the new size entered onto the order.   When finished with this form click Create 
Order button to display the order entry forms. 

This feature is used instead of the Register Members button to add a "ad-hoc" member (or 
choose an existing customer in the system) to the event, like a prom or social member, and 
to create a new rental order for the member.  The event date and other information will 
default onto the order. 

 

Event Form - Spec Orders/Pickup Tab 

Switchboard: Main->View/Change Event->Spec Orders/Pickup tab 

Menu: Sales->Event->Spec Orders/Pickup tab 

Action: EVENT 

 

The Spec Orders/Pickup Tab is used to review the items On Order and in Pickup Inventory for 
ALL members of the selected event. This tab is disabled when entering a new event.  A shop 
could require a user to have appropriate security group level access for this tab. 

Order Grid 

On Order Grid...Lists all the items that have been special ordered for this event. Only items that 
were sold on tickets for this event will appear here. If you sold an item on a ticket that 
was not linked to this event the item will not appear here. If you accidentally sold an item 
on a ticket that was not linked to this event, you can retroactively assign that ticket to the 
event. See How do I assign a ticket to an event?  
 
Any special ordered item, regardless of event, will always appear on the Spec 
Orders/Pickup Tab on the Customer card.  The grid will scroll to the right to display more 
information concerning the selected item. 

The PO Confirm shipping date incorporates the same date padding rules as the customer 
MyInfo web pages so store personnel will provide the same info to customers when they call 
as if they were viewing the dates online in MyInfo. 

Buttons 

Go to PO Item...Select an item in the On Order list and click this button to go to the Purchase 
Order Item Maintenance form to view PO item. 

Go to PO...Select an item in the On Order list and click this button to go to the Purchase Order 
Maintenance form for the purchase order this item appears on. 

Got to Ticket... Will display the sales ticket the selected items was sold on. 

Note: 

The system will Display the code (RCR) in the customer name field of an item when the item 
has an RCR entry within the  RCR form created and it does not contain an Return Date 
(must be out).  This should indicate to the user that the item is NOT available for customer 
pickup. 

 

Pickup Grid 

Pickup Inventory list...Lists all the items currently in pickup inventory for this event. An item 
must have been received via the PO Maintenance form to appear here. 

Buttons 
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Mark all Notified...Puts today’s date in the Notified field for all items in pickup inventory for this 
event. 

Go to Pickup Inventory...Select an item in the Pickup Inventory list and click on this button to go 
to the Pickup Inventory form to view this item. 

Go to Ticket... Will display the sales ticket the selected items was sold on. 

 

Note: 

The system will Display the code (RCR) in the customer name field of an item when the item 
has an RCR entry within the  RCR form created and it does not contain an Return Date ( a 
empty return date indicates that the item is out of the store).  This should indicate to the user 
that the item is NOT available for customer pickup. 

Register Members Wizard 

Switchboard: Main->View/Change Event->Rentals tab->Register Members button  

Menu: Sales->Event->Rentals tab->Register Members button  

Action: EVTCREAT 

 

This tab is only available if you have the optional WinTPOS© software module and is utilized for 
quickly entering rental members of an event.. 

Overview 

This form is used to quickly pre-register (like weddings where styles are assigned to specific 
member before that actually place the order) new members renting items for the event. It uses 
the information entered on the Events-> Event Tab for default use date, customer pick-up 
location, styles and pricing. The customer’s name, styles, discount, pick-up location, not our 
measurement (NOM) indication, and damage waiver acceptance can be entered for each 
member.  

Modifications to any information on the form are allowed until the rental order is created, 
indicated by the presence of an ‘order number’ within the form. Only the customer name may be 
modified once the order is created.   

Orders for these pre-registrations are created automatically by WinTPOS when the Create 
Order button is clicked from the rental tab. 

After Orders are created, the information on the order may be edited from the rental Order Entry 
forms. 

The rental order is created using the prices in effect when the order details were entered into 
the Register Members form. If the rental prices in the inventory have increased since then, an 
adjustment will be added to the ticket so the net price of the rental order will be the same as the 
price quoted when the event was registered. If the rental prices have gone down the then the 
lower price based on the current rental prices is used instead. 

WinTPOS® automatically creates the Customer Card, Rental Order and Sales Ticket for the 
highlighted member when you click the Create Order button, when it does not exist. 

Click the Go To Order button to make any modifications to the order’s details. 

This wizard is the fastest way to pre-register an event member 

Operation 

To add new members select a blank line within the ‘Members of the group’ grid and enter the 
known details. Multiple members may be added at a time. 
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Buttons 

Next Role button...Moves the cursor down to the next line, and over to the First name field. This 
is a time saver to be used during data entry. 

Save button…Saves all edits made to the form. 

Cancel button… Discards any edits made to the form. 

Grid 

Members of the group grid...This list shows you all the members of this event that have rental 
orders. 

• Role: The member’s role in the event.  Each member must a role assigned to save 
the data. 

• First, MI, Last: You enter the first and last names for a member or their customer 
card and rental order will not be created. 

• Alt Store: The store where this order will be returned, if different from the Pickup at 
store. 

• NOM: Not our measurements. Check this is the measurements were taken 
somewhere else. This is for reference only. 

• Rental styles: The next set of column headings will be the Item Type descriptions in 
the numerical ‘line number’ sequence defined within the Item Type maintenance 
form. These columns will contain style codes for this rental order. Press F2 within a 
cell to display a lookup list of valid style codes for the item type in the heading, or 
click on File-> Lookup F2 on the Title Bar menu.  

• Free: Check this if this is a free rental order. The Rental Order form will still show a 
rental price, but the Ticket form for that order will show a zero price.  This checkbox 
may be automatically checked/enabled by WinTPOS.  This setting obeys the 
System Setup->Rental Tab->  Every x formalwear order is free setting.  It will 
automatically check this box as the number of members entered matches the 
required numbers.  The “no charge for order” option will be checked on the rental 
order when created and shows in the Free column on the Register Wedding form. 
 The Reports-> Customer/Event/Prospect Reports-> Rental Event report provides a 
tools to audit the FREE rental registrations. 

• work when using the Register Wedding (or Register Members) form from the Event 
form to enter multiple event  

• members. The “no charge for order” option will be checked on the rental order, 
which shows in the Free column on  

• the Register Wedding form. 

• Disc 1 & 2: Disc is short for discount which is a markdown amount. These two fields 
allow you to give up to two markdown amounts to this rental order. The discount will 
be applied to the rental price and carried through the Ticket for this order.  

• Code 1 & 2: A markdown code indicating why you gave this discount. 

• Price: The total rental price for this order. This value is computed automatically by 
WinPOS®. 

• Status: The current status of the rental order. See Rental Process Overview for 
more details. This field is maintained by WinPOS®. 

• Dmg Wavr?: Check this if a damage waiver should be charged. If a rental order has 
already been created, this indicates if the damage waiver was charged. You cannot 
change this after the rental order has been created.  In case of error, a operator may 
visit the ticket that contains the charge for the order and manually add/cancel a 
Damage Waiver charge using the Sales or Adjustment transaction types. 
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Event Import 

Switchboard: Main->Housekeeping->System Maintenance->Import Wedding Events  

Menu: Setup->Import Data->Import Events  

Action: CUSTIMPORT 

 

WinPOS offers a tool to quickly add wedding events in bulk.  This software tool is ideal for new 
stores to quickly get existing wedding loaded so they may begin conducting business. 

Please review the Import Wedding Events topic for more instructions on how to use. 

Reports 

Event PO Summary 

Printed from the Event form PRINT button.   

 

PO Summary...List each member of the event and list items sold to each with a PO recap (if 
ordered). Includes special order and pickup items (held for customer pickup)  for each member 
of the event.   

 

Prints Event Card document terms at the end of the report. 

 

Event Summary Report 

Printed from the Event form PRINT button.   

 

Event Summary...A detailed recap of the  members of the event & includes spending,  balance 
phone # & individual notes. 

 

Prints Event Card document terms at the end of the report. 

 

Event Card Report 

Printed from the Event form PRINT button.   

 

Event Card.. For use with the optional WinTPOS© software module.  It recaps all rental 
member details including registered styles,  ideal for a event registration review where a 
customer could sign. 

Prints Event Card document terms at the end of the report. 

 

 

Event Rental Performance 

Printed from the Event form PRINT button.   
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For use with the optional WinTPOS© software module.  Designed to be ran once an event is 
completed, it performs an analysis of the rental order activity for the selected event.  The report 
is comprised of three sections.  

Note 

Units and sales volume within the report are totalled for the store found on the order's pickup 
location.  In multi-store installations, the store that created the event and registered the 
members may not be the same store where the order is picked up.  The potential unit and 
volume for registered only member, i.e. those without an order, are total for the store that 
created/registered the event. 

 

First Section 

It compares the pervious year's rental volume to the event's current event date, showing 
number of orders (unit volume), revenue for those orders and average revenue per order) 
 group by pickup location 

The previous year's comparison is accomplished via a name match-up.  Users MUST create 
event names that are the same EXCEPT they end in the year of the event.   For example: 
 North Central Prom 2008 would compare to North Central Prom 2007.  North Central Prom 
2008 COULD NOT compare to North Central 2007 nor could North Central Prom 2008 compare 
to North Central Prom. 

This section contains several data totals.  Their definitions are: 

Order volume = Sales volume for all rental orders (created orders & registered orders (potential 
orders)).  For a order's sale to be counted, orders may not be marked as NO SHOW, Cancelled, 
exchanged and must contain at least one rental style. 

Units # = total rental orders (created orders & registered orders (potential orders)).  To be 
counted orders may not be marked as NO SHOW, Cancelled, exchanged and must contain at 
least one rental style. 

Order Registrations  Members that do NOT have a real order are counted for store that created 
the event. Orders for members that have been created total for the order pickup location. 

 

Second Section 

Volume by style within selected item type.  Provides an count by each style of the selected item 
type found on orders placed  within the event being analyzed and include's it's percentage to 
event total for that selected type. 

 

Third Section 

This is a Markdown analysis.  It totals the markdowns grouped for each markdown amount with 
it's percentage of total.  

 

Criteria 

Item Types to include... the report may include up to six rental inventory item types.  Select the 
types to include. 
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Tickets & Payments 

Payments 

Payments Overview 

Payments can be made for a single ticket, or apply a single payment to multiple tickets, or even 
take multiple payments and apply them to multiple tickets. 

WinPOS supports multiple stores via the optional Multiple Store software option. Multi-Store 
allows support for a payment being accepted in a store for a sale created in a remote store 
location.  See this topic's Multi-Sore payment section for more information. 

WinPOS© will apply the payment amount to the sales transactions on the selected ticket 
automatically.  When the payment is a partial payment (a term called Deposit by many), the 
system will start applying the payment to the oldest unpaid sales transaction first and move 
forward to following unpaid sale transactions until the payment amount is fully used.  

Payment tender options are set in Housekeeping-> Accounting Setup-> Accounting Setup. 
 

Single payment for a Single ticket: 

1. Go to the ticket. 

2. Click the Payment/Rtn. Check button. The Enter payments form displays. 

3. Click the tender type for the payment. 

4. Enter the amount paid, or use the default. If the tender type is cash, you can also 
enter the amount tendered and WinPOS® will compute the change due. 

5. Enter the clerks SA ID and click Save Payment. 

6. If it is a credit card payment and you have the Credit Card Integration, you will be 
prompted to process the credit card. 

7. If you have other tender types, repeat steps 3-5. 

8. Click Next to save the payment. A receipt will print. 

Note: 

It is possible for a customer to have a store credit.  This occurs when a customer has 
overpaid on a ticket.  Scenarios exists where a relative provided a payment for a customer 
who has not yet purchased an item (sort of like a gift credit) or where a customer had paid 
for their item(s) then the item(s) were cancelled from the ticket/  The resulting credit balance 
was not refunded to the customer. 

Any store credit available to a customer will show as payment tender option on the payment 
form when that customer has that ticket that the shop is taking a payment for.  The credit 
 may be applied to a ticket balance as a payment.  A Store credit may be given back to the 
customer as a REFUND.  Display the customer ticket and choose the REFUND transaction. 

When performing a REFUND the system will display the payment form asking the tender 
type of the customer REFUND  DO NOT USE THE STORE CREDIT tender type as the form 
of payment going back to the customer. 

 

 Multiple ticket Payment: 

1. Select Maine Menu-> Payments  This will display the Select tickets to pay form 

2. Enter either the customer number or event number. You can search for either by 
using the binoculars button. WinPOS® displays all the tickets for that 
customer/event that have a balance. Once a customer or event is chosen, all the 
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tickets associated to the customer/event  with a balance will be selected for 
payment. 

3. If you don’t want to make a payment on a ticket, select it in the list and click the 
Remove Ticket from List button. 

4. You can select more tickets by repeating step 2. 

5. Enter the clerks SA ID and click the Next button. 

6. The Enter payments form displays. 

7. Click the tender type for the payment. 

8. Enter the amount paid, or use the default. If the tender type is cash, you can also 
enter the amount tendered and WinPOS® will compute the change due. 

9. If it is a credit card payment and you have the Credit Card Integration, you will be 
prompted to process the credit card.  Click Save Payment for  the tendered 
payment. 

10. If you have other tender types, repeat steps 7-9. 

11. Once you have entered all the payments, click Next. 

12. The Apply payments form displays. 

13. Select a ticket from the list of tickets. 

14. Enter the amount you want to apply to that ticket. 

15. Click the Apply to Ticket button to apply that payment to that ticket. 

16. Repeat steps 14-15 until all the payment is applied. 

17. Click Done to finish the process. 

WinPOS will prompt for a receipt to be printed.  The receipt will contain a recap of each of the 
tickets the payment was applied to. 

 

Multi-Sore payment 

 

WinPOS refers to remote stores taking payments for another store's sales as a "Remote 
Payment". 

Allowing a store to accept a payment for another store's sale does not require any special set-
up. A WinPOS account must be assigned to the Remote Payment tender type within 
Housekeeping-> Account setup-> Accounting Setup-> WinPOS Accounts tab.  The WinPOS 
software system is capable of automatically handling remote payments.  The user sees no 
difference in the process.  The Revenue Report reporting is affected with the presence of a new 
Remote Payment tender type. 

Remote payments show under Tender section of the Revenue Report.  Say a cash $100 remote 
payment was taken at a remote store, Store2 for a ticket with a sale created at Store1. 

 

Store 1 Store 2 

Receipts Receipts 

  Remote payment: 
  $100 

  Cash:  $100 

   Remote Payments: 
 -$100 

  Receipts Total: 
    $100 

  Receipts total:  $0 

Revenue Revenue 
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  Sales:  $93 Sales:  $0 

Tax Tax 

  Tax Collected::  $7   Tax Collected:  $0 

  

 

Security Deposits may also be accepted on tickets created at a different store. A security 
deposit involves a payment and is very similar scenario as a standard payment.  However, in 
the case where the Security Deposit payment is forfeited and must be converted to revenue, the 
revenue and any adjustments are assigned to the store that originally created the ticket. 

Security Deposits 

The payment form behaves in a special way with the optional WinTPOS module installed and 
the Housekeeping-> General Setup-> System Setup Rental tab -> Minimum    _______     $ 
_______ set to security deposit and a dollar amount.  With these conditions, a payment on a 
rental order's ticket will check to see if the minimum security deposit has not been accepted.  If 
not, the system will prompt the user and ask if a portion of the payment being entered can be 
used for the security deposit.  If OK'd by the user, the system will re-apply a portion of the 
payment equal to the minimum security deposit and then any remainder will be applied as a 
partial payment.. 

 

   

Select Tickets to Pay Form 

Switchboard: Main->Payments  

Menu: Sales->Split Tender/Split Ticket Payments 

Action: SELETICK 
 

This is the Payment’s Wizard that allows payments to be applied to a single ticket or to multiple 
tickets.  It is only available from the main menu when the Payment menu option is chosen. 

The first step to select the ticket(s) that the customer is paying on. The tickets receiving 
payment should appear within this form’s Ticket List Grid. 

To locate tickets, a customer or event must be selected. Once selected WinPOS® will display 
all the tickets that have a balance due. If there are tickets you do not want to make a payment 
on, select the ticket in the list and click the Remove Ticket from List button. Once the list is 
displaying the tickets you want to pay, click Next. 

Customer...Enter the customer ID, or use the binoculars to search for the customer. All the 
tickets for this customer that have a balance will be displayed. 

Event...Enter the event ID, or use the binoculars to search for the customer. All the tickets for this 
event that have a balance will be displayed. 

Sales associate...The ID of the person entering the payments. 

Ticket List grid… Lists all the tickets with a balance associated to the customer or event 
entered. 

Remove ticket from list button...Deletes the highlighted ticket from the list. WinPOS® will apply 
payments to the tickets within the list.  

Next button…Takes the user to the payment/tendered form. 

Enter Payments Form 
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Switchboard: Ticket Form->Payments/Refund/Return Check button 

Menu: n/a 

Action: none 
 

The Payments form is where the payment amount and tender type of the payment is entered. 
Multiple tender types may be easily entered if needed. 

The standard payment tender types are: Cash, Customer Check, Gift Certificate/Card, Credit 
Card (Visa,MasterCard, Amex, Discover, Optima, Other Credit Card), Debit Card, Electronic 
Checks, Store Credits and store check (for refunds). The company may define two additional 
tender types in the GL Account Setup - GL Accounts tab. 

Hint: 

See Credit Card Processing Integration to learn how credit card integration provides a single 
step to taking a credit card or debit card payment.  

 

Tender types...The different tender types are shown at the top of the form, Cash, Check, Visa, 
AmEx ..etc. Most are self-explanatory.  These payment types are turned on/off in the Main-> 
Housekeeping-> Accounting Setup-> Account Setup-> Setup Tab. 

• Other credit cards: This can be used for any tender type not defined elsewhere. 

• Gift certificate: When a customer redeems a gift certificate. 

• Returned checks: When a check is returned from the bank, you take a negative 
payment for the amount of the check using this tender type. The customers ticket 
will then show the amount due, and the amount will show on your revenue report 
under returned checks. 

• Store check:  In processing a refund it may be necessary to provide a store check as 
the refund tender type.  This tender option is available when a refund is being 
processed. 

• Sec Dep.: This button will only appear if the customer has a security deposit. You 
would use this tender type if they are using their security deposit as a payment. 

• Store Cred: A situation may arise where the customer has overpaid his purchases or 
a item purchased was returned. In this case the shop owes the customer some 
amount of money.  This credit may be refunded or used on future purchases. The 
amount due is converted into a store credit for the customer.  Once a customer has 
a credit it may be used for payment on future purchases or refunded.  The Store 
Credit tender option will display when the customer has a credit balance. This button 
will only appear if the customer has a store credit OR  if the customer is an 
WEDDING event member and another member of the same event has a credit.  The 
system will first use the selected member's credit over providing the option of using 
another member's credit. 

Other Wedding Member's Store Credit 

You would use this tender type when the store credit of another customer within the same 
WEDDING event (event type must be WEDDING) should be used for payment. 

When a another member of the same event this customer is a member of (if they are a event 
member) has a store credit, it may be automatically transferred to this member and used for 
a payment on their event sales ticket.  When a payment is being taken for an event member 
the system will quickly scan the other member's looking for store credits.   

The system will identify the member with the largest store credit and provide a Store Credit 
tender button for that amount.  Hovering the mouse arrow over the button will display the 
store credit's owner. When used for payment the system will transfer the amount of the 
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payment (up to the full amount of the Store Credit) to this member applying it as payment. 
 The transfer of any store credit is logged for tracking and an event's transfer history may be 
reviewed from the Event's Event tab.  All Store Credit transfer activity may be reviewed from 
Reports-> Daily Management Reports-> Store Credit Transfers.  Hovering your mouse 
pointer over the Store Credit tender button will display the details of the credit. 

Store Credits may be manually transferred from one customer to another as well.  This is 
done from the Customer Card-> Details tab of the customer who is in possession of  a credit. 
 On this form choose the Transfer Store Credit function button. 

• Electronic Checks (E-Check)  are checks that are processed via an check reader 
and are validated/approved by a check guarantee service.  Once processed the 
check may be given back to the customer.  BBL does not currently support check 
readers, but once the check is approved outside of WinPOS the payment may be 
captured. 

 

Refund store credit button...This is used to refund a store credit. Click this button first, then 
select the tender type for the refund. Enter the amount of the refund in the Amount Paid 
field. Enter the clerk and press Save Payment and Next. The customers store credit will 
be decremented and a refund will appear on their ticket. 

Amount due...As you enter payments, this will show the updated balance due. This is calculated 
automatically by WinPOS®. 

Amount paid...Here is where you enter the amount of the payment. 

Amount applied...This is the amount of payment that will be applied to the ticket(s.) This is 
calculated automatically by WinPOS®. 

Tendered, Change due...If the customer is paying with cash you can enter the amount tendered 
here and WinPOS® will calculate the change due automatically. 

Reference...You can enter extra information about this payment here if you like. For checks, you 
enter the check number. For credit cards not processed through the WinPOS® Credit 
Card Integration, you can enter the approval number. For gift certificates, you can enter 
the certificate number. 

Clerk...Enter the SA ID of the person entering the payment. 

Save Payment button...This will add the payment to the list of payments at the bottom of the 
form. If this is the only payment, you can press Next to save the payment to the ticket. If 
there are more payments, you can press another tender type to enter another payment. 

If you have the Credit Card Processing integration and you are entering a credit card 
payment, you will be see the Credit Card form at this point. You can then swipe the credit 
card to enter the account number and expiration date, or manually enter the information.  

Delete Payment button...This will remove the selected payment from the list of payments. 

Total payments this session...The total of all the payments you have entered here. 

Total charge...The total due before you started entering payments. 

Next button...This will save the payment(s) to the ticket(s) and close the ticket form and print the 
receipt. 

Cancel button...This will discard all the payment(s) and take you back to the Ticket form.   
 

Step-by-step description of the payment process 

To enter a payment quickly: 

1. The Payments form is displayed. 
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2. Click the tender type at the top of the form. The tender type selected is displayed at 
the top of the form. 

3. The cursor moves to Amount paid. Enter the amount to be paid and press Enter. 

4. If you are making a cash payment, the cursor moves to Tendered. Enter the amount 
tendered and press Enter. WinPOS® displays the Change Due. 

5. The cursor moves to Clerk. Enter your SA ID, or use the binoculars to select one. 
Press Enter. 

6. The cursor moves to the Save Payment button. Press Enter to save the payment. 

7. The cursor moves to the Next button. Press Enter to complete the process.  

Apply Payments Form 

After you have selected the tickets and entered the payments, you have to tell WinPOS® how 
much to apply to each ticket. If you have only one ticket, WinPOS® applies the total of 
payments directly to it, and bypasses this step. If the total of payments matches the total 
balance due (regardless of how many tickets and payments) WinPOS automatically applies the 
payments and bypasses this step. 

Total paid today...This is the total of all payments that you are taking. 

Payments left to apply...This is the running balance of payments left to apply. As you apply 
payments to tickets this amount goes down.  The "Payment left to apply" box has a red 
background as long as there are payments left to apply to one of the tickets 

Total due on all tickets...This is the total balance due when you started this process. 

Balance due on all tickets...This is the running balance due. It goes down as you apply 
payments to tickets. 

Amount to apply to ticket...This is the amount you want to apply to the selected ticket. 

Apply to ticket button...Clicking this will apply the amount to the selected ticket. 

Ticket list...This is the list of tickets you are applying payments to. 
 

Here is a step-by-step description of the payment apply process. 

1. Click on a ticket you want to apply an amount. 

2. Enter the amount to apply to the ticket in the Amount to Apply field and click Apply to 
ticket. 

3. Continue until the field labeled Payments to Apply is zero. 

4. Click Done once the total paid has been applied to the tickets.  

5. A consolidated receipt will print automatically that shows all the tickets paid. 

Gift Cards/Certificates 

WinPOS® supports gift card/certificate services being offered. Gift certificates can increase 
sales and can become a convenient method of payment for a shop’s goods and services. 
Basically, a customer would purchase the Gift Card/Certificate for any amount and then redeem 
it by using it for payment. 

WinPOS® includes a inventory style code, accounting class, payment tender type and category 
called Giftcertificate. As Gift Certificates are sold they would show on the Revenue Report by 
increasing the Gift Certificate account (usually considered a liability by most accountants). As 
they are redeemed via the payment Gift Certificate tendor they are deducted from the 
Giftcertificate account of the Revenue Report. There are only two steps involved in using Gift 
Cards/Certificates: 
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1. Sale a Gift Card/Certificate to a customer. This involves creating a sales ticket using 
the Giftcertificate style code. WinPOS® enforces two rules upon sales tickets when a 
Giftcertificate is being issued. 1

st
, only one sales transaction is allowed, the 

Giftcertificate. 2
nd

, the ticket must be paid for in full. The balance must be zero before 
WinPOS® will allow it to be saved. 

2. Redeem the Gift Card/Certificate in the form of a payment. At some point in the future 
a customer will want to redeem a gift card/certificate that they own. A store would 
accept it in the form of a payment tendor type. The payment form contains the Gift 
Certificate tendor button that would be utilized. 

WinPOS® can track gift card/certificate balances by gift card/certificate ID code. See Gift Card 
Tracking and How do I use Gift Certificates for more information. 

Gift Card/Certificate Tracking 

WinPOS® offers the ability to track the balance of a gift card/certificate ID code. This capability 
will not allow an operator to enter a gift certificate payment that exceeds the available balance. 
A customer can continue using the same gift card/certificate until it’s balance is exhausted. 

Enabling this feature will prompt for a ID code when the gift card/certificate is issued on the 
sales ticket and when a gift card/certificate is used for payment. Credit card swipes may be 
used for the entering of ID codes from Gift Cards equipped with magnetic stripes (offered by 
BBL). 

The system provides the Gift Card Balances report that will list and total all balances by Gift 
Card ID code as an audit tool. 

In addition, inactive Gift Cards/Certificates can be retired irregardless of balance. Most 
companies have terms that state a card will be retired after two years of inactivity and any 
balance remaining will be lost. Gift Card/Certificate purging is accomplished via the Gift Card 
Purge function. 

 

Please see topic How do I use Gift Certificates for more information. 

Tickets & Sales 

New Sales 

When creating new sales, it is important to make sure that the sale is linked to the correct Event 
and Customer. The top right hand corner of the ticket displays the event and customer the ticket 
is assigned to.  The ticket's customer or event may be re-assigned by simply changing the 
customer or event fields on the ticket. 

Tickets may be created from the Main Menu-> Customer form; this form auto assigns the ticket 
to the customer, but not to any event.  A new ticket may be created from the Main Menu-> 
Event-> Members tab or from the Rental tab.  Tickets created from these two locations are auto 
assigned to the event and customer.  Tickets are indirectly created from the rental Order form, 
Main Menu- Orders (with optional WinTPOS software option).  New rental orders will create a 
ticket to contain the rental transactions and are auto assigned to the event (if any) and 
customer.  Finally new tickets are created from the Main Menu-> SALE function.  Quick Sale 
tickets are assigned to a generic customer called "Walk-In". 

Tickets linked to events will have all sales on the ticket accumulated to that event. This event 
link makes any of the ticket sale transactions of items on order or in pick-up inventory appear on 
the event's Special Order/Pickup tab and grouped properly on any Event report. 

The Sale button (located at Main Menu ->Sale) provides the capability to generate 1) a fast 
Quick Sale Ticket, whereby no customer demographic information is captured  2) Lookup an 
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existing Customer via the customer primary phone number to create a new ticket assigned to 
that customer or 3) Create a brand new Customer and Ticket.  

The Quick Sale option is typically used when the shop needs little, if any, information about a 
customer for a Ticket and does not have any requirement to maintain history about the specific 
customer, i.e. address, phone number, etc.  This option does not allow for items to be Special 
Ordered or for Partial Payments (deposits).  All tickets created via Quick Sale will be assigned 
to a system owned customer called WALK -IN.  This is an actual customer that may be looked 
up via the View/Change Customer option.  This customer should never be deleted from the 
system.  Also tickets may be recalled if necessary to review purchases. 

Use the Quick Sale button when you are selling an item directly from inventory. For example, 
items sold using the Sale button might include garters, shoes or other items that are not special 
ordered. These are items the customer takes with her when she leaves the shop, and that are 
paid for in full. Also, use the Sale button for Gift Certificates. 
 

To ring up a sale for an event 

1. Go to the Event form at Main->View/Change Event and locate the correct event. 

2. Click on the Members tab and select the correct customer in the Members list. 

3. If the customer already has a ticket for this event, under Select Customer/Member 
task section, the Go to Ticket will be available. Click the option to go to the ticket for 
this event. 
 
If the customer does not have a ticket, under Select Customer/Member task 
section, click the Create New Ticket option to create a new ticket for this event. 

4. When a ticket is displayed the customer and event the ticket is assigned to will be 
displayed in the top right corner.  The ticket may be re - assigned if ever needed. 

 

To ring up a quick sale 

1. Click on Main Menu-> Sale. 

2. Enter a phone number, the system will display a list of existing customers with that 
phone number 

3. The options of select an existing customer, create a new customer or choose Quick 
Sale will be available. 

4. A selection of Quick Sale will create a new ticket with the customer name of WALK-
IN. Each sale transaction will be marked TAKEN and the ticket balance must be $0 
before the ticket may be completed. 

 

To ring up a sale from the customer card. 

1. Bring up a Customer card or create a new card for a new customer, Main -> 
View/Change Customer 

2. On the Customer Tab double click an existing ticket to add a transaction or click the 
New Ticket button to create a new sales ticket to add sales transactions to.  The 
New Ticket function checks to see if this customer is in an event, and if so, 
WinPOS® will ask you if this sale is for one of those events. This is done as a safety 
precaution so that you have the option to ring this sale up as part of an event even 
though you didn’t ring it up via the Event form. 

 

Ticket Overview 
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Switchboard: Main->View/Change Event->Members Tab->Go To Ticket and Main-
>View/Change Customer->Customer Tab->Tickets List 

Menu: Sales->Event->Members Tab->Go to Ticket 

Action: TICKET 

 

Tickets can be created from four locations.  1) The Customer form, 2) The Event Form 3) The 
Quick Sale function of the Main Menu SALE button and from 4) a Rental Order via the optional 
WinTPOS© software module for rental sales.   

Tickets are virtual, meaning transactions may be added to a ticket once it is created the first 
time.  In other words, a Ticket may be created, a partial payment accepted (the ticket balance is 
NOT paid) and saved.  Some time later the ticket may be recalled and additional transactions 
added.  The power of WinPOS© keeps the accounting of this correct. 

The Ticket form contains the sales and payments for a customer. The sales ticket is the heart of 
the entire WinPOS® system. We have designed it to be as easy to use as possible, but also to 
contain the functionality required to handle the situations that arise during the business 
operation. You use the Ticket form to ring up new sales, whether they are special orders or 
simple purchases. You take payments and give refunds via the Ticket form. You can also take 
payments for multiple tickets simultaneously using the Payments form located at Main-
>Payments. You can make adjustments to sales prices and cancel sales from the Ticket form. If 
a customer comes in to pick up an item they have special ordered, you indicate to WinPOS® 
that the item has been taken via the Tickets form. The Ticket form may look complicated at first, 
but in reality you’ll only utilize a small portion of it 90% of time. The rest of the power of the 
Ticket is used in special circumstances, as outlined below. 

As with most forms in WinPOS®, you can make changes to a ticket on the Ticket form, and then 
decide later that you didn’t really want to make those changes and discard them. On this Ticket 
form, there are two levels to this.  

First, you can add new line items to a ticket (ring up a new sale, make an adjustment to it, etc.) 
If you’ve added multiple lines to a ticket, and have not clicked the Save/Done with Ticket button 
yet, you can instead press the Cancel Changes button and any new line items added to the 
ticket will be discarded. Once you press the Save/Done with Ticket button, the changes are 
saved for good. 

The second level is when you’re actually entering in a sale, adjustment, or cancellation. As 
you’re entering it in, most of the buttons on the Ticket form are disabled, except for Save Line 
Item and Cancel Changes. In this case, you press Save Line Item when you’re satisfied with the 
current line item. If you press Cancel Changes, changes to the current line item will be 
discarded. Changes to other line items will still be present though. Ultimately, you’ll press 
Cancel Changes or Save/Done with Ticket to confirm all your changes to the ticket. 

Don’t worry if this sounds complicated, WinPOS® enables and disables the buttons 
automatically, so it’s hard to press the wrong one. 
 

The customer’s sales ticket becomes the center point for many other files within the WinPOS® 
system. Often, a user can simply go to a customer’s ticket and see exactly the status of each 
item sold. See the following illustration for more insight. 

 

Information Flow Diagram  
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Ticket Header 

Switchboard: the top of the Ticket form, above the horizontal divider line 

Menu: n/a 

Action: none 

Overview 

The fields at the top of the Ticket form display the details of the highlighted item within the ticket 
grid. Selecting a transaction code will blank the detail and allow new information to be entered. 
The information will be saved to the ticket grid. 

Review the Ticket Details topic for more information. 

Field 

Ticket...This is the unique ticket number automatically assigned to this ticket by WinPOS®. The 
first part of the number is your store number (as set in Main->Housekeeping->General 
Setup->System/Store Setup->Setup Tab) followed by a sequence number. You cannot 
change this number. 

Customer...A ticket always belongs to one particular customer. You can change the customer for 
this ticket by pressing the binoculars and selecting another customer. You would only do 
this if the ticket was accidentally created for the wrong customer. 

Event...A ticket can belong to an event. This field shows the event date followed by the event 
name for this ticket. A ticket does not have to belong to an event. You can change the 
event for this ticket by pressing the binoculars and selecting another event. You would 
only do this if the ticket was accidentally created for the wrong event, or was created with 
no event, and it really belongs to one. 

Security deposit...Shows a security deposit if one has been placed on this ticket. A security 
deposit is different than a partial payment or down payment. A partial payment is 
payments towards a balance due. A security deposit is money held by the store to insure 
that customer brings something back, or actually places an order, etc. Security deposits 
are covered in more detail later. 
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Tax exempt ID...If this ticket is to be tax exempt, you can enter a tax exempt ID number here and 
all the items sold on this ticket will be tax exempt. If you enter the tax exempt ID after you 
have created the ticket, only items added after that will be tax exempt. 

 

Buttons 

Show Reg. Sales button...This function will display all sales transactions that are marked 
Registered for this event.  See Events Registration information within the Events 
Overview topic. 

Event Notes... Allows the user to view & edit the notes for the event. 

Show/Add Fittings...Allows a user to review or add a fitting into the optional Custom Fitting 
module.  When a sales transaction is selected and there are NO fitting records on file 
then the button will read ADD Fitting where when clicked will take a user to the Custom 
Fitting form with a new record created.  When Fittings DO exist it will read SHOW fittings 
where when clicked take the user to the Custom Fitting form and select the first fitting for 
this item.  Additional fittings may be added when needed. 

Camera... Will display inventory images of the selected sales transaction when they have been 
stored in inventory for the item. 

Color Chart... Will display inventory color chart of the selected sales transaction when an color 
chart has been created with an image and assigned in inventory for the item. 

Taxes...Allows a user to selectively add or remove taxes for the selected Sales transaction. 
 These changes are reflected in the Taxes Report for the day's business. When setting 
up taxes in multi-store, you have to choose which tax rates are automatically applied for 
each store.  These are the tax rates that are shown when you use the Taxes button the 
ticket.  There is a "Show all?" checkbox at the top of the Taxes selection dialog box.  If 
checked, it will show all the tax rates for all the stores.  You can then select any tax rate 
to apply to the ticket. 

+ Inventory Quick Add feature... Found next to the Store Style Lookup binoculars & designed to 

allow a new inventory item to be created & sold for SPECIAL ORDER.  The function 
becomes active once the ticket's SALE button is clicked. 

The Inventory Quick Add form allows a inventory style to be created, quickly during ring out, 
within the inventory with minimum information, i.e. Vendor Style (real style #), Vendor code, 
Category, Sub-Category, Price (retail 1) and Cost.  The item's wholesale cost is displayed as 
asterisks so curious customers cannot see it being typed.  WinPOS will auto create a 
sequential store style number for the item when it is saved & then auto insert it into the Style 
code field of the ticket.   Enter a vendor code that does not exist and WinPOS will add the 
vendor to the vendor file automatically.  Enter a category code that does not exist and 
WinPOS will add the category to the category file automatically.  Enter a sub category code 
that does not exist and WinPOS will add the sub category to the category file automatically. 
No sizes or colors are created for the new item.  Just enter the size & color onto the ticket to 
be special ordered. 

 

 

Ticket Details 

Located in the middle of the Ticket form, below the horizontal divider line 

Overview 
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These fields show you the details for the ticket line item selected in the line item list in the 
middle of the Ticket form. These ticket line items are also called transactions. The fields are 
listed in order left to right, top to bottom since some of the fields do not have captions. 

You can hide these details and only show the ticket list by pressing the Hide Details button at 
the bottom of the Ticket form. If you want to view the details, press the Show Details button. 
This option is only enabled if Short Ticket Format is checked in System Setup, Options Tab. 

You can edit the data for the ticket line item directly using a special edit function. This special 
edit function bypasses the normal safety checks for the Ticket and is used only to correct 
internal ticket problems by users who understand the internal workings of the Ticket. To edit a 
line item, hold the Shift key down and click in the Line number field. An editor showing the ticket 
line item will be displayed. Make any changes required and click the X in the upper right corner 
of the editor to close it. The user must have EDITTICK security to use the editor.  

Fields 

Line number...Ticket line items are numbered, 001, 002, etc. This field is set automatically by 
WinPOS® and cannot be changed. 

Date...This is the date and time this line item was created & is entered automatically. 

Transaction type...The next two fields tell you what kind of transaction this is. The transaction 
type is set automatically based on the selection the user makes. Here are the various 
transaction types. 

• Sale: This is the sale of an item or service.  The item or service being sold should 
have a code in the inventory that contains specific details, as vendor code, cost, 
categoy/class, retail price ..etc.   Note:  Sales of Services or other intangibles can be 
made. 

• Rental: Only available in WinTPS or WinTPOS optional rental software modules.  This 
line item represents a rental created with the Rental Order form. The Rental Order 
form contains all the details of the rental (styles and sizes rented) and this line item on 
the ticket contains the total charge for the rental.  This transaction is automatically 
entered on a ticket by the creation of a Rental Order. This transaction is NOT tied to 
any inventory style.  The transaction does not contain a Inventory Style code and but 
always contain the inventory category of RENTAL.  The accounting class assigned to 
this transaction is controlled by the user defined Order Type entered on the order. 
 The Order Type's defined accounting class is assigned to the transaction.  The 
default is TUXRENT. 

• Payment or Refund: In this case, the next field indicates the tender type. Cash, Visa, 
Discover, etc. 

• Sec. Dep.: This line item indicates a security deposit transaction. The style field 
indicates what happened with the security deposit (Add, Forfeit, Refund, Apply) 
Security deposits are covered in more detail below. 

• Adjustment: This line item shows that a sale line item has had its price changed. 
Rather than changing the sales transaction directly, an adjustment transaction is 
created. Adjustments are covered in more detail below. 

• Cancel: This line item shows that a sale line item on this ticket has been cancelled, 
meaning that the item was returned. Rather than changing the sales transaction 
directly, this cancellation transaction is created. Cancellations are covered in more 
detail below. 

• Credit: This indicates a store credit was created for a customer. When you attempt to 
save a Ticket that has a positive balance (that is, you owe the customer money) 
WinPOS® converts the balance into a Store Credit.  
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Sale registered?...If checked, this sale as registered to the event for this ticket. This means that 
if you sell the same style to another customer for this event, the operator will received a 
warning. Sales may be setup to be automatically registered when sold via the Inventory 
Category form and/or a user may manually register a sales when it is being made on a 
event  member's ticket by checking the "Sale Registered?" checkbox.  When sales are 
marked registered on the ticket, the WinPOS ticket will automatically alert the operator 
when an item of the same style and same style & color are being sold to the event. 

PO Item...The PO item number for this line item. You will only see a number here if this item has 
been special ordered. This field is set automatically by WinPOS® and cannot be 
changed. If you double click on this number it will take you to view the PO item screen 
when the status is ORDER or to the Pickup Inventory form with the status is IN. The 
Show Fitting button will become enabled so you can go to the fitting for that item when a 
fitting record exists in the optional Custom Fitting Module for the highlighted item. 
 Remember the user must have the proper security setting to visit or edit the PO item 
details in the Purchase Order module or in the Pickup Inventory form. 

Camera button...You can take pictures of inventory items and store them on the Inventory form. 
This button displays the images for the selected inventory line item. 

Color chart button...You can take pictures of color charts and store them on the color chart form 
then assign color charts to inventory items. This button displays the images for the 
selected line item. 

Qty...The quantity sold. 

Style...The inventory style code being sold. The binoculars will display a list of style codes in the 
Retail Inventory (This lookup function will not display rental styles entered in via 
WinTPS/TPOS© optional modules). You can select a style code from the list. You can 
also enter a SKU, barcode number, or UPC code. In this case, the SKU, barcode, or UPC 
will identify the style and size/color/width so those fields will be filled in automatically. 

Note on WinTPS Rental Inventory Sales 

WinTPS users may sale tracked rental inventory by entering the item’s serial/ID number into 
this field. This is allowed when the item’s ‘Allow sale of Rental Items’ is checked on the 
Inventory - Rental tab -> Rental Sizes form. Rental Items sold by scanning serial/ID number 
will be automatically marked as unavailable for assembly, Sold will be entered into the status 
field, the ticket number containing the sales transaction will be entered onto the inventory 
item's comment field and the current date will be placed in the date retired field of the View 
Serial/ID numbers form.  The item may be marked for Pickup Now or Pick later or 
TRANSFER IN (with optional multi-store module) status. (SPECIAL ORDER is not allowed) 
 
After you enter a style code, the description and price from the Retail Inventory will appear to 
the right of the style code automatically. If this item has a Retail 2 price, you will be prompted 
for the correct price to use.  
 
The cost is also computed at sale time depending on the sale type. If this is a special order, 
the cost is the reorder cost from the Retail Inventory. If this a stock sale, the cost comes from 
the Receive History. If the inventory costing method is set to LIFO, then the most recently 
received inventory item is sold first, and the unit cost of that item is used. If FIFO is selected, 
then the oldest inventory item in the receive history is used. In either case, the cost is then 
discounted using the cost factor (if applicable) and vendor discount from the Retail Inventory. 
 
The style code you enter must appear in your Retail Inventory. However, there is a special 
way to sell something even if you don’t have it in your inventory. Make sure the “Allow sale 
of item not in inventory?” option is checked in System Setup, Options Tab. Then, when you 
enter a style code that does not appear in your Retail Inventory, you will be prompted “SKU 
not on file, sell anyway?” If you say yes, the style code will be converted to NOSKU, a 
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special style code that always appears in your inventory that has the MiscSales Accounting 
Class assigned and Misc Category assigned (by default when the system is installed). The 
user entered SKU will be copied to the reference field so there will be a record of what was 
entered by the user.  

For NOSKU sales, the MiscSales Accounting class 'Allow Price Changes' option should be 
checked which allows the user to edit the selling price on the ticket to any value.  

Most users do not use the NOSKU option because there are a number of reasons why you 
don’t want to sell items that have not been entered into your inventory. 

• You will not be able to analyze these sales as you can analyze other sales using the 
sales reports, since they will all show up under the NOSKU style. 

• You cannot special order this item, since the style will appear as NOSKU on a 
purchase order. 

Hint: 

A shop may wish to enter styles in inventory of merchandise they do not carry, thus the 
quantity on hand will be zero. These items may be sold on sales tickets. A couple of things 
to remember for set-up are: If the T-Taken status will be used on the sales ticket vs O-order, 
'The allow quantity to go Negative' checkbox should be checked or 'Allow stock sale of item 
not in stock' option in System/Store Setup, Options Tab should be checked.  

Hint: 

Comments for inventory style codes may be entered within inventory. Information entered in 
an inventory style’s Comment 1 is automatically displayed on screen to the user when it is 
sold. 

 

Size, Color, Width...Enter the size, color, and/or width sold. If you entered a SKU, barcode, or 
UPC code, these fields are filled in automatically. 

When “Allow stock sale of item not in stock?” is checked in System/Store Set-up - Options 
Tab, then the values entered are not matched up with the Size, Color & Widths (SCW) 
entered on the inventory SCW form. This is usually not desirable, as the QOH & sales 
statistics for inventory cannot be updated even if the item is sold out of stock, since WinPOS 
does not know which size/color/width entry on the SCW form to update. When the option is 
unchecked, then the size & color entered on the ticket are matched against those entered on 
the inventory  SCW form.. In a case where there is no match in inventory for if the 
size/color/width entered the WinPOS system will accept the entry but force the user to 
Special Order the item and it cannot be sold from Stock.  Either setting does not compare 
the entered SCW  on the ticket to the style's SCW charts, if any are entered in the Inventory 
Details/Style tab.  Please see note below to validate size, colors or widths entered on a ticket 
against a chart. 
 
Behavior when user clicks the binoculars to look up the size, color, and width is follows.  

Inventory with a defined a size/color/width chart for style codes being sold can display a 
matrix of the all the sizes, color, and widths available. You can then click on any cell in the 
matrix to select a particular size, color, and width and they will be inserted into the ticket. 
 The presence of a size chart on an inventory style and the entering of customer 
measurements onto the event or customer card will cause the system to suggest a size for a 
customer based upon the chart measurements and actual customer measurements.  See 
the Size Chart topic for more information. 

   

If you do not have size, color, or width charts defined for this style, or you press Cancel on 
the matrix, you will be presented with a pick list of all sizes, colors, and widths defined the in 
Retail Inventory for this style (located at Main->Inventory->Inventory->Sizes button.) 
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You can come back to the ticket later and change the size, color, and width for an item. If the 
item is special ordered and the PO has not been issued, changes to the size, color, and 
width will be carried through to the un-issued PO item.  

The system will allow modification of size, color or width for special ordered items, even 
when the PO has been issued to the vendor.  The system will present a alert to the operator 
that there may be a problem with attempting the change.  The system will automatically add 
a purchase order 'To-Do' so the person responsible for managing customer special orders 
can be alerted to attempt the change. If the change cannot be made the size color or width 
may be changed back to reflect the original order.  Security may be set via the UPDISSUED 
security setting that prohibits unauthorized users from making a change to the SCW or 
Special Instructions of an item when a special order has been issued.   

Note: 

The System/Store Set-up -  Ticket/Receipt tab setting, "Require size/color/width to appear in 
charts?" will only allow (validated) size or colors or widths being entered against the Size, 
Color & Width charts that may be entered on the inventory style.  If a chart is not entered, 
the system will accept any value entered by the user.  To check the Size/Color/Width entries 
on the Inventory SCW form against any entered Chart(s),the system has an inventory report 
called SCW not on Chart that will list entries in the SCW form that are not on the Style's 
chart.  Management should make sure the SCW form and Size, Color, Width Charts agree. 
 Without this setting the user may enter any SCW combination, even if the SCW does NOT 
appear in a entered chart. 

Special Order Note: 

Size, color of width of sale items marked to be special ordered may be edited at any time by 
clicking on the line items size/color/width fields.  If the Purchase Order is issued then a 
Ordering TO-DO is created so the person responsible may attempt to implement the change 
to the order.  If the change cannot be done then the ordering person will reject the edits and 
revert them back to the options ordered. 

 

Adj. Amt, Mkdn. Code...When making an adjustment to sale or rental line item, you first indicate 
the markdown amount (ie. –50, 10%) and the optionally enter a markdown code 
(depends on system setup how markdowns are used). The markdown code indicates 
why the markdown was given. Possible reasons are damaged goods, competitive 
discount, etc. You can define your own markdown codes using the Markdown form at 
Main->Housekeeping->Inventory Setup->Mark down Codes. 
 
The actual discount is automatically computed and displayed in the Price field for the 
adjustment line item. 

Price...On a sale or rental, the price field is filled in automatically, and indicates the unit price of 
the item. You can change the price of an item if the Accounting Class for that item allows 
it. Each retail inventory item has an accounting class assigned to it, as shown on the 
Retail Inventory form. 
 
For an adjustment transaction, the price indicates the actual adjustment amount. For 
example, for a 10% adjustment on the $1500 gown, the actual adjustment amount is -
$150.00. 
 
For a cancellation transaction, the price is the negative of the sales price of the item 
cancelled, which zeros out it’s price on the ticket. 

Reference...This field contains extra information for this line item. On a sale transaction, you can 
enter anything you like here. The reference can optionally be printed on the receipt (see 
System Setup - Options Tab).  
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For an adjustment or cancellation transaction, you can enter an additional explanation as 
to why the markdown or cancellation was given. 
 
For check payments, the check number appears here. For credit cards, the approval 
number is shown. For gift certificates, the certificate number is shown. 

Status...An sale transaction may be assigned a STATUS.  The item's status indicates where the 
item is. An item's status may be changed later when needed, i.e. from In to Taken. 
 When an item or service is being sold the system will prompt the user for a status. 
 Possible statuses the user must choose are.   

• Taking: This item is in the process of being taken. When you save the ticket, the 
status will be changed to Taken. If you cancel changes to the ticket, the item will 
revert to it’s prior status. 

• Taken: The item has been taken by a customer. This could be because they 
purchased something and took it with them, or if an item that was special ordered 
arrived, was placed into pickup inventory, and the customer has now and picked it 
up or the item was shipped to them via the WinPOS® shipping module.  Special 
Order sales must be marked TAKEN by a user.  This can be accomplished for 
individual sales from the sales ticket or by batch via   Inventory-> Mark Items Taken 
form. 

• In: This item is in pickup inventory for the customer. This can happen if you select 
layaway at sale time. It can also happen if an item that was special ordered was 
received.  Special Ordered items once received are auto placed into pickup 
inventory. 

• Order: This item has been special ordered.  The PO may or may not have been 
issued.  Check the PO item form or Order/PU Inventory tab on customer or event 
 for PO status.  When an ordered item was received then returned via the RCR 
module, it will go to back to a ORDER status.  Customers will see the confirmed 
shipping date plus the number of padding days on their MyInfo web page when 
active. 

• Cancelled: This sale has been cancelled.   Automatically entered by WinPOS when 
a sale is cancelled. 

• Shipping: The letter’s color is significant. Black means no shipping information and 
Blue means shipping information exists for the highlighted ticket transaction. This 
function will edit/create a shipping record for the selected sales ticket item and allow 
the editing of it’s Shipping Details. Items marked for shipping can be shipped with 
the Shipping function. 

Orig. Price...The original selling price of this item, prior to any adjustments or cancellations. 

Ext. Price...The unit price of the item times the quantity sold. 

Sales 1, 2, and 3...Enter up to three SA ID’s for the salespersons who handled this sale. If the 
“Show 2

nd
 and 3

rd
 salesperson on ticket” option in System Setup – Options Tab is not 

checked you will only see field for one SA ID. The Sales by Salesperson report will break 
down sales by the SA ID’s entered here. For this reason it is important to enter the ID’s 
here.  

Clerk...Enter the SA ID of the clerk who rang up the sale. 

Taxes button...Allows you to select which taxes apply to this sale transaction. The taxes are set 
automatically based on the tax group specified on the accounting class for the retail 
inventory item. You will see a list of all the tax rates defined on the Taxes form (located at 
Main->Housekeeping->Accounting Setup->Taxes) Tax rates with a check mark next to 
them will be applied. Note that you cannot change the taxes on an item you have just 
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made an adjustment to the line item. You have to save the ticket and come back in and 
then change the taxes. 
 
TICKTAX security is required to change the taxes on a ticket. 

Tax...The tax charged on this line item. Click the taxes button above to change the tax. 

Ticket details list...This list shows you the line items on the ticket. Since there is more 
information than will fit in the list, all the details for the selected item are shown above the 
list. As you select an item in the ticket details list, the details are show above the list. 

• Line: The line number of this transaction. 

• Transaction: The transaction type: Sale, Rental, Payment, Refund, Sec. Dep, 
Adjustment, Cancel. The transaction types are documented in Ticket Details. 

• Qty: Quantity sold. 

• Style, Size, Color, Width: For the item sold. 

• Price: The extended price for the item. 

• Status: The items status. See Ticket Details above. 

 

Buttons 

Show CCard...Available when with the optional integrated credit card processing software.  A 
button "Show CCard" will appear on the ticket form, next to the items grid if a credit card 
line item is selected.  This button will show the last four digits of the credit card.  Requires 
VIEWCCARD security. 

 

Hidden Functions 

WinPOS provides several hidden functions that allow management to edit raw ticket information 
when needed. 

a) Hold SHIFT key down and click the selected transaction's line number field (next to the Date 
field).  This will display a new window of ALL the field data for the transaction and allows any 
edits to be made.  This edits are not check for accuracy so please be careful.  Requires 
EDITTICK security.  

b) Hold Shift key down and click just outside the bottom right corner of the transaction grid.  This 
will signal WinPOS to re-calculate the ticket totals.  This is occasionally necessary after editing 
any ticket transaction. 

c) Hold the Ctrl key and click the Line Number field (next to the Date field).  This will bring up the 
cost editor, where you can change the cost of the sale.  You can change the cost of the sale 
only if the revenue has not been realized for the line item.  Requires COSTTICK security.  

 

Ticket Footer 
 

Financial Fields for ticket 

This totals are automatically computed for the ticket by WinPOS©. 
 

Sub-Total...The total of all the line items on the ticket, without taxes. 

Tax...The total tax charged for all tax rates applied to sales transactions on the ticket. 

Total...The total due, which is the sub-total plus tax. 
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Paid...The total of payments on this ticket. 

Balance due...The total due minus payments. 
 

Transaction Options 
 

WinPOS® offers different transaction to enter payments, sales and adjustments to tickets. 
These transactions are found on the bottom left hand corner of the form. 
 

Sale button...Ring up a new sale on this ticket. WinPOS® will lead you through all the fields for 
the sale. You must press either the Save Line Item button or Cancel Changes button to 
add the sale to the ticket. 

Payment/Rtn. Check button...You use this to take payments and enter returned checks. It takes 
you to the Payments form to make a payment on this ticket. Note that when you take a 
payment the ticket form is closed automatically. 

Adjust/Canc/Extra Chrg. button...This button is used to make adjustments to sales or payment 
transactions, cancel sales, add extra charges.  First, click on the Sale, Payment, or Extra 
Charge you want to adjust or cancel, then click the Adjust/Canc/Extra Chrg button. 

   

Security deposit button...This button is used to handle security deposits. If the customer 
currently has a security deposit it is shown at the top of the Ticket form. A security 
deposit is different than a partial payment or down payment. A partial payment is 
payments towards a balance due. A security deposit is money held by the store to insure 
that customer brings something back, or actually places an order, etc. A menu will be 
displayed with four buttons.  Security is provided by WinPOS© on this specific function 
via the USESECDEP security code. 

• Add: Use this to take a security deposit. The Payments form will be displayed, with 
the notation “PAYMENTS WILL BE APPLIED TO SECURITY DEPOSIT.” Take a 
payment as usual, and the payment amount will be added to the customers security 
deposit.   

• Refund: Use this to return a security deposit to a customer. This button is only 
enabled if this ticket has a security deposit. The Payments form will be displayed, 
with the notation “REFUND OF SECURITY DEPOSIT.” Give a refund as usual, and 
the refund amount will be deducted from the customers security deposit. 

• Forfeit: Use this option when the customer is to forfeit the security deposit. The 
security deposit will become revenue for your store, and show on your revenue 
report according to the GL account number defined on the GL Accounts tab of the 
GL Account Setup form. You will be prompted for the SA ID clerk 

• Apply as payment: Use this option when the customer will be using their security 
deposit as a payment. The Payments form will be displayed, with the notation 
“MAKING PAYMENTS USING SECURITY DEPOSIT.” Click the Sec Dep tender 
button and enter the amount of payment. Process the payment as usual and the 
payment will be deducted from the customers security deposit.  Security Deposit 
payments may exceed the balance owed.  In this situation WinPOS© will 
automatically display the difference of the overpayment amount in the Payments 
form immediately following the entry of the Security Deposit payment allowing the 
user to process a Refund.  A Store Credit will automatically be created for the 
customer and the ticket balance will be zero ($0.00) if the user Cancels the payment 
form not processing a refund to the customer. 

Item Status button...This button lets you change an item’s status. A menu is displayed with up to 
six options.  WinPOS retrieves the inventory item's cost & inserts the cost of sales onto 
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the stored ticket transaction.  The cost may vary depending on the costs entered onto the 
inventory record.  A item SPECIAL ORDERED cost definition is:  Quantity sold * the 
Inventory Reorder Cost.  A item sold from STOCK cost definition is: Quantity sold * 
(Average unit cost less inventory Manufacturer discount * Cost Factor)  

• Pickup Now: Sets the item status to Taking, and when you save the ticket the status 
will change to Taken. This means that the customer is taking the item with them. 
You would use this on a sale where the customer is leaving with an item. You would 
also use this if a customer is picking up an item from pickup inventory. It is important 
to mark items as picked up so that your Pickup Inventory will be up-to-date. 
 Typically items should be paid for prior to them being Taken from the store.  When 
the system believes the item is not fully paid it will display a warning message to the 
user.  The users can change the status to something else or continue the process of 
marking the item Taken.    

• Pickup Later: Sets the item status to In, meaning that the item is going to Layaway, 
or Pickup inventory. The item will be added to Pickup Inventory, and an item number 
will be generated for this item, which will identify it in Pickup Inventory. The item 
number is shown in the Ticket Details section of the Ticket form. You can view 
pickup inventory on the Pickup Inventory form, located at Main->Inventory->Pick Up 
Inventory. 

• Special Order: The items status will be Order, meaning this item is to be ordered. 
WinPOS® will automatically create a purchase order item number and add this item 
to the pending purchase order file. You can view pending (also known as un-issued) 
PO’s from the Un-issued Purchase Orders form. The PO item number will appear in 
the Ticket Details section of the Ticket form.  If this option is chosen on a previously 
marked item for order then the special & private instructions may be edited at any 
time. If the Purchase Order was issued before the edits were made, a Ordering TO-
DO is created so the person responsible may attempt to implement the change to 
the order.  If the change cannot be done then the ordering person will reject the edits 
and revert them back. 

• Return from Customer: Used if a customer has taken an item from Pickup Inventory 
and now wants to return it. For example, you may have a bride who wishes to take 
her gown from your store to have her portraits taken, then return the dress to your 
shop for final steaming, pressing and storage until the actual wedding. The items 
status is set to In, the item is automatically added into pickup inventory and the 
system prompts a user to re-print a pickup tag.  The dates the item was taken & 
returned are shown on the form for Items that have been taken then returned from 
the customer. 

Hint:  Store styles that begin with the word RENTAL perform differently.  These styles will not 
be re-inserted into pickup inventory.  These type style numbers are most often used in shops 
that rental tuxedos from wholesalers and wish to track customers & orders without 
purchasing the optional WinTPOS rental point of sale module.  The pickup and return dates 
will be created. 

• Customer Shipping: Allows the highlighted sales transaction to be tagged for 
shipping.  This function creates a shipping record for the highlighted sales item. 
Shipping address, method and other shipping information may be entered in the 
record. Items tagged for shipping will display in the Shipping module. 

• Transfer In: Available with the optional Multi-Store module.  You can create an 
Inventory Transfer to request that the item sold be transferred to this store. When 
you press this button an inventory transfer will be created for this item. You will then 
be prompted for the details (such as the store to acquire the item).  The Inventory 
transfer does not affect retail Quantity on Hand totals.  It will create an Pickup 
Inventory item record once the transfer has been received via the Transfer form.  If 
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the item is never received a user would be responsible for cancelling the item sold 
on the ticket. 

Refund button...You use this to give refunds. It takes the user to the Payments form and places 
it in REFUND MODE.  Enter the refund amount Note that when you give the refund the 
ticket form is closed automatically. 

No Sale button...If you have a cash drawer attached to this workstation this button will cause it to 
open. The cash drawer must be configured in Register Setup, located at Main-
>Housekeeping->General Setup->Register Setup (REGSETP) 

Delete button...This button will let you delete an entire ticket, or delete a single ticket line item.  
 
You will see a menu with two options, Delete line item and Delete ticket. If you choose to 
delete a line item, select the line item from the detail list before pressing the Delete 
button. You will be given a number of warnings and a final confirmation before the 
deletion occurs. 
 
WARNING: If you delete an entire ticket, you lose it altogether. No record of it is left 
behind. You would only use this if the ticket has become corrupted or damaged somehow 
and is no longer meaningful. Also, your GL postings for the day will probably be off and 
your revenue report may not balance. You can also delete a single line item from a ticket. 
Again, you would only do this if the line item were damaged somehow. With this as well, 
your GL postings for the day will probably be off and your revenue report may not 
balance.  

Print button...Prints the receipt for this ticket or with the optional email option allow you to email 
the receipt.  You can use this button to print a receipt even if you’ve made no changes to 
the ticket.  Receipts may be printed or emailed. The email feature is available via the 
optional marketing module.  Make sure the email settings are configured on the 
Integration tab of System/Store setup.  When the email option is selected the system 
prompts for email address and subject.  A blank email body appears where information & 
instructions may be typed. A template may be set in Main-> Housekeeping-> 
Letters/Tags/Labels using the Source CUSTOMER and Printer/Type EMAIL.  The 
template can be inserted into the body for any editing by selecting if from the Insert 
Template Drop down that appears on the editor.  Once entered email will be sent with the 
receipt attached as a PDF file attachment.  The customer must have an PDF file 
viewer/reader installed to read any PDF formatted document.   

Four choices may be available when the print option is selected.    

Print: Prints the receipt to your defined printer.  The Main-> General Setup-> System Setup-
> setup-tab-> Prompt for summary only receipt?... Checked, the WinPOS system stop 
and ask user to print a summary or standard receipt. A summary receipt will only print  the 
receipt grand totals.  It omits all line item details. 

eMail: eMails the receipt.   

eMail & Hold:  eMails the receipt and marks the ticket held.  Most likely the consultant is 
waiting on the proper signatures or confirmations from the customer.  Once all is OK, the 
ticket HOLD can be released by entering the ticket and clicking the Un-Hold button found to 
the right of the item grid.  Tickets marked HELD will appear in the follow-up modules found 
under Main Switchboard-> Files-> BM Follow-up and Bridal Follow-up.  The words Ticket 
HELD will appear next to the customer name.  Held Tickets will appear in the Un-Issued on 
screen worksheet the HELD code.  This is a message to the operator that the PO should not 
be issued for the item. 

Fax:  Receipts may be faxed when your hardware is properly configured with a fax modem. 
 This option only appears once the hardware is configured.  See the How I fax receipts topic 
for more information. 
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Hint 

The receipt is automatically printed if you have made changes to the ticket when you press 
Save/Done with Ticket to close the Ticket form. 

 

Recalculate button...There is a hidden button on the Ticket form, right above the Cancel 
Changes button on the right edge. If you click the mouse on this button WinPOS® will 
recalculate the total for this ticket. Use this function when the ticket totals at the bottom of 
the ticket do not add up correctly. 

Total cust balance...If the customer has other tickets with balances, the total of all those tickets 
will be shown in red, just above the Save/Done with Ticket button.  

 

Line Item   (botton Left, appear when a new transaction is added) 

Save Line item button...Will temporarily save the newly created ticket transaction.  Not 
permanently saved until the Save Done with Ticket button is clicked. 

Cancel Changes button...Cancels eliminates the newly created line item and allows a user to re-
enter.. 

 

Ticket   (botton Right) 

Cancel Changes button...Will cancel/eliminate all newly added ticket transaction during this 
session 

Save Done with Ticket button...Permanently saves any edits & exits from the ticket.  Also, auto 
updates the Customer Self Service web site information. 

Receipt 
 

A ticket’s sales receipt is a printed record of ALL financial transactions, i.e. charge (sales & 
rental), adjustments, payments ..etc made by a customer.   

Using the optional email integration module a receipt may be emailed.  The Email Receipt 
button will appear if Email is enabled.  A dialog box will appear to confirm the email address, 
enter a subject, and enter text for the body of the email.  The receipt will be attached to the 
email as a PDF file.  The Insert email template drop down will display a list of Customer 
source, Email type letters. Selecting one will insert the contents of the letter into the email body. 
 This can be used to insert boilerplate or common blocks of text for emails, such as signatures. 

Typically a printed receipt will be for a single sales ticket. However, a sales receipt can recap 
several tickets. This is the case when a single payment is applied to multiple sales tickets via 
the Payment Form. Printed Sales receipts may also recap rental order details, via the optional 
rental module. 

The receipt is printed automatically when you finish with a ticket, after making any changes to 
the ticket. For example adding sales transactions or taking a payment.  

You can also press the Print button on the Ticket form to print a receipt. The fields are listed left 
to right, top to bottom.  You may see these options when the Print receipt button is clicked: 

Print: Prints the receipt to your defined printer.  The Main-> General Setup-> System Setup-
> setup-tab-> Prompt for summary only receipt?... Checked, the WinPOS system stop 
and ask user to print a summary or standard receipt. A summary receipt will only print  the 
receipt grand totals.  It omits all line item details. 

eMail: eMails the receipt.   
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eMail & Hold:  eMails the receipt and marks the ticket held.  Most likely the consultant is 
waiting on the proper signatures or confirmations from the customer.  Once all is OK, the 
ticket HOLD can be released by entering the ticket and clicking the Un-Hold button found to 
the right of the item grid.  Tickets marked HELD will appear in the follow-up modules found 
under Main Switchboard-> Files-> BM Follow-up and Bridal Follow-up.  The words Ticket 
HELD will appear next to the customer name.  Held Tickets will appear in the Un-Issued on 
screen worksheet the HELD code.  This is a message to the operator that the PO should not 
be issued for the item. 

Fax:  Receipts may be faxed when your hardware is properly configured with a fax modem. 
 This option only appears once the hardware is configured.  See the How I fax receipts topic 
for more information. 

 

If the "Prompt for summary only receipt?" option is checked in System Setup, it will stop and ask 
user to print a summary or standard receipt. A summary receipt will only print the receipt grand 
totals.  It omits all line item details. 

Note  

WinPOS™ with optional Rental Point of Sale feature can print the details of a rental order 
associated to the ticket. A rental order will generate a rental transaction on a ticket that 
represents the total charge of the rental order. The details of the rental order, i.e. use date, 
pickup date, return date, styles & sizes ..etc will be printed on the receipt the first time the 
ticket is printed. It will not print on subsequent printed receipts or after a Rental Reservation 
Receipt is printed. 

Receipt Information 

Logo...If there is a file called LOGO.BMP in your data directory (normally \TPSWINS\TWDATA) 
the bitmap will be printed in the upper left corner of the receipt. The bitmap should be 210 
pixels wide by 77 pixels high. 

Date, time, register name...The top right of the receipt contains the date and time the receipt 
was printed, as well as the register that printed it. 

Store name, number, address...The store name comes from your license file and can only be 
changed by BBL Systems customer service. The store number and address are entered 
in System Setup - Setup Tab. 

Ticket...This is the ticket number that is automatically assigned by WinPOS®. 

For:...This is the customers name and address. If they are a member of an event, their role, the 
event name, the event number, and the sales associate who registered them is printed 
here. The customers measurements will also print here if the Print measurements on 
receipt option is checked in System Setup - Options Tab. 

Transactions...For each transaction the receipt shows: 

• Type: Sale, Canc for Cancellation, Adju for adjustment. 

• Date: The date it occurred. 

• Qty: Quantity sold. 

• Style: The store style code sold. 

• Descrip: The description from Retail inventory. 

• Size, Color: For the item sold. 

• Price: The original selling price of the item, before any adjustments. For adjustment 
and cancellation transactions, the price si the adjustment or cancellation amount. 

• St: Short for status. O for special orders, C for cancellations, T for taken from store, I 
for In pickup inventory. 
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Clerk and Sales associates...If the Print clerk and all salespeople on receipt option is checked 
on System Setup - Options Tab, WinPOS® will print the clerk and SA. 

Special instructions...If the Print special instructions on receipts option is checked on System 
Setup - Options Tab, WinPOS® will print the special instructions. 

QTY @ Price...If the Print QTY@Price on receipt option is checked on System Setup - Options 
Tab, WinPOS® will print the quantity purchased at the price. 

Reference...If the reference on receipts option is checked on System Setup - Options Tab, 
WinPOS® will print any reference entered on the ticket. 

Statement summary...List the sub-total, total tax, then breaks down the payments paid today 
versus payments paid before, and finally lists the balance due. 

WinPOS supports the ability to set-up & apply multiple tax rates to sales transactions.  The 
sales receipt will print the totals for each tax rate next to that tax rate's description. 

Contract...WinPOS® will print the “Receipt” Document Terms at the bottom of the receipt. If the 
receipt contains a special order, the “Special Order” terms will also print. If the receipt 
contains a rental order, the “Rental Agreement” terms will print. 

View Ticket by Style 

Switchboard: Main->Top Level Menu-> Locate->View Ticket By Style 

Menu: File->Ticket by Style 

Action: none 
 

This option lets you find a ticket if you know the store style number that was sold to the 
customer.  

Enter the style number in the search for field and then click on OK. A list of all the customers 
that have purchased that style will be displayed. You can choose the ticket you want to display 
by double clicking on the entry in the list or highlighting the correct line and clicking OK.  

View Ticket by Number 

Switchboard: Main->Register Functions->View Ticket By Number and  Main->Top Level menu-
>Locate-> Ticket By Number 

Menu: Find->Ticket By Number 

Action: none 

 

This option lets you go directly to a ticket by it's ticket number OR allows direct edits to ticket 
transactions including it's accounting postings used by the revenue report and all other 
accounting related reports.  A ticket may deleted as well. 

Enter the ticket number at the Search For prompt.  WinPOS will locate and select the entered 
ticket number. 

 

Buttons 

View Ticket...This button will display the ticket for review or editing. 

Edit Postings...This button will display the details of the ticket and the associated GL 
transactions for each line item.  
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The Transaction Editor shows the ticket line items on the top half of the form. When a ticket 
line item is selected, the bottom half of the form will show the Posting transactions 
associated with that ticket line item. You would use this option to manually correct problems 
with the postings or ticket transactions.  The displayed data columns may be edited like an 
eXcel spreadsheet. Simply click into the cell and entered the desired value.  There are no 
program checks on the data entered within this form so please be knowledgeable with the 
effects of your changes will be. The WinPOS Revenue report, payments reports and other 
closing reports utilize this posting data for report calculations.   

Any cell within the grid may be edited.  BE CAREFUL since any change will effect the details 
of the Revenue Report. 

This is an advanced feature. 

Cancel.. Exit the form and return to the previous menu. 

 

Edit Postings Buttons 

Ticket line items grid 

Delete line item... Deletes the selecting transaction.  The deleted item will no longer appear on a 
sales ticket or be included in any sales reports.  Deleted items do NOT disappear from 
this grid, but instead a black box will appear to the left of the line which indicates it is 
marked as deleted.  Click the black box to UN-DELETE the item. 

Edit Line Item... Opens a data windows showing all editable fields in the table for the selected 
line item.  Any field's data may be modified. 

 

Postings grid 

Delete posting ... Marks the selected posting as deleted.  WinPOS ignores all deleted entries for 
accounting report calculations.   Deleted items do NOT disappear from this grid, but 
instead a black box will appear to the left of the line which indicates it is marked as 
deleted.  Click the black box to UN-DELETE the item. 

Recall posting... Recalls (un deletes) the selected posting.  This is the same as clicking the 
black box to un-delete. 

 

Footer buttons 

Delete entire ticket ... Will delete the entire ticket by marking all ticket transactions and postings 
as deleted (black box to left will appear). 

Edit Ticket... This function displays a new window that allows the ticket header to be edited.  The 
ticket header contains important ticket info and store location that owns the ticket, 
customer number that the ticket is assigned to, tax info, created date ..etc 
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Purchase Orders 

Purchase Orders Overview 
 

WinPOS® Purchase Order management provides the tools to efficiently process a large number 
of purchase requests for customers (special order) and inventory (stock order). 

Purchase Orders items are created from the customer’s Sales Ticket while stock order items are 
created within the View PO Items maintenance form. WinPOS® provides flexible report and 
printing options to allow extensive control over the entire process. 

The Issue Purchase Orders Work form is the primary function that is used on a daily basis to 
review items that need ordering & to determine which items may be released for PO creation.  It 
actually serves two needs.  It can indicate which items need to be ordered OR which Open POs 
(those issued, but not received) need follow-up. 

Once a PO is issued (a PO is issued by printing it) it may be reviewed/received via the View 
Purchase Orders maintenance forms. 

Purchase orders can be sent electronically to a vendor if the vendor supports Smart Link.   

Note: 

Special Ordered for specific customers are automatically created from their sales ticket 
status.  In some circumstances details of the special order may be modified or even deleted. 
 Available modification  features depend upon the PO status of the item being ordered.   

 

1.  Modifications made on the PO Item form do not show/display on the customer's ticket 

2.  Size and/or color may be modified on the ticket even after the PO is issued.  In that case 
a PO Alert is created for the ordering manager that indicates what was changed. 

3.  A ordered sales transaction is cancelled, the PO item is deleted when the PO has NOT 
been release 

4.  A ordered sales transaction is cancelled, the PO item is marked to indicate the sales 
ticket sales transaction is cancelled when the PO has been release.  The PO must be 
manually cancelled with the manufacturer, if possible. 

 

 

PO Item Creation to PO Diagram 
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Issue Purchase Orders 

Purchase Order - Search Form 

Switchboard: Main->Purchase Order->Issue Purchase Order 

Menu: PO/Ship->Issue Purchase Orders 

Action: PURCHORD 
 

The PO Search form provides the selection criteria for displaying information within the 
Purchase Order/Item Work form. The selection criteria can limit the information displayed to 
Issued Purchase Orders (Open POs), i.e. POs have been printed, but NOT received OR UN-
Issued PO items, i.e. items to be ordered that are not on a PO yet by the user making the desire 
SHOW option. Simply check the Un-Issued PO Items or Issued POs checkbox to indicate which 
to display within the Show box. 

The Show option selected has it’s own Search form selection criteria. The search form will 
remove or add search criteria dependent upon which option is selected. 
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Selection Criteria 

Show Box 

Show...Select to see either un-issued PO items or issued purchase orders. 
 

Sort Box 

Sort...The work form can sort the results of your search in various ways. You can sort by event 
date, vendor, PO number, issue date, confirmation date, or event name. Not all options 
are available at all times. The available sorting options depend on whether you are 
showing PO items or purchase orders. 

 

Date Box 

Issued...Only POs that have been issued within this date range will be shown. You would 
typically enter a date range if you were checking for items that had been issued within a 
certain date range and have still not been received from the vendor. This option is only 
available if you have checked issued purchase orders.  

Event...Only PO items for events within this date range will be shown. You would typically enter a 
date range since you don’t want to see un-issued PO items for events still months away.  

Confirm...Only purchase orders that have a confirmation date within this date range will be 
shown. You would typically enter a date range if you are checking to make sure that all 
items have been received from the vendors on the dates they confirmed. This option is 
only available if you have checked issued purchase orders. 

 

Other Criteria 

Limit to category...You can choose to only see PO items for a certain category. For example, 
you may have a category for bridesmaid dresses and another for wedding dresses. In 
this case, you can select the category for wedding dresses to just see those PO items. 

Limit to vendor...You can choose to only see PO items for a certain vendor. 

Limit to style code...You can choose to only see PO items for a certain store style code. 

Vendor style code...You can choose to only see PO items for a certain vendor’s style code.  

Limit to store(s)... By default the store the Register is assigned to that is running the report will 
default.  A user with VIEWSTORES security permission may change the store for the 
report. 

Note 

Items ordered for an event will only display to stores that own the event, EVEN if the PO 
item was created at another store.   The concept is that the store who created the event is 
ultimately responsible for managing the POs. 

 

Show Special Order items (checkbox)...Check this to show special order PO items. 

Show Stock Order items (checkbox)...Check this to also show stock PO items. 

Show items w/Confirm dates (checkbox)...Check this to also show items that have been 
confirmed. 

Show items w/o Confirm dates (checkbox)...Check this to also show items that have not been 
confirmed. 
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Buttons 

Update button...WinPOS® will analyze your PO items and display the Purchase Order/Item 
Work form with the PO items based on your selections. 

Cancel... Stop and return to previous form. 

Issue Purchase Order/Item Work Form 

Main->Purchase Orders->Issue Purchase Orders->Purchase Order Search Update 
 

The Purchase Order/Item Work form is an on-screen worksheet that displays information 
matching the criteria entered within the Purchase Order Search form. The information displayed 
will be Issued Purchase Orders (Open POs), i.e. POs have been printed, but NOT received OR 
UN-Issued PO items, i.e. items to be ordered that are not on a PO yet. The information 
displayed may also be printed for a hardcopy worksheet. 

The form is designed to be fast & efficient tool to manage the creation and follow-up of 
Purchase Orders. From a single on-screen worksheet the operator can make intelligent 
decisions on the proper course of action. To issue the special order for the customer OR to 
follow-up with a manufacturer of a issued PO for some reason. 

Purchase orders can be emailed to vendors as well.  If email is enabled in WinPOS, it will 
prompt "Send PO's to vendors with email addresses on file?"  Answering yes will cause the 
program to check the vendor for each PO printed, and if the vendor has an email address set 
up, it will create an email with the PO attached as a PDF and send it to the vendor. 

The work form will behave differently depending on the display/search settings of Un-Issued PO 
Items vs Issued POs. The behavior of each is defined within this topic. 
 

Un-Issued Items Selection 

This selection will show unissued PO items grouped by event in an outline.  

The first level of the outline is events. For each event, the second level shows the PO items for 
that event. To show the PO items level within the 2

nd
 level, click the + next to the event number. 

To hide the PO items, click the -. 

Click the little box to the left of the item to insert a check. This indicates to the system to put the 
item onto a printed Purchase Order. Click once and a checkmark appears. Click again and it 
disappears. Items with the check mark will be issued when the Issued button is clicked. Click 
next to the event number to automatically check all the PO items for that event.  
 

Buttons 

Event selected (1
st
 level selection) 

Show Event/Detail… This action will display the event registration form for the selected event.  
 

Item is selected (2nd level selection) 

Show Ticket button...This will display the ticket where the selected PO item was sold. This is 
useful to review the details of the sale. 

Show Item button...This will display the PO Item Maintenance form for the selected PO Item.  

Show Cust. Button...This will display the Customer form for the customer who purchased the 
selected PO item. 

 

Event or Item level is selected 
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Check all...This will mark all purchase orders items within the worksheet to be issued when the 
issue button is clicked.  

Uncheck all...This will uncheck all purchase orders items within the worksheet so that no 
purchase orders will be purchased when the issue button is clicked.  

 

Issue button...This will issue/print purchase orders for the selected/checked PO items. The user 
will be prompted for specific information about printing the PO.  The PO will print once 
this information is supplied.  The required information is: 

Requested Ship Date 

• Ask me for each Purchase Order: WinPOS® will prompt for a requested ship date as 
each PO prints. 

• Use this date for ALL Purchase Orders: WinPOS® will use the date entered for 
every purchase order created. 

• Use the Event Date minus: WinPOS® will subtract the number entered from the 
event date and use that. For example, if you enter 90, WinPOS® will use a 
requested ship date of 90 days before the event. 

• Leave blank for ALL: WinPOS® won’t put a requested ship date on the PO. 

Ship Method 

A Ship Method should be put on the PO. Examples are: Best Way, Ground, Overnight.. etc. 
The ship method entered will be printed on each PO. 

 

Group Methods - When Printing Stock POs 

This option is utilized when the items selected for printing are being ordered for inventory 
stock.  The setting is ignored. if the items being ordered are customer special orders.  

• Print one PO for each vendor and style.   

• Print one PO for each vendor and category  

• Print one PO for each vendor.  

Group Methods - When Printing Special Order POs 

This option is utilized when the items selected for printing are being ordered for customer 
specials.  The setting is ignored. if the items being ordered are for inventory stock. 

• Create one PO for each event, vendor & vendor style. This is the PO grouping most 
used for bridal shops.  

• Print one  PO for each event & vendor.  Multiple styles for the vendor would be 
printed for each event.  Nice when printing orders for two part bridesmaid gowns 
(top style & bottom style) 

• Print one for each vendor. All styles across multiple customers & events will be 
printed on one PO. 

PO # Prompt 

Prompt for PO number... The user may manually enter a unique PO number for the order being 
printed.  BBL suggests that users allow WinPOS to auto-create the PO number. 
 However, circumstances occur when a the PO number should be manually entered. 
 These PO number must be unique,i.e. the number cannot be in use on any other PO. 

 

The operator has the option to preview all the POs to the screen prior to printing. 
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Smart Link 

If any vendor has a Smart Link username/password or a PO email set up, the program prompts 
"Send/Email PO's if possible?" 

If No, the ProfitSystem will simply issue and print and purchase orders. 

If Yes, and only a PO email is set up, the program will generate a PO number and issue the PO. 
 It will then convert it to a PDF and attach it to an email.  The user is prompted to type the 
text for the email body, and the email is sent. 

If Yes, and a Smart Link username is enter for the vendor: 

1. It will generate a PO number and issue the PO. 

2. For each PO, it will prompt for the requested ship date, shipping method, and 
shipping speed (Rush or Regular) 

3. It will then send each PO in turn to the correct vendor.  The vendor will validate 
the requested ship date, vendor styles, sizes, and colors.  If the PO is not 
accepted, an error message from the vendor is shown, stating what needs to 
corrected before the PO can be accepted.  If the PO is accepted, no message is 
displayed.  In either case, the PO is issued in the ProfitSystem. 

4. If the PO is accepted, and the total price returned from the vendor differs from the 
PO price in the ProfitSystem, a To-Do is created for the Ordering manager. 

5. Once all the POs have been sent, a final summary report is shown, indicating 
which POs were accepted and which were not.  This report can be printed using 
the Print button. 

6. If a PO was not accepted, the style, size, and/or colors can be changed on the 
ticket, which will update the PO itself.  The user can then go to View Purchase 
Orders and either re-print to PO and fax it in, or re-send it via Smart Link. 

Search...Displays the Purchase Order Search form to allow for a new set of display criteria to be 
entered. The worksheet will clear & redisplay the information matching the new criteria 
entered. 

!Codes... Hover the mouse pointer over the !Codes label for a description of the !Codes that 
appear in the note column next to a PO item.  Below are the !Codes definitions. 

Print...Prints the displayed information. The user will be prompted ‘Show Details for each 
member?’. Answer YES to see the maximum amount of information about each item to 
be ordered grouped by event (if any assigned) and customer. 

Done…Exits the screen 
 

Form Columns 
 

Un-Issued PO Items Selection 

Event is selected (1
st
 level selection) 

Event number, Name, Type, Date...This is the event information. 

#M...Number of Members. This is the number of customers that appear on the Members Tab of 
the Event form for this event. 

#P...Number of Purchases. Of the members above, this is the total number who have a ticket for 
this event. If they have a ticket, it means they have purchased something. 
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#D...Number of Down payments. Of the tickets counted above, these is total number that have 
paid their down payment. The down payment percentages are defined separately for men 
and women on the System Setup form, Other Settings Tab. 

Notes...Indicates a suggested action. 

• !H   Held:  Held.  The sales TICKET is marked held from the sales ticket by clicking 
the PRINT button and selecting eMail Receipt and Hold.  When this is done the !H 
code appears as a message to clear reason for HOLD before issuing PO.  Most 
likely the consultant is waiting on the proper signatures or confirmations from the 
customer.  Once all is OK, the ticket HOLD can be released by entering the ticket 
and clicking the Un-Hold button found to the right of the item grid.  Tickets marked 
HELD will appear in the follow-up modules found under Main Switchboard-> Files-> 
BM Follow-up and Bridal Follow-up.  The words Ticket HELD will appear next to the 
customer name. 

• D ##  Discontinued:  The inventory has a discontinued date entered that is within 
60 days of the current date the report is being ran.  The # is the number of days until 
the item becomes discontinued. 

• !D  Discontinued:  The item is marked discontinued in the Retail Inventory.  It may 
not be able to be ordered from the manufacturer. 

• !L  Late : The event is getting close and the PO has not yet been issued. If the 
number of days before the event is less than the number of days specified on 
System Setup form, Other Settings Tab, this alert will appear. 

• !C   Cancelled: The sales transaction on the ticket has been cancelled. 

• !I   Issue Now:   Each member has a purchase, and has paid their minimum down 
payment 

• !X  Extra Charges:  The item has extra charges linked to it. 

Show Event button...This will display the Event form for the selected event. 

Each event within the form, can list all members of the event whether or not any items have 
been purchased for special order.  This is a great tool to see if the current member orders can 
be ISSUED or must wait for other members to place orders. 

 

PO item is selected (2
nd

 level selection) 

Item number...The PO item number. 

Customer...The customers name. 

Role...Their role in the event. 

Vendor...The vendor who will supply the item. 

Style, size, color...Vendor style, size, and color for the item to be ordered. 

Paid...The % of down payment paid. 
 

Open Purchase Order Selection 

This selection will display Open Purchase Order items grouped by Purchase Order number. 
Open PO’s are items that have been issued (printed) but not received. 

The first level of the outline is Purchase Orders. For each Purchase Order number, the second 
level shows the PO items on that PO. To show the PO items level within the 2

nd
 level, click the + 

next to the PO number. To hide the PO items, click the -. 

Attempting to check the box next to each item has no effect in this mode. 
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Buttons 

PO Number is selected (1
st
 level selection) 

Show PO button...Displays the PO Maintenance form for the selected PO. 
 

PO Item is selected (2
nd

 level selection) 

Show Ticket button...This will display the ticket where the selected PO item was sold. This is 
useful to review the details of the sale. 

Show Item button...This will display the PO Item Maintenance form for the selected PO Item.  

Show Cust. Button...This will display the Customer form for the customer who purchased the 
selected PO item. 

 

PO or Item levels selected 

Search...Displays the Purchase Order Search form to allow for a new set of display criteria to be 
entered. The worksheet will clear & redisplay the information matching the new criteria 
entered. 

Print...Prints the displayed information. The user will be prompted ‘Show Details for each 
member?’. Answer YES to see the maximum amount of information about each ordered 
item grouped by PO Number and customer. 

Done…Exits the screen 
 

Form Columns 

PO Number is selected (1
st
 level selection) 

PO Number...The list is grouped by purchase order. Click the + next to a PO to see the line 
items. Click the – to hide them. 

Event Name, Date...This is the event information. 

Issue Date...The date the PO was created. 

Confirm Date...The date the PO was confirmed with the vendor. 

Vendor...The vendor who received the PO. 

Notes...Any special information about the PO is shown here. If the PO needs to be issued based 
on the setting “Warn user if a PO is unissued and the event is less than x days away” on 
System/Store Setup-Other Settings Tab, then the notation !DANGER! appears here. If 
the PO is ready to print because the all the members of the event have paid their 
downpayment, based on the “For bridal special orders: Issue PO when each member has 
paid at least x% down.” Setting in System/Store Setup-Other Settings Tab, then the 
notation !ISSUE! appears here. 

 

PO Item is selected (2
nd

 level selection) 

Item number...The PO item number. 

Customer...The customers name. 

Role...Their role in the event. 

Vendor...The vendor who will supply the item. 

Style, size, color...Vendor style, size, and color for the item ordered. 
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Printing Purchase Orders 

Specials - Purchase Order 

Purchase orders, both stock & specials are printed from the Issue Purchase Order/Item Work 
Form.  

Purchase Order Editing 

View Purchase Orders Maintenance 

Switchboard: Main->Housekeeping->View Purchase Orders  

Menu: PO/Ship->Purchase Orders 

Action: POMAINT 
 

Purchase Orders are created from the Purchase Order/Item Work form from PO Items created 
on Sales Tickets (special orders) and within the PO Item Maintenance form (stock orders).  

PO Numbers are automatically assigned to each PO created. 

The PO Maintenance form allows edits to the Purchase Order detail which is primarily used to 
enter confirmation date/details. It also allows for the review of all the information pertaining to 
the Purchase Order. 

This form is also utilized to receive purchase orders from the manufacturer, stock and special 
orders.  

WinPOS® knows which POs are for customers and which are for stock. The Receive function 
will automatically put specials into pick-up inventory and stock orders into inventory and insert 
receive date, last received date, invoice and last received qty into the PO detail. 

Hint: 

To delete a customer special order when the PO is issued and the PO contains only the one 
item being cancelled: a) cancel the item on the sales ticket b) find the PO in PO Maintenance 
and click the un-issue button c) find the Item in PO Item Maintenance then click the delete 
button for it to permanently go away. 

PO Maintenance consists of three tabs of information. 

List Tab 

The List tab of the Purchase Order Maintenance form contains a special checkbox. 

Show open purchase orders only?...If checked, the search list will only show purchase orders 
that have not yet been fully received. That is, the received date is empty. 

 

PO Maintenance buttons common to all tabs 

Print button...This is used to reprint the Purchase Order or print a Purchase Order Recap (for in-
house use), or send a PO via Smart Link. The Purchase Order Recap includes any notes 
entered on the Purchase Order, whereas the purchase order includes the Purchase 
Order Document Terms. The re-printed purchase order will include the quantity ordered 
versus the quantity received if any items have been received. If no item has been 
received, only the quantity ordered will print. 
 
If a Smart Link username is entered for the vendor, then the Smart Link button is 
enabled.  A warning is displayed If the PO has already has a confirmation number, but 
the PO can still be sent.  If the PO is accepted then the confirmation date and 
confirmation number are filled in automatically. 
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Receive PO button… This button is only enabled if this purchase order has not yet been 
received. You click this button to display the Receive form, which lets you select the 
items to receive and print tags for them. If there is more than one item on the PO you can 
select only the items that have been received. The items are automatically added to 
pickup or permanent inventory (for special orders and stock orders, respectively.) 

Un-issue …This is used to “un-issue”  a PO. When the PO is un-issued, it just clears the PO 
number from the PO so it can be re-issued at a later date. 

Force PO closed…This is used to mark the PO as received even though all the items have not 
yet been received on the PO. This would be used for any PO where the vendor only 
ships part of the order and indicates that the remaining open items will not be shipped. 
 When this button is used the current system date will be inserted into the 'Date PO 
Received' field & changes the quantity to receive value to zero. 

Done…Exits the form. 

PO Maintenance - Details Tab 

Switchboard: Main->Housekeeping->View Purchase Orders->PO Details Tab 

Menu: PO/Ship->Purchase Orders->Details Tab 

Action: POMAINT 

 

Detail Tab 

The PO Maintenance Detail tab displays information about the purchase order that was selected 
from the Purchase Order Maintenance list tab. 

PO Number...This PO number is created automatically by WinPOS®, and is your store code 
followed by a sequence number. You cannot change the PO number. 

Event name...If this PO is for an event, the event name appears here. If no event name appears 
here, then it means that when this item was sold on a ticket, the ticket was not linked to 
an event. Once the PO is created, you can’t change the event. You can double-click on 
the event name to view the Event form. 

Event date...The event date, taken from the Event form. 

Req. Ship date...The Requested Ship Date. This is the date you tell the manufacturer to ship the 
item to the shop. The requested ship date is entered when the Purchase Orders are 
printed. 

Req. Ship Speed...Rush or Regular.  Only enabled for Smart Link vendors. 

Req. Ship method...The Requested Ship Method. This is the method you want the manufacturer 
to ship the item to the shop. The requested ship method is entered when the Purchase 
Orders are printed.  If this vendor set up for Smart Link, then the requested shp method 
must be selected from a list of valid ship methods. 

Store number...The store code for the store that created this PO. Only relevant if you are using 
the Multi-Store Integration. 

Issue date...Until you issue a PO there are only PO item numbers so this actually represents the 
date the PO was created. WinPOS® inserts this date automatically. 

Confirmation Shipping date...The Confirmation Received Date. This is the date the 
manufacturer has committed to ship the garment to you.  

Confirmation number...The Manufacturer’s Confirmation number. If a manufacturer gives you a 
confirmation number for an ordered item, enter it here.  If the PO was sent via Smart Link 
and accepted, the confirmation number is filled in automatically. 
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Date PO received...The date that the PO was fully received into inventory (permanent or pick-
up). If this PO is only partially received, this date is blank until the last item arrives. 

Sent via SmartLink...The date the PO was sent to the vendor via Smart Link.  This is filled in 
automatically if the purchase order is sent via Smart Link and accepted by the vendor. 

Invoice number...The actual invoice number from the vendor. This is typically captured when the 
item is received. 

Total cost...The total cost for all the items on this PO. 

Items Grid...This list shows all of the line items on this PO. You can select an item in the list and 
click on the Item Details Tab to show all the details for that item. 

• Item number: This is the PO item number automatically generated by WinPOS® when 
the item was originally sold and you indicated that it should be special ordered. 

• Qty: The quantity ordered. 
• Vendor: The vendor for this item. 
• Style, Size, Color: For the item ordered. 
• Customer: The name of the customer this item was ordered for. For stock orders, the 

customer name is Stock Order. 

Buttons 

Notes ...You can enter any special notes about the PO here. These notes are not printed on the 
PO itself. They are however, printed on a PO Recap. They are for your own internal use. 

Add RCR ...This function is available when an item is received and in Pickup Inventory.  It allows 
for the creation of an RCR record for the selected item. 

View/Edit SCW ...Available on stock orders. This button display the actual sizes/colors/widths 
ordered on a stock PO.  On a stock PO, the Items grid shows each style ordered, but not 
the sizes/colors/widths.  Click on the line item in the grid and click this button to display 
the actual sizes/colors/widths.  Size and/or colors may be edited on stock orders once 
they are issued since many times substitute sizes or colors may be accepted. 

Go to Pickup Inv...This button will display the Pickup Inventory record for the highlighted PO 
Item within the PO Maintenance Grid. 

Go to Style...This button will display the Inventory record for the highlighted PO Item within the 
PO Maintenance Grid. 

 

PO Maintenance - Item Detail Tab 

Switchboard: Main->Housekeeping->View Purchase Orders->Item Details Tab 

Menu: PO/Ship->Purchase Orders->Item Details Tab 

Action: POMAINT 
 

Item Detail Tab 

To view all the details for a line item on a PO, select the item on the PO Details tab and click the 
Item Detail tab. This is used to easily review the item details. To create a new PO item manually 
(for a stock order) use the Purchase Order Item Maintenance form, located at Main-
>Housekeeping->View PO Items. 

Note 

When a PO Item has been received, then set out of the store via the RCR module, a alert 
message will display in the bottom left portion of the form. 
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Form Fields 

PO number...This PO number is created automatically by WinPOS®, and is your store code 
followed by a sequence number. You cannot change the PO number. 

PO item number...This is the PO item number automatically generated by WinPOS® when the 
item was originally sold and you indicated that it should be special ordered. 

Customer...The name of the customer this item was ordered for. For stock orders, the customer 
name is Stock Order. You can double-click on the customer name or number to view the 
Customer form. 

Date PO item created...The date the item was originally sold to the customer. 

Quantity...The total quantity outstanding. This is the original quantity ordered minus the total 
quantity received.  Each time quantities are received this number would decrement and 
the Date last received will automatically update with the system date. 

Original quantity ordered...The original PO quantity of this item ordered. 

Vendor number...The unique vendor number that is supplying this item. 

Vendor style...The manufacturers style number.  

Style code...The store style number for this item. 

Description...The description for this item. This comes from the Retail Inventory. 

Category, sub-category...The inventory category and sub-category for this item. This comes 
from the Retail Inventory. 

Size, Color, Width...For the item ordered.  These fields are blank for Stock Orders.  A user must 
click the View/Edit SCW button to see the colors & sizes ordered. 

Date received...The date that this line item was fully received. That is, the total quantity ordered 
was received. If you’ve only partially received this item, the date last received will show a 
date, but this field will be empty. 

Date last received ...The date you last received any quantity on this PO item. 

Last quantity received...The quantity you received the last time you received anything for this 
PO item. 

Total quantity received...The total quantity you’ve received for this item. Between these fields 
and the Original Quantity Ordered (explained above), you can determine if all items 
ordered have been received or not. If, say, a PO was created for 5 items but only 3 have 
been received so far. These fields would indicate how many have been received so far 
and the date the item was last received.  

Unit cost, Extended cost...Your unit and extended cost for this item. 

Special instructions...These are the special instructions for the manufacturer. If this is a special 
order item, these are the special instructions you entered at sale time. 

Buttons 

View/Edit SCW button...This button display the actual sizes/colors/widths ordered on a stock 
PO.  On a stock PO, the Item Detail tab shows each style ordered, but not the 
sizes/colors/widths. Click this button to display the actual sizes/colors/widths. 

Un-Receive button…This is used to “un-receive” items from a stock PO. When items are un-
received the quantity outstanding (still on order) is incremented. When this option is 
selected the size matrix for the stock order is displayed. The quantities to be un-received 
are entered into the correct cells in the size matrix. Click Done on the matrix to complete 
the process. This option can only be used if some quantity of items has already been 
received. 
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Extra Charges... For special ordered items.  Extra Charge button letters will display in BLUE 
when Extra Charge transactions are present.  Click the extra charge button to see a list of 
Extra Charges attached to this item.  Double click the Extra Charge to edit.  Once 
selected the Extra Charge may be deleted or any of it's details modified which will be 
reflected on the PO when printed and customer sales receipt.  Extra Charges may be 
edited from the customer ticket as well.  Review the Extra Charge topic for more 
information. 

Hint: 

Be careful of editing extra charges for special orders once POs are printed.  The ordering 
information may be with the vendor and cannot be changed. 

View Purchase Order (PO) Item Maintenance 

Switchboard: Main->Housekeeping->View PO Items  

Menu: PO/Ship->PO Items 

Action: PIMAINT 
 

This form allows special ordered item details to edit prior to issuing it on a PO.  It also allows for 
the creation of items to be ordered for stock inventory.  All PO Items are displayed within this 
grid (whether issued onto POs or not) and can be found by their Item number.  

This PO Item Maintenance form allows edits to the un-issued PO Items. 

UPDPOITEM security is required to edit, add, or delete PO Items. 

Note 

When a PO Item has been received, then set out of the store via the RCR module, a alert 
message will display in the bottom right corner of the form as reference. 

 

Special Orders 

PO items are usually created from sales tickets when the item’s status is set to Order. These 
orders are often referred to as Special Orders. Once a special order item is created, it's details 
may be edited from this form. 

PO Item Numbers for Specials can be found on the sales ticket, Events-> Spec Orders / Pickup 
tab  or Customers-> Spec Orders / Pickup tab or Purchase Order/Item Work form. Each can 
take you to this Item Maintenance form. 

 

Stock Orders 

A PO Item entry must be created for Stock Orders as well. Stock Order items are created via 
this form. See the Stock Purchase Overview for more information. The system automatically 
assigns a Item Number (an item number is comparable to a sequential serial number) to each 
item when it is created.  

IItem numbers for Stock Orders can be found on the Purchase Order/Item Work form. 

 

Field Definitions 

PO item number...This is the PO item number automatically generated by WinPOS® when the 
item was originally sold and you indicated that it should be special ordered.  Double-click 
on this field to display the ticket containing the PO item. 
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Customer...The name of the customer this item was ordered for. For stock orders, field is not 
shown. 

Event...The name of the event this item was ordered for. For stock orders, field is not shown. 

Date created...The date the PO item was created. For a special order, this is the date it was 
originally sold to the customer. For a stock PO item this is the date is was added. 

Quantity...The total quantity outstanding. This is the original quantity ordered minus the total 
quantity received. 

Orig. quantity...The original quantity of this item ordered. Works in conjunction with the Last 
Received Date/Quantity field (discussed later). 

Vendor number...The unique vendor number that is supplying this item. 

Vendor style...The manufacturers style number.  

Style code...The store style number for this item. 

Description...The description for this item. This comes from the Retail Inventory. 

Category, sub-category...The inventory category and sub-category for this item. This comes 
from the Retail Inventory. 

Sales Associate...The clerk who created the PO item. 

Size, Color, Width...For the item ordered. 

Size, Color, and Width chart...These fields only appear for stock PO items and must be filled in 
to create the stock PO item.  

Date received...The date that this line item was fully received. That is, the total quantity ordered 
was received. If you’ve only partially received this item, the date last received will show a 
date, but this field will be empty. 

Date last received ...The date you last received any quantity on this PO item. 

Last quantity received...The quantity you received the last time you received anything for this 
PO item. 

Total quantity received...The total quantity you’ve received for this item. Between these fields 
and the Original Quantity Ordered (explained above), you can determine if all items 
ordered have been received or not. If, say, a PO was created for 5 items but only 3 have 
been received so far. These fields would indicate how many have been received so far 
and the date the item was last received.  

Unit cost, Extended cost...Manufacturers unit and extended cost for this item. 

Special instructions...These are general instructions to the manufacturer concerning the item 
being ordered.   Typically these instructions are entered from the sales ticket when the 
sale is being created.   These instructions are normally printed onto the customer receipt 
for the customer to see and approve. They may be edited from this form.  These are 
printed onto the PO when it is created. 

Private Instructions ... These are detailed instructions to the manufacturer concerning the item 
being ordered.   Typically these instructions are entered from the sales ticket when the 
sale is being created and are NOT seen by the customer.  They may be edited from this 
form.  These are printed onto the PO when it is created. 

Notes... General comments about the item.  These comments are maintained with the item and 
are NOT printed on the PO or customer receipt. 

 

Buttons 
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Matrix button...After filling in the size, color, and width charts click this button to display a matrix. 
You can then enter the quantities of each size/color/width directly into the matrix to create 
the un-issued PO items. 

View/Edit SCW button…Displays the Stock PO Items form (POSCW) A special order PO item is 
a single item (the item ordered by a customer) A stock PO item can be multiple items, in 
various sizes, colors, and widths. The Stock PO Items form shows you these line items. 
Normally, these line items are created when you use a matrix to create the stock PO. 
Alternatively, you can click Add on the PIMAINT form, enter the style code and details, 
and click the View/Edit SCW button to display the Stock PO items form. From there you 
can enter the sizes, colors, widths, and quantities to order. 

Extra Charges... When a item is ordered from a ticket, i.e. special ordered, additional charges for 
changes or add-ons may be applied called Extra Charges.  These charges include a 
retail price and a wholesale cost.  These charges are printed on the PO for this item and 
appear on the customer's sales ticket that created the order.  This button will display the 
Extra Charges and allow for a user to edit or delete them.  Changes to extra charges 
should be done when the PO item is not issued.  However the extra charge wholesale 
cost can be edited at anytime. 

View Ticket... For special order items, ie those created from a customer ticket, this button will 
display the ticket that created the item. 

Delete button…Deletes the displayed/highlighted PO Item. 

Add button…Will add a new PO Item for a Stock Order. Customer/Special Orders are created 
from sales tickets. 

Done button…Exits the form and returns to the previous screen. 

Purchase Order Creation for Stock 

Stock Purchase Order Overview 

Stock purchase orders are used to purchase items/merchandise for stock inventory and are 
created from Purchase Orders->View PO Items->Add button. 

Review the topic View Purchase Order Item Maintenance for more information on the form to 
create Stock Orders or to edit Special Orders prior to printing. 

Stock Orders may be created with or without Size & Color charts, however a Stock order must 
have a SIZE entered. Using Size and color charts will shorten the time needed to add quantities 
to a stock order when multiple sizes and/or colors of the same vendor/vendor style are being 
ordered. 

Stock orders may be received directly into inventory via the Purchase Orders->View Purchase 
Orders->Receive PO option.   

Once a stock PO is issued (printed) it's size or color information may be modified (this CAN 
NOT be done on Special Orders).  To edit one, go to the View Purchase Order form and locate 
the purchase order.  Find the item to be edited on the PO Details tab and click View/Edit SCW. 
 Finally, click Edit items to edit the line items.  Changes are logged  and can be viewed on the 
Log form.  The log entries use the key type of STOCKPOEDIT, and the Log form can be filtered 
to show only these log entries. 

Stock Order creation requires some mandatory information. Review the data requirements 
below. 

Data Requirements: 

• Vendor number (mandatory) 

• Manufacturer style number (mandatory) 
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• Store style number (if item has a inventory style previously assigned in WinPOS; 
entering a inventory store style will speed up the creation process because all the 
required data will automatically be completed by WinPOS® with the information 
entered into the inventory)  This number is validated against the WinPOS inventory 
file and any entry must match a store style entered there.  The Store Style is not 
required and may be entered when the PO item is received during the PO receiving 
module. 

• Description 

• Category (mandatory) 

• Subcategory 

• Size Chart (optional, but speeds up the creation when different sizes of the same 
style are being ordered) 

• Color Chart (optional, requires size charts, speeds up the creation when different 
colors & sizes of the same style are being ordered)Width Chart (if shoes) 

• Unit Cost  

• and any special instructions 
 

Stock Orders are entered individually, then selected for issued. All selected will be printed on 
one PO to each vendor. To generate a Stock Purchase Order: 

 

1.  Click Purchase Orders, then click on View PO Items. 

2.  Click Add. Enter all information needed to generate the Stock P.O.  

3.  The Sales Associate (SA) feild will be automatically populated with the Sales Associate 
(SA) code of the currently logged in user when password/security protection is activated. 

 

To use a Size or Size/Color/Width matrix the Size chart or the Size, Color & width charts 
need to be assigned. 

 

4. Click on the Matrix button. Depending on your charts selected, you will see the Size Matrix 
screen pop-up. Click into the square corresponding to the size and color you wish to order 
and enter quantity to order.  

 

To enter the size and colors without a matrix  

 

5. Click the View/Edit SCW button and enter the size, color and quantities to order for each. 
   Click on Done to save & exit the form.  
 

8. To enter another item, repeat steps 1 thru 5. 

9. Click Done to complete the process so you can then issue the POs per vendor. 

 

To Issue a Stock PO: 

1. From the Main Menu click on Purchase Orders then Issue Purchase Orders. 

2. From the Purchase Order Search Menu, check Show Stock Purchase Order Items. 
Click Update. 
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3. Click on the + sign next to the Stock Order row to display a list of all Stock PO items 
needing to be issued. Locate the items to issue and double-check the boxes on left 
of those entries to enter a check, indicating that item is to be printed on a PO. 

4. Once completed marking all the items to order.  Click Issue.  

5. Enter Shipping Information,i.e. method and requested date. Click Ok. 

6. Select the purchase order terms to print (only will be prompted when several are 
entered within the system), Click Ok to print the PO. 

7. After the PO(s) print, click Done to exit 

To Receive a Stock PO: 

1. Receive via the View Purchase Order form by clicking the Receive PO button.  For 
more information please read help concerning the Receive form. 

Purchase Order Reports 

Un-Issued Purchase Order Report 

This report is a printout of the information that displayed on the Issue Purchase Order/Item 
 form.  Click the update button after selecting UN-ISSUED POs in the Show section of the report 
criteria.  When displayed to the screen click the PRINT button.   

 

Open Purchase Order Report 

This report is a printout of the information that displayed on the Issue Purchase Order/Item 
 form.  Click the update button after selecting ISSUED POs in the Show section of the report 
criteria.  When displayed to the screen click the PRINT button. 

Purchase Order Listing Report 

Switchboard: Main->Reports->PO Reports…->Purchase Order Report  

Menu: Reports->Purchase Orders Reports->Purchase Order Report  

Action: RP_POISS 

 

This report displays/prints a listing of  PO items per the criteria entered by the user.  It is a 
helpful tool to review on PO activity, follow-up on outstanding POs and to determine upcoming 
costs once the orders are received.   

The report is grouped by event with stock orders being listed at the top of the report (when the 
Stock Order checkbox is checked).   

The report detail includes, Event # & Event name.  The PO item number, event date, customer 
name, last transaction date, vendor style, size, color, width, vendor code, role, item cost, 
confirmation date/#, date received, quantity ordered, quantity received and percentage of total 
ticket paid by customer and special instructions are included on report. 

If outstanding cost is selected then the report shows only the cost of un-received line items on 
stock orders, since a stock order can be partially received.  A special order PO item is 
completely received or un-received so this setting has not effect on them. 

This report offers many criteria options to filter the report.  It is easy to enter a criteria 
combination that will result in NO items selected.  Please carefully analyze the criteria to 
achieve the desire results. 

 

Report Selection Criteria 
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Show 

Un-Issued or Issued (checkbox)... One of these check-boxes must be selected.  The report will 
list Open (issued) POs or PO items not yet issued as POs. 

 

Group by 

Vendor... Group & sub total by vendor, 

Category... Group & sub total by category, 

No Grouping.. Chronological list our POs. 

 

Criteria 

Limit to Category...Limit the list to items from the entered category.  A blank field will capture 
ALL categories. 

Limit to vendor...Limit the list to items from the entered vendor.  A blank field will capture ALL 
vendors. 

Style Code...Limit the list to items from the entered inventory style code.  A blank field will 
capture ALL styles. 

Vendor Style Code...Limit the list to items from the entered vendor style.  A blank field will 
capture ALL items. 

Limit to Stores...Available in multi-store installations. Enter store locations and the report will 
limit to the PO items for members of  events where the event was created at the store. 
 When the PO Item is not linked to an event the report will list the PO Item(s) created at 
those store(s).  Multiple stores must be separated by a comma  A blank field will capture 
ALL stores. 

Role...Limit the list to items from for customers in events with the entered role.  A blank field will 
capture ALL customer roles. 

 

Show Special Order (checkbox)...Checked, the listing will include customer special order PO 
items. 

Show Stock Order Items (checkbox)...Check, the listing will include PO items for stock. 

Show Received items (checkbox)? ... Checked, it will limit the report to only those PO items 
that have been marked received,i.e. where the quantity ordered equals the quantity 
 received.  Un-Checked fully received items will not appear on the report. 

 

Date Range 

Issued (for issued POs)... Enter the issued date range for POs issued/created. 

Event (for issued or un-issued)...Enter the Event date range for special order items 
issued/created.  Special order items for customers not associated with an event will 
always be listed no matter what event date range is entered. 

Received (for issued POs)... Enter the RECEIVED date range for POs issued.  

 

Confirmed Options - available for Issued POs listing 

No confirm date...  checked, the report includes items with no confirmed shipping dates entered. 
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Any confirmed date... checked,  the report includes items with no confirmed shipping dates 
entered. 

Confirm date range.. Issued POs with confirmed shipping dates within the date range entered 
are included. 

 

SmartLink - available for Issued POs listing 

All orders...Include all orders, whether or not sent via Smart Link. 

Orders not sent via Smart Link...Filter out any orders sent via Smart Link. 

Sent.. Only include orders if they were sent via Smart Link within the date range specified. 

 

Display 

Total Cost....When selected  the system will display the total original cost of the PO Item 
irregardless of the outstanding quantity. 

OR 

Outstanding cost ..When selected the report lists only the costs for Un-Received PO Item 
quantities.  Un-Received Qty * Unit Cost 

 

Buttons 

Cancel...Exits the PO Report form and returns to the previous form. 

Ok...Processes the report with the entered criteria. 

 

Purchase Order Receiving 

Receive Form 

Switchboard: Main->Purchase Order->View Purchase Order->Receive PO button 

Menu: PO/Ship->Purchase Orders->Receive PO button 

Action: POMAINT 

This form is used to receive items contained on open stock or special purchase orders.  Stock 
POs are received into the WinPOS© Retail/Rental inventory file.  Special Order POs are 
received into the Pick-up inventory file.  WinPOS© will do this automatically. 

Locate the PO number containing the items to be received within the View Purchase Order 
form.  Once the correct PO is highlighted, click the RECEIVE PO button to begin. 

Fields 

Items list...This list shows all the items on the purchase order, even the ones that have already 
been received. 

• Receive? checkbox: Check the line items you want to receive. If a line item has 
already been received, it will be checked automatically. 

• Received: The date this item was received. It is automatically completed by the 
system based upon the last time a quantity was received for this item on this PO. 

Uncheck all button...Will uncheck the Receive? check box for all the items. 

Check all button...Will check the Receive?check box for all the items. 
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Receive button...WinPOS® will receive each checked line item as outlined below. 
 

Receive process for Special Order PO’s 

1. WinPOS® will first ask if you want to print tags for received items. A selection of Yes 
will instruct the system to print the Pick Up tags for ALL the items received. 

2. It will ask for the invoice number, then display the item details for each item on the 
PO.  WinPOS© will print the Pickup tag if instructed to do so in step 1. 

When the operator is logged into this form (by the system asking for SA ID and password) they 
system will record the user and display the ID on the Pickup Inventory form via the Received by 
field.. 

Receive process for Stock PO’s 

1. WinPOS® asks for a store style number for the item. If you enter a store style 
number that already exists, WinPOS® will add this item to the existing style. 
Otherwise, WinPOS® will create a new style code using the code entered by the 
user when prompted or it will generate a new serial number style code upon user 
request, either via the form prompts. 

2. It will then display the item details and ask you for the invoice number. 

3. Next  will display the matrix for the item so you can enter the quantities actually 
received. The matrix cells will default to zero quantities. Input the quantities being 
received for each size/color/width. 

4. Once quantities are accepted the system will display the inventory style form so 
additional info may be entered when needed. 

5. Upon the completion of the receive process the system will re-display the PO’s 
details form. 

 

PO Alerts 

Switchboard: Main->Purchase Order->PO Alerts 

Menu: PO/Ship->PO Alerts 

Action: none 

 

This option will display any TO DOs created and assigned to the role ORDERING role.  Sales 
Associates may manually create TO DOs that should be reviewed by the personnel responsible 
for customer merchandise ORDERING or the system may automatically create TO DOs when 
sales tickets or wedding dates are modified and items are ordered. 

When open TO DOs exist the PO Alert button will be blue.  Please review the TO DO topic for 
more information, particularly those actions that create ordering TO-DOs.. 
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Register Operations 

Open / Close the store 

Opening & Closing the Store Overview 

 

WinPOS© offers flexibility in how to end the day's business (close) for a store.  Management of 
the store would configure the system that best meets the store's needs.  These options are set 
in the housekeeping-> General Setup-> System Setup-> Options Tab via the prompts "Don't 
prompt user to confirm date at startup?,  Require registers/store to be closed?, Close all 
registers at once?" 

The options are: 

Store Open 

Store open is comprised of setting the business date for ticket transactions to be associated 
with.. 

1)  Automatically open the store each date change, when the first register logs into WinPOS for 
that new date. - Don't prompt user to confirm date at startup? checked 

2)  Manually open the store for all registers when the first register logs into WinPOS and 
confirms the business date by displaying the Opening the store form. - Don't prompt user to 
confirm date at startup? unchecked 

 

Store Close 

A close is comprised of a formal reconciliation of cash & remaining tender methods.  The close 
is logged and any over/under amounts are clearly identified. 

1)  Close each register individually. - Require registers/store to be closed? checked &  Close all 
registers at once? unchecked 

2)  Close ALL registers within a store via one close step. -  Require registers/store to be closed? 
checked & Close all registers at once? checked.  Closing the store from a single register will 
require all other Register/Workstations to exit the WinPOS system.   The Register/Store Status 
form may be used as a tool to learn which Registers are still active within WinPOS so the 
appropriate action may be taken by the operator to have those Registers log out. 

3)  Do not require a WinPOS formal close.-  Require registers/store to be closed? unchecked 

For options 1 & 2 above, the program will force that the registers and store to be closed 
correctly by comparing the current date to the date of the last close.  When the program is 
started it checks the current date, according to the computer, and checks if there was a close for 
the prior date.  If not, it will stop and force the user to close the register and store correctly 
before it will run.  The user can bypass this close if they have FORECECLOSE security.  In this 
case, a closing is created, but all the numbers are zero.  Also, a log entry is created, using key 
FORCECLOSE to indicate who forced the store closed.  Once the store has been forced closed 
for the prior day, it can be opened for the current day. 

Workstations/Registers may re-access the WinPOS system after the store is closed without 
reopening for a new day.  However, operation in "Store Closed" mode the system will not allow 
financial transactions to be added or modified on tickets (includes changes to any form that may 
auto generate financial transactions.). 

Once a store is closed it may be reopened for a the same date that has been previously closed. 
 So if the store needs to enter additional transaction after being closed it must opened for the 
next business day. 
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Typically, a store that does not perform the formal WinPOS close process would print daily, as a 
minimum, the Revenue Report and Payment by Type report to reconcile the monies at the end 
of day.   

 

 

WinPOS© considers terminals 'REGISTERS' and each has to be defined within the Register 
Setup form.  The REGISTER word/term is short for 'Cash Register' and symbolizes a device 
where money & sales will be transacted. 

Note 

The Accounting / Business date is the date where all sales, adjustment & payment 
transactions are being recorded to.  It is NOT the computer date even though the computer 
date and the accounting /business date are the same date in most circumstances. 

Individual registers are closed at the terminal / register being closed via the Close Register 
function OR from any terminal / register via the Register Status function. 

 

There is not a right or wrong selection for opening & closing the store.  It should be set to the 
preference of your store.  The preferences may be modified at anytime, as the store's needs 
change. 

 

 

 

Opening the store 

 

The Opening the Store form is displayed when the "Confirm business date" is enabled in 
System Setup for the business.  WinPOS© will automatically display the 'Open Store' form to 
the first Register as it logs into WinPOS.  This form is displayed when the current computer's 
system date is different than the previous WinPOS business date.  

Complete the form to complete the store opening.  This process sets the business DATE to the 
date the user accepted/entered into the Open Store form.  The business Date and the 
computer's clock/system date may be different dates, but usually are the same date.  A store 
may be opened on a business date that have been previously closed.  When a business date is 
entered/accepted of a previously closed business the system presents an alert of the business 
date has been closed.  A user may move about the WinPOS system, but may not edit or create 
new financial transactions.  HOWEVER, the store may be REOPENED for the business date by 
the user entering the Register functions menu and choosing Store Open.   

See the FAQ "How do I change the WinPOS business date" for additional information. 

 

To open the store  

1. Enter your sales associate ID in the Sales Associate field. 

2. Enter/Confirm the WinPOS business date. 

3. Click the OPEN STORE button.  

4. If this is the first time you are running WinPOS® or you have not set up the sales 
associate’s information yet, enter MANAGER and click OPEN REGISTER. 

Form Fields 
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WinPOS business date was..   This is  the prior business date and shown for reference. 

Computer date is... The current computer date. 

 

Closing/Opening the store  

Switchboard: Main->Register Functions->Store Close  

Menu: File->Register/Store Close or Open 

Action: CLOSE 

 

Overview 

The Closing the store option is available when the Housekeeping-> General Setup-> System 
Setup-> Require registers/store to be closed? is enabled. 

Closing is the process of reconciling the monies transacted during the business.  Use this 
feature to close individual registers/stores for a the current business day. 

Entering this menu option will close the individual Register currently that the close is being 
performed from OR the entire store (controlled by a system setting) at the end of the business 
day.  

The closing process is necessary so that the cash drawer(s) may be reconciled and the system 
can close out the accounting period for that business day.   

The accounting date/period is not closed for the store until ALL registers defined for that store 
are closed.  The 'Closing the Store form displays all the recorded receipt transactions for a 
register / store. 

The system displays the receipt transactions recorded throughout the day in the WinPOS 
Count column.  The user will enter the actual count in the Drawer Count column.  The system 
will calculate a variance between the WinPOS© Count and Drawer Count and display any 
variance in the third column.  

The user must perform an actual count of the receipts.  Any variances/discrepancies between 
the system totals and the actual count should be corrected before closing.  If the variance can't 
be corrected the system will make note of it on the revenue report. 

The Revenue report is an accounting report and offers additional detail and compliments the 
Daily Register Report or Revenue Listing Report. 

A store may be re-opened on a business date that have been previously closed.  When a 
business date is entered/accepted of a previously closed business the system presents an alert 
of the business date has been closed.  A user may move about the WinPOS system, but may 
not edit or create new financial transactions.  HOWEVER, the store may be REOPENED for the 
business date by the user entering the Register functions menu and choosing Store Open.   

To close the register/store  

1. Enter appropriate Paid In or Paid Out amounts via those forms 

2. Click on Store Close & start by the operator entering their sales associate ID in the 
Sales Associate field. 

3. Perform a CASH tender count and enter the actual count the cash Drawer Count 
field. The Cash count bill/coin count aid may be used to help count the money and 
it's total is automatically entered. 

4. Enter the cash Drawer End (the amount of cash remaining in the drawer) 
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5. The system displays the transactions recorded for the other non-cash tender types 
in the fields listed by each tender type  under Computer count.  Enter the drawer 
count for each. 

6. Once all totals are satisfactory, press CLOSE STORE to close the register (set for 
next period's business) and print the Closing Reports.  Click on DAILY REGISTER 
REPORT to print a closing report.  Click CLOSE STORE to exit and return to the 
previous menu. 

The formulas utilized by the STORE CLOSE form are: 

 

+Paid Outs 
(show as 
negative 
number_ 

+ Drawer 
Count 

+ Cash 
Count 

+ Drawer 
End 

+Paid 
In/Petty 
Cash 

- 
Comput
er Count 

+ Paid 
In/Petty 
Cash 

-  Drawer 
Start 

+POS Cash 
payment 
transactions 

- Drawer 
Start 

- 
Draw
er 
End 

 

= Cash 
Computer 
Count 

= 
Over/Under 

= Cash 
Depo
sit 

= Extra 
Cash 
Held 
Out 

 

Fields 

Security Deposits to be Reimbursed... This section is for stores who utilize security deposits. 
The section displays the anticipated security deposits to be reimbursed for the listed 
days.  These totals are determined according to the return date of rental orders.  It is an 
aid to determine the amount of cash to be withheld from the bank deposit (or to withdraw 
additional money) in order to make security deposit refunds. 

Bill, coin count aid... The user simply counts the number of each bill or  coin type and enter the 
counts in the appropriate field.  The system will automatically multiply and total the values 
and insert the result into the Cash computer count field. 

Paid In / Out... The system display the total paid in / outs as entered into the Paid In & Paid Out 
forms. 

Drawer start... The is the Cash Drawer CASH balance as it was recorded the day before. 

Computer count... This is the net total for each tender type as computed the WinPOS system. 

Over/Under...The difference between the computer count and the manual drawer count. 
 Obviously the goal is not to be under or over.  When the store is under the system will 
require a comment to be entered by the user before the form may be saved. 

Drawer End... The ending Cash in the cash drawer after the deposit is made.  This will become 
the next days starting cash. 

Cash Deposit... The amount of cash being deposited in the bank. 

Cash/Checks deposit... Total of cash and paper checks being deposited.  Adds Cash deposit 
field and Checks drawer count. 
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e-Checks/Charge deposit...This represents the total "Electronic Payment" totals shown by the 
software.  E-Checks are checks process through a check verification service.  The store 
may or may not have a copy of the check.  

Closing notes... The operator may enter any type of comment to relating to this close.  Notes are 
required for Over /Under conditions. 

 

Buttons 

Close Store..This button finalizes the entered counts and totals, closes the store and resets for 
the next business day. 

Suspend Close... Begin entering totals then press this button to SAVE the edits and return to the 
previous form.  The entered data is recalled and displayed the next time this form is 
displayed.   

Cancel... Cancel any edits and return to previous form. 

Daily Register Report... Print the Daily Register report.  use as an aid in performing the counts 
for the close. 

 

Paid Out 

Switchboard: Main->Register Functions->Paid-Out  

Menu: File>Paid-Out  

Action: CASHFUNC 

The information entered on the Paid Out screen is printed on the Revenue report. You can enter 
the amount of money paid for outside services, and show which sales associate was 
responsible for the payment.  Outside services may be added or removed from the list via the 
Accounting Setup form 

To enter a paid out transaction 

1. Click Register Functions main menu, click PAID-OUT. The Paid-Out window 
displays. 

2. Select one of the services. 

3. Enter the sales associates ID in the Sales Associate field. 

4. Enter the amount paid for the service in the Paid Out field and click OK. 

Paid In 

Switchboard: Main->Register Functions->Paid-In  

Menu: File->Paid-In 

Action: PAIDIN 

The information entered on the Paid In screen is printed on the Revenue report & closing 
reports. You can enter the amount of money received for items or services other than sales, and 
show which sales associate was responsible for the receipt of payment. 

To enter a paid in transaction 

1. From the Register Functions main menu, click PAID-IN. The Paid-In window 
displays. 

2. Enter the sales associates ID in the Sales Associate field. 

3. Enter the amount paid for the service in the Paid In field. 
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4. Enter a reason within the reference field and click OK. 

Register Status 

Switchboard: Main->Register Functions->Register Status  

Menu: File->Register/Store Status 

Action: REGSTAT 

 

Overview 

This form is used to identify the open/close status of each register for each store location and to 
see whether a Register is currently running the WinPOS program. 

A system setting option exists to "Close all Registers at Once".  When set, a single Register 
may be utilized to close the entire store.   This function would require all users to be logged out 
of the WinPOS system, thus preventing additional financial transactions to be posted to tickets 
while a close is in process.  This form is a convenient tool that allows the operator to see which 
Registers are logged  into the system and stopping the Store Close from preceding. 

 

Limit to store... Displays Registers within the grid that are assigned to the selected store id. 
 Change to store ID to another location to see that store's assigned Registers. 

 

Grid 

Register... Name of Register, as it was entered in the Register setup file 

Store... Store ID the Register is assigned to, as it was entered in the Register setup file 

Status... current Open or Close status of the Register. 

In Use?... the In Use messages & their meaning are:  Blank = Not in use |  ? = Register does not 
have entry in tracking file (usually means register has never been started) |  IN USE   = 
Register is currently logged into the WinPOS system. 

Cash Drawer Open 

This function will open an electronic cash drawer attached to the station and configured within 
the Register Set-up & Status form.. 

Reports 

Daily Register Report 

Switchboard: Main->Register Functions->Daily Register  

Menu: Reports->Financial->Daily Register Report 

Action: RP_DAYREG 

 

Overview 

The Daily Register report is available when the Housekeeping-> General Setup-> System 
Setup-> Require registers/store to be closed? is enabled. 

The daily Register report is a recap of the movement of money through a store for a particular 
day. It is the net total of money by tender type that has moved in & out of the store.  The first 
page of the report compares what store personnel counted as being in the cash drawer(s) to the 
total WinPOS computed  for the day's business.   
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It also provides all ticket transactions by tender type that comprises the total for that tender type 
as an aid to reconcile the count. The report is inclusive and thus has paid in & outs, security 
deposits paid in & refunded (also what will be due to customers), etc.  It also displays the daily 
starting and ending cash retained in the cash drawer(s). 

Note 

Security Deposits are typically used in rental operations and is held pending the ontime, safe 
return of rental garments/items. When the rental order is returned the customer's security 
deposit is refunded.  The report provides an estimate of security deposits due for refund to 
customers for the next several days. 

Criteria 

Business date between xxx and yyy...This is the business date, not the transaction date. You 
must enter a date range and only transaction created within that business date range will 
be included. 

Register...You can limit transactions that were created at a specific Register  

Limit to store(s)…Limits the transfers listed to the store(s) that performed the transfer. 
(available with the multi-store integration option). 

 

Deposit Listing Report 

Switchboard: Main->Register Functions->Deposit Listing  

Menu: Reports->Financial Reports->Deposit Listing 

Action: RP_DEPLIST 

 

Overview 

The Deposit Listing report is available when the Housekeeping-> General Setup-> System 
Setup-> Require registers/store to be closed? is enabled. 

This report is an easy and concise recap of the net money transacted by business date within a 
store for a tender type.  It shows the computed bank deposit for a specific day (for auditing), 
once the store is closed for that day.  It also lists the ending drawer balance that will become the 
beginning drawer balance the following business day. 

The report allows for the addition of one user defined tender type to be added. (via 
Housekeeping-> General Setup-> Accounting Setup-. Accounting Setup -> Setup & WinPOS 
Accounts tabs. 

The report may be ran for a range of business days. 

 

Criteria 

Business date between xxx and yyy...This is the business date, not the transaction date. You 
must enter a date range and only closings created within that business date range will be 
included. 

Register...You can limit transactions that were created at a specific Register  

Limit to store(s)…Limits the transfers listed to the store(s) that performed the transfer. 
(available with the multi-store integration option). 

 

 

Revenue Listing Report 
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Switchboard: Main->Register Functions->Revenue Listing  

Menu: Reports->Financial Reports->Revenue Listing 

Action: RP_TRANLIST 

 

Overview 

The Revenue Listing report is available when the Housekeeping-> General Setup-> System 
Setup-> Require registers/store to be closed? is enabled.   

This report is an easy and concise summary recap of the beginning cash in drawer, security 
deposit changes, rental revenue, sales revenue, sales tax, paid outs, total money received, any 
over/under counts and any extra cash held out from the deposit.  This report is fixed to it's 
format and is not a replacement to the more flexible & detailed Revenue Report.  

The report will highlight any days where there was an over or under on the cash/checks/charges 
counts at closing. 

The report may be ran for a range of business days with each days totals listed on a single line. 

Please review the Closing the store topic for more formula information. 

Column Definitions 

All totals are specific to the date. 

Beginning cash: Ending cash from previous day's closing 

Security deposits Returned: Security deposits refunded, totaled from ticket line items at 
closing 

Security deposits Received: Security deposits received/added, totaled from ticket line items at 
closing 

Security deposits Retained: Security deposits forfeited, totaled from ticket line items at closing 

Rentals: The closing builds a list of all the Sales/Revenue accounts for the accounting classes 
used for rental orders (according to the Order types form), then totals up all the postings for 
those accounts, except damage wavier 

Revenue Sales: The closing builds a list of all the Sales/Revenue accounts for all the 
accounting classes, then totals up all the postings for those accounts, except damage wavier. 

Revenue Damage waiver: Total of Damage Waiver Sales/Revenue account (DMG WAIVER 
REV by default) postings for the date. 

Tax: Total of the postings for all the Tax Revenue accounts as set up on the Taxes form, for tax 
records with a non-zero tax at closing 

Paid Outs: Total postings for the Paid Out accounts as setup on Accounting Setup at closing 

Total Receipts: Security deposits Received + Revenue Sales + Rentals + Tax-Paid Outs - 
Security deposits Returned  

Over/Under: Cash over/under from day's closing form. 

Extra Cash Held Out: Drawer end cash - Drawer Start Cash from day's closing 

 

Criteria 

Business date between xxx and yyy...This is the business date, not the transaction date. You 
must enter a date range and only transaction created within that business date range will 
be included. 
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Register...You can limit transactions that were created at a specific Register  

Limit to store(s)…Limits the transfers listed to the store(s) that performed the transfer. 
(available with the multi-store integration option). 

 

Column Definitions 

Date...  

Security Desposits, Returned, Received, Retained... 

Rentals...  

Revenue, Sales, Dmg Waiver...  

Tax... 

Paid Outs... 

Total Receipts... 

Over/Under... 

Extra Cash Held Out...  

Journal Report 

Switchboard: Main->Register Functions->Register Journal  

Menu: Reports->Financial Reports->Register Journal 

Action: RP_JOURNAL 
 

This report lists all the transactions that occurred in the date range specified. Transactions 
include sales, payments, cancellations, anything that appears on a ticket. This report is similar 
to the Transaction Review but differs in the report layout. 

 

Criteria 

Business date between xxx and yyy...This is the business date, not the transaction date. You 
must enter a date range and only transaction created within that business date range will 
be included. 

Register...You can limit transactions that were created at a specific Register  

Limit to store(s)…Limits the transfers listed to the store(s) that performed the transfer. 
(available with the multi-store integration option). 

Department...Only transactions created within the selected department will print.  You can set up 
your departments at Main->Housekeeping->General Setup->Departments. Then you can 
specify the department for each register at Main->Housekeeping->General Setup-
>Register Setup. 

 

Register Journal Layout 

Transaction type.. The ticket transaction, i.e. Sale, Payment, Rental ...etc.  The type of payment, 
i.e. cash, check, visa ..etc of a payment transaction type. 

Customer Name...  

Qty and Style... The quantity sold for the transaction and inventory style sold of a SALE 
transaction type. 
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Price... The amount of the payment, if payment transaction or the NET retail sales price (net of 
markdowns or markups) of a SALE transaction. 

List Price... The amount of the payment, if payment transaction or retail sales  price of a SALE 
transaction prior to markups or markdowns. 

SA...  The sales associate ID that received credit fo the transaction. 

Ticket #... Number the transaction was placed upon. 

Store ID... Multi-store feature that list the location that created the transaction. 

 

Revenue Reporting 

Revenue Report 

Switchboard: Main->Reports->Revenue and Main->Register Functions->Revenue Report 

Menu: Reports->Financial Reports->Revenue  

Action: RP_REVENUE 
 

Overview 

This report is the daily accounting report of the store.  It shows the receipts by tender type 
(cash, checks, etc.) and the total revenue for the enterprise. 

It is usually ran by Day, but also may span several days or months. 

The grand total of the Report should balance with the Receipts total of the report. If it does not, 
the difference is shown as Cash Over/Under. This could happen if you delete tickets or 
transactions from the Ticket form, or if you had data corruption due to power failure, hardware 
failure, etc. In normal conditions the revenue report should balance. Receipts to revenue + 
deposits/receivables + taxes. 

Please review the topics, Revenue Report Setup and WinPOS Revenue Report Posting for 
more information. 

Tax exempt transactions are shown (transactions where you entered a tax exempt ID). Finally, 
your sales are broken down by inventory classy, into taxable and non-taxable sales. 

This report can be exported to an accounting application with the optional Accounting 
Integration module  

 

Criteria 

Between xxx and yyy...Shows the revenue for the dates xxx through yyy, inclusive. You must 
enter a date range. 

Show receipts only (checkbox) (current store only)...If checked, the report totals for the store 
assigned to the Workstation/Register printing the report (only a consideration when using 
the optional multi-store module) and includes only the top half with shows the receipts by 
tender type (cash, checks, etc.)    

Show detail for each line on report (checkbox)...Displays the details of the GL transaction 
record and ticket line item that created each entry that make up the revenue report. You 
would only use this if you need very detailed information about how the revenue report is 
being calculated. Note that the revenue report will be quite long with this option checked. 

Print for all stores?... Available with optional multistore option.  Checked the report will include 
transactions chain wide (across all stores). 
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Limit to store...Will only print transactions for the store selected. Only applicable to Multi-Store. If 
left blank it will print the transactions for all stores. 

WinPOS Revenue Posting Explanation 

 

 

Sales Revenue Postings in WinPOS 

This topic describes how WinPOS revenue report postings are made during a typical sale based 
upon the different revenue trigger choices.  (Account numbers in this topic are internal WinPOS 
account numbers).  WinPOS offers a choice between three revenue triggers.  When a 
customer's purchases match the selected trigger, revenue and sales taxes are realized & 
reported on WinPOS reports.  Three choices are offered because of the different shop 
accounting needs.   

The accounting trigger selected must be a decision between shop management and it's CPA. 
 The Revenue Trigger is set in Housekeeping-> Accounting Setup-> Accounting Setup 

 

Examples 

For the purposes of this example, assume: 

Our credit card WinPOS  account # is 1007. 

We have two accounting classes, WG and BM. 

WG uses AR/deposit account # of 4000, cost account of 5000, and revenue account # of 6103. 

BM uses AR/deposit account # of 4000, cost account of 5000, and revenue account # of 6102. 

The tax rate is 5%, and tax account # is 3001 

 

 Ticket Zero Accounting: 

When a sale is initially made, there are no postings.  As payments are taken towards the sale, 
postings are made to the WinPOS AR/deposit account.  The AR/deposit account holds these 
“partial payments” until the balance on the ticket is zero and it is paid in full. 

When the balance on the entire ticket is zero these partial payments are moved from the 
AR/deposits account to the revenue account(s) for the sales items, and to the tax account(s). 

Payments are applied top to bottom on the ticket.  Payments are applied to the first line item for 
the sales price + tax.  Once the first item is paid for, payments are applied to the second line 
item, and so on. 

For example, on Monday, we have: 

Sale of wedding gown $1000 (cost is $400) 

Sale of bridesmaid dress for $500 (cost is $200) 

Total balance due is $1000 + $500 + $75 (tax) = $1575 

Payment of $750 

 

Postings: 

 

WinPOS 
Account 

Amount Why? 
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1007 – 
Credit 
card 

$750 Payment taken 

4000 – 
Deposits 

$750 Partial payment on 
wedding gown 

 

On Tuesday, we have: 

Payment of $200 

 

Postings: 

 

WinPOS 
Account 

Amount Why? 

1007 – Credit 
card 

$200 Payment taken 

4000 – 
Deposits 

$200 Partial payment on wedding 
gown 

 

 

On Wednesday, we have: 

Payment of $625, which pays the balance due in full. 

 

Postings: 

 

WinPOS 
Account 

Amount Why? 

1007 – Credit 
card 

$625 Payment taken 

4000 – 
Deposits 

$100 Partial payment on wedding 
gown + tax 

4000 – 
Deposits 

$525 Partial payment on bridesmaid 
dress + tax 

4000 – 
Deposits 

-$1050 Wedding gown partial 
payments removed from 
deposits 

6103 – WG 
revenue 

$1000 Revenue realized for wedding 
gown 

3001 – Tax $50 Tax realized on wedding gown 

5000 – Costs $400 Cost of wedding gown.  This is 
can printed on the revenue 



Register Operations 

285 

report, the posting is used for 
GL exports, if applicable. 

4000 – 
Deposits 

-$525 Bridesmaid partial payments 
removed from deposits 

6102 – BM 
revenue 

$500 Revenue realized for 
bridesmaid dress 

3001 – Tax $25 Tax realized on bridesmaid 
dress 

5000 – Costs $200 Cost of bridesmaid dress.  This 
is not printed on the revenue 
report, the posting is used for 
GL exports, if applicable. 

   

 

This completes the account postings for this ticket. 

 

 Cash Accounting: 

When a sale is initially made, postings are made for the tax and revenue on all sales items. 
 Also, postings are made to the AR/deposit account for the total amount of revenue and taxes. 
 These AR/deposit postings represent the amount due from the customer.  As payments are 
taken towards the sale, postings are made to the AR/deposit account.  These posting offset the 
original AR/deposit postings until the items are paid in full.   When the items are paid in full the 
postings in the deposit account balance each other out. 

Payments are applied top to bottom on the ticket.  Payments are applied to the first line item for 
the sales price + tax.  Once the first item is paid for, payments are applied to the second line 
item, and so on. 

 

For example, on Monday, we have: 

Sale of wedding gown $1000 

Sale of bridesmaid dress for $500 

Total balance due is $1000 + $500 + $75 (tax) = $1575 

Payment of $750 

 

Postings: 

 

WinPOS 
Account 

Amount Why? 

1007 – Credit 
card 

$750 Payment taken 

4000 – 
Deposits 

-$1050 Amount due on wedding gown 
+ tax 

6103 – WG $1000 Revenue realized for wedding 
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revenue gown 

3001 – Tax $50 Tax realized on wedding gown 

5000 – Costs $400 Cost of wedding gown.  This is 
can printed on the revenue 
report, the posting is used for 
GL exports, if applicable. 

4000 – 
Deposits 

-$525 Amount due on bridesmaid 
dress + tax 

6102 – BM 
revenue 

$500 Revenue realized for 
bridesmaid dress 

3001 – Tax $25 Tax realized on bridesmaid 
dress 

5000 – Costs $200 Cost of bridesmaid dress.  This 
is not printed on the revenue 
report, the posting is used for 
GL exports, if applicable. 

4000 – 
Deposits 

$750 Amount paid towards wedding 
gown + tax 

 

 

On Tuesday, we have: 

Payment of $200 

Postings: 

 

WinPOS 
Account 

Amount Why? 

1007 – Credit 
card 

$200 Payment taken 

4000 – 
Deposits 

$200 Amount paid towards wedding 
gown + tax 

 

On Wednesday, we have: 

Payment of $625, which pays the balance due in full. 

Postings: 

 

WinPOS 
Account 

Amount Why? 

1007 – Credit 
card 

$625 Payment taken 

4000 – 
Deposits 

$100 Amount due on wedding gown 
+ tax 
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4000 – 
Deposits 

$525 Partial payment on bridesmaid 
dress + tax 

 

This completes the account postings for this ticket. 

 

Note: 

The AR/deposits account shows the change in partial payments or deposits held by the 
store.  It does not show the total monies held, or owed to the store.  The revenue report is 
usually configured to show the increase and decrease to the AR/deposits account 
separately, as negative and positive numbers.  The total of these numbers is the net change 
to the deposits account. 

 

Other Revenue Postings in WinPOS 

Example, adjust the sales price after the revenue has been realized: 

On Monday, we have: 

Sale of wedding gown $1000 ($400 cost) 

Payment of $1000 + $50 tax 

Postings: 

 

WinPOS 
Account 

Amount Why? 

1007 – Credit 
card 

$1050 Payment taken 

4000 – 
Deposits 

$1050 Partial payment on wedding 
gown + tax 

4000 – 
Deposits 

-$1050 Wedding gown partial 
payments removed from 
deposits 

6103 – WG 
revenue 

$1000 Revenue realized for wedding 
gown 

3001 – Tax $50 Tax realized on wedding gown 

5000 – Costs $400 Cost of wedding gown.  This is 
can printed on the revenue 
report, the posting is used for 
GL exports, if applicable. 

 

Now, on Tuesday, we have: 

Adjustment to print of wedding gown -$200 

Refund of $210, ($200 for gown, $10 refund on tax) 

Postings: 
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WinPOS 
Account 

Amount Why? 

1007 – Credit 
card 

-$210 Refund given 

6103 – WG 
revenue 

-$200 Loss of revenue realized for 
wedding gown 

3001 – Tax -$10 Loss of tax realized on wedding 
gown 

 

If you cancel the sale before the revenue has been realized: 

FORFEIT style code uses FORFEIT accounting class, which uses AR/deposit account # of 
4000, cost account of 5000, and revenue account # of 6108.  FORFEIT style has no cost, and is 
non-taxable. 

For example, on Monday, we have: 

Sale of wedding gown $1000  

Partial payment of $700 

Postings: 

 

WinPOS 
Account 

Amount Why? 

1007 – Credit 
card 

$700 Payment taken 

4000 – 
Deposits 

$700 Partial payment on wedding 
gown 

 

Now, on Tuesday, we have: 

Cancel of sale of wedding gown  

Shop sells a FORFEIT style to retain the partial payment 

Postings: 

 

WinPOS 
Account 

Amount Why? 

4000 – 
Deposits 

-$700 Loss of partial payment for 
wedding gown 

4000 – 
Deposits 

$700 Partial payment on FORFEIT 
style 

4000 – 
Deposits 

-$700 Partial payment on FORFEIT 
style removed from deposits 

6108 – 
FORFEIT 
revenue 

$700 Revenue realized for FORFEIT 
style 
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Taxes Report 

Switchboard: Main->Reports->Taxes Report and Main->Register Functions->Taxes Report 

Menu: Reports->Financial Reports->Taxes 

Action: RP_TAXES 

 

Overview 

This report shows the taxes collected by your store. It is broken down by WinPOS© account 
number since each tax has a WinPOS Account number associated with it. If you have multiple 
tax rates to collect, you must assign each one to a different WinPOS© account number when 
they should be totalled separately. The report also shows your sales for each tax rate, and non-
taxable sales, broken down by inventory category. 

If you have multiple stores, the report will break down the taxes collected and taxable, non-
taxable sales for each store. 

This report will also show any Tax Forward (TF) transactions that have been realized in the date 
range specified. The sum of the Tax Forward (TF) transactions for a specified time period will 
need to be added to the retail and rental tax figures from the revenue report for the same time 
period. This will insure that you are paying the correct amount of taxes. TF transactions are 
normally created as part of the BPS data conversion. They are also entered when adding 
existing customers to the program during setup if your shop uses the ticket zero or pickup 
accounting method. 

Notes: 

WinPOS© will allow sales tax rates to be added, modified and removed anytime from sales 
transactions, EVEN if the tax has been previously realized.  This report is designed to reflect 
those changes.  For example.  Suppose a sales tax was charge on a gown in Jan and 
realized on the Daily revenue report & reported on this Sales Tax report.  Now, suppose in 
February a user removed the sales tax from the sales item.  Now, the revenue report & this 
Taxes Report will show a decrease in sales tax collected, a decrease in taxable sales and an 
increase in 'non taxable sales' in the amount of the sales item on the ticket affected even 
though there where not any NEW sales transaction.  Just a tax reduction transactions took 
place. 

There is no relation of the sales totals on this report to the sales totalled on sales reports like 
Sales by Category.  In most cases they would not be the same number. 

Run the Revenue report in detail mode and look at the tax section to see the ticket numbers 
of the included sales transactions where the tax was realized on this report.  This would 
allow an audit of the tax totals by allowing the operator to review the ticket transactions. 

Hint: 

Enable the TICKTAX security setting to require a password to manually add/remove tax to a 
sales transaction.  Logging the use of this feature via the Actions/Transfer table is available 
when it is password protected and would allow management to see whom is taking 
advantage of this capability 

 

Criteria 

Between xxx and yyy...Shows the taxes collected for the dates xxx through yyy, inclusive. You 
must enter a date range. 
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Limit to store(s)…Limits the payments listed to the stores entered (available with the multi-store 
integration option).  Leave blank for all stores. 

 

Receipts Report 

Switchboard: Main->Register Functions->Receipts Report  

Menu: Reports->Financial Reports->Receipts 

Action: RP_RECEIPTS 
 

This report is the tender portion of the revenue report and shows the receipts for your store 
(cash, checks, etc.)  

The Receipts section of the report breaks down your store receipts, such as Cash, Checks, and 
other payments. 

 

Criteria 

Between xxx and yyy...Shows the receipts for the dates xxx through yyy, inclusive. You must 
enter a date range. 

Department...Only transactions for the selected department will print. You can set up your 
departments at Main->Housekeeping->General Setup->Departments. Then you can 
specify the department for each register at Main->Housekeeping->General Setup-
>Register Setup. 

Register...You can select a specific register for payments. 

View Ticket by Number 

Switchboard: Main->Register Functions->View Ticket By Number and  Main->Top Level menu-
>Locate-> Ticket By Number 

Menu: Find->Ticket By Number 

Action: none 

 

This option lets you go directly to a ticket by it's ticket number OR allows direct edits to ticket 
transactions including it's accounting postings used by the revenue report and all other 
accounting related reports.  A ticket may deleted as well. 

Enter the ticket number at the Search For prompt.  WinPOS will locate and select the entered 
ticket number. 

 

Buttons 

View Ticket...This button will display the ticket for review or editing. 

Edit Postings...This button will display the details of the ticket and the associated GL 
transactions for each line item.  

The Transaction Editor shows the ticket line items on the top half of the form. When a ticket 
line item is selected, the bottom half of the form will show the Posting transactions 
associated with that ticket line item. You would use this option to manually correct problems 
with the postings or ticket transactions.  The displayed data columns may be edited like an 
eXcel spreadsheet. Simply click into the cell and entered the desired value.  There are no 
program checks on the data entered within this form so please be knowledgeable with the 
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effects of your changes will be. The WinPOS Revenue report, payments reports and other 
closing reports utilize this posting data for report calculations.   

Any cell within the grid may be edited.  BE CAREFUL since any change will effect the details 
of the Revenue Report. 

This is an advanced feature. 

Cancel.. Exit the form and return to the previous menu. 

 

Edit Postings Buttons 

Ticket line items grid 

Delete line item... Deletes the selecting transaction.  The deleted item will no longer appear on a 
sales ticket or be included in any sales reports.  Deleted items do NOT disappear from 
this grid, but instead a black box will appear to the left of the line which indicates it is 
marked as deleted.  Click the black box to UN-DELETE the item. 

Edit Line Item... Opens a data windows showing all editable fields in the table for the selected 
line item.  Any field's data may be modified. 

 

Postings grid 

Delete posting ... Marks the selected posting as deleted.  WinPOS ignores all deleted entries for 
accounting report calculations.   Deleted items do NOT disappear from this grid, but 
instead a black box will appear to the left of the line which indicates it is marked as 
deleted.  Click the black box to UN-DELETE the item. 

Recall posting... Recalls (un deletes) the selected posting.  This is the same as clicking the 
black box to un-delete. 

 

Footer buttons 

Delete entire ticket ... Will delete the entire ticket by marking all ticket transactions and postings 
as deleted (black box to left will appear). 

Edit Ticket... This function displays a new window that allows the ticket header to be edited.  The 
ticket header contains important ticket info and store location that owns the ticket, 
customer number that the ticket is assigned to, tax info, created date ..etc 

 

Payments by Type Report 

Switchboard: Main->Reports->Daily Mngmnt-> Payments by Type and Main->Register 
Functions->Payments by Type 

Menu: Reports->Financial Reports->Payments by Type 

Action: RP_PMTTYPE 
 

This report will list the payments received within a date range by tender type.  With the optional 
WinTPOS© module installed, the report will group & subtotal the payments applied to retail 
sales tickets and those payments applied to rental tickets.  The definition of a Rental Ticket is: A 
ticket that contains a RENTAL sales transaction created by a Rental Order.  Thus, the ticket is 
linked to a rental order.  Subsequently a user may add retail sales transactions to the ticket. 
 The system will always consider the ticket a Rental ticket.   
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Management has the option via the System / Store rental setup to NOT allow sales transaction 
to be added to Rental Tickets, making this report more useful. 

Codes may appear on this report indicating transaction types.  Codes are SR = Security deposit 
Add, SR = Security deposit Refund, P = Payment 

It groups & subtotals by Retail  (tickets that contain RETAIL transactions) & Rental (tickets that 
contain RENTAL transactions)  payments, by default it will not print the ticket detail.  This report 
is similar to the Checks/Charges Review report. 

Selection Criteria 

Show Payment Detail? (checkbox)…Checked will display the payment detail for each payment, 
i.e. date received, SA who entered it, tender typem, credit card number (if credit card 
processing is active) etc. 

Business date between…The date range to limit the payments. 

Limit to store(s)…Limits the payments listed to the stores entered (available with the multi-store 
integration option). 

Department…Limit to a store’s department if turned on.  

Register…Limit to a specific register in a multiuser environment. 

Show Checks? (checkbox)…checked will show checks tendors. 

Show charges? (checkbox)… checked will show any charge tendors. 

Show Cash? (checkbox)… checked will show cash tendors. 

Show Gift Certificates? (checkbox)… checked will show Gift Cards/Certificates used as 
payments. 

Buttons 

OK…Process the criteria and run the report. 

Cancel…Quit without running the report and return to the previous screen. 

Gift Card Balance 

Switchboard: Main->Register Functions-> Gift Card Balance 

Menu: Find->Gift Card Balance 

Action: none 
 

This form will display the remaining balance of a Gift Card.  Gift Card balances may be edited. 
 See Gift Card Editor for more info. 

 

Fields 

Acct #... Manually enter or swipe or scan the identification number of the gift card.  The system 
will display the current balance. 
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Reports 

Reports Overview 

Switchboard: Main->Reports 

Menu: Reports 

Action: none 

Locate at Main->Housekeeping->Reports 

The reports are broken down into multiple groups of related reports.  For example sales reports 
are reports relating to sales and ran from the customer's tickets. 

Reports may be printed to the screen, a printer, a text file, a Microsoft excel spreadsheet XLS 
file format for use in Excel.  Reports may be printed to Adobe's PDF document format which is 
great for email and or coping to other computers.   

When printing to file formats, WinPOS will display a dialog box. Click the ... button to specify the 
output file name.  WinPOS will auto add the proper extension automatically to the name 
entered, i.e. TXT, XLS or PDF.  Printing long reports to PDF can take a few minutes. 

Daily Management Reports 

Revenue Report 

Switchboard: Main->Reports->Revenue and Main->Register Functions->Revenue Report 

Menu: Reports->Financial Reports->Revenue  

Action: RP_REVENUE 
 

Overview 

This report is the daily accounting report of the store.  It shows the receipts by tender type 
(cash, checks, etc.) and the total revenue for the enterprise. 

It is usually ran by Day, but also may span several days or months. 

The grand total of the Report should balance with the Receipts total of the report. If it does not, 
the difference is shown as Cash Over/Under. This could happen if you delete tickets or 
transactions from the Ticket form, or if you had data corruption due to power failure, hardware 
failure, etc. In normal conditions the revenue report should balance. Receipts to revenue + 
deposits/receivables + taxes. 

Please review the topics, Revenue Report Setup and WinPOS Revenue Report Posting for 
more information. 

Tax exempt transactions are shown (transactions where you entered a tax exempt ID). Finally, 
your sales are broken down by inventory classy, into taxable and non-taxable sales. 

This report can be exported to an accounting application with the optional Accounting 
Integration module  

 

Criteria 

Between xxx and yyy...Shows the revenue for the dates xxx through yyy, inclusive. You must 
enter a date range. 

Show receipts only (checkbox) (current store only)...If checked, the report totals for the store 
assigned to the Workstation/Register printing the report (only a consideration when using 
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the optional multi-store module) and includes only the top half with shows the receipts by 
tender type (cash, checks, etc.)    

Show detail for each line on report (checkbox)...Displays the details of the GL transaction 
record and ticket line item that created each entry that make up the revenue report. You 
would only use this if you need very detailed information about how the revenue report is 
being calculated. Note that the revenue report will be quite long with this option checked. 

Print for all stores?... Available with optional multistore option.  Checked the report will include 
transactions chain wide (across all stores). 

Limit to store...Will only print transactions for the store selected. Only applicable to Multi-Store. If 
left blank it will print the transactions for all stores. 

Deposit Slip Report 

Switchboard: Main->Reports->Daily Mngmnt->Deposit  

Menu: Reports->Financial Report->Deposit Slip 

Action: RP_DEPOSIT 
 

This Deposit Slip report will show your cash and checks receipts for the day with all the 
information you need to fill out a deposit slip. You can’t actually attach this report to your deposit 
slip and include with your deposit as backup 

Deposit Audit Report 

Switchboard: Main->Reports->Daily Mngmnt->Deposit  

Menu: Reports->Financial Reports->Deposit Audit 

Action: RP_DEPAUDIT 

 

Overview 

This is a summary report is used to audit the total of payments like cash/check/credit card 
receipts for WinPOS. The report shows a single line per day which breaks down the receipts by 
tender methods accepted by the store. 

 

Criteria 

Business date between…The date range to limit the audit. 

Limit to store(s)…Limits the payments listed to the stores entered (available with the multi-store 
integration option). 

 

Store Credit Transfers 

Switchboard: Main->Register Functions->Store Credit Transfers   

Menu: Reports->Financial Reports->Store Credit Transfers 

Action: RP_TRANCRED 

 

Overview 

WinPOS allows operators to transfer store credits between customers.  WinPOS logs this 
action.  This report allows store management to see what the transfers were. 
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The report shows the transfer date, sales associate who performed the transfer, the store 
id/location that performed the transfer, from which customer to which customer and the amount 
of the transfer. 

 

Criteria 

Transferred between... Date range the transfer occurred. 

Limit to store(s)…Limits the transfers listed to the store(s) that performed the transfer. 
(available with the multi-store integration option). 

 

 

Taxes Report 

Switchboard: Main->Reports->Taxes Report and Main->Register Functions->Taxes Report 

Menu: Reports->Financial Reports->Taxes 

Action: RP_TAXES 

 

Overview 

This report shows the taxes collected by your store. It is broken down by WinPOS© account 
number since each tax has a WinPOS Account number associated with it. If you have multiple 
tax rates to collect, you must assign each one to a different WinPOS© account number when 
they should be totalled separately. The report also shows your sales for each tax rate, and non-
taxable sales, broken down by inventory category. 

If you have multiple stores, the report will break down the taxes collected and taxable, non-
taxable sales for each store. 

This report will also show any Tax Forward (TF) transactions that have been realized in the date 
range specified. The sum of the Tax Forward (TF) transactions for a specified time period will 
need to be added to the retail and rental tax figures from the revenue report for the same time 
period. This will insure that you are paying the correct amount of taxes. TF transactions are 
normally created as part of the BPS data conversion. They are also entered when adding 
existing customers to the program during setup if your shop uses the ticket zero or pickup 
accounting method. 

Notes: 

WinPOS© will allow sales tax rates to be added, modified and removed anytime from sales 
transactions, EVEN if the tax has been previously realized.  This report is designed to reflect 
those changes.  For example.  Suppose a sales tax was charge on a gown in Jan and 
realized on the Daily revenue report & reported on this Sales Tax report.  Now, suppose in 
February a user removed the sales tax from the sales item.  Now, the revenue report & this 
Taxes Report will show a decrease in sales tax collected, a decrease in taxable sales and an 
increase in 'non taxable sales' in the amount of the sales item on the ticket affected even 
though there where not any NEW sales transaction.  Just a tax reduction transactions took 
place. 

There is no relation of the sales totals on this report to the sales totalled on sales reports like 
Sales by Category.  In most cases they would not be the same number. 

Run the Revenue report in detail mode and look at the tax section to see the ticket numbers 
of the included sales transactions where the tax was realized on this report.  This would 
allow an audit of the tax totals by allowing the operator to review the ticket transactions. 

Hint: 
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Enable the TICKTAX security setting to require a password to manually add/remove tax to a 
sales transaction.  Logging the use of this feature via the Actions/Transfer table is available 
when it is password protected and would allow management to see whom is taking 
advantage of this capability 

 

Criteria 

Between xxx and yyy...Shows the taxes collected for the dates xxx through yyy, inclusive. You 
must enter a date range. 

Limit to store(s)…Limits the payments listed to the stores entered (available with the multi-store 
integration option).  Leave blank for all stores. 

 

Checks/Charges Review Report 

Switchboard: Main->Reports->Daily Management Reports->Checks/Charges Review Report  

Menu: Reports->Financial->Checks/Charges Review Report  

Action: RP_CCARD 

 

Overview 

This report will list the detail of each payment received within a date range by tender type. It can 
be used to audit your daily deposit or credit card processors batch report since it includes the 
ticket #, customer id, SA who took the payment, approval codes, register id ..etc..   

 

Criteria 

Business date between xxx and yyy...Only transactions between the dates specified will print. 

Limit to stores...You can select one or more store ID’s for the report. This option is only 
available if you have the Multi-Store integration. 

Department...Only transactions for the selected department will print. You can set up your 
departments at Main->Housekeeping->General Setup->Departments. Then you can 
specify the department for each register at Main->Housekeeping->General Setup-
>Register Setup. 

Register...You can select a specific register for payments. 

Show checks, charges, cash, gift certificates?...You can check the tender types you want to 
see on the report. 

Payments by Type Report 

Switchboard: Main->Reports->Daily Mngmnt-> Payments by Type and Main->Register 
Functions->Payments by Type 

Menu: Reports->Financial Reports->Payments by Type 

Action: RP_PMTTYPE 
 

This report will list the payments received within a date range by tender type.  With the optional 
WinTPOS© module installed, the report will group & subtotal the payments applied to retail 
sales tickets and those payments applied to rental tickets.  The definition of a Rental Ticket is: A 
ticket that contains a RENTAL sales transaction created by a Rental Order.  Thus, the ticket is 
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linked to a rental order.  Subsequently a user may add retail sales transactions to the ticket. 
 The system will always consider the ticket a Rental ticket.   

Management has the option via the System / Store rental setup to NOT allow sales transaction 
to be added to Rental Tickets, making this report more useful. 

Codes may appear on this report indicating transaction types.  Codes are SR = Security deposit 
Add, SR = Security deposit Refund, P = Payment 

It groups & subtotals by Retail  (tickets that contain RETAIL transactions) & Rental (tickets that 
contain RENTAL transactions)  payments, by default it will not print the ticket detail.  This report 
is similar to the Checks/Charges Review report. 

Selection Criteria 

Show Payment Detail? (checkbox)…Checked will display the payment detail for each payment, 
i.e. date received, SA who entered it, tender typem, credit card number (if credit card 
processing is active) etc. 

Business date between…The date range to limit the payments. 

Limit to store(s)…Limits the payments listed to the stores entered (available with the multi-store 
integration option). 

Department…Limit to a store’s department if turned on.  

Register…Limit to a specific register in a multiuser environment. 

Show Checks? (checkbox)…checked will show checks tendors. 

Show charges? (checkbox)… checked will show any charge tendors. 

Show Cash? (checkbox)… checked will show cash tendors. 

Show Gift Certificates? (checkbox)… checked will show Gift Cards/Certificates used as 
payments. 

Buttons 

OK…Process the criteria and run the report. 

Cancel…Quit without running the report and return to the previous screen. 

Costs by Inv. Category 

Switchboard: Main->Reports->Sales Reports->Costs By Category  

Menu: Reports->Sales Reports->Costs By Category  

Action: RP_CSTICAT 

This report shows cost of sales, sub-totaled by each category of the inventory items that were 
on sales transactions where the revenue of the sale has bee realized.  The timing of when 
revenue realized is based up accounting triggers and is set in the accounting setup form. 

Criteria 

Revenue realized between xxx and yyy Dates...Only prints costs for items where the revenue 
has been realized within the date range specified. You must enter a date range. 

Limit to category...You can limit the report to a specific category, if you like. Leave blank for all 
categories. 

Limit to Stores...This option available in the Multi-Store module.  Allows report to limit cost of 
sales to the selected store locations. 

Tax/Freight Audit Report 
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Switchboard: Main->Register Functions->Tax/Freight Audit 

Menu: Reports->Financial Reports->Tax/Freight Audit 

Action: RP_TAXCHECK 

 

Overview 

This report is an audit of specific ticket scenarios.  The report checks each ticket for transactions 
in the date range requested and if the ticket matches one the following TAX or FREIGHT 
(SHIPPING) scenarios it is included in the report with it's issue as a message. 

This report is a necessary audit since the addition or removal of TAX or the sales ticket or sale 
of  FREIGHT charges and creation of shipping requests are manual and depends on the 
accuracy of sales associates. 

To identify a shipping freight charge the word "FREIGHT" must appear in the store style code. 

Qualifications 

SHIP OR FREIGHT BUT TAXED:  Shipping or Freight charges on ticket, but sale item is taxed 

NOT TAXED BUT NO SHIP OR FREIGHT:  Sale Item is not taxed nor are there is shipping 
request created or FREIGHT charge on ticket 

NOT TAXED BUT TAXABLE:  Sale Item is not taxed nor are there a shipping request created 
and it is a taxable sale 

TAXED BUT NOT TAXABLE:  Sale Item is a standard non-taxable item, but a tax charge is 
applied. 

SHIP BUT NO FREIGHT:  Sale Item has a shipping request entered but no Freight charge is 
added to ticket. 

Ticket #, customer name, event name, style, size,color,  ticket transaction date and  message 
appear on the report if the transaction qualifies. 

 

Criteria 

Sold between... The transaction date range of sale items that were placed on tickets.  Then 
checks these sales for the scenarios.  This report should include a wide range of dates to 
insure all active transactions are checked, .i.e., the start date could be 2 years from the 
current date. 

Limit to store(s)…Limits the payments listed to the stores entered (available with the multi-store 
integration option).  Leave blank for all stores. 

Sort by, Transaction date or Ticket number... Select the preferred sort order. 

 

Costs By Class Report 

Switchboard: Main->Reports->Sales Reports->Costs By Class Report  

Menu: Reports->Sales Reports->Costs By Class Report  

Action: RP_COSTCAT 

This report shows cost of sales, sub-totaled by each accounting class of the inventory items that 
were on sales transactions where the revenue of the sale has bee realized.  The timing of when 
revenue realized is based up accounting triggers and is set in the accounting setup form. 

Criteria 
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Revenue realized between xxx and yyy Dates...Only prints costs for items where the revenue 
has been realized within the date range specified. You must enter a date range. 

Limit to class...You can limit the report to a specific accounting class, if you like. Leave blank for 
all classes. 

Limit to Stores...This option available in the Multi-Store module.  Allows report to limit cost of 
sales to the selected store locations. 

Hourly Pay Report 

Switchboard: Main->Reports->Daily Mngmnt Reports->Hourly Pay Report and Main-
>Housekeeping->Time Clock-> Hourly Pay Report (RP_CLKHR) 

Menu: Reports->Financial Reports->Hourly Pay Report and Time Clock->Hourly Pay Report 

Action: RP_CLKHR 

 

Overview 

This report is available with the optional  Time Clock integration module. 

The WinPOS timeclock program is not a payroll system, but makes working with payroll 
systems easier.  It prints hours worked and optionally can multiple the hours worked & an hourly 
rate to provide a payroll budget..  It helps management by allowing employee time to analyzed 
and prints time saving hourly time reports.  It is designed to be used by management as an 
analysis tool for maximizing the shops profit via more efficient labor distribution. It contains a 
general idea to payroll costs and does not take  into consideration, payroll taxes, insurance or 
benefits. 

The report prints the total time and pay for employees. It prints a single line per employee. Use 
the Time Card report for "time Cards" by employee.  Overtime is considered hours over 40 in 
the date range asked for. 

The report runs as two reports.  The first report provides the calculations for hours, 8am to 2 
pm.  The second report includes the hours of 3pm to 9pm. 

Grouped by department and day, the report provides the total employees that worked the full or 
portion of the hour.  Exact total time of all employees working within the hour and the sales 
divided by the time worked, thus providing an accurate sales per hour total. 

 

Criteria 

Only include time from xxx to yyy...Only print time cards for the dates between the dates 
specified. 

For sales associate...The report may be limited to a specific sales associate by entering the 
employee code.   Leave blank for all. 

Department...Each employee is assigned a department on the Employee form. Print time cards 
by department by entering the department code.  Leave blank for all departments. 

Limit to stores… In multi-store installations the store locations where the employees were 
clocked in/out may be entered.  Leave blank for all locations. 

 

 

Transaction Review Report 

Switchboard: Main->Reports->Daily Management Reports->Transaction Review  
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Menu: Reports->Financial Reports->Transaction Review 

Action: RP_TRANS 

This report lists all the transactions that occurred in the date range specified, similar to an 'old 
fashion' cash register Z report.. Transactions include sales, payments, cancellations, anything 
that appears on a ticket. This report is similar to the Register Journal Report but with a slightly 
different layout.  It is an ideal tool to audit the days business for a store location. 

Criteria 

Transaction date between xxx and yyy...This is the transaction date, not the accounting date. 
You must enter a date. 

Department...Only transactions for the selected department will print. You can set up your 
departments at Main->Housekeeping->General Setup->Departments. Then you can 
specify the department for each register at Main->Housekeeping->General Setup-
>Register Setup. 

Register...You can select a specific register for transactions. 

Limit to stores...This option is available with the optional multi-store module.  It will limit 
transactions to the entered stores.  Multiple store IDs may be entered separated by a 
comma. 

Sort by, Transaction Date or Ticket Number... Select one or the other. 

 

Layout 

Date & Time... Date & time the transaction was created. 

Ticket #... Number the transaction was placed upon. 

Customer number and Name...  

Transaction type.. The ticket transaction, i.e. Sale, Payment, Rental ...etc. 

Payment Type...The type of payment, i.e. cash, check, visa ..etc of a payment transaction type is 
found in this column 

Style...  The inventory style sold of a SALE transaction type. 

Price... The amount of the payment, if payment transaction or retail sales price of a SALE 
transaction. 

Cost... The inventory style's cost of a SALE transaction type. 

Register... Register the transaction was created. 

 

Customer/Event/Prospect Reports 

Customers Report 

Switchboard: Main->Reports->Cust/Event/Pros Report->Customer  

Menu: Reports->Cust/Event/Pros Report->Customer  

Action: RP_CUSTOMER 

These are five different options to filter (limit ) the customers in this report.  Customers are any 
person registered in the system as a customer who may or may not have purchased something. 
 Members of any event are customers. 

Criteria 
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Show all customers...Every customer in file. 

Limit to Customers in event type...Only show customers who are a member of a selected type 
of event. 

Limit to Customers in event...Only show customers who are a member of a selected event. 

Limit to Customers with a balance due...The Balance selection will list customers with a 
balance and indicate what percentage of their total sales has been paid.  A great report to 
see the total dollars due.  Also when "ticket Zero" accounting is selected a DEPOSIT 
column will appear and this is the amount of deposit each ticket contains.  This is NOT a 
total of all payments made on the ticket, but the partial payments (deposits, i.e. sale items 
with balances remaining) made toward purchases.  This feature makes this report a great 
customer deposit audit report. 

Limit to Customers with store credits...Include any customer that has a store credit. 

Bridal Events Report 

Switchboard: Main->Reports->Cust/Event/Pros Reports->Bridal Events  

Menu: Reports->Cust/Event/Pros Reports->Bridal Events  

Action: RP_EVSUMB 

 

This report will show all events matching the entered criteria, their spending and current 
balances.  

Criteria 

Event date between...Based on the variation selected below, only show events where the event 
date is between the dates specified. You must enter a date range. 

Event Created between..Limit events in report that are created between the dates entered for 
this range.  A date range must be entered. 

Limit to stores… In multi-store installations the store numbers where the events were 
registered may be entered. 

Event SA...Limit to events where the event SA match this SA. 

BM SA...Limit to events where the BM SA on the event matches this SA. 

Rental SA...Limit to events where the Rental SA on the event matches this SA. 

 

There are three variations of this report: 

Show all events...Show all events on file, where the event date is in the range specified. 

Limit to events with balances...Only show events with balances. 

Single event...Only print the selected event.  

Sort by Event Name or Event Date…Prints the report in the selected sequence. 

Buttons 

OK…Process the criteria and run the report. 

Cancel…Quit without running the report and return to the previous screen. 

Rental Events Report 

Switchboard: Main->Reports->Cust/Event/Pros Reports->Bridal Events  
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Menu: Reports->Cust/Event/Pros Reports->Bridal Events  

Action: RP_EVENTSUM 

 

This report is available with the WinTPOS software option.  

This analysis report will show all events that contain members with rental orders which qualify to 
the entered criteria.  

Criteria 

Event date between...Based on the variation selected below, only show events where the event 
date is between the dates specified. You must enter a date range. 

Limit to stores… In muti-store installations the store numbers where the events were 
registered may be entered. 

Event SA...Limit to events where the event SA match this SA. 

BM SA...Limit to events where the BM SA on the event matches this SA. 

Rental SA...Limit to events where the Rental SA on the event matches this SA. 

 

There are three variations of this report: 

Show all events...Show all events on file, where the event date is in the range specified. 

Limit to weddings with missing sizes...List those events that contain rental orders without 
sizes entered. 

Single event...Only print the selected event.  

Too many free rental orders…List those events where the total number of FREE rental orders 
exceed the free order ratio defined within System/Set-up - Rental tab. 

Sort by Event Name or Event Date…Prints the report in the selected sequence. 

Manager Reviewed 

All… Lists all events whether the reviewed checkbox on the Event form – Event Tab is checked 
or not. 

Reviewed Only… Lists all events with the reviewed checkbox is checked in the Event form – 
Event Tab. 

Not Reviewed… Lists all events with the reviewed checkbox is Not checked in the Event form – 
Event Tab. 

Buttons 

OK…Process the criteria and run the report. 

Cancel…Quit without running the report and return to the previous screen. 

Statements 

Switchboard: Main->Reports->Cust/Event/Pros Reports->Statements  

Menu: Reports->Cust/Event/Prospect Report->Statements 

Action: RP_AR 

This report prints a statement for each customer that has a balance. The statement is formatted 
to be folded and inserted into a windowed envelope. 
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Print statements for customers with a balance greater than...Only customers with a balance 
equal to or greater than this amount will have a statement printed. Note that statements 
will print regardless if the customer has items that are received or not. 

Print a receipt rather than a statement...If checked, WinPOS® will print a the WinPOS receipt 
for each customer rather than a statement. 

Duplicate Customers Report 

Switchboard: Main->Reports->Cust/Event/Pros Report->Duplicate Customers  

Menu: Reports->Cust/Event/Pros Report->Duplicate Customers  

Action: RP_DUPCUST 

This report lists all the customers where two or more customers have the same first and last 
name, and city and state. This is used to delete duplicate customers. 

Customer Add On Report 

Switchboard: Main->Reports->Cust/Event/Pros Reports->Customer Add-ons  

Menu: Marketing->Customer Add-ons  

Action: RP_ADDON 

 

This report lists OR prints mailing labels for all customers or brides of events that purchased 
one category of item, but not another. It is a great marketing tool to identify certain customers to 
contact for promoting add on business. 

Criteria 

Who to list 

Only one of the checkboxes can be checked. 

List customers where they checkbox…List individual customers. 

or 

List events/brides where someone in the event checkbox…List events & brides (primary 
contact) when a member of the event purchased some item but not another. 

What to list 

Bought an item from one of the following categories…list the category of item(s) purchased. 

Between the following dates...Enter a date range of when the item had to be purchased. 

But did not buy an item from the following categories…List the catgories that was not 
purchased. 

Buttons 

OK…Process the criteria and run the report. 

Cancel…Quit without running the report and return to the previous screen. 

Gift Card Balance Report 

Switchboard: Main->Reports->Sales Reports->Gift Card Balances  

Menu: Reports->Cust/Event/Prospects Reports->Gift Card Balances  

Action: RP_GIFTCARD 
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This report lists gift card transactions that fall between an specified date range.  The report lists 
gift card/document account number, transaction date (transaction is when money is added or 
deducted) and gift card/document balance. 

Criteria 

Last transaction between date…List individual customers. 

 

Buttons 

OK…Process the criteria and run the report. 

Cancel…Quit without running the report and ret 

Event Analysis Report 

Switchboard: Reports->Customer/Event/Pros Reports-> vent Analysis Report  

Menu: Reports->Customer/Event/Pros Reports->Event Analysis Report  

Action: RP_EVNTAL 

 

Management report showing event statistics pertaining to members and revenue and providing 
rental event penetration effectiveness. This report provides an summary event analysis for the 
criteria entered.  Data such as number of events by year & month, number of  members, how 
many members are female vs male roles, event revenue, Average Revenue, Events with any 
rental orders, rental orders paid and unpaid and paid rental order percentage  (rental order 
analysis only with WinTPOS option). 

 

Columns 

First column is the month and year of the events taking place. 

Events 

Members 

Avg # of Memebers per Events 

of those members how many are male 

of those members how many are female 

Total revenue for all events in month 

Avg Revenue = Tot Rev / # Events 

# Events in month with Rental orders 

Events with rentals %:  events with rental / Events with rentals 

# Unpaid rental orders 

# Paid rental orders 

Paid Orders Percentage = paid orders / total orders 

 

Criteria 

One date selection is allowed per report run 

Event created between... Events created within the date entered will be included when their 
event date matches the other criteria of this report. 
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Event date between... The event date of the of the events selected from the Event Created 
between criteria must fall between the entered event date range to  be totalled in the 
report. 

Limit to events from... Optional Multi-store feature.  Select the store/accounts to include events 
& orders for within the report.  Leave blank for all. 

Event Type... All types is the default, meaning events with any type is included. Or select the 
type code assigned to the event. Examples are Wedding, Social or School.  

Event SA...Limit to events where the event SA match this SA. 

BM SA...Limit to events where the BM SA on the event matches this SA. 

Rental SA...Limit to events where the Rental SA on the event matches this SA. 

 

This report groups on year plus month & totals by year. 

Prospect Action List 

Switchboard: Main->Reports->Prospect Action List 

Menu: Reports->Customer Events Prospects->Prospect Action List 

Action: RP_PROACT 

 

The prospect action report list open TO-DOs which greatly expands the capabilities of 
maintaining and tracking tasks, actions & to-dos for prospects, events and customers. 

This report prints all the prospect open TO-DOs  items due during the dates specified of with 
blank TO-DO due dates. 

One page is printed per sales associate. 

 

Print prospect TO-DOs due ...Date range. You must enter a due date range. 

Limit to stores(s)...Only print to-dos for the selected stores. 

Prospect Listing Report 

Switchboard: Main->Reports->Prospect Listing  

Menu: Reports->Cust/Event/Prospect Reports->Prospect Listing 

Action: RP_PROSLIST 

This report prints a list of prospects for the criteria enter and includes the Wedding date, Bride 
Name, Address, Sold date, Register date, Work Phone, Home Phone, Sales Associated that 
registered bride email. groom email & Prospect Type data within the report.  The report totals 
the number of prospect selected by the criteria. 

 

Selection Criteria 

Wedding Dates or Register Dates...select either Wedding Dates or Register Dates to limit 
printing by a entered date range for the selection 

Category...This refers to the inventory category of the merchandise entered on the Prospect's 
Interest form. Leave blank for all categories. Or enter a single category or multiple 
categories separated by commas.  Use the look up binoculars to select categories. 
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Vendor...This refers to the inventory vendor of the merchandise entered on the Prospect's 
Interest form. Leave blank for all vendors. Or enter a single vendor or multiple vendors 
separated by commas.  Use the look up binoculars  to select vendors. 

Store(s)...This selection is only available in multi-store installations. This refers to the store that 
registered the prospect(s).  Leave blank for all stores. Or enter a single store or multiple 
stores separated by commas.  Use the look up binoculars to select stores. 

Style Code...This refers to the inventory style of the merchandise entered on the Prospect's 
Interest form. Leave blank for all styles. Or enter a single style.  Use the look up 
binoculars for help to select a style. 

Price Point Range...This refers to the inventory merchandise entered on the Prospect's Interest 
form. Leave blank for any price point range. Or enter a price range.  The first field is the 
minimum price and the second field is the maximum.  The system will only select 
prospects with merchandised entered on the Interest form that fall between the minimum 
& maximum price (current price entered in inventory for the item). 

Discontinued after date...Limit prospects by items that are listed on the favorites that are or will 
be discontinued after the entered date.  These items need to have the discontinue date 
entered within inventory for the styles.  This is how WinPOS© knows the discontinued 
date for ANY style. 

selection based upon items entered on favorite list that are discontinued after a user entered date 

Sales Associate...This field refers to the Sales Associate that registered the prospect.  Leave 
blank for any SA or enter a single SA to list only their prospects. Use the look up 
binoculars to select a SA. 

Prospect Type...This field refers to the Prospect/Customer Type entered on the Prospect form. 
 Leave blank for all Types or enter a single Type to list only those that match.  Use the 
look up binoculars to select a Type. 

Prospect Source... Select the advertising source that drove the prospect to your store.  Leave 
blank for any source. 

Hint 

WEBREQUEST is a source code used by the BBL marketing module when inserting web 
form prospects into the prospect.  This code should appear in your source file so you may 
report on those prospect entries created by the marketing web forms.  If it does not please 
go to that form and add it.  Found in Housekeeping-> General Setup-> Customer Source 

Who have purchased or Who have NOT purchased or ALL...Limit your list by whether the 
Prospect has had an event registered.  The system determines this by the presence of a 
Event Number on the Prospect form.  If a event number is present then the Prospect is 
considered as purchased, blank/empty the Prospect is considered NOT purchased. 

 

Sort Order 

Wedding Date or Name or Zip Code...The sequence of the listed prospects is controlled by this 
selection.  Wedding/Event date or Bride's name or Bride's zip code. 

 

Buttons 

OK…Process the criteria and run the report. 

Cancel…Quit without running the report and ret 

PO Reports 
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Purchase Orders Issued But Cancelled Report 

Switchboard: Main->Reports->PO Reports…->Issued But Cancelled  

Menu: Reports->Purchase Order Reports->Purchase Orders Issued But Cancelled 

Action: RP_CANCPO 

This report shows you special order purchase orders that were issued, but the transaction on 
the ticket was cancelled after they were issued.  WinPOS© does not automatically alter issued 
POs since it requires communications to the vendor to handle the situation. 

Issue POs for specials must be manually cancelled with the vendor when the ticket transaction 
is cancelled. 

This report should be ran on a regular basis to insure the open POs are properly handled. 

Criteria 

Limit to stores... With optional multi-store capability you can see cancellations made at specific 
stores. 

Purchase Orders Paid in Full Not Received Report 

Switchboard: Main->Reports->PO Reports…->Paid In Full, Not Received  

Menu: Reports->Purchase Order Reports->Paid In Full, Not Received  

Action: RP_PONRECV 

 

This report is available to WinPOS installations set to Ticket Zero or Customer Pickup revenue 
accounting and is a cash flow tool to compute the cost of sales of customer's special orders. 
 These paid in full special orders are shown as revenue with a cost of sales in WinPOS, 
however an invoice has not been received. 

For the cost of items ordered for customers to included, the revenue cannot be realized within 
the date range specified  

WinPOS may force an PO item's cost to zero dollars if: 

a) The item's revenue has not been realized  

b) The revenue was realized OUTSIDE the date range specified.   

Otherwise the cost will stay intact and totaled on the report. 

 

Criteria 

Create date between...Only show PO’s created in within this date range.  Items created within 
the range AND not received (item's PO received date) within the range will be listed on 
the report. 

Sort by...Sort options are: 

• Issue date 

• Create date 

Can select only one filter option: 

Remove zero cost and revenue realized items... Suppress PO items if the PO item cost is 
zero. 

Remove items received or revenue realized outside the date range... Do not list these PO 
items. 
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Remove items received or revenue realized outside the date range, and zero cost items... 
 Do not list these PO items. 

 

Purchase Order Listing Report 

Switchboard: Main->Reports->PO Reports…->Purchase Order Report  

Menu: Reports->Purchase Orders Reports->Purchase Order Report  

Action: RP_POISS 

 

This report displays/prints a listing of  PO items per the criteria entered by the user.  It is a 
helpful tool to review on PO activity, follow-up on outstanding POs and to determine upcoming 
costs once the orders are received.   

The report is grouped by event with stock orders being listed at the top of the report (when the 
Stock Order checkbox is checked).   

The report detail includes, Event # & Event name.  The PO item number, event date, customer 
name, last transaction date, vendor style, size, color, width, vendor code, role, item cost, 
confirmation date/#, date received, quantity ordered, quantity received and percentage of total 
ticket paid by customer and special instructions are included on report. 

If outstanding cost is selected then the report shows only the cost of un-received line items on 
stock orders, since a stock order can be partially received.  A special order PO item is 
completely received or un-received so this setting has not effect on them. 

This report offers many criteria options to filter the report.  It is easy to enter a criteria 
combination that will result in NO items selected.  Please carefully analyze the criteria to 
achieve the desire results. 

 

Report Selection Criteria 

Show 

Un-Issued or Issued (checkbox)... One of these check-boxes must be selected.  The report will 
list Open (issued) POs or PO items not yet issued as POs. 

 

Group by 

Vendor... Group & sub total by vendor, 

Category... Group & sub total by category, 

No Grouping.. Chronological list our POs. 

 

Criteria 

Limit to Category...Limit the list to items from the entered category.  A blank field will capture 
ALL categories. 

Limit to vendor...Limit the list to items from the entered vendor.  A blank field will capture ALL 
vendors. 

Style Code...Limit the list to items from the entered inventory style code.  A blank field will 
capture ALL styles. 
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Vendor Style Code...Limit the list to items from the entered vendor style.  A blank field will 
capture ALL items. 

Limit to Stores...Available in multi-store installations. Enter store locations and the report will 
limit to the PO items for members of  events where the event was created at the store. 
 When the PO Item is not linked to an event the report will list the PO Item(s) created at 
those store(s).  Multiple stores must be separated by a comma  A blank field will capture 
ALL stores. 

Role...Limit the list to items from for customers in events with the entered role.  A blank field will 
capture ALL customer roles. 

 

Show Special Order (checkbox)...Checked, the listing will include customer special order PO 
items. 

Show Stock Order Items (checkbox)...Check, the listing will include PO items for stock. 

Show Received items (checkbox)? ... Checked, it will limit the report to only those PO items 
that have been marked received,i.e. where the quantity ordered equals the quantity 
 received.  Un-Checked fully received items will not appear on the report. 

 

Date Range 

Issued (for issued POs)... Enter the issued date range for POs issued/created. 

Event (for issued or un-issued)...Enter the Event date range for special order items 
issued/created.  Special order items for customers not associated with an event will 
always be listed no matter what event date range is entered. 

Received (for issued POs)... Enter the RECEIVED date range for POs issued.  

 

Confirmed Options - available for Issued POs listing 

No confirm date...  checked, the report includes items with no confirmed shipping dates entered. 

Any confirmed date... checked,  the report includes items with no confirmed shipping dates 
entered. 

Confirm date range.. Issued POs with confirmed shipping dates within the date range entered 
are included. 

 

SmartLink - available for Issued POs listing 

All orders...Include all orders, whether or not sent via Smart Link. 

Orders not sent via Smart Link...Filter out any orders sent via Smart Link. 

Sent.. Only include orders if they were sent via Smart Link within the date range specified. 

 

Display 

Total Cost....When selected  the system will display the total original cost of the PO Item 
irregardless of the outstanding quantity. 

OR 

Outstanding cost ..When selected the report lists only the costs for Un-Received PO Item 
quantities.  Un-Received Qty * Unit Cost 



WinPOS Version 11 

310 

 

Buttons 

Cancel...Exits the PO Report form and returns to the previous form. 

Ok...Processes the report with the entered criteria. 

 

Order Reports (Rental Orders) 

Orders Report 

Switchboard: Main->Reports->Orders Report->Orders  

Menu: Reports->Rental Orders Report->Orders  

Action: RP_RESERVATION 
 

This report is available with the WinTPOS© software option is for retail type store/accounts. 

This report lists all of the rental orders that qualify according to the criteria specified. It is useful 
to find out how many orders are expected for a particular weekend (specify the weekend for the 
date range and select all statuses) or to show orders that you are still waiting to receive from 
your suppliers (status Confirmed).  The report totals the number or orders selected & printed on 
the report.  When the order is returned without the customer picking it up, the code NO SHOW 
will appear next to the number. 

Criteria 

Pickup date, order date, or assembly between xxx and yyy (checkbox)...Select what kind of 
date range to use, then enter the date range.  You must enter a date range. 

Order Status...Select all the order statues to limit the report data.  Hold down the Ctrl key and 
click each order status to include in the report.  For all orders select the ALL STATUS 
selection. 

Only show sub-rented line items (checkbox)...Will only include orders that contained any item 
that was marked for sub-rental. 

Hide order line items? (checkbox)...If checked, the report will only show order header details, 
and will not include the actual styles rented. 

Orders with or without deposit, Only orders without deposit, Only orders with deposit 
(checkbox)…Check the selection that you wish to limit report data. If any payments have 
been made towards an order, the orders is considered to have a deposit made. 

Pickup at store(s)…Enter one or more store ID's (separated by commas) to limit the report to 
orders to be picked up at those stores. 

Ordered at store(s)…Enter one or more store ID's (separated by commas) to limit the report to 
orders that were ordered at those stores. 

Group by pickup account? (checkbox)…If checked, the report will list the orders sorted on and 
broken down by pickup accounts.  Otherwise, the report is sorted by pickup date. 

Overbooked Orders only?... Checked, the report will only show orders that have some item on it 
overbooked for the time period needed. 

Buttons 

Done... Run the report with the enter criteria 

Cancel...Exit the report, do not run it and return to the previous form. 
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Held Orders Report 

Switchboard: Main->Reports->Orders Report->Held Orders  

Menu: Reports->Orders Reports->Held Orders  

Action: RP_HELD 
 

This report is available with the WinTPOS© software option is for retail type store/accounts. 

This report lists all of the rental orders that have a status of Hold. Orders may be marked HELD 
on the Order Entry -> Detail tab or during the Production Assembly/QC. 

When you save a new rental order, one of the options is to Hold it. 

 

Criteria 

Pickup at store(s)…Enter one or more store ID's (seperated by commas) to limit the report to 
orders to be picked up at those stores. 

Future Rental Orders Report 

Switchboard: Main->Report->Orders Reports->Future Orders Report  

Menu: Reports->Rental Orders->Future Orders Report  

Action: RP_RESVFUTR 

Overview 

This report is available with the WinTPOS© software option. 

It will show total events with any rental orders registered, for the date range specified in the 
criteria, grouped by weeks. For each date range, it will show the number of events registered 
(that have at least one member with a created rental order), how many members in those 
events have no order, how many orders are registered for those events, how many single 
orders are registered, and finally the expected revenue for all those orders and members. The 
report is useful as a sales/rental activity analysis tool. 

Events could be registered with no rental orders created.  These do not show on the report. 
 Later when at least one rental order is created for an event's member the event will be listed on 
the report.  As a result event totals for a time period may change as new rental orders are being 
created. 

For orders or events to be counted they must be within the created or pickup date range and be 
created at the stores (in multi-store implementations) entered by the user.  For events with 
registered members without orders the system will compute the cost of the 'yet-to-be created' 
member's rental based upon the pricing for the store/location running the report (store pricing is 
a multi-store feature where a store may have different prices from other stores for the same 
rental styles) 

Criteria 

Pickup date range for first period...The report will count events and rental orders where the 
event pickup date falls within the date range specified here.  

Rental Event Created for first period...The report will count events and rental orders where the 
event rental registration date falls within the date range specified here. 
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Periods to show…The report will also count the events and orders for the number of periods 
specified here. The length of each period is the same as the length of the pickup date range 
specified above. For example, if the pickup date range specified is 1/1/2011through 1/7/2011, 
then the period length is seven days. If the periods to show is 12, then the report will show the 
week of 1/1/2011-1/7/2011, and then the next 12 weeks. 

Limit to stores…In multi-store installations the report will limit to events that were registered at 
the stores specified, or where the single orders are to be picked up at the store(s) specified. 

Rental Orders/Upgrade Report 

Switchboard: Main->Reports->Orders Report->Rental Orders/Upgrade  

Menu: Reports->Rental Orders Report->Rental Orders/Upgrade  

Action: RP_RENTUPG 

 

Overview 

This report is available with the WinTPOS© software option is for retail type store/accounts. 

This report shows how many rental orders were sold with accessory upgrades. An upgrade is 
an accessory that belongs to a rental Item Type that is defined as an accessory.. It also counts 
how many orders were sold with damage waivers. 

First, it counts how many reservations were created by each SA for the Pickup Date range 
entered, and the total rental price for those reservations as it appears on the ticket. If the rental 
price has been adjusted via an adjustment on the ticket the total on this report will reflect that 
adjustment. 

The report will list up to eight(8) accessory Item Types on the report & calculate a total number 
for each that are considered upgrades (those with Price Group names other than Basic). 

This report will also show the number of orders within the date range entered with any money 
applied toward the balance. The heading is called Advanced Deposit. 
 

Criteria 

Pickup date between xxx and yyy...This is the pickup date for the rental order. You must enter 
a date range. 

Orders created at…Enter one or more store ID's (separated by commas) to limit the report to 
orders that were ordered at those stores. 

Rental Orders and Pricing Report 

Switchboard: Main->Reports->Orders Report->Rental Orders and Pricing  

Menu: Reports->Rental Orders Reports->Rental Orders and Pricing  

Action: RP_RENTORDPRI 
 

This report is available with the WinTPOS© software option is for retail type store/accounts. 

This report shows the original rental price vs. the discounted rental price for rental orders 
according to the criteria you select. The report is grouped by sales associate. It can be used to 
identify sales associates that may be giving inappropriate discounts and/or where customer's 
have NOT paid for orders that should have been paid.. 
 
Criteria 
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Pickup date or Return date or Created date  between xxx and yyy...The report can analyze 
orders based on the registration date or return date. 

Ordered at store(s)…Enter one or more store ID's (separated by commas) to limit the report to 
orders that were ordered at those stores. 

Limit to discounted Orders ...Will only display/print those orders where the ticket price (amount 
charged to customer) is different than the rental order price (the price the system 
defaulted to for the order which is based upon management set-up). 

Limit to orders with balance due...Will only display/print orders where the customer still has a 
balance on their ticket. 

Limit to no-show orders... The will include only those orders that were marked as NO SHOW. 
 Done by returning the order without it being marked PICKED-UP by the customer. 

Rental Balance Different Report 

Switchboard: Main->Reports->Orders Report->Balance Difference Audit Report  

Menu: Reports->Orders Report->Balance Difference Audit Report  

Action: RP_BALDIFF 
 

This report is available with the WinTPOS© software option is for retail type store/accounts. The 
type is set within the Housekeeping-> General Setup-> Stores-> Rental tab-> Pricing/Type field. 

This report will show all orders of retail stores where there is a difference between the original 
price of a rental order when it was first created to the current customer sales ticket linked to the 
order.  The ticket amount is what the customer would be paying for the rental order.  The 
amount compared is the original order price + tax + damage waiver to the current like values on 
the ticket.  The report is sorted by order number. 

Criteria 

Pickup date between xxx and yyy...This is the pickup date for the rental order. You must enter 
a date range. 

Ordering store(s) is…Enter one or more store ID's (separated by commas) to limit the report to 
orders that were ordered at those stores.  Stores/Accounts with Retail Type set to 
RETAIL can be selected. 

Show...The report can show orders as follows.  May choose only one for a report. 

• All: All rental orders within the pickup date range specified and ordered at the stores 
entered will be printed 

• Where Plant and POS price differs: Only orders where the price entered into TPS 
Plant and the actual WinTPS order price in WinTPS differ. 

• Where the ticket balance is not zero: All orders where the WinTPS balance is non-
zero will be printed. 

Late Fees/Dmg Waivers 

Switchboard: Main->Reports->Orders Report->Late Fees/Dmg Waivers  

Menu: Reports->Rental Orders Report->Late Fees/Dmg Waivers  

Action: RP_LATEFEE 
 

This report is available when the BBL WinTPOS© module is installed.  It will list Late Fees 
applied to orders being returned past the Return date entered on the rental order grouped & 
totalled by rental order sales associate.  It can also list Damage Waiver sales charged on rental 
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orders.  This report is useful as a management audit report of these charges.  The report also 
highlights those charges that were cancelled with percentages.  The report includes the order 
number, ticket number and invoice number (when the fee was to a wholesale account via the 
optional WinTPS© module) and price charged for the fee.   

Criteria 

Sold between...Limit the transactions that were sold/created in the entered date range. 

or 

Revenue Realized between...Limit the transactions to the date range of when their revenue was 
realized.  Revenue is realized based upon the accounting method selected in WinPOS©. 

Summary report only? (checkbox)...Unchecked the report will list each transaction and the 
ticket/invoice number.  Checked a grand total will print. 

Only show items where the revenue is has been realized? (checkbox)...Limit the listing to only 
transactions that the revenue has been realized. 

Limit to store(s)...In muti-store installations the report will limit to transactions created at the 
store(s) specified. 

Show late fees? (checkbox)...Checked, the report will show Late Fee sales transactions. 

Show damage waivers? (checkbox)...Checked, the report will show Damage Waiver sales 
transactions. 

Rental Registrations/14 week count 

Switchboard: Main->Reports->Orders Report->Rental Registrations/14 week count Report  

Menu: Reports->Rental Orders Report->Rental Registrations/14 week count Report  

Action: RP_RENTREG 
 

This report is available with the WinTPOS© software option is for retail type store/accounts. 

For each sales associate this report shows how many orders they have registered, the total 
revenue expected for those orders, the average price per order, the number of free orders 
given, the number of rental orders cancelled, and finally the number of orders registered for 
each of the 14 periods following the date range specified & grand totals for all sales associates. 

The report is useful to analyze sales associate performance, as well as predict upcoming rental 
order volume. 

Criteria 

Pickup date between xxx and yyy...This is the pickup date for the rental order. You must enter 
a date range.  The number of days that comprise the date range is calculated.  The days 
are added to the ending date to create Period 2, then added again to the ending date of 
period 2 to make Period 3.  This goes on for 13 periods. 

It is recommended that a week (or 7 days) date range is entered, for whatever week is 
interesting.  This approach will make each period calculation be for  on a week's worth of 
orders. 

Pickup at store(s)…Enter one or more store ID's (separated by commas) to limit the report to 
orders that are be picked up at those stores. 

Delinquent Orders 

Switchboard: Main->Reports->Orders Report->Delinquent Orders  

Menu: Reports->Rental Orders->Delinquent Orders  
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Action: RP_RESVLATE 

 

This report is available with the WinTPOS© software option is for retail type store/accounts. 

This report shows rental orders that have not been fully returned by their return date. The report 
shows the contact information for the customer as well as the order details.  Only orders of 
status Picked Up are listed since this is a POS late report.  The return date for orders to 
wholesale accounts is adjusted to take into account ship date when computing the overdue 
date. 

 

Criteria 

List orders x or more days overdue...Days overdue is computed using the return date. 

Pickup at store(s)…Enter one or more store ID's (seperated by commas) to limit the report to 
orders that are be picked up at those stores. 

Misdirected Orders 

Switchboard: Reports->Orders Report->Misdirected Orders 

Menu: Reports->Rental Orders Report->Misdirected Orders 

Action: RP_RESVMIS 

 

This report is available with the WinTPOS© software option is for retail type store/accounts. 

This is a report tool used in Multi-Store locations to help locate a missing Order.  Many multi-
store locations required orders to be scanned in as they are received from the warehouse.  Via 
human error it may be feasible for the operator to accept/scan a order that should had been 
sent to another company location.  This report will provide a detailed order report of any order 
where it's current location differs from the pickup location.   

It lists all the order details making it easier for someone to locate and direct the order to the 
proper location. 

 

Criteria 

None 

Detailed Rental Event List 

Switchboard: Reports->Orders Report->Detailed Rental Event List  

Menu: Reports->Rental Orders->Detailed Rental Event List  

Action: RP_RENTEVNT 

 

This report is available with the WinTPOS© software option. 

This report provides a detailed list of Events and Single Orders during the specified time period 
selection.  Selection date ranges may be: Rental Registered (the date the first order was 
created for the event) OR Order Pickup  OR Rental Event Created Date ranges grouped by 
Sales Associate ID .   

The report considers the Rental Created date located on Event Registration form and the Single 
order created date when choosing Rental Event Created dates.  When choosing Pickup Dates 
the reports looks at the pickup date entered on the event and for single orders the pickup date 
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located on the order itself.   For the rental event to be listed on the report the event must contain 
at LEAST one member with a rental order for the event. 

With the multi-store option, the orders are counted for the  based upon the order's pickup 
account and if that account was included in the report selection criteria..  Frequently a store 
creates an event with orders being picked up at other locations..  In this situation the event is 
counted for the store that created it, but the orders are counted for the store where they will be 
picked up. 

This is a great report to see new booking activity  by registration created dates and upcoming 
workload requirements when ran by order pickup dates.   

Many shops may elect to pay spiffs/commissions for event registrations based upon the Event 
Registered date.  Once the first order is created for the event this date will be set to the created 
date and will not change, even when the original order is cancelled or deleted. 

The Expected Revenue column of the report is the forecasted revenue based upon member 
order registrations (found usually in wedding parties where members are pre-registered).  Does 
NOT include created orders revenue (these are found in booked rev. column). 

The Booked Revenue column of the report is all created  order's net value found on it's ticket. 

 

Criteria, one selection is allowed for a report run 

Pickup Date between... This is the pickup date entered on the event or for single orders the 
pickup date located on the order itself.  A minimum of one order must be created for the 
event for the event registration to be listed.   

Rental Event Created... This is the rental registered date located on Event Registration form and 
the Single order created date.  A minimum of one order must be created for the event for 
the event registration to be listed.   

Rental Registered... This is the date the first rental order is created for any member of the event. 
 A minimum of one order must be created for the event for the event registration to be 
listed.  Single Rental Orders are also listed in the report with a included created date. 

Event SA...Limit to events where the event SA match this SA. 

BM SA...Limit to events where the BM SA on the event matches this SA. 

Rental SA...Limit to events where the Rental SA on the event matches this SA. 

Limit to events from... Optional Multi-store feature.  Select the store/accounts to include events 
& orders for within the report.  Leave blank for all. 

Note for Multi-store 

Store Scenarios 

1) Field is blank to include all Stores 

All events and all orders appear on report 

2) Some stores are selected 

Event must be created at one of selected stores, pre-registered (orders not created yet) 
member/revenue forecast will count for store creating the event, created order counts and 
revenue for the event (if on the report) will only appear if the pickup store/account appear in 
the selected store list. 

Group by, Sales Associate or Event Type... The report may be grouped and totaled by 
selected Sales Associate type (Event, BM or Rental) or Event Type.  The Event 
registration card contains three Sales Associate (SA) fields. Event SA (who created the 
event - in bridal stores this is usually the SA who sold the wedding gown), Bridesmaid 
(BM) sales associate (SA responsible for bridesmaid members) and Rental SA ( SA 
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responsible for rental members).  Orders are grouped by the Event SA if the Rental SA & 
BM SA are empty (blank).. 

Summary report only? (checkbox)... Checked the report prints only the totals for each grouping. 

 

 

 

 

Rental Orders Pricing/Margins Report 

Switchboard: Main->Reports->Orders Report-> Pricing/Margins  

Menu: Reports->Rental Orders Report->Rental Orders Pricing/Margins  

Action: RP_RENTMARG 

 

Overview 

This report groups orders by store then sales associate and provides the gross price of rental 
orders, a discount percentage (if any) cost (if any) and margin. 

 

Criteria 

Choice of date range for (may choose only one): 

where the pickup date range is 

where the return date range is 

where the created date range is ... Orders of the select date type and inclusive of the dates 
entered will be included. 

 

Summary report only? checkbox...Enabled (checked) the report provides totals only.  Disabled 
the report displays the information for each ordered included. 

Pickup at...Include orders of only the entered pickup location/store id.  Leave field blank for all 
locations. 

Ordered at...Include orders of only the entered ordered at location/store id.  Leave field blank for 
all locations. 

 

 

Rental Order Exchanges Report 

Switchboard: Main->Reports->Orders Report->Rental Order Exchanges 

Menu: Reports->Rental Orders Report->Rental Order Exchanges 

Action: RP_RENTMARG 

 

Overview 

This report is available with the WinTPOS© software option is for retail type store/accounts. 
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This report helps perform an analysis of exchanges.  The lower the number of exchanges the 
more profitable the shop will become. This report  groups by store (with multi-store option), then 
by each Sales Associate (SA), then grouped by reason under SA. for the report's selection 
criteria. 

A SA will appear on the report if they had an exchange.  When the SA is listed, the system also 
lists for the SA's total number of orders, their total exchanges with their percentage of 
exchanges to orders.  Finally the report provides the total orders for the store and total 
exchanges with a percentage. 

 

Criteria 

Choice of date range for (may choose only one): 

where the pickup date range is 

where the return date range is 

where the created date range is ... Orders of the select date type and inclusive of the dates 
entered will be included. 

 

Summary report only? checkbox...Enabled (checked) the report provides totals only.  Disabled 
the report displays the information for each ordered included. 

Pickup at...Include orders of only the entered pickup location/store id.  Leave field blank for all 
locations. 

Ordered at...Include orders of only the entered ordered at location/store id.  Leave field blank for 
all locations. 

 

 

Order Status Report 

Switchboard: Main->Reports->Orders Report->Order Status  

Menu: Reports->Rental Orders Report->Order Status  

Action: RP_RESVSTAT 
 

This is an optional report for users of BBL DOS TPS Plant software.  The report lists the order 
number, pickup store, ordering store, and the order status. It is visible for users with the TPS 
DOS software module installed. 

 

Criteria 

Pickup date between xxx and yyy...This is the pickup date for the rental order. You must enter 
a date range. 

Orders created at…Enter one or more store ID's (seperated by commas) to limit the report to 
orders that were ordered at those stores. 

Sales Reports 

Sales By Category Report 

Switchboard: Main->Reports->Sales Reports…->Sales By Category  
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Menu: Reports-Sales Reports->Sales By Category 

Action: RP_SALECAT 

This report groups/totals sales by inventory category and sub-category. It is useful to see how 
the different types of items are selling, based on their grouping via the categories. 

Dynamic View 

This report output option displays the report results on-screen in a concise, summarized format. 
 It displays one row for each inventory category with the sub-totals for that category. 
 Clicking on that row then shows sub-rows for each sub-category.  Finally, clicking on a 
sub-category displays the actual sales records for that category and sub-category. 

  

Criteria 

Select transactions...Only sales that fall within the date range specified will print. You must enter 
a date range. The date range can mean one of two things, depending on your selection: 

• Sold between xxx and yyy: Print items that were sold between the dates specified, 
regardless of when (or if) the revenue has been realized. 

• Revenue realized between xxx and yyy: Only print items where the revenue has 
been realized within the date range specified. On the cash accounting method, 
these options are identical. 

Limit to category...You can limit the report to a specific category, if you like. Leave blank for all 
categories. 

Summary report only (checkbox)...This option will suppress the actual styles sold, and just show 
the totals for each category. 

Only show items where the revenue has been realized?(checkbox)...This will only show items 
where the revenue has been realized during the date range specified. 

Show sub-Totals for each sub-category? (checkbox)...This will print a sub total for each 
category's sub category. 

Department...You can limit the report to a specific department, if you like. Leave blank for all 
departments.  

Sub-Total by dept? (checkbox)...Option will sub-total the report by department. 

Limit to stores...This option is available with the optional multi-store module.  It will limit sales to 
the entered stores.  Multiple store IDs may be entered separated by a comma. 

Sub-Total by stores? (checkbox)...This option is available with the optional multi-store module. 
 It will subtotal the sales by the entered store IDs. 

Include rental transactions…If checked, the report will include rental transactions under the 
category RENTAL. RENTAL is a system defined category and cannot be directly used on 
retail inventory. This option is only available with WinTPS. 

Show items...You can choose what types of sales to include: 

• Sold from Stock 

• Special Order 

• Stock and Special Order 

Sales By Vendor Report 

Switchboard: Main->Reports->Sales Reports…->Sales By Vendor  

Menu: Reports->SA Reports->Sales By Vendor 
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Action: RP_SALEVEND 

This report breaks down your sales by vendor. This report is useful in comparing sales of 
vendor. It also provides a complete sales history for the vendor, which can be a handy 
reference.  

This report never includes rental transactions. 

Dynamic View 

This report output option displays the report results on-screen in a concise, summarized format. 
 It displays one row for each vendor with the sub-totals for that vendor.  Clicking on that 
row then shows sub-rows for each category and sub-category.  Finally, clicking on a sub-
category displays the actual sales records for that vendor, category and sub-category. 

Criteria 

Select transactions...Only sales that fall within the date range specified will print. You must enter 
a date range. The date range can mean one of two things, depending on your selection: 

• Sold between xxx and yyy: Print items that were sold between the dates specified, 
regardless of when (or if) the revenue has been realized. 

• Revenue realized between xxx and yyy: Only print items where the revenue has 
been realized within the date range specified. On the cash accounting method, 
these options are identical. 

Limit to vendor...You can limit the report to a specific vendor, if you like. Leave blank for all 
vendors. 

Limit to store(s)...This option is available with the optional multi-store module.  It will limit sales 
to the entered stores.  Multiple store IDs may be entered separated by a comma. 

Summary report only...This option will suppress the actual styles sold, and just show the totals 
for each category. 

Only show items where the revenue has been realized?...This will only show items where the 
revenue has been realized. 

Sales By Vendor Style Report 

Switchboard: Main->Reports->Sales Reports…->Sales By Vendor Style  

Menu: Reports->SA Reports->Sales by Vendor Style 

Action: RP_SALEVSTY 

This report breaks down your sales by vendor and vendor style. This report is useful in 
comparing vendors and styles. It also provides a complete sales history for the vendor, which 
can be a handy reference.  

This report never includes rental transactions. 

Select transactions...Only sales that fall within the date range specified will print. You must enter 
a date range. The date range can mean one of two things, depending on your selection: 

• Sold between xxx and yyy: Print items that were sold between the dates specified, 
regardless of when (or if) the revenue has been realized. 

• Revenue realized between xxx and yyy: Only print items where the revenue has 
been realized within the date range specified. On the cash accounting method, 
these options are identical. 

Limit to vendor...You can limit the report to a specific vendor, if you like. Leave blank for all 
vendors. 

Limit to style...You can limit to a specific vendor style. Leave blank for all styles. 
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Limit to stores...This option is available with the optional multi-store module.  It will limit sales to 
the entered stores.  Multiple store IDs may be entered separated by a comma. 

Sub-Total by store? (checkbox)...Will provide a total for each store contained within the report. 

Summary report only...This option will suppress the actual styles sold, and just show the totals 
for each category. 

Only show items where the revenue has been realized?...This will only show items where the 
revenue has been realized. 

Customer Source Analysis Report 

Switchboard: Main->Reports->Sales Reports…->Customer Source Analysis Report  

Menu: Reports->Sales Reports->Customer Source Analysis Report 

Action: RP_CUSTSRC 

 

This report groups prospects and customers by the source specified when they were created. 
Set up valid sources in Customer Sources. 

 

Criteria 

Registration date between...Only analyze prospects/customers entered within this date range. 
You must enter a date range. 

Limit to stores...This option is available with the optional multi-store module.  It will limit data to 
the entered stores.  Multiple store IDs may be entered separated by a comma. 

Invitation Sales/Pricing 

Switchboard: Main->Reports->Sales Reports…->Customer Source Analysis Report  

Menu: Reports->Sales Reports->Customer Source Analysis Report  

Action: RP_INVSALPRI 

 

This sales report includes only sales transaction of the style code INVITATION. 

 

Criteria 

Limit to stores...This option is available with the optional multi-store module.  It will limit data to 
the entered stores.  Multiple store IDs may be entered separated by a comma. 

Print statistics for invitation sales for the week ending...Enter a date & WinPOS© include 
sales transaction for the date and six days prior. 

Sales Forecast Report 

Switchboard: Main->Reports->Sales Reports…->Sales Forecast  

Menu: Reports->Sales Reports->Sales Forecast 

Action: RP_SALEFOR 

 

This report will project your stock inventory sales for a selected time period, and compare that 
with your quantities on hand and outstanding stock purchase orders to show which weeks or 
months you may be short of inventory. 
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First, you select a time period, which can be weeks or months. You can select 1-12 week or 
month periods. You can also select on which date the projection should start. Then, you select 
the classification of inventory you want to analyze. You can select by inventory category, 
vendor, or style code. WinPOS© will then perform the following analysis to create the report. 

Assume you have selected to forecast the next 12 months of sales. 

First, WinPOS© will total your stock sales for each inventory item month by month for the last 12 
months. These totals will be used as the forecasted sales for the next 12 months. 

Then, WinPOS© will total your stock PO’s for each inventory item month by month for the next 
12 months. The confirmation date on the stock PO indicates the month in which it is to be 
received. 

Finally, for each month, WinPOS© takes your current quantity on hand for each inventory item, 
subtracts the forecasted sales, adds the confirmed stock PO items, and uses the result as the 
ending balance for the month. It then repeats the process for each month. 

On the report itself, each inventory item (style, size, color, width) is listed, along with the MTD 
sales, YTD sale, Total sales, current quantity on hand, quantity on stock order, and date last 
received. Next, a grid appears that shows 3 numbers for each time period (weeks or months) 
The first number is the previous sales (which is the forecast), followed by stock orders to be 
received, and finally, the ending balance. 

 

Criteria 

Forecast the next...The report will project your sales for an upcoming time period. You can 
select 1-12 weeks or months, starting on any selected date. WinPOS© will analyze your 
sales for the last 1-12 weeks or months (depending on which you selected) and project 
them out for the next 1-12 weeks or months. 

Limit to vendor...You can limit the report to a specific vendor, if you like.  

Limit to category/sub-category...You can limit the report to a specific category and sub-
category.  

Limit to style code...You can limit the report to a specific style code, if you like.  

Limit to stores...This option is available with the optional multi-store module.  It will limit data to 
the entered stores.  Multiple store IDs may be entered separated by a comma. 

 

Sales With Barcode Report 

Switchboard: Main->Reports->Sales Reports…->Sales With Barcode  

Menu: Reports->Sales Reports->Sales with Barcode 

Action: RP_SALEBCOD 

 

This report shows all your sales for an sales date range, and displays a barcode of the SKU for 
each one on the report. 

 

Criteria 

Sold between xxx and yyy...Only sales between the accounting dates specified will print. 

Limit to stores...This option is available with the optional multi-store module.  It will limit sales to 
the entered stores.  Multiple store IDs may be entered separated by a comma. 
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Sales Detail Report 

Switchboard: Main->Reports->Sales Reports->RP_SALEDETL  

Menu: Reports->Sales Report->Sales Detail 

Action: SALEDETL 

 

This report shows sales transactions broken down into various groupings that are user 
selectable.  The report will have one detail line per style/size/color/width, per store.  It may be 
utilized to see how sales of certain styles/size combinations compare from store to store in 
multi-store configurations. 

The report totals net sales for the Sale transactions selected as of the date the report is ran and 
DOES NOT take in effect the dates of when adjustments were made to those sales.  For 
example, running the Sales Detail report  for a past month includes the adjustments made in the 
current month to that sale transaction because the report analyzes the NET selling price for the 
item regardless when the adjustments were made to the sale transaction.  As a result the totals 
of this report cannot be compared to other sales reports, like sales by category that are date 
sensitive for both the sale transaction and the adjustment transaction. 

 

For example, assume you sell these items: 

Sept 20, sale of style 123  

Oct 2, adjustment to sale of style 123 

Oct 3, sale of style 456 

 

If you run the Sales by Category report for Oct, you'll see the adjustment to 123 and the sale of 
456 since they both occurred in Oct.  

If you run the Sales Detail report for Oct, you'll only see the sales of dress 456, because the 
sale happened in Oct.  You won't see that adjustment to dress 123 since it comes from the sale 
which occurred in Sept. 

Also, if the net retail is zero on the Sales by Detail report, it means that you had net zero sales 
for that style in that time period.  For example, a sale that was mark-downed or canceled.  

 

Report Criteria 

Select transactions...Only sales that fall within the date range specified will print. You must enter 
a date range. The date range can mean one of two things, depending on your selection: 

• Sold between xxx and yyy: Print items that were sold between the dates specified, 
regardless of when (or if) the revenue has been realized. 

• Revenue realized between xxx and yyy: Only print items where the revenue has 
been realized within the date range specified. On the cash accounting method, 
these options are identical. 

Limit to category/sub-category...You can limit the report to a specific category and sub-
category.  

Limit to vendor...You can limit the report to a specific vendor, if you like.  

Limit to stores...This option is available with the optional multi-store module.  It will limit sales to 
the entered stores.  Multiple store IDs may be entered separated by a comma. 
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Only show items where the revenue has been realized?...This will only show items where the 
revenue has been realized during the date range specified. 

Include rental transactions…If checked, the report will include rental transactions under the 
category RENTAL. RENTAL is a system defined category and cannot be directly used on 
retail inventory. This option is only available with WinTPOS/TPS©. 

Show items...You can choose what types of sales to include: 

• Sold from Stock 

• Special Order 

• Stock and Special Order 

Sort...You can choose how the report should be sorted and broken down.  If the first sort order is 
chosen, then the report will first be grouped and sub-totaled by vendor, then by 
category/sub-category, and finally by style/size/color/width/store, with separate records 
for each store.  If the second sort is selected, the report will be grouped by category/Sub-
cat (not by vendor) then by style/size/color/width/store. 

• Vendor/Category/Sub-cat/Style 

• Category/Sub-cat/Style 

• Style 

Sales Graph 

Switchboard: Main->Reports->Sales Reports-> Sales Graph  

Menu: Reports->Sales Reports->Sales Graph 

Action: RP_SALEGR 

This report analyzes sales and displays a graph that summarizes the results according to the 
criteria selected.   

Select transactions...Only sales that fall within the date range specified will be graphed. You 
must enter a date range. The date range can mean one of two things, depending on your 
selection: 

• Sold between xxx and yyy: Graph items that 
were sold between the dates specified, 
regardless of when (or if) the revenue has 
been realized. 

• Revenue realized between xxx and yyy: Only 
graph items where the revenue has been 
realized within the date range specified. On the 
cash accounting method, choosing Sold 
between or Revenue realized have the same 
effect, since revenue is realized when items 
are sold. 

Only show items where the revenue has been realized?...This will only show items where the 
revenue has been realized. 

Limit to vendor...You can limit the report to a specific vendor, if you like. Leave blank for all 
vendors. 

Limit to category...You can limit the report to a specific category, if you like. Leave blank for all 
categories. 

Limit to sub-category...You can limit the report to a specific sub-category, if you select a 
category.  Leave blank for all sub-categories. 
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Limit to style...You can limit to a specific vendor style. Leave blank for all styles. 

Show items...You can choose what types of sales to include: 

• Sold from Stock: These are any non-special order sales. 

• Special Order 

• Stock and Special Order: All sales. 

Limit to stores...This option is available with the optional multi-store module.  It will limit sales to 
the entered stores.  Multiple store IDs may be entered separated by a comma. 

Compare to last year?...If selected, the graph will show the results for the date range specified 
and the same period one year ago next to those results. 

Include rental transactions?...If this option is selected then rental transactions are included in 
the graph. 

What to graph: Y-axis?...The Y-axis is the vertical line on the graph.  For the criteria specified, 
the graph totals one of the following: 

Units: Counts the number of items sold. 

Sales: Counts the total of retail selling price. 

Profits: Counts the price minus cost. 

Cost Counts the cost of items sold. 

What to graph: X-axis?...The X-axis is the horizontal line on the graph.  It breaks down the item 
selected on the Y-axis into groups.  The selections are Category, Sales Associate, 
Vendor, Stores, Months, Weeks. 

Graph type...The graph type can be Bar, Line, or Pie. 

 

 

 

 

SA Reports (Sales Associates) 

Sales By Sales Associate Report 

Switchboard: Main->Reports->Sales Reports-> SA Reports-> Sales By SA  

Menu: Reports->SA Reports->Sales By SA 

Action: RP_SALESA 

 

This report groups sales by Sales Associates (SA). This report is useful in comparing SAs.  

All sales transaction that a Sales Associate (SA) code appears on in the SA 1 or SA 2 or SA 3 
ticket position will be listed under that associate.  

Sales transactions that are split among multiple sales associates will force the report to list all 
the associates that are in position SA 1 or SA2 or SA3, even when the report is ran for just one 
of the sales associates.  As long as the requested associate appears in any of the SA ticket 
positions.  By listing all SAs the report grand totals will be equal the net selling price, cost and 
margin for the all the transactions listed. 

SA 1 should be completed on sales tickets for proper reporting, ie DO NOT put a SA in the SA 2 
or SA 3 positions without a SA code in the SA 1 position first.  
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Report Columns Definition 

QTY is the Qty of the ticket transaction.  On multiple SA transaction splits the QTY is NOT split 
or shown as a percentage. 

Price is the transaction's gross selling price or adjustment amount (markup or markdown). If the 
transaction is split among multiple SAs then the Price is the percentage of the split for the SAs 
on the ticket, i.e. one SA = 100%, two SAs = 50%, three SAs = 33.33% 

Commisionale Amount is the amount of the sale that is commissionable for the listed Sales 
Associate & is determined by the number of SAs listed on the ticket transaction, , i.e. one SA = 
100%, two SAs = 50%, three SAs = 33.33% 

Cost is the transaction's item wholesale cost. If the transaction is split among multiple SAs then 
the Cost is the percentage of the split for the SAs on the ticket, i.e. one SA = 100%, two SAs = 
50%, three SAs = 33.33% 

Hours worked...If the time card module is active and used, the report will print the total hours 
worked for the date range in question, along with their $ per hour, which is the commissionable 
price / total hours. 

Commision...If a commission percentage is entered on the SA form, then the commision is 
computed as percentage of commissionable price. 

 

Criteria 

Select transactions...Only sales that fall within the date range specified will print. You must enter 
a date range. The date range can mean one of two things, depending on your selection: 

• Sold between xxx and yyy: Print items that were sold between the dates specified, 
regardless of when (or if) the revenue has been realized. 

• Revenue realized between xxx and yyy: Only print items where the revenue has 
been realized within the date range specified. On the cash accounting method, 
these options are identical. 

Limit to sales associate...You can limit the report to a specific SA, if you like. Leave blank for all 
SA. 

Print one SA per page...You can print one SA per page if your shop likes to give the reports to 
the sales associates so they can monitor their own sales. 

Department...Sales Associates may be assigned to a department on the Sales Associate 
maintenance form.  This field allows for a departments to be entered and thus only SAs 
assigned to that department will be listed.   

Limit to stores...This option is available with the optional multi-store module.  It will limit 
transactions for the Sales Associates  that occurred at the included store.  Multiple store 
IDs may be entered separated by a comma. 

Sub-Total by stores? (checkbox)...This option is available with the optional multi-store module. 
 It will subtotal the sales by the entered store IDs. 

Summary report only...This option will suppress the actual styles sold, and just show the totals 
for each category. 

Only show items where the revenue has been realized?...This will only show items where the 
revenue has been realized. 

Commissionable sales only...You can specify whether to pay commissions for each Accounting 
Class. If this option is checked, only commissionable sales will print. 
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Show profit information...If checked, WinPOS® will print the profit, which is the selling price 
minus the cost. 

Include rental transactions…If checked, the report will include rental transactions under the 
category RENTAL. RENTAL is a system defined category and cannot be directly used on 
retail inventory. This option is only available with WinTPS. 

Close Ratios Report 

Switchboard: Main->Reports->Sales Reports->SA Reports-> Close Ratios  

Menu: Reports->SA Reports->Close Ratios 

Action: RP_CLRATIO 

 

This report is a management tool to provide statistics concerning the effectiveness of the sales 
staff.  It provides the closing counts by each sales consultant. 

 

Report Selection Criteria 

Registration/Created date between...Only analyze prospects created within this date range. A 
date range must be entered. 

Prospect Type... Prospect may be assigned a customer type code.  When assigned this report 
may be limited to the prospects that match the entered code.  Leave blank for all. 

Limit to category... The report will total sales for each prospect (prospect purchase $ column) 
only for the categories entered within this field, i.e. wedding gowns, veils,  etc.  These 
sales are counted only for the included prospects.  Sales are not included for other 
prospects whom may have become members in the same event, but are NOT prospects 
that match the entered criteria, however they would be included in the total event $ 
column.   

The Category and/or category with sub category must match the category of the sold item 
for it to count.  For example, if the category of a sold item is BM, but the report criteria 
category entered is BM M0 (MO being a sub category).  It would not qualify.  To have the 
report include all of BM category, each subcategory must be selected as well. 

Count events where prospect are a bride? (checkbox)...  Checked, The system will provide 
event count information in the report. Event count information includes, Event #, Events 
w/Bridesmaids, Events w/tuxedo & Event $. 

 

Report Column Definitions: 

The report totals by Sales Associate 

Sales Associate... Totals are for this sales associate.   

# Prospect Registered = Total number of prospects the SA registered during the entered date 
range.  The  report counts the bride and groom on a prospect record as two prospects 
when the last name appears.  Technically, if something appears in the brides last name 
field, that counts as one and if  something appears in the grooms last name field, that 
counts as another one.   Why is this done? The groom and bride can each have a 
separate customer record and ticket. If the report counted the entire prospect record as 
one prospect, then when the bride and groom both purchased any items there would be 
one prospect that converted into two customers with two tickets, thus skewing the close 
ratio.  

# Prospects that purchased selected categories... Total number of prospects that purchased 
the categories of merchandised defined in the report criteria 
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% purch... The ratio of prospects registered to those that purchased.  (purchased / registered) 

Prospects purchased $...  Dollar amount of the of purchases that match the category criteria 

Events... number of counted prospects that were brides in events 

Events w/bridesmaids... Of the prospects that were brides the number of those events that 
had bridesmaids registered.  To qualify, at least one member is registered within the event that 
is assigned a role of BRIDESMAID.  If the event has one bridesmaid member, it is counted. 

% w/Bridesmaids... The ratio of total events to those with register bridesmaids. (Events 
w/Bridesmaids / Events) 

Events w/Tuxedos...  Of the prospects that were brides the number of those events that had 
rentals. To qualify as a tuxedo rental, the character sequence of Rental must appear in the style 
code of the item sold.  This count requires a sales ticket with a style sold containing the 
sequence of RENTAL..  Roles have no effect on this calculation.  In addition,  the system's 
security/payment rules are enforced (set in System setup).  The minimum payment or security 
deposit must be met for it to be counted (if defined). 

% w/Tuxedo... The ratio of total events to those with sold rentals. (Events w/Tuxedos / Events) 

Event $... Total value of all sales to all members of each included event irregardless of category 
of merchandise. 

 

 

 

Sales by Hour 

Switchboard: Main->Reports->Sales Reports-> SA Reports-> Sales by Hour  

Menu: Reports->SA Reports->Sales By Hour 

Action: RP_SALESHR 

 

Overview 

A powerful statistic tool that calculates total booked sales volume per business day per 
department and with the optional time clock employee tracking module, provides sales per hour 
of total employee hours worked within the department or store  by time of day. 

This tool can be utilized as a employee scheduling analysis. 

The report actually runs as two reports.  The first report provides the calculations for hours, 8am 
to 2 pm.  The second report includes the hours of 3pm to 9pm. 

Grouped by department and day, the report provides the total employees that worked the full or 
portion of the hour.  Exact total time of all employees working within the hour and the sales 
divided by the time worked, thus providing an accurate sales per hour total. 

The reported is sub-totaled on department and contains a grand total for all. 

Criteria 

Sales between... Date range of days to include sales for.   

Commissionable sales only (checkbox)... Sales revenue of only inventory items sold that are 
marked as "Pay Commission" on the inventory items's accounting class. 

Limit to stores... Multi-store feature.  Report may be ran for a specific store or set of stores, 
leave blank for all. 
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Department... Limit booked sales and hours worked to the entered department.  Registers and 
Sales associates may be assigned to a department code. 

 

 

 

Weekly Sales/Pricing 

Switchboard: Main->Reports->Sales Reports->SA Reports->Weekly Sales/Pricing  

Menu: Reports->SA Reports->Weekly Sales/Pricing  

Action: RP_FWSALPRI 

 

Overview 

A  report tool to see the ticket #, store style, list price, selling price and any discount given by 
sales associate, sales per hour total grouped by sales associate.  . 

For the date entered the system will include sales transaction for the date entered & six days 
prior.  The system automatically excludes DMG WAIVERS and LATE FEES sales transactions 
for the report.  This report is most useful for operations where the primary sales are tuxedo 
rentals.  The data includes Sales Associate, Ticket numbers, List price, Selling price, & discount 
percentage.  When a 100% markdown on a sale is given by the SA, then discount column will 
state 100%. 

The reported is sub-totaled by SA and contains a grand total for all. 

 

Criteria 

Print statistics for sales for the week ending... Enter your week ending day and information 
will be totalled for the day and 6 previous days. 

Limit to stores... Multi-store feature.  Report may be ran for a specific store or set of stores, 
leave blank for all. 

Markdown By SA Report 

Switchboard: Main->Reports->Sales Reports-> SA Reports-> Markdowns By SA  

Menu: Reports->Sales Reports->Markdowns by SA 

Action: RP_MARKSA 

 

This report groups markdowns by sales associate. This report is useful to find out who is giving 
markdowns and how they compare to other associates. 

 

Criteria 

Sold between xxx and yyy...Only markdowns that fall within the date range specified will print.  

Limit to SA...You can limit the report to a specific SA, if you like. Leave blank for all SA. 

Summary report only?...This option will suppress the actual styles sold, and just show the totals 
for each category. 

Limit to stores...This option is available with the optional multi-store module.  It will limit sales to 
the entered stores.  Multiple store IDs may be entered separated by a comma. 
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Sub-Total by store (checkbox)... Checked the system will total the for each store contained 
within the report. 

Only show items paid in full?...This will only show items where the revenue has been realized. 

SA Sales Performance 

Switchboard: Main->Reports->Sales Reports-> SA Reports-> Sales Performance 

Menu: Reports->Sales Report->Sales Performance 

Action: RP_SALEPERF 
 

The Sales Associate Sales Performance report provides important information that will help 
gauge the production of sales people. This report can provide data across all sales people to 
see the overall sales effectiveness for the company OR on a individual SA level. 

The report runs differently for shops that also have the Appointment Management Module 
installed. The differences are pointed out in the column descriptions below. 
 

Report Criteria 

Sold between date range…The date range of created sales to include. 
 

Grouping 

Week Ending Sunday…Will group the totals by week. Each week will end Sunday. 

Sales Associate…Groups all report information by Sales Associate. 
 

Department…The report can be limited by sales within a defined department. See the 
Department topic for more information. 

Limit to Store(s)… Available in the optional multi-store software. Limits the totals to specific 
store(s) within the chain. 

 

Report Columns 

 

$ sales…Net sales of all sale transaction on tickets 

$ Markdowns…Gross $ markdowns used to generate the net sales number 

# Tickets…Total tickets created. A ticket is defined as a transaction set, i.e. one or more sale 
transactions that have the same date and same sales person in the SA1 slot.  

The ticket is counted based on the grouping option. It will be counted if it falls in the week 
OR where the SA is in SA#1 position. 

# Non Registered Tickets…Tickets that were to customers not registered as prospects within 
the report date range OR customers without an appointment within the report date range 
(for shops with the BBL Appointment module). Quick Sale tickets are included in count. 

# Items…This is the number of sale transactions across all tickets counted. 

# Prospects…Number of prospects registered whether they have purchased or not. 

# Hours Worked…Total hours worked in timeframe. (Available when the optional WinTime 
Timecard software is installed). 

$ Sales Hour…Net Sales / Hours worked (Available with optional WinTime) 
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# Assists …The number of times the SA shows up in SA2 or SA3 fields on a ticket or for group 
by week the number of tickets with entries in SA2. 

# First…Number of tickets that were to customers registered as prospects where the date 
registered as a prospect matched the ticket transaction date. 

% Sales…Percentage of this grouping’s sales as compared to the total sales 

Avg. $ Ticket…Net sales divided by # tickets.  

Avg. # Ticket…# Sales Transactions divided by # Tickets 

Close Ratio… 
(available with Appointment module)…  

# Ticket divided by (Total ‘Sale Type’ Appointments plus # Non-Registered Tickets) 

or without appointment module 

# Tickets divided by (# prospects plus # Non-Registered Tickets) 
 

Formula definitions  

Total Sale Type appointment = all ‘Sale Type’ (see Appointment Type topic for more info) 
appointments registered in date range for Sales Associate (SA).  

# tickets = tickets created in date range by Sales Associate (SA).  

# Non-Registered Tickets = tickets created w/o appointment or prospect association within the 
date range for the Sales Associate (SA). 

# prospects = customers registered in the prospect module during date range and for Sales 
Associate (SA). 

Setup Rev. by Associate Report 

Switchboard: Main->Reports->Sales Reports-> SA Reports->Setup Rev. By Associate  

Menu: Setup->Reports->Financial Reports->Set Rev. by Associate 

Action: none 

 

This form lets you configure the content of the Revenues By Associate report. You have ten 
columns, each of which can total up to five GL accounts. For each salesperson, WinPOS® will 
total the dollars in those GL accounts credited to that salesperson and print it.  

For example, you could have column one includes the bridal gown revenue GL, column 2 has 
bridesmaids revenue GL, and column 3 has accessories revenue GL. You will then get a 
breakdown, by salesperson, of their revenues for each of these accounts 

 

Criteria 

Report column to view...Select column 1 to 10. WinPOS® will display the GL account numbers 
for that column in the list on the right of the form. 

GL account number list...You choose which GL account numbers to include in the selected 
section here.  

• To add a new one, find the first blank entry, click in the GL Account column, and 
enter the GL account number. You can also press F2 to bring up the pick list of GL 
account numbers. 

• To remove a GL account number, simply clear the GL account number from the list. 
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Revenues By Associate Report 

Switchboard: Main->Reports->Sales Reports-> SA Reports-> Revenues By Associate  

Menu: Reports->SA Reports->Revenues by Associate 

Action: RP_REVASC 

 

This report breaks down your Revenue By Sales Associate. This report shows you totals for 
WinPOS account numbers  selected in the revenue by associate setup. 

 

Criteria 

Sold between xxx and yyy...Only sales where the revenue was realized between these dates 
will print. You must enter a date range. 

Limit to sales associate...You can limit the report to a specific SA, if you like. Leave blank for all 
SA. 

Limit to stores...This option is available with the optional multi-store module.  It will limit sales to 
the entered stores.  Multiple store IDs may be entered separated by a comma. 

Receipts By Associate Report 

Switchboard: Main->Reports->Sales Reports-> SA Reports-> Receipts By Associate  

Menu: Reports->SA Reports-> Receipts By Associate  

Action: RP_REVSA 

 

This report breaks down the payments/monies received for sales made by each sales associate 
(indicated by their code being in SA1 or SA2 or SA3 on a sales ticket. If a customer has made a 
payment towards a sale, regardless of whether the revenue has been realized for an item, the 
payment will appear on this report. 

 

Criteria 

Sold between xxx and yyy...Only payments taken between the dates specified will print. This is 
the accounting date. You must enter a date range. 

Limit to sales associate...You can limit the report to a specific SA, if you like. Leave blank for all 
SA. 

Limit to category...You can limit the report to a specific category, if you like. Leave blank for all 
categories. 

Summary report only?...This option will suppress the actual payments, and just show the totals 
for SA. 

Limit to stores...This option is available with the optional multi-store module.  It will limit sales to 
the entered stores.  Multiple store IDs may be entered separated by a comma. 

Commissionable Sales only? (checkbox)...Will only include receipts to sales transaction that 
have a merchandise category which is marked comissionable. 

Breakdown by SA? (checkbox)... By default this report groups by category of the items the 
payment was applied to.  Checked, this setting will  Group payments received by SA, 
then sub-group by category. 

Markdown By Vendor Report 
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Switchboard: Main->Reports->Sales Reports…->Markdowns By Vendor  

Menu: Reports->Sales Reports->Markdowns By Vendor  

Action: RP_MARKVEND 

 

This report breaks down your markdowns/adjustments by vendor. This report is useful to find 
out whom you are marking down the most. 

 

Criteria 

Sold between xxx and yyy...Only markdowns that fall within the date range specified will print.  

Limit to vendor...You can limit the report to a specific vendor, if you like. Leave blank for all 
vendors. 

Limit to stores...This criteria option is available with the optional multi-store module.  It will limit 
sales to the entered stores.  Multiple store IDs may be entered separated by a comma. 

Sub-Total by store (checkbox)... Checked the system will total the for each store contained 
within the report. 

Summary report only?...This option will suppress the actual styles sold, and just show the totals 
for each category. 

Only show items paid in full?...This will only show items where the revenue has been realized. 

Markdown by Markdown Code Report 

Switchboard: Main->Reports->Sales Reports…->Markdowns By Markdown Code  

Menu: Reports->Sales Reports->Markdowns By Markdown Code  

Action: RP_MARKMARK 

 

This report breaks down your markdowns by markdown code. This report is useful to find out 
which markdowns are being most used. 

 

Criteria 

Sold between xxx and yyy...Only markdowns that fall within the date range specified will print.  

Limit to markdown...You can limit the report to a specific markdown, if you like. Leave blank for 
all markdowns. 

Limit to stores...This option is available with the optional multi-store module.  It will limit sales to 
the entered stores.  Multiple store IDs may be entered separated by a comma. 

Sub-Total by store (checkbox)... Checked the system will total the for each store contained 
within the report. 

Summary report only?...This option will suppress the actual styles sold, and just show the totals 
for each category. 

Only show items paid in full?...This will only show items where the revenue has been realized. 

Retail Inventory Reports 

Retail Inventory By Vendor Report 

Switchboard: Main->Reports->Inventory Reports…->By Vendor  
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Menu: Reports->Retail Inventory Reports->By Vendor 

Action: RP_INVVEND 

A detailed report by Size, Color & Width that shows retail inventory grouped by vendory. It 
includes activity and sales figures, and thus an excellent tool to evaluate how different vendors 
are selling. 

Criteria 

Limit to category...You can limit the report to a specific category, if you like. Leave blank for all 
categories. 

Limit to items where QOH (quantity on hand) is greater than 0 (checkbox)...Checked, the 
system will only include inventory where the on hand quantity is greater than zero. 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items with quantities at the entered stores. Limit to vendor...You can 
limit the report to a specific vendor, if you like. Leave blank for all vendors. 

Sort by...You can sort this report by: 

• Store style number 

• Vendor style number 

Group by category? (checkbox)...Will group & sub-total  inventory items by category within a 
vendor. 

Limit to items where QOH (quantity on hand) is greater than 0 (checkbox)...Checked, the 
system will only include inventory where the on hand quantity is greater than zero. 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items to the entered stores.  

 

Retail Inventory Reorder Report 

Switchboard: Main->Reports->Inventory Reports…->Reorder  

Menu: Reports->Retail Inventory Reports->Reorder  

Action: RP_INVREOR 

This report shows you your retail inventory where the quantity on hand has fallen below the 
reorder quantity. You can specify a reorder quantity at the style level (RETLINV) or size level 
(RETLSIZE) If the reorder quantity is set to zero at the size level, then WinPOS© will check the 
reorder quantity at the style level. Otherwise, WinPOS© will use the reorder quantity at the size 
level. 

Criteria 

Limit to vendor...You can limit the report to a specific vendor, if you like. Leave blank for all 
vendors. 

Limit to category...You can limit the report to a specific category, if you like. Leave blank for all 
categories. 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items for the entered stores. 

Retail Inventory YTD Detail Report 

Switchboard: Main->Reports->Inventory Reports…->YTD Detail  

Menu: Reports->Retail Inventory Reports->YTD Detail  
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Action: RP_INVDETL 

This report shows retail inventory, grouped by inventory category, then by vendor. For each 
vendor, it shows the stock, value, sales, and margins. It is a very useful analysis tool to compare 
vendor performance. 

Criteria 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items for the entered stores.  Separate multiple store IDs with commas 

 

Retail Inventory Movement Report 

Switchboard: Main->Reports->Inventory Reports ->Inventory Movement 

Menu: Reports->Retail Inventory Reports ->Inventory Movement 

Action: RP_INVMOVE 
 

This report will show an opening inventory quantity, total units sold, total units received, total 
units transferred, manual adjustments, and finally and ending quantity so you can see how & 
where inventory has moved over time.  

Criteria 

Show inventory movement since…This is the starting date the movement report will use to 
analyze your data (The report will always show your current QOH as the ending quantity).  

Limit to Vendor…You can limit the results to a specific vendor if you like. Leave blank for all 
vendors. 

Limit to Category…You can limit the results to a specific category if you like. Leave blank for all 
categories. 

Sub-category… You can limit the results to a specific sub-category if you like. Leave blank for all 
sub-categories. 

Style code…… You can limit the results to a specific style code if you like. Leave blank for all 
style codes. 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items for the entered store.  Separate multiple store IDs with commas 

Summary report only?...This option will suppress the details for each line and just show the 
totals. 

Retail Inventory Age Report 

Switchboard: Main->Reports->Inventory Reports ->Age  

Menu: Reports->Retail Inventory Reports->Age 

Action: RP_INVAGE 

This report shows your retail inventory, broken down by inventory category, sorted to show you 
the oldest items first. It is used to identify items that you’ve had in stock for a long time. 

Criteria 

Last received between xxx and yyy...Only show items received between the dates specified. 
You must enter a date range. 

Limit to items where QOH (quantity on hand) is greater than 0 (checkbox)...Checked, the 
system will only include inventory where the on hand quantity is greater than zero. 
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Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items to the entered stores.   

 

Retail Inventory Last Sold Report 

Switchboard: Main->Reports->Inventory Reports ->Last Sold  

Menu: Reports->Retail Inventory Reports->Last Sold 

Action: RP_INVSOLD 

 

This report shows your retail inventory, broken down by inventory category, where you can 
select only items that were last sold during a specified date range. 

Criteria 

Last sold between xxx and yyy...Only show items last sold between the dates specified. Note 
that this does not mean “sold between the dates specified” The item must have been sold 
for the last time between the dates specified. You must enter a date range. 

Limit to items where QOH (quantity on hand) is greater than 0 (checkbox)...Checked, the 
system will only include inventory where the on hand quantity is greater than zero. 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items to the entered stores.   

 

 

Retail Inventory YTD Sales Analysis Report 

Switchboard: Main->Reports->Inventory Reports ->YTD Sales Analysis  

Menu: Reports->Retail Inventory Reports->YTD Sales Analysis  

Action: RP_INVSTAT 

 

This report shows your retail inventory performance for each vendor. 

Criteria 

Sort by...The report may be  sorted by: 

• Total sales 

• Gross margins 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items for the entered stores.  Separate multiple store IDs with commas 

Retail Inventory Not Sold Report 

Switchboard: Main->Reports->Inventory Reports ->Inventory Not Sold  

Menu: Reports->Retail Inventory Reports ->Inventory Not Sold  

Action: RP_INVNSOLD 

 

This report lists inventory items not sold with the entered criteria.  The report is extremely 
important as a tool  to identified dead or slow moving inventory items.  Using the information on 
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the report a user can make decisions whether to specially promote slow moving inventory styles 
for liquidation. 

Fields 

Limit to vendor...The report may be limited to a specific vendor entered in this field.  Leave blank 
for all vendors. 

Limit to Inventory Category...The report may be limited to a specific category entered in this 
field. Leave blank for all categories. 

and 

Limit to items that are marked down, (checkbox)...Checked, the system will include only 
inventory items that have a Markdown Date completed on the Inventory form - Style tab. 

or 

Not Marked Down (checkbox).. Those items that do not have a markdown date entered. 

or 

All... Markdown or no markdown, both types will be included. 

and 

Months not sold...The system will limit the listing to inventory that any SCW has not sold in the 
number of months entered.  It compares the current system date to the Last Sold date 
found on the Inventory form - Statistics tab. 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items for the entered stores.  Multiple store IDs may be entered 
separated by a comma. 

Sort by Category or Vendor selection...Sort by inventory category or by vendor. 

 

Retail Inventory By Category Report 

Switchboard: Main->Reports->Inventory Reports ->By Category  

Menu: Reports->Retail Inventory Reports->By Category 

Action: RP_INVCLASS 

 

A detailed report by Size, Color & Width that shows retail inventory grouped by category. It 
includes activity and sales figures, and thus an excellent tool to evaluate how different 
categories of items are selling. 

Criteria 

Limit to category...You can limit the report to a specific category, if you like. Leave blank for all 
categories. 

Limit to items where QOH (quantity on hand) is greater than 0 (checkbox)...Checked, the 
system will only include inventory where the on hand quantity is greater than zero. 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items with quantities at the entered stores.  

 

Retail Inventory Listing Report 

Switchboard: Main->Reports->Inventory Reports ->Listing  
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Menu: Reports->Retail Inventory Reports->Listing 

Action: RP_INVLIST 

 

This report shows you your entire retail inventory in a condensed form, i.e. two lines per item. 
 This makes for a shorter & more concise report. 

Criteria 

Limit to vendor...You can limit the report to a specific vendor, if you like. Leave blank for all 
vendors. 

Limit to category...You can limit the report to a specific category, if you like. Leave blank for all 
categories. 

Last received between xxx and yyy...Only show items received between the dates specified. 
You must enter a date range. 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items for the entered stores.  Multiple store IDs may be entered 
separated by a comma. 

Summary Report only? (checkbox)...Checked the report will not include the Size, Color, Width 
(SCW) details of each style. 

Limit to items where QOH (quantity on hand) is greater than 0? (checkbox)...Checked, the 
system will only include inventory where the on hand quantity is greater than zero. 

Exclude items not carried in inventory (OTHER items)? (checkbox)...Every retail inventory 
item has a size called OTHER that is built in to WinPOS. This size holds the sales 
statistics numbers for sales of sizes/colors that you don’t have in inventory. This size can 
never have a QOH greater than zero. If this option is checked, WinPOS will exclude 
these items from the report. 

Include Rental styles? (checkbox)...By default the listing will not include any inventory marked 
as rental via the presence of a rental Item Type.  Checked the report will rental inventory. 

Sort by vendor and Store Style/Vendor Style?...Choose how you want the report sorted. It will 
always be sorted by vendor, and for each vendor you can choose whether to sort by 
store style or vendor style. 

 

Retail Inventory Short Format Listing Report 

Switchboard: Main->Reports->Inventory Reports ->Short Format Listing  

Menu: Reports->Retail Inventory Reports->Short Format Listing  

Action: RP_INVLISTS 

 

This report shows you your entire retail inventory, using only one line per item. 

Note: 

The cost column is the inventory style's reorder cost. 

Criteria 

Limit to vendor...You can limit the report to a specific vendor, if you like. Leave blank for all 
vendors. 

Limit to category...You can limit the report to a specific category, if you like. Leave blank for all 
categories. 
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Last received between xxx and yyy...Only show items received between the dates specified. 
You must enter a date range. 

Limit to QOH more than zero?...Only show items with at least QOH of 1.This option checked 
will not include sales of size/colors with a QOH of zero and thus omit any sales figures 
that these items may have.  This may result in seeing less MTD, YTD or Life Total 
numbers than you expect on the report. 

However, this setting does not affect the OTHER size/color for each style being reported. 
 The report will include OTHER sales totals for each style in the report.  Each Style by 
default has a OTHER SCW created.  This accumulates sales statistics for the style being 
sold when size, colors, widths are sold for the style that does not exist in the inventory. 
OTHER cannot contain a quantity on hand and is always zero. 

 

Discontinued status... Select ALL to disregard discontinued status and to see all styles.  Select 
Discontinued to list only discontinued styles and select Not Discontinued to see only not 
discontinued styles. 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items for the entered stores.  Multiple store IDs may be entered 
separated by a comma. 

Include rental styles?...Normally, the report will not include rental styles (styles with an item 
type.) If this is checked then rental styles are included with the retail styles. 

Inventory Detail Report 

Switchboard: Main->Reports->Inventory Reports->Inventory Detail   

Menu: Reports->Retail Inventory Reports->Inventory Detail   

Action: INVDETL2 

 

This report shows the inventory broken down into various groupings.  The report will have one 
detail line per style/size/color/width, per store.  It is usually used to see how the sales of certain 
styles compare from store to store. 

Criteria 

Limit to vendor...You can limit the report to a specific vendor, if you like.  

Limit to category/sub-category...You can limit the report to a specific category and sub-
category.  Leave blank for all. 

Last received between...List the inventory item If the date last received for the inventory falls 
between the date specified.   

Limit to items where QOH more than 0?...If checked, only items with a QOH greater than zero 
will be listed. 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items for the entered stores.  Multiple store IDs may be entered 
separated by a comma.  

Include rental styles? (checkbox)...Checked, rental styles will be included (styles with an rental 
item type) on the Rental Tab of the Inventory form. 

Sort...You can choose how the report should be sorted and grouped.  If the first sort order is 
chosen, then the report will first be grouped and sub-totaled by vendor, then by 
category/sub-category, and finally by style/size/color/width.   If the second sort is 
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selected, the report will be grouped by category/Sub-cat (not by vendor) then by 
style/size/color/width. 

• Vendor/Category/Sub-cat/Style 

• Category/Sub-cat/Style 

• Style 

Secondary Sort...Another level of sorting is available.  It will sort & group by SORT selected 
above, then by Size/Color/Width/Store OR Color/Size/Width/Store.  The primary difference 
being organized by SIZE or COLOR. 

Sell Through Report 

Switchboard: Main->Reports->Inventory Reports->Sell-Through  

Menu: Reports->Retail Inventory Reports->Sell-Through  

Action: RP_SELLTHRU 

 

Overview 

This report is a tool to determine adequate inventory in-stock levels based upon a season's 
selling requirements and to determine how well a inventory item is performing.  It is ideal for 
inventory that is sold out-of-stock, as in, many ready to wear, mother's and prom retail 
operations. 

The report groups by category &, may sub group by Style or Size or Color (depending on choice 
in selection criteria).. Each line of the report represents a specific style, size, color (SCW). 

 

Report Column definition 

Style Code, Size, Color... Specific SCW that is being analyzed on this line of the report. 

QOH Start... The QOH as of the season's start date, (first date of season runs date range in the 
criteria). 

Recv Adjust... Totals from beginning season until the Sell Through as of date in selection 
criteria,  counts units received in range 

Sold... Totals from beginning season until the Sell Through as of date in selection criteria, 
calculates units sold in range 

Order... On stock order as of todays date (current system date) 

QOH End... (QOH Start + qty RECD) - qty SOLD.  This is the ending quantity on hand for the 
range 

 

Sell Thru... As of the entered Sales thru date, Sales calculations stop on this date..  Sold / 
(QOH start +  Recv) 

Week left... (QOH start + Recv – Qty Sold) / ((Qty sold / ((sell thru date - season start date) / 
7)))  .  A calculation to indicate how many weeks of inventory are available based upon the 
season's sales history to date. 

(QOH start + Recv – Qty Sold) / ((Qty sold / (sell thru date - season start date) * 7) 

Avg Unit Cost... Is the Average unit cost for the SCW found within inventory on the SCW form. 

Avg Cost of Sales... Cost / Qty Sold.  Total costs are not found within the report.  This 
calculation is a summation of cost of sales for the sold qty. 
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Sales... Is the total net sales dollar value that occurred from the report's season start to the 
sales through date for this SCW. 

% of Total Sales...  This is the % of sales for this item, computed as a % of the total sales for 
this category.  Sales for ths SCW / Total Category sales. 

Margin...  Sales - (Avg Cost Sales * qty Sold) / (Avg Cost Sales * qty Sold)  printed as a 
percentage. 

Inv. Turns... Qty SOLD  / (QOH Start + QOH End) / 2.   

 

Selection Criteria 

Season runs from (date range)... The date range, Start date and end date of the season being 
analyzed. 

Sell-through as of...   Todays date or prior.  Does not make sense to compute sales on a future 
date since those sales have not happened yet.  This date should not exceed the last date of the 
season. 

Group by (Style or Size or Color)... The primary grouping is always by category.  This field 
allows for a sub-grouping and may be either by style, size or color.  

Limit to vendor... Limit report to a specific vendor.  Leave blank for all vendors. 

Limit to category... Limit report to a specific category.  Leave blank for all categories.. 

Limit to sub-category... Limit report to a specific sub-category.  Leave blank for all sub-
categories. 

Limit to Stores... Available with multi-store option. Limit report to a specific store.  Leave blank 
for all stores. 

 

 

Purchase Analysis 

Switchboard: Main->Reports->Inventory Reports->Purchase Analysis 

Menu: Reports->Retail Inventory Reports->Purchase Analysis 

Action: RP_PURCH 
 

The powerful Inventory Retail Purchase Analysis report is designed to help management make 
inventory merchandising decisions. The user will input the report’s creation criteria to focus the 
output on specific areas for analysis.  
 

Report Criteria 

Sold between…Date range that the items were booked on sales tickets. 

Limit to Vendor…Blank for all vendors or enter a specific vendor code. 

Limit to category… Blank for all categories or enter a specific category code. 
 

Grouping Options 

Controls the sort order and report sub totals. 

Price point…Groups on user defined price points 

Price point and vendor… Groups by Vendor & user defined price points within vendor 
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Category & vendor… Groups by Category & vendor within category 

Category & price point… Groups by Category & user defined price points within category 
 

Price Point Options 

Any grouping options selected above will provide the user access to the Price Point Options 
box. Here is where the price point breakdown will be defined. The user must input the starting 
price point in the Minimum field. Say $0. The Maximum field is where the grouping will end, say 
$500. The Price break every indicates the price point range, say $100. The example takes the 
input and displays it back. For this scenario the Example would be: $100 - $200, 200.01 - $300, 
$300.01 - $400, $400.01-$500 

Minimum…starting price point. 

Maximum…maximum price point 

Price break every…group at what increments 

Example…display - applying the information entered 

Limit to store(s)…Available in the optional multistore software limiting the totals to specific 
store(s) within the chain. 

 

Report Columns 

# In Stock: … Total on hand 

% stock… # in Stock / Total Stock 

Cost… Total on hand * Average Unit Cost 

% Cost… Cost / Grand Total Cost (Cost of all reported items) 

# Sold … Units sold (stock or ordered) 

% Sold… Units sold / Grand Total units (Units of all reported items) 

% Variance… % Stock / % Sold 

# Stock Sold… Units sold from stock 

% Stock Sold… Units stock Sold / Grand Total stock units sold (Stock Units sold of all reported 
items) 

# Ordered Sold… Units sold that were ordered 

% Ordered Sold… Units ordered sold / Grand Total ordered sold (Ordered Units sold of all 
reported items) 

Net Sales… Net sales (gross price – discounts) 

Markdown… Discounts to achieve net sales figure 

Turns… Sales / Cost 

Cost of Sales… Net cost of sales 

Gross Margin… Cost of Sales/ Net Sales 

Vendor Size Color Summary Report 

Switchboard: Main->Reports->Inventory Reports->Vendor Size Color Summary 

Menu: Reports->Retail Inventory Reports->Vendor Size Color Summary 

Action: RP_SALEVSTL 
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This report shows detail sales information that especially useful when the store sales many units 
of the same style(s) in different sizes and/or colors.  It is useful to see vendor or style and size 
or color selling trends. 

 

Criteria 

Sold between xxx and yyy Dates...Only prints sales for items where they were booked within 
the date range specified. A date should be entered 

Limit to vendor...The report may be limited to a specific vendor. Leave blank for all vendors. 

Limit to category...The report may be limited to a specific category. Leave blank for all 
categories. 

Sub-category..When a category is specified, the user may also add a sub-category (if available) 
to further limit the report data. 

Sort by 

Vendor/Vendor style/SIZE/color/width...The data within the report may be sorted this way of 

or 

Vendor/Vendor style/COLOR/size/width...The data may be sorted this way. 

 

Buttons 

Cancel... Cancels the report and returns to the previous menu. 

OK...Processes the report with the entered criteria. 

 

SCW not on Chart 

Switchboard: Main->Reports->Inventory Reports->SCW not on Chart 

Menu: Reports->Retail Inventory Reports->SCW not on Chart 

Action: RP_SCWINVALID  

 

This is an audit report is visible with the Housekeeping-> General Setup-> System Setting-> 
Setup Tab-> Require size/color/width to appear in charts? 

The setting requires for a style's size, color and width to appear within the charts entered on the 
inventory-> style tab before it can be sold on to a customer.  This report will list any items of an 
inventory style where their size, color or width DO NOT appear within the chart.  A situation that 
would not allow those items to be sold to a customer.  These should be corrected by adding the 
size or color or width to the chart. 

 

Pickup Inventory Reports 

Pickup Inventory By Age Report 

Switchboard: Main->Reports->Inventory Reports ->By Age  

Menu: Reports->Pickup Inventory Reports->By Age 

Action: RP_PINVAGE 
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This report shows items in your pickup inventory sorted by age. 

Pickup Inventory reports will show costs based upon the following rules: 

For items sold from stock the Cost of sale is the inventory's "Average Cost".  

For items sold that were Special Ordered, the Cost comes from PO file when the item was 
received and is the inventory Reorder cost at the time the item was ordered. 

The system zeros the cost (0) of the pickup item when it is accounted for (based on 
accounting set-up) on the sales ticket. 

Criteria 

Received date between...Only show items received in this date range. You must specify a date 
range. 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items to the entered stores.   

 

Pickup Inventory By Due Date Report 

Switchboard: Main->Reports->Inventory Reports…->By Due Date  

Menu: Reports->Pickup Inventory Reports->By Due Date  

Action: RP_PINVDUE 

 

This report shows item in your pickup inventory that are due to be picked up during a specified 
date range. 

Pickup Inventory reports will show costs based upon the following rules: 

For items sold from stock the Cost of sale is the inventory's "Average Cost".  

For items sold that were Special Ordered, the Cost comes from PO file when the item was 
received and is the inventory Reorder cost at the time the item was ordered. 

The system zeros the cost (0) of the pickup item when it is accounted for (based on 
accounting set-up) on the sales ticket. 

Criteria 

Due date between... Compares the date information entered to the Due Date field of the Pick-up 
inventory form for each item in pickup inventory.  The pickup item will appear on the 
report when one of the following situations exist:  1)the item's due date must appear 
within the entered due date range OR 2) the item's actual due date is empty OR older 
than current system date AND the  event the item's owner is a member of has a event 
date within the entered due date range OR 3) the pickup item's due date is empty AND 
there is no event date for the item's owner 4)  Leaving this date range blank (empty) will 
include ALL pickup inventory items in the report.   

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items to the entered stores.   

 

Pickup Inventory Overdue Items Report 

Switchboard: Main->Reports->Inventory Reports…->Overdue Items  

Menu: Reports->Pickup Inventory Reports->Overdue Items 

Action: RP_PINVOLD 
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This report shows items in your pickup inventory that are older than a specified number of days. 

Pickup Inventory reports will show costs based upon the following rules: 

For items sold from stock the Cost of sale is the inventory's "Average Cost".  

For items sold that were Special Ordered, the Cost comes from PO file when the item was 
received and is the inventory Reorder cost at the time the item was ordered. 

The system zeros the cost (0) of the pickup item when it is accounted for (based on 
accounting set-up) on the sales ticket. 

Criteria 

Show inventory xxx or more days old...Only show items where the received date is older than 
this. 

Show items...You can select which kinds of items to see. 

• All items 

• With a balance due 

• Fully paid 

Limit to store(s)..This option is available with the optional multi-store module.  It will limit the 
listing to inventory items to the entered stores.   

 

Rental Inventory Reports 

Locate Inventory 

Switchboard: Main->Reports->Rental Inventory Reports->Locate Inventory  

Menu: Reports->Rental Inventory Reports->Locate Inventory  

Action: RP_LOCATE 

 

This report will list rental orders that contain a specified style, and optionally a size. It is typically 
used to locate inventory that can be taken from one order and assigned to a different order 
during production. 

Filter Criteria 

Style…The style to search for, this field is optional.  If it is left blank then all styles will be listed. 

Size…The size to search for.  If left blank then all sizes will be listed. 

Orders not shipped (checkbox)...If checked, only orders of status Missing sizes, Wait Confirm, 
Confirmed, In Assembly, or Wait Ship are listed.  These statuses represent orders where 
items can be swapped prior to shipment. 

Assembly date between…Only orders to be assembled between the dates specified will be 
listed. 

Hide order details…If checked, only the order header details are listed (order #, customer, 
pickup date, etc.)  The actual order line items are suppressed. 

 

Quick Check Serial/Control 

Switchboard: Main->Reports->Rental Inventory Reports-> Quick Check Serial/Control 
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Menu: Reports->Rental Inventory Reports-> Quick Check Serial/Control 

Action: none 

 

WinTPS® optional software feature. 

This report displays details concerning a tracked inventory item.  It is helpful when attempting to 
locate a specific inventory item. 

 

Criteria 

Serial # ... Select and enter the item's serial/barcode number to display it's details. 

Control #... Select and enter the item's control code to display it's details.  The control number is 
a user assignable code that may be given an item when entering it into inventory. 

Lookup Barcode/Serial 
 

Switchboard: Main->Housekeeping->Lookup Barcode/Serial and Main->Reports->Rental 
Inventory Reports-> Lookup Barcode/Serial 

Menu: Find->Inventory by Serial/Control 

Action: none 
 

This report will display the information pertaining to a specific inventory item. 

The user will enter the ID/Serial number (if WinTPS® is installed) or Control number (if 
WinTPS® is installed) or Sku or Barcode number or Style code. Once the code is entered the 
system will attempt to locate the item and if successful display the item’s inventory SCW form 
(SKU, Barcode, or UPC entered) or the item’s inventory style form (STYLE entered) or the 
Rental Serial/ID form (Serial/ID, Control number entered). When an Serial/ID code is not found 
within the inventory WinTPS will assume the code is possibly from a Sub-Renter and attempt 
to locate the item from rental orders. The rental order will be displayed if the Serial/ID is found 
on a order. 

Rental Inventory Report 

Switchboard: Main->Reports->Production Reports->Rental Inventory Report  

Menu: Reports->Rental Inventory Reports->Rental Inventory Report 

Action: RP_RINVLIST 

 

WinTPS® optional software feature. 

This report prints a list of inventory items that have units available for rental. It can display the 
ID/Serial number of tracked items and the total average cost of the quantities currently 
designated as rental. It is useful to see the amount of rental inventory entered and to check the 
accuracy of the data. 

This report prints a inventory value.  This value is Quantity on Hand * Average Unit cost.  This is 
why it is important to maintain accurate quantity on hand counts and to enter invoice costs as 
new stock is received.  Average unit cost is calculated from the SCW Receive form and 
displayed on the Inventory Detail form 

The report has listing options.  The totals will be handled differently depending on the option 
chosen. 

Option 1. All rental inventory 
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The Average Unit Cost (AUC) is listed separately for each serial number.  When the AUC is 
printed for the style/size, it is actually the average of all the AUC's listed for every style/size. 
 Also, the AUC listed on the item type sub-total is the average of all the AUC's for the item 
type. 

The Qty shown is the total number of serial numbers listed (since each serial number 
represents one tracked item) 

Option 2. Only tracked items (that have serial numbers) 

If check "Print only tracked items & serial #s".  "Suppress items not available for rental?" 
must be checked when the criteria "Print only tracked items & serial #s" is checked for the 
quantities and value to agree with the quantity reported when the report is run for Option 1 
above.  The Quantity available for rental used for Option 1 is the total number of serials that 
are currently available for rental, so if the option is not checked, the report will include serial 
numbers not available for rental, making the total qty higher. 

Main-> Reports-> Inventory Reports-> Listing Report.  This report provides a complete listing of 
ALL (retail & optionally rental) inventory and may include Rental Styles as well.  This report 
computes the inventory value using inventory cost factors, which is a method to perform value 
write downs. 

Criteria 

Item Type...Enter the Item Type to limit the report to.  Leave blank for all. 

Styles... Enter the rental Style codes to limit the report to. Multiple styles may be selected by 
separating each with a comma. 

Status...Enter a rental inventory Status to limit the report to.  Leave blank for all. 

Limit to items where QOH is more than 0?... This option when checked will only include rental 
inventory items where the quantity on hand is greater than zero (0). 

Print  serial # details? (checkbox)...Checked, the report will list rental inventory of tracked Item 
Types and show individual item info.. 

Suppress tracked where "Currently available?" is not checked? (checkbox)...Checked, the 
report will not list tracked rental inventory that has it's Currently Available? checkbox un-
checked on the inventory rental sizes view serial number form (making it not counted in 
the availability count for that style & size).  In other words only showed Tracked inventory 
marked not available to rent. 

 

 

Rental Inventory w/Low QOH 

Switchboard: Main->Reports->Production Reports->Rental Inventory QOH Low Report  

Menu: Reports->Rental Inventory Reports->Rental Inventory QOH Low Report  

Action: RP_RENTRETL 

 

WinTPS® optional software feature.  

This reference report shows inventory rental style codes where the quantity available for rental 
exceeds the total QOH shown in inventory. In WinTPS the Total QOH shown on the Inventory 
Style form (RETLINV) is the total units owned, rental and retail. The rental quantity shown on 
the Rental SCW form (RENTSCW) is the portion of the total units that is rentable. If the style is 
rental only and all units are currently available for rental, then the retail QOH and rental quantity 
should be the same.  
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Normally, the rental qty would always be the same or lower than the total inventory QOH. This 
report lists styles where the rental quantity exceeds the inventory QOH. Normally, WinTPS will 
not allow a rental quantity to be entered that exceeds the inventory QOH. However, this can be 
overridden by checking the “Allow rental qty to be greater than on-hand qty?” option on the 
Rental Production tab of the System/Store Setup.  

If that option is checked, Rental quantities can be entered before the actual inventory has been 
received via Receive History function of inventory. When this happens the rental qty can be 
greater than the total inventory QOH. 

During inventory creation many companies find it is faster to enter the rental quantities within 
the Rental SCW form prior to receiving the total quantities owned in the Retail SCW form. 
WinPOS© offers a function to auto-enter the quantity enter in the Rental SCW form into the 
Retail SCW receive history form which saves an significant amount of data entry time. 

Rental inventory quantities for each size should never exceed the total owned quantity for each 
size found on the Inventory->SCW form. 

The system uses the total quantity on hand for inventory value computations. 

 

Filter Criteria 

Item Type…Enter an item type to limit the report to. 

Styles…Enter styles separated with commas or use the lookup to select styles to limit the report 
to. 

Rental Performance Report 

Switchboard: Main->Reports->Production Reports->Rental Performance Report  

Menu: Reports->Rental Inventory Reports->Rental Performance Report  

Action: RP_RINVPERF 

 

WinTPS® optional software feature.  

This report shows how well each rental inventory item is being utilized. It is useful when making 
decisions about which styles or sizes to purchase, or which styles or sizes to remove from 
inventory.  

Several output options exist for it, it can break the rental inventory down by Style or Size. The 
‘by Style’ option can be further limited to a specific Item Type. When the report is ran by Size it 
can be optionally limited to a specific Style code. 

In either case, the report shows the following information for each item listed:  

Total units owned for item  

the total turns for the item  

the number of units owned for each style/size as a percentage of the total,  

the number of turns as a percentage of the total,  

the turns month to date  

the turns year to date  

Finally, it shows the Fill Qty, which is the (YTD percentage of rentals – percentage of total 
units) * total rental units for the item.  The closer the fill number is to the quantity owned 
indicates how well the item is performing.  The goals are to have each item's fill quantity equal 



Reports 

349 

other items fill quantity indicating level performance across each item AND to have the fill 
quantity be as close as possible to the units owned for the item. 

to equal the total unit quantity for the item . 

Example:   

   formula: (YTD rental % - % of all units owned) * # units owned for the item 

      (20% - 8%) * 53 = 6.36 

      ( 1% - 8%) * 53 = 0 

      (90% - 1%) * 53 = 47.17 

 

Criteria 

Filter by Rental Item Type.. The report prints all styles for the item type and provides # of units, 
turns, percentages and FILL qty by style 

Print Sizes for Selected Styles...  Groups rental inventory by selected Style and all it's sizes 
providing the same data column as the item type selection.. 

Production Reports (Rental) 

Forecast Report 

Switchboard: Main->Reports->Production Reports->Forecast Report  

Menu: Reports->Production Reports->Forecast 

Action: RP_RESVFORE 

WinTPS® optional software feature. 
 

This is a report to help determine future rental inventory requirements by counting your current 
bookings by any style & size for any future date period. The knowledge can help management 
make buy or sub-rent decisions.   

Many operators would run this report on a style basis listing it's sizes for a future rental period. 
 The report will show where inventory is running low or is overbooked. 

Report is selectable by the criteria of: 

Assemble date thru Back Date...Only show items to be assembled and back within the date 
range specified.  This date could be for any period into the future.  The assembly date of 
the order must equal or be greater than the date entered AND the back date must be less 
than or equal to the date entered. 

Assemble date range... The assembly date range,  Perform calculations only on orders with an 
assembly date within the range.  The report will count the style/sizes on orders to be 
assembled within the range and show how many are owned tat are marked available for 
rental. This option will include orders with no booked quantities and exclude 
CANCELLED orders or orders will missing sizes. 

Limit to Vendor...Only items from the entered vendor will be shown.  May choose one.  Leave 
field blank for all. 

Limit to Inventory category/sub-category...Items with the inventory category and/or sub-
category entered will be included. 

Item Type... Report may be limited by a single rental item type. 
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Styles...Multiple styles may be entered by separating each store style code with a comma.  Use 
F2 for a list of styles to enter. 

Show sizes? (checkbox)...If not checked, only the styles will be shown.  Showing only styles is a 
good reference to see how each style inventory is performing.  Checked sizes for each 
style will be included for a detail analysis of style/size performance.  This report may be 
used to forecast there need for additional stock before it is actually needed for 
production. 

Show only overbooked items? (checkbox)...Limit report to items/sizes that are overbooked 
within the date range specified.  This is a powerful feature to zero in all hard stock needs. 

Export to FORECAST.DBF? (checkbox)... The report data is placed into a database file called 
FORECAST.DBF and is then available for further analysis via other programs, like excel. 

 

Account Shipping Report 

Switchboard: Main->Reports->Production Reports->Account Shipping Report 

Menu: Reports->Production Reports->Account Shipping Report 

Action: RP_RESVSHIP 
 

WinTPS® optional software feature. 

The account shipping report is a useful tool for management to see the production volume for a 
assembly date range. It also can be used as a quality control check to make sure all orders 
have been properly processed. 

The report prints totals of orders by status for each store/account. 

 

Criteria 

Assemble date range... totals orders with assembly dates within the entered date range 

Store Class... Wholesale/Multi-store feature to limit totals for store/accounts that match the 
entered store class code.  Store/Account classes are assigned on the Stores Form. 

Wholesale Account Sales Report 

Switchboard: Main->Reports->Production Reports->Wholesale Account Sales 

Menu: Reports->Production Reports->Wholesale Account Sales 

Action: RP_ACCTSTAT) 

 

WinTPS® accounts receivable optional software feature. 

This report shows the spending for each store/account that is invoiced, including their current 
balance and date of last transaction. It it useful to analyze the relative sales performance of the 
stores and identify the best and worst performing ones. 

For each store, the report shows the current balance, total spending, year-to-date spending, last 
year spending, and the date of their last transaction. The balance and spending figures include 
both sales and rentals, and all adjustments and cancellations. The last transaction date is the 
most recent sale, rental, adjustment, cancellation, or payment. 

Criteria 

The report can be optionally limited to one or more stores. Enter multiple store IDs separated by 
a comma. 
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Canceled Sub-Rentals 

Switchboard: Main->Reports->Production Reports->Canceled Sub-Rentals  

Menu: Reports->Production Reports->Canceled Sub-Rentals  

Action: RP_CANCORD 

 

WinTPS® optional software feature. 

This report prints the items that were marked to be sub-rented from a supplier and ordered as 
indicated via the presence of a confirmation number that were later cancelled or removed from 
the rental order.  Helpful in knowing what inventory ordered from a supplier should be cancelled. 

 

Criteria 

Canceled... The date of cancellation must be within the entered date range for the order line item 
to appear on this report. 

Bulk Print Laundry Tags 

Switchboard: Main->Reports->Production Reports->Bulk Print Laundry Tags 

Menu: Reports->Production Reports->Bulk Print Laundry Tags 

Action: none 

 

Allows Laundry tags to be quickly created for rental inventory .  Simply scan a rental inventory 
barcode, enter the description & location codes when modification is required and click print to 
save/print the tag. 

Many operators like to attach ID tags to garments to make it easier for warehouse personnel to 
locate & pull.. 

 

Late Orders for Accounts 

Switchboard: Main->Reports->Production Reports->Late Orders for Accounts 

Menu: Reports->Production Reports->Late Orders for Accounts 

Action: RP_ACCTLATE 
 

WinTPS® optional software feature. 

This is a very important function to help identify rental items that are overdue. Making sure this 
inventory is back by it’s assigned ‘Return Date’ is important to keeping the production cycle 
running smoothly. 

This function may also be used to dun wholesale type accounts (available in WinTPS® optional 
software feature). 

Letters may be printed to each wholesale account that has any overdue item that is overdue by 
the specified time entered. The letter is a standard letter and cannot be edited.  It includes the 
item overdue, order #, style, size, serial/Id number and days overdue. 

The report will list items with a status of Shipped, Received. Picked up, Returned, or Shipped 
Back. 

Criteria 
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List order ____ or more overdue... Enter the number of days the items has to be overdue 
before it is shown on the report.  Current system date minus Back in Inventory date on 
Rental order equals days late. 

Pickup at store(s)... Include all of the order pickup locations for the report. 

Show orders by store/account (checkbox)...Group the report by Pickup account. OR 

Show orders by item type (checkbox)...Group the orders by Item Type. OR 

Letters by account (checkbox)...A Late Reminder letter can be printed for each Wholesale type 
store/account included matching the days late and pickup at store(s) criteria.   

 

 

Laundry Report Selectable 

Switchboard: Main->Reports->Production Reports->Send to Laundry  

Menu: Reports->Production Reports->Laundry  

Action: RP_RESVLAUN 

 

WinTPS® optional software feature. 

This report prints the items by style and size, grouped by batch/bag number and item type 
selectable by item status. It is useful in locating inventory and seeing it’s laundry age. 

Criteria 

The report is selectable by Item Type, Styles (Multiple styles may be selected by separating 
each with with a comma), Batch/Bag number and Status. Optionally return sub-rented items 
may be included when the “Include sub-rented items?” checkbox is checked. 

Wholesale Revenue 

Switchboard: Main->Report->Production Reports->Wholesale Revenue  

Menu: Reports->Production Reports->Wholesale Revenue  

Action: RP_INVREV 

 

WinTPS® optional software feature. 

This report shows the total of sales, rentals, payments and refunds actually invoiced to 
wholesale accounts. Taxes are also shown separately. This report lists transactions invoiced, 
whether or not they have been paid in full. 

Invoice created…Only invoices created between the dates specified will be listed. 

Pull Report 

Switchboard: Main->Reports->Production Reports->Pull Report 

Menu: Reports->Production Reports->Pull Report 

Action: RP_PULL 

 

WinTPS® optional software feature. 

This report prints a list of inventory items style & sized grouped with a page break by rental item 
type for orders within a range of picking tickets or by ALL orders in assembly.  This is helpful to 
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production warehouses that assembles orders via the "marry" system.  A pull report may be 
given to department workers where they can pull the items required by the orders being 
assembled. 

Prints style, description, picking ticket # and order adjustment note for each item. 

Criteria 

Picking Tickets from # to # ... Enter the production ticket range for items contained on those 
orders. 

All Orders in Assembly... Check this option is print report for ALL orders in assembly. 

 

Print New Invoices 

Switchboard: Main Menu->Rental Production->Print New Invoices 

Menu: Rental->Production->Print New Invoices 

Action: PRINTINV 
 

WinTPS© software only feature.  

 

WinPOS utilizes the word INVOICE in two software modules  1)  Accounting Integration optional 
module, the invoice term is used to indicate INVOICES for the receipt of special order or stock 
merchandise.  This invoices will be paid by the operation 2) In the WinTPS optional Accounts 
Receivable module, where the service center creates invoices to Retailed Invoices customers 
and/or Wholesale type Accounts.  These invoices will be paid by them and the outstanding 
balance of these invoices is the operation's receivable. 

This feature will print all un-printed invoices for store/accounts with invoice terms (any terms 
except None or Ticket). The Terms are set in the Store/Account maintenance form. 

WinTPS© computes the invoice due date based upon the Stores/Account Terms and inserts it 
onto the invoice. 

The system will assign a sequential number (invoice number) to each invoice produced. The 
invoice will contain all the un-invoiced ticket sale transactions that have been created (this 
includes LOST or LATE fee transactions) that have a TAKEN status and tickets of rental orders 
shipped since the last invoice was produced for a store/account.  See Ticket - Details Status for 
more information on STATUS.  

Invoices are 8.5” x 11” and do not require pre-printed forms.  Codes used on some invoice 
formats are: PD = Pickup Date, SD = Shipped date, PS = Packing Slip number. 

Note: 

Tickets with Rental transactions for wholesale store/account types cannot have Sales 
transactions on the same ticket & this rule is enforced by the system.  LOST & LATE fees 
when added by WinTPS© will be automatically placed on a newly created ticket and appear 
on the next new invoice.  Price Adjustments or Cancellations to previously invoiced rental or 
sales transactions will be placed on the invoice originally created for those transactions.  

 

Criteria 

Limit to stores…Leave blank to print invoices for all stores, or select one or more stores to limit 
invoice printing to those stores. 
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Print Statements 

Switchboard: Main Menu->Rental Production->Print Statements 

Menu: Rental->Production->Print Statements 

Action: PRINTSTATE 
 

WinTPS® software only feature.  

This feature will print statements for store/accounts with invoice balances. The user may enter a 
transaction cutoff date so only invoices created prior to the date will be included within the 
statement. The actual statement format is controlled by the Statement setting on the Rental 
Production tab of the System/Store Setup form. 

The statements printed may be limited to selected stores, instead of all. 

The statement is printed on standard 8.5” x 11” paper and can be folded to fit in a windowed 
envelope. 

Limit to stores…Leave blank to print invoices for all stores, or select one or more stores to limit 
invoice printing to those stores. 

Include transactions on or before…Only transactions that occurred prior to the date specified 
will be included. 

Include transaction details on statement…Detail of each transaction (rentals, sales, 
adjustments, payments) will be included if checked. If not checked, only the totals for each 
invoice will be printed. 

Invoice Payment Audit 

Switchboard: Main->Reports->Production Reports->Invoice Payment Audit 

Menu: Reports->Production Reports->Invoice Payment Audit 

Action: RP_INVPMT 

 

WinTPS® optional software feature for wholesale invoicing, A/R. 

A helpful report to reconcile invoice payments.  The report lists invoice payments by Account 
(the pickup account of a rental order is the account invoiced & responsible for payment)  within 
a business date range grouped by the Pickup Account then sorted by invoice showing the 
payment details. 

 

Criteria 

Business date between ... The business date range to include in the report.  The business date 
is usually the date the payment was entered into the system. 

Show Checks, Charges, Cash, Gift Certificates (checkboxes?)... Checked the tender type will 
be included in the report.  Unchecked it will be omitted. 

 

Account Rental Statistics 

Switchboard: Main->Reports->Production Reports->Account Rental Statistics 

Menu: Reports->Production Reports->Account Rental Statistics 

Action: RP_ACCTFORE 
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Overview 

This report may be ran for any pickup date range (not limited to a week) and my be selected by 
store/account locations.  The report serves as a good forecast  for business across all 
store/account of the enterprise. 

Events with event pickup dates within the range or Single Orders with pickup dates within the 
range are included. 

Events are counted for the store/account location that created the event as well as all orders 
linked to that event are totaled to that store/account (pickup locations is not considered in this 
report).  Single orders are totaled under store/account location where picked up. 

 

Criteria 

Pickup Date Range… The date cutoff of transactions. Transactions prior or equal to the entered 
date will be included in the report. 

Limit to events from… Checked this option will NOT include individual invoice balance 
information. 

Buttons 

OK button… Run the report. 

Cancel button… Exits the form to the calling screen. 

 

Layout Definitions 

Total revenue is total net potential sales income.  Revenue w/dep is net order value of the 
orders with tickets that contain a deposit ( as defined by your deposit rules setup in the system 
settings) 

Revenue w/o dep is potential order sales income if ultimately the order is completed. 

The store must appear in the "Limit to events from" criteria field for the event and it's orders to 
be included in the report. 

 

AR Aging 

Switchboard: Main->Reports->Production Reports->AR Aging  

Menu: Reports->Production Reports->AR Aging  

Action: RP_ARAGING 

 

This report is a WinTPS® only report. It produces an listing of store/accounts that are invoiced 
and have a balance due. The balances are aged 0 – 30 days, 31 – 60 days, 61 –90 days and 
over 90 days and totalled. 

Criteria 

Include all transactions created up to… The date cutoff of transactions. Transactions prior or 
equal to the entered date will be included in the report. 

Summary Report? checkbox… Checked this option will NOT include individual invoice balance 
information. 

Buttons 
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OK button… Run the report. 

Cancel button… Exits the form to the calling screen. 

Invoice/Un-Invoice Detail Report 

Switchboard: Main->Report->Production Reports->Invoice/Un-Invc Detail  

Menu: Reports->Production Reports->Invoice/Un-Invc Detail  

Action: RP_INVAUDIT 

 

WinTPS® optional software feature. 

This report is used to match rentals/sales to their invoice line items. For each invoice line item it 
lists either the sale details or the rental order details. 

It can also be used to show the details of sales and rentals that have not yet been invoiced. 

Limit to stores…Leave blank to list transactions or invoices for all stores/accounts. Enter a store 
ID to limit the report to a single store. 

Select transactions checkbox…Select the type of transactions to list. 
• Un-invoiced…The report will list only un-invoiced transactions. A transaction date 

range can be specified and only transactions created during that date range will be 
listed.  

• Invoiced…Only invoiced line items will be listed. An invoice number can optionally be 
specified and the report will be limited to that invoice.  Invoices listed can also be 
limited to the Invoice CREATED DATE range. 

 

Shipping/Invoice Audit Report 

Switchboard: Main->Reports->Production Reports->Shipping/Invoice Audit Report 

Menu: Reports->Production Reports->Shipping/Invoice Audit Report 

Action: RP_RESVISHIP 
 

WinTPS® optional software feature. 

This report is used to verify that orders that should have been shipped have been shipped and 
invoiced.   

This report will list all the orders where the ship/asm date falls in the date range entered.  For 
each order, it will show the status and the invoice number, if one is present.  If no invoice 
number is present then the order has not been invoiced.  If the status is not Shipped or a later 
status, then the order has not been shipped. 

Criteria 

Limit to stores...Select the pickup location for the orders. 

Assembly/ship date...The report will list orders where the assembly/ship date on the order itself 
falls in this date range. 

 

Account Revenue Report 

Switchboard: Main->Reports->Production Reports->Account Revenue Report 

Menu: Reports->Production Reports->Account Revenue Report 

Action: RP_ACCTREV 
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Overview 

This report may be ran for any pickup date range (not limited to a week) selected by 
store/account locations and serves as a good forecast and/or history report.  This report totals 
orders grouped by each order's pickup store/account location (ignores created location).   

For a order to be counted it must meet your deposit rules as configured in system setup, i.e. 
security or partial payment, or no required deposit - based upon system deposit rules 

 

Criteria 

Pickup Date Range… The date cutoff of transactions. Transactions prior or equal to the entered 
date will be included in the report. 

Limit to events from… Checked this option will NOT include individual invoice balance 
information. 

Buttons 

OK button… Run the report. 

Cancel button… Exits the form to the calling screen. 

 

Layout Definitions 

Total Orders = total number of orders that qualify for the store 

Dmg Waiver = total number of damage waivers sold to qualified orders 

% Damage Waiver = percentage of damage waivers sold to total orders 

Exch = total number of exchange orders applied to qualified orders 

% Exch = percentage of total exchanges to total orders 

SD Forfeit = Total of how many security deposits were forfeited for the total orders.  Applies if 
using  security deposit transaction on order's ticket 

% SD Forfeit = percentage of forfeits to total orders 

$ Collected =  net order value if a deposit has been paid on the order's ticket.  The total 
excludes damage waiver charges (if any). 

Query Report Writer 

Query 

Switchboard: Main->Housekeeping->Query and Main->Housekeeping->Reports->Query 

Menu: Reports->Query 

Action: none 

 

WinPOS® Query Maker simplifies the process of executing and creating your own queries and 
reports.  

You can find data by picking up to 18 different comparison operators. Operators use English 
terminology like: Begins with, Ends with, Exactly matches and Sounds like. You can easily 
summarize the data you find. You can calculate totals, averages, counts or find the largest or 
smallest values. 
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Each query can contain up to 10 conditions (such as "amount is greater than $100"). Each 
condition can contain up to 12 comparison values (e.g., "city equals Chicago, Los Angeles or 
New York") allowing for a total of 120 comparisons per query.  

Furthermore, you can connect the conditions with AND/OR logic and specify parentheses to 
clarify the order of operations for your conditions. For example, "amount is greater than $100 
and (city equals Chicago, Los Angeles or New York)". 

WinPOS® Query Maker automatically saves your settings so you won't have to re-specify them 
every time you run a query. You can give each query a descriptive title to make it easy to 
recognize every time you need it. 

You can also copy and then modify existing queries instead of writing each new one from 
scratch. 

When you want to view sets of information based on changing values, WinPOS® Query Maker 
lets you create fill-in queries. For example, suppose you want to run weekly sales reports for 
totals over a certain threshold, but the minimum threshold changes. Every time you run this 
query, WinPOS® Query Maker will ask you to fill in the minimum sales threshold. 

WinPOS® Query Maker can display results in the form of: 

• On-screen tabular views (a browse window) 

• Reports 

• Merge letters or labels 

• eMail blasts 

• Text files 

• Databases 

• Lotus or Excel spreadsheets 

Note 

File output selections, i.e. text, database or spreadsheets create a file that will be saved to 
the computer's disk drive.  By default in Vista this will be in the 
 c:\programdata\profitsystem\user folder.  However, this location may be modified from within 
the Query maker.  HINT Do not have SPACES in the file name and make sure you have 
security access to save a file to any other folder. 

Report output formats may be modified with fonts, grouping levels and report totals. WinPOS® 
Query Maker helps you modify the page layout and preview the results on screen before 
printing. The modified report form is saved as part of the query for future use. 

You have the power to set up each query to work exactly the way you want: 

• Select which fields should appear in the query results. 

• Arrange the fields in any order. 

• Pick up to nine fields to sort on, with ascending or descending order for each field. 

• Select up to three fields for grouping results. 

• Specify any number of summaries: averages, totals, counts, maximum or minimum 
values. 

• Eliminate or include duplicate records at your option. 

• Browse the results in a tabular view before outputting the information to a report or a 
file. 
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When you click Query, you are shown a list of all the query sources (or Tables.) A query can be 
run for customers, or events, or tickets, or purchase orders, etc. You must first select what the 
query will be based on. After selecting the source, you are taken to the Query Manager. 

See the complete WinPOS Query Maker manual for more details.  This manual is found in the 
Start-> Program files-> Profit System group of your windows operating system. 

Lookup Barcode/Serial 
 

Switchboard: Main->Housekeeping->Lookup Barcode/Serial and Main->Reports->Rental 
Inventory Reports-> Lookup Barcode/Serial 

Menu: Find->Inventory by Serial/Control 

Action: none 
 

This report will display the information pertaining to a specific inventory item. 

The user will enter the ID/Serial number (if WinTPS® is installed) or Control number (if 
WinTPS® is installed) or Sku or Barcode number or Style code. Once the code is entered the 
system will attempt to locate the item and if successful display the item’s inventory SCW form 
(SKU, Barcode, or UPC entered) or the item’s inventory style form (STYLE entered) or the 
Rental Serial/ID form (Serial/ID, Control number entered). When an Serial/ID code is not found 
within the inventory WinTPS will assume the code is possibly from a Sub-Renter and attempt 
to locate the item from rental orders. The rental order will be displayed if the Serial/ID is found 
on a order. 
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Marketing Tools 

Marketing Overview 

 

Marketing is a set of software tools to facilitate communication with suspect lists, prospects & 
customers.  Marketing communication includes eMail, Text messaging, labels and letters.  The 
idea is that the more they know about your merchandise, store image and pricing the more 
inclined they are to visit the store & purchase.  You may be attempting to communicate now in a 
variety of time consuming methods.  With BBL's integrated approach, these old multi-step, time 
consuming tools are a thing of the past. 

Marketing features of WinPOS is comprised of: 

1. WinPOS helps by providing a easy way to select prospects or customers based upon 
certain criteria (see marketing topic) and to generate labels, printed letters, email and 
SMS messages. 

2. List Marketing.  Acquiring lists of unqualified suspect prospects from trade shows or list 
providers is a popular method to get in front of potential customers.  Working with those 
lists is very straight forward in WinPOS.. 

3. Additionally, WinPOS can capture requests coming in from web data forms.  When 
prospect/customers complete the form the data is sent to WinPOS whereby it may be 
acted upon.  These web contacts will be available for future marketing campaigns.  

4. Finally WinPOS will support great customer service via the MyInfo Self Service 
customer web interface.  This tool makes it easy for customers to stay abreast of their 
account in your store. 

 

 

Marketing 

Switchboard: Reports->Marketing->Marketing 

Menu: Marketing->Marketing 

Action: none 

 

Overview 

This form provides the ability to select a group of prospects or customers based upon specific 
criteria and to generate labels, printed letters, eMail,  SMS messages in bulk, or a printed report. 

Label, Letter & eMail formats and content that is used by this Marketing tool is defined within the 
WinPOS Labels, Tag, Letter editor. 

 

Selection Criteria 

Three Options exists for building criteria.  Two options select customers, the third selects 
prospects, i.e. people who have not been registered to an event.  In addition, 
Prospect/Customer type, Wedding/Event date and date created are criteria that may be utilized 
in selecting the groups.  

Option 1 
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The first option looks for customers who purchased an item of the specified categories, for a 
non-zero price occurring during the sale date range specified.  They would have had not 
purchased anything from the other category, regardless of price or date of purchase. 

Option 2 

For the second option is set for wedding event types and looks for any events  with members 
assigned the role that matches the role specified in this form.  Then, it looks to see if  any of the 
member roles  has a sales ticket, if they do not, then the wedding is added to the list of wedding 
events to be contacted.  The bride, groom, or both are added to the contact list, depending on 
the option selected. 

Option 3 

The third option selects prospects (are not a bride or groom of an existing event) that are 
interested in one or more styles (styles of interest are specified and appear on their prospect 
interest list).  Or, if a vendor is specified, then any style from that vendor must appear in their 
prospect interest list.   Styles or vendors may be manually entered by separating them with a 
comma. 

Prospect/customer type... Only customers or prospects are included that match the TYPE 
code entered here.  Leave blank for ALL prospects & customers. 

Wedding date range... Only customers or prospects are included that have event dates that fall 
within the date range entered here.  Leave blank for ALL prospects & customers. 

Created date range... Only customers or prospects are included that were created (added to 
system) that fall within the date range entered here.  Leave blank for ALL prospects & 
customers. 

Track views & un-subscribes (checkbox)? (for HTML eMail only)... The track views and un-
subscribes checkbox is only used when sending HTML emails. (Which is a Letters/Tag/Mailing 
Label of Printer type Email.)  Checked, the Profit System will create an email campaign to track 
Statistics, and will automatically add an un-subscribe link to the end of each email sent, as well 
as a special tracking image.  When the user displays the images of the email the tracking image 
will automatically increment the counter for a read email.  The system will prompt for a 
Campaign name.  Enter a descriptive name such as July2011Promo.  This way you can see 
statistics based upon the campaign. 

The un-subscribe link, when clicked by a reader will take them to an web page with an un-
subscribe confirmation message.   Their email address is added to the un-subscribe queue on 
the BBL Systems data warehouse when they confirm the un-subscribe.  Later the shop will 
request the un-subscribes via the Get Form / eMail results option. 

A tracking image is included in the email.  When the email is viewed by the customer, the BBL 
Systems data warehouse tracks the fact that the tracking image was viewed.  It then knows 
which customer viewed which email.  Many online email systems such as Yahoo, GMail, and 
Hotmail specifically block images from being displayed in emails to prevent such tracking. 
 However, if the email message contains pictures of gowns, etc, then the customer will probably 
choose to view the pictures in the email, which will allow the tracking to occur.  When the 
tracking image is viewed, then a view count is added to the view queue on the BBL Systems 
data warehouse. 

The un-subscribes and view counts are downloads from the data warehouse via the Get 
Form/Email Results option on the Marketing switchboard.  When this option is selected, the 
Profit System connects to the BBL Systems data warehouse and downloads the un-subscribe 
requests, view counts, and prospect forms filled out.  This data is also downloaded 
automatically when View Email Statistics is selected or Process Web Prospects. 

As the un-subscribe requests are downloaded the email addresses are automatically cleared 
from the customer, prospect, and appointment file.  The email is replaced by “Removed on 
date/time” 
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View Email Statistics is used to view the list of email campaigns.  A campaign is created each 
time “Track views and un-subscribes” is checked and an email is sent.  There is no need to 
check it for letters or mailing labels. For each campaign, the total number of un-subscribes, and 
specific emails un-subscribed is shown.  The total number of views, as well as which email 
addresses actually viewed the email is shown as well. 

Buttons 

Ok... Processes the entered criteria and will show the total # of customer or prospects found 
matching the criteria.  If emails or SMS messages are sent to those customers or 
prospects, then the total # of emails sent may not match the number of 
customers/prospects found since everyone might not have an email, or a valid email or 
have a SMS carrier specified. 
 
After the # number of records found, select the letter, label, or Email to be sent.  An SMS 
and Print List buttons appear as well.  SMS will prompt for an SMS to send to all the 
recipients, and Print List will print a contact list for all the recipients.  The Print List report 
has an option to group by SA.  This is useful to distribute to sales associates to use as 
lead sheets. 
 
  

Cancel... Exits the form without processing. 

 

 

View email Statistics 

Switchboard: Reports-> Marketing-> View eMail Results 

Menu: Marketing-> View Email Statistics 

Action: CAMPAIGN 

 

The View eMail statistics function displays a list of eMail campaigns and shows available 
numbers.  These statistics are available when performing a eMail blast via the Marketing 
function and the Track views & un-subscribes (checkbox)? (for HTML eMail only) is 
checked. When checked the user must enter a campaign name which the statistics are 
displayed by. 

The form displays: 

Name... Campaign name 

Sent... Date / Time the campaign was sent. 

Sent by... SA who sent campaign when security is in effect. 

Un-Subscribes... the number if recipients who clicked the un-subscribed link in the eMail. 

Views... the number of recipients that opened and displayed the entire message including 
graphics.  

View Log... The eMail addresses of the recipients whom un-subscribed and those that opened 
the entire message are listed.  Also the total number of emails sent for the campaign are in the 
log. 

Bulk Un-subscribe 

Switchboard: Reports->Marketing->Bulk Un-Subscribe  
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Menu: Marketing->Bulk Un-Subscribe  

Action: BULKUNSUB 

 

Allows multiple eMail addresses to be entered.  Entered address will be removed from all data 
tables of WinPOS when the Un-Subscribed button is clicked.  This is a very fast method to 
manually remove / un-subscribe email addresses. 

 

Get Form / eMail Results 

Switchboard: Reports-> Marketing->Get Form / eMail Results  

Menu: Marketing->Get Form / eMail Results  

Action: UNSUBS 

 

Process 

When selected this form immediately connects to the BBL Data Warehouse and downloads 
form data results, eMail campaign counts and un-subscribe requests.  This data is also 
downloaded automatically when View Email Statistics or Process Web Prospects are selected. 

As the un-subscribe requests are downloaded, the email addresses are automatically cleared 
from the customer, prospect, and appointment file.  The email field email address is replaced by 
“Removed on date/time”. 

 

Customer / Prospect Mailing 

Switchboard: Main->Housekeeping->Marketing ->Customer / Prospect Mailing  

Menu: Marketing ->Customer/Prospect Mailing  

Action: MASSMAIL 

The Customer / Prospect Mailing function allows the selection of groups of customers or 
prospects based upon demographic information and print mail merge letters or mailing labels for 
them. 

1. Select whether you want to print letters or labels for customers or prospects 

2. Next, you create one or more expressions. WinPOS® will check each 
customer/prospect on file, and if all the expressions are true, it will print the letter or 
label for that person. For example, the expression “Last activity is before 1/01/2001”, 
will cause WinPOS® to show people who have not been in your store after 1/1/2010.  
 
If you are doing a mass mailing to prospects, you can also select one or more style 
codes. Only prospects who showed interest in these styles will be printed. . (If you 
want to be sure you print out labels for prospects who have not purchased be sure 
to include the expression “where customer number is an empty field”). 

3. Finally, click Done. WinPOS® will display the list of letters and labels for customers 
or prospect so you can select one to print. If you have only one letter/label defined, it 
will print automatically. An actual list of the customers and prospects that will print 
out cannot be displayed before the printing starts, so be sure you have all 
expressions selected and the printer ready with labels loaded before clicking on the 
done button. 
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Customer / Prospect USPS mailing or email can also be accomplished via the included more 
powerful Query report writer or the optional Marketing tool. 

List Marketing 

Mailing List Overview 
 

The Mailing List functions are used to Import an ASCII (CSV) file containing contacts.  Once 
imported use the data to create a marketing campaign to entice the contacts to visit the 
business. 

ASCII CSV files can be created by almost all programs used to collect contact data.  The format 
rule of the file is that it may contain one contact per line, each data element (field) is separated 
by commas and text strings (non-numeric data) is surrounded by quotes.  A very popular 
program to create ASCII CSV files is Microsoft Excel.  The first line of the file may contain Field 
Headers that explain the data fields within the file. 

Once a file is chosen for import, the user must match the fields within the ASCII file to the field 
values within WinPOS©.  This is accomplished via the Import Mailing List form.  Once the file is 
imported, the data may be edited via the Mailing List Management form.  Use Query to utilize 
the imported Mailing List to generate Letter/Label & Email campaigns. 

 

How to use Query with Mailing Lists 

Query is a powerful program to pull data out of a file for reporting, tagging, creating letters/labels 
or sending  email with the optional Email functions. 

Step 1:  Start Query and select the Mail List file. 

Step 2: Create or select a new query. 

Step 3: Insure the required fields of ID and Import Name are found within the Fields to Include 
list.    

Step 4: Create selection criteria.  The Import Name is the name provided by the user to identify 
the Mailing List when it was imported.  WinPOS© automatically assigns the list a unique ID 
number found on the Mailing List Management form.  Either could be used to create a 
campaign for a specific list. 

Step 5: Choose the output type, i.e. email, letter, email or report ..etc  (make sure letters and 
labels are created & ready for use prior to beginning the query. 

Step 6:  Run the query. 

 

 

Import Mailing List 

Switchboard: Main->Housekeeping->Mailing Lists-> Import Mailing List 

Menu: Marketing->List Marketing->Import Mailing List 

Action: MASSIMPORT 

 

This form is used to import a ASCII CSV file of contact information into the WinPOS© mailing 
list table.  The ASCII file must be in the format of one contact per line, each data element (field) 
is separated by commas and text strings (non-numeric data) is surrounded by quotes.  The 
steps to import a list are: 
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Step 1: The form will ask for the ASCII file to import.  Navigate to the file by clicking the 
BROWSE button.  Once chosen click the NEXT button. 

Step 2: Once the file is selected WinPOS© will attempt to open the file.  Once successfully 
opened the next form will display the fields of the ASCII file and provide a tool to match the 
ASCII fields to the 15 data fields within WinPOS©.  The user simply uses the drop down 
widget located above the each ASCII data field to select the WinPOS© field that matches. 
 Choose IGNORE for the fields not needed for the import.  Once all are selected click the 
NEXT button.  Also, select the date format used in the import file, which can be Automatic or 
MM/DD/YYYY.   

Step 3: Name the imported Mailing List.  Make it a name that easily identifies it.  For example, 
the list could be for Fashion Show on May 6, 2005.  So a good name would be FS5605.  A 
concise name is best and easiest to recall in the Query when a campaign is created.  Once a 
name is created click the FINISH button.  The dta will be imported.   

Imported Mailing lists my be reviewed and edited in the Mailing List Management function. 

Mailing List Management 

Switchboard: Main->Housekeeping->Mailing Lists->Mailing List Management  

Menu: Marketing->List Marketing->Mailing List 

Action: MAILLIST 

 

This form allows for an imported mailing list to be selected by the name given during the import 
and reviewed or edited.  The form also allows for mailing lists to be created without an import. 
 Contacts may be manually typed in. 

The form has two tabs.    

List Tab is the list of imported mailing lists.  Select the list to review/edit and the Details Tab will 
be active for it. 

Buttons 

Add..Create a new Mailing List.  The Detail tab will be displayed and allow the user to enter a 
new mailing list name.  Use the Add Item button to add contacts.  CTRL END key will 
jump to the last contact record in the file.  CTRL HOME keys will jump to the first. 

Delete...Delete the selected list and ALL Contacts. 

Save...Save the changes made to Lists & contacts. 

Cancel...Cancel all changes made during this session to lists an contacts. 

 

Detail tab shows all the contacts of the list  

Buttons 

Print... Will print a label or letter or send a email (via optional email integration) to the selected 
person.  The form letters/labels must be set via Housekeeping-> Letters/Tags/Labels 
editor for MAILING source. 

Add Item...Use the Add Item button to add contacts.  CTRL END key will jump to the last contact 
record in the file.  CTRL HOME keys will jump to the first.  The END key will put the 
cursor behind the last character of the highlighted field.  The HOME key will move the 
cursor to the first character of the highlighted field. 

Delete Item...Use the Delete Item button to delete the record containing the highlighted field. 
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Internet Forms Processing 

Process Web Forms 

Switchboard: Main->Reports->Marketing ->Process Web Prospects  

Menu: Marketing ->Process Web Prospects  

Action: WEBPROSPECTS 

Used to process incoming prospect requests from a web form. 

Forms results data for each individual web form submitted form are displayed one at a time on 
this form, allowing the operator to make a decision on how to import the data into WinPOS. 
 When either Discard, Create Prospect, or Create Pros+Appt is clicked, the selected action is 
performed, and the next web form details are displayed. 

If the phone number for a web prospect matches an existing prospect, the message 
"PROSPECT ALREADY ON FILE" will appear on the form.  In this case, the Create Prospect 
button is disabled, and the Create Pros+Appt button becomes Create Appt for Pros. A new 
prospect cannot be created, but a new appointment can be created for the matching existing 
prospect. 

Buttons 

Discard... Skips and deletes the display form results.  No actions are taken with the data. 

Assign to SA for Review...If the web prospect needs to reviewed by a certain sales associate, 
clicking this button will prompt for a SA ID and assign the web prospect to that SA.  The 
form will then display the next web prospect to be processed. 
 
On the Todo menu is an option, Web Prospect for SA.  This will display all the web 
prospects that are assigned to the logged in SA, so they can Discard, Create Prospect, 
Create Pros+Appt, Create a Todo, or assign to another SA. 

Create Prospect... Creates a prospect from the display data.  Takes the user to the prospect 
form just created to allow further action.  Examples of actions would be: end a email, print 
a label or make additional notes, assign a TO DO for more follow-up. 

Create Pros+Appt... This action makes a prospect entry and an appointment entry for the 
displayed data.  The new appointment form is displayed to the user so the appointment 
date /time may be completed or additional tasks completed.  This button is available 
when the BBL Appointment module is installed. 

Hint:   

The prospect source is automatically set to WEBREQUEST when the prospect card is 
created thus allowing for selection in reports and marketing campaigns.  

 

Create TO DO... This will create a TO DO for the displayed form submittal and display it to the 
user so additional documentation may be done.  The TO DO could be assigned to an 
individual for follow-up. 

Close... Closes the Process Web Form without processing any additional form submitls. Any 
remaining form data is SAVED and is displayed for processing the next time this form is 
viewed. 

 



WinPOS Version 11 

368 

Web Forms Setup 

 

The Web Forms system in the marketing module lets prospects send you their contact details 
via a web page, and those details will be automatically added to the prospect file in the Profit 
System.  The prospect can also request an appointment via the web page and the Profit System 
will guide you through creating an appointment for the prospect. 

          

 

 

The web page that the prospect fills out is hosted on the your shop's web site. It can be styled 
via cascading style sheets -CSS by a web master to match the style of the shop's existing web 
site.  When the prospect fills out the form and clicks Submit, the prospect's details are saved on 
BBL Systems data warehouse server where they wait for the store to retrieve. 

To process data from web forms go to the Process Web Forms / eMail on the Marketing 
switchboard.  This WinPOS form shows the new web data for each web form to the user.  The 
user reviews the data details and decides if it’s a valid prospect.  If so, they click Create 
Prospect or TO DO or Prospect  + Appointment.   When the data is SPAM click Discard.  Then 
the next prospect is shown and the process is repeated.  

The prospect source is automatically set to WEBREQUEST.  This allows the Prospect Listing 
report to be run for prospect source WEBREQUEST, and can be filtered to today, which will 
show all the new prospects. 
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Form Setup 

To generate a default form, start the Profit System and go to Main->Reports->Marketing->Set 
Up Myinfo/Forms. 

The encrypted shop id and store number are shown at the top of the form. 

Click Build Prospect Web Page. The Profit System will prompt for a folder, and it will create 
prospect.html and prospect.css files. These two files can be used as a starting point for the web 
form.  The page will already have the correct encrypted shop id and store number embedded, 
along with basic formatting. 

 

Also, the default prospect web form, prospect.htm, can be downloaded from 
http://services.bblsystems.com/prospect.zip.  This is a sample form which can be used as 
is.  Additional forms may be created using the same methods utilized in the prospect.htm form. 
 The form data collected will be inserted into the WinPOS prospect table and used to create 
appointments when the form contains data within the ApptDateTextBox text box of the form. 
 As form data results are pulled from the BBL data warehouse  via the Get form / eMail results 
menu, the user will be able to make import decisions. 

A sample CSS file is also included with the prospect.htm page.  The CSS file is optional.  The 
prospect.htm file can be customized as long as the field names do not change, the required 
fields are present, and the form posts to the correct location. 

 

In either case, the html file should be placed on the bridal shops web site.  

 

Certain fields must be present with specific names, and the form must post to: 

http://services.bblsystems.com/ProspectPost.aspx 

 

Testing 

After submitting a form, go to  

http://services.bblsystems.com/Testform.aspx?shopid=MjA5MjY= 

replacing MjA5MjY= with your encrypted shop id. 

The resulting page will show you the values from the last form submitted. 

 

Fields 

These forms fields will save to the WinPOS prospect database mapped to the fields indicated 
below. 

ProspectType - Value can be either Bride or Groom.  If the ProspectType data field is missing, 
the system will default to Bride.  This field data controls whether the details as name, address, 
email & phones go into the Groom or Bride fields on the prospect form. 

FirstNameTextBox - Bride or Groom First name, should be required on web form. 

LastNameTextBox - Bride or Groom Last name, should be required on web form. 

EmailTextBox - Bride or Groom Email, should be required on web form. 

EventDateTextBox - WinPOS->Event date, should be set as required.  Should be formatted as 
the common date format for the region (MM/DD/YYYY for the US for example) 
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AddressTextBox - Bride or Groom Address 

CityTextBox - Bride or Groom City 

StateTextBox - Bride or Groom State 

ZipTextBox - Bride or Groom Zip 

PrimaryPhoneTextBox - Bride or Groom Primary phone.   Format as 770-555-1212 

AltPhoneTextBox - Bride or Groom Alt phone 

NotesTextBox - WinPOS->Notes 

ApptDateTextBox - Displayed to the WinPOS user on import and if filled in will be prompted to 
create an appointment.  Data not stored in WinPOS. 

ApptTimeTextBox - Optional for the appointment. Displayed to the WinPOS user on import if 
present.  Data not stored in WinPOS. 

Storenumber - A required hidden text field. The store number for the Profit System, usually 01 
for single store systems.  For multi-store, the actual store ID that should be assigned to the 
prospect on import. To get your store number, start the Profit System and go to Main->Reports-
>Marketing->Setup MyInfo/Forms.  The store number is shown at the top of the form 

Shopid - A required hidden text field. Encrypted shop number.  This must be present for the 
BBL Systems data warehouse to send the form details to the correct bridal shop.  Example 
MjA5MjY=  Note that you should not use this value, it’s an example to show you what your 
shopid will look like.  To get your encrypted shop id, start the Profit System and go to Main-
>Reports->Marketing->Setup MyInfo/Forms.  The encrypted shop id is shown at the top of the 
form 

Confirmpage - A required hidden text field.  The URL of the web page that should be shown 
after the user clicks Submit.  It defaults to 
http://services.bblsystems.com/FormComplete.htm which is a generic “Thank you” page. 

More fields can be added to the web form.  These new fields are simply saved to the prospect 
notes field when the prospect is imported. 

 

MyInfo - Self Customer Service 

 

Overview 

myInfo is a web page that allows a customer to check their balance and order status at any 
time.  This feature is turned on in Housekeeping-> System Setup-> Stores-> Internet tab-> 
Enable on-line MyInfo? 

When enabled, a sales ticket created in the Profit System is automatically assigned a web key, 
which is a 10 digit code.  The customer then goes to a myInfo web page, which would be a link 
on your shop's website, and enters the ticket's web code.  The web page will then display their 
name, ticket balance, event date, and status of special ordered items.  When the ticket's 
customer is a bride in an event, the page will also show all the attendants in their event.  For 
each attendant it will show their total spending which indicates to the bride whether or not the 
member has purchased their dress. 

The web page also has a button to email the receipt to the customer.  They can enter their email 
address and a PDF copy of their receipt will be emailed to them.  Some stores customize the 
web page to allow customers to make payments that can be applied to their open ticket 
balances. 
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Technical 

myInfo relies on a program called the Communications Manager   This is a separate program 
provided by BBL and installed with WinPOS (called CM.EXE, and located in the main Profit 
System program folder) that should be running all the time on one computer in your shop's 
LAN. The computer must have internet access available at all times. CM.EXE should be added 
to the Startup program group on this computer, and the computer should remain turned on and 
logged in at all times. 

The Communications Manager transmits customer details to the BBL Systems Customer Server 
located at BBL, so those details can be viewed by bridal customers. The Communications 
Manager also receives requests from your web site when a customer wants a copy of their 
receipt.  The Communications Manager receives this request, creates the receipt, and sends it 
to the customer. 

Changes to a Ticket, PO, or Pickup Inv. are tracked and queued up by  the Communications 
Manager to be sent to the BBL Systems Customer Server. 

Actions in Profit System that will cause a customers details to queue for online MYINFO update 
are: 

• When a ticket is created, edited or viewed in the Profit System, the customer and order 
details are queued to be sent.  If the ticket is for a bride or groom, the members of the 
event are sent as well. 

• When an item on a ticket has a ORDER status and it's Shipping Confirmation date is 
modified.  The date entered plus the number of pad days entered in the WinPOS 
housekeeping System Setup form will be displayed on the myinfo web-page . 

• When an item on a ticket has a IN status and: 

• It's Customer Notification Date is modified.  Customer Notification dates may be 
modified directly on the PickUp Inv. item form or the Pick Up Notification form, 
the events Order/PU Inv tab - Mark all items notified 

• The item is deleted from the Pick UP Inventory form 

• The item is marked TAKEN from the sales ticket 

• The item marked TAKEN from the Housekeeping form 

• The item is marked RETURNED on the sales ticket (customer took and then 
returned it) 

On the myinfo page, the pickup status of a item may be any of the following: 

Taken - The item status on the Ticket is Taken. 

Call - Pickup Notification date OR the confirmed shipping date plus padded days is after the 
event date 

On/After [date] - Stock sale that is now pickup inventory, and [date] is the date it went into 
pickup inventory, OR for a special order with a Pickup Notification date, [date] is the Pickup 
Notification date, OR for a special order without a Pickup Notification date, but with a Scheduled 
Notification date, [date] is the Scheduled notification date. 

Est on/after [date] -  Special order with no Pickup Notification or Scheduled Notification dates, 
but it does have a Confirmed Shipping Date on the PO.  In this case, [date] is Confirmed 
Shipping Date plus the padded days (entered in Housekeeping-> System Setup-> Other 
Settings). 
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For a bride or groom, the myinfo page will show their details as well as the details for all the 
members of the event.  For any other member, the myinfo page will only show their personal 
details. 

 

Queued 'data change updates' are processed via the running Communications Manager 
software (CM.EXE is installed when WinPOS is installed) approximately every 30 seconds.  A 
disruption to communications will cause an alert message will appear if the BBL 
Communications Manager is not running or there is a network problem and the requests are not 
being transferred.  The alert message triggers if more than 50 records are in the queue, the 
message displayed is:  

"The MyInfo queue has more than 50 actions queued up.  Make sure the 
Communications Manager PROGRAM(CM.EXE) is running on one computer" 

Every 30 seconds the Communications Manager program checks the Queue table for web keys. 
 When it finds one it retrieves the customer details (balance, order statues, etc.) and sends it to 
the BBL Customer Server. 

The Communication Manager, when it connects to the BBL Customer Server checks for your 
customer's  receipt requests coming in from your shop's website.  Customer may request their 
receipt be emailed to themselves from your website.  Tthe email address and web key are 
placed in a queue at the BBL Customer Server.  The communications manager downloads 
these requests when it connects, generates, and emails the receipts.  It uses the store's SMTP 
email settings from the Profit System to email the receipts. 

Modifications to the Housekeeping-> System Setup -> Days to Add to Confirmed Ship date 
on PO for est. ready for pickup  date on MyInfo page.will require the Communications 
Manager to be stopped then restarted for the changes to take effect  Existing customer 
information must be re-queued for the new settings to be seen.  This is done by displaying the 
customer ticket, and clicking Save/Done with Ticket, or making a change to the PO confirmed 
shipping date or Notification date. 

 

Setup instructions 

myInfo must be enabled on Options tab of the Main Menu-> Housekeeping-> General Setup-> 
Stores -> Internet Tab.  The option is only available if you have BBL’s Marketing Email/Online 
modules enabled.   

Make sure your email SMTP login information is entered in the Profit System. Housekeeping-> 
General Setup-> Stores-> Options Tab 

An HTML file containing a form to prompt for the web key and submit it should be placed on the 
bridal shops web site.  Certain fields must be present with specific names, and the form must 
post to: http://services.bblsystems.com/MyInfo.aspx  See Web form below for field details. 

The Communications Manager program should be running all the time on one computer in the 
shop.   

Communications Manager is automatically installed as Program Files\ProfitSystem\CM.EXE 
when WinPOS is installed.  Open the Startup group in the Windows Start Menu and add a 
shortcut to CM.EXE.  This will insure that CM.EXE runs when the computer is started. 

Start CM.EXE.  It can be minimized and will continue running. 

Now, as tickets are updated, it's data is summarized and is sent to the BBL Systems data 
warehouse for retrieval by your customer.  

To test it, view a ticket in the Profit System and make a note of the web key.  The web key is 
shown below the Event name at the top of the Ticket form. 
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Click Save/Done with Ticket to close the Ticket.  The ticket will be added to the Communications 
Manager queue. 

The Communications Manager will process the ticket and upload the customer details to the 
BBL Customer Web Server.  It can take up to 30 seconds for the details to be sent. 

On the web form, enter the web key and submit it.  The customer details will be shown. 

 

Web form 

To generate a default form, start the Profit System and go to Main->Reports->Marketing->Set 
Up Myinfo/Forms. 

The encrypted shop id and stories number are shown at the top of the form. 

Click Build Myinfo Key Page. The Profit System will prompt for a folder, and it will create 
myinfo.html and myinfo.css files. These two files can be used as a starting point for the web 
form.  The page will already have the correct encrypted shop id embedded, along with basic 
formatting. 

Also, a default myinfo.htm web form can be downloaded from 
http://services.bblsystems.com/myinfo.zip  This web form must have the correct 
encrypted shop id embedded before it is used. 

 

The following fields must be present in the web form: 

WebKeyTextBox - Contains the web key as entered by the customer. 

Shopid - A required hidden text field.  Encrypted shop number.  This must be present for the 
BBL Systems data warehouse to get the data for your shop.  Example MjA5MjY=  Note that you 
should not use this value, it’s an example to show you what your shopid will look like.  To get 
your encrypted shop id, start the Profit System and go to Main->Reports->Marketing->Setup 
MyInfo/Forms.  The encrypted shop id is shown at the top of the form. 

The form should POST to http://services.bblsystems.com/MyInfo.aspx 
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To Do Management 

TO-DO Overview 
 

Overview 

A typical store has significant activity and must keep up with many tasks (TO DOs) promised to 
customers.  Remembering what has to be done for all those customers can be a daunting 
challenge.  The WinPOS TO DO module can help.  Instead of using Post-it notes, just enter the 
To Do directly into WinPOS.  By doing so, WinPOS can remind and maintain a list of open & 
completed TO DOs by prospect, customer and event.  TO DOs should be assigned to individual 
store sales associates/employees .  Sales Associates when added to the system may be 
assigned to a store department and thus allows TO DOs to be sorted by employee and / or 
department.   

When employees login or use their passwords for security, a message will appear in top right 
corner of screen when for the SA when there are open TO-DOs to for them to complete. 

 

Note 

Employees and their departments are maintain in the SA form. 

 

The TO DO feature remembers customer and prospect tasks that need to be performed and 
provides a review log of the tasks that are open and completed.  It is handy to insure timely 
customer service. 

 

TO-DO functions may be access from the main switch board menu by selecting the drop down 
TO-DO menu from the header menu.  The functions include: 

TO DOs:  A list of the open TO-DOs for the logged in sales associate. 

New TO-DO:  Add a new TO-DO 

Department TO-DOs: See a list of all TO-DOs assigned to all sales associates assigned to 
the same department as the currently logged in sales associate (departments are set in the 
Sales Associate form). 

Web Prospects for SA: A list of the open TO-DOs created thru the Prospect Web Form 
processing within the marketing module for the logged in sales associate.  These are 
inquires/requests from the internet that have been assigned to a Sales Associate for 
completing. 

 

TO-DO shortcuts include: 

F7 to View TO DO for a Sales Associate from most any form/screen within WinPOS.  The 
system will prompt for a user name and password when operator is not logged in. 

Shift F7 to Add TO DO from most any form/screen within WinPOS. 

 

Creating TO DOs manually 

TO DOs may be any customer contact, phone call, email, web-form, face to face 
contact..etc.  It is an ideal way to remember what has to be done.  It also keeps a history of 
the TO DOs completed for review at any time allowing the   
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From Anywhere 

TO DOs are typically created manually when any store employee makes contact with a 
customer or prospect and needs to perform a task.  A TO DO may be created via the 
program from any screen by pressing the key combination Shift F7 or from the main menu 
by clicking on the TO DO menu selection found on the top menu..   

This will display the TO DO form in ADD mode.  Enter the responsible person/department 
and TO DO description/results. Optionally assign an existing prospect or customer to the TO 
DO.  TO DOs must be assigned to prospects or customers and optionally event to make a 
log is available. 

Customer or Prospect forms 

A TO DO can be created for each customer or prospect contact and can be left open or 
completed while being created.  A important benefit of the TO DO system is he history log it 
automatically creates for review. 

A TO DO may be created from a prospect or customer form by selecting the customer and 
clicking on the Interests/History Tab and clicking the Add To-Do button.  Doing so will 
automatically assign the TO DO to that prospect or customer that is being displayed when 
the TO DO is created. 

Event Member 

Creating a TO DO for a event member  is done by selecting the event and visiting the 
Members tab.  Select the member and click the New To-Do option from within the Select 
customer/member task menu drop down.  Creating a TO DO for an event member from the 
Event form will automatically tag the TO DO to the member customer and event.   

 

HINT: 

Quickly add TO-DOs for prospects, customers and event members with TO-DO buttons. 
 Each button creates a new completed TO-DO and auto enters the task completed, but 
provides the opportunity for the user to input additional details of the task results. The TO 
DO buttons are: 

Called... Creates a completed TO-DO with the action description set to Called with current 
date/time.  User should enter additional description of call result. 

eMailed... Creates a completed TO-DO with the action description set to eMailed with 
current date/time.  User should enter additional description of email details. 

SMS... Creates a completed TO-DO with the action description set to SMS with current 
date/time.  User should enter additional description of SMS. 

 

WinPOS can create TO DOs automatically 

TO DOs are automatically created for the ORDERING role/user ( those may be (found in 
Main-> Purchase Orders-> PO Alerts) when specific ticket modifications are done or event 
date changes for events with open customer orders are made.  TO DOs are created when:   

• Change wedding date and POs are issued for any item on any member's 
ticket 

• Change Size or Color or width and PO is issued 

• Adjust & Cancel a sale for a transaction with a PO issued  

• Adjust and cancel a sales on a  ticket with that item is marked received (IN). 
 System will prompt consultant to move item into Retail Inventory.  When the 
Move to Retail Inventory option is selected a PO TO-DO alert is created to 
move it to selling floor. 
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• Receive a PO and ticket line item is cancelled 

• Delete an extra charge from an item on a PO via the PO Item editor form 

• When extra charge is added to a sales item on the ticket that is on a Issued 
PO. 

• When special instructions are edited from the sales ticket associated  to a 
sales item on the ticket that is on a Issued PO. 

TO-DOs are auto created and marked completed for a customer or prospect when an email 
is sent to customer or prospect from the respective form via the PRINT button.  The email 
topic is auto inserted in the TO-DO description. 

 

Creating TO-DOs from Web Forms 

TO-DOs may easily be created when processing Web Forms within WinPOS.  As Web-Form 
data is reviewed, the user may easily create a TO-DO for the currently displayed information 
and assign to any sales associate for further processing.  Sales Associates may review and 
complete Web-Prospect TO-DOs by simply selecting it from the TO-DO drop down header 
menu when the main switch board menu is displayed.  Main menu->TO-DO-> Web Prospect 
for SA. 

 

 

Reviewing or Re-assigning TO DOs 

TO DOs may be reviewed in several areas of WinPOS.   

Note 

All TO DOs should be completed as quickly as possible to maintain great customer 
satisfaction.  Any details of a displayed TO DO may be modified (except for past 
descriptions) including re-assigning the TO DO to another employee. 

1. From the main menu by selecting the TO DO option from the top level menu 
and then select TO DO within the drop down OR press F7 from any screen. 
 When selected the system will prompt for a user name and password.  Once 
entered the Sales Associate will see a grid of open TO DOs assigned to them. 
 Click a row within the grid to review the details of that TO DO.   

2. From the main menu by selecting the TO DO option from the top level menu 
and then select DEPARTMENT within the drop down.  The system will display a 
list of defined store departments.  Select the department to see a list of TO DOs 
with responsible sales associates assigned that are members of the selected 
department  A grid of open TO DOs may appear.  Click a row within the grid to 
review the details of that TO DO.  

3. From a prospect or customer form by selecting Interest/History tab.  By default 
this grid will display open TO DOs.  Click on any row to see the TO DO details. 
 Check the Show Completed? box to see any completed TO DOs for the 
displayed customer or prospect. 

4. From an event.  Select the event, click the Members tab and then click the 
Event To-Do button.  This will display TO DOs for any member of the event. 

Hint: 

TO DOs are not private even though assigned to a Sales Associate / Employee or the 
Ordering role.  Anyone with security access may review, respond, change responsible 
SA and mark complete.  This allows the store to act as a team in completing all open 
TO DOs. 
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Completing TO DOs 

Simply review any open TO DO, perform the action, enter the results and mark it closed by 
clicking the Mark Completed button. 

When reviewing TO-DOs from the Prospect form or Customer form, TO-DOs may be 
marked completed from the rid by checking the box under the Done column next to the TO-
DO.. 

The current date & time is auto inserted onto the TO-DO as the completed date when it is 
completed.  The consultant currently logged in will be entered as the person completing the 
TO-DO. 

 

TO DO Log 

The TO DO grid is also the history log for completed TO DOs.  From any TO DO grid check 
the Show Completed checkbox? to see all closed TO DOs. 

 

Multi-Store Considerations 

Sales Associate TO DO lookups display all SAs entered within the system across all stores. 
 SAs are not assigned home stores because they may float between stores.  BBL 
recommends a special SA is created that signifies a specific store (maybe the store number 
is the SA code).  When a TO DO is entered it may be assigned to that special store SA, 
whereby those TO DOs may be checked by that store's management and reassigned 
appropriately to SAs regularly working within their store.   

Another method would be to create a store department and assign SAs of the store to that 
department including the store manager.  Then assign TO DOs received a for that store  to 
the store manager, then the manager would re-assign as needed, but all TO DOs assigned 
to the store department could easily be seen. 

 

 

The TO DO form is comprised of several data fields.  Definitions are: 

Responsible Section (required) 

SA... A TO DO is required to be assigned to a store Employee/Sales Associate (SA) or Role. 
 Sales Associates/Employees are created in the SA form.  When creating an SA they 
may be assigned to a department which are setup in the Department form.  Sales 
Associates are reminded of open TO DOs each time they are required to use their 
security username and password.    

Role... Currently only one role exists and it is called Ordering   TO DOs would be assigned to the 
ORDERING role when the TO DO concerns customers merchandise on special order. 
 The shop's people responsible for the ordering would be able to see the ORDERING 
role's TO DOs from the Purchase Order PO Alert menu selection found on the PO menu  

Date Due... (optional)  This would be the date the TO DO needs to be completed by.  Not the 
date to perform the TO DO.  Obviously all TO DOs need to be completed.  This date 
allows the responsible person to prioritize the more critical TO DOs over the less critical. 

Created by... Automatically filled with the SA who created the TO DO 

Completed by... The SA who marked the TO DO complete 

Add to TO DO..  

Top box 
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The description of the TO DO.  Enter as info as possible.  When the TO DO is created this 
could be the customer's question or issue.  When saved the details entered become a 
permanent part of the TO DO and is displayed in the Botton Box and are not editable. 

The TO DO can be re-displayed and more description information entered.  This could be the 
result of performing the TO DO. 

Bottom box 

This contains all the TO DO descriptions previously entered. 

Double down /up arrows on the TO-DO form  (displays or hides the following fields) 

Created (date/Time)... Date and time when the TO DO was created. 

ID... The unique TO DO id. 

Completed (Date/Time)...Date and time when the TO DO was marked completed. 

Customer ... The customer this TO DO was assigned to (if any).   When creating an TO DO, 
use the lookup to optionally link the TO DO to a existing customer. 

Prospect... The prospect this TO DO was assigned to (if any).  When creating an TO DO, use 
the lookup to optionally link the TO DO to a existing prospect. 

Event...The event this TO DO was assigned to (if any).  When creating an TO DO, use the 
lookup to optionally link the TO DO to a existing event. 

Buttons 

Mark Completed... Automatically enters the competed date/time and SA code of who is marking 
the TO DO complete. 

Done... Exits the TO DO form. 

Save... Save any edits made to the TO DO. 

Cancel... Discards any edits made to the TO DO. 
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System Maintenance 

Table Maintenance 

Switchboard: Main->Housekeeping->System Maintenance->Table Maintenance 

Menu: Setup->System Maintenance->Table Maintenance 

Action: none 

This form allows you to restore corrupted data files. We also refer to this as “Rebuilding the 
index files” If you suspect that data files are corrupted, select this option. You will be prompted 
for further information. 

Your files are corrupted when you request data, but the system displays the wrong data. 
Corruption of files may be caused by poor power conditions or other environmental conditions 
that may affect your computer.  

You can easily restore corrupted files to normal status with functions within Housekeeping. 

You might be attempting to select bride's sales tickets or attendants' sales tickets, for example, 
or attempting to locate prospects in your prospect file. If the information is not displayed, or the 
wrong information is displayed, your files may be corrupted. 

Any time you suspect your files may be corrupted, you should use this form to correct them. 

The file you are working in when you experience difficulties indicates which one of the restore 
routines you will need. If the Customer form is not working correctly, try Customer. If you are not 
sure, check All Tables. 

Note: We recommend that you restore all your data files once a day. This will help keep the 
WinPOS® program running smoothly. 

You can perform Table Maintenance from any of the workstations, but it will run fastest on your 
server computer. ALL OTHER WORKSTATIONS MUST BE EXITED OUT OF THE PROGRAM 
TO RUN THE REINDEXING. 

You can choose individual tables or check the all tables box to re-index all the data files. 

When you select to pack the tables, this feature removes all deleted records from the 
selected table(s). 

When the tables are selected click the Reindex button. 

When this process is complete, you will return to the Housekeeping – Manager’s Mode 
automatically. 

Validate Accounting Configuration 

Switchboard: Main->Housekeeping->System Maintenance->Validate GL  

Menu: Setup->System Maintenance->Validate GL  

Action: VALIGL 

 

This utility will attempt to check the accounting configuration of WinPOS© for common mistakes 
and report any issues found for the user to correct.  This utility does not check accounting 
integration setup for Quickbooks or Peachtree. 
 
Among other things, It will change the export cost, export inv, and export purchase accounts to 
be consistent for all accounting classes. 
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Sequence Numbers 

Switchboard: Main->Housekeeping->System Maintenance->Sequence Numbers  

Menu: Setup->System Maintenance->Sequence Numbers 

Action: SEQ 

 

Overview 

WinPOS utilizes a Sequence ID number in many of the data tables, like events, ticket numbers, 
rental order numbers ..etc.. 

This form keeps track of the last sequence number used for the various sequence numbers in 
WinPOS©(customer ID, event ID, etc.) You can change a sequence number here and the next 
time WinPOS© needs a number it will use your new number, plus one. Remember, this form 
shows the last number used. 

You can cause serious data problems by changing these numbers incorrectly. For example, if 
your current customer ID sequence number is 51 (meaning this was the last one used), and you 
change it back to 50, the next time WinPOS© needs a customer ID it will get 51. This would 
duplicate an ID already on file. 

The system prefixes all sequence numbers with the current store's Store ID.  WinPOS© by 
default will use the number 1 as your Store ID.  This can be modified by calling BBL Support. 
 This should be done before transactions are entered in the system.  In Multi-Store 
implementations of WinPOS the user may assign a Store ID to new stores added to the system. 
 Optionally the system will insert a dash between the Store ID and the sequence number, 
example 1-51.  This can be turned on or off via the System/Store Setup->Options.  In multiple 
store implementations the dash is desirable due to the ease in which transactions can be 
identified. 

By default the system does not prefix inventory barcodes sequence numbers with the Store ID. 
 This can be turned on via the System/Store Setup.  However, most implementations prefer to 
have the barcode omit the Store ID, this will guarantee the SCW barcode will be 8 characters.. 

An added option for sequence numbers is to maintain a separate set of Sequence numbers for 
each store in a multistore implementation.  Turn this on via the System/Store Setup->Options 
Tab: Make Sequence numbers store specific. 

 

FIELDS 

Primary Key  This identifies form/table the sequence number applies to: 

Current Key  This is the last value used in the form / table. 

Maximum key value This is the maximum value the number will reach before it resets to 1. 

Pad with Zeros to ___ characters This setting determines the number of characters of the 
number.  You must take the maximum key value into consideration when entering a value 
here.  for example.  Say the Store ID is 1, no dash is used and the maximum value is 
100000 with a pad of 7.  Your first sequence number would be: 1000001.  If the pad 
value was modified to 6 the sequence number would look like: 000001.  The system 
takes the pad value number of characters from the right.  Another example of the pad 
value of 2 would be: 01. 

 

Credit Card Processors 

Switchboard: Main->Housekeeping->General Setup->Credit Card Processors  
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Menu: Setup->System Maintenance->Credit Card Processors  

Action: CCPROCS 

Overview 

This form maintains the list of credit card processors, which are used by Verifone's PC Charge 
credit card software processing integration.  Use this form is to add new processor codes.  New 
codes entered here must match PCCharge processor codes.  
 
 
Fields 
 
Code...The four digit code for the processor.  This code must come from Verifone.  Arbitrary 
codes are not supported by their software.  
 
Description...A description used for reference purposes. 

 

Purge Functions 

Switchboard: Main->Housekeeping->System Maintenance->Purge Functions 

Menu: Setup->System Maintenance->Purge Functions 

Action: PURGE 

 

BBL Systems recommends that you run a complete backup of the data files before 
attempting a purge. 

The Purge Functions button allows you to permanently delete the following data from the 
system. Deleting, or "purging," old data, is necessary to avoid using up all the available disk 
storage space on your computer. Purging is based on dates * other criteria specific to the tables 
being purged.  Instructions for each will be provided on-screen when selected.  WinPOS® 
includes several functions for deleting old data. It is good computer practice to make a complete 
backup of you data files prior to doing purges and keep the data in a safe location. Keep the 
data until you are satisfied that the purge worked successfully. 

• Customers: Purged when their last transaction date is before the specified date. This 
purge function will also delete the sales tickets of WALK-INs if the last transaction 
date of the ticket is prior to the entered date. 

• Events: Purged when the event date is before the specified date. 

• Prospects: Purged when the event date is before the specified date. 

• Purchase Orders: Purged when the event date is before the specified date. 

• Inventory: Date received is before the specified date. Inventory marked as a 
SERVICE will NOT be purged.  Services items must be deleted individually. 

• GL Transactions: Where the accounting date is before the specified date. 

• Time Cards: Clock in date is between the specified dates. 

• Error Log: Where the date logged is between the specified dates. 

• System Log: Where the date logged is between the specified dates. 

• Fittings: Where fitting is created before a specified date and the status of the fittings 
are either complete or cancelled. 

• Gift Cards: Where last transaction/activity date is prior to the entered date. 
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• Tracked Rental Inventory: Where tracked inventory Serial/ID items have a Date 
Retired before the entered date.  The Inventory - Rental Sizes form contains a 
Retired Date field. 

• Rental Orders: Where orders are picked up or returned before the date specified. 

• Sub-Rental Returns: Will erase sub-rental returns that occurred prior to the date 
entered.  Sub-Rental returns are the item bar-codes scanned indicating they are 
being returned.  Review the Return Sub-Rentals topic for more information. 

• Appointments: Appointment dates prior to the entered date will be deleted.  You will 
want to keep old appointments in WinPOS® for a certain period of time (a year 
perhaps) but delete any appointments older than that.  

• Shipping: Shipment that are shipped prior to the entered date are deleted. 

• TO-DOs: Completed TO-DOs created prior to the entered date will be purged. 

When running a purge, all other terminals must be completely out of the WinPOS 
application. 

IMPORTANT NOTE 

BBL Systems recommends that you run a complete backup of the data files before 
attempting a purge. 

It is important not to interrupt a purge once it starts to ensure the integrity of the data files. 

Update Event Date on ALL PO 

Switchboard: Main->Housekeeping->System Maintenance->Update Event Date on ALL POs  

Menu: Setup->System Maintenance->Update Event Date on ALL POs  

Action: EVDATEPO 

WinPOS© will store the date entered on the Event Registration for the event date on a PO when 
an item on a sales ticket is special ordered for a customer who is a member of the event. 

Many times a user will change the date of an event by making the change on the Event 
Registration form.  This does not change the event date store on all previously created POs for 
the event. 

This utility will make all POs match the currently entered event date for their respective events. 

It is best if ALL users are exited from WinPOS© when the utility is ran. 

Re-Calculate All Ticket Balances 

Switchboard: Main->Housekeeping->System Maintenance->Re-Calculate ALL Ticket Balances  

Menu: Setup->System Maintenance->Re-Calculate ALL Ticket Balances  

Action: CALCTICK 

WinPOS© maintains a total of the sum of the transactions on sales tickets.  In the event that 
these totals appear incorrect this function will perform the math on ALL tickets in the system and 
update each of their totals. 

It is best if ALL users are exited from WinPOS©. 

SMS Carriers 

Located on the Housekeeping-> System Maintenance> SMS Carriers 

WinPOS via the optional email integration option will send out SMS text messages to cell 
phones via the mobile carriers SMS email interface gateway.  Most of the common cell carriers 
are defined by the default WinPOS installation and all accept an email as a text message. 
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Just enter the carrier name and the email domain for any additional carriers needed.  Example 
for T-Mobile USA is: 

Name:  T-Mobile 

eMail:  $@tmomail.net 

 

The email is entered as $@carrier.com, where the $ is replaced by the mobile number. 

Inventory Maintenance Programs 

Recalculate MTD/YTD Totals 

Switchboard: Switchboard: Main->Housekeeping->System Maintenance->Inventory 
Maintenance-> Re-Calculate Retail MTD/YTD 

Menu: Setup->Inventory Maintenance->Re-Calculate Retail MTD/YTD 

Action: none 
 

WinPOS© maintains Month to Date (MTD), Year to Date (YTD), and Lifetime sales totals for 
each retail inventory item. Circumstances may develop where the totals are out of synch with 
the data.  In this case WinPOS can analyze your sales tickets and recompute these totals.   This 
function is aware of the optional multi-store module and performs the calculations for the store 
the register the user performing this function is logged in on is assigned to. 

Sales in the current month will be counted in the MTD totals. You can specify the date range for 
your current YTD totals. Only sales that fall between the dates specified will be counted in the 
YTD totals.  

You can also choose to calculate Lifetime totals as well. Note that these totals are calculated 
using your tickets.  

Calculations do not include purged tickets.  The totals only include those sales left after purging. 
So, lets say you have five years of tickets on file, and you purge the oldest three years of 
tickets. If you choose to recompute MTD/YTD totals and also include lifetime totals, the lifetime 
totals will only show the totals for your last two years of tickets. 

Criteria 

Include items sold between these dates for YTD totals...This is the business date, not the 
transaction date. You must enter a date. 

Recompute life totals?...If checked, WinPOS will also recalculate the life totals for all retail 
inventory. 

Reset MTD/YTD Totals 

Switchboard: Switchboard: Main->Housekeeping->System Maintenance->Inventory 
Maintenance-> Reset MTD/YTD totals  

Menu: Setup->Inventory Maintenance->Reset MTD/YTD Totals 

Action: MTDRESET 

 

On the 1st of each month and the start of each new year  WinPOS® displays a question to the 
first user of day when opening the program.  The question asks to Reset the MTD totals at the 
start of each month, and also Reset the YTD totals at the start of a new year.   The user may 
answer Yes or No. 
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This option will force WinPOS® to reset the totals when ran.  This option may be preformed at 
any time. 

Recompute On-Hand Qty 

Switchboard: Switchboard: Main->Housekeeping->System Maintenance->Inventory 
Maintenance->Recompute On-Hand Qty 

Menu: Setup->Inventory Maintenance->Recompute On-Hand Qty 

Action: none 

 

WinPOS® stores the QOH for each item you carry (style, size, color, and width) on the Retail 
Details form. Also, WinPOS® stores the QOH separately in the Retail History form. This is done 
so that WinPOS® can tell how many items are left from each batch of stock received. 

Normally, WinPOS® maintains these two numbers automatically. However, these numbers can 
get out of sync if you have computer problems, hard drive failure, etc. This menu option will re-
synchronize these numbers. 

WinPOS® will take the total QOH from the Retail History form and carry it through to the Retail 
Details form. For example, if you have three receive history entries for a specific size and color, 
WinPOS© totals the QOH and replace the QOH on the Retail Details form. 

Recompute Activity 

Switchboard: Main->Housekeeping->System Maintenance->Inventory Maintenance-> 
Recompute Activity Totals  

Menu: Setup->Inventory Maintenance->Recompute Activity  

Action: ACTRECOMP 

 

This function will zero out the activity on each inventory store style, then will count the total 
number of times a style has been entered onto a prospect or customer FAVORITES form and 
then saves this total onto the inventory style-> statistics tab. 

Activity is a great measure of an item's popularity with customers.   It would be used the activity 
counts were accidentally cleared, or if customers or prospects were purged. 

Reset Inventory Activity 

Switchboard: Main->Housekeeping->System Maintenance->Inventory Maintenance-
>Recompute Activity Totals  

Menu: Setup->Inventory Maintenance->Recompute Activity Totals 

Action: ACTRECOMP 

 

This function will zero out the activity on each inventory store style. 

Change Vend/VendStyle 

Switchboard: Main->Housekeeping->System Maintenance->Inventory Maintenance->Change 
Vend/Vend Style  

Menu: Setup->Inventory Maintenance->Change Vend/Vend Style  

Action: VENDCHANGE 
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This utility is used to update the vendor and vendor style specified for an inventory item. It 
updates all occurrences of the vendor and vendor style throughout WinPOS. The vendor and 
vendor style can be updated directly on the Inventory form, but that change will not affect 
existing ticket sales, purchase order items, etc. When using this utility the old vendor, old vendor 
style, new vendor, and new vendor styles must all be entered, and the new vendor must already 
be entered into WinPOS via the  Vendors form. 

It is recommended that a current backup be made before using this (or any utility) that make 
mass updates to the data files. 

Change Style/SCW 

Switchboard: Main->Housekeeping->Inventory Setup->Inventory Maintenance->Change 
Style/SCW  

Menu: Setup->Inventory Maintenance->Change Style/SCW  

Action: RETLEDIT 

 

This utility is used to change a style code, size, color, or width for an existing item. All other 
users have to be out of WinPOS to change a style, size, color, or width. This utility changes the 
retail inventory, past tickets, purchase orders, pickup inventory, RCR’s, fittings, and inventory 
transfers. 

Always make a Backup before using this utility since it makes wide-sweeping changes to the 
data. A restore from back-up will need to be performed in the case of a data entry mistake. 
 

Existing item...Enter the style and/or size and/or color and/or width of the item you want to 
change. WinPOS© will find all matches to the data entered in this section of the form & 
make the changes (entered in the “Change to” section) to each item match found. 

Change to…Enter the new style and/or size and/or color and/or width. Enter the SAME value for 
any field as found in the “Existing item section” if you don’t want to change it.  

Examples: 

Example 1: In the Existing Item section the field Color, value of WHITE is entered. The Change to 
section also contains a field Color, vlue of field is blank. WinPOS© will blank the color of 
ALL items with color of WHITE. If the Change to field contain WHITE also, no changes 
would be made to inventory. 

 

Example 2: Existing Item section, the field Style has a value entered of 12345, and the Size field 
value is 12. Then in the Change to Section the Style field value is ABDEF and the Size 
field value is blank, WinPOS© will locate all entries within the system of style 12345 for 
size 12, change it’s style to ABDEF and change the size 12 to blank. 

 

Example 3: Existing Item section, Style field, value is entered 12345. In Change to section, Style 
field, value is entered ABCDE. All other fields of both sections are left blank. WinPOS© 
will move all Size, Color, Width inventory of style 12345 to style ABCDE (not changing 
any of the sizes, colors or widths entered), then remove style 12345 from inventory. 

   

 

Change Inv Cat/Sub-Cat 

Switchboard: Main->Housekeeping->System Maintenance->Inventory Maintenance-> Change 
Inv Cat/Sub-Cat 
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Menu: Setup->Inventory Maintenance->Change Inv Cat/Sub-Cat 

Action: CATCHANGE 

 

This utility is used to update the category and sub-category specified for an inventory item. It 
updates all occurances of category and sub-category throughout WinPOS. The catetgory and 
sub-category can be updated directly on the Inventory form, but that change will not affect 
existing ticket sales, purchase order items, etc.  

The vendor can optionally be entered along with the old category and sub-category. In this 
case, only inventory items that match on the vendor, category, and sub-category will be 
updated. The old vendor or old sub-category can be left blank, and in this case all inventory that 
matches on whichever fields are filled in will be updated. For example, if the old category is WG, 
and the vendor is 12, then only inventory with category WG and vendor 12 will be updated. If 
the old category is WG and the vendor is left blank then all inventory with category WG will be 
updated. 

It is recommended that a current backup be made before using this (or any utility) that make 
mass updates to the data files. 

Mass Update Unit Cost 

Switchboard: Main->Housekeeping->System Maintenance->Inventory Maintenance->Mass 
Update Unit Cost  

Menu: Setup->Inventory Maintenance->Mass Update Unit Cost  

Action: COSTUPD 

 

Allows a user to select a style & SCW to update the cost of ALL receiving records to a different 
amount. 

 

Mass Update Inventory 

Switchboard: Main->Housekeeping->System Maintenance->Inventory Maintenance->Mass 
Update Inventory  

Menu: Setup->Inventory Maintenance->Mass Update Inventory 

Action: MASSUPDATE 
 

Mass Update is used to make modifications to multiple inventory styles at the same time. The 
modifications may be Reorder Cost, Date Discontinued and Retail factor %. For instance, a 
vendor may raise the cost of all their bridesmaid gowns, this form will update all styles from that 
vendor in one step (cost & retail prices).  

Mass Update can automatically change the Retail Price #1 of each item it modifies. The 
program will change retail prices when the System/Store Setup setting “Don’t allow direct price 
changes to inventory” is enabled. This setting assumes that the computer is managing the 
computation of the retail price within Inventory and as a result it can compute the new Retail 
Price during a mass update.  

There should be a current backup of all data before using this function, in case a data entry 
mistake is made. 

There are four steps to accomplish a mass update of inventory.  

1. Enter the selection criteria of the items to update  
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2. Input the new values 

3. Review selected items for update 

4. Apply the update 
 

Update Inventory where 

Indicates to WinPOS which inventory items to select for updating. 

Category… Only inventory items containing the category selected will be updated. Blank updates 
all categories. 

Vendor… Only items from the vendor selected will be updated. Blank updates all vendors. 

Vendor style…Only items with the vendor style selected will be updated. Blank updates all 
vendor styles. 

Last received…The item will only be updated if the last date received is within the date range 
entered. When the item was received during the date range and also received at a later 
date, it would not be updated, since only the *last* receive date is checked. 

 

Make the following changes 

What modifications are to made to the  items of the entered criteria. 

Date discontinued…Sets the discontinued date to the entered date.  

Reorder cost…Change the reorder cost based on an adjustment amount.  

The adjustment amount is a code and an amount. The valid codes are =, -, +, %. You must enter 
the adjustment amount in the following format. Use =100 to set the actual reorder cost to 
$100.00 Use 25, or -25 to subtract $25 from the reorder cost. Use +45 to add $45 to the 
reorder cost. Use 15% to subtract 15% from the reorder cost. If you don't enter a code 
and just enter an amount, the reorder cost will be discounted by that amount (as if you'd 
entered a -) 

Retail factor %… Change the retail factor to the number entered. Enter 200% as 200, or 175.5% 
as 175.5 

 

Buttons 

Cancel button…Aborts any updates and returns to previous screen. 

OK Button… Accepts the criteria entered. WinPOS will display the matching inventory with the 
Inventory Selection Grid. 

Inventory Selection Grid…This list contains the inventory items that match the criteria entered. 
WinPOS® will display a list of the inventory styles selected for modification. The operator 
should review this list to insure the correct items have been selected for modification.  

Items may be removed by highlighting the item and pressing the DEL (DELETE) key. The 
item will remain visible, but a black box will appear on the left indicating it will not be included 
in the update. 

Pressing the DEL (DELETE) key again with the item highlighted will remove the Black box 
indicating it WILL be updated. 

ESC Key…Press Escape (or Esc) key while in the Inventory Selection Grid to exit the 
selection grid.   

WinPOS will exit the grid and prompt for the update to continue. Click YES for the update to 
be performed or NO to cancel the update.. 
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Import Inventory 

Switchboard: Main->Housekeeping->System Maintenance->Import Inventory  

Menu: Setup->Import Data->Import Inventory  

Action: INVIMPORT 

 

This form is used to by WinPOS to import inventory into WinPOS.  This is a great tool for NEW 
users to quickly add their store's inventory. 

Create your vendor list and category file list in the WinPOS system before starting to import 
inventory.  This is not required but recommended.  When creating categories within WinPOS 
(product departments) accounting classes are automatically created and given the identical 
code as the category. 

Data may be keyed directly into the Import Inventory grid OR loaded from an excel spreadsheet. 
 Inventory imports may be performed as often as needed.  Each import is appended to existing 
inventory. 

The import, when processing via the Add to Inventory function looks carefully at the vendor style 
code.  QOH of the items being  imported is added to existing QOH of items in inventory with the 
same vendor style code.  

The minimum data required is the Vendor Style, Vendor code and Category.  However we 
recommend the minimum being Vendor Style, Category, Color, Size, Description, Price 1, QOH 
& Vendor Code/ID 

If size or color are not entered, WinPOS will auto-create a sized named NA. (short for non 
applicable).  If a accounting class is not specified, WinPOS will attempt  to locate the matching 
class for the category and if it cannot, it will auto create a matching category account class 
(meaning it will create one with the same name as the category). 

New vendors, categories and accounting classes are created with default settings. Each newly 
created item's settings should be reviewed. 

Our preferred import method, is to enter items for a single category and vendor for each Import 
leaving the category & vendor code columns blank.  WinPOS will prompt for for the category & 
Vendor when the ADD to Inventory form button is clicked . Once the category & vendor are 
selected WinPOS will import each row.    It will automatically add the vendor & category codes 
to each inventory item as it is inserted into the inventory file.  After the import you can run a 
inventory listing report by category and/or vendor to check the data.  This approach is optional, 
but we find superior for reduced manual errors.  You may instead enter vendor & category code 
for each item and enter the whole store's inventory if you prefer. 

During Add to inventory processing WinPOS will create a store style for each row in the grid and 
if the same vendor style appears twice with different colors, sizes or widths it will simply add the 
additional colors/sizes quantity to the same store style code.  When a vendor code or category 
is entered within the import that does not exist in WinPOS, it will prompt for confirmation to add 
the new vendor or category codes to the appropriate file. 

Click the ADD to Inventory button when completed entering / importing rows of styles, colors & 
widths.  WinPOS will prompt for for the category & Vendor Code/ID/  Once the category & 
vendor are selected WinPOS will import each row.  It will create a store style (if a store style 
was not entered/imported) for each row in the grid. 

The retail factor and plus for new items will be set from the Vendor and Category of each 
imported setyle, and if none is found there, then from the Category for the imported style. 

If the price column is not filled it, it will computed using the reorder cost * retail factor + plus.  

Note on Store Style Numbers 
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When entering your own style numbers the Store style numbers should be unique for 
different vendor style / vendor code/id combinations per row.  For example you have 3 
different size / color combinations for the same vendor style and vendor.  Each of these 
should ideally have the same store style, otherwise the Add to Inventory processing will 
create multiple inventory entries.  This works but would require the operator to view multiple 
inventory entries for analysis of the same vendor and vendor style. 

 

Using a eXcel spreadsheet to add inventory to the grid for import 

All rows of the spreadsheet will be added during the load.  Delete any unwanted rows such as 
the column headings.  Once a Spreadsheet is imported  the Import Grid column headings 
should be modified to match the data within the newly added column.  Select ignore to skip any 
un-wanted columns. 

 

Review the Quick Inventory Add learning Video for more information. 

 

Note: 

For multi-store installations, WinPOS will prompt for the store to add the item's quantity on 
hand to. 

 

Best Practice 

The best way to import inventory is to create a separate spreadsheet for each vendor and 
category.  So, you'd have one spreadsheet for Amsale bridal, and a separate  spreadsheet for 
Amsale bridesmaids, for example.  When you import each spreadsheet, it will detect that the 
spreadsheet has no category or vendor and prompt for both when you click Add to Inventory. 

 

Make sure the spreadsheet has these columns, in this order: 

Vendor style  (the Vendor's Style Number for the item) 

Size (size of item) 

Color (the color of the item) 

Description 

Price #1 (retail selling price #1) 

QOH (quantity-on-hand of item) 

Reorder Cost (the per-unit cost of the item) 

 

1. Click Load Excel File and select your spreadsheet. It will loaded into the grid. 

2. You can use the Delete Selected Row button to remove any bad rows. 

3. Make sure everything looks Ok, and click Add to Inventory.  It will prompt for the Category 
and Vendor, and then add the inventory to the system. 

4. You can then repeat the process for the other spreadsheets. 

 

Buttons 

Delete Selected Row... Highlight any row of data within the grid.  Clicking this button will delete it 
permanently from the grid.  
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Load Excel File... Allows a user to import data into an empty grid from an Excel spreadsheet file. 
Once the data is loaded the user should select the proper column headings for the data 
by using the column name drop downs above each grid field column.  If the a field does 
not exist that matches the data, just select the IGNORE column name and the system will 
skip that column's data during the insert.  Data within the spreadsheet that is longer than 
the maximum allowed will be truncated. 
 
The spreadsheet file MUST be saved as an "Excel 5.0/95 Workbook" file format.  You 
can easily do this by loading your spreadsheet into Excel, selecting "Save as...", then 
selecting "Excel 5.0/95 Workbook (*.xls)" as the file format. 
 
The Color field in WinPOS is 10 characters long.  If the name of the Color in your 
spreadsheet is longer than 10 characters, the name will be truncated upon import.  You 
may wish to abbreviate your longer Color names in your spreadsheet prior to importing. 

Add to Inventory... Takes the data within the grid and inserts it into the inventory file, then 
DELETEs the data within the grid.  Once clicked WinPOS will check the data and if it 
identifies any issues it will display a message and stop the import and allow the entered 
data issues to be corrected within the grid by the operator.  Once corrected, simply click 
he Add to Inventory button again and repeat the process until all issues are corrected and 
the import completes. 

Close... This exits the form, saving the data within the grid.  The data will re-appear the next time 
the form is opened. 

 

Manual Update Inventory 

Switchboard: Main->Housekeeping->System Maintenance-> Manual Update Inventory 

Menu: Setup->System Maintenance->Manual Update Inventory 

Action: BULKQOH 

 

Used to update the QOH, reorder cost, discontinued date, size chart, color chart, color chart 2, 
price 1, and price 2 for multiple inventory items at the same time. 

Select a store style OR a vendor and vendor style OR a single vendor, and click Filter.   

The grid will display all the styles, sizes, and colors that match the selection.  Make changes to 
the QOH, reorder cost, price 1 or price 2 for each item.  When the changes are complete, click 
Save.  Clicking Cancel will discard the changes and clear the grid. 

Hint 

The discontinued date, size chart, color chart, color chart 2, reorder cost, price 1, and price 2 
can only be changed on the first row for a each style, since there can be multiple rows for a 
single style when the style has multiple sizes or colors.  If additional rows for the same style 
are modified, only the first row's data will be accepted. 

The QOH can be changed for any row (size/color). 

Inventory Maintenance - Display Inventory Value 

Switchboard: Main->Housekeeping->System Maintenance->Inventory Maintenance->Display 
Inventory Value 

Menu: Not available 

Action: none 

This displays the total value for all of your inventory.  
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WinPOS Value Computation works as follows: 
 

WinPOS uses the receive history for an item to compute the average unit cost automatically. 
Each time you receive stock inventory, WinPOS records the quantity received and the unit cost. 
It keeps this history as you receive more inventory. Assume this is your receive history for style 
100, size 10, color white. 
 

Date 
Recv 

Qty 
Recv 

QOH Unit 
Cost 

1/1/2011 25 25 $100.00 

2/12/2011 25 25 $150.00 

At this point, your average unit cost is ((25 * 100) + (25 * 150)) / 50 = $125.  

Now, you sell 10 units and are on FIFO inventory costing (which is set in System/Store Setup) 
 

Date 
Recv 

Qty 
Recv 

QOH Unit 
Cost 

1/1/2011 25 15 $100.00 

2/12/2011 25 25 $150.00 

Now, your average unit cost is ((15 * 100) + (25 * 150)) / 40 = $131.25. 

At any point, you can tell how many you have left at each cost. WinPOS remembers how many 
you originally received at each time, and how many are left from each batch. Once you sell all 
the ones received on 1/1/2011, WinPOS will start using the QOH for the 2/12/2011 ones.  

Now, to compute the value we look at each receive history entry. For each receive history entry 
we compute the value as 

Cost Factor % * (Unit Cost – (Unit Cost * Vendor Discount %)) * Qty On Hand 

And then sum all the values to get the total value for the inventory item. 

 

Inventory Maintenance - Re-Apply Sales to QOH 

Switchboard: Main->Housekeeping->System Maintenance->Inventory Maintenance->Re-Apply 
Sales to QOH  

Menu: Setup->Inventory Maintenance->Re-apply Sales to QOH 

Action: REDOSALE 

 

This utility will update the QOH for sales and cancellations that occurred during the specified 
date range (including the dates specified.) This would normally only be done if the retail 
inventory had to be re-created and the QOH did not reflect sales and cancellations that had 
already occurred. 

This utility should only be used under direction on BBL Systems Technical Support and when 
system is in DEVELOPMENT mode. 

Inventory Maintenance - Recalculate Rental MTD/YTD 

Switchboard: Main->Housekeeping->System Maintenance->Inventory Maintenance-
>Recalculate Rental MTD/YTD  

Menu: Setup->Inventory Maintenance->Recalculate Rental MTD/YTD  

Action: MTDRECOMP 
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For use with the optional WinTPS© software module.  Allows a user to recompute all rental 
statistical totals for MTD, YTD and Life Time rentals.  Allows the user to select a Ship date 
range for the orders to include in the calculations. 

Inventory Maintenance - Recompute Rental Qty 

Switchboard: Main->Housekeeping->System Maintenance->Inventory Maintenance-
>Recompute Rental Qty  

Menu: Setup->Inventory Maintenance->Sync Rental Qty with QOH 

Action: SYNCRENT 

 

WinTPS automatically maintains a rental quantity for rentable inventory styles. For non-tracked 
styles, the rental quantity must be entered manually on the Rental Sizes form. For tracked 
items, WinTPS automatically counts how many serial numbers are available for rental that are 
found on the View Serial Numbers form of the Rental Sizes form. 

This utility forces the corresponding QOH for each Rental Inventory item rental QTY for each 
size (Inventory-> Rental tab-> Rental Sizes form) to equal the Quantity on Hand (QOH) of each 
size on the SCW form.  It does this making increasing/decreasing the last receive history entery 
for the size. 

WinPOS should automatically keep these numbers equal when quantities are entered onto the 
rental sizes form. In a circumstance that they do not equal, this utility will synchronize the two 
quantities. 

Older versions of the program used a special receive history entry called SYNCRENT to track 
these updates.  SYNCRENT is no longer used by the program.  When the Sync Rental Qty with 
QOH is used, these obsolete SYNCRENT entrires are removed automatically. 

Import DOS BPS Data 

Converting from BPS Overview 

Switchboard: Main->Housekeeping->System Maintenance->Import BPS Data 

Menu: Setup->Import Data->Import BPS Data 

Action: CONVERT 
 

Getting Started… 

Before using WinPOS® at all, we strongly recommend watching the WinBPS section of the 
InfoDisc in its entirety to familiarize yourself with WinPOS®. 
 

We also recommend importing your data using the Training version of WinPOS® first, to 
familiarize yourself with the conversion process. You can then use the Training version of 
WinPOS® to see what was converted and what was not.  
 

To use the Training version of WinPOS®, choose WinPOS® TRAINING from the BBL Systems 
group on the Windows Start Menu. To restore the training data back to how it was when 
WinPOS® was installed, choose Refresh Training Data from the BBL Systems program group 
on the Windows Start Menu. You can restore the data, then re-import your BPS data as many 
times as you like. 
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Before trying to import your BPS data, read the document entitled “How to Convert DOS BPS 
Data to WinPOS™” If you didn’t receive this document with your WinPOS® CD, please contact 
customer service and request one. 

It is important that you read “How to Convert DOS BPS Data to WinPOS™” before trying 
to import your data! 

Import BPS Data 

Switchboard: Main->Housekeeping->System Maintenance->Import BPS Data  

Menu: Setup->Import data->Import BPS Data 

Action: CONVERT 

This utility is used to import DOS BPS© version 10 program data into the WinBPS© module of 
WinPOS©.  

There should always be a current backup copy of the WinPOS© data before performing a 
merge.  This allows for a restore and a re-merge if a problem is discovered after the merge. 

 

Instructions 

Before using WinPOS© at all, we strongly recommend watching the WinBPS© section of the 
InfoDisc in its entirety to familiarize yourself with WinPOS©. 

Read through the manual as you look through the program and take note of any questions or 
concerns you may have with regards to it's operation as comapred to the DOS BPS operations. 

Begin practicing data entry by using the training module of the WinPOS© program.  To a test 
import into the WinPOS© training program and then run all of the available reports using that 
data so you can see the information that they provide. 

Begin training your staff on the windows program using the DOS BPS© Data in the training 
program. 

Get together a list of figures your shop uses on a daily and monthly basis along with copies of 
the reports your shop uses regularly in DOS BPS©. 

Check to see that you can find the information and reports you use regularly in WinPOS© and 
list the things you cannot find.  Fax or e-mail us your list so we can help you find the information 
your shop needs. 

Once you and your staff are comfortable using the windows program it is time to set a final 
conversion date.  It is best to schedule your final conversion date for the last day of the month at 
the days end. This will make reporting easier for you. (Preferably not on a Friday.) 

Before trying to convert your BPS data… 

Before converting the DOS BPS data make sure: 1)  the current tax rate is set correctly in 
WinPOS©  2) the correct accounting method is selected  and 3) that all other users are out of 
the program.  

1. To set the tax rate in WinPOS you must go from the Main Menu into Housekeeping and 
then into Accounting Set-up and finally into Taxes (Main->Housekeeping->Accounting 
Setup->Taxes)  This is where you will set up your Retail tax rate before you convert the 
data. 

2. To set up the accounting method you start at the main menu and go into Housekeeping, 
then into Accounting Setup, then into GL Account set up, click on the GL Accounts tab and 
you will find the setting on the bottom right portion of the form (Main->Housekeeping-
>Accounting Setup->Accounting Classes) 
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3. Enter a store code on the system setup before importing (unless you have multiple stores, 
use 1.  Housekeeping->General Setup->System/Store Setup. 

We also recommend importing your data using the Training version of WinPOS© first, to 
familiarize yourself with the conversion process.  You can then use the Training version of 
WinPOS© to see what was converted and what was not.   

To use the Training version of WinPOS©, choose WinPOS© TRAINING from the BBL Systems 
group on the Windows Start Menu.  To restore the training data back to how it was when 
WinPOS© was installed, choose Refresh Training Data from the BBL Systems program group 
on the Windows Start Menu.  You can restore the data, then re-import your BPS© data as many 
times as you like.   

After the test conversion has been successfully completed you should check out all sections of 
the windows training module to see exactly how things were converted.  Write down any 
concerns and fax or e-mail them to us so we can help you resolve any issues before running the 
final conversion. 

 

To Convert the Data… 

1. Start at the Main Menu and click on Housekeeping. Enter the user name and password if 
required.  Username is MANAGER and password is PASSWORD. 

2. Click on the System Maintenance button. 

3. Click on the Import BPS© Data button. 

4. You have to select how you want your BPS© style codes converted.   

The conversion inventory prompts are asking you do make decisions about the way the BPS 
‘Store Style’ will be converted.  DOS BPS© had the ‘Store Style’ code.  WinPOS© has a Style 
Code and a SKU, both of which are VERY important and must be unique!  A thru C below are 
the inventory conversion options (WP = WinPOS©): 

a. Use BPS© style as WP SKU and BPS style + WP as WP Style:  

Answer YES to this prompt and the existing BPS style code becomes the SKU in 
 WinPOS©, and the BPS Style code plus the characters “WP” becomes the style code.  This 
is best option for most shops.  In BPS, the style code uniquely identifies a style, size, and 
color.  In WinPOS©, the style only identifies the style.  The SKU uniquely identifies the style, 
size, color, and width.  This is why the BPS style becomes the WinPOS SKU.  The BPS style 
+ WP then becomes the WinPOS style code so you can continue to locate items by style 
code.  The WP is added to the BPS style since in WinPOS style codes and SKU’s cannot be 
the same. 

b. Use BPS style as WP SKU and generate WP Style:  In this case, the BPS style becomes 
the WinPOS SKU, and WinPOS creates a new style code. 

c. Use BPS SKU as WP Style and generate WP SKU:  Here, the BPS style becomes the 
WinPOS style, and WinPOS generates a SKU as the style + size + color + width. 

5. Make sure that both show progress and erase WINPOS© data boxes are checked and then 
click on start. 

6. You are then prompted to select the location of the DOS BPS© data you want to convert. 

7. Once you have located the BPS© directory and it is highlighted click on select and the 
conversion process will begin. 

The data conversion will import: 

1. Users 

2. Vendors 
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3. Inventory Categories 

4. Brides 

5. Attendants 

6. Tickets 

7. Purchase Orders 

8. Un-issued PO items 

9. Pickup inventory 

10. Retail Inventory 

Notes: 

• Brides will be imported.  A single event (wedding will be created for each bride.)  The maid and 
bride styles entered on the bride’s card will be imported into the event notes in WinPOS. 

• Attendants will be imported as bridesmaids or groomsman on the bride’s event.   

• A customer card is created for the bride and each attendant. 

• The dress, shoes, and veil from the brides’ interest and dress, shoes, and hat from the 
attendant interest on the bride card is converted into the event notes. 

• Cancelled sales are not converted, and sales with adjustments are converted as a single sale 
(without adjustment) using the net sale price. 

• WinPOS© retail inventory is broken down into styles and sizes.  A single style record is linked 
to multiple size records. 

• Inventory cost factors on permanent inventory are not imported.  

• Markdowns on inventory categories are not imported 

• GL entries of Ticket Transactions that do not have a matching ivneotry category will be given 
MiscSales during the conversion 

 

DOS BPS© Files 

Technically, the conversion only requires the following BPS data files, and their associated CDX 
and FPT files. 

PW 

VENDORS 

CATS 

BRIDE 

ATTENDS 

SINGLE 

ORDERS 

PURCHORD 

PUINV 

INVENTOR 

PROSPECT 

 

KEY COMPARISONS BETWEEN BPS AND WINPOS 

In BPS (DOS) vs WinPOS© 
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HOUSEKEEPING FUNCTIONS 

Rebuilding / Restoring Data Files Reindexing Tables 

(Housekeeping→System Maintenance→Table Maintenance) 

 

REPORTS 

Daily Report 

Summary of Daily Reports Revenue Report 

Prints when closing register(s) and store 

OR 

Register Functions→Revenue Report) 

OR 

(Reports→Revenue) 

Salesperson Activity Report (when printing Daily Report) 

Sales by Salesperson 

Sales by Clerk 

Commission Report by Salesperson  

Commission Report by Clerk Sales by SA (Sales Associate) 

(Reports→Sales Reports→Sales by SA) 

Sales Ticket Activity Report (when printing Daily Report) 

Sales Ticket Activity Audit Transaction Review 

(Reports→Transaction Review) 

Sales by Vendor / Style Sales by Vendor 

(Reports→Sales Reports→Sales by Vendor) 

& 

(Reports→Sales Reports→Sales by Vendor Style) 

Sales by Category Sales by Category 

(Reports→Sales Reports→Sales by Category) 

Close Ratio by Salesperson Close Ratios 

(Reports→Close Ratios) version 3 

(Reports→Sales Reports→Close Ratios) version 4 

Mark Downs by Vendor Markdown by Vendor 

(Reports→Sales Reports→Markdown by Vendor) 

Mark Downs by Category Create Query 

Mark Downs by Primary Sales Person Markdown by SA (Sales Associate) 

(Reports→Sales Reports→Markdown by SA) 

Mark Downs by Clerk Markdown by SA (Sales Associate) 

(Reports→Sales Reports→Markdown by SA) 

Mark Downs by Reason Markdown by Markdown Code 

(Reports→Sales Reports→Markdown by Markdown Code) 

 

INVENTORY 
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Store Style Number SKU 

(Style Number+Size+Color) 

 

Special BPS Data Import 

Switchboard: Main->Housekeeping->System Maintenance->Special BPS Data Import  

Menu: n/a 

Action: CONVERT7 

This utility is used to import DOS BPS© version 7 or older data into WinPOS©.  Use this 
function under the direction of BBL Technical support. 

See the Import BPS Data topic for more information on importing BPS© data. 

 

 

 

Import TPS Data 

Switchboard: Main->Housekeeping->System Maintenance->Import TPS Data  

Menu: Setup->Import Data->Import TPS DOS Data 

Action: TPSCONVERT 

This utility is used to merge one copy of the DOS TPS© program data into the WinTPS© 
module of WinPOS©.  

There should always be a current backup copy of the WinPOS© data before performing a 
merge.  This allows for a restore and a re-merge if a problem is discovered after the merge. 

The DOS TPS© import will use DOS TPS© inventory Price w/o coat for WinTPS© price w/ coat 
when the DOS TPS© Free Format order entry setting is ON. 

The option to import the rental orders when enabled will overwrite the line items for existing 
matching orders within WinTPOS/WinTPS© with the order line items from within the DOS TPS© 
program when the same order number exist in both programs.. 

When importing TPS orders, if the order is already present within the database the IMPORT 
function will just import the line items of the order & not modify any Order header details.  If the 
style is present within inventory the IMPORT will check if thesizes/colors and serial #'s are 
already on file & if not add them from the database being imported from. 

Import WinPOS Data 

Switchboard: Main->Housekeeping->System Maintenance->Import WinPOS Data  

Menu: Setup->Import Data->Import WinPOS Data 

Action: WPCONVERT 

For multi-store implementations.  

This utility is used to merge one copy of WinPOS data into another. It would be used to move 
from two separate WinPOS installations to a single multi-store installation. 

There should always be a current backup copy of the data before performing a merge. 
 

The process merges the following data: 
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• Retail/Rental Inventory 

• Customers 

• Events 

• Tickets 

• Prospects, Prospect Interests,  

• Pickup Inventory 

• Purchase Orders 

• Inventory Categories 

• Accounting Classes 

 

It is possible (and likely) that styles in the imported inventory will match styles already in the 
existing inventory. It’s also possible that imported styles will use different store style codes. 
WinPOS addresses this by merging the styles based on the vendor number and vendor style. If 
the vendor number and vendor style in the imported inventory matches one in the existing 
inventory, the sizes and receive history will be merged into the existing style. If the vendor and 
vendor style are not found in the existing inventory, the style will be added to the existing 
inventory.  

For this reason it is vital that the vendor numbers and vendor styles are consistent between the 
two copies of WinPOS data to be merged. Review the vendor numbers in both copies of 
WinPOS to make sure the vendor numbers are consistent. If changes need to be made, use 
Main->Housekeeping->Inventory Setup->Inventory Maintenance->Change Vend/Vend Style to 
change the vendors/vendor styles in the import data. 

WinPOS will first prompt for the location of the data to be imported. This import data will be 
merged into the data WinPOS is currently using. 

WinPOS performs the following actions: 

1. First, WinPOS makes a temporary copy of the import data. This can take a few 
minutes, depending on the size of the data files. 

2. Next, WinPOS analyzes the data to identify vendor/vendor styles that appear in the 
import data but do not appear in the existing data. These are the styles that will be 
created in the existing data. If any are found, WinPOS displays and message and 
asks if the import should continue. At this point, a report can be printed of the 
vendor/vendor styles that will be created. This report should be reviewed to insure 
that these are indeed styles the appeared in the import data, but not in the existing 
data. If they actually do appear in the existing data, change the vendor/vendor style 
codes in the import data before retrying the import. 

3. WinPOS then imports the inventory, merging styles that already exist and creating 
new styles. 

4. WinPOS imports the customer, events, tickets, pickup inventory, purchase orders, 
prospects, inventory categories, and accounting classes. The sequence numbers for 
each imported item are automatically prefixed with the imported store ID to insure 
that they are unique. 

5. Finally, WinPOS displays a report at the end of the merge process. This report 
documents any exceptions that occurred during the merge process. This report 
should be reviewed and any appropriate actions taken. 

A message is displayed when the merge process is completed. The data files should be 
reviewed to insure the data merge process was successful. 

Import Wedding Events 
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Switchboard: Main->Housekeeping->System Maintenance->Import Wedding Events  

Menu: Setup->Import Data->Import Events  

Action: EVNTIMPORT 

 

This form is used to by WinPOS to import events into WinPOS.  The imported events will be 
automatically assigned a WEDDING type.   The type may be manually changed after the import 
when necessary. 

It is designed for new WinPOS installations to add their existing events as quickly as possible. 
 In addition, each member's sales ticket may be created with the balance they owe.  The 
balance & tax may be separated if necessary.  Please review the topic "Existing Customer 
Conversion" for an in-depth explanation pertaining to balance forwards & tax forwards of 
customer financial conversions. 

Simply enter a single specific wedding and it's members with as much information as possible. 
 When none of the members are assigned the role of BRIDE and/OR GROOM, WinPOS will 
stop the import & prompt for those names.  The event is created using the brides last 
name/grooms last name. 

Data may be keyed directly into the grid OR loaded from an excel spreadsheet. 

The heading for each column can be used to select what data will be entered in that column. 
 You can select from:  First, Last, Phone, Email, Address, City, State, Zip, Role, Balance due, 
Taxes due, Store ID 

Once all the members are entered, click Add to Wedding.  The Profit System will prompt for the 
brides’ last name, the grooms’ last name, and the wedding date.  If you have entered the bride 
and/or groom in the grid then the last names are set automatically.  The function the names to 
create the event name, but you could change it after the fact.  The gird contains members and 
their roles, so you could enter any roles. 

The event is created using the brides last name/grooms last name. 

Each row in the grid becomes a member of the event, with the role specified.  If an unknown 
role is entered, it will be added to the master list of roles. 

If a balance due or taxes due is entered, a sales ticket will be created for the member.  It will 
contain a sale of a BF style sold for the balance due, and a TF style sold for the taxes due.  This 
lets the event reflect the actual balance due for the members. 

Repeat the process for each wedding party. 

 

Manually Enter Customer into the grid for import 

Type customers into the grid.  Clicking the CLOSE button will save the entered data.  It will 
automatically be displayed GRID the next visit to the grid. 

Click the ADD to Customers button when completed entered rows of data.  WinPOS will prompt 
for the store location when the system is set to support multiple stores, then ask for each 
customer's event information. 

 

Using a eXcel spreadsheet to add customers to the grid for import 

All rows of the spreadsheet will be added.  Deleted any unwanted rows such as the column 
headings.  Next the Import Grid column headings should be modified to match the data within 
the newly added column.  Select ignore to skip any un-wanted columns. 
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Click the ADD to Customers button when completed entered rows of data.  WinPOS will prompt 
for the store location when the system is set to support multiple stores, then ask for each 
customer's event information. 

 

Buttons 

Delete Selected Row... Highlight any row of data within the grid.  Clicking this button will delete it 
permanently from the grid.  

Load Excel File... Allows a user to import data into an empty grid from an Excel spreadsheet file. 
Once the data is loaded the user should select the proper column headings for the data 
just loaded by using the column name drop downs above each grid field column.  If the a 
field does not exist that matches the data, just select the IGNORE column name and the 
system will skip that column's data during the insert. 

Add to Events... Takes the data within the grid and inserts it into the event, customer & ticket 
files, then DELETEs the data within the grid.  Once clicked WinPOS will check the data 
and if it identifies any issues it will display a message and stop the import and allow the 
entered data issues to be corrected within the grid by the operator.  Once corrected, 
simply click he Add Events button again and repeat the process until all issues are 
corrected and the import completes. 

Close... This exits the form, saving the data within the grid.  The data will re-appear the next time 
the form is opened. 

 

Program Status 

Switchboard: Main->Housekeeping->System Maintenance->Program Status 

Menu: Setup->System Maintenance->Program Status 

Action: none 

Overview 

This form shows the licensee for the program, as well as technical details and which modules 
are enabled. 

 

Fields 

Total Allowed Users...The program can be installed on any number of computes, but only this 
many users can be using it at the same time. 

Current Active Users...The number of active users at this moment.  This number cannot exceed 
Total Allowed Users. 

Soft/Hard...The due dates for the next payment, if the program is on a payment plan. 

Max Foreground/Max Background...The program can be configured to limit the total amount of 
memory it will use.  These numbers indicate how many bytes of memory the program will 
use when it's in the foreground, and background, respectively. This can be controlled via 
the MaxForeground and MaxBackground INI settings, and are usually only set on 
Remote Desktop Servers. 

Off-screen bitmaps...Used to correct display problems on some Remote Desktop Servers. 
Controlled via the Bitmap INI setting. 
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Oplocks...Indicates if Windows Oplocks are enabled or have been disabled.  Oplocks should be 
disabled for Windows 7 file servers, or Server 2008 file servers to prevent data corruption 
issues. 

Data...The path to the data files. 

Temp...The path to the temporary files folder. 

 

Program Options 

Switchboard: Main->Housekeeping->System Maintenance->Activate Options 

Menu: Tools->Unlock Options 

Action: none 

This form is used to activate and deactivate the optional modules in WinPOS®. This is utilized 
by BBL Systems tech support.  

Edit INI files 

Switchboard: Main->Housekeeping->System Maintenance->Edit INI Files 

Menu: Setup->System Maintenance->Edit INI Files 

Action: none 

 

The WinPOS system upon startup will attempt to open the TPSWIN.INI file which should be 
found in the Program Files folder where WinPOS installed, the default folder is 
PROFITSYSTEM. 

The TPSWIN.INI file contains settings & commands which instruct WinPOS how to start and 
begin operation.  This file may require editing from time to time and this option is a quick method 
to edit the file. 

The settings/commands for the TPSWIN.INI may be found within the TPSWIN.INI topic. 

Open Data folder 

Switchboard: Main->Housekeeping->System Maintenance->Open Data folder 

Menu: Setup->System Maintenance->Open Data Folder 

Action: none 

This form will open a file explorer window into the WinPOS data folder.  It is provided as a 
convenience to quickly access those files. 

Misc System Tools 

Data Manager 

Switchboard: Windows Start Menu->Programs->BBL Systems->Data Manager 

Menu: n/a 

Action: none 

The Data Manager is a special utility used to correct problems with your data that may stop 
WinPOS® from operating correctly. There is normally no reason to be in the Data Manager 
unless you are having data problems. 

No one can be using WinPOS® when you are using the Data Manager. 
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Please review the General Question topic, WinPOS will Not Start of Having operation trouble for 
detail information on how to utilize the Data Manager when WinPOS© is having issues.. 

 

Available Functions 

Reindex Tables...Re-creates special “index” files used by WinPOS®. You cannot harm your data 
by reindexing. 

Update Data...Checks all your data files to make sure they have the correct structure. This option 
will also reindex your files. This option is performed automatically when you update to a 
new version of WinPOS®.  You will be prompted for the location of the data files to 
update.  They are normally located in \TPSWINS\LIVEDATA 

Backup Data...Makes a backup of all your WinPOS® data files. It creates a file called 
BACKUP20010112.ZIP (BACKUP + year + month + date.ZIP) It is not meant to be used 
as your daily backup. It is it be used to make a quick backup before using Data Manager 
to work on your data files. 

Share Data Folder... Will automatically set the permissions on the data folder (location of 
WinPOS data files) to share read/write for all users.  This would be done via a logged in 
Windows user with Admin privileges. 

 

Reset Security to Default...This option is used to set the security settings back to their defaults, 
allowing everyone access to all parts of the program.  It would be used if the security was 
incorrectly configured, locking users out of WinPOS. You will be prompted for the location 
of the data files to update.  They are normally located in \TPSWINS\LIVEDATA. 

Validate Actions/Transfer...This option checks the Transfer/Actions list to make sure no entries 
are missing.  This option would be used if WinPOS is displaying a message such as "No 
entry in the Actions/Transfer table for" You will be prompted for the location of the data 
files to update.  They are normally located in \TPSWINS\LIVEDATA. 

Validate Query Data Dictionary...This option checks the query data dictionary tables to make 
sure no entries are missing.  This does not remove any queries.  It is used if tables or 
fields are missing from the Querymaker. You will be prompted for the location of the data 
files to update.  They are normally located in \TPSWINS\LIVEDATA. 

Validate Ship Options...This option checks a table that contains the various shipping carriers, 
shipping options, etc. has all the correct entries.  You will be prompted for the location of 
the data files to update.  They are normally located in \TPSWINS\LIVEDATA. 

 

Is WinPOS in Use?...Displays a message indicating if the data files are in use.  The data files 
cannot be in use for these utilities to be run.  You will be prompted for the location of the 
data files to update.  They are normally located in \TPSWINS\LIVEDATA. 

Force WinPOS exit...Prompts you for the data directory and sends a message to the registers 
using the data in that directory telling WinPOS® to shut down. Note that this does not 
close the register, it only shuts down WinPOS®. This will only work if the register is at the 
main menu. 

Lock out users...Creates a text file called LOCKOUT.TXT in the \TPSWINW program folder, 
which stops WinPOS from starting.  Note that this only works on a terminal server, where 
there is one program folder shared by all users. 

Remove lock out...Removes the LOCKOUT.TXT in the \TPSWINW program folder, which stops 
WinPOS from starting.  Note that this only works on a terminal server, where there is one 
program folder shared by all users. 
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Repair Headers...This option is used to fix damaged data files.  It does a quick repair.  You 
should have a data backup before attempting to use this utility, in case it makes the 
problem worse.  You will be prompted for the location of the data files to update.  They 
are normally located in \TPSWINS\LIVEDATA. You will then be prompted for the files to 
repair. 

Repair Files...This option is also used to fix damaged data files, however, it does an exhaustive 
repair process.  You should have a data backup before attempting to use this utility, in 
case it makes the problem worse.  You will be prompted for the location of the data files 
to update.  They are normally located in \TPSWINS\LIVEDATA. You will then be 
prompted for the files to repair. 

Integrity Check...Checks the contents of your data files to make sure data needed by the system 
is present. 

 

Data Utilities...Contains a number of specialized data update utilities. These should only be used 
under the direction of BBL Customer Service. 

Create Blank Data...Prompts you for a directory and creates a blank set of WinPOS® data.  This 
should not be done in the \TPSWINS\LIVEDATA folder because the existing data will be 
overwritten and lost. 

 

Update Data Technical Details 

Update data actually performs a series of operations. 

1. Make a backup of the data files.  The backup file is named YYMMDD.ZIP and is placed 
in the parent folder of the Livedata folder. 

2. Install the new database meta data. 

3. Update the existing data tables to match the structure of the new database meta data. 

4. Reindex all data tables. 

5. Make sure all records in the Users table have a valid primary key. 

6. Add the WALK-IN customer if missing. 

7. Make sure all wholesale rental orders have a valid customer name and event name. 

8. Add any missing system defined style codes. 

9. Make sure all registers belong to at least one store. 

10. Make sure all inventory records have a store id. 

11. Make sure every style code has an OTHER size record. 

12. Make sure every size/color/width has a valid quantity record for each store. 

13. Make sure every size/color/width has at least one receive history record. 

14. Make sure all OTHER records have a QOH of zero. 

15. Make sure all taxes records are logically consistent. 

16. Clear any existing saved credit cards. 

17. Make sure all accounting class names are uppercase. 

18. Move old actions from prospect to new todo table. 
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19. Clear any logged credit card entries. 

20. Remove any letters from extra charge size ranges. 

21. Make sure every owned store has a Store record. 

22. Delete orphaned size, store QOH, and receive history records. 

23. Extract all inventory images from the database storage and move to 
livedata\InventoryImages.  Move customer/prospect images to 
livedata\CustomerImages 

24. Move web store settings to style level for BigCommerce. 

 

Update  

Backup 

Located on the File menu->Tools-> Backup option. 

 

WinPOS© includes a simple backup routine that will make a backup of your data tables and 
index tags. It does not backup the program files. WinPOS© will create a single compressed ZIP 
file that contains your data and tags. The Backup path where this file will be saved is set in 
System/Store Setup, located at Main->Housekeeping->General Setup->System/Store Setup-
>Other Settings Tab. 

The Backup selection will suggest a filename of the current date, and will default to the path in 
System/Store Setup-> Other Settings tab. 

Customers may consider using BBL's Titan Backup Service.  This service is designed to provide 
a fast, easy & secure method for backing up all important data.  The data is encrypted, sent to 
BBL via the internet and stored on BBL servers.  Restoring the data is easy and it can be 
restored to any computer.  Off site backup is the safest form of data recovery.  Visit BBL's web-
site, www.bblsystems.com to sign up.  A FREE trial is offered. 

TPSWIN.INI 

Switchboard: Housekeeping->System Maintenance->Edit INI files 

Menu: Setup->System Maintenance->Edit INI files 

Action: none 

 

TPWWINS.IN is an ASCII text file that offers unique system settings that affects the operation of 
WinPOS©.   The file is editable from within Housekeeping-> System Maintenance-> Edit INI 
files menu option or from any system text editor.  Some entries, as data path and station name, 
are automatically placed in the TPSWIN.INI file by WinPOS© when it is installed.  These entries 
may be modified and others added. 

Note 

Any system operational options, such as default printers and others found in System Setup 
may be entered and will override any of the same options set with the WinPOS software. 
Contact BBL for additional information system settings override. 

 

The TPSWIN.INI file is found in the local workstation's profitsystem data folder.  Each 
PC/Workstation has a local data folder for error logs and the INI configuration file (even if the 
shared program/customer data is located on another computer).  Please refer to the Installing 
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WinPOS topic for folder locations.  You may view data, the INI and temporary file folder 
locations by visiting housekeeping-> System Maintenance-> Program Status. 

Note 

In a multi-user peer to peer network each user will have their own INI configuration file which 
may be customized for that specific workstation.  In a Terminal Services with an Application 
Server setup, each user shares an INI configuration file.  However, a workstation may have 
it's own INI configuration file by passing it's custom file to the program as a parameter when 
it started for that user.  An example would be: TW.EXE INI=F:\PROGRAM 
FILES\THISWS.INI     (include path to INI file location). 

 

Available TPSWINW.INI commands are: 

• DataPath=[path], i.e. DataPath=C:\TPSWINS\LIVEDATA\   It is the Location of the 
WinPOS data files.  Should have a trailing slash / 

• MaxForeground=[x]. i.e. MaxForeground=16000000 

• MaxBackground=[x], i.e. MaxBackground=16000000 MaxForeground and 
MaxBackground makes it possible for you to optimize WinPOS© performance by 
adjusting the amount of memory WinPOS© allocates for the foreground and 
background buffers. The foreground memory buffer is the memory available to 
WinPOS© when it is operating in the foreground as the currently active application. 
The background memory buffer is the memory available to WinPOS© when it is 
operating in the background when another application is the foreground application. 
 [x] is set to the maximum buffer memory size in bytes. 

• StationName=[name], i.e. StationName=FRONTDESK  Sets the station name for 
WinPOS to use.  The name must appear in the Register Setup form. (REGSETP) 
  For terminal services the [name] should be set to %USERNAME. 

• Background=[bmp file], i.e. Background=C:\TPSWINS\LIVEDATA\LOGO.BMP 
  Specifies the path and filename of a Windows BMP format file to be displayed 
behind the main WinPOS switchboard. 

• TempPath=[path], i.e. TempPath=C:\TEMP\    Specifies the path for temporary files. 
 This setting has been superseded by the Temporary path on the Register Setup 
form. 

• XPPROSERVER=YES   Enables a special mode of WinPOS© that corrects an 
application hang during WinPOS© shutdown when running on certain Windows XP 
Professional workstations. 

• NoCalendar=YES, i.e.  Disables the automatic display of the calendar on the Add 
Appointments form. 

• ICDiag=YES   Enables logging of communications between IC Verify and WinPOS© 
during credit card processing.  WinPOS will create icdiagr.txt and icdiaga.txt, 
containing the request and response messages. 

• ICVConfirm=[codes], i.e. ICVConfirm=BVK    Allows ICVerify to interpret additional 
codes as success during credit card processing. By default, only a Y indicates 
success.  By using this entry, any one of [codes] indicates success. 

• LogCharges=YES, writes an entry into LOG.DBF (WinPOS Log file) reviewable 
from Housekeeping-> General Setup-> Log, key =LOGCHARGE.  The command 
writes REQUEST file and RESPONSE and credit card swipe information.  This is 
used to analyze the process to uncover errors.  A User may key-press SHIFT+F10 
on credit card screen to LOG that one charge for diagnoses.  

• Rainbow=YES,  WinPOS uses random colors for form backgrounds. 
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• LongReportWarn=YES, WinPOS displays a confirmation message before printing 
very long reports. 

• DisableShipping=YES, Disables the Customer Shipping functions. 

• NoLinks=YES, Disables the web links within WinPOS©.  On Housekeeping, the 
Order Supplies, BBL Systems web site, and Check for Upgrades.  On the menu, the 
Unlock Options, Backup, Check for Upgrades, and Update License. 

• DestroyShiprush=YES,   Creates and destroys the reference to ShipRush as 
needed.  If not present, the same instance of ShipRush is used over and over again. 

• QOHReason=YES, This setting will instruct WinPOS© to prompt for a SA ID and a 
reason each time the QOH is changed directly via the Receive History or Stores 
QOH form.  To review the log entries for manual changes, visit Housekeeping-
>General Setup->Log. 

• NoDOWPickPrint=YES, This setting will not use the day of the week within the 
name of  printer for the printing of Picking Tickets 

• NoZeroPostings=YES  WinPOS© will be forced to not make any Ticket postings for 
zero dollar amounts, nor will it post any revenue or tax postings at zero dollar 
amounts. 

• NoTicketTheme=YES, will correct intermittent Windows XP SP2 themes where 
WinPOS© will have display refresh problems.  Try this setting when display issues 
are being experienced. 

• PrinterWait=99, instructs WinPOS to wait a number of seconds before it attempts to 
locate a Register/Workstations printers.  This is commonly used when Terminal 
Server printer redirector programs like Thinprint or Screwdriver software is utilized. 

• PromptTagQty=YES, Always prompt for number of retail tags to print from SCW 
form 

• Faxprinter=\xxxxxxxx\xxxxx, example XSHOPTS\BBL, forces the fax device to the 
name entered in this setting.  See the topic, "How do I fax receipts in WinPOS" for 
more info. 

• BitMap=OFF, Helps control screen painting issues found in some system 
installations.  

• NoInvoiceAtShipTime=YES,  NoInvoiceAtShipTime=YES means never print an 
invoice at ship time for wholesale type accounts on COD.  This is utilized for 
Wholesale type accounts on COD terms or other wholesale accounts that are 
pushed to COD because they exceeded their credit limit. 

• ReqFileName=USER1,  Setting created for PC Charge installations on a standalone 
PC or peer to peer PC network.  In this config each PC has it's own TPSWIN.INI file 
and this setting overrides the standard naming convention for Payment request files 
made to PCCharge from WinPOS.  Typically the request name is STAXX (where XX 
is the station number entered in the Register form).  PCCharge is shipped with a 
standard user called USER1, which cannot be modified.  This setting controls the 
request file name for each PC that the setting exist within it's INI file.  For those 
PC/Workstations without this INI setting the WinPOS default naming convention will 
apply. 

• ShipRushVersion=SR6, ShipRush is updated frequently and will issue a new 
version number, i.e. version 3 or 4 or 6 ..etc.  WinPOS should be set to use the 
proper ShipRush version, i.e. SR6.   This is accomplished with this INI setting.   

Program Switches 

A switch a program parameter that my be included on the command line when the program is 
executed that will instruct the program to start in a special way.  WinPOS offers two switches 
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that mat be utilized.  TW.EXE XXXXX, where XXXXX is the switch and this examples illustrates 
how to use it. 

 

SSWEB: Start WinPOS in the customer service self service web site building mode.  This auto 
creates the pages of the customer service web site. 

DM: Starts WinPOS in data manager mode which will display a menu of all the system utilities 

General 

Press Shift F11 to put the program in development mode.  This is a special operation mode with 
ALL reports/tags are displayed to the screen instead of printing and additional diagnostic 
information is display in specific function modules.  DO NOT use this for normal program 
operation. 

 

 

Program Parameters & Startup 

 

Startup Parameter Options 

WinPOS is a program with the file name TW.EXE.  It is typically found under the C:\Program 
files\ProfitSystem folder.  It is typically started from a Windows shortcut by providing the file 
name.   

It's behavior may be modified by adding a parameter to the command line when started.  This 
can be accomplished via a command line entry or shortcut.   

Example shortcut syntax is:  "C:\PROGRAM FILES\ProfitSystem\TW.EXE" DM 

 

Available Parameters 

DM... Starts the program in Data Manager mode. 

NOLOCKOUT... Starts the program irregardless of the Data Manager Lock Out Users setting. 

INI=....  By default the system looks for the TPSWINS.INI file.  This setting allows a different INI 
file to be used. 

Data=... Data folder location where data files/container is located. 

DIR= ... Switch to the specified folder to run within. 

Patch=... Yes or No... Set to NO the system will ignore performing a patch/ 

Register= ... Register name to use over-riding the register name in the INI file. 

 

Services that automatically run at program Start-up 

• Deletes inventory records with blank style codes 

• Deletes customer records with blank customer numbers 

• Delete rental item records with blank reservation/order numbers 

• Checks for accounting classes that have a blank tax group, and assigns RETAIL to 
them 
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• Checks if the Transfer/Actions table is missing records by comparing it to the reference 
one built into the TW.EXE and updates it if necessary. 

• Checks if there are security actions that no one can access and if so, displays an alert 
message 

• Checks if the query data dictionary is empty and if so, reloads all the query data 
dictionary files. 

• Checks if there is a user called DEFAULT in the user table, and if not, stops the 
program 

• Checks if any sequence numbers are set to rollover and if so, clears the rollover.  Also 
makes sure that bar-codes are set to pad to 8 characters 

• Checks if the WALK-IN customer is missing and if so, stops the program 

• Check for Purchase Orders with no receive date, but all line items are marked received 
and mark PO as received with last item's received date. 
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WinPOS Frequently Asked Questions 

WinPOS Frequently Asked Questions 

 

The topics under this chapter contain answers to many common questions.  Please explore all 
the topics. 

Prospecting 

How can I follow up with prospects? 

Go to Main->Prospects->Interests/History Tab. The Action List is where you can set up a list of 
actions to be performed, geared towards the sales associate. It is a way to keep track of the 
tasks that need to be completed for that prospect.  

You can run queries to analyze your prospects and to generate phone lists, emails, mailing 
labels and letters. See WinPOS® Query Maker for more details. 

You can also print a individual mailing label, letter or email for a prospect using the Print button 
on the Prospect form  and using Reports-> Cust/Events/Prospects Mass Mailing function. 

How do I keep track of gowns that a prospect has tried on and liked? 

Go to Main->Prospects->Interests/History Tab.  

1. Enter the store style number and SA ID who helped the prospect. 

2. Click on Add Item.  

The item now will be displayed on the box on the right. To view the inventory details regarding 
the item, double click on the style code. 

How do I enter prospects into the system? Why? 

Go to Main->Prospects and click on Add. Enter in all of the information you have. Include an 
event date, even if you do not have an actual date. When complete, save your work. 

Prospects are tracked by WinPOS® so the shop can provide a higher level of customer service, 
perform marketing activities and analysis.  

Reporting 

How do I get a sales person commission report? 

Use the Sales by Sales Associate report, at Main->Reports->Sales Reports->Sales by SA. 

What is a revenue report and how is it used? 

The Revenue Report shows the receipts for your store (cash, checks, etc.) and the total 
revenues for your store. 

The Receipts section of the report breaks down your store receipts, such as Cash, Checks, and 
other payments. 

The Cash Register section of the report shows your revenues and sales deposits/receivables. 
The actual lines totaled in this section are controlled by the Revenue Report Setup form.  

Below the Cash Register section is the Taxes section, which totals taxes collected. After that 
paid-outs and paid-ins are shown. The total of the Cash Register section plus taxes, plus paid-
outs and paid-ins should balance with your Receipts total. If it does not, the difference is shown 
as Cash Over/Under. This could happen if you deleted tickets or transactions from the Ticket 
form, or if you had data corruption due to power failure, hardware failure, etc. 
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Then, tax exempt transactions are shown (transactions where you entered a tax exempt ID). 
Finally, your sales are broken down by inventory category, into taxable and non-taxable sales. 

How do I use the Query tool? 

The Query report writer is a powerful tool to allow users to access the data stored within 
WinPOS™. An unlimited number of reports may be generated. See WinPOS® Query Maker 
help section for more information. 

How do I obtain sales analysis reports? 

The sales reports are at Main->Reports->Sales Reports. 

Purchase Orders 

How do I print POs? 

1. Select Issue Purchase Orders at Main->Purchase Orders->Issue Purchase Orders. 

2. Enter selection criteria (remember to check the Un-Issued PO Items checkbox) and 
click the UPDATE button to update the Purchase Order/Item Work Form list. The on 
screen worksheet displays all the items that match the criteria entered. 

3. Click the + sign to display unissued items within each events 

4. Click one or more item checkboxes to mark them for issuing 

5. Click on Show Item to display editable details about item before issuing if needed 

6. When all the desired items are marked, click the ISSUE button 

7. Enter the requested shipping information & printing options as appropriate 

8. The print preview will display the PO before printing, then click print & select output 
print. 

How do I receive POs? 

1. Go to PO Maintenance, at Main->Housekeeping->View Purchase Orders. 

2. Locate the PO to receive and click the Receive button. The Receive form is 
displayed. 

3. Check off the items to receive. 

How do I cancel and reissue a PO? 

1. Go to PO Maintenance, at Main->Housekeeping->View Purchase Orders. 

2. Locate the PO, and click the Un-issue button. 

3. Go to the Un-issued Purchase Order Menu, at Main->Purchase Orders. 

4. Click the Update button to view the Un-issued Purchase Order Items form. 

5. Re-issue the PO. 

How do I change something on a PO after it is issued? 

To make changes to a PO that has been issued, you will need to Un-issue the PO, make the 
appropriate changes and reissue the PO. 

1. Go to PO Maintenance, at Main->Housekeeping->View Purchase Orders. 

2. Locate the PO, and click the Un-issue button. 

3. Go to the ticket where the item was originally sold and make the changes. 

4. Go to the Purchase Order Search form, at Main->Purchase Orders->Issue Purchase 
Orders. 

5. Enter the slection criteria & click the Update button to view the Purchase Order/Item 
Work form. 
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6. Find & check the Item(s) in the list, then click Issue. 

How do I check on outstanding POs? 

1. Go to the Issue Purchase Orders form. at Main->Purchase Orders->Issue Purchase 
Orders. 

2. Click the Issued PO’s checkbox at the bottom of the criteria list 

3. Specify the selection criteria for the open PO display,i.e. event dates, inventory 
categories, etc. 

4. Click Update to show the Purchase Order/Item Work form. The on screen display 
can be printed for hardcopy reference. 

How do I delete an un-issued Purchase Order Item? 
 

If the customer is canceling the order: 

1. Go the ticket that contains the sales item. 

2. Select the item and cancel the sale using the Adjust/Canc/Extra Chrg. button. 

3. The un-issued purchase order item is deleted automatically. 
 

To manually delete an un-issued customer/stock PO item: 

1. Go to PO Item Maintenance , at Main->Housekeeping->View PO Items. 

2. Locate the purchase order item. 

3. Click on the delete button. 

How do I enter PO confirmations? 

1. Go to PO Maintenance, at Main->Housekeeping->View Purchase Orders. 

2. Locate the PO, and click on the PO Details Tab. 

3. Enter the confirmation date. 

4. Repeat steps 2-3 FOR A;; Purchase Orders 

 

. 

What do I do when a Customer cancels their event and a Purchase Order 
has been ordered for the event? 

If you can cancel the order with the vendor, you need to remove the PO from WinPOS: 

1. Go to PO Maintenance, at Main->Housekeeping->View Purchase Orders. 

2. Locate the PO, and click the Un-issue button. 

3. Go to PO Item Maintenance, at Main->Housekeeping->View PO Items. 

4. Locate each purchase order item on the original PO. 

5. Click on the delete button to delete it. 

If you cannot cancel the order, you’ll need to receive the item into WinPOS® as normal, then 
delete it from the pickup inventory and add it to retail inventory to sell it off. 

1. Go to PO Maintenance, at Main->Housekeeping->View Purchase Orders. 

2. Locate the PO to receive and click the Receive button. The Receive form is 
displayed. 

3. Check off the items to receive. 

4. Go to pickup inventory, at Main->Inventory->Pickup Inventory. 
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5. Locate the items received.  

6. Click the delete button to delete the item in pickup inventory. 

7. Go to inventory and add the item. 

8. Repeat steps 5-7 for all the items received. 

How do I special order items for a customer? 

1. When you enter the sale on the ticket, make sure you select Special Order for the 
status. WinPOS® will create an Un-issued PO item for it.  

2. Go to the Un-issued Purchase Order Items form, which will show all the un-issued 
PO items. Click the check box next to the customers PO item to select it. 

3. Click the Issue button to issue the PO. Enter the shipping information, and the PO 
will print. 

4. When the item is received from the vendor, go to PO Maintenance, locate the PO, 
and click the Receive button. This will place the item in Pickup Inventory. 

5. When the customer comes in to pick up their item, go to the ticket, select the item, 
and click the Pickup/Spec Order/Return button. Select Taken and save the ticket. 

6. The item is removed from pickup inventory. 

General Operation 

How do I register gowns sold to an event? 

Go to Main->View/Change Event->Event Tab for the event. Check the “Register sales” option. 
Now, when any item is sold to a member of this event, you will be asked if you want to register 
it. Also, you will be warned if you try to sell the same item to two members of the event. You can 
review the items registered by clicking the Show Reg. Sales button on the Members Tab of the 
Event form. 

How do I create form letters to be used and reused? 

Go to Main->Housekeeping->Letters, Tags, and Mailing Labels  

1. Click Add. 

2. Enter Source – Source is the area of the program that the printing will be generated 
from. 

3. Enter Type – Letter 

4. Enter Description 

5. Create Letter 

6. Navigate to \TPSWINS\USER. Give the letter a name and click Save 

Once the name is saved, you will be transferred into the word processor. Type your letter. You 
can insert merge fields into the letter by clicking the Insert Field button. Click Save when done. 

How do I create new price tags, pickup id tags and mailing labels? 

See Letters, Tags, and Mailing labels for information on customizing and creating your own 
tags. Call BBL Systems for information on our custom tag, label programming service. 

How are accounting classes used? 

Accounting Classes are assigned numbers from the WinPOS™ Chart of Accounts. Accounting 
classes are then assigned to inventory items. 

When inventory items are sold, the system records revenue & deposit information into the 
WinPOS™ transaction file by storing the GL Numbers associated to the accounting class of the 
item sold. The revenue report retrieves the data from the transaction file for printing. 
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As new Categories are created WinPOS™ will automatically create an Account Class of the the 
same name using default Chart Account Numbers. 

The optional accounting integration module allows users to add/modify GL Numbers and 
Accounting Classes default information.  

This methodology allows for great flexibility, but is not for inexperienced users. Please consult 
BBL for set-up/modification support. 

WinPOS® Will Not Start or having Operational trouble 

WinPOS© is a operates on a large database comprised of many data tables.   

Typical problems fall into two broad categories,  

1) In peer to peer networks WinPOS issue is usually network related, i.e. network share is 
lost, a workstation losses it network mapping, bad network transmissions or WinPOS data 
folder is not read/write  

2) Hard Drive begins to fail with bad read/writes, i.e. the drive does not stop working 100%, 
but gradually stops working and in doing so corrupts WinPOS data.   

3) License file failed error ##.  This WinPOS startup message indicates that the WinPOS.LIC 
needs to be replaced.  Retrieve this file from a backup copy and place into the WinPOS 
Livedata folder 

WinPOS© will stop functioning properly when it cannot access a table or data within a table 
becomes corrupt.   

Any data corruption must be eliminated before WinPOS© can resume.  BBL has created tools 
contained within the DATA MANAGER to help correct data issues.  The data must be restored 
from a backup when these tools fail to correct the data problem.  (backup EVERY day!!) 

The WinPOS data manager is built within the WinPOS software.  To access the Data Manager 
menu start WinPOS with the DM switch, i.e. TW.EXE DM.  The Data Manager shortcut may be 
found in Windows at Start-> Program Files-> The Profit System-> Data Manager.  See the 
TPSWINS.INI topic for more information. 

 

This document discusses the data correction tools & how to use them. 

Try these steps when WinPOS© is not running as it should: 

 

1) Reboot the server. 

Turn the server back on first, and wait for it to finish starting up. Try to run WinPOS® on 
your server only. If it works, then the problem is with your network. Consult with your 
network or computer technician. 

 

2) Peer to Peer LAN (skip this step for Terminal Server/Citrix environments) 

If WinPOS® works on your server, try this when you have a Peer to Peer LAN  

Turn on each computer in turn, and try to get into WinPOS®. If only certain computers can 
get into WinPOS®, then the problem is with your network. Consult with your network 
technician. 

 

3) WinPOS® will NOT run on your server 

a) Backup/Copy WinPOS© data to a safe location on your computer or to new blank 
backup media. This is done so that if these correction procedures make the problem worse 
you can still get back to where you were when you started. 
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b) Go to your server and click Start->Programs->BBL Systems->Data Manager (or to 
manually start it \tpswinw\TW DM).  This will start WinPOS© in data manager mode & 
present a menu of functions. 

 

4) Data repair steps via Data Manager (DM) 

Make sure all users are out of WinPOS©.  Perform each step in order.  If an error of 
Duplicate Record or Corruption in ticket file is being received, perform step D first. 

Once a step is completed exit the DM and test WinPOS.  Upon a successful WinPOS test, 
you are done and do not need to perform any more steps.   

A)  DM -Re-index Tables 

B)  DM - Repair Headers 

C)  DM - Update Data 

D) An error of Duplicate Record or Corruption in ticket file,  use FixTick.exe repair utility (an 
external program) described in # 5 

E) DM - Repair Files 

Using the REPAIR program 

When you run DM Repair program it will: 

1. Ask for the location of the data files. 

2. Make a backup of the data files into a zip file named using the current date. 

3. Create a temporary directory called TEMPDATA, and make an empty set of data files. 

4. Create a “def” files for each WinPOS data files.  These are used by the Recover program 
we licensed and use to check data files. 

5. For each file in WinPOS it will 

a) Check each file using the recover program.  It will automatically fix any problems it 
can. 

b) Scan the table for records with non-character data.  If it finds any it will just delete 
them. 

c) If it did find bad data and deleted records, it will also pack the table. 

6. Once it’s checked all the tables it will delete all the CDX files, then rebuild them all. 

There is a checkbox for “Use advanced mode”  If checked, Repair will allow you to select 
which table(s) to process.  If you don’t select any, or click Cancel it will process all the 
tables. 

When you run repair it will  

7. Ask for the location of the data files. 

8. Make a backup of the data files into a zip file named using the current date. 

9. Create a temporary directory called TEMPDATA, and make an empty set of data files. 

10. Create a “def” files for each WinPOS data files.  These are used by the Recover program 
we licensed and use to check data files. 

11. For each file in WinPOS it will 

a) Check each file using the recover program.  It will automatically fix any problems it 
can. 
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b) Scan the table for records with non-character data.  If it finds any it will just delete 
them. 

c) If it did find bad data and deleted records, it will also pack the table. 

12. Once it’s checked all the tables it will delete all the CDX files, then rebuild them all. 

There is a checkbox for “Use advanced mode”  If checked, Repair will allow you to select 
which table(s) to process.  If you don’t select any, or click Cancel it will process all the 
tables. 

 

F) Restore from a backup 

The preceding steps failed to get the WinPOS functioning, the last choice is to restore the 
data from your last backup.  The information entered into the system after the last backup 
is LOST.  It is very important to backup your WinPOS data folder at least once a day. 

 

 

5) Ticket table repair via FIXTICK utility program 

If it’s known that the ticket table is corrupted, use FIXTICK.EXE.   WinPOS© will run, but 
operations involving tickets do not work or causes the system to crash typically it is a 
DUPLICATE record error. 

The FIXTICK.EXE tool is semi automatic & will require some user intervention.  When a 
duplicate record or corrupted record is found the program will stop and highlight the 
duplicate/corrupt record of data.  Simply mark it for deletion by clicking the leftmost column 
(the delete flag column) which will mark the cell black. 

The FixTick program may be downloaded from BBL’s website: 
(bblsystems.com>Downloads>Support Software Tools) if WinPOS© works properly now you 
are done or found in \program \files\profitsystem\ folder. .  Exit the FIXTICK & test.  If test 
fails RESTORE FROM BACKUP. 

Using the FIXTICK program 

Run FixTick.exe 

1. When you run fixtick it will ask for the location of the data files. 

2. It will then make a backup to a temporary directory, named using the current date and 
time. 

3. It will then validate the database, which may delete the indexes on the tickitem file.  This is 
ok. 

4. It will then scan tickitem for non-alphanumeric records (corrupted records) and also 
duplicate records where the ticket and line number are the same for two records. 

5. If it finds any, it will display a browse window on the screen and take you to the first bad 
record.   

6. Manually correct the current record if possible, if not delete the record. 

7. Press ctrl-page down to go the next bad record, ctrl-page up to go to the previous. 

8. Once all the records have been fixed press ctrl-W to exit. 

9. You can run it again to see if it finds any more problems. 

10. Finally perform an update data structures from the Data Manager to rebuild the tickitem 
index. 
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If you still get errors you will have to restore from your most recent backup. You may 
want to contact a computer consultant for help if you are not comfortable restoring from 
your backup. 

 

Technical Notes 

1. Database and tables 

Extensions of files used by WinPOS©: 

DBF – Data table 

CDX – Index file.  They can be regenerated in WinPOS under Housekeeping–>System 
Maintenance–>Table Maintenance, or in Data Manager under Reindex Tables. 

FPT  – Memo file, contains free format text fields. 

LIC –  license file 

TW.DCT, TW.DBT, TW.DCX – Collectively are the Database Container.  Holds the meta–
data about all the tables and indexes (field types/length, key values) 

Data tables, indexes, memo files, and database container files all live in same directory. 
 WinPOS© can be configured to look for its data in any directory, as long as all the files are 
together in that directory. 

 

2. Folders created by installation 

See Installing WinPOS topic for detailed information. 

 

3. Data Manager 

Most maintenance is performed via the Data Manager.  The data manager is started via 
Start->Programs->BBL Systems->Data Manager, or by running \TPSWINW\TW.EXE DM 

Each Data Manager functions will prompt for the location of the data files to operate on. 

WinPOS itself contains a complete data dictionary built into the TW.EXE program file.  At 
startup WinPOS performs a quick check to make sure the data files in the data directory 
match it’s internal data dictionary.  If they do not the user is asked if they should be updated. 
 WinPOS© will not start if the user chooses not to update when asked. 

Reindexing tables is usually performed on a regular basis as preventative maintenance. 
 Tables can be individually reindexed.  Under terminal server reindexing is performed 
weekly.  All users need to be out of WinPOS for Reindexing. 

Reindexing is performed via WinPOS under Housekeeping–>System Maintenance–>Table 
Maintenance, or in Data Manager under Reindex Tables. 

During reindexing a Pack option can be selected.  When records are deleted in WinPOS the 
space is marked as deleted in the table but the record data is retained. Packing actually 
removes deleted records from the table.  Packing is only performed as-needed, for 
performance reasons (during an end-of-year process, for example) 

The other Data Manager options are documented below.  Each one will prompt for the 
location of the data files to operate on: 

Integrity Check – Scans tables and corrects various logical inconsistencies.  Does not need 
to be run on a regular basis.  This process is automatically run as part of an Update Data 
process. 
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Backup Data – Creates a ZIP compatible backup file of the data tables.  The DBF, CDX, 
FPT, database container, license, and contents of the USER folder are backed up. 

Force Exit from WinPOS – Sends a shut down message to each copy of WinTPS running 
from the data directory selected.  Only copies of WinTPS currently at the main switchboard 
will shut down. 

Is Anyone is WinPOS? – Displays a message indicating if the data files are in use. 

Update Data – Compares the structures of the tables and indexes in the data directory and 
makes sure that they match the internal data dictionary.  Tables and indexes that do not 
match are updated.  WinPOS checks its structures automatically at startup so this does not 
normally need to be run directly.  However, if data corruption is suspected this can be run to 
insure that the data structures are correct.  

Repair Headers – Re-generates the header on a data table.  This would only be used if 
WinPOS is reporting a “Not a table” error.  This is option will have no negative effect on a 
good table. 

Create Blank Data – Simply creates a blank set of data files in the specified directory. 

Data Utilities – A set of special-purpose utilities were created for very specific 
circumstances.  There are only three that are generally used. 

a) Reset Security – Resets the security groups and settings back to their default values. 

b) Reset Actions – Insures that WinPOS is using the latest list of security actions.  Only 
used if you are receiving a message “No entry in transfer table for ‘XYZ’”  This will cause 
no problems if run when it is not needed. 

c) Reset Query Data Dictionary – Insures that WinPOS is using the latest query data 
dictionary.  Used if new data table fields appear to be missing from the built-in Query 
maker. This will cause no problems if run when it is not needed. 

d) Fix Corrupted Data – Obsolete.  This is now superseded by the standalone Repair 
program. 

4. Basic table relationships 

Every customer is represented by a record in the CUSTOMER table (with a unique customer 
ID), and every event (wedding, prom, etc.) is represented by an EVENT record. 

If the customer is a member of an event (bride, bridesmaid, etc.) the CUSTOMER record is 
linked to the EVENT record via the EVCUSLNK table.  The EVCUSLNK will have a record 
with the customer ID and event ID.  A customer can belong to any number of events. 

Tickets are broken into two tables TICKMAST and TICKITEM.  The TICKMAST contains the 
ticket header, unique ticket ID and contains a customer ID and event ID field (among others) 
and TICKITEM contains the individual line items (sales, payments, etc.).  TICKITEM is linked 
to TICKMAST via the ticket ID.  Each TICKITEM record further has a sequenced line number 
(001, 002, etc.) that is unique to the ticket.  Each TICKITEM record is unique based on the 
ticket number and line number. 

If an item is sold and the status is special order, a record is created in POITEM with a unique 
item number.  This item number is written back to TICKITEM as well.  At this point, the 
POITEM record is an “un-issued PO item” 

When a purchase order is issued, a POMAST record is created with a PO number.  This PO 
number is written to each POITEM record that is a line item on the PO. 

When a special order is received, a PICKINV record is created.  PICKINV is the Pickup 
Inventory.  The item number is copied from the POITEM table which links back to the 
TICKITEM record. 
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If an item is sold into Layaway, a PICKINV record is created as well. 

Corruption Detected Error message 

 

When the  "Corruption Detected Error” message is displayed it means one or more of your data 
files has been corrupted.  Perform the following steps to attempt a correction of the problem. 

 

1. Exit from BPS on all workstations. 

2. Make a backup of your data files. 

3. On the server, run the Profit System Data Manager. 

4. Click Repair Headers, choose all the files, click Repair. 

5. Try to start the program again. 

For more details go to this web link: 
http://bblsystems.com/Default.aspx?Contenttype=ArticleDet&tabID=64&Aid=7 

How do I find the version of the program I am running? 
 

Knowing what version of WinPOS® you are currently running is necessary when checking for 
updates to the program and contacting technical support.  

From the main menu, click on the help menu at the top of the screen and select “About 
TPS/BPS Windows”. A splash screen will appear and give you the version opf the program you 
are running, the location of the data directory and who the software is licensed to. This is the 
same screen that comes up when the program is started for the first time. 

How do I open the store? 

When you start the WinPOS®, it will check if the register is open. If not, it will prompt you to 
open the register. After the register is opened, WinPOS® will check if the store is open. If not, it 
will prompt you to open the store and enter the business date. 

How do I close the store? 

Go to Main->Register Functions->Close Register. Once all the registers are closed, store will 
close. If you have the “Open and close all registers” option checked in System/Store Setup - 
Options Tab, WinPOS® will close all the registers and the store automatically when the first 
register is closed. 

Review Register Operations Help Chapter for more information. 

How does the accounting work? 

Taxes 

Taxes are computed as follows. At sale time, WinPOS® gets the Accounting Class from Retail 
Inventory for the item being sold. It then retrieves the Tax Rates for the Tax Group assigned to 
that accounting class. 

Before revenue is realized, WinPOS® posts taxes to the Tax Deposits GL account number as 
specified on the Taxes form. When revenue is realized taxes are posted to the Tax Revenue GL 
account number. 
 
 

Partial Payments 
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As you take partial payments, they are posted to the AR/Deposits account specified by the 
accounting class for the sales item. 

Remember, on the Cash accounting method the total amount due is posted to the AR/Deposits 
account as a receivable at sale time, so the postings above offset it. On Ticket Zero or Pickup, 
the posting above are deposits. 
 
 

Realizing Revenue 

Revenue is posted (or realized) at different times, depending on your accounting method. On 
Cash, revenue is realized at sale time. On Ticket Zero, when the ticket balance is zero. On 
Pickup, when the item is actually picked up. 

How do I change the WinPOS© business date 

 

You may be receiving this message 

What if my system date does not match my accounting date 

which indicates that the store  was not manually or automatically closed at the end of the day. 

As WinPOS® starts, it compares the system date (the computer date) to the accounting date it 
stored the last time the shop was opened within WinPOS©. A warning appears when these two 
dates are different.  Typically these dates should be the same unless shop management is 
wanting to enter transactions for another day's business. 

It’s important that the store is opened for the correct accounting/business date each day. All 
transactions are date-stamped with the current accounting date, so if your shop's business date 
is set to any other date other than the current computer date, all transactions created while that 
business date is set will be stamped for that business date and appear on that date's revenue 
report. 

OR 

You may wish enter/create transactions for a date other than today's date 

The Procedure 

The procedure to change the business date depends upon how system is configured to open or 
close it's registers. 

When WinPOS© is set "Auto Open/Close Store" 

Shut down program, change computer's system date to the desired date then restart WinPOS©. 

When WinPOS© is set to manually open/close store/register: 

To change the business date to a date other than the current date,  

1. Go to each workstation and close the register. 

2. Exit from WinPOS® (Main->Quit) 

3. Repeat steps 1-2. 

4. When you close the last register, WinPOS® will tell you that the store has been 
closed. 

5. Exit from WinPOS®. 

6. Launch WinPOS 

7. WinPOS® will prompt you to open the register  
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8. After you open the register, WinPOS® will prompt you to open the store. Enter the 
correct business (accounting) date. 

The user setting the date must have security access to the BDATEBACK (enabled for the user) 
action to set the business date to a date in the past.  

 

Register Open/Close options are set via the General Store setup Options Tab. 

 

How do I cancel a wedding? 

If you choose to charge a cancellation fee you should create a style in your retail inventory 
called CANCEL FEE. Use an accounting class that reflects the correct taxable status of a 
cancellation fee. 

1. Cancel the sale of the wedding gown on the brides ticket. The ticket now has a 
negative balance 

2. If you charge a cancellation fee, sell them a CANCEL FEE for the correct amount. 

3. Finally, click the Refund button and refund the balance back to the customer. 

Use WinPOS Data with other Programs 

Import WinPOS data into Microsoft Access & Excel 

Access 

The complete set of the Access Wizards should be installed. By default the Access installation 
does not install all wizards. To install additional wizard just locate the MS Access or Office 
installation under Windows Control panel, Add/Remove programs then select modify 
installation. This will allow you to instruct the set-up wizard to install the remaining wizards. 
Refer to MS Access Help for more information.  

All of MS Access functionality is available to work on WinPOS© data once the WinPOS data is 
imported within MS Access. 

Two Steps are required for MS Access to have use of WinPOS© data 

Step 1 

Data must be copied from WinPOS© into Microsoft Dbase III format. This is easily 
accomplished via the FOXCMD utility that is included with WinPOS©. Follow the listed 
commands here to copy the data. 

Start the FOXCMD program found within the program folder of WinPOS.  The name & location 
of this folder varies with the version of WinPOS and the version of the Windows Operating 
System used. 

Click the Start button, and choose Run. 

Type C:\TPSWINW\FOXCMD and click Ok. FoxCommand should start. 

Type CD F:\TPSWINS\LIVEDATA Replace F:\TPSWINS\LIVEDATA with the path to your data 
directory 

Type USE ? <Enter> A pop-up list of all the data files in WinPOS© will be displayed. Select the 
one you wish to use and click OK 

Now enter the command  

COPY TO c:\test DATABASE prospect TYPE FOXPLUS 
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Replace c:\test with any path & name you wish. Replace the word PROSPECT to the name of 
the new database you are creating. The system will add the .DBF extension to any file name 
you give. Your file is created! 

Exit FOXCMD by entering the word QUIT.  

Step 2 

Start MS Access 

Create a Blank database, you do not need to define any fields 

Select File->Get External Data->Import.  

The file selection pop-up screen will appear. Change the ‘Files of Type’ box to dBase III (*DBF) 
and navigate to the file you just created in Step 1 above. Then click OK 

MS Access will create the new table including the field names. 

Now use MS Access normally to manipulate or to create reports on the WinPOS data just 
imported. 
 

Microsoft Excel 

You can export WinPOS© data to MS Excel as well. Just modify the command discussed in the 
Access topic above to: 

COPY TO c:\test DATABASE newdata TYPE XLS (or XL5) 

As mentioned above, change c:\test to be the path where the new spreadsheet file should be 
created. Change newdata to the name of the new worksheet to be created. 

Type: XLS  

Creates a Microsoft Excel version 2.0 worksheet file. Each field from the currently selected table 
becomes a column in the spreadsheet, and each record becomes a row. If you do not include a 
file extension, an .xls extension is assigned to the new worksheet.  

Note   Though you can export a maximum of 65,535 rows, which includes one row reserved for 
the field header, versions of Excel earlier than 8.0 (Excel 97) display only the first 16,384 rows 
and cannot import files containing more than 32,767 rows. 

 

Type: XL5  

Creates a Microsoft Excel version 5.0 workbook file. Each field from the currently selected table 
becomes a column in the spreadsheet, and each record becomes a row. If you do not include a 
file extension, an .xls extension is assigned to the new workbook.  

 

Note   Though you can export a maximum of 65,535 rows, which includes one row reserved for 
the field header, versions of Excel earlier than 8.0 (Excel 97) display only the first 16,384 rows 
and cannot import files containing more than 32,767 rows. 

How do I use Gift Cards 
 

WinPOS© offers standard features to allow a store to offer a gift card/certificate service.  This 
help will refer to this service as gift cards. The shop may elect to not use card but to issue a 
formal numbered certificate.  

The features include the ability to sale gift cards and accept gift cards as payment for sales.  A 
gift card is no more than an advance payment for some future item or service.  The shop needs 
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to 1) accept the advanced payment without a prior sale of any item, 2) to accept a gift tender 
type payment and 3) then to track the balance of the gift card. 

Enable Tracking 

Enabled the System Setup - Other Options tab Track Gift Card Balances setting. This turns on 
the feature set required to process gift cards.   

Issue a Gift Card 

Gift Cards are issued on a customer sales ticket or on a Quick Sale ticket.  The SALE 
transaction for the Gift Card must be the ONLY SALE transaction on the ticket.  The user enters 
a new sales ticket and creates a SALE transaction for the style code of GIFTCERTIFICATE.   

Note: 

GIFTCERTIFICATE is pre-setup in WinPOS inventory with a GIFTCERT accounting class & 
GIFTCERT category.  This setup is required by WinPOS and MUST NOT be altered.  The 
GIFTCERT accounting class must have the 'Allow price changes' checked to allow users 
to enter the gift amount when it is being rung up.  With this setting checked the user will 
enter in the amount of the gift card in the price field. 

The accounting class  'Allow price changes' flag will allow any user whom may ring up 
sales to change a price on a ticket as the item is being sold.  Once the item's  ticket sales 
transaction is saved the system requires the security setting of  TICKPRICE to be enabled 
for the a user for that user to be able to modify an item's price. 

WinPOS will display a dialog box requesting: SWIPE CARD NOW message and a field for the 
Account # of the card to the user  when the transaction is saved.  A real gift card may be swiped 
or an ID/Acct # manually entered from a certificate.  This will become the ID that the balance is 
assigned to. 

The customer must pay in full the amount of the gift card.  The total payments on the ticket must 
equal the amount of the gift card. The balance of the ticket must be zero before it can be saved. 
 Once entered 

Using a Gift Card as Payment 

A Gift Card may be used as payment on any sales ticket containing a balance.  Make a 
payment on the ticket as normal, but choose the Gift Certificate tender type.  The system will 
display a dialog box requesting: SWIPE CARD NOW message and a field for the Account # of 
the card to the user.  The user may swipe a gift card or enter a ID code of a certificate.  The 
system will display the available balance of the gift card account and the user may enter in the 
amount to be used for payment.  The user will not be allowed to save a payment that exceeds 
the balance of the gift card. 

Gift Card Maintenance 

The Register Functions menu contains a selection called Gift Card balance.  This option will 
allow an gift card ID/account number to be entered and it will display the remaining balance and 
the last transaction date. 

The WinPOS Revenue report will list Gift Cards as they are issued and when they are used as 
payments for liability tracking. 

The Sales report - Gift Card Balances will print a list of gift card balances. 

Gift Cards may be purged based upon the Last Transaction date, deleting any remaining 
balance. 

Notes: 

It is a good security practice to NOT utilize a sequential numbering scheme for gift 
cards/certificates..  Sequential numbering makes it easier for employee fraud.  Gift Cards 
must be closely monitored and provides opportunity for employee theft.  This is due to the 
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fact that gift cards are assigned anonymously to customers.  So any individual (including 
employees) may use them to pay for goods.  A bad employee just needs to simply 
memorized a gift card/certificate ID number and use it to pay for personal items. 

 

How to set up Canadian Sales Tax 
Canada Tax Rates for WinPOS ‘Single Store’ 

 

Several areas of WinPOS must be set-up to properly account for taxes on purchases.  The 
areas are: Chart of Accounts, Accounting Classes, Tax Rates, Tax Groups and Inventory. 

A Canadian sales tax example: 5% PST tax on sales, 6% GST tax.  There exists two scenarios. 
 Set up the scenario that fits your shop, see below. 

 

Scenario 1 is for the store that must charge both rates on all items sold. 

Step 1: 

a) Create a tax rate called PST 

b) Set the rate to 5 

c) Set the tax group to RETAIL 

d) Set the Tax Revenue GL to 3001  

e) Set the Tax Deposit GL to 4000 

 

Step 2: 

a) Create a tax rate called GST 

b) Set the rate to 6 

c) Set the tax group to RETAIL. 

d) Set the Tax Revenue GL to 3002  

e) Set the Tax Deposit GL to 4000 

 

Make sure that the accounting classes are assigned to the RETAIL tax group.   

 

Scenario 2 for the store will sale some inventory items that should only have one of the two 
taxes applied. 

Add a new GL Account Number thru the WinPOS Chart of Accounts function.  Call it called 
3004 – Tax Retail Collected. 

 

Step 1: 

a) Delete RETAIL tax group 

b) Create a tax rate called PST 

c) Set the rate to 5 

d) Set the tax group to PST. 

e) Set the Tax Revenue GL to 3001  

f) Set the Tax Deposit GL to 4000 
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Step 2: 

a) Create a tax rate called GST 

b) Set the rate to 6 

c) Set the tax group to GST. 

d) Set the Tax Revenue GL to 3002 

e) Set the Tax Deposit GL to 4000 

 

Step 3: 

a) Create a tax rate called PSTBOTH 

b) Set the rate to 5 

c) Set the tax group to BOTH 

d) Set the Tax Revenue GL to 3001 

e) Set the Tax Deposit GL to 4000 

 

Step 4: 

a) Create a tax rate called GSTBOTH 

b) Set the rate to 6 

c) Set the tax group to BOTH. 

d) Set the Tax Revenue GL to 3002 

e) Set the Tax Deposit GL to 4000 

 

Also do: 

Modify/Create accounting classes for inventory and assign one of the tax methods: 

PST – Items sold will be charged PST only. 

GST – Items sold will be charged GST only. 

BOTH – Items sold will be charged both rates. 

Finally, assign the correct accounting class (based on which taxes are to be used) to the 
inventory item within Inventory on the Inventory - Details tab.  

With either option, go to Chart of Accounts and rename GL number 3001 from Retail Collected 
1 to PST, and rename GL number 3002 from Retail Collected 2 to GST. 

 

Disk Drives and Data Problems 

Hard Drive issues will result in intermittent and unexplained system errors they may corrupt data 
and make WinPOS© un-useable. 

Hard Drive issues fall into two classes: 

A) Viruses 

B) Physical hardware issues 

100% of all Hard drives eventually fail.  Disk errors occur frequently and the user never 
knows a problem occurred, since most computer hardware systems can automatically 
recover from minor issues.  However, at some future point, that cannot be predicted,  a drive 
will have a significant failure that will result in data loss or total system shutdown. This is why 
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it is critical to make backup copies of important data everyday.  Since most drives die slowly, 
data issues may creep their way into your backup data.  For this reason we recommend at 
least 1 week of daily backups be maintained, i.e. 7 copies of data, one for each day of week. 
Each copy would a data snapshot of how the computers data was that day.  So, in the event 
of data loss or corruption, a user could step back each day until a good clean set of data was 
found.  At which time that data could be restored to the computer and the input that occurred 
after that backup to the current date/time could be re-entered.   Please consider BBL’s Titan 
Off-Site backup service for the most reliable backup.  Review the Backup Topic for addition 
information. 

 

Please follow the this checklist when trouble shooting a Hard Disk.  Perform these steps on/at 
the primary computer (server) where WinPOS© data is located: 

1) Check for Viruses & remove any found.  Use popular programs like Norton or MacAfee.  A 
Virus that cannot be removed may cause the need to Reformat &  re-install Windows and all 
applications/data. 

2) Are any other programs experiencing issues also.  Does all installed programs start up and 
execute properly.  If not, consider replacing the hard drive. 

3) Run Window’s Error Checking utility and review any errors (click Start-> My Computer-> 
Right Click on the hard drive to check [usually C]-> Select Properties-> Click Tools Tab). 
 Replace hard drive when excessive errors are found. 

4) Run Window’s Defragmentation utility and review any errors (click Start-> My Computer-> 
Right Click on the hard drive to check [usually C]-> Select Properties-> Click Tools Tab). 
 Replace Hard Drive when excessive problems are found. 

5) Copy a large file from (500mb+) from one folder to another on the suspect hard drive.  If the 
system fails replace the hard drive. 

How do I rent Tuxedos with WinBPS 

 

Overview  

WinBPS can provide limited tracking of rental formal wear transactions, without the use of the 
Tuxedo Point-of-Sale or Tuxedo Profit System modules. 

The procedure is as follows:  

• Register an event with rental members 

• Sell the customer/member a retail inventory style code that represents the tuxedo as a 
special order item from the vendor/supplier and take payments 

• Issue a special order PO to order the tuxedo from the supplier.  (optional) 

• Receive the tuxedo via the normal special order receive function.  (optional) 

• Mark it picked up by the customer  (optional) 

• Mark it returned from the customer  (optional) 

Configure WinBPS for Rentals 

• Go to Main-Inventory->Vendors. Set up a vendor for each formal wear supplier.  

• Go to Main->Inventory->Categories.  Create a new category called RENTALS.  

• Go to Main->Housekeeping->Accounting Setup->Accounting Classes.  Find the 
category RENTALS and make sure the “Allow price changes option is checked”  Also, 
make it taxable or non-taxable as required in your city/county/state.  
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• Go to Main->Inventory->Inventory.  Create a separate style code for each formal wear 
vendor. The style code should be called RENTAL plus a short abbreviation of the 
vendor name. For example: RENTALJIMS, or RENTALMW.  Set the vendor style to the 
vendors tuxedo style, the vendor to the correct vendor, and the category and 
accounting class to RENTALS. Add a single size NA for each style. This style code will 
be sold on a ticket to represent the tuxedo rental.   

Note 

Optional: Mark the rental inventory item as a SERVICE/Not INVENTORIED.  This will 
automatically mark the rental inventory item status to NA when sold.   This is done to refrain 
form tracking the item thru a ordering, receiving and customer pickup/return steps as 
explained in more detail within the following sections. 

Set Up a Wedding 

• Create an event for the wedding.  Set the event date to the pickup date for the tuxedos.  

• On the members tab enter each customer and set the role to Groom, Groomsman, etc. 
 Enter their phone number, and their measurements.  

•  Click the Rental Styles button and enter the styles selected for the event  to order. 
 These styles are the actual rental styles codes utlized by the tuxedo wholesaler 

• Repeat steps for each member of the wedding.   

Create a Rental Order 

• Select the correct wedding, go to the Members tab and select the correct member.  

• Click Create New Ticket for that customer.  

• Sell them the RENTAL style code for the correct vendor.  Enter the correct selling price. 
 Enter a size of NA.  

• For the status, click Special Order (optional, do only if tracking is needed for 
ordering,receiving & pickup).  Automatically marked as TAKEN by system when item is 
marked as Service/not inventoried within inventory. 

• On the Special Order Instructions form, click Insert Styles.  Enter the sizes required. 
 Optionally, click Insert Measurements to add the measurements from the customer 
card to the special instructions.  

• Complete the sale and take a partial payment or security deposit.   

Note 

When not placing the orders via WinBPS, the store must maintain a manual file of tuxedo 
orders for managing that process.  BBL recommends the store utilize the Purchase Order 
functions of WinBPS for easy maintenance of the ordering process. 

Place Orders With Vendor/Supplier (optional) 

Go to Main->Purchase Orders->Issue Purchase Orders and issue a purchase order for each 
tuxedo vendor.  This purchase order is faxed to the vendor to order the tuxedos.  

 

Receive Orders From Vendor/Supplier (optional when not ordering) 

Go to Main->Purchase Orders->View Purchase Orders and receive the special order that 
contains the tuxedos.  The tuxedos now appear in pickup inventory.   

Customer Picks Up Tuxedo (optional  when not ordering) 

• Go to Main->View/Change Event and locate the correct wedding.  

• Go to the Members tab and locate the customer.  Click Go to Ticket.  
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• Select the tuxedo line item on the ticket and click Item Status.   

• Click Pickup Now to mark the tuxedo as taken.  

• Take any final payment.   

Customer Returns Tuxedo (optional when not ordering) 

• Go to Main->View/Change Event and locate the correct wedding.  

• Go to the Members tab and locate the customer.  Click Go to Ticket.  

• Select the tuxedo line item on the ticket and click Item Status.   

• Click Return from Customer to mark tuxedo back.   

Note 

The character sequence of RENTAL within the inventory style code is a key to WinPOS to 
not place the item into Pickup Inventory as would normally be done with any other item. 

 A query can be created which will show the status of tuxedo rentals: 

• Create a query based on the Tickets(Sales)  

• For the criteria: step 1 select Style code-item, step 2 Begins with, step 3 RENTAL.  

• For the output fields, select Last name, First name, Style code-item, Vendor-item, Sales 
item status-item, Date taken-item.  

 When the query is run: 

If the status is In and the Date taken is empty, then the tuxedo has not yet been picked up by 
the customer.  

If the status is Taken then the tuxedo is out to the customer, and was taken on the date taken.  

If the status is In, and a date appears under date taken, it means the order was returned by the 
customer on the date taken. (the date taken field has two possible meaning depending on 
the status) 

 

Sales & Tickets & Payments 

How do I sell something not in my inventory 

Generally the style code you enter must appear in your Retail Inventory to be able to sell it.  

However, there is a special way to sell something even if you don’t have it in your inventory. 
Make sure the “Allow sale of item not in inventory?” option is checked in System Setup, Options 
Tab.  

Then, when you enter a style code on a sales ticket that does not appear in your Retail 
Inventory, you will be prompted “SKU not on file, sell anyway?” If you say yes, the style code will 
be converted to NOSKU, a special style code that always appears in your inventory that has a 
MiscSales accounting class assigned and Misc category assigned (by default when the system 
is installed). The user entered SKU will be copied to the reference field so there will be a record 
of what was entered by the user.  

The MiscSales accounting class 'Allow Price Changes' option should be checked which allows 
the user to make the price whatever is needed.  

Most users do not use the NOSKU option because there are a number of reasons why you do 
not want to sell items that have not been entered into your inventory. Including: 

• You will not be able to analyze these sales as you can analyze other sales using 
the sales reports, since they will all show up under the NOSKU style. 
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• You cannot special order this item, since the style will appear as NOSKU on a 
purchase order & the vendor will always be the system default SHOP vendor. 

How do I find a customers ticket? 

If you know the event name: 

1. Go the Event form and locate the correct event  

2. Click the Members tab. 

3. Click on the Customer’s Name in the Members List.  

4. Click the Go To Ticket button. If Customer has more than one ticket, select the 
desired ticket 

5. The Ticket form displays the correct ticket. 
 

If you only know the customers name: 

1. Go to the Customer form and locate the correct customer. 

2. Click on the Customer tab. 

3. Locate the correct ticket in the Ticket list and double-click on it. 

4. The Ticket form displays the correct ticket. 
 

If you only know the ticket number: 

1. Go to the Select a Ticket form  

2. Enter the ticket number and click Ok. 

3. The Ticket form displays the correct ticket. 

How do I assign a ticket to a different event? 

1. Locate the Customer card for the customer (Main->View/Change Customer-
>Customer Tab) 

2. Double-click on the correct ticket in the Tickets list. 

3. Click on the binoculars next to Event field at the top of the Ticket form. 

4. Locate the correct event in the pick list. 

5. You will be asked to confirm that you actually want to assign this ticket to the event. 

How are markdowns used on sales ticket? 

When you use the Adjust/Canc/Extra Chrg. button to adjust the sale price of an item on a ticket, 
you must enter an adjustment amount and optionally a markdown code. This provides a record 
of the reason the adjustment was given. 

How do Security Deposits work? 

WinPOS allows each store to have the flexibility to hold a Security Deposit in case item is 
canceled, causing the forfeit or a full refund of money, as well as the option to use the Security 
Deposit as a payment towards the balance.  

When a security deposit is placed on an item, it is not reflected in the balance due, as it is not 
considered part of the payment. You must sell an item before taking a Security Deposit. 

To Add a Security Deposit 

1. Sell an item as normal. When wanting to add the security deposit to this item, click 
on Security Deposit or press the letter D on your keyboard. This will bring up the 
Security Deposit box.  
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2. Click Add or press the letter A on the keyboard. The payment window will display. 
Notice the bold message under Sales Associate; it will read: 
 
PAYMENTS WILL BE APPLIED TO SECURITY DEPOSIT 

3. Enter the amount of the Security Deposit, enter your Sales Associate ID, press Save 
Payment, and then click Next. You will return to the ticket for further options. 

4. To hold the Security Deposit for now, click the Done button to print receipt. The 
Security Deposit amount will be listed on the Receipt. 

 

To Apply the Security Deposit as a payment 

1. Locate the ticket. 

2. Click on Security Deposit or press the letter D on your keyboard.  

3. Select on Apply as Payment or press the letter P on the keyboard. This will take you 
to the payment window. This time you will notice a different bold message under the 
Sales Associate box that reads: 
 
MAKING PAYMENTS USING SECURITY DEPOSIT 

4. You will also notice a new button in the upper right hand corner labels Sec Dep. To 
apply this amount, click on this button. Enter your Sales Associate, Save Payment, 
and then click Next to print receipt. 

 

To Forfeit the Security Deposit 

1. Locate the Ticket. 

2. Click on Security Deposit or press the letter D on your keyboard. 

3. Select on Forfeit or press the letter F on the keyboard. This will display the Forfeit 
box. 

4. Enter your Sales Associate and click Forfeit or press the letter F on the Keyboard. 
This will return you to the ticket.  

5. If the Security Deposit is being refunded because of a cancellation, you will need to 
CANCEL THE LINE ITEM. Click on the line item that needs to be canceled, and 
then click on the ADJUST/CANC/EXTRA button. Select CANCEL LINE ITEM. Enter 
a REFERENCE, enter CLERK and click SAVE. The system will ask you if you want 
to remove item from pickup inventory or cancel purchase order. Press Done to print 
receipt. 

To Refund the Security Deposit 

1. Return to the Customer’s Ticket. 

2. Click on Security Deposit or press the letter D on your keyboard. 

3. Click on Refund or press the letter R on the keyboard. This will bring up the payment 
window. Notice under Sales Associate the message reads: 
 
REFUND OF SECURITY DEPOSIT.  

4. You will also see the Sec Dep button. Click on this button; enter Sales Associate, 
Save Refund, and then click on Next. You will return to ticket and the receipt will 
print. 

How are Rental Order prices computed? 

WinPOS® computes the rental price for an order as follows. 
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It first totals all the rental prices for non-accessory items, using the rental price w/ coat or w/o 
coat, depending if there is a coat on the order. 

It then totals all the rental prices for accessory items (again using the price w/ coat or w/o coat).  

In addition, accessory package pricing will apply additional discount (when in effect). It then 
finds the highest ranked price group code (based on the Ranking field for the price group) used 
on the rental order. If the total price of the accessories is greater than the maximum price for 
that price group, WinPOS® creates a discount so that the total price of the accessories will 
equal the maximum price for that price group. If the price of the accessories is lower, WinPOS® 
just uses the total accessories price. 

It adds these two totals together to get the total rental price. 

The system will apply any markdowns created on a event, if the order is to a event and the 
event has special pricing on the registration. 

What are markdown codes? 

Markdown codes are a way to identify the different reasons you gave a customer a discount. 
They are used on the ticket form, inventory form, and inventory categories form. You can create 
your own markdown codes on the markdown form, at Main->Inventory->Mark down codes. 

Using Markdowns 

It is a common practice to make point of sale ticket adjustments / markdowns to encourage 
customers to purchase specific products. 

Markdowns may be planned or performed when needed at point of sale via a ticket.  Markdowns 
are performed on a line item by line item basis, meaning an adjustment is entered by the 
operator for each SALE transaction.  However, line item markdowns may be automatically 
applied when specific set-up conditions exist. 

Adjustments / Markdowns are computed on the current net price of the sales transaction.  A 
system setting in Main-> Housekeeping-> General Setup-> System Setup -> Setup Tab - 
Exclude extra charges from adjustments?  Extra Charges affect the sales's net price. Checked 
this setting will exclude any extra charges from the adjustment calculation.  For example.  A 
bride purchases a size 22 gown for $1000, the extra size charge adds another $200 for a $1200 
total.  Now you wish to give the bride a 10% adjustment / markdown on the dress.  When extra 
charges are excluded the 10% discount would be $100 in this example. 

 

Markdown scenarios 

1) Promotional Pricing.  Rules are set to indicate which inventory is being markdown, when the 
markdown is in effect and how much the markdown is.  See the Promotional Pricing topic for 
more information. 

 

2) Markdown Codes.  Markdown codes are optional to use & may apply to any inventory item or 
service.  They may allow any markdown amount or be limited.  They may be applied during any 
time-frame or be limited.  All this is determined by setup.  See the Markdown Codes topic for 
more information. 

 

3) Manually. A operator may enter a markdown on a ticket on demand.  When a operator has 
security to perform ticket markdowns they may add a markdown anytime to a ticket.  When 
doing so the system provides options to how the markdown may be physically entered on the 
ticket, for ease of use. 

Any markdown amount can be entered in any of the following formats: 
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• A whole dollar amount, entered like 50.00, or –50.00. In this case, the retail price will 
be discounted by $50. 

• A percentage entered like 10%. Here, the price will be discounted by 10% 

• A percentage entered like +10%. Here, the price will be increased by 10% 

• A plus amount, like +15. The retail price will be increased by $15. 

• A divisor, like /1.07. The retail price will be discounted by the exact amount needed 
so that if you went back and marked the price back up by 7%, you’d get the original 
price. An example: $1000 discounted by /1.07 would result in a discount of -$65.42, 
and a markdown price of $934.57. If you then take $934.57 and mark it back up by 
7%, you get $1000. A 7% discount on $1000 is -$70.00, and a markdown price of 
$930.00. If you mark $930.00 up by 7%, you get $995.10. This is useful if you want 
to give a customer credit for tax charged. In our example, if the tax rate was 7%, the 
discount of 1.07 will discount the item to equal the tax charged. 

WinPOS© checks to insure the code entered is valid.  If not WinPOS© will display a message 
indicating the code is invalid. 

 

4) Ticket Level Markdowns.  A operator can set a temporary ticket-level adjustment to a ticket. 
 Once set up, this adjustment amount and adjustment code is automatically applied to every 
new sale entered on the ticket, until the ticket is closed.  

To set up the adjustment, click Adjust/Canc/Extra Charge on the ticket.  On the adjustment 
dialog box, select Ticket Adjustment.  It will prompt for the adjustment amount and code.  Enter 
them, and click Save. 

To clear the adjustment so it won’t be applied to the rest of the sales entered on this ticket, click 
Adjust/Canc/Extra Charge, then Ticket Adjustment (note that Ticket Adjustment is shown in 
boldface, indicating that a ticket-level adjustment is in effect.)  Finally, click Clear.  Now, no 
adjustment will be automatically applied to each new sale on the ticket. 

Once the ticket is closed, the ticket-level adjustment is cleared automatically.  The adjustments 
added to the sales will remain, but if the ticket is re-opened, the adjustment will not be added to 
new sales, unless the ticket-level adjustment is re-set.  However, you can create a Customer 
Markdown, if you want a ticket-level adjustment to apply to every sales on every ticket for a 
customer. 

 

5) Customer Markdown.  On the details tab of the customer you can specify an adjust amount, 
and an adjust code.  This will become the default Ticket-Level adjustment for new tickets for the 
customer.   

You can clear the ticket-level adjustment so it won’t apply to the rest of the sales entered on this 
ticket, click Adjust/Canc/Extra Charge, then Ticket Adjustment (note that Ticket Adjustment is 
shown in boldface, indicating that a ticket-level adjustment is in effect.)  Finally, click Clear. 
 Now, no adjustment will be automatically applied to each new sale on the ticket.  However the 
Customer Markdown stored with the customer is NOT cleared. 

 

How do I charge for a service? 

If you want to see the service item broken out on Sales and Inventory by Category reports, 
create an new inventory category for the service, using a descriptive name i.e.. SHOE DYE, 
 FREIGHT, ALTERATIONS, PRESSING, CANCELLATION FEE ...etc. WinPOS will 
automatically create a new accounting class and line item on the revenue report. 
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Go to the new accounting class and set the taxable status appropriately. If you need to change 
the selling price at sale time, check the “Allow price changes” checkbox. 

Create a style code in inventory for the service, again using a descriptive term for the style code 
ie. ALTERATIONS, PRESSING. Use the new inventory category and accounting class. If there 
is a standard price for the item, enter it as the Retail 1 price.  Remember to check the 
Service/Not inventoried? checkbox so WinPOS© will not attempt to count it during physical 
inventories, WinPOS© will auto apply a TAKEN transaction status when it is sold on a ticket and 
not attempt to adjust Qty on Hand when sold.. 

Create a single size of “NA” for the item. 

Now, you can simply sell the new style code to sell the service. 

What is a Store Credit? 

A store credit is money that your shop owes the customer. Store credits are created when you 
cancel a sale and choose not to give the customer a refund. The money owed the customer 
becomes a store credit. This store credit can be used for other purchases, or refunded to the 
customer. If a customer has a store credit it is shown on the Customer form and on the Ticket 
form. 

How is cost and value computed? 

The cost of sale is computed the moment of the sale and is realized when the sale revenue is 
realized.  

There are multiple cost numbers that may retrieved from inventory, 1) Reorder cost 2) Actual 
Cost, based on LIFO or FIFO.  

The inventory reorder cost is used for sales that are given a ORDER status. The actual cost is 
retrieved from the Inventory Receive History data for newly created sale items given a status of 
IN or TAKEN. LIFO costing will result with the most recently received inventory item sold and 
the unit cost of that item will be used. FIFO results with the oldest inventory item in the receive 
history being used.  

The inventory value computation is documented in Inventory Maintenance - Display Inventory 
Value. 

How do I adjust the selling price? 

There are four ways to adjust the selling price of an item. 
 

1. Enter a Price 2 on the inventory style that is lower than Price 1 and then select the 
lower price when WinPOS® suggests it on the ticket 

2. Enter a markdown price on the inventory style for Price 1 or Price 2 

3. Create Promotional Price for the style that is automatically applied when sold 

4. Enter a manual Adjustment on the ticket when the item is sold.  
 

Follow these instructions to enter a manual discount adjustment. Manual adjustments may be 
applied to any style sold, even if it had other markdowns also, 

 

1. Locate the ticket. 

2. Click on the Line Item Number you want to adjust 

3. Click on the button labeled Adjust/Canc/Extra 

4. Click Adjust Line Item 

5. Enter the adjustment amount in the Adj. Amt field. Adjustment must be entered as 
follows: 
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  sell for exactly 10 dollars, enter 

  =10  

   

sell at 10 percent off displayed price, enter 

10%  

   

sell for 10 dollars off displayed price, enter 

$10 or 10 or –10  

   

sell displayed price plus add a markup of 10 dollars 

+10  

 

6. Enter a markdown code in the Mkdn. Code field. 

7. Enter an explanation in the Reference field, if you like. 

8. Click Save Line Item. 

How Do I Cancel the Sale of an Item? 

To cancel an item 

1. Locate the ticket. 

2. Click on the Line Item you want to cancel and then click on the button labeled 
Adjust/Canc/Extra. Select Cancel Line Item.  

3. Enter a Reference, enter the clerks SA ID, and click Save. The system will ask you if 
you want to remove item from pickup inventory or cancel purchase order, if the item 
was special ordered. 

4. The Refund button is enabled so that you can give the customer a refund, if needed. 
If the customer has a credit balance, and you do not give a refund, the credit 
balance will be converted to a store credit. If you don’t want a store credit, you must 
give a refund before you click Save/Done with Ticket to close the ticket form. 

How do I change taxes when selling an item? 

On the ticket form, highlight the Sale transaction and click the Taxes button. You can select 
which taxes to charge by checking the ones you need. You cannot change the taxes on a sale if 
the revenue has already been realized. 

How do I give a refund? 

A ticket must have a negative balance before you can give a refund, or the customer must have 
a store credit. To generate a refund if the ticket has a negative balance: 

1. Go to the ticket. 

2. The Refund should be enabled. Click the Refund button. The Payment form 
displays. 

3. Click the tender type for the refund. 

4. Enter the correct refund amount, or use the default. 

5. Enter the Sales Associate ID and click Save Refund. 

6. Click Next to save the refund. A receipt will print. 

If the customer has a store credit: 

1. Go to the ticket. 
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2. Click the Refund button. The Payment form displays. 

3. Click the Refund Store Credit button on the Payment form. An indicator appears 
saying that Refunds will be taken from Store Credit. 

4. Select the tender type for the refund, enter the amount of refund as a negative 
number, enter the clerks SA ID, and click Save Refund. 

5. Click Next to save the refund. A receipt will print. 

If the customer was a Quick Sale and you do not know the ticket number: 

1. Use the Main ->Sale->Quick Sale function to create a new ticket. 

2. Sale the item being returned with a negative quantity, i.e. -1. 

3. The negative quantity sale will cause the ticket to have a negative balance. 

4. Choose Payment enter a positive  payment in the tender type for the amount of 
refund.  WinPOS© will convert the sign of the payment refund properly. 

OR - preferred method 

1. Determine the style code of the item being returned. 

2. Use the Main ->Register functions->View Ticket by Style Code to find a ticket with 
the item being returned 

3. Adjust & cancel the item, this will generate a negative balance 

4. Choose Payment & REFUND the amount. 

 

How do I take a single payment across multiple sale tickets? 

1. Go to the Select tickets to pay form (Switchboard:  Main->Payments, Menu: Sales-
>Split tender/Split payments) 

2. Enter either the customer number or event number. You can search for either by 
using the binoculars button. WinPOS® displays all the tickets for that 
customer/event that have a balance. 

3. If you don’t want to make a payment on a ticket, select it in the list and click the 
Remove Ticket from List button. 

4. You can select more tickets by repeating step 2. 

5. Enter the clerks SA ID and click Next. 

6. The Enter payments form displays. 

7. Click the tender type for the payment. 

8. Enter the amount paid, or use the default. If the tender type is cash, you can also 
enter the amount tendered and WinPOS® will compute the change due. 

9. If it is a credit card payment and you have the Credit Card Integration, you will be 
prompted to process the credit card. 

10. If you have other tender types, repeat steps 3-5. 

11. Once you have entered all the payments, click Next. 

12. The Apply payments form displays. 

13. Select a ticket from the list of tickets. 

14. Enter the amount you want to apply to that ticket. 

15. Click the Apply to Ticket button to apply that payment to that ticket. 

16. Repeat steps 13-15 until all the payment is applied. 

17. Click Done to finish the process. 

How do I change the Customer or Event on a sales ticket 
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Occasionally a mistake may take place where the operator creates a ticket for the incorrect 
customer or event.  WinPOS© provides a simply solution for this situation.   

Simply display the ticket and in the top right corner will be the customer and the event (if any) 
that this ticket is assigned to.  Just click on the binoculars next to the event or customer and 
select the correct Event or Customer the ticket belongs to.  Save it and it is done.  Now the 
ticket is assigned to the new event or customer.  Obviously the Event and/or Customer must be 
created prior to attempting to assign the ticket. 

How do I FAX receipts in WinPOS 
 

Fax a receipt in WinPOS is an simple task once your computer system is setup to transmit or 
receive faxes.   

Requirements 

• Your system should have a FAX modem attached 

• Microsoft Fax software should  be installed and configured (3rd party fax software would 
work as well). 

Microsoft fax & scan software is available for FREE on Windows XP & Vista and newer 
operating systems. This software should be installed and configured to work with an available 
fax modem.  When configuring the "fax software" it will create a printer in your systems Printers 
folder.  The name of this device must contain the work FAX in it.  Check the new devices's 
name and if it doesn't, rename it to include the word FAX, i.e. Print to Fax or FaxPrinter 

Once the Fax device is created with a name containing the word FAX, the WinPOS system will 
automatically detect it.  When printing a receipt the WinPOS system provide a prompt to the 
user with the option to FAX.  

Selecting the fax option will 1) print the receipt to the TIF graphic file format and 2) start the 
Windows Fax software in New Fax mode and automatically attach the receipt.  In "New Fax" 
mode the Windows Fax software will additionally prompt the user for a fax number, subject & 
comments for the fax. 

The Fax printer name can be overwritten with w TPSWIN.INI entry.  With this entry WinPOS will 
FAX the receipt to the printer/fax device defined in the INI entry.  an Example is: 

Faxprinter=\\SHOPTS\BBL_FAX 

See the TPSWINS.INI topic for more detail. 

Reports or letters may be  electronically FAXED, once a Fax device is setup on the system. 
 Simply choose the Fax device instead of a printer when prompted. 

Inventory 

How do I enter retail inventory? 

Go to Main->Inventory->Inventory  

1. Click on ADD 

2. Enter the Style Code Number (Your representation of the vendor’s style number) or 
let the system generate a serial number for the store style code. 

3. Enter Vendor Style Code Number 

4. Enter Comments & Notes (These will not print on receipts. They are designed to 
give any addition sales information to clerks at time of sale.) 

5. Enter a Vendor Number. 

6. Enter an Accounting Class. 
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7. Enter an Inventory Category. 

8. Enter Size, Color, and Width Charts (optional.) 

9. Enter Reorder Cost (Once these figures are entered the Retail Price One will 
automatically be calculated.) 

10. Click on the SCW (sz,clr,with) button to add the sizes and colors you have in 
stock and to create a receiving history with the date received, quantity received, the 
quantity on hand and wholesale cost. 

11. SAVE your work 

12. Repeat for each style 

How do I find out how well an inventory item is selling? 

Go to Main->Inventory->Inventory->Statistics Tab for the style in question. You can see Total, 
YTD, and MTD sales, revenue, prospect interest, and other information. 

How do I get a pickup inventory value? 

It’s shown at the end of the Pickup Inventory by Age report, at Main->Reports->Inventory 
Reports->Pickup Inventory by Age. 

How do I age the items/inventory in my pick-up inventory? 

Use the Pickup Inventory by Age report, at Main->Reports->Inventory Reports->Pickup 
Inventory by Age. 

How do I markdown discounted inventory? 

You can enter an adjustment amount and markdown code on the inventory form to discount the 
retail price of the item. Then, when the item is sold the new price will be used. 

How do I set up color charts? 

Go to Main->Inventory->Color Charts  

1. Click on ADD.  

2. Enter Color Chart Names – all chart names need to be unique and different for all 
vendor charts. Select the Vendor  

3. SAVE 

4. To add the colors, click on Add Color and enter the color name 

5. SAVE.  

6. For next color, click on Add Color, type in color name  

7. SAVE 

Continue same procedure until all color names are complete. 

How do I set up size charts? 

Go to Main->Inventory->Size Charts  

1. Click on ADD.  

2. Enter Size Chart Names – all chart names need to be unique and different for all 
vendor charts.  

3. Select Vendor 

4. SAVE  

5. To add a size, click on Add Item.  

6. Enter the Size information. Measurement 1, 2, 3, and 4 are user-defined and 
optional. Some fields require you to press the space bar to activate field. 
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7. SAVE  

8. To add an additional size, click on Add Item.  

9. Enter information and SAVE.  

Repeat until all desired sizes are entered and saved. 

How do I get an inventory value? 

 

Go to Main->Inventory->Inventory Maintenance. Click on Recompute on-Hand Qty, then 
Recompute Inventory Value, and then finally Display Inventory Value. 

Value is also available on most inventory reports. 

How do I do a physical inventory? 

Physical can be accomplished for Retail, Rental & Pick-Up inventories. There are several 
approaches offered to performing a Physical of the inventory.  

Review the Physical Inventory Overview topic for complete information. 

How do I print inventory price tags? 

You must set up your tag in Main->Housekeeping->Letters, Tags, Mailing labels as an InvDetail 
tag before you can print (see Letters, Tags, Mailing Labels).  

Once the tag format(s) are created, tags can be printed from the Retail Sizes (SCW) form or 
Print Tags form (for a batch set of tags) 

How are markdown codes used in inventory? 

You can enter an adjustment amount and markdown code on the retail inventory form to 
discount the retail price of the item. Then, when the item is sold the new price will be used. 

What is a store style number? 

A store style number is a unique code you assign to identify the style of an item. The store style 
number does not identify it’s size, color (that is done via a SKU, barcode, or UPC code) Rather, 
the store style number is analogous to the vendor style number. You create the store style 
number so you don’t have to use the vendor style number. 

What is Matrix and how do I use it? 

A size or color or width matrix is a grid that is created containing the variants available for each 
style.   A cross the top of the grid will be the color names and along the left side will be the sizes 
and widths that are available.  

For example, the store stocks a shoe that comes in sizes 5-7 narrow white. The color column is 
where we will be entering our quantity on hand for each size and width. To begin, on the left 
side of the grid locate narrow (or A for narrow) in the width column and locate numbers 5, 5.5, 6, 
6.5, and 7 in the sizes column. Then, from left to right, locate the color white. Beginning with the 
lowest size, 5 narrow, follow this row to the column titled white, click in this corresponding grid 
field and enter the quantity on hand. Continue thru all the sizes in stock. 

How do I track manual changes to inventory receive history? 

How do I track manual changes to existing receive history quantities in inventory? 

WinPOS© will log manual changes to existing inventory receive history when a specific setting 
is entered within the TPSWIN.INI file. 

Add the line QOHReason=YES to the TPSWIN.INI file in the Application section of the INI file. 
 Example: 
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[Application] 

DataPath=C:\TPSWINS\LIVEDATA\ 

StationName=%USERNAME 

QOHReason=YES 

With this setting WinPOS© will then prompt for a SA ID and a reason each time the QOH is 
changed directly via the Receive History or Stores QOH form. 

To review the log entries for manual changes, visit Housekeeping->General Setup->Log. 

WinPOS Maintenance 

How do I backup WinPOS? 
 

Overview 

The most important job of working with a computer is to back-up it's data on a daily basis. 
Computers are mechanical and thus can break ANYTIME! This is usually not a problem 
because they can be repaired quickly and easily. However, a breakdown can cause data loss. 
Data CANNOT be replaced quickly and easily. For this reason you must BACKUP the data on 
the computer every day.  

Computers can be equipped with TAPE drives that will quickly back the data to a TAPE 
cartridge. This the preferred method of backing up since it's fast and requires almost no 
involvement from an operator. You can also back up to CD-ROM, zip drive, or other removable 
media. 

The proper routine is to have a separate TAPE cartridge (or CD, zip disk, etc.) for each day of 
the week that you are open. Then every day back-up to that day’s cartridge, i.e.: every Monday 
backup to the Monday cartridge, Tuesday to Tuesday cartridge ..etc. Place the cartridges in a 
safe place like a fireproof safe or take them home. This method provides plenty of protection 
and security. 

If you don’t know how to get your backup set up, contact a computer consultant or computer 
store.  

Consider this: If you hard drive fails and you have no backup, you now have no record of who 
paid you money, who still owes you money, what gowns you need to special order, what you 
have in inventory, etc. 

Most people experience a computer failure of some sort at one time or another. The difference 
between an inconvenience and a disaster is whether or not you have a good backup! 
 

What to BACK-UP 

The WinPOS® data to back up is in it's data folder. (you can see the data location by visiting the 
Main Switchboard -> Housekeeping-> System Maintenance-> Program Status form - bottom left 
corner). This folder’s contents should be copied to media that can be stored in a safe place like 
a safe or taken off site. 

It is a good idea to maintain multiple backups of the data. The media should be placed in a 
fireproof safe or taken off-site.   A suggestion is to keep 7 days of data on 7 different media. 
 Label the media Sunday thru Saturday.  Each Monday overwrite the data on the Monday 
media, Tuesday on Tuesday media ..etc.  That way you always have 7 opportunities to restore 
good data. 
 

Our Tools 
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WinPOS® has a tool to help make the backup of data easier. Under the Header menu of the 
main switchboard un Tools there is a selection called Backup. This will auto copy the contents 
of the WinPOS data folder by creating a compressed ZIP file (default name BACKUP.ZIP) and 
place it in any folder, the default being the FOLDER PATH entered in Housekeeping->General 
Set up->System/Store Set up->Other Settings Tab. 

This single file will contain all the data files that required by WinPOS®. It does not contain the 
program files as they can be easily reinstalled. The file should be copied to a CD or Flash drive 
or Off-Site and placed in a fire proof safe. 

BACKUP.ZIP is a ZIPPED file (ZIPPED is a termed used to describe files that have been 
compressed and stored together in a single file). Any zip program, like WinZip, is able to 
unzip/restore the files to their normal state and would be used to gain access to the data files 
within BACKUP.ZIP file.  Backup.zip should be copied to another media like a CDRW for safe 
keeping.  
 

REMEMBER: Do not take chances with your shop’s precious customer 
and inventory information. Back up your system EVERY DAY! 

Off-Site Backup 

Located on the File menu, On-Line Backup option. 

WinPOS includes a specialized off-site backup option that backs up your data to secure servers 
at BBL Systems, keeping it safe from any disaster that could occur at your shop.  This is an 
optional feature. 

Learn more about this valuable service at http://www.bblsystems.com/backup.htm 

When is it safe to purge my files? 

Most stores purge every 15 months of business. 

Using Upgrades 

What is a upgrade? The WinPOS® program itself is rather large (28 megabytes or so.) When it 
is updated.  It can be updated to a new version in one of two methods.   

1 . Entire Program: we may send you a new copy of the entire program, called TW.EXE.  

2.  Patch file: A upgrade patch is a small file that tells WinPOS® how to convert itself from one 
version to another. Rather than sending you a CD containing the new version of the program, 
we just send you a upgrade file. Updates can be used for minor update, i.e. 7.1 to 7.2.  You 
cannot use a update to go up a major upgrade, i.e. 7.1 to 8.0. 

An analogy: You’ve just purchased a book. It turns out that the publisher misprinted a couple of 
words in the book. Rather than sending you an entire new book (which is big), the publisher just 
sends you an addendum, which you can use to correct your book. The addendum to similar to a 
upgrade file. 

All users that are covered under warranty or a service agreement can update themselves as 
often as they like. BBL posts updates to the BBL website as they become available. It is: 
http://www.bblsystems.com . 
 

Updating WinPOS® takes 4 steps: 

1. Make a complete backup of your data and program folders in case you  must roll back 
to the current version of the program and data. 
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2. Identify your current version of WinPOS© and your service expiration date.  A service 
expiration date prior to the  current system date cannot be applied and will render the 
system useless.  

3. Download the correct upgrade.  

4. Store it in the appropriate location. 

5. Start WinPOS© on only the server and allow it to perform any file updates prior to 
starting any other workstation.  Once the server has completed, start each workstation 
in sequence, waiting for it to display the main menu before starting the next. 
 Workstations should NOT have to update files if the update was performed properly on 
the server. 

Updating WinPOS via a TW.EXE file: 

1.  Start WinPOS®.  

2.  Click on the "Help" menu and choose "WinPOS®...".  

3.  The version number will appear as “Ver XX.YY.ZZ” 

4.  Go to www.bblsystems.com and locate the WinBPS/WinTPS Upgrades from the 
Downloads menu.  

5.  Locate your version in the Upgrades table. Click on the link  to download the TW.EXE file.  

6.  If you are using Internet Explorer, choose "Save this program to disk" and click the "OK" 
button.  

7.  Save the file.  It may be saved  directly into the workstation directory on your server 
computer.   This could be in several folders depending on how and which operating system it 
was originally installed on.  It also depends whether WinPOS was installed into the standard 
locations via the installation process.  If the user accepted the defaults the possible locations 
are: 

The original installation folder prior to version 3 to version 7 for Win95/98, Win2000, XP and 
is  \TPSWINW\ 

The original installation folder for version 8 on Vista is  \PROGRAM 
FILES\PROFITSYSTEM\ 

8.  When the download is complete, close your web browser.  

9.  Make sure all workstations are out of WinPOS®.  

10. Start WinPOS® on one computer only.  

11. You may see a dialog indicating that your data needs to be updated. Make sure no other 
users are trying to use WinPOS®. Click Yes. Once it finishes processing, restart WinPOS® 
on this computer. 

12. Click on the "Help" menu and choose "About WinBPS™ / WinTPOS™...". Confirm that 
you are now running the new version. 

13. With a Peer to Peer PC network LAN the TW.EXE file must be copied from the server to 
each workstation folder on each computer.  Perform this manual copy on each workstation 
computer in the LAN placing the TW.EXE file into the appropriate WinPOS workstation folder 
for each. 

14. Start WinPOS® on the other computers. The operator should NOT l see the same dialog 
as indicated in step 11. Contact BBL support if this message appears and answer 
NO/CANCEL to the continue prompt. 

Note: 
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WinPOS© can be updated on on Peer to Peer LAN by placing a new TW.EXE (WinPOS© 
program file)in the \PATCHES folder on the server.  As each workstation starts it will detect 
the new version and install it on the workstation automatically.   

If the TW.EXE is zipped up in a file named xxxTWEXE.ZIP. where xxx is the version number 
(such as 714TWEXE.ZIP for version 7.14) then the zipped file can be placed in the patches 
folder and the update will work as well. 

Each time a workstation in a peer to peer network will look in the patches folder and use a 
tw.exe or tw zip file and the workstation will look there & update itself. 

 

Updating WinPOS via a Patch file: 

1.  Start WinPOS®.  

2.  Click on the "Help" menu and choose "WinPOS®...".  

3.  The version number will appear as “Ver 7.x.x” 

4.  Go to www.bblsystems.com and locate the WinBPS/WinTPS© Upgrades from the 
Downloads menu.  

5.  Locate your version in the Upgrades table. Click on the link “Update xxx to xxx” to 
download the upgrade file.  

6.  If you are using Internet Explorer, choose "Save this program to disk" and click the "OK" 
button.  

7.  Save the file directly into the PATCHES directory on your server computer.   This could 
be in several folders depending on how and which operating system it was originally 
installed on.  It also depends whether WinPOS was installed into the standard locations via 
the installation process which may be modified by the user.  If the user accepted the defaults 
the locations are: 

The original installation folder on Win 95/98, Win2000, XP & Vista  for version 3 to 7 is 
\TPSWINS\PATCHES 

The original installation folder on Vista for version 8 and after is 
 \PROGRAMDATA\PROFITSYSTEM\PATCHES 

Note: You should  leave the update files in the patch file.  You may need them again if you 
have to re-install the WinPOS© software form the original CD.  WinPOS will self update from 
the patches it finds there.  The patch file may be in the format of xxxTWEXE.ZIP  (This is a 
compressed file and the xxx will equal the version number) 

8.  When the download is complete, close your web browser.  

9.  Make sure all workstations are out of WinPOS®.  

10. Start WinPOS® on one computer only.  

11. A dialog will appear indicating a new version is available. Click the Update button. 

12. The upgrade utility will update your WinPOS® program file and exit automatically. Wait 
until the upgrade utility window closes. 

13. Start WinPOS® on the same computer.  

14. You may see a dialog indicating that your data needs to be updated. Make sure no other 
users are trying to use WinPOS®. Click Yes. Once it finishes processing, restart WinPOS® 
on this computer. 

15. Click on the "Help" menu and choose "About WinBPS™ / WinTPOS™...". Confirm that 
you are now running the new version. 
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16. You can start WinPOS® on the other computers. You’ll see the same dialog as indicated 
in step 11. Click Update for each one. 

 

That’s it. All the computers will now be running the new version of WinPOS®. 

Anti Virus Software 

 

BBL recommends that a virus protection program is install and running on each computer in a 
shop, particularly when the computers have access to the internet and/or email..  Use popular 
programs like Norton AV © , MacAfee AV© or many others & keep the Virus definition files 
updated so the software  can protect against the latest threats. 

Anti-Virus software should not monitor the TW.EXE file (usually found in \TPSWINW\ folder of 
each workstation) which is the main program file of WinPOS©.  Monitoring of this file will slow 
it’s execution down significantly.  Each AV program has setup options to EXCLUDE specific files 
from monitoring.  When you have trouble setting this up just contact the AV software 
manufacturer for instructions.   Insure the TW.EXE file is excluded.  

Network Troubleshooting 

 

Network problems will result in intermittent unexplained system errors that may corrupt data and 
make WinPOS© un-useable. 

WinPOS© requires a minimum of 100mb Ethernet LAN speed. in computer Peer to Peer 
configurations.  Wireless networks are not fast enough or reliable enough for proper WinPOS© 
operation in Peer to Peer topologies.  Other types of configurations or NON Peer to Peer setups 
may support other network configurations, like terminal services or 'thin client' computing. 

Please follow the this checklist when trouble shooting a Local Area Network (LAN): 

1) Check/test your hard disk to see if it is operating properly before trouble shooting the LAN 
network.  You can purchase hard disk diagnostic programs (when you hardware vendor 
does not supply them) to test for problems. 

2) Copy a large file from (500mb+) from one folder to another (not on server) from a client PC 
(not server where file is located) If the system fails continue Network trouble shooting.  Test 
changes to cables/cards with this large file transfer test. 

3) Wireless networks will not work satisfactorily with peer to peer 

4) Check cable for proper type.  Insure it is rated for 100mb/Gigabit Ethernet speed 

5) Check cable lengths from switch (cannot exceed 100 meters) 

6) Check location of cables, insure they are not close to items that will cause electrical 
interference like electrical motors for heat/ac equipment and the like. 

7) Check Switch/Hub to make sure it is 100mb/Gigabit rated 

8) Check network cards for proper operation (best method is to swap card for brand new one) 

 

Ethernet Overview 

There are two kinds of network technologies: 

• Wireless - communicates through radio waves  

• Wired - communicates through data cables (most commonly called Ethernet-based) 
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Why choose a wireless network?  

Wireless networks don't use cables for connections, but rather they use radio waves, like 
cordless phones. The advantage of a wireless network is the mobility and freedom from the 
restriction of wires or a fixed connection. The benefits of having a wireless network include:  

• Mobility and freedom - work anywhere  

• No restriction of wires or a fixed connection  

• Quick, effortless installation  

• No cables to buy  

• Save cabling time and hassle  

• Easy to expand  

Also known as Wi-Fi, or Wireless Fidelity, wireless networks allow you to use your network 
devices anywhere in an office or home. There is no need to drill holes in the wall and install 
Ethernet cables. You can network anywhere - without wires.  The downside of a Wi-Fi network 
is A) speed (they are slower than wired) B)  reliability (more susceptible to interference & 
distance) and security (hackers could gain access to your network) 

 

 Why choose a wired network?  

Wired networks have been around for decades and are the most secure and reliable. Wired 
networking technology found today is known as Ethernet. The data cables, known as Ethernet 
network cables or wired (CAT5) cables, connect computers and other devices that make up the 
networks. Wired networks are best when you need to move large amounts of data at high 
speeds, such as WinPOS©.  

The benefits of having a wired network include:  

• Relatively low cost  

• Fastest - offers the highest performance possible  

• Most Reliable 

• No Distance limitations with repeaters 

• Faster speed - up to 1000Mbps (gigabit)  

 

Common Network Rules 

Building a network involves abiding by specific topology rules.  These rules specify distance 
limitations and cabling specifications. Data loss, collisions, and other network problems causing 
down time are likely to occur if the rules below are not followed. 

1. Use UTP Category 5e (or better) Ethernet cabling with four pairs of wires and RJ-45 
tips for all Fast Ethernet connections. 

2. Always use a 100/1000 mega/giga bit SWITCH.  A Switch acts as a repeater, 
regenerating data signals before passing them on to the next device.  Switches also 
feature full-duplex data transfer, meaning that all computers on the switch can 
communicate to the switch at the same time. Plus, switches can send and receive 
data simultaneously to all connections. 

3. A cable length from the Switch to the PC/Terminal should not exceed 100 meters 
(328 feet)  

4. Cables should not be placed near any equipment hat generates any type of 
electrical interference, i.e. motors, air/heater conditioner fan, light fixtures ..etc.  This 
interference will cause problems. 
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Events/Customers 

How do I enter a wedding party? 

If this is a new prospect, and isn’t sure if she’s going to purchase, create a prospect for the 
bride. 

If this is a new bride who is ready to set up her wedding, go to Main->View/Change Event, and 
click Add. You’ll be prompted for her phone number, so WinPOS® can check if she’s already on 
file. If she is not on file, you’ll be taken to the Members Tab of the Event form, where you can 
enter her information, her bridesmaids, etc. 

You’ll want to enter each of her bridesmaids in even if she’s not sure of their names yet. Use 
MAID TBA, or something similar. 

How do I enter a prom event? 

Go to Main->View/Change Event and click the Add button. Use the schools name plus the prom 
name/year for the event name. Members will be the students who come to register.  You can 
even track/register the styles sold so the system will warn when multiple like styles and colors 
are being sold to the same event.. 

How do I add members to an event? 

Go to Main->View/Change Event->Members Tab. 

Enter the new member in the first blank entry in the member list. 

How do I sell anything to an event member? 

Go to Main->View/Change Event->Members Tab for the event in question. Select the member 
in the member list. Click Go to Ticket and select the ticket for this event. Sell the item on this 
ticket. If they don’t have any tickets, click Create New Ticket and sell the item. 

It’s important to make sure the ticket you use is attached to the event. You can confirm this by 
making sure the correct event is shown at the top of the ticket. 

How do I sell anything to a single customer? 

If you don’t want to capture the customers name, address, etc.  

1. Go to Main->Sale 

2. Click the Quick Sale button 

3. Enter the sale on the ticket. The ticket will be sold to the Walk-In customer. 
 

If you do want to save the customers contact information for recall, follow-up, mailings, etc. 

1. Go to Main->View/Change Customer 

2. Click Add and create a new customer card.  

3. Click the New Sale button on the Customer tab. 

4. Enter the sale on the ticket. 
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Accounting Integration 

Accounting Integration Overview 
 

The WinPOS® Accounting Integration is a series of integrated program functions that allow 
WinPOS® to export portions of its data to outside accounting programs.   It is important to note 
that WinPOS is a front end to other accounting programs TWO specific features, 1)  Invoice 
exporting  2) Revenue Report exporting. 

Currently the supported accounting programs with WinPOS® are Peachtree Accounting for 
Windows and QuickBooks Pro 2004/2005/2006/2007, However, other accounting programs, 
which offer IMPORT capabilities may be able to work with WinPOS® with little or no 
modification.  Contact BBL Tech Support for questions. 

Two accounting functions are integrated.  First,  Accounts Payable invoice data from the 
WinPOS® Purchase Order module and second, Daily Revenue Report details that insert into 
the accounting General Ledger. 

For Peachtree and older QuickBooks versions like 2004 (and older), WinPOS creates two 
export ASCII text files which contain the invoice details and general ledger entries respectively. 
 These files are manually imported into Peachtree and QuickBooks using functions built into 
those programs.   

WinPOS communicates directly to the QuickBooks 2005 & newer via a utility program 
(ACTIVEX) provided by the Quickbook's manufacturer and installed on the computer that 
Quickbooks was installed upon during the Quickbooks installation process.  These versions of 
Quickbooks allows WinPOS to automatically insert the transactions in the correct locations.   

Note:   

Quickbooks 2005 & newer must be installed on the same PC as WinPOS© for accounting 
data to be successfully inserted (exported).  This is a specific Quickbook's requirement. 

WinPOS® does not require both accounting export functions be used. For example a user may 
wish to only utilize the Invoice export functions for Accounts Payable, but not the General 
Ledger export functions. This is accepted, However, please remember all the GL Account 
Numbers must be entered in the WinPOS® accounting setup regardless. See the section 
“Entering General Ledger Account numbers” for more details. 

As with any accounting endeavor, it is suggested that the user have a good understanding of 
basic accounting principles. If not, please ask for help from a CPA. Also, you must set up your 
company in your accounting program before proceeding with the WinPOS® accounting 
integration setup. Consult you accounting program’s manual or your CPA for assistance. 

Important Note: 

WinPOS® utilizes WinPOS Account Numbers/Names for the posting of information to our 
internal ledger file. This file is created by entering transactions onto Sales Tickets and used 
by the Revenue Report to compute totals for the report. Do NOT confuse the WinPOS® 
account numbers with the General Ledger account numbers of your accounting software. 
They ARE NOT the same thing & do not have to match!  BBL recommends that the 
WinPOS® account numbers are NOT MODIFIED. Modifying the WinPOS® account 
numbers/names can cause the totals on the Revenue report to become incorrect. Correcting 
a WinPOS® account modification is a billable service offered by BBL. 

The integration of WinPOS® with an accounting software package is accomplished by entering 
the GL Account Numbers of the accounting software within the the WinPOS® export fields 
described. Please refer to the Integration Set-up topic for more detail. 
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Integration Set-Up 

The accounting system (Peachtree, QuickBooks 2001, or QuickBooks Pro 2005 & newer)   

The accounting package utilized must be operational with your company’s chart of accounts. A 
CPA or trained bookkeeper can help in setting up the accounting package with your company’s 
chart of accounts (known as General Ledger Account numbers).  

Next, the appropriate GL Account names from the Accounting software will be entered within 
the proper places within WinPOS®. There are three forms that contain set-up information for 
accounting integration, of which two are locations where GL account numbers must be entered 
for export.  

Note 

There are two types of account names/numbers.   

First, WinPOS account names/numbers.  These are used internally by WinPOS.  A store 
may create additional WinPOS account names/numbers via the Chart of Accounts form to 
add additional detail to the included basic WinPOS setup (please contact BBL Tech support 
for some direction), but it is highly recommend that the existing WinPOS account 
names/numbers are NOT modified. 

Second, Accounting Package general ledger account names/numbers.  These are inserted 
into WinPOS in very specific field locations.  Most of the accounting fields within WinPOS 
requires WinPOS account names/numbers.  The forms that contain entries for Accounting 
Package general ledger account names/numbers is detailed next in this topic. 

 

Accounting Package general ledger account names/numbers WinPOS locations 

1) Main->Housekeeping ->Accounting Setup->Accounting Setup->Setup tab, Accounting 
Integration Accounts Section  

Shipping/Freight and Payables.  Both require the entry of your accounting software GL 
account number and are used for Accounts Payable integration. 

2) Main->Housekeeping ->Accounting Setup->Accounting Setup-> Chart of Accounts.   

Export GL number/name field contains the corresponding GL account number found within 
your Accounting Package general ledger chart of accounts. 

All other account WinPOS names/code references are internal WinPOS accounts. 

Your Accounting GL account numbers entered are not validated by WinPOS® against your 
accounting software package EXCEPT for QuickBooks Pro 2005 (or later), so double check the 
entries to protect against typos. However, the accounting program will validate the numbers 
during its own IMPORT routine and any incorrect account numbers will cause a error situation. 
The GL account numbers entered in WinPOS® must precisely match those 
numbers/descriptions set up in the accounting program. 

 

WinPOS account names/numbers locations 

1) Main->Housekeeping ->Accounting Setup->Accounting Setup-> Chart of Accounts.   

2) Main->Housekeeping ->Accounting Setup->Accounting Setup->Setup tab, Accounting 
Integration Accounts Section  
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3) Main->Housekeeping ->Accounting Setup->Accounting Setup-> Accounting Classes 

 
QuickBooks Pro 2005 & newer notes:  You will be using a pick list to select the account 
names, vendors, terms, etc. instead of entering them directly.  The pick list is displayed by 
clicking the binoculars lookup button next to the field in WinPOS.  This pick list is read from the 
QuickBooks data file. This document refers to General Ledger Account numbers, GL account 
number, or export GL number  in the accounting program.  For QuickBooks Pro 2005 the actual 
account names are used.  QuickBooks Pro 2005 requires you to give authorization to WinPOS 
so it can access the company file.  When setting up the accounting integration with QuickBooks 
Pro 2005, make sure QuickBooks is running and the correct company file is loaded. 
 QuickBooks will display a message indicating that WinPOS is trying to access the company file 
the first time a pick list is accessed from WinPOS.  We recommend selecting "Yes, always; 
allow access even if QuickBooks is not running"  This will allow exports to occur without having 
to start QuickBooks and load the company file first.  The account names, vendors, and terms 
must be set up in QuickBooks before attempting to configure WinPOS, since the pick lists in 
WinPOS come directly from the data in QuickBooks. 

1) General Ledger Account Set-Up 

General Ledger Account numbers must be entered on the GL Account Setup form 
(ACCTSETP), located at Main->Housekeeping->Accounting Setup->Accounting Setup-
>Setup tab, Accounting Integration Accounts Section. 

Accounting Integration Accounts Section 

Program…Select the accounting package you are integrating with from the drop down list. 
Quickbooks 2001 is selected for all versions of QuickBooks prior to 2005, and for 
QuickBooks Standard 2005.  QuickBooks 2005 is only selected for QuickBooks Pro version, 
2005 or later. 

Shipping…Select/enter accounting package’s GL account description/number for shipping 
charges.  For QuickBooks Pro 2005, select Sales: Shipping and Handling.  The 
Shipping/Freight account is used for non-merchandise or freight charges on orders shipped 
from vendors to the shop.  The account # is used as the default for the Shipping account 
when Invoice details are entered during the order receive process. 

Payables…Select/enter accounting package’s GL account description/number for payables. 
For QuickBooks Pro 2005, select Accounts Payable.  In Quickbooks 2005, the PAYABLES 
account in Quickbooks  is used for the merchandise total.  This account is used as the 
default. 

Revenue report out of balance…Enter accounting package’s GL account 
description/number for variances on the WinPOS revenue report. The WinPOS out of 
balance account must have an export account selected on the Chart of Accounts form.   If 
there is a out of balance on the WinPOS Revenue Report, a transaction using this account 
will be exported containing the out of balance amount. 

Path…The folder on the computer where the export files should be created. For AccPac, the 
directory must be C:\ASP\DATA\. For QuickBooks 2005 this option is disabled since 
WinPOS connects directly to the QuickBooks data file. 

QB file…Using the lookup button, select the company file for QuickBooks Pro 2005 or 
greater.   

Tax Agency... should be filled in with the name of your tax agency as it appears in 
Quickbooks 2005 or greater.  This is only necessary if you must normally select a tax agency 
when manually entering tax postings into Quickbooks. 

QB Region... is set to CA for Canadian customers, US otherwise for Quickbooks 2005 or 
greater. 

Flip sign on QB deposits?... should be checked for Quickbooks 2005 or later.  Partial 
payments exported to Quickbooks are positive for inflows (partial payments made) and 
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negative for outflows (partial payments released)  With this option checked, inflows are 
negative and outflows are positive, which is what Quickbooks 2005 expects.. 

 

2) WinPOS® Chart of Accounts Export GL account numbers 

 

Part I - Accounting Classes 

Accounting classes (Main->Housekeeping->Accounting Setup->Accounting Classes) 
are WinPOS accounting classifications that are assigned to Retail/Rental merchandise within 
the inventory maintenance module of WinPOS® that indicate how to post transactions. 
  WinPOS includes a default set of accounting classes and automatically creates a new one 
each time an Inventory Category is created by a user.  A new accounting class is created to 
match the category and places it upon the WinPOS revenue accounting report (Main-
>Housekeeping->Accounting Setup->Revenue Report Setup (REVRSETP).  This 
provides an opportunity for the store to see a detail accounting breakdown of revenue and 
costs.   

NOTE 

For accounting integration purposes, how  the revenue and cost  totals are exported is 
controlled by how the user assigns the accounting GL names/codes to the WinPOS 
accounts within the chart of accounts. ( Main->Housekeeping->Accounting Setup-
>Chart of Accounts (COASETUP)).  For example, multiple WinPOS accounts may be 
totalled to a single Accounting software GL account. 

Accounting classes are assigned WinPOS account number/names from the WinPOS Chart 
of Accounts form.  These WinPOS account names/numbers translate into your Accounting 
software GL account number/names (see part II below).  Verify that a inventory, cost of sale 
and purchase WinPOS® account number is assigned to each accounting class. 

The sales & purchase WinPOS® account numbers are entered on the Accounting Class 
form (ACCTCLAS), located at Main->Housekeeping->Accounting Setup->Accounting 
Classes. 

Fields 

Purchase... Used in the accounts payable interface. 

Inventory... Used with the General Ledger interface, accumulated when sales revenue is 
realized. 

Cost of Sales... Used with the General Ledger interface, accumulated when sales revenue 
is realized. 

Please refer to the Accounting class topic for information on the other fields contained within 
the Accounting Class form 

 

Example Postings When an invoice is received 

 

Acct Payable Export 

The PURCHASE WinPOS account code is utilized for accounts Payable. This is the invoice 
balance due for the merchandise received and an account number could be set to identify the 
type of inventory merchandise being purchased.   

Merchandise 

Purchase....$1000 
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A/P is a hidden field & no configuration is needed for 2005 Quickbooks & newer.  The Purchase 
amount will automatically be posted to the Quickbook's AP account.  For all other versions the 
AP account must be set in Step 1 above. 

A/P... $1000 

 

Freight/Shipping 

The Shipping WinPOS account is set in Main->Housekeeping->Accounting Setup-
>Accounting Setup->Setup tab, Accounting Integration Accounts Section, Step 1 above. 

Shipping:.. $50 

A/P (hidden field no configuration for newer Quickbooks, for other accounting it is set in Main-
>Housekeeping->Accounting Setup->Accounting Setup->Setup tab, Step 1 above)  

A/P...  $50 

 

Example postings when an inventory item is sold on a sales ticket the GL postings would use 

SALES 

Inventory...  Posts to the Inventory account in the accounting software. 

Cost of Sales... Posts to the Cost of Sales account in the accounting software. 

 

<< Flow Diagram >> 

 

Part II - WinPOS Chart of Accounts 

Each WinPOS© account number must have assigned a valid GL account number of the 
accounting package utilized. Export GL numbers must be entered on the COA Setup form 
(COASETUP), located at Main->Housekeeping->Accounting Setup->Chart of Accounts. 
WinPOS© converts the WinPOS© account number to your accounting package’s General 
Ledger Account number when exported. 

Leave the GL export number blank for all WinPOS® accounts that do not need to be 
exported to the accounting software.  

Peachtree & QuickBooks 2001: Occasionally the accounting software used expects the 
sign of the amount exported to be the opposite of what WinPOS© provides. For each Export 
GL account number entered you can choose whether or not to flip the sign on the dollar 
amount when it is exported. When checked, WinPOS© will change the sign automatically at 
export time. This option should be checked for revenue and tax GL account numbers when 
exporting to PeachTree  and QuickBooks 2001. If you are using an accounting package that 
is not supported directly, you may need to check this option for other accounts. 

QuickBooks Pro 2005 or newer notes: The Flip Sign option is disabled for QuickBooks 
Pro 2005 integration.  WinPOS automatically flips the sign for revenue and tax when posted.  
Also, WinPOS© maintains a customer deposits account which holds monies paid towards 
sales where the revenue has not yet been realized when TICKET ZERO or PICKUP revenue 
triggers are selected in WinPOS.  This same WinPOS© Account/Name is also used when in 
the Accounts Receivable revenue trigger mode.  The description of the account could be 
changed to "Accounts Receivable" and the description will display on the Revenue Report. 
 An corresponding account must be created in QuickBooks Pro 2005 to hold these monies.  
For example with deposits, create a new account of Other Current Liability and call it Partial 
Payments.  Select this account for the Export GL account on the Deposits account in 
WinPOS. 
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Note: 

The WinPOS© Revenue Report when ran, will locate this Export GL number in the 
WinPOS© chart of accounts for each line item on the report. WinPOS© creates an export 
entry with the export GL number and total dollar amount for the date the revenue report is 
ran when this export GL number is present.  During the export process WinPOS© will 
display a warning if line items on the revenue report do not have associated GL export 
accounts, but the export will continue.  Any errors or omissions must be manually corrected. 

A revenue report may be re-ran for a business day.  When done and the day HAS NOT bee 
previously exported, the report will update the "to be" exported totals.  This provides an 
opportunity for the operator to identify and correct any numbers.  Only export once the 
Revenue report totals are acceptable. 

 

3) Vendors 

Accounting Integration fields 

Terms:  This is the discount computation formula for accounts payable invoicing when 
receiving merchandise from a particular vendor.  Terms are set for each vendor. 

Days & Discount %:  Used with Peachtree accounting integration, whereby WinPOS will 
compute a discount amount for an invoice and pass that to Peachtree. 

Export Vendor number:  This is the vendor (payee) of the invoice being received.  This code 
is passed to the accounting software and MUST match a the accounting package vendor 
code.  

To utilize the INVOICE Export functions, each WinPOS© vendor must have and export 
vendor number, terms, and discount percentages entered. The vendor terms are entered on 
the Vendor form (VENDOR), located at Main->Housekeeping->Inventory Set-Up-
>Vendors (VENDOR.) The possible terms are displayed in this legend:  The export vendor 
number will default to the WinPOS© vendor number. 

 

Notes 

QuickBooks 2001 notes: The terms are not required for use with the QuickBooks 2001 
integration, since QuickBooks 2001 does not support the export of a discount amount on the 
invoice. 

QuickBooks Pro 2005 & newer notes: The terms are selected directly from the 
QuickBooks company file using a pick list, available via WinPOS lookup..  Also the Export 
vendor number is selected using a pick list, from the vendors defined in QuickBooks. 

Peachtree and QuickBooks 2001: For each vendor, enter a discount percentage and the 
terms the vendor allows.  

0 = Cash Account 

1 = COD 

2 = Net Due Now 

3 = X% 10 Days, Net End Of Month (where X = the discount percentage entered in the 
“Disc.” Field) 

4 = Net 10 Days End Of Month 

5 = Net Due 30 Days 

6 = X% Net Due 30 Days (where X = the discount percentage entered in the “Disc.” Field) 

7 = X% 10 Days, Net Due 30 Days (where X = the discount percentage entered in the “Disc.” 
Field) 

8 = X% 20 Days, Net Due 30 Days (where X = the discount percentage entered in the “Disc.” 
Field) 
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9 = Custom Terms. Enter the discount percentage and the number of days manually 

Note:  

GL account numbers and Vendor terms are assigned to transactions the moment 
transactions are created within WinPOS®. Any changes made to GL account numbers will 
only affect transactions entered AFTER the changes are entered. 

 

Quickbooks Integration 

QuickBooks Setup 

  

This accounting integration is compatible with QuickBooks 2001 &  QuickBooks Pro 2005 or 
newer   

The version utilized must be operational and have your  company’s chart of accounts created. A 
CPA or trained bookkeeper can help in setting up the accounting package with your company’s 
chart of accounts (known as General Ledger Account numbers).  

Next, the appropriate GL Account names or numbers will be entered within the proper places 
within WinPOS®. There are three forms that contain set-up information for accounting 
integration, of which two are locations where your GL account numbers must be entered for 
export.  

1) Main->Housekeeping ->Accounting Setup->Accounting Setup->Setup tab, Accounting 
Integration Accounts Section  

2) Main->Housekeeping->Accounting Setup->Accounting Classes 

3) Main->Housekeeping->Inventory Set-up->Vendors, Accounting Integration section 

Your Accounting GL account numbers entered for older versions of Quickbooks (prior to 2005) 
are not validated by WinPOS® when being entered so great care must be taken to insure the 
GL accounts are correct.  However, even with the older Quickbook versions the accounting 
program will validate the numbers during its own IMPORT routine and any incorrect account 
numbers will cause a error situation. The GL account numbers entered in WinPOS® must 
precisely match those numbers/descriptions set up in the accounting program. 
QuickBooks Pro 2005 & newer notes:  You will be using a pick list to select the account 
names, vendors, terms, etc. instead of entering them directly.  The pick list is displayed by 
clicking the binoculars lookup button next to the field in WinPOS.  This pick list is read from the 
QuickBooks data file. This document refers to General Ledger Account numbers, GL account 
number, or export GL number  in the accounting program.  For QuickBooks Pro 2005 the actual 
account names are used.  QuickBooks Pro 2005 requires you to give authorization to WinPOS 
so it can access the company file.  When setting up the accounting integration with QuickBooks 
Pro 2005, make sure QuickBooks is running and the correct company file is loaded. 
 QuickBooks will display a message indicating that WinPOS is trying to access the company file 
the first time a pick list is accessed from WinPOS.  We recommend selecting "Yes, always; 
allow access even if QuickBooks is not running"  This will allow exports to occur without having 
to start QuickBooks and load the company file first.  The account names, vendors, and terms 
must be set up in QuickBooks before attempting to configure WinPOS, since the pick lists in 
WinPOS come directly from the data in QuickBooks. 

1) General Ledger Account Set-Up 

General Ledger Account numbers must be entered on the GL Account Setup form 
(ACCTSETP), located at Main->Housekeeping->Accounting Setup->Accounting Setup-
>Setup tab, Accounting Integration Accounts Section. 

 

Accounting Integration Accounts Section 
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Housekeeping-> Accounting Setup-> Accounting Setup 

Program…Select the accounting package you are integrating with from the drop down list. 
Quickbooks 2001 is selected for all versions of QuickBooks prior to 2005, and for 
QuickBooks Standard 2005.  QuickBooks 2005 is only selected for QuickBooks Pro version, 
2005 or later. 

Shipping…Select/enter accounting package’s GL account description/number for shipping 
charges.  For QuickBooks Pro 2005, select Sales: Shipping and Handling.  The 
Shipping/Freight account is used for non-merchandise or freight charges on orders shipped 
from vendors to the shop.  The account # is used as the default for the Shipping account 
when Invoice details are entered during the order receive process. 

Payables…Select/enter accounting package’s GL account description/number for payables. 
For QuickBooks Pro 2005, select Accounts Payable.  In Quickbooks 2005, the Purchase 
account is used for the merchandise total.  This account is used as the default for the 
Purchase account on the Invoice. 

Revenue report out of balance…Enter accounting package’s GL account 
description/number for variances on the WinPOS revenue report. The WinPOS out of 
balance account must have an export account selected on the Chart of Accounts form.   If 
there is a out of balance on the WinPOS Revenue Report, a transaction using this account 
will be exported containing the out of balance amount. 

Path…The folder on the computer where the export files should be created. For AccPac, the 
directory must be C:\ASP\DATA\. For QuickBooks 2005 this option is disabled since 
WinPOS connects directly to the QuickBooks data file. 

QB file…Using the lookup button, select the company file for QuickBooks Pro 2005 or 
greater.   

Tax Agency... should be filled in with the name of your tax agency as it appears in 
Quickbooks 2005 or greater.  This is only necessary if you must normally select a tax agency 
when manually entering tax postings into Quickbooks. 

QB Region... is set to CA for Canadian customers, US otherwise for Quickbooks 2005 or 
greater 

 

2) WinPOS® Chart of Accounts Export GL account numbers 

 

Part I 

Accounting classes are assigned to Retail/Rental merchandise within the inventory 
maintenance module of WinPOS®. Verify that a sales and purchase WinPOS® account 
number is assigned to each accounting class used for inventory. You may create new 
purchase & sales WinPOS® account numbers within the WinPOS® Chart of Accounts form. 

If you want to export a cost of sales transaction and its balancing inventory transaction, 
make sure you add a WinPOS account number for the inventory account via the COA Setup 
form, with an export GL number (located at Main->Housekeeping->Accounting Setup-
>Chart of Accounts (COASETUP)) and an Accounting Integration account/inventory 
account on Accounting Class form (ACCTCLAS), located at Main->Housekeeping-
>Accounting Setup->Accounting Classes.  Also make sure the cost of sales and 
inventory account number appear on the revenue report setup, located at Main-
>Housekeeping->Accounting Setup->Revenue Report Setup (REVRSETP) 

The sales & purchase WinPOS® account numbers are entered on the Accounting Class 
form (ACCTCLAS), located at Main->Housekeeping->Accounting Setup->Accounting 
Classes. 

 

Part II 
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Each WinPOS© account number must have assigned a valid GL account number of the 
accounting package utilized. Export GL numbers must be entered on the COA Setup form 
(COASETUP), located at Main->Housekeeping->Accounting Setup->Chart of Accounts. 
WinPOS© converts the WinPOS© account number to your accounting package’s General 
Ledger Account number when exported. 

Leave the GL export number blank for all WinPOS® accounts that do not need to be 
exported to the accounting software.  

QuickBooks 2001: Occasionally the accounting software used expects the sign of the 
amount exported to be the opposite of what WinPOS© provides. For each Export GL 
account number entered you can choose whether or not to flip the sign on the dollar amount 
when it is exported. When checked, WinPOS© will change the sign automatically at export 
time. This option should be checked for revenue and tax GL account numbers when 
exporting to PeachTree  and QuickBooks 2001. If you are using an accounting package that 
is not supported directly, you may need to check this option for other accounts. 

QuickBooks Pro 2005 or newer notes: The Flip Sign option is disabled for QuickBooks 
Pro 2005 integration.  WinPOS automatically flips the sign for revenue and tax GL accounts.  
Also, WinPOS© maintains a customer deposits account which holds monies paid towards 
sales where the revenue has not yet been realized when TICKET ZERO or PICKUP revenue 
triggers are selected in WinPOS.  This same WinPOS© Account/Name is also used when in 
the Accounts Receivable revenue trigger mode.  The description of the account could be 
changed to "Accounts Receivable" and the description will display on the Revenue Report. 
 An corresponding account must be created in QuickBooks Pro 2005 to hold these monies.  
For example with deposits, create a new account of Other Current Liability and call it Partial 
Payments.  Select this account for the Export GL account on the Deposits account in 
WinPOS. 

Note: 

The WinPOS© Revenue Report when ran, will locate this Export GL number in the 
WinPOS© chart of accounts for each line item on the report. WinPOS© creates an export 
entry with the export GL number and total dollar amount for the date the revenue report is 
ran when this export GL number is present.  During the export process WinPOS© will 
display a warning if line items on the revenue report do not have associated GL export 
accounts, but the export will continue.  Any errors or omissions must be manually corrected. 

 

3) Vendors 

To utilize the INVOICE Export functions, each WinPOS© vendor must have and export 
vendor number, terms, and discount percentages entered. The vendor terms are entered on 
the Vendor form (VENDOR), located at Main->Housekeeping->Inventory Set-Up-
>Vendors (VENDOR.) The possible terms are displayed in this legend:  The export vendor 
number will default to the WinPOS© vendor number. 

QuickBooks 2001 notes: The terms are not required for use with the QuickBooks 2001 
integration, since QuickBooks 2001 does not support the export of a discount amount on the 
invoice. 

QuickBooks Pro 2005 & newer notes: The terms are selected directly from the 
QuickBooks company file using a pick list.  Also the export vendor number is selected using 
a pick list, from the vendors defined in QuickBooks. 

QuickBooks 2001: For each vendor, enter a discount percentage and the terms the vendor 
allows.  

0 = Cash Account 

1 = COD 

2 = Net Due Now 
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3 = X% 10 Days, Net End Of Month (where X = the discount percentage entered in the 
“Disc.” Field) 

4 = Net 10 Days End Of Month 

5 = Net Due 30 Days 

6 = X% Net Due 30 Days (where X = the discount percentage entered in the “Disc.” Field) 

7 = X% 10 Days, Net Due 30 Days (where X = the discount percentage entered in the “Disc.” 
Field) 

8 = X% 20 Days, Net Due 30 Days (where X = the discount percentage entered in the “Disc.” 
Field) 

9 = Custom Terms. Enter the discount percentage and the number of days manually 

Note:  

GL account numbers and Vendor terms are assigned to transactions the moment 
transactions are created within WinPOS®. Any changes made to GL account numbers will 
only affect transactions entered AFTER the changes are entered. 

Note:  

Throughout the remainder of this manual, we will make reference to creating “import 
templates” in your accounting program. Refer to your accounting program’s manual, their 
technical support line, or your CPA for instructions on creating these templates. 

Quickbooks Accounts Payable & Invoicing 

 

Invoice details for exporting to the Account Payable module of the accounting software are 
created when Purchase Order items are received into WinPOS®.  

When receiving a PO item, WinPOS® will display the Invoice detail screen automatically and 
complete most of the data fields itself. The data which must entered is the total merchandise 
amount for the entire invoice (not just the one item that is being received) and the non-discount 
amount (if any, i.e.: freight charges). WinPOS® will automatically calculate discount amounts 
and due dates based on the vendor terms and discount percentage previously entered for each 
vendor. 

If you need to edit an existing, UN-EXPORTED invoice, you may do so through the Invoice form 
(INVOICE), located at Main->Housekeeping->Accounting Integration->Invoices.  

Invoice exporting procedures  

1. Before exporting your invoices, you may wish to edit them, if necessary. As mentioned 
above, you may edit an existing invoice, provided you have not already exported it. You may 
do this on the Invoice form (INVOICE.) 
 
Here you may make changes to an existing invoice or add an invoice from scratch by 
clicking the Add button. Invoice details may be printed using the Invoice report (RP_INV) 
located at Main->Housekeeping->Accounting Integration->Invoices Export Report. This 
report may be run for the received date period you specify. You may specify to print only 
those invoices from a specific vendor, and you may also choose to print only those invoices 
that have or have not been exported.  
 
If the invoice displayed on the screen has already been exported the export date will appear 
on the form. Remember: Exported invoices may not be edited.  

2. Once you are satisfied with the entered invoices, you are ready to EXPORT the invoices to 
your accounting program. First, go to the Export Accounting Transactions form, located at 
Main->Housekeeping->Accounting Integration->Export AP/GL. This form will first display 
the total dollar amount of ALL the invoices and all the general ledger transactions it will be 
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exporting. Many shops will reconcile this total to an audit trail before proceeding with the 
export. 

3. If satisfied check the checkbox next to the invoices total to proceed.  The exact details for 
each accounting program are shown below. 

 
QuickBooks 2001:  Next, the system will inform you if an export file already exists from a 
previous export (Note: This will not appear during your very first export). Make sure you have 
already imported the previous export file into you accounting program and answer “Yes” to 
overwrite the old file. This will create an ASCII export file. The file name will be 
PURCHASE.CSV and will be created in the folder specified in the Accounting set-up form.  
 
QuickBooks Pro 2005 & newer:  WinPOS will export one invoice for the merchandise total, 
and a separate invoice for the non-merchandise.  These invoices will be added directly to the 
company file for QuickBooks.  No other import step is required. 
 

Quickbooks General Ledger 

WinPOS® allows for its Revenue Report data to be exported to a General Ledger. Each time a 
new Revenue Report is printed, a transaction set is created for exporting. You can re-run the 
Revenue Report as many times as you like, and WinPOS® will replace the transactions IF they 
have not yet been exported. Also, WinPOS® will only create export transactions if you run the 
Revenue Report for one day, NOT if you run it for multiple days. 

The transactions are placed in an ASCII export file. For QuickBooks 2001 or earlier the file 
name will be GENERAL.CSV and will be created in the directory specified in your Accounting 
Setup.   For Quickbook 2005 and newer the export inserts the postings directly into the 
Quickbooks program with no intermediate file created. 

The export file accumulates all of the daily transactions until the user PURGEs (deletes) them. 
Purging can be done as often as a user wishes, but at least once a year. To purge, use the 
Purge Menu from within System Maintenance. 

The Revenue Report in WinPOS® has been designed to balance, like a GL debit/credit entry 
would have to. In some circumstances the report may not balance. To handle these situations 
WinPOS® will force the GL Export to balance by calculating the amount to make it balance and 
placing it in with the day’s transactions with the Over/Under GL account number specified in the 
GL Account Setup. The user will have to manually reconcile the discrepancy and place it into 
the correct GL distribution. 

General Ledger Exporting Procedures 

Before exporting the day’s GL information, you must first run a Revenue Report for the day (you 
would normally be doing this at the end of every business day anyway).  

To export the GL data, go to Export Accounting Transactions form, located at Main-
>Housekeeping->Accounting Integration->Export AP/GL. This form will first display the total 
number of general ledger transactions it will be exporting. If satisfied check the checkbox next to 
the gl transactions total to proceed. 

Peachtree Integration 

Peachtree Accounts Payable & Invoicing 

 

Invoice details for exporting to the Account Payable module of the accounting software are 
created when Purchase Order items are received into WinPOS®.  

When receiving a PO item, WinPOS® will display the Invoice detail screen automatically and 
complete most of the data fields itself. The data which must entered is the total merchandise 
amount for the entire invoice (not just the one item that is being received) and the non-discount 
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amount (if any, i.e.: freight charges). WinPOS® will automatically calculate discount amounts 
and due dates based on the vendor terms and discount percentage previously entered for each 
vendor. 

If you need to edit an existing, UN-EXPORTED invoice, you may do so through the Invoice form 
(INVOICE), located at Main->Housekeeping->Accounting Integration->Invoices.  

Invoice exporting procedures  

1. Before exporting your invoices, you may wish to edit them, if necessary. As mentioned 
above, you may edit an existing invoice, provided you have not already exported it. You may 
do this on the Invoice form (INVOICE.) 
 
Here you may make changes to an existing invoice or add an invoice from scratch by 
clicking the Add button. Invoice details may be printed using the Invoice report (RP_INV) 
located at Main->Housekeeping->Accounting Integration->Invoices Export Report. This 
report may be run for the received date period you specify. You may specify to print only 
those invoices from a specific vendor, and you may also choose to print only those invoices 
that have or have not been exported.  
 
If the invoice displayed on the screen has already been exported the export date will appear 
on the form. Remember: Exported invoices may not be edited.  

2. Once you are satisfied with the entered invoices, you are ready to EXPORT the invoices to 
your accounting program. First, go to the Export Accounting Transactions form, located at 
Main->Housekeeping->Accounting Integration->Export AP/GL. This form will first display 
the total dollar amount of ALL the invoices and all the general ledger transactions it will be 
exporting. Many shops will reconcile this total to an audit trail before proceeding with the 
export. 

3. If satisfied check the checkbox next to the invoices total to proceed.  The exact details for 
each accounting program are shown below. 

4. Start the accounting program and import the file created by WinPOS. 

 

Next, the system will inform you if an export file already exists from a previous export (Note: 
This will not appear during your very first export). Make sure you have already imported the 
previous export file into you accounting program and answer “Yes” to overwrite the old file. This 
will create an ASCII export file. For Peachtree Accounting the file name will be 
PURCHASE.CSV and will be created in the folder specified in the Accounting set-up form.  

The PURCHASE.CSV file (for Peachtree) will have the following information from left to right: 

Vendor Code 

Invoice Number 

Date Received/Entered 

Invoice Due Date 

Discount Date 

Discount Amount 

Accounts Payable GL number 

Invoice Total (non-merchandise +merchandise amount) 

Number of Distributions for this invoice 

PO Number (The number BPS generated for this purchase order 

Purchase GL for the category of the item received 
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Discountable Amount 

GL period (always 20) 

If a non-discount amount exists for an invoice, WinPOS® will create a second distribution entry 
so the proper accounting will take place.  

NOTE: This PURCHASE.CSV file may be viewed or edited with any standard text editing 
program, such as the MS-DOS / Windows program “EDIT”. 

Below is a short example of what a PURCHASE.CSV file would look like: 
 

13,88888,06/01/97,07/01/97,07/01/97,0.00,1000,95.00,2,10,300,85.00,20 

13,88888,06/01/97,07/01/97,07/01/97,0.00,1000,75.00,2,10,1100,10.00,20 

10,1234,06/16/97,06/16/97,06/16/97,0.00,1000,11.00,2,,300,10.00,20 

10,1234,06/16/97,06/16/97,06/16/97,0.00,1000,9.00,2,,1100,1.00,20 
 

Peachtree Accounting for Windows requires an Account Payable IMPORT Template to be 
created. This template should have the following fields selected IN THIS ORDER: 

Vendor ID 

Invoice # 

Date 

Date Due 

Discount Date 

Discount Amount 

Accounts Payable Account 

Accounts Payable Amount 

Number of Distributions 

Description 

G/L Account 

Amount 

Transaction Period 
 

 

General Ledger 

WinPOS® allows for its Revenue Report data to be exported to a General Ledger. Each time a 
new Revenue Report is printed, a transaction set is created for exporting. You can re-run the 
Revenue Report as many times as you like, and WinPOS® will replace the transactions IF they 
have not yet been exported. Also, WinPOS® will only create export transactions if you run the 
Revenue Report for one day, NOT if you run it for multiple days. 

The transactions are placed in an ASCII export file. For Peachtree Accounting the file name will 
be GENERAL.CSV and will be created in the directory specified in your Accounting Setup.  

The export file accumulates all of the daily transactions until the user PURGEs (deletes) them. 
Purging can be done as often as a user wishes, but at least once a year. To purge, use the 
Purge Menu from within System Maintenance. 
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The Revenue Report in WinPOS® has been designed to balance, like a GL debit/credit entry 
would have to. In some circumstances the report may not balance. To handle these situations 
WinPOS® will force the GL Export to balance by calculating the amount to make it balance and 
placing it in with the day’s transactions with the Over/Under GL account number specified in the 
GL Account Setup. The user will have to manually reconcile the discrepancy and place it into 
the correct GL distribution. 

General Ledger Exporting Procedures 

Before exporting the day’s GL information, you must first run a Revenue Report for the day (you 
would normally be doing this at the end of every business day anyway).  

To export the GL data, go to Export Accounting Transactions form, located at Main-
>Housekeeping->Accounting Integration->Export AP/GL. This form will first display the total 
number of general ledger transactions it will be exporting. If satisfied check the checkbox next to 
the gl transactions total to proceed. 

The GENERAL.CSV file (for Peachtree) that is created when the GL entries are exported will 
have the following information from left to right:  

Transaction date 

Reference description 

Number of Distributions for the day 

GL Account number 

Transaction description 

Amount 

Transaction Period (defaults to 20) 

Transaction Number (defaults to 20) 

NOTE: 

 This GENERAL.CSV file may be viewed or edited with any standard text editing program, such 
as the MS-DOS / Windows program “EDIT”. 

 

Below is a short example of what a GENERAL.CSV file could look like: 
 

06/13/2008,Trans from BPS,9,1500,Ttl Cost of Sales,44.16,20,20 

06/13/2008,Trans from BPS,9,1400,Inventory,-44.16,20,20 

06/13/2008,Trans. from BPS,9,1200,Cash deposit,101.76,20,20 

06/13/2008,Trans. from BPS,9,1600,Visa/MC deposit,100.00,20,20 

06/13/2008,Trans. from BPS,9,2400,New Sale Deposit,130.40,20,20 

06/13/2008,Trans. from BPS,9,2400,Sales Deposit Rel.,395.00,20,20 

06/13/2008,Trans. from BPS,9,2600,Sales Tax 1,-51.96,20,20 

06/13/2008,Trans. from BPS,9,2500,Force Balance,-579.20,20,20 

06/13/20087,Trans. from BPS,9,2000,STREET LENGTH <=$200 -Tax,-96.00,20,20 
 

Once the transactions for day have been exported, enter your accounting program and IMPORT 
them. For Peachtree a GL import template should be created with the following fields checked 
IN THIS ORDER: 
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Date 

Reference 

No. of Distributions 

G/L Account 

Description 

Amount 

Transaction Period 

Transaction number 
 

Export Vendors Form 

Switchboard: Main->Housekeeping->Accounting Integration->Export Vendors 

Menu: Reports->Accounting Integration->Export Vendors 

Action: none 

This form will create an export file containing all your vendors. You can then import these 
vendors into an accounting package like Peachtree. You will be prompted for a purchase GL 
account number, which is exported with each vendor. This account number should precisely 
match the purchase GL account number within your accounting package. Finally, click ok and a 
file called VENDORS.CSV will be created. 

Each record will contain the following information: 

“Vendor number”,”vendor name”,”contact name”,”billing street 1”,”billing street 
2”,”city”,”state”,”zip code”,”main phone”,”fax phone”,”purchase GL”,”vendor account number” 

Example record in the CSV file 

"36","CAROLINA AMATO","","15 W. 37TH ST","","NY","NY",10018-,212-683-9095 ,233-687-
9107 ,,"" 

Export Vendors 

When you set up your company’s information Peachtree Accounting, one of the things you will 
need to do is enter all your vendor information (vendor names, addresses, account numbers, 
etc.). As a convenience for our users, WinPOS® can export its entire vendor information file, 
eliminating the need to enter all your vendor information into Peachtree from scratch. You do 
this from the Export Vendors form (EXPVEND), located at Main->Housekeeping->Accounting 
Integration->Export Vendors. This will create a file named VENDOR.CSV in the export Path 
specified in the GL Account Setup. This file will contain the following fields: 
 

Vendor Code 

Name 

Contact 

Address 1 

Address 2 

City 

State 

Zip 
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Phone 

Fax 

GL Account # 

Account # 
 

Once the vendors are exported, enter Peachtree and IMPORT them. An import template must 
be created with the following fields checked/selected IN THIS ORDER: 
 

Vendor ID 

Vendor Name 

Contact 

Address 1 

Address 2 

City  

State 

Zip 

Telephone 1 

Fax Number 

GL Purchase account number 

Account # 

Export AP/GL Form 

Switchboard: Main->Housekeeping->Accounting Integration->Export AP/GL 

Menu: Reports->Accounting Integration->Export AP/GL 

Action: AIEXPORT 

This form will show how many invoices and Revenue GL transaction postings are ready for 
export.   Invoices are created during PO receipts and by manually adding invoices via the 
View/Change Invoices form.  Revenue GL postings are created by the running of the Revenue 
Report. 

Simply check the appropriate option, Invoices and/or Revenue Transactions to export.  This 
physically performs the export. 

Accounts Payable & Invoicing 

Invoice details for exporting to the Account Payable module of the accounting software are 
created when Purchase Order items are received into WinPOS®.  

When receiving a PO item, WinPOS® will display the Invoice detail screen automatically and 
complete most of the data fields itself. The data which must entered is the total merchandise 
amount for the entire invoice (not just the one item that is being received) and the non-discount 
amount (if any, i.e.: freight charges). WinPOS® will automatically calculate discount amounts 
and due dates based on the vendor terms and discount percentage previously entered for each 
vendor. 

If you need to edit an existing, UN-EXPORTED invoice, you may do so through the Invoice form 
(INVOICE form), located at Main->Housekeeping->Accounting Integration->Invoices.  
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Invoice exporting procedures  

1. Before exporting your invoices, you may wish to edit them, if necessary. As mentioned 
above, you may edit an existing invoice, provided you have not already exported it. You may 
do this on the Invoice form (INVOICE.) 
 
The Invoice form allows changes to an existing invoice or add an invoice from scratch by 
clicking the Add button. Invoice details may be printed using the Invoice report (RP_INV) 
located at Main->Housekeeping->Accounting Integration->Invoices Export Report. This 
report may be run for the received date period you specify. You may specify to print only 
those invoices from a specific vendor, and you may also choose to print only those invoices 
that have or have not been exported.  
 
If the invoice displayed on the screen has already been exported the export date will appear 
on the form. Remember: Exported invoices may not be edited.  

2. Once you are satisfied with the entered invoices, you are ready to EXPORT the invoices to 
your accounting program. First, go to the Export Accounting Transactions form, located at 
Main->Housekeeping->Accounting Integration->Export AP/GL. This form will first display 
the total dollar amount of ALL the invoices and all the general ledger transactions it will be 
exporting. Many shops will reconcile this total to an audit trail before proceeding with the 
export. 

3. If satisfied check the checkbox next to the invoices total to proceed.  The exact details for 
each accounting program are shown below. 

4. Start the accounting program and import the file created by WinPOS. 

 

Peachtree: Next, the system will inform you if an export file already exists from a previous 
export (Note: This will not appear during your very first export). Make sure you have already 
imported the previous export file into you accounting program and answer “Yes” to overwrite the 
old file. This will create an ASCII export file. For Peachtree Accounting the file name will be 
PURCHASE.CSV and will be created in the folder specified in the Accounting set-up form.  

The PURCHASE.CSV file (for Peachtree) will have the following information from left to right: 

Vendor Code 

Invoice Number 

Date Received/Entered 

Invoice Due Date 

Discount Date 

Discount Amount 

Accounts Payable GL number 

Invoice Total (non-merchandise +merchandise amount) 

Number of Distributions for this invoice 

PO Number (The number BPS generated for this purchase order 

Purchase GL for the category of the item received 

Discountable Amount 

GL period (always 20) 

If a non-discount amount exists for an invoice, WinPOS® will create a second distribution entry 
so the proper accounting will take place.  
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NOTE: This PURCHASE.CSV file may be viewed or edited with any standard text editing 
program, such as the MS-DOS / Windows program “EDIT”. 

Below is a short example of what a PURCHASE.CSV file might look like: 
 

13,88888,06/01/97,07/01/97,07/01/97,0.00,1000,95.00,2,10,300,85.00,20 

13,88888,06/01/97,07/01/97,07/01/97,0.00,1000,75.00,2,10,1100,10.00,20 

10,1234,06/16/97,06/16/97,06/16/97,0.00,1000,11.00,2,,300,10.00,20 

10,1234,06/16/97,06/16/97,06/16/97,0.00,1000,9.00,2,,1100,1.00,20 
 

Peachtree Accounting for Windows requires an Account Payable IMPORT Template to be 
created. This template should have the following fields selected IN THIS ORDER: 

Vendor ID 

Invoice # 

Date 

Date Due 

Discount Date 

Discount Amount 

Accounts Payable Account 

Accounts Payable Amount 

Number of Distributions 

Description 

G/L Account 

Amount 

Transaction Period 
 
 
QuickBooks 2001:  Next, the system will inform you if an export file already exists from a 
previous export (Note: This will not appear during your very first export). Make sure you have 
already imported the previous export file into you accounting program and answer “Yes” to 
overwrite the old file. This will create an ASCII export file. The file name will be 
PURCHASE.CSV and will be created in the folder specified in the Accounting set-up form.  
 
QuickBooks Pro 2005:  WinPOS will export one invoice for the merchandise total, and a 
separate invoice for the non-merchandise.  These invoices will be added directory to the 
company file for QuickBooks.  No other import step is required. 
 
AccPac: Next, the system will inform you if an export file already exists from a previous export 
(Note: This will not appear during your very first export). Make sure you have already imported 
the previous export file into you accounting program and answer “Yes” to overwrite the old file. 
This will create an ASCII export file. The file name will be APIBATCH.DAT and will be created in 
the folder specified in the Accounting set-up form, which should be \ASP\DATA (remember, this 
directory must already exist). 

The APIBATCH.DAT file (for AccPac) will contain 3 lines for each invoice entry and will have the 
following information from left to right: 

Line 1: 
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 “H” 

 Vendor number 

 Invoice number 

 “IN” 

 Date received 

 Terms 

 Null placeholder 

 Due date 

 Due date minus 1 day 

 Discount percentage 

 Invoice amount 

 Purchase order number 

 Null placeholder 

 Null placeholder 

 “0.00” 

Line 2: 

 “D” 

 Null placeholder 

 Accounts payable GL number 

 Department number (if applicable) 

 “0” 

 “0.00” 

 Invoice amount 

 Null placeholder 

Line 3: 

 “D” 

 Null placeholder 

 Shipping GL account number 

 Department number (if applicable) 

 “0” 

 “0.00” 

 Non-discount amount 

 Null placeholder 

NOTE: This APIBATCH.DAT file may be viewed or edited with any standard text editing 
program, such as the MS-DOS / Windows 95 program “EDIT”. 

Below is a short example of what an APIBATCH.DAT file might look like: 
 

"H","14","12345","IN","","970220","",""," 00000","4902315",0.00,1.00,"PO:12345","","",0.00 
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"D","","","",0,0.00,1.00,"" 

"D","",1235,"",0,0.00,1.00,"" 
 

AccPac accounting requires a similar setup for importing the APIBATCH.DAT file. Consult the 
AccPac manual for details. 

Invoices Form 

Switchboard: Main->Housekeeping->Accounting Integration->Invoices  

Menu: Reports->Accounting Integration->Invoices 

Action: INVOICE 

 

This form displays the invoices entered in WinPOS®, whether or not they have been exported. 
 Invoices in the invoice grid may be sorted by Invoice number or Received date for fast lookup. 
 Invoices that do NOT contain an export date will be exported when the Export AP/GL function 
is selected.  New Invoices may be added from this form, but typically are created via the 
Purchase Order receiving process.  

 

Fields 

Vendor..The vendor the invoice is payable to.   
QuickBooks Pro 2005 note:, You can only select vendors that have a Vendor export 
number set up.   
Peachtree and QuickBooks 2001 note: , WinPOS will use the WinPOS vendor number 
for the export vendor number if no export vendor number is defined for the vendor. 

Export Vendor Number... The number/code that matches to the vendor in the accounting 
package.  This is the code that is exported to the accounting program.  For QuickBooks 
Pro 2005, use the lookup button to select the vendor from a pick list. 

Due Date...This is the date the invoice is due to be paid for the vendor based on the vendor 
terms entered on the vendor form. 

Date received...The date the invoice is received (not the date entered). 

Exported…The date that this invoice was exported. The invoice cannot be changed if it has been 
exported. 

Invoice date...Date the invoice used for discount computations. 

Inventory Category...The category of the inventory item received. 

Invoice Number...This is the vendor's number/code assigned to the document being paid. 

PO Number...The PO the item was ordered on. 

Merchandise total…The total merchandise on the order, not including freight or other special 
charges. This is the discountable amount. 

Non-merchandise total…The total of freight or other special charges. This is the non-
discountable amount. 

Total... The grand total of the merchandise & non-merchandise. 

Discount amount…The discount amount is computed automatically, based on the terms entered 
on this invoice. 
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Terms.. The discount terms allowed by the vendor.  These may be pre-setup on the vendor form 
& they will automatically be entered or manually entered when the invoice entry is being 
created. 

Purchase...The GL account that the merchandise total will be exported to. 

Shipping...The GL account that the non-merchandise total will be exported to. 

Payables…The GL account for the accounts payable. 
QuickBooks Pro 2005 note: The Payables account is disabled since QuickBooks Pro 
2005 automatically posts to the correct accounts payable account. 

 

GL Export Report 

Switchboard: Main->Housekeeping->Accounting Integration->GL Export Report  

Menu: Reports->Accounting Integration->GL Export Report  

Action: RP_GLEXP 

 

When GL transactions are exported from the ProfitSystem into an accounting software package, 
the transactions are placed in the GL Export table before being exported.  Then, they are 
exported in batch to the accounting software package.  The transactions are then marked as 
exported in the GL Export table.  

This report lists transactions in the GL Export table.  It can filter the list to un-exported, exported, 
or all transactions. 

It can be used to audit the transactions before exporting to the accounting software.  The report 
will total the transactions, and this total should be zero, because all the exported transactions 
should balance each other.  Simply run the report for un-exported transactions and check the 
total.  If it's non-zero, it means the export accounts are not configured correctly, or the revenue 
report is out of balance. 

Criteria 

All Transactions... List all transactions in the file. 

Exported Transactions... Allows operator to enter a date range and the report will include only 
those EXPORTED transactions that were exported within the date ranged entered. 

Un-Exported transactions... Lists only Un-Exported transaction posting 

Invoices Export Report 

Switchboard: Main->Housekeeping->Accounting Integration->Invoices Export Report  

Menu: Reports->Accounting Integration->Invoices Export Report 

Action: RP_INVEXP 

This report shows the Invoices whether or not exported. You can choose to print un-exported 
invoices, all invoices, or invoices exported during a specific date range. You can also choose to 
export invoices received during a certain date range, and optionally invoices for a specific 
vendor. 

Multi-Store Integration 

Multi-Store Integration 

WinPOS® can support an unlimited number of retail locations with its Multi-Store Integration. 
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With the Multi-Store Integration, you will have one set of data files for all your retail locations. 
The benefits of the multi-store integration are: 

• Customers may visit any store in chain and each store will have customer/event 
details  

• Payments may be accepted for sales made at a remote store 

• Inventory levels of each store is available to all employees unless blocked by the 
utilization of STORE GROUPs. 

• Easy management of trackable inventory transfers from one store to another 

• Consolidated Reporting 

Stores may view prospects, customers, events and tickets created at any other store.  Edits 
may be done to any data, other than tickets.  Tickets may be viewed and payments added.  No 
other adjustments may be made to a ticket, those have to be done at the creating store. 

Set-up Overview 

Each store of the chain must be entered into the Store/Accounts form. 

Optionally a Region may be assigned to a store.  See Region Topic for more information. 

Optionally a Store Group code may be assigned to a store.  See Store Groups Topic for more 
information. 

Optionally a Store class code may be assigned to a store.  See Store Classes Topic for more 
information. 

 

Hint: 

Make sure each store’s store id / code is the same number of characters.  This makes it 
simple to lookup via store lookups. 

 

Each store will have terminals installed. Terminals are given account names which are called 
registers in WinPOS. Consult with the network administrator for the list of register names.  

Go to Register Setup and add each terminal’s account name (terminals are referred to as 
registers). When you add a register, you can specify the store where it is located.  When a 
Registered logins to WinPOS the store location is set and all data entry is owned by that store. 
 A register can swtich Store locations (the user must have appropriate security to do so) by the 
file switch register/store feature. 

Note: 

Each register name must be unique, across all stores. For this reason, you may want to 
append the store ID to the register name. For example, you have a register called 
FRONTDESK at store #1. Call the register 1FRONTDESK. 

 

Tax Groups 

Switchboard: Main->Housekeeping->Accounting Setup->Tax Groups  

Menu: Setup->Accounting->Tax Groups  

Action: TAXMETH 
 

This form is only used with complex tax requirements.  Generally, most store's sales tax 
requirements can be handled via the tax rates found on the Store/Accounts form. 
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This form is used in multi-store installations OR when a single store must charge multiple tax 
rates & wish for the rates to be listed on reports separately.   

See the Tax Rates topic (see Taxes topic for defining percentage rates). Tax Groups are 
 required in multi-store or WinTPS® Plant wholesale installations.  

A tax Group must be createed for EACH store location in multi store implementations. 

WinPOS® ships with the tax Method named RETAIL assigned to each Accounting Class. It is 
suggested that Tax Group name be used first when creating Tax Groups for each store. 

Why 

Defining Tax Groups for each store in multistore installations is required for proper tax 
computations within WinPOS™. When setting up taxes in multi-store, you have to choose which 
tax rates are automatically applied for each store.  These are the tax rates that are shown when 
you use the Taxes button the ticket.  There is a "Show all?" checkbox at the top of the Ticket's 
Taxes selection dialog box.  If checked, it will show all the tax rates for all the stores.  You can 
then select any tax rate to apply to the ticket. 

Tax Groups are a means to build Tax Rates combinations on a store by store basis. The Tax 
Group is a descriptive name given to an individual Tax Rate or Tax Rate combinations and are 
assigned to a specific store location. 

How does it works 

The same Tax Group name may be given to multiple stores, and can contain different Tax Rate 
combinations for each store it is given.  

A Tax Group name assigned to the same store more than once will be charge the Tax Rate(s) 
within the Tax Group for each time the Tax Group was assigned to that store. Typically, a store 
will have a particular Tax Group name assigned once. 

Each Accounting Class will have a Tax Group assigned to it. Finally each Inventory Item/Service 
setup will have an Accounting Class assigned. 

WinPOS™ will retrieve the Tax Group name from the Accounting Class assigned to the 
inventory item/service sold. It then will then locate the Tax Group name assigned to the store 
where the sale is taking place and charge the Tax Rate(s) selected. 

Setup 

First, use the Taxes form to set up all your tax rates.  

To add Tax Groups for each store, click the large add button at the bottom of the form and enter 
a tax group name (such as RETAIL) and the store ID where the tax rate(s) should be used.. 
After pressing the Save button, click Add item and either enter or select a tax rate name (press 
F2 for a lookup). This links the selected Tax Rate to the Tax group.  

In most cases, you will have a minimum of one RETAIL tax group for each store, and this 
RETAIL tax group will have one Tax Rate. 

Steps 

1. First, set up a tax rate for every rate you charge using Main->Housekeeping-
>Accounting Setup->Taxes 

2. Go to the Tax Group form, click Add, and enter a tax group name.  

3. For retail sales, use Retail. For rentals, use Rental. 

4. Click Add Item, then click in the Tax Rate Name column, and type the tax rate name. 

5. If there are more tax rates that need to be charge for this store, click Add Item and 
enter another tax rate name. 

6. Repeat steps 2 – 5 for each store. 
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Fields 

Tax Group...A short, descriptive name, such as RETAIL. 

Store...The store that this tax group applies to. 

Taxes list...The list of tax rates that apply to this tax group. To add a new tax rate, click the Add 
Item button. A blank entry will appear at the end of the list. Click on the blank entry and 
enter the tax rate name. To remove a tax rate, select the tax rate name in the list and 
click Delete Item. 

• Tax rate name: You can look up a tax rate name by pressing F2. 

• Rate: The tax rate is filled in automatically. 

 

Tax Computation Flow diagram 
 

 

Store Pricing 

Switchboard: Main->Rental Production->Inventory->Inventory->Rental Tab->Store Pricing and 
Main->Housekeeping->Rental Setup->Inventory-> Rental Tab->Store Pricing  

Menu: Inventory->Rental Inventory->Rental Tab->Store Pricing 

Action: RENTPRIC 
 

Overview 

Use with optional multi-store integration and allows for store specific pricing on each rental item. 

The Store Pricing function allows for multi-store store/account specific pricing be created. This 
form is utilized each time a rental order is created. The system will attempt to locate the order’s 
‘Pick-Up at’ store/account location within this form. When found the pricing on the record will be 
used instead of the standard Retail & Wholesale pricing found on the inventory rental tab. 

There should only be one entry for each store/account and the pricing displayed is controlled 
the Pricing/Type field setting on the Store/Accounts-> Rental tab.  For example, a location set to 
WHOLESALE pricing will see the wholesale price with & without coat on this form. 

Fields 

Style… The inventory style is automatically entered. 

Store… The specific store/account the prices entered will apply for. 
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Rent price w/ coat...The rental price for this item to a customer if on a rental order that includes 
a style that is a COAT item type. If the item being edited is rental item of COAT, this field 
is the rental price for this item.  

Hint: 

The COAT item type is system defined and cannot be modified within the item type maintenance 
form. 

Rental price w/o coat... The rental price charged to a customer for this item if it is on a rental 
order that does not include a style that is a COAT item type.  

Wholesale price w/coat… Available only for WinTPS Production Management installations with 
wholesale accounts. The rental price charged to a WHOLESALE account for this item if 
on a rental order that includes a style that is a COAT item type. If the item being edited is 
rental item of COAT, this field is the rental price for this item.  

 See Store/Account Maintenance form topic for more information. 

Wholesale price w/o coat… Available only for WinTPS Production Management installations 
with wholesale accounts. The rental price charged to a WHOLESALE account for this 
item if it is on a rental order that does not include a style that is a COAT item type.  

Transfers 

Retail Inventory Transfers Overview 

Switchboard: Main->Inventory->Transfer Inventory and Main->Housekeeping->Transfer 
Inventory 

Menu: Inventory->Transfers 

Action: none 
 

The Inventory Transfer module is only available to users of the BBL WinPOS™ Multi-store 
option. Transfers are requests for specific inventory (retail or pick-up) to be moved from one 
store to another.  This module provides for the management of these transfer requests. 

Transfer requests can be created from the Ticket form (TICKET) via the sales transaction 
status, or from the Inventory Transfer Form (RETLTRAN). 

A inventory transfer from the Ticket form requests a specific style’s size\color\width item to be 
sent from any chain store to the requesting store for a customer’s purchase. This action creates 
a Transfer Request that will be seen from the Outgoing Transfers form of the store being 
requested to send the inventory item(s). 

When you create an inventory transfer from the Inventory Transfer form, you can specify that a 
specific item be transferred from one store to another, or that a specific pickup inventory item be 
transferred from one store to another. 

Mutltple transfer requests can grouped onto a Transfer Manifest. A manifest contains transfer 
requests for items being sent to the same store. A manifest allows all transfers in the manifest to 
be shipped or received as a group.  

To view all the pending outgoing transfers requests for your current store, go to Main-
>Housekeeping->Inventory Transfers->Outgoing Transfers or to view an outgoing manifest with 
all the transfers that comprise it go to Main->Housekeeping->Inventory Transfers->Outgoing 
Mainfests.  

To view all the transfers that have been shipped and are coming to your current store, go to 
Main->Housekeeping->Inventory Transfers->Incoming Transfers or to view an incoming 
manifests with all the transfers that comprise it go to Main->Housekeeping->Inventory 
Transfers->Incoming Mainfests. 
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Inventory Transfers 

Switchboard: Main->Inventory->Transfer Inventory->Inventory Transfers and Main-
>Housekeeping->Transfer Inventory->Inventory Transfers 

Menu: Inventory->Transfers->Inventory Transfers 

Action: RETLTRAN 
 

Overview 

Inventory Transfers is a software tool used to control the movement of retail inventory and 
pickup inventory. It maintains a complete transfer history and automatically updates the 
inventory quantities for the shipping & receiving locations. 

The inventory quantity of items transferred will be deducted from the outgoing stores’s on-hand 
quantity for the style’s color/size/width when the transfer is shipped and added to the receiving 
store’s quantity once a transfer request is marked received. 

The quantity does not appear in any location while the transfer has a status of ship. 

This Inventory Transfer form is used to create a transfer request and to manage the request. 
Managing a request includes:  

1. Add/Create a request 

2. Shipping the request 

3. Receiving the request 

4. Cancelling the request 

Multiple transfers created for the same TO store location may be combined into a Transfer 
Manifest. 

Fields 

Header Section 

Transfer ID…This is the unique transfer ID automatically generated by WinPOS®. The first part 
of the number is your store number (as set in Main->Housekeeping->General Setup-
>System/Store Setup->Setup Tab) followed by a sequence number. You cannot change 
this number & one must exist. 

Manifest…If this transfer was assigned to a manifest, the manifest ID appears here. 

Status…The status of the transfer & the effect on Quantity on Hand (QOH) 

• PENDING: The transfer has been created, but not shipped. The item is counted in the 
QOH within the FROM store's inventory QOH. 

• SHIPPED: A sales associate (SA) id & actual quantity shipped (may be different from 
requested quantity) has to be entered and upon SAVING the status will be 
automatically changed by the system to SHIPPED indicating the transfer has been 
shipped from the From store. QOH is reduced in the FROM location, but NOT yet 
added to receiving store's inventory QOH.  It shows in neither the FROM's ro TO's 
QOH. 

• RECEIVED: A sales associate (SA) id & quantity received has to be entered onto the 
transfer record and upon SAVING the system will auto change the status to 
RECEIVED indicating the transfer has been received at the To (receiving) store. 
Quantity on Hand of the receiving store is incremented up by the quantity received 
number manually entered. 

• CANCELLED: The transfer has been cancelled. Does not change any quantity.  The 
quantity on hand of the receiving or sending store may need to be adjusted depending 
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upon the Transfer Record's status when it was cancelled.  Typically does not require 
any adjustments unless the Transfer was cancelled when during a SHIPPED status. 

Statues may be manually changed by an SA with adequate security privileges.  This is NOT 
recommended since inventory QOH updates do NOT occur. 

Created by... SA who created the transfer request. 

Notes…The reason for the transfer.  Could include customer name and additional details to 
facilitate the transfer process. 

Transfer from store... The store/service center from where the inventory is coming from. 

To store... The store/service center to where the inventory is going to. 

 

To be Transferred Section 

Ticket or Inventory Transfer  

Pickup item number…If this is a transfer of a pickup inventory item, the item number appears 
here. A transfer can be for a pickup inventory item, or a style code, but not both. 

Ticket/Line number…You can create an inventory transfer directly from the Ticket form, 
indicating that customer is purchasing an item that is to be transferred into the store. The 
ticket and line number will appear here. 

Note: 

When an item is sold on a sales ticket with a TRANSFER request status the system will NOT 
decrement the requesting sore's inventory QOH of the specific inventory item's QOH by the 
number of units sold.   Upon receiving the TRANSFER the item will automatically be added 
to the Pick-Up inventory of the receiving store.  If the sale was cancelled prior to receipt, the 
quantity received will be added to the item's inventory on-hand quantity for the receiving 
store. 

Qty to transfer…The quantity to transfer out of the From store.  

Style code/size/color/width…The item to be transferred from inventory. Note that the item must 
actually exist in the store selected as the From store. If you enter the 
style/size/color/width you cannot enter a pickup item number.  This field will accept a bar 
code number, SKU, or UPC code and convert it to a style code automatically.  This field 
will not quick-fill for that reason. 

Serial... This field is available when the optional WinTPS rental production software module is 
installed.  Once a TRACKED rental inventory style & size are entered, a bar-code of a specific 
item may be scanned to automatically mark it sold, un-available for rental and date retired thus 
indicating that is the item being transferred.  

Note 

The transfer of Non-Tracked rental inventory works as any other transfer.  The quantity on 
hand at the "Transfer From Store"  will decrement by the transfer quantity and the inventory 
of the "Transfer To store" will increment when received, but the Rental quantity available for 
rental will NOT decrement until the item is sold or marked TAKEN on a sales ticket  transfer 
in request. 

 

Ship Section 

Qty shipped…The quantity actually shipped out of the From store. Once this quantity is entered, 
the transfer status becomes Shipped and you can no longer change the qty shipped. For 
this reason, you cannot ship a transfer in multiple parts.  
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Also, the qty shipped does not have to match the qty to transfer. This would happen if the 
from store did not have the total quantity needed, but they went ahead and shipped what 
they had. You can audit this situation by running the Transfers Where Quantities Vary 
Report (RP_TRANSBAD) to show transfers where the qty to transfer does not match the 
qty shipped, or the qty shipped does not match the qty received. 
 
Once the qty shipped has been filled in, the Date shipped fills in automatically, and the 
user will have to enter their SA ID for the Shipped by. The status changes to Shipped 
automatically.  
 
If this is a retail inventory transfer, the quantity on hand at the From store is decremented 
at this point. If this is a pickup inventory transfer, nothing happens yet. 

Date Shipped... Date/time the item(s) were shipped. 

Shipped by... SA who shipped the inventory items. 

Shipping method...How were the inventory shipped. 

Tracking number... A tracking number / id code for the shipment. 

 

Receive Section 

Qty received…The quantity actually received at the From store. Once this quantity is entered, 
the transfer status becomes Received and you can no longer change the qty received. 
For this reason, you cannot receive a transfer in multiple parts.  
 
Once the qty received has been filled in, the Date received fills in automatically, and the 
user will have to enter their SA ID for the Received by. The status changes to Received 
automatically.  
 
If this is a retail inventory transfer, the quantity on hand at the To store is incremented at 
this point. If this is a pickup inventory transfer, the Store ID for the pickup inventory item 
is changed to the To store. 

Date received... Date transferred inventory items were received. 

Received by... SA who received the items. 

 

Buttons 

Print button…Prints a transfer document. The document contains a recap of the transfer and 
locations for signatures of the responsible people involved in completing the transfer. 

Add…Creates a new transfer request. 

Done…Exits the form and returns to the calling form. 

Save…Saves any changes made to the request. 

Cancel…Discards any changes made to a request. 

Incoming Manifests 

Switchboard: Main->Inventory->Incoming Manifests 

Menu: Inventory->Transfers->Incoming Manifests 

Action: RETLMAN 
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This form will show all transfer manifests that are marked shipped and designated for the store 
where the terminal the user is using is assigned to. 

Selecting a transfer manifest within the grid will display the Transfer Manifests form and allow 
the user to mark a selected transfer received. 

Marking a manifest received automatically receives all quantities shipped to the incoming store’s 
inventory.  

Incoming Transfers 

Switchboard: Main->Inventory->Incoming Transfers 

Menu: Inventory>Transfers->Incoming Transfers 

Action: RETLTRAN 
 

This form will show all transfers that are marked shipped and designated for the store where the 
terminal the user is using is assigned to. 

Selecting a transfer within the grid will display the Inventory Transfer form and allow the user to 
mark the transfer received. Marking a transfer received automatically adds the quantites to the 
incoming store’s inventory. 

Outgoing Transfers 

Switchboard: Main->Inventory->Outgoing Transfers and Main->Housekeeping->Outgoing 
Transfers 

Menu: Inventory->Transfers->Outgoing Transfers 

Action: RETLTRAN 
 

This form will show all transfers that are marked pending and will be shipped from the store 
where the terminal the user is using is assigned to. 

Selecting a transfer within the grid will display the Inventory Transfer form and allow the user to 
mark the transfer shipped. Marking a transfer shipped automatically deducts the quantities from 
the outgoing store’s inventory. 

Transfer Manifests 

Switchboard: Main->Inventory->Transfer Inventory->Transfer Manifests and Main-
>Housekeeping->Transfer Inventory->Transfer Manifests  

Menu: Inventory->Transfers->Transfer Manifests  

Action: RETLMAN 
 

Overview 

Transfer manifests are used to group a set of Transfers together and then to ship and receive 
them as a group. You first create a manifest, then select transfer requests to add. 

Individual transfers may be shipped or received, even if part of an manifest. Simply select a 
transfer within the manifest’s grid and click the Show Transfer button. This will display the 
Inventory Transfer form and allow the operator to enter shipping or receiving details. 
 

Fields 

Transfer…This is the unique manifest ID automatically generated by WinPOS®. The first part of 
the number is your store number (as set in Main->Housekeeping->General Setup-
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>System/Store Setup->Setup Tab) followed by a sequence number. You cannot change 
this number. 

Status…The status of the manifest: 

• PENDING: The manifest has been created, but not shipped. 

• SHIPPED: A Shipped by SA ID and quantity shipped has been entered indicating 
the manifest has been shipped from the From store. 

• RECEIVED: A Received by SA ID and quantity received has been entered indicating 
the manifest has been received at the To store. 

• CANCELLED: The manifest has been cancelled. 

Shipped by…The SA ID of the person who shipped this manifest. When the SA ID is entered, 
the status of the manifest is changed to Shipped. For each transfer on the manifest the 
qty shipped is set to the qty to transfer, and the Shipped by SA ID is set to be the same 
as the Shipped by on the transfer, and finally the status of the transfer is set to Shipped. 

Received by…The SA ID of the person who received this manifest. When the SA ID is entered, 
the status of the manifest is changed to Received. For each transfer on the manifest the 
qty shipped is set to the qty to transfer, and the Received by SA ID is set to be the same 
as the Received by on the transfer, and finally the status of the transfer is set to 
Received. 

Received by…The SA ID of the person who checked the all the items after receiving. No 
quantities or statuses change on entry of this ID. 

Add to Manifest button…Displays a list of all transfers that are currently pending, that are going 
to the same store as the manifest. You select a transfer from the list and it is added to the 
list of transfers on this manifest. 

Remove Selected button…Removes the selected transfer from this manifest. 

Show Transfer button…Displays the details of the selected transfer. 

Transfer on manifest grid…Shows all of the transfers on this manifest. 

Print button…Prints the transfer manifest form. 

Outgoing Manifests 

Switchboard: Main->Inventory->Outgoing Manifests 

Menu: Inventory->Transfers->Outgoing Manifests 

Action: RETLMAN 
 

This form will show all transfer manifests that are marked pending and will be shipped from the 
store where the terminal the user is using is assigned to. 

Selecting a transfer manifest within the grid will display the Transfer Manifests form and allow 
the user to mark the transfers shipped. Marking a manifest shipped automatically marks all the 
transfers shipped and deducts the quantites from the outgoing store’s inventory. 

Manifests Report 

Switchboard: Main->Inventory->Transfer Inventory->Manifests Report and Main-
>Housekeeping->Transfer Inventory->Manifests Report 

Menu: Inventory->Transfers->Manifests Report 

Action: RP_MANIFEST 

 

This report will list manifests based on the criteria specified. 
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Criteria 

Status...Select a specific status to only see manifests of that status, or All for all statuses. 

Transfer From/To Store...If you enter a From and/or To store, only manifests where the From/To 
store(s) match will print. Leave either blank to print all transfers. 

Select Transfers...You can enter a date range, and select the type of date range to use. If you 
want to print all manifests, select All Dates. 

Inventory Transfers Report 

Switchboard: Main->Inventory->Transfer Inventory->Inventory Transfers Report and Main-
>Housekeeping->Transfer Inventory->Inventory Transfers Report  

Menu: Inventory->Transfers->Inventory Transfers Report  

Action: RP_TRANSFER 

 

This report will list transfers based on the criteria specified. 

Status...Select a specific status to only see transfers of that status, or All for all statuses. 

Transfer From/To Store...If you enter a From and/or To store, only transfers where the From/To 
store(s) match will print. Leave either blank to print all transfers. 

Select Transfers...You can enter a date range, and select the type of date range to use. If you 
want to print all transfers, select All Dates. 

Transfers Where Quantities Vary Report 

Switchboard: Main->Housekeeping->Transfer Inventory->Transfers Where Quantities Vary 
Report  

Menu: Inventory->Transfers->Transfers Where Quantities Vary Report  

Action: RP_TRANSBAD 

This report will list transfers where the quantity shipped does not match the quantity to be 
transferred, or the quantity received does not match the quantity shipped. 

Only show transfers created after...If you want to see all transfers, enter a date far in the past, 
such as 1/1/1900. 

Transfer From/To Store...If you enter a From and/or To store, only transfers where the From/To 
store(s) match will print. Leave either blank to print all transfers. 

Rental - Point of Sale 

Rental POS Getting Started 

WinTPOS® and WinTPS® are optional software modules to WinPOS®. Both software options 
require the implementation steps detailed within this section. 
 

Overview 

WinTPOS is a rental point of sale system. Customers may rent items as individuals or as part of 
a event, i.e. wedding, social prom, ..etc. The system has intricate rental order management 
capabilities. Users will know the members of events, what they plan to rent, if all sizes are in, 
the price they are paying, whether the rental is confirmed, if has been received from supplier, 
whether customer has picked it up, or if customer has returned it and if the store has shipped it 
back to the supplier. 
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It will maintain the balances customers owe and can automatically apply late charges when 
rentals are returned late. The system has many sales and rental analysis reports. It also 
provides basic revenue accounting and provides bank deposit, revenue & tax information as a 
result. 
 

Order Flow Diagram 
 

 
 

Terminology Clarification 

Order: A rental order. A computer document that includes the information about the customer, 
the use date of the rental items, the specific items being rented and measurements/sizes for 
each item. The order contains a status that provides a quick reference to where the order is in 
the production cycle. 

Ticket: A sales ticket/receipt. A list of financial transactions for a particular customer. A newly 
created rental order will automatically create a sales ticket to contain the charge for the order. 
The operator may add additional transactions to the order. Transactions can be adjustments 
(discounts), additional retail sale transactions and payments. The ticket will calculate 
appropriate sales taxes and compute a balance. 
 

Implementation 

Tasks to complete prior to using the software. 

1. Enter System General Set-Up data. WinTPOS/WinTPS provide options to customize 
how some features work. Enter your preferences in the System Setup module. 
 
Hint: WinTPOS/WinTPS offers two types of Order Entry screen formats.  
 
Free Format provides a BLANK order entry screen. The data entry operator will be 
able to enter rental items on a order in any combination. Multiple items of the same 
type are allowed on the order.  
 
Fixed Format allows the rental “Item Types” to be also used as prompts on the 
screen for the operator. A entry slot tagged by a item type only permits that type of 
item to be entered. This allows the owner to control the order in which items are 
entered and useful as a reminder of items omitted from the order. As a option, 
additional rental items can be added to the order in a free format method also. This 
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allows multiple like item types to be added to the same order as multiple shirts or 
pants. 

2. Enter Stores Add stores in General setup. This required with the optional multistore 
management software system. When installed, stores are added in the System 
Setup form by selecting Add and completing all the information, including setting 
each option.   

3. Enter rental Item Types. WinTPS© and WinTPOS© allows the owner to customize 
the types of items rented with descriptions. Review those included and modify as 
needed. This is accomplished in the Item Type maintenance module.  

4. Size Conversion charts. This allows operators to enter the actual customer 
measurements items rented. The system will automatically convert the 
measurements into a size to match the size code entered into the computer’s 
inventory. For example a operator could enter pant measurements of 40 waist, 38 
outseam (40-38) and the computer could automatically convert it to a 40R. 

5. Enter/Assign Rental Inventory Add inventory rental styles and retail styles to the 
system. Any style created within the inventory system may sold at retail. It can also 
be designated as a rental style. Rental styles may be sold at retail also. 

6. Create Rental Order Types. Order types allow operators to classify the type of order 
being taken at order entry. These types are owner defined and can be utilize to 
analyze the amount and type of rental business being won. 

7. Create Catalog (as pictured) Codes and other Special pricing strategies. A catalog 
code lets the owner create a group of rental items (jacket, pants, tie and 
cummerbund, for example) under one code and to assign a package price to that 
code. A catalog code will be utilized by an operator at order entry to automatically fill 
the order with the styles & price previously entered with the catalog code as a 
means of FAST order entry.  

8. Price Group package pricing may be created for groups of rental items. Package 
names are created with the discount rules & pricing of the package. A package 
group may be assigned to any rental item.  

9. Each individual store/account may have pricing that is different from other 
store/accounts. This alternate pricing may be on the item and is setup via the 
inventory forms. Alternate pricing may be at the catalog/as pictured price level and is 
set up from the catalog maintenance screen. 
 
Hint: Discounts may be manually applied to rental orders at anytime on the rental 
order entry screen. Catalog codes/pricing, individual store pricing and package 
discounts are optional. 

10. Enter orders. Existing events, customers and orders should be entered starting 
with the earliest week. All new orders being placed should be input directly into the 
software while existing orders are being entered. 

Inventory 

Rental Inventory Entry Overview 

 

WinPOS maintains a single Inventory database that contains Inventory styles for both Retail & 
Rental inventory.   

The process for entering a new Rental Style is different than that of a Retail style.  The steps of 
this rental style entry process are listed here: 

1)  Create a meaningful Store Style code.  An example code for a Black Notch 2 button coat 
with a vendor style of 100 could be as simple as C100 or C1002BN. 
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2) Assign a SIZE Chart to the new style.  Several are included within the system for coats, 
shirts, pants & vests.  These can be modified by you anytime.  

3) Enter an rental item type on the inventory rental tab. 

3) Batch create all the rental SIZES by clicking the CREATE SIZES button found on the 
inventory rental tab for the new size.  The sizes created are from the size chart entered in 
step 2 above. 

4) Enter the quantities and/or bar-codes for each of the  Rental SIZES created via the 
Inventory Rental Tab, Rental Sizes form.  This process automatically enters the Quantity On 
Hand  for the style size in the styles Size Color Width (SCW) form. 

Anytime the quantity changes for a rental style, the system automatically updates it's SCW form 
to insure the quantity on the SCW form match the Quantity on the Rental Sizes form. 

Typically it is recommended that inventory is received from Stock Purchase Orders via the 
style's SCW form.  Once new rental inventory is Received it's Rental Sizes form must be 
updated to reflect the new quantity on hand.  

The system uses the total quantity on hand in the SCW form for inventory value computations 
and some inventory reports making this number an important bit of information. 

WinTPS Rental Note: 

1. Inventory styles that will be rented cannot contain a color or width entry in the SCW 
Form.  

2. In multistore installations, the rental inventory availability is maintained on a corporate 
basis, which is how most companies assembly rental orders, i.e. inventory is housed 
and orders assembled within a central production facility.  

Any style entered into inventory may used as a rental item.  However it is STRONGLY 
suggested that inventory used for RENTAL inventory should have a different style code than 
inventory used for RETAIL, even if the same inventory item is both used for retail and rental.  It 
would be a best practice to set aside an a quantity for retail entered for the retail code then the 
quantity reserved for rental under a rental style code.  This implementation is easier for your 
personnel to manage and to keep the quantities organized.  

Hint 

When necessary management can allow the retail sale of used rental inventory using the 
current Rental style code. 

 

Please review the Complete Inventory Creation & Maintenance chapter in the document for 
more information. 

 

 

 

Inventory - Rental Tab 

Switchboard: Main->Rental Production->Inventory->Inventory->Rental Tab and Main-
>Housekeeping->Rental Setup->Inventory->Rental Tab 

Menu: Rental Inventory->Rental tab->Rental Sizes button  

Action: RETLINV 

 

Overview 

The rental tab is available with the optional WinTPS and WinTPOS software rental modules. 
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Any style entered into inventory may used as a rental and/or a retail inventory.  However it is 
STRONGLY suggested that inventory used for RENTAL inventory should have a different style 
code than inventory used for RETAIL, even if the same inventory item is both used for retail and 
rental.  It would be a best practice to set aside an a quantity for retail entered for the retail code 
then the quantity reserved for rental under the rental style code.  This implementation is easier 
for your personnel to manage and to keep the quantities organized.  

Hint 

When necessary management can allow the retail sale of used rental inventory using the 
current Rental style code. 

Three inventory set-up actions must be in place to activate a style as a rental: 

1. The inventory style can only have sizes entered within the SCW form (omit colors & 
widths).  

Hint: 

The style code can represent a style & color combination. For example, say there exists a 
Blue Vest style 100. The style code entered into the inventory could be V100B and it’s sizes 
could be S, M, L, XL, XXL. 

2. The rental tab must be completed with the minimum information,i.e. item type and 
base rental price 

3. This step is only available/required with WinTPS Production Management module. 
The quantity available to rent must be entered. For tracked items (those that are being 
assigned ID/Serial numbers) the ID/Serial numbers for each item available for rental 
must be entered into the Rental SIZES form. 

Fields 

Item type...You must enter an item type for this style code. You can create your own item types 
using the Item Type form. Some item types are system defined and cannot be deleted. 
Style codes with item types can be used for rental orders. 

Default catalog code...If this style code is normally sold as part of a package, create a catalog 
code for that package and enter the catalog code here. Then, when the user enters this 
style code on the order form WinTPS will automatically stop when the style is typed on to 
a order and suggest to the operator hat the catalog code may be used instead.  The user 
may accept and the remaining styles of the catalog )if any) will be added to the order 
along with the catalog price OR reject it's use to continue entering each style manually. 

Price group code... Assign a optional package price group code for this field.  Assign a COAT 
Package price code to coat item types and an accessory package code to non-coat item 
types.  Package pricing is assigned to Package Codes and provide flexible pricing 
options.  The package price is displayed when a code is assigned and is the price that 
will be applied to a rental order when the item qualifies for package pricing. The Package 
discount codes with it's style contents is created via the Coat & Accessory Price Group 
forms. 

Replacement cost...The cost to charge a customer if they lose the item.  Replacement costs 
may be automatically applied to retail customers when items are not returned. 

Size conversion for whole size...You can specify a size conversion that applies to sizes for this 
item created during order entry.. If you enter a size conversion chart name within this 
field, WinPOS® will take the size entered on the actual order and try to convert it as a 
whole. If you specify this conversion, you cannot specify a left/right conversion. 

Size conv. for left of hyphen...WinPOS® will take the part of the size to the left of the hyphen 
and convert it using this size conversion. It will also convert the right side of the size 
(using Size conversion. for right of hyphen), and concatenate the results to create the 
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converted size. 
 
For example: 32-34 could become M4, if the left side conversion converts 32 to M, and 
the right side converts 34 to 4. 

Size conv. for right of hyphen...The conversion for the right side of the size entry field on a 
order entry screen. 

Swap sizes on conversion? (checkbox)...If checked, WinPOS® will take the results of the size 
conversion and swap them before concatenation. 

Example: 32-34 could become M4, if the left side conversion converts 32 to M, and the right 
side converts 34 to 4. With this option enabled the system would swap the two sides and the 
size would become 4M. 

 

Total, YTD, MTD Revenue...The dollars earned for rentals of this style code. Total dollars refers 
to the total revenue from this item since it was entered into WinPOS®. The MTD and 
YTD counters are reset automatically by WinPOS® at the start of each month and year, 
respectively. 

Total, YTD, MTD times used...The rental turns for this style code. Total times used refers to the 
total rentals from this item since it was entered into WinPOS®. The MTD and YTD 
counters are reset automatically by WinPOS® at the start of each month and year, 
respectively. 

 

Rent Price w/coat…Display only. This calculated field takes the base price entered for the rental 
style and applies any specific stores pricing. It displays for the logged in store & displays 
the retail or wholesale price determined by the Price/Type field setting in the 
Stores/Accounts form. 

Rental Price w/o coat…Display only. This calculated field takes the base prices entered for the 
rental style and applies any specific stores pricing. It displays for the logged in store & 
displays the retail or wholesale price determined by the Price/Type field setting in the 
Stores/Accounts form. 

 

View / Change Base Prices 

These four price fields appear when the View/Change Base Prices function button is clicked. 

 

Rent price w/coat...The rental price for this item to a customer if on a rental order that includes a 
style that is a COAT item type OR if the style being edited is a Item Type of COAT. 

Hint: 

The COAT item type is system defined and cannot be modified within the item type 
maintenance form.  If modified the with w/ coat, w/o coat pricing will NOT work! 

Rental price w/o coat... The rental price charged to a customer for this item if it is on a rental 
order that does not include a style that is a COAT item type.  Is the PRICE of a coat when 
no other rental items are on the order (Coat only price). 

Wholesale price w/coat… Available only for WinTPS Production Management installations with 
wholesale accounts. The rental price charged to a WHOLESALE account for this item if 
on a rental order that includes a style that is a COAT item type. If the item being edited is 
rental item of COAT, this field is the rental price for this item.  

 See Store/Accounts Maintenance form section for more information. 
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Wholesale price w/o coat… Available only for WinTPS Production Management installations 
with wholesale accounts. The rental price charged to a WHOLESALE account for this 
item if it is on a rental order that does not include a style that is a COAT item type.  

 

Important Pricing Note: 

Rental Orders that contain only a COAT can utilize Coat Only pricing.  Orders with only a 
Coat rental will use the price in the without (w/o) price field for the coat's rental price.  When 
the order contains a coat and any other rental item(s) the price field with (w/ ) Coat will be 
used for the coat rental price. 

 

Buttons 

Rental Sizes button...Displays the Rental Sizes form for this style code. The Rental Sizes form 
shows the rental quantities and rental statistics for each rentable size. The form also 
allows deletions of Rental Sizes, be careful because a deletion will permanently remove 
all rental history for that size. In addition, items of tracked item types, will have the 
ID/Serial numbers listed for each rentable size.  

Access to rental statistics for each ID/Serial number is available from the form. 

The entry of quantities and ID/Serial numbers is for the use of the WinTPS Production 
Management module only! 

Creating rental sizes is optional for WinTPOS ONLY! The “Allow any size on rentals” option 
in System/Store Setup - Rentals Tab must be checked when no sizes are identified as 
rentable. In this case, WinPOS® will allow any size to be entered on the Rental Order form. 

Store Pricing button… Available with multistore or Wholesale optional software modules. This 
feature allows for each store/account to have different prices for the same rental style. 
See Store Pricing for more information. 

View/Change Base Prices…Displays and allows edits of the retail and wholesale pricing for the 
rental style. The user must have adequate security privileges to edit.  Four fields appear. 

Create Sizes from Chart button...This option is used to add inventory size scales quickly. It will 
create a size and a single receive history entry for every size in the size chart entered for 
this style. The QOH will be set to zero for the new sizes added. Click the Rental Sizes 
Button to add rental quantities OR Barcode/ID numbers for the new sizes.  This function 
can be re-used when new sizes are added to a Size chart.  It will only add the new sizes 
to the SCW & Rental Size forms.   

Save... Save edits. 

Cancel... Cancels / Discards edits. 

Delete... Deletes the selected style and ALL associated information.  CAUTION:  Data is deleted 
and cannot be recalled. 

Add... Add a new style. 

Done... Exits this form and displays previous form. 

 

 

Inventory - Rental Sizes Form 
 

Switchboard: Main->Rental Production->Inventory->Inventory->Rental tab->Rental Sizes button 
and Main->Housekeeping->Rental Setup->Inventory-> Rental tab->Rental Sizes button  



WinPOS Version 11 

484 

Menu: Inventory->Rental Inventory->Rental tab->Rental Sizes button  

Action: RENTSCW 
 

This form is for WinTPOS and WinTPS optional software modules only. 

The Rental Sizes form shows the rental quantities and rental statistics for each size created 
within the Inventory SCW form. 

Two classifications of rentable inventory is supported, 1) Tracked 2) Non-Tracked. The Item 
Type assigned to this Inventory item indicates it’s classification.  

Non-tracked inventory will be assigned a rentable quantity to each size. This quantity is the 
maximum number available for the assembly of orders. 

Tracked inventory is assigned Serial/ID numbers to each piece for each size. The total pieces 
entered for each size and marked available will become the maximum number available for 
assembly of orders. 

This form allows additions, deletions and modifications to the quantities available for tracked & 
non-tracked inventory. 

The entry of quantities or ID/Serial numbers is for the use of the WinTPS Production 
Management module only! This module requires the entry of sizes and quantities. 

WinTPOS only users do not have to be concerned with the quantity available for order 
assembly. 

Creating rental sizes is optional for WinTPOS ONLY!  The “Allow any size on rentals” option in 
System/Store Setup - Rentals Tab must be checked when no sizes are identified as rentable. In 
this case, WinPOS® will allow any size to be entered on the Rental Order form. 
 

Fields 

Quantity available for rental… This feature is used with the WinTPS Production Management 
software module only.  

This number represents to the WinTPS™ production management software the total number 
of units for the style & size that are available to be assembled at one time. 

For non-tracked (defined in Item Type maintenance) rental item type, the total quantity 
available for rental is manually entered.  

For tracked rental item type inventory, the total quantity available for rental is is a total of 
items entered within the View Serial Numbers from that is marked Available.  

The total quantity shown must equal the current on hand quantity of the size (found in the 
Inventory SCW form). If the total quantity for the style/size entered does not match the total 
style/size quantity found on the SCW form then WinTPS will enforce this rule and 
automatically make an adjustment entry within the newest RECEIVE HISTORY entry in 
order to make the quantities match.  If no receive history entries exist for the style/size then 
the  system will automatically create one. The system utilizes the quantity on hand total 
within the Inventory SCW form for many reports and inventory valuation. Inventory value is 
available on printed inventory reports and in the Inventory Maintenance->Display Inventory 
Value function. 

 

WinTPS™ offers the Rental Inventory w/Low QOH report as a tool to help insure the 
quantities showing here are equal or less than the total found on the Inventory SCW form. 
This report can produce a list of styles & sizes where the rental total exceeds the Inventory 
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SCW total. It would be up to management to determine why the discrepancy appears and to 
adjust either the Inventory SCW quantity of rental quantity accordingly. 

Hold back... Allows a user to enter a hold back % (fractions allowed) or whole number.  When a 
fraction is used,  the system would compute the holdback quantity). The holdback Qty is 
deducted from that style/size availability quantity. So when users request availability via 
the Availability lookup or during order entry the holdback quantity is deducted from the 
total quantity.  Example, own 50, holdback is 10%, and then availability to rent is 45. 
 (Only used for quick avail and availability from rental form).  This is a tool to help 
manage the rental inventory, allowing a buffer for late order returns and other over 
booking requirements.   

The Check Overbookings form would ignore the HOLDBACK in determining the inventory 
items overbooked.  Why, you would not want to show overbooked and then purchase or sub-
rent, when inventory quantity exists to fill orders. 

Allow sale of rental items? Checkbox…WinTPS users may sale tracked rental inventory by 
entering the item’s serial/ID number into the style field on a ticket. This is allowed when 
this option is enabled by checking. 

Note: 

Rental Items sold by scanning serial/ID number will be automatically marked as unavailable 
for rental/assembly, Sold will be entered into the status field and the current date will be 
placed in the date retired field of the View Serial/ID numbers form. Attempting to sell a rental 
inventory item via the 'Store Style' code INSTEAD of the serial/ID will not update the rental 
status and quantity. 

 

Total, YTD, MTD Revenue...The dollars earned for rentals of this specific size. Total dollars 
refers to the total revenue from this size since it was entered into WinPOS®. The MTD 
and YTD counters are reset automatically by WinPOS® at the start of each month and 
year, respectively. 

Total, YTD, MTD times used...The rental turns for this specific size. Total times used refers to 
the total rentals from this size since it was entered into WinPOS®. The MTD and YTD 
counters are reset automatically by WinPOS® at the start of each month and year, 
respectively. 

 

Grids 

Size Grid...The size gride lists the sizes entered within the Inventory SCW form.  

Serial Numbers Grid… This feature is used with the WinTPS Production Management software 
module only. For a tracked rental item type, the total quantity available for rental is 
computed by summing the ID/Serial numbers entered on the Rental Size Serial Number 
Form.  

This quantity can equal or be less than the current on hand quantity of the size. Once entered the 
WinTPS production management software will utilize the number for computing 
availability for each style/size. 

 

Buttons 

View Serial Numbers button…Available for tracked Rental inventory. It Displays the Serial/Id 
form. 

Delete Size button…Permanently deletes the selected size in it’s entirety. Data deleted includes 
Inventory SCW information, Store Transfers and Serial/Id numbers and all statistics. 
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Once deleted it cannot be retrieved. It is always a good practice to back up data prior to 
making permanent deletions. 

Print... Prints a laundry tag for the currently selected serial number. 

Add New Rental Sizes... Displays the Inventory SCW -> Receive History form and allows a new 
Style / Size entry to be created.  The Rental Sizes form can immediately utilize the new 
style / size created. 

Done button….Exits the form and returns to the calling form. 

Order Entry 

Rental Orders Form Overview 
 

Switchboard: Main->View/Change Order  

Menu: Rentals->Rental Orders 

Action: RESVMAST 
 

The capabilities found within the rental modules are only available when WinTPOS® or 
WinTPS® software is installed. 

The Rental Order Form is where rental orders are created, reviewed  and modified. It also is a 
source of information concerning the order, examples are ship dates, status, tracking number 
.etc.  Rental Orders may be for Retail Customers (requires WinTPOS©) or Wholesale accounts 
(requires WinTPS©). 

The Order form(s), even though containing many details, have been designed for ease of use 
and fast data entry. The utilization of ‘field auto complete’, add same, catalog codes, 
measurement conversions, auto pricing, auto accessory package pricing and default application 
of damage waivers are just a few of the ways that the system saves data entry time. 
 

Overview 

A rental order contains a pickup location and ordering location.  The pickup location may be a 
company owned retail store or wholesale account (feature available when WinTPS© Plant 
Management is installed).  The pickup location controls which shipping methods are available 
and the rental item pricing charged. 

Upon creation, a rental order will automatically create a financial sales transaction on a 
ticket/ledger and link that sale to the rental order..  For company owned stores this would be a 
customer's ticket whereby the customer may add additional retail sale items, security deposits 
and/or partial payments.  With the optional WinTPS accounts receivable module for wholesale 
accounts the ticket becomes a transaction ledger that ultimately becomes a invoice when the 
order(s) are shipped. 

A rental order's original value is recorded when the order is initially created.  Management, as 
an audit, may run the WinPOS Balance Difference Report for a specified time frame to review 
rental orders where there original value does not match the current financial ticket. 

Automatic Order Ticket Adjustments 

There are four ways to create a ticket adjustment for an order.   

1) The business may define the standard rental period.  A order that extends this standard 
period may be automatically charged for the time it is kept out.  This is defined in the system 
setup - rental tab.  When a order is created that extends the standard rental period 
WinTPOS/WinTPS will automatically enter an adjustment on the customer's ticket/wholesale 
ledger.  This "multi-period" rental will have an user created adjustment code (this code is 
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placed on the ticket with the adjustment) and calculated charge that  was defined in the 
System/Store setup form - Rental Tab. 

2) A price change of any item on the order after the order is initially created/saved.  This 
includes a direct price over ride or replacing a style on the order with a new style of a 
different price or adding/removing an existing style that results in a price change.   No 
adjustment code placed on the order, just on the ticket.  The sysem can track these order 
modification via the Housekeeping-> General Setup-> System Set-up-> Rental tab-> Keep 
order change history. 

3) An adjustment code manually entered on the order.  The code will appear on the order 
and ticket. 

4) A CATALOG CODE is entered when the order is created where the sum of the items 
within the catalog code is different (usually more) than the package price of the catalog 
code.  This enters an adjustment on the order which is also placed on the ticket.  A code on 
the order and ticket. 

5) The utilization of Package Pricing.  A package price is usually less than "ala cart" pricing. 
 The user has a choice to use package pricing or not on an order.  

Any adjustments made to a rental order via the rental order entry that affect price will 
automatically be place on the ticket/ledger for the order.  An adjustment code of 
ORDERCHANGE (this code is system defined and may not be changed) will be auto 
inserted on the adjustment and the Order # will be inserted in the Reference line.    

For wholesale accounts, payments are made to invoices.  Once a invoice is created any price 
modifications to any order on the invoice will always be placed on the same invoice as the 
original order.  Late fees automatically applied for a specific late order will be placed on a new 
invoice. 

Within a retail store the order is associated to a customer and the customers sales ticket. 
Optionally the customer may be a member to an event, like a wedding.  Payments are made to 
tickets. 

The rental order itself contains the rental items, and a total charge for the rental. The rental 
order also has a single Ticket or Invoice (for a wholesale account) associated with it to hold the 
total net charge. The ticket or invoice is created automatically by the software when the rental 
order is saved. The total price for the rental is transferred over to the ticket/invoice, and is 
shown as a single rental charge line item on the ticket. If the rental order is changed after the 
ticket is created, and price change results, then WinTPS will insert an Adjustment line item on 
the ticket to account for the price difference. The markdown code on this Adjustment will be 
ORDRCHNG, indicating that the adjustment was automatically inserted by WinTPOS/TPS. 
  WinTPS/TPOS© will NOT apply order price adjustments to tickets/invoices if the adjustment 
causes the ticket balance to fall below zero.  The entire price adjustment will be ignored. 

Rental orders can be created or edited from the Event form, the Customer form, the Main Menu 
or from the Wholesale Order Entry forms 

 

Order Types Diagram 
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The rental order as a whole has a Status, and each line item has a Status. The status tells you 
where the order is in the production process (also see Item Status).  

Note 

The order status could be different from a line item status. For example, if all but one of the 
line items on an order are Returned, the order status will be Picked Up, the single line item 
will be Picked Up, and all the other line items will be Returned.  The order's status will equal 
the status of the earliest line item status in the production cycle. 

 

When a new rental order is created, it’s initial status will depend upon options that are set in the 
General Setup - Rental tab.  

Once a order is created and saved it will have a STATUS.  Depending on your operation, 
management may want to limit when store personnel are allowed to make changes to orders.   

Installations where the TPS Rental Production software module is NOT installed will have an 
option within General Setup – Rental tab to “Require confirmation numbers for orders”. When 
the option is enabled (checked), new order statuses will be “Wait for Confirm” In this case, to 
confirm an order a confirmation number must be manually entered on the rental order itself, or 
use the Enter Confirm Number form, located at Main->Enter Confirm Number. If the option is not 
checked, orders are status Confirmed immediately after each is created. 

Upon installation of the TPS Rental Production software option: Order statuses are “Wait for 
Confirm” until saved at which point the status will become Confirmed.  See the topic  

Rental Order prices are computed as outlined in How Are Rental Order Prices Computed, 

An Order is not allowed to be edited once it has been Picked up (Picked Up status) by default. 
 However,  this may be a user defined setting.  Some operations may not want store personnel 
to change orders once it is in assembly for example.  This feature is controlled via 
Housekeeping-> General Setup-> System Store Setup-> Rental Tab-> Deny changes for 
statuses setting. 
 

The Order form has three tabs.  Please review each's topic/chapter for more information. 
• List tab: Used to locate the correct rental order. Several search options are provides 

to locate a specific rental order.   
• Order tab – Contains information that applies to the complete order, such as 

customer, pickup and return dates, etc. 
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• Items tab – Contains the line items for the order, such as the coat, pants, etc, sizes & 
production notes. 

 

Rental Orders Form - List Tab 
 

Switchboard: Main->View/Change Order  

Menu: Rentals->Rental Orders 

Action: RESVMAST 

 
The order form List tab is utilized to locate rental orders.  Several search options are provided 
to locate a specific rental order.  The most common search options are order number or 
customer name and are bolded column headings which indicate to the user that the column may 
be clicked on to  move the column into the leftmost position and thus make it the search column. 
 
By default the Order Number is the searchable column.  Just enter a order number in the 
Search field and the system will attempt to locate it as it is typed.  To search by Customer name 
appearing on the rental order simply click the Customer column heading moving it into the 
leftmost position and type  the customer last name in the Search For field. 
 
Additional order filters may be applied to help locate an order.  These filters may be used 
separately or in any combination.  All criteria entered within the filters must match for orders to 
be displayed when used in combination.  The optional filters are: Pickup Date range, Order 
Status, specific pickup Store id and starting part of an event name  (event names must begin 
with the characters entered,i.e. smi will match smith, but ith will not match smith) and 
Confirmation number.   
 

Note 

Filtering the list by Status will quickly display any orders that have at least one item entered 
with the matching status. 

 
Complete the fields to filter by and click the Limit button.  Orders that match the filter condition 
will be displayed within the grid.  The Order Number search and Customer name search will 
only attempt to locate orders found within this subset of filtered orders. 
 

Buttons used on ALL Rental Order Tabs 

 

Save button...Saves a new rental order. When you press Save, the system can prompt with a 
choice of tasks OR automatically take you to a task as defined in Housekeeping -> 
General Setup-> Rental tab-> When saving an order?  A selection of PROMPT here will 
cause the operator to see a menu with four options. 

• Hold Order button: Saves the order but sets the order status to Hold. This would be 
used if you want to enter an order into WinPOS®, but not actually put the order into 
production. A report is available of orders on hold. Held orders will NEVER print on a 
picking ticket. 

• Save button: Saves the order and starts the production process. 
• Security Deposit button: Saves the order and starts the production process. Displays 

the Payments form to with the security deposit mode auto selected. 
• Payment button: Saves the order and starts the production process. Displays the 

Payments form. 
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Without the TPS Production option: the order status is set to Waiting for Confirm. A 
confirmation # must be entered for the order to become Confirmed. A confirmation # may be 
entered directly on the order or from the Enter Confirm Numbers form (Main->Enter Confirm 
Numbers) on the main menu. 

If any sizes are missing when saving a rental order, the status of the order is set to Missing 
sizes. If the order is set for pickup at a wholesale account then the user is warned about the 
missing sizes before saving. 

 

Cancel button…Will cancel all edits/additions and return data to values prior to any changes. An 
order CANNOT be cancelled once it has a RECEIVED or later status.  Once a order is 
marked cancelled it may be reviewed.  The financial charges placed on the ticket remain 
and should be cancelled or potentially modified depending upon the situation. 

Print button…Prints a Rental Agreement for the order. The Rental Agreement recaps all the 
order details, and also includes the details of any payments made & balance information. 
It also includes the Rental Receipt document terms that established in Document Terms 
set-up.  A rental agreement may automatically be printed when a new order or change an 
existing order is SAVED. 

Print Pick ticket button…Immediately prints a picking ticket for the displayed order only. A 
picking ticket number is assigned to the order, the status of all items are changed to In 
Assembly, and the picking ticket is printed. A picking ticket may be printed for orders that 
are status Confirmed OR In Assembly.  A Log entry with key type of RESVPICK is made 
for orders with manually printed Pick Tickets.  This requires PICK security to access. This 
is the same security required to Print picking tickets via the PICK form. Will print ticket if 
item is on hand to assemble. If no lines are status Confirmed or In Assembly OR no line 
items need a picking ticket number, then the message "No line items are correct status, 
or all line items already have a picking ticket number" is displayed. 

Add Same button…Will copy displayed order’s details (less the sales associate, sizes and 
customer name for wholesale store/account types for the Ship to location) to a new order 
to eliminate the retyping of the existing order details. Excellent tool for wholesale order 
entry of wedding parties or to add another single order for an existing customer in POS. 

Add button…Will exit the current order, create a new one and display the blank fields. 

Delete button…Used to delete the current rental order. The user must have RESVDEL security 
to delete the rental order. The rental charges placed upon it's ticket are not deleted, the 
rental transaction should be cancelled manually from the Ticket form.  Deleting the order 
removes it from the system and it cannot be recalled or reviewed. 

Done button…Exits the user from this form. 

 
 
 

Rental Orders Form - Order Tab 

Switchboard: Main->View/Change Order->Order Tab  

Menu: Rentals->Rental Orders->Order Tab 

Action: RESVMAST 

May also be reached via Customer form, Events->Members Tab, and Rental Production-
>Stores/Accounts. 
 

This tab shows the order details that pertain to the entire order. 
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Order...This is the order number automatically generated by WinPOS®. It consists of the store 
number followed by a sequence number. If WinTPS is configured to prompt for order 
numbers (“User must enter rental order number?” option on System/Store Setup-Rental 
Tab ), then WinTPS will ask for the order number after the Add button is clicked. 

Created...The date/time this order was created. 

Ordered at...The store location that created this rental order.  For retail type store/accounts sales 
tax for the order charges will be computed on this location for the customer. 

Pickup at...The store where this rental order will be shipped to (for WinTPS Plant Production 
users) and/or where the customer will pick it up.  

The pick-up account entered sets data entry parameters configured in the Store / Accounts 
form for this order, i.e. 1) Pricing used, Wholesale or Retail 2) The type of billing, i.e. 
invoice/COD or ticket or none 3) Whether a customer can be assigned or not and 4) the 
available shipping methods.  For pickup location having a WHOLESALE type, sales tax will 
be charge based on the pickup store/account sales tax rate.  Finally the pickup location 
controls items status when it is assembled and shipped. 

Customer...This order is for the customer displayed here. For orders going to Retail type pickup 
accounts, you can change the customer by entering a new customer number, or using 
the binoculars to select another. For Wholesale type accounts, simply enter the 
customers name 

Event...Rental orders can be associated with an event (the groom and groomsmen for a 
wedding, for example.) For Retail type pickup accounts, select the event using the lookup 
button. For Wholesale accounts, enter the event name. 

Height/Weight…For Wholesale type accounts enter the height and weight for the customer, to 
be used by the Auto Size Suggestion system.  Will not display for retail customers. 

Shipping Method…… This field is available with the optional WinTPS Production management 
software. It is the transit method of how the order will reach the store/account. Shipping 
methods are defined for each store/account in the Stores/Accounts form and is controlled 
by the pick-up account entered for the order.  Each shipping method will have defined the 
time required to ship to/from the location the order is being sent.  WinTPOS/TPS will 
complain if the shipping method selected will not allow adequate time for the order to be 
ready on the customer pickup date. 

Alternate ship to...Optionally, the order may be shipped to a different store/account than the 
pick-up location.  This location can appear on a Picking Ticket to signal order shipping 
personnel where to ship it.  By default orders are shipped to the order's Pickup location.. 

Current location.. Orders should be Checked-In or Returned thru the system hen they are 
received from the supplier/service center and returned from the customer. This field is the 
current store ID of the location where the order is. It is automatically filled in by the 
Check-In order function and Order Return function.  

Sometimes orders can be mis-shipped to the wrong retail location and/or the customer 
returns it to another store that was more convenient to them, rather than the original Pick-up 
store. This inform management where the order is/was. 

Confirm order regardless of availability...If checked, WinPOS® will automatically confirm this 
order, even if inventory will not be available on the dates specified. Only available with 
WinTPS Service Center Integration. The RESVFORC security setting control whether or 
not the user can check this.   

When entering a new Order the system checks availability for each style/size as it is entered 
onto the order.  If the style/size is NOT available for the timeframe requested then the system 
will complain and display alternative sizes (larger & smaller sizes).  When a NON-available 
style/size is required the operator can force the order into a OVERBOOKED but CONFIRMED 
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status by checking the "Confirm order regardless of availability"  checkbox on the items screen. 
 This allows the order to be saved.  If the operator does not check "Confirm order regardless of 
availability", the order cannot be saved.  Once a order is OVERBOOKED it must be handled in 
Production via the "Check Overbookings" function. 

Invoice number... This is the invoice number the charges for this order was placed on when 
billed.  Invoices are used for wholesale accounts in the optional WinTPS module or for 
retail open account/invoice customers.  Double click the invoice number in the field and 
the invoice form will be displayed. 

Returned at alternate store...The store ID where this order was actually returned and is 
automatically set by the customer return function. 

Status Order...The order status. See rental order status topic for more information.  Beneath 
Order Status the code NO SHOW may appear.  This appears when the order was 
returned with a RECEIVE status, i.e. it was never marked PICKED UP by the customer. 

Ship... Displays the shipping service used to ship the order (if a service was used) and shipping 
date.  If a rental order has multiple, different ship dates or tracking numbers then display 
“see order line item details” instead.  This happens when items of an order are shipped at 
different times via multiple shipments. 

Track... Displays a tracking number of the ship service used (if available).  If a rental order has 
multiple, different ship dates or tracking numbers then display “see order line item details” 
instead. 

This is an exchange for order...When you exchange an item on an order, WinPOS® creates a 
new order to hold the new item. If this is one of those orders, this field contain the order 
number of the original order. This is maintained automatically by WinPOS®. A Order may 
have multiple exchange orders associated to it. 

Type...The type of rental order is validated against a management defined database, popularly 
either Formalwear, Gown or Prom. Rental order types are created/edited using the Order 
Types form, located at Main->Housekeeping->General Setup->Order Types 
(ORDERTYP) The order type controls how the income revenue for the order is accounted 
for on the Revenue Report. It can also be use to report on orders grouped by Type, thus 
providing interesting statistics. 

At least one Order type must exist for each pricing/account type in the Stores/Accounts, 
WHOLESALE and RETAIL. For example, say two store/accounts existed, one retail and 
one wholesale. There would need to be a order type set-up for each, ie. Formalwear for 
Wholesale & Formalwear for Retail. The user would need to select the appropriate type for 
the order when the order is created. 

Role...The role that this member will play in the event. 

Used on...The date the rental order will actually be used.  This cannot be past date. 

Pickup on...The date the rental order is to be picked up at the store by the customer. 
Automatically completed by the system.  

Return on...The date the customer is to return the rental order. Late fees are computed if the 
rental order is returned after this date. Automatically completed by the system during 
order return.   

Hints:  

The user should enter in the USE DATE of the rental.  The system will calculate the 
remaining dates automatically based upon system settings.  

The Pick-up on date and the Return on date CANNOT be greater than six weeks apart.   

Late fee amount is determined by the Late Fee system setting found in System Setup-> 
Rental tab. 
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The 'Pickup on & Return on' dates automatically default to dates based upon Event Type 
settings in Housekeeping->General Setup->Event Types.  A User can set the number of 
PRE DAYS & POST DAYS to subtract from the USE DATE for defaulting PICKUP on date 
and add to USE DATE add for defaulting RETURN on date.   

Event Types are assigned to Events whey the event is created.  Different events can have 
different  Pre & Post Days set.  Single rentals and Wholesale rentals will always default to 
the Pre & Post days set to Wedding event types. 

A rental order standard cost to the customer may be automatically increased by WinTPOS 
based upon the rules set  "Charge for Extra Rental Periods" found in System Setup-> Rental 
tab when the order is initially created. This increase is treated as an adjustment and 
automatically added to the ticket the rental order is lined to.  The markdown (adjustment) 
code set in the system setting is inserted onto the ticket's adjustment transaction for easy 
identification.   

A change to the Pickup and Return dates that extend the rental period will initiate an alert 
message to the operator to check the ticket for extended period charges that the date 
modifications may cause.. 

Asm/Ship on … This is a calculated date used to indicate the last date when the order can go 
into assembly/production to reach the account/store/customer by the Pickup date. 
Automatically completed by the system. Can be modified if the user has RESVCHNG 
security. 

Back in Inventory … This is the estimated date that all items on an order will be available for a 
new order assembly. This is automatically calculated by the system & automatically 
entered by the system. Can be modified if the user has RESVCHNG security.  The Back 
in Inventory" date is a basis for determining item availability when using the optional 
WinTPS module. Formula is: Return date + RetDays + Laundry Days  

Note: 

WinTPS© will not allow the Assembly & Back date on a rental order to be more than 42 days 
apart.  The Check Overbookings in the WinTPS© module will complain and display the order 
numbers of orders that have dates more than 42 days.  It will ignore those orders in it's 
processing. 

 

Actual Return Date...This is the date the last time an item was returned on the order.  It is 
completed automatically by the system.  "Actual Return Date" is the date the last item on 
the order is returned via the POS return function, Later when the order is completely 
returned at the plant (with WinTPS optional module) the date is overwritten with the date 
 the last item on the order is returned there. 

See Item Availability for more information on dates. 

Confirmation number...The confirmation number is used when this shop brings orders in from 
an outside company and does not utilize BBL’s integrated rental production software 
module. 

This is the confirmation number given to the shop by the supplier when order is confirmed 
(ordered) from a supplier. The operator enters the confirmation/order number from the 
supplier here and the order status will be set to Confirmed.  

Confirmation numbers may be entered from the Enter Confirm Numbers form at Main-
>Enter Confirm Numbers to confirm orders also. 

PO/Authorized by...WinTPOS Point of Sale software module can support third party billing for 
retail payment of rental orders. An example of this is a hotel situation where it’s 
employees come in to rent items for an event at the hotel. The hotel provided the 
employees a PO number for the statement to reference. This field allows that PO number 
to be entered as a reference. 
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Sales associate...The SA ID of the sales associate who created the order.  When the enter key 
is pressed from this field the system will automatically change to the Items Tab and 
position the cursor on the style field.  The Sales Associate is required information.  The 
order will not save until a SA is assigned to the order. 

The Sales Associate ID entered here will receive the sales/revenue credit for the rental 
charges.  Their ID is automatically transferred to the Rental Transaction created on a sales 
ticket when the rental order is initially saved.  This ID is also automatically added to any 
other ticket transactions created from the rental order, including damage waivers, multi-
rental period charges, markdowns/discounts, catalog code pricing adjustments  ..etc. 

Hint 

With the optional Rental Production module installed, the 'Tab Order' (the order in which the 
cursor jumps to each field when the Tab or Enter key is pressed) can be modified.  

To do , hold down the SHIFT key & click onto the blank area of the bottom right corner or the 
form.  A list of all the fields will be displayed in their current tab order.  Simple move the 
fields into the order that you want them.   

This tab order is only in effect when the from is displayed from the Rental Production-
>Stores/Accounts->New Rental function for wholesale pricing/type store/accounts. 

Buttons 

Hold / Release Hold button…Writes all edits/additions permanently to database, and sets the 
Hold flag for the order. When the Hold flag is set the notation “ORDER HELD” appears 
on the Order tab and this button name changes to Release Hold, near the Order status. 
Held orders will not print picking tickets, and also can be reported on using the Held 
Orders Report. An order is usually held if a deposit is not taken on the order or there is 
some question about the order, i.e styles or sizes and the operator does not want the 
order to go into production. 

To ‘Un-Hold’ simply click the Release Hold button.  When the SAVE button is clicked to 
save changes WinPOS© will ask the operator to Take the order off Hold, Yes or No. Answer 
Yes and the order is automatically taken off HOLD and will print on Production Tickets 
(assumes all items are a Confirmed status). 

Note 

Changes to orders may be logged and tracked.  This feature is set to Low/High  via 
 housekeeping-> General Setup-> System Setup-> Rental tab Keep Order Change History?. 
 WinTPOS will request a change REASON when a tracking level is set. 

 

Ship / Un-Ship Hold button... Allows the order to be placed into a Ship Hold state or to Remove 
the order from the Ship Hold state.  This feature typicaly utilized by order production to 
control when orders are shipped to stores / accounts. 

Show Ticket button…Displays the sales Ticket form associated with this rental order. There is 
always one and one ticket only associated with each rental order. For a wholesale order, 
displays the Ticket that contains the invoiced line item. 

Show History button…Displays the order change history. There is an option in System/Store 
Setup - Rental Tab, “Keep order change history.” If that option is checked, WinPOS® will 
prompt the user to document any changes made to the rental order.  This button will 
display all recorded order edits. 

Show Notes button…Allows notes and comments related to this rental order to be created or 
edited. 

Plant Status button…Selection only available when DOS TPS Plant is accessible from WinPOS. 
Clicking this button will display the order status in TPS DOS Plant. After the order is 
confirmed in WinTPS, it will pass through a variety of statuses in TPS Plant (WT ASM, IN 
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ASM, WT SHP, SHIP) During this time, the status is WinTPS will remain Confirmed. In 
this case, knowing the TPS Plant Only status can be useful. 

Cancel Order button…Once the desired order is display the CANCEL ORDER will change 
order’s status to Cancelled and a cancellation receipt is printed, thus providing an audit 
trail.   

The rental order's SALES transaction on the ticket is also cancelled as long as no payments 
have been taken. If payments have been taken, the user is advised via a WinTPS© 
message to manually cancel the rental SALES transaction on the ticket. Reports may be ran 
of cancelled orders via the Orders Report providing an audit trail for management. 

 

Note 

NO SHOW processing.  Often customers do not pick up the orders they have rented and are 
in the shop awaiting pickup (RECEIVED status).  Most stores consider this a NO SHOW 
order and wish to account for it.  This is a simple process. Just return the order via the 
RETURN function and WINTPOS will automatically reverse the inventory turns/stats for the 
order.  The user should visit the ticket associated to the order and perform an mark down 
adjustment using the reason of NO SHOW when an unpaid balance exists. 

 

Rental Orders Form - Items Tab 

Switchboard: Main->View/Change Order->Items Tab  

Menu: Rentals->Rental Orders->Items Tab 

Action: RESVMAST 

May also be reached via Customer form, Events->Members Tab, and Rental Production-
>Stores/Accounts. 

Overview 

This tab shows the line items (style, sizes, prices, comments ..etc) for a rental order. 

The form is divided into three areas. 1) the heading area is where the entry of data is 
accomplished, 2) the grid area is a summary recap of all the item data entered. The grid lists 
item information by item type, sequenced by the numerical line number order entered for each 
item type within the Item Type Maintenance form. 3) the footer area that contains the total price 
of the order that is computed by WinTPOS™ and allows for an operator to enter adjustment 
codes & amounts, order production notes and to allow for the application of Damage Waiver 
fees to the customer. 

 

Heading Fields 

These fields show you the details for the rental line item selected within the grid area. By default 
the first line item within the grid is selected. 

Item Type...The item type of the highlighted rental item. It is automatically displayed when an 
rental style number is entered. 

Style...Enter a inventory item style code that is set up for rental (see Rental Inventory for more 
information). You can also enter a Catalog Code (as pictured code) and WinTPOS® will 
expand the catalog code into it’s components on the Orders form. Catalog Codes are a 
quick way to build orders. If a catalog code is used on an order that already contains 
styles found within the catalog code, then those duplicate styles (and entered sizes) will 
be deleted before the catalog code is loaded.  In this case, the user is warned before the 
line items are deleted.  Non-duplicate styles are NOT deleted.  Usually catalog codes are 
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used to add styles to the order from the start, but some operators may find them useful to 
auto add accessory packages to an order. 

Size...The size code to be rented. By Default, WinTPOS® will validate the size code against the 
sizes of the style entered within rental inventory and only allow the item to be saved with 
a size that exactly matches a size entered in inventory.   

WinTPOS will allow for a DASH to be entered into a size.  The DASH within a size is a tool 
to provide additional size information to the service center.  Typically, for example, a style 
with an item type PANT, the service center may require the out seam to be included with the 
size, a DASH may be used to accomplish this task, i.e. 34R-37.  WinPOS validates the size 
to the left of the dash against the sizes found within the inventory.  It does NOT validate the 
size information to the right of the dash, thus allowing any information.  The maximum 
length for a size is 7 alphanumeric characters.  Due to this limited space the Order Entry 
form also allows a reference for each style on the order with up to 20 alphanumeric 
characters.  In addition, each order has a spot for production notes where additional order 
details may be entered.  On the Item Type maintenance form, service center management 
may set a item type to REQUIRE a dash within the size as a reminder to store operators to 
include the additional size information. 

When the customer’s size is unknown, WinTPOS® will allow the size field to be left blank 
(empty). As a result that item’s status will be set to Missing Sizes. See Item Status for more 
information about statuses. 

Size validation may be turned off. This feature may be disabled by checking “Allow any size 
on rentals” in System/Store Setup – Rental Tab. Turning size validation off is useful for 
companies that sub-rent most of the rental items from an outside supplier and do not wish to 
enter all available rental sizes within their own inventory. 

WinTPOS® provides a ‘Size Conversion’ feature to aid data entry operators. Company 
management may elect to enter size codes within inventory, i.e. a shirt size could be M3 or 
a pant size could be R4. These codes are useful for inventory production managers, but 
difficult for store personnel and order entry clerks to utilize.  

By enabling the ‘Size Conversion’ feature, data entry personnel may enter exact 
measurements for the selected style and WinPOS® will convert the size entered to the 
correct inventory size code. The measurement entered will be automatically replaced with 
the inventory size code and the original measurements will be saved and displayed to the 
right of the size field. 

See How To enter exact style measurements for more information on size entry. Also see 
Rental Inventory for information on enabling Size Conversion. 

WinPOS® will automatically default to a size for a style when that rental style code as only 
ONE size on file. This is helpful for styles that have FIT ALL sizes, usually represented by 
the code FA and thus saves entry time.  

As a new rental order is created, the system will automatically insert the sizes previously 
entered onto the customer's card as each style of an item type found on the card is added. 
 If sizes ARE NOT present in the customer form the WinTPOS system will attempt to locate 
a previous rental order for this customer.  If an older order is found, the system will default 
the sizes from that order as the new order is created.  If the size entered on this new rental 
order is different than the older sizes entered on the customer card, WinTPOS will prompt 
the user and if accepted update the customer card size with the new size. 

After a size is entered/converted for a style on a order, WinTPOS® will automatically 
perform an availability check when BBL’s Rental Production software is installed. The status 
of the item will be set to Confirmed when the style and size are available for the requested 
use date. If the size is NOT available, WinTPOS® will display an ALERT message to the 
user and pop-up a list of available sizes that may optionally be switch to.  

The user may decide to keep the originally entered size. To do this, the user must check the 
“Confirm order regardless of availability” option on the Order tab of the Rental Order form. In 
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keeping the unavailable size the system will now be in an Overbooked situation for that 
Style & Size in the requested timeframe. Additional inventory must be ordered by 
management to fulfill the order. See Check Overbookings for information describing how to 
handle inventory overbooked situations. Overbooked inventory is only available when BBL’s 
Rental Production software is installed. 

To save and confirm the order either all the items must be available, or the user must check 
the “Confirm order regardless of availability” checkbox. 

 

Quantity...The quantity to rent. On tracked items the quantity must be one. Tracked items are 
items that are assigned ID/serial numbers. 

Price...The rental price for the item. This is filled in automatically from the rental inventory and 
may be manually modified by the operator. However, it is recommended to enter 
markdown codes and formulas for applying discounts within the Adjustment field 1 or 2. 
The RESVPRIC security setting control whether the user can make direct changes to the 
rental price of an item. 

Total...The extended price for the rental item. Quantity times price. 

Adjust...At production time the size requested on the highlighted item may not be in inventory to 
be assembled for order. In this situation the ADJUST code will indicate the type of size 
substitution that may be feasible, i.e. should the supplier substitute an item of a larger 
size (Up), smaller (Down), or do not substitute (No) 

Serial number...  Shows the ID/serial number of this item that has been assigned. Assigning the 
ID/serial numbers of items to rental orders is optional when using WinTPS©. This can be 
accomplished during QC/Assembly of Production or when the ordered is received at a 
store via it’s Check-In form.   

Status...The status for this line item. A status is the description of where in the order cycle this 
item is. See Item Status for more information. 

Item notes...This a area that random comments may be made for this item. The notes could 
describe special measurements or details concerning this item. An example could be one 
sleeve of a coat should be shorter than the other. Any notes entered for this line item may 
be reviewed here and printed on a Production ticket when the Production software 
module is installed. 

Price Group... Price group code for package discounts that the style has been assigned to  via 
the inventory.  Checked a price group is in effect for the order, meaning a special 
package price defined within the price group module is being applied.  Un-Check a Price 
Group is not being applied.  Users may check & un-check to insure the customer is 
receiving the best available price for the order. 

Measure button... Displays the customer measurements for reference that are entered onto the 
customer form that this order is being created for.  This is WinTPOS feature. 

Change line item status button… Used to directly change the status of a line items. This should 
only be done to correct a problem under direction of BBL Systems Customer Service. 

Item exchanged? checkbox...This is a system controlled field and for user reference. It is 
automatically checked when this item is tagged for an Exchange by an operator. Items 
are Exchanged after they have been Shipped from the Rental Production module or 
Received at a retail store. It is a quick indication to a user viewing this order that this item 
has been exchanged and another order exists containing the newer item. 

Exchange item button…Situations may arise where the assigned item is not wanted by the 
customer at pickup (wrong style or size).  To create an exchange order highlight the item 
to be exchanged and click the Exchange button.  When an item is marked for an 
exchange a checkbox appears in the Exch? column of the order.  Exchanges may be 
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made while the order is in a NON EDITING MODE (meaning no items have been 
modified or added; to exit editing mode simply click SAVE or CANCEL).  Before SAVING 
any exchanges, another item may be marked for an Exchange by simply selecting the 
line to exchange and clicking  the Exchange button again.   Once the item(s) to be 
exchanged are marked  click the SAVE button.  A new Exchange order is created with 
the styles of the items being exchanged & linked to the original order.  This process is 
ideal for operations whom have the production performed off site from the retail store and 
must process in the exchanged item(s) orders from the service center. To un-mark an 
item for EXCHANGE, click the CANCEL button.  Once the SAVE button is clicked all 
edits/exchanges are permanent. 

Once item(s) on a order is selected for exchange, the item is marked as an exchanged item 
on the original order (via the item exchanged checkbox) and a new rental order is created 
for the new line item with the same order number as the original order number, but with the 
letters EX appended to the end.  This makes it easy for production workers to identify an 
order as an exchange.  This process creates an audit trail, provides option for reporting 
exchange statistics and results in added security for management.   Only one item at a time 
may be selected for exchange. 

Exchange orders are processed via WinTPS© production and may follow the traditional 
steps of Printing a Production Ticket, Assembling the order and optionally Shipping the 
order. 
 
Highlight the original line item within the Grid area and click Exchange item.   The system 
will automatically prompt for an exchange reason.  Available reasons are: Wrong Size, 
Wrong style, Changed mind or Other.  Choose a reason and the system will create a new 
exchange order for the item type selected on the original order.  Exchange order analysis 
may be performed via the Reports-> Order Reports-> Rental Order Exchanges report.  
 
When the new rental order is created it will contain a copy of the selected line item. Make 
any rental item changes necessary (new size or style) and save and confirm the new order. 
Pickup, return dates, customer names etc may not be modified on exchange orders. 
 
If the option “Check-in exchange orders automatically?” is set in System/Store Setup-Rental 
Tab, the order will automatically be checked in and marked picked up when the original 
order is picked up by the customer.  The exchange order must be marked picked up by the 
customer when the exchange is performed on order previously marked picked up. 

Orders my have a STATUS of RECEIVED or PICKED UP and have items marked 
exchanged. 

Fast Exchange/Assembly 

This feature is offered in the event where rental inventory is kept in the retail store where the 
user may go retrieve the exchange garment.  In this case the Print Production Ticket & 
QC/Assembly may be skipped. With this feature the operator wishes to QUICKLY exchange 
the  item to a different item & does not want go thru the traditional assembly steps.   In this 
case, the production ticket and assemble steps are skipped by simply double clicking the 
serial number field and entering a new serial/id number.  This is allowed if the user has 
REVCHNG security.  

The serial/id number entered must be a valid existing serial number of any rental item (can 
be of different item type, style or size than the existing item).  The swap will modify the 
inventory turns/stats of the previous serial/id (if any existed).   The statistics  are reversed. 
 In addition the system will review the inventory status for the serial/id of the item being 
entered to insure it is marked AVAILABLE for rental and complain if the item has a RETIRED 
inventory status. 

The status of the new item will be ASSEMBLED or RECEIVED (depends on store/account 
settings) if it had not been previously picked up by the customer.  For all other statuses it will 
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immediately inherit the existing status of the item it is replacing (in the case where you are 
changing an existing item).   

A new line item may also be ADDED to a order and the serial/id number assigned (not 
replacing/exchanging an existing item).  A order may be modified  when the is order status is 
prior to PICKED UP.  This is the system default status when order changes may be made. 
The store owner may deny order modifications based upon other order statuses which would 
be defined via Housekeeping-> General Setup-> System Store Setup-> Rental Tab-> Deny 
changes for statuses setting. 

 

Grid Area 

The Grid area is a summary recap of all the item data entered. The Item Types are 
automatically listed in line number numerical sequenced as set-up within the Type Type 
Maintenance form. The Header area is active for the highlighted item type within the grid, so any 
information entered there will be saved to the highlighted item type. Hint: only styles of the 
highlighted row’s item type may be entered. 

The booking column indicates if the style & size combination is available for the order.  This 
feature is available with the WinTPS option where you reserve your own rental inventory.  The 

word OVER! in RED appears in the column  on the item that is not available 

(OVERBOOKED)  for that order.  Overbooked indicates not enough style/size inventory is 
available for the item in the time period needed and incorporates the inventory HOLDBACK 
percentages or quantity.  Once more inventory is purchased or the item on this order is marked 
to be Sub-Rented the word OVER! will disappear. 

Any style of any Item type may be entered in the grid by highlighting a blank line within the grid.  

 

Footer Area 

Checkboxes 

Always confirm order? checkbox... If checked, WinPOS® will automatically confirm this order, 
even if inventory will not be available on the dates specified. Only available with WinTPS 
Plant Integration. The RESVFORC security setting control whether or not the user can 
check this. 

No sec dep/payment req? checkbox... No security deposit or payment required.  A setting 
exists in General Setup - Rental tab. that sets a system requirement for rental orders to 
have a minimum payment or security deposit on the order's ticket before the order will be 
processed.  Orders they do have the minimum payment/deposit will not have a picking 
ticket printed.  This checkbox, when enabled (checked)  will cause the WinTPS to ignore 
the system setting for the minimum deposit/payment and print the picking ticket as 
normal. 

Not our measurements? checkbox...The operator would check this box when an order’s sizes 
are entered, if the customer was not measured at that location. It is used for reference. It 
will indicate that the measurements were taken by another shop. 

Damage waiver? checkbox...Many companies offer damage insurance for the items being 
rented. WinTPOS/TPS® easily handles the addition of this insurance, popularly referred 
to as a ‘Damage Waiver’, to the order.  

 

The system must be configured/setup for the automatic addition of this fee to customers. 
 Access the inventory located at Main->Housekeeping->Inventory Setup->Inventory and 
lookup the Store Style DMG WAIVER. Edit the DMG WAIVER inventory item via the 
Inventory->Rental tab-> Rental Prices-> Rental Price w/Coat and Rental Price w/o Coat, 
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found on Rental Tab, to the desired amount to charge.  The entered fee which will become 
the amount charged to a retail customer for accepting the damage waiver.  Also insure the 
Accounting Class and Category are set to the desired selections for the fee. 

Once the system is configured it will automatically mark each new retail order to be 
accessed the Damage Waiver fee.  This checkbox will AUTOMATICALLY be checked for 
each NEW order created.  This feature is active for new orders only (orders being created 
for the first time)!   Checking or un-checking this box after new order has been saved will 
have NO effect. 

The operator may un-check this box to removed the fee from the new order prior to it being 
saved.  Once SAVED the damage waiver may be removed from the ticket via a ticket 
adjustment and canceling the Damage Waiver transaction.  A damage waiver may manually 
be added to any ticket at anytime. Display the ticket and choose the SALE transaction 
button. For the Style enter DMG WAIVER. 
 
The damage waiver is automatically unchecked for orders to Wholesale type accounts.  See 
the topic Damage Waiver for more information. 

 

Buttons 

Rental Order Details button…Active when WinTPS is installed. It provides production details 
about the order, including picking ticket number, tracking number, sub rented, packing 
slip number, ship date and laundry batch number. 

Change Line Item Status button... WinTPOS® maintains the line item status automatically. A 
reason may arise for the status to be forced to a different status. This button allows an 
operator to force the status to any other status. 

Show Ticket... Displays the financial ticket this rental order is linked to.  Allows the operator to 
review and/or make modifications to the ticket. 

Assemble Order... Used with the optional WinTPS production software.  Allows orders with a IN 
ASSEMBLY status to be assembled.  When this button is clicked the system will drop the 
displayed order into the WinTPS assembly form so a QC check may be made as well as 
serial/bar-code numbers assigned to the order.  The order status must be IN ASSEMBLY 
before it can be assembled.  Once assemble, the order status becomes RECEIVED. 

Pickup Order...Will allow an operator to mark the order Picked-Up.  The order's Status will be 
forced to RECEIVED. 

Rental Order details… Available with the WinTPS plant module. This button will display the 
production details of the order, i.e. picking ticket number, when shipped, tracking number, 
sub-rent info..etc. 

 

Fields 

Order total...The total price of all rental items, before any discounts. 

Accessory package discount...The total discount automatically given for the accessory 
package purchased. This is computed based on the price groups for the accessory items. 

Adjustment 1 &, Markdown code...Enter a adjustment amount and markdown code that will be 
applied to this rental order. You can only enter this adjustment on the order form when 
the order is created, not when you are editing the order later. When additional 
markdowns are needed, go to the Ticket form to enter an adjustment/markdown there. 

 

Total...The total rental price for this order, including all discounts given on the rental form.  
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Additional discounts may manually be entered directly on the Ticket for this rental order. 
Additional ticket markdowns, if entered, are NOT reflected in this total price. 

No charge for order? checkbox...Check this box if the entire order is to be free. WinTPOS® will 
create a ticket/invoice with a zero charge rental transaction. This applies to both 
wholesale and retail rental orders. 

Prod. Notes...Production notes for this order are random comments about this order. The notes 
could describe any special circumstances or details. Any notes entered for this line item 
may be reviewed here and printed on a Production ticket when the Production software 
module is installed. 

Ticket DEPOSIT message... This message displays GREEN when the deposit is met or RED 
when the deposit is not met.  The deposit criteria is set in System Setup-> Rental Tab. 
 The message displays the information of  DEPOSIT PAID or DEPOSIT NOT PAID, SD 
(Security Deposit) paid amount and PMT (partial payment) paid amount. 

 

Retail Invoicing 

Switchboard: Main->Retail Invoicing 

Menu: Sales->Retail Invoicing 

Action: none 
 

Available in WinTPOS© installations. WinTPOS Point of Sale software module can support third 
party billing for retail payment of rental orders. An example of this is a hotel situation where it’s 
employees come in to rent items for an event at the hotel. This function displays a grid of 
store/accounts designated as retail invoicing within the Store/Accounts form.  This will allow a 
retail store sales associate to create retail sales and rentals for accounts that will be invoiced for 
their purchases.   

Locate and select the desired account, then click New Sale or New Rental.  Rentals will default 
to the selected account for order Pickup at location.  This may be changed to a different 
account/store location if needed.  Billing will stay to the selected account.  

Sales tickets will default to the account as the "Bill to" entity.  This should NOT be modified 
since changing it will remove the billing to the original account, i.e. they will not be invoiced for 
the sale(s). 

 

Buttons 

New Rental... Creates a new rental.  Once saved rental orders may be edited via the Main-
>Orders function or from the Store/Accounts form for the account. 

New Sale... Creates a new sales ticket. Once saved sales tickets may be edited via the 
Store/Accounts form for the account. 

OK... Clears the screen and returns to the previous menu. 

 

 

Events Rental 

 

Events that will contain members that are renting are handle through the standard 
 WinBPS/TPOS© Event functions.  For detailed explanation see topics: 

Events Overview 
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Event Form - Event tab 

Event form - Members tab 

Event form - Rentals tab 

Register Members Wizard 

 

Damage Waiver 

Damage Waiver is a term to indicate a special add-on charge to rental orders.  WinTPS/TPOS© 
incorporates specific features to facilitate the successful add-on of this charge.  Sales Reports, 
like Sale by Vendor Style or Orders Reports like Late Fees/Dmg Waiver, may be utilized to list 
the number sold & and sales volume for a selected date range.  Damage Waivers may be sold 
to customers in WinTPOS© and Wholesale accounts in WinTPS©.  

 

Setup 

WinPOS© has a default Inventory Item for damage waivers with a Style Code of DMG WAIVER, 
Vendor Style of DMGWAIVER & category of DW.  The style code will be utilized by 
WinTPOS/TPS© to insert this add-on charge on to customers/accounts tickets/invoices.  This 
style may NOT be modified.  The pricing entered on this style will be the standard charge for 
damage waivers applied to all retail orders.  With the optional WinTPS and wholesale support, 
wholesale store/account orders may also be charged a damage waiver. 

To begin charging Damage Waivers, three steps must be complted: 

1. Enter the Damage Waiver selling price for the Inventory Style Code:.DMG WAIVER. 
 See description below on which prices to create. 

2. Enable the  Housekeeping-> Rental Setup-> Stores-> Rental Tab->Default to damage 
waiver? checkbox for each store/account where Damage Waivers should be charged. 

3. Insure the Damage Waiver? checkbox found on the Order - Items tab is checked 
when a order is created.  This Damage Waiver setting is automatically checked for 
Retail customers when 1 & 2 above are completed. 

The Inventory ->Rental tab base prices for the DMG WAIVER style code should be entered, 
Rental with coat (for retail customers), as well as, Wholesale with coat (for optional WinTPS 
production module with A/R when doing orders to wholesale accounts and the service center 
wishes to charge damage waiver to them)..   

Additionally, a feature is offered in multi-store implementations or a service center scenario that 
accepts wholesales orders to multiple accounts, where the damage waiver price may be 
different for each account.  This multi-store pricing is set in the Inventory-> Rental tab-> Store 
Pricing form.  Setting multi-store pricing is optional.  When not utilized, the system will use the 
base price. 

There are two type of stores or accounts that may be created in the Store / Account form.  1) 
Those that are assigned RETAIL pricing and those that are assigned WHOLESALE pricing 
(available via the optional WinTPS accounts receivable module).  This is determined by the 
store's Pricing/Type field setting in the Store setup-> Rental tab form.   

Stores set to RETAIL pricing will charge the retail Damage Waiver price and those accounts set 
to WHOLESALE pricing will charge the wholesale price.   

Each order, when created, will have a Pickup Location set.  In single store implementations this 
will always be the that store.  In multi-store implementations or wholesale account 
implementations the pickup location could be any of the stores or accounts.  The Pickup 
location instructs the system to charge the Damage Waiver price set  for that location. 
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Retail Customers entered via the Customer Module & Event - Rental tab will automatically 
receive the DMG WAIVER pricing in inventory.  By simply setting a DMG WAIVER price 
indicates to WinTPOS© that each customer should, by default, be charged the Damage Waiver 
fee.  A operator would have to manually stop the charging of the Damage Waiver for the order 
by un-checking the Damage Waiver? checkbox found on the Order - Items tab or to manually 
adjust and cancel it off a ticket once the fee has been charged. 

 

Application 

Insure the Damage Waiver? checkbox found on the Order - Items tab is checked when a order 
is created to automatically charge the waiver fee..  When registering events enable (check) or 
Disable (uncheck) the Damage Waiver? checkbox on the Event's Register Members Wizard 
prior to creating the rental order.  In case of error where the waiver was charged or not charged, 
a operator may visit the ticket that contains the rental charge and sale - ring up the waiver 
charge to add or adjust-cancel the waiver charge to remove. 

There exists system setting, System Setup - Rental Tab- > Add Damage Waiver to FREE 
rentals?.  Un-checked the system will not automatically charge a Damage Waiver to customers 
that were marked FREE on the Events - Register Members Wizard. 

WinTPS© does not default to adding a Damage Waiver charge to orders entered via the 
optional  Wholesale Order Entry form unless the Damage Waiver checkbox is enabled for that 
store/account.  The Pickup location on the order controls the damage waiver  price being 
charged.   

Damage waiver charges are created if the Damage Waiver? checkbox found on the Order - 
Items tab is checked when the order is originally created/saved.  The Damage Waiver is 
simply a sales transaction that will appear on a customer's ticket or wholesale invoice.  This 
charge may be manually adjusted when needed. 

 

Reports 

Report Late Fees/Dmg Waiver, Rental Orders/Upgrade, Sales by Vendor Style & Sales by 
Category are some of the standard reports that provide information regarding the sale of 
Damage Waivers. 

ICR Form Processing 

Form Processing 

Switchboard: Main->Form Processing  

Menu: Rental->Form Processing 

Action: IMPORT 

This optional software is only enabled when the Forms Processing Integration is installed. 

This option allows WinPOS® to receive incoming rental orders from handwritten orders on 
printed forms (via integrated handwritten character recognition - ICR), or from a WindowsCE 
handheld PC. 

When using ICR, the optional forms processing software must be configured to automatically 
process any TIF graphic files (graphic format of all faxed and some scanned scanned 
documents) that are placed in a specific directory. The ICR software will read the handwritten 
information and insert the results as a record into the a import table in the WinPOS® data 
directory. See Configuring Teleform for Form Processing for more details. 

A WindowsCE pocket or handheld computer will copy orders entered on it to the import table in 
the WinPOS® data directory also. 
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The fields on this form are self-explanatory and are the same as the corresponding fields on the 
Rental Order form. 

Customer number...The customer ID number assigned by WinPOS®. If not present, WinPOS® 
will create a new customer card when you process this order. 

Event number…The event ID if this customer belongs to an event. If present, the rental order will 
be added to that event. Additionally, WinPOS® will automatically add any adjustment 
amount and markdown code present on the event into the rental order. 

Payment fields…Enter the details of the payment here. When a rental order is processed, 
WinPOS® will enter the details of this payment automatically. 

Process Order button…Click this button to create the rental order. WinPOS® will validate that 
the information is correct, then create a rental order. If the customer ID is empty, 
WinPOS® will also create a customer card. If the event ID is filled in, the rental order will 
be assigned to that event. You will then be taken to the Select Payments for to take a 
deposit. 

Configuring Teleform for Form Processing 

ICR capabilities requires that a third party software application called Teleform© be installed 
and running.  The The Teleform reader needs to be running at all times on a single workstation. 
It will become the Forms Server. It will open and attempt to accomplish a FORM read on any 
TIF image written into the directory \TPSWINS\ICR . When the image is read it will be stored 
into a \TPSWINS\TWDATA\IMPORT.DBF table. 

The user initiates a form read from within the WinPOS® application by clicking the Scan button 
on the Import form (Located at Main->Forms Processing. This function will start the scanning 
system software of the scanner’s manufacturer. The user will tell the software to scan. When it 
completes the software will return the user to the WinPOS® application. The scanned image is 
automatically saved to the \TPSWINS\ICR folder, where the Teleform software will automatically 
process it and store the results in \TPSWINS\TWDATA\IMPORT.DBF table. 

Set-Up should be done from the workstation that will be the Forms Server. 

1. Insert the disk into the computer that contains the form definition files 

2. Start the TeleForm Designer Application 

3. Select File and then Import. Browse the floppy in the From Directory portion of 
dialog box. Select the Orders Form description in the Forms section of the dialog 
box. Check the Preserved Auto Exports box and then Press Import button when the 
form is selected. 

4. Now Select File and then Open from the menu. In the dialog box look for ORDERS 
FORM and select it, then press Ok. The form should now be displayed within the 
Teleform Designer 

5. Now choose Form from the menu, select Primary Auto Export 

6. The Dialog box should appear. From the Format field select FOXPRO (.DBF) using 
the drop down arrow 

7. Now select Save As and enter X:\TPSWINS\TWDATA\IMPORT.DBF as to the 
location and database to save form data. Replace X: with your server drive letter. 

8. Now click Ok to exit the Form menu.  

9. Select File and Save to save the changes. 

10. Select File and then Exit to exit TeleForm Designer 

11. Now start the Teleform Reader application 

12. Select Utilities, then Configuration Tab, Reader 

13. Check Enable remote Data File Processing 
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14. Directory to check for remote data files, enter x:\TPSWINS\ICR (Replace X: 
with your server drive letter.) 

15. Enter the following values for: Images to evaluate every (sec): 3, Remote data 
files every (sec): 3 

16. Go to configuration options Tab 

17. Select INI Item: Eval Image Format using the drop down arrow. Enter the 
Value: BMP and click UPDATE ITEM. 

18. Now select UTILITIES from the drop down menu. Within this menu select 
CONNECT AGENT SETUP.  

19. From here Select: EVALUATE DIRECTORY. 

20. Check enable evaluations from directory.  

21. The value of SEARCH FOLLOWING DIRECTORY FOR IMAGES should be 
x:\tpswins\ICR\ 

22. Insure the value of EVALUATE FILES WITH EXTENSION is *.BMP 

23. You may exit the software by pressing FILE & then EXIT or you may leave it 
running to evaluate forms. 

24. You may want to put the TeleForm Reader icon in the STARTUP FOLDER of 
the Forms Server workstation so the application will start each time the computer is 
started. 

25. HINT: Remember scanned forms must be monochrome images. 
 

FIELD_NAME TYPE LEN DEC 
 

IPFIRSTNAM C 15 0 
 

IPLASTNAME C 20 0 
 

IPMIDDLE C 1 0 
 

IPADDR1 C 30 0 
 

IPADDR2 C 30 0 
 

IPCITY C 25 0 
 

IPSTATE C 4 0 
 

IPPOSTCOD C 10 0 
 

IPHOMEPHON C 14 0 
 

IPWORKPHON C 14 0 
 

IPFAXPHON C 14 0 
 

IPPAGEPHON C 14 0 
 

IPCELLPHON C 14 0 
 

IPALTID1 C 30 0 Credit card 
number 

IPSA C 8 0 Clerk ID 

IPPICKACCT C 10 0 Pickup store 

IPPKUPDATE C 10 0 Pickup date 
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(MM/DD/YYYY) 

IPRETDATE C 10 0 Return date 
(MM/DD/YYYY) 

IPSTYLE1 C 10 0 
 

IPSTYLE2 C 10 0 
 

IPSTYLE3 C 10 0 
 

IPSTYLE4 C 10 0 
 

IPSTYLE5 C 10 0 
 

IPSTYLE6 C 10 0 
 

IPSTYLE7 C 10 0 
 

IPSTYLE8 C 10 0 
 

IPSTYLE9 C 10 0 
 

IPSTYLE10 C 10 0 
 

IPSTYLE11 C 10 0 
 

IPSTYLE12 C 10 0 
 

IPSIZE1 C 7 0 
 

IPSIZE2 C 7 0 
 

IPSIZE3 C 7 0 
 

IPSIZE4 C 7 0 
 

IPSIZE5 C 7 0 
 

IPSIZE6 C 7 0 
 

IPSIZE7 C 7 0 
 

IPSIZE8 C 7 0 
 

IPSIZE9 C 7 0 
 

IPSIZE10 C 7 0 
 

IPSIZE11 C 7 0 
 

IPSIZE12 C 7 0 
 

IPSUBCODE C 10 0 Payment type 

IPPMT F 20 4 
 

IPDMGWAIV C 1 0 
 

IPEVENTNUM C 15 0 
 

IPORDRTOTAL F 20 4 Order price (no 
tax or damage 
waiver) 

IPPROCESS C 10 0 When 
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processed into 
WinPOS 

IPPROCBY C 8 0 Clerk who 
processed into 
WinPOS 

IPCHEST C 3 
  

IPOVERARM C 2 
  

IPHEIGHT C 3 
  

IPWEIGHT C 3 
  

IPUSEDATE C 10 
 

Use date 
(MM/DD/YYYY) 

IPPKUPCMNT C 30 
  

IPCUSTNUM C 15 
  

IPEXPDATE C 6 
 

Credit Card 
expiration 

IPSTOREID C 10 
  

IPWAIST C 4 
  

IPOUTSEAM C 4 
  

IPSLEEVE C 4 
  

IPADJAMT C 10 
  

IPADJCODE C 10 
  

 

PAYMENT TYPES 

"Cash" 

“Charge” 

"Gift Cert" 

"Check" 

"Bill Acct" 

"Remote Pmt" 

Order Processing 

Enter Confirmation Numbers 

Switchboard: Main->Enter Confirm Numbers 

Menu: Rental->Enter Confirm Numbers 

Action: CONF 

Overview 

This form is only available when the “Require confirmation numbers for orders?” option is 
checked on System/Store Setup - Rentals Tab.  
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This form is used to quickly assign confirmation numbers tor rental orders.  It is used by shop's 
that receive their orders from wholesalers (this feature is not used when the optional WinTPS is 
installed). Confirmation numbers are provided by the wholesaler when a rental order is placed.  

This form can be used as an electronic worksheet.  A user may enter confirmation numbers and 
wholesale cost for each order directly within the grid as each order is placed with the 
wholesaler.  Alternatively, the user may selectively print orders to be confirmed to use as a hard 
copy worksheet to place orders.  Some shops find it helpful to fax the hard copy worksheet to 
the wholesaler and let them fax it back with confirmation and costs, then use the Bulk Entry 
feature to quickly entered the confirmation numbers/costs into the WinTPOS system. 

A confirmation number may also be entered form the Rental Orders Form - Orders Tab for each 
order, a much slower, but effective method. 

 

Filter 

A filter will limit the orders displayed within the grid.  The available filter options are: 

Unconfirmed or Confirmed... Check only one.  Confirmed orders have a confirmation number 
assigned.  Unconfirmed DO NOT have a confirmation number assigned. 

Pickup Date Range... Enter the date range of when orders are to be picked up by the customer. 
 Leave both dates blank to include all pickup dates. 

Created date range... Enter the date range of when orders where created.  Leave both dates 
blank to include any created dates. 

Limit button... Click this button to execute the filter.  Only orders that match the filter will display 
in the grid. 

Clear button... Click this button to quickly clear the filter. 

 

Search 

The Search for field will search thru the orders displayed within the grid.  The data entered into 
the search field will look within the leftmost column.  By default the Customer name (last name) 
is the searchable column.  Double click the Event column heading or the Order Number 
column heading (both are bolded)  to search by either of those columns. 

 

Grid 

The grid lists the order number, customer name, event name (if any), order pickup date, 
confirmation number, cost and PRINT status. 

A user may quickly work the grid and enter confirmation numbers, vendor and wholesale cost 
for each order as the wholesaler provides you the information, example when the order is being 
phoned in..  Just click the confirmation number or cost cell of each order and type the value. 
 WinTPOS will prompt for the vendor as each order's confirmation number is entered. 

The user may select orders to print onto a hard copy worksheet (suitable for faxing to the 
wholesaler).  Click into the Print? cell of each order to mark it for printing.  It will display the word 
YES when properly marked for printing. 

Buttons 

Bulk Entry... This function displays a form, where the user supplies a order number, cost 
(optional, used when tracking cost is important), Vendor (optional, used when tracking 
vendor purchase volume is important) and confirmation number (required for order to 
change to a CONFIRMED status).  Vendor is selected from vendors entered into the 
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system via Housekeeping-> Inventory Setup-> Vendors.   The grid data has no effect on 
this function. 

Print All... Marks ALL orders within the grid for printing. 

Print none...Clears ALL orders within the grid from printing. 

View Ticket... Displays the customer ticket the rental order is linked to. 

View Customer... Displays the customer card the rental order is linked to. 

View Event... Displays the event registration the rental order is linked to (if any). 

View Order... Displays the selected rental order details, including styles and sizes. 

Print... Will print all orders marked for printing (PRINT? column contains a YES).  Suitable for 
hard copy worksheet or as a fax to the wholesaler.  Click Print, and WinTPOS will ask for 
a vendor selection.  This vendor will be assigned to the printed worksheet.  The vendor is 
selected from vendors entered into the system via Housekeeping-> Inventory Setup-> 
Vendors.   The report includes the order's quantity rented, store style, vendor style (as 
entered in inventory), size and any size notes for all items on the order. 

This report may be ran for CONFIRMED orders by selecting that mode in the filter.  This 
report would display the confirmation numbers and costs. 

OK... Exits the form and returns to the previous form.  It will discard edits if those edits have not 
been saved.  It will provide a warning prior to discarding edits. 

Save button...Save all edits to all orders.  Any orders with new confirmation numbers entered will 
be changed to status “Confirmed”, and the confirmation number will be saved to the 
order. 

 

Check-In Rental Order 

Switchboard: Main->Check-In Order  

Menu: Rental->Check-In Order 

Action: CHECKIN 

 

The Check-In order process is optional. 

This form is used to check-in orders as they arrive from the wholesale supplier or the in-house 
SC/Plant. The order being check in should have a status of “Shipped” or “Confirmed”, although 
you can check-in orders of any status.  

It is important to check-in orders for two primary reasons: 

1. Late orders can be identified and proper follow-up performed 

2. ID/Serial numbers may be optionally entered for each item on the order. This ID 
number capturing is optional, but a good idea for companies who receive their goods 
from a wholesaler. It allows fast order return by the ID number and provides better 
order management.  

3. Reports may be ran at the store to determine what orders are in & ready for customer 
pickup, as well as to identify a possible problem with a order that has not been 
received. 

The operator may enter the Order’s number (usually found on a picking slip accompanying the 
order or it’s production ticket and could be barcoded and thus scannable for fast entry) or 
Customer Number or Confirmation number to locate the order to be check in. 
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Order number...Enter the order number to check-in. If there are no orders of status “Confirmed” 
or “Shipped”, WinTPOS® will display a dialog “There is no information on file from which 
to select an item” 

Customer number...Enter the customer number. WinPOS® will display all the “Shipped”/ 
“Confirmed” orders for that customer so the correct one may be selected for check-in. 

Confirmation number...Enter the confirmation number for the order to check-in. 

Auto check-in...If checked, WinTPOS® will not display the order details within the two list boxes 
described below.  

Checked, the system will simply update the order’s status to “Received” and clear the form 
for entry of the next order number. This feature is utilized to bypass the steps of 1) Order 
check, verify items received against item’s ordered 2) do not want to enter the ID/Serial 
numbers of the items being received.  

Auto check-in should be checked by default when the production management module is 
installed. In either case, serial numbers are only required if the “Require serial numbers on 
order check-in?” option is checked on System/Store Setup - Rental Tab. 

This option is enabled by default if the “Automatically save order check-in?” option is 
checked on System/Store Setup - Rental Tab. 

Tracked items list...Once a order is selected WinTPOS® displays the tracked line items (Items 
defined in system as having ID/Serial numbers) in this list. You can optionally enter the 
ID/serial numbers for each item in this list box. 

Non-tracked items list... Once a order is selected, WinTPOS® displays the non-tracked line 
items in this list.  

Using both list boxes the operator should check the items shown against the order itself to find 
discrepancies before the customer does. 

Check-In button… Updates the order status “Received” and clears the tracked and non-tracked 
list so you can select another order. 

OK button...Exits from the screen and returns the operator to the previous screen. 

Pickup Rental Order 

Switchboard: Main->Pickup  

Menu: Rental->Pickup 

Action: PICKUP 

This form is used to mark orders as picked-up by customers and to receive payments for any 
remaining ticket balance.  

The orders must be status “Received” to be picked up. It is important to mark orders as "picked 
up" for three primary reasons: 1) The system can alert you to orders being returned late from 
customers 2) To insure the balance is paid prior to the customer taking the order 3) Late 
charges can automatically be added to customer tickets when the order is returned, if overdue. 

The operator can select one or more orders to pickup at the same time.  

When a customer number, event number, order number, or confirmation number is entered, 
WinPOS® automatically displays the rental order(s) in the upper list on the form associated to 
the number entered. Only orders of status Received are listed. 

The operator then selects the order(s) being picked up by highlight them. Multiple orders may 
be highlighted concurrently by holding the CTRL key on the keyboard and then highlighting the 
order and right clicking it with the mouse. Click the Add button once the order(s) are highlighted 
which will automatically move them to lower list.  
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A operator can then enter another ID number, select more orders, and click the Add button to 
add those orders to the lower list as well. Once the desired orders are in the ‘Orders to be 
Picked up” list box, click Save to change those orders status to “Picked Up.” 

Orders and their exchange orders (if any) being picked up with a balance will automatically be 
taken to the Ticket screen.  If more than one order is being pickup up, then the split-ticket 
payment form is shown to pay off the tickets. 

This allows the operator to enter the balance pay off. Orders should have a zero balance to be 
marked picked up. If an order does not have a zero balance, the user must have TAKEUNPAID 
security access to mark it picked up. 

A pickup receipt is printed if the “Print return receipts?” option is checked on the Rental tab of 
the System/Store Setup form. 

Fields 

Customer...Enter the customer number. If the customer has any orders of status “Received”, 
they are displayed in the upper list. 

Event...Enter the event number. If the event has any orders of status “Received”, they are 
displayed in the upper list. 

Order ...Enter the order number to check-in. The order is displayed in the upper list. 

Confirmation number ...Enter the confirmation number for the order to check-in. The order is 
displayed in the upper list 

Upper list...This list shows all the orders you have searched for, To pickup an order, move it to 
the lower list. Click Pickup All button to move all the orders to the lower list, or Pickup 
Selected button to move the highlighted one. Conversely, Un-Pickup Selected button 
will remove the highlighted order, and Un-Pickup All button will remove all of them. 

Lower list...This list shows the orders to be picked up. 

Pickup Orders  button...Changes the order statuses to Picked up of the selected orders. There 
is an option in System/Store Setup – Rental Tab, “Go to payment window on pickup” If 
checked, and the ticket for this rental has a balance, the user will be taken to the Enter 
Payments form to pay the ticket off. 

Return Rental Order 

Switchboard: Main->Return  

Menu: Rental->Return 

Action: RETURN 

This form is used to mark orders as returned for WinTPOS© retail customers. The order's status 
must be Received, Picked Up, Shipped, or Lost before it may be returned. Once an order is 
selected,  the rental items are displayed in the grid. A operator can check or un-check each item 
to indicate if it is present. 

The system can automatically print a customer return receipt, providing a receipt document to 
the customer listing the specific items returned during the session. This is a setup preference in 
Housekeeping->General Set up->System/Store Set up->Rental ‘Print Return Receipts’. 

If the customer has any balance at return time (either outstanding from the original rental, or 
from late fees, etc.) the Ticket form is automatically displayed after the items are returned. 

The system setting: System/Store Set-up->Rental Tab->Serial numbers must be scanned for 
Return? controls the exact behavior of this form.  With this option: 

SET/Checked, forces a operator to scan/enter all tracked inventory serial/ID numbers to 
return. 
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Entering a Order #, Customer or Event displays all items on the order.  Scanning a serial ID 
number will return & display that tracked item only and display other Non-Tracked items on 
the order. 

Scanning a serial ID number will return that tracked item and all the non-tracked items that 
were on the order.  The user cannot manually check the Present? box for any other tracked 
item that may show on the order.  A tracked item's Serial/ID number must be entered for it 
to be marked present. 

 

UnSet/UnChecked, Entering a Order #, selecting a Customer or Event or entering/scanning 
a Serial/ID number of any item on a order displays all items on the order.  Once the order's 
items are displayed the operator may indicate which items are Present? by checking the 
Present? box next to each item.   

Any items NOT checked as Present? will be marked as LOST. 

If an item is marked Present,  the status is changed to the status specified for “Return order to” 
on the Stores form-Rental Tab for the store actually performing the return. It can be Returned, 
Shipped Back, Laundry, Wait Laundry, or Done.  

Lost Items 

Items on an order are marked LOST when the order is returned on or after it's DUE DATE and 
the operator does not check off or does not scan the barcode of the items that are present.  If 
they are left unchecked/unscanned the order's line items not indicated as RETURNED are 
marked with a LOST status on the order, the inventory item is marked LOST.  Later if the LOST 
item is returned past it's due date, a late fee will be added to the ticket based upon the system 
settings. 

Returning that order again via the POS return will update an item's LOST status if eventually 
returned.  Late fess will be charge if the return is past the order's return date. 

As items are marked to Lost, a sale transaction for style code “LOST ITEM” is added to the 
ticket and the sales price is set to the replacement cost entered in inventory of the item lost. 
This is charging the customer for the lost item. When the customer returns the item (hopefully 
they do), the charge on the ticket may be manually adjusted and canceled by the operator. 

With the optional WinTPS© Plant Management module installed the system will also mark the 
LOST item to UNAVAILABLE for renting in the inventory system and assign it the LOST status. 
 This step removes the item from the available number of items to be rented.  Conversely 
when/if the item is returned, the inventory AVAILABLE setting will be automatically checked by 
the system and the LOST status will be removed. 

During the WinTPS Production (when installed) Assembly when a item marked LOST is 
scanned onto a new order the system also checks the inventory status and clears it and makes 
sure it is set to available for rental.  The assemble also checks the orders and will change the 
STATUS to DONE if not already set, except for a order with a status of LOST.  It skips lost as a 
reminder that the order was returned lost.   

 

Late Fees 

If an item is returned late, and the late fee method is set to Retn (set in System/Store Setup – 
Rental Tab) WinPOS® computes a late fee as the daily late fee charge for the item type (on the 
Item Type form) times the number of days late.  

If the late fee is set to Daily, then the late fee is computed when the entire order is returned, and 
is the total number of days late times the daily late fee, as set in System/Store Setup – Rental 
Tab) 
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Late fees are Sales transactions with a SKU “Late Fee” and are automatically entered onto the 
order’s ticket for the customer to pay. Of course a Late Fee may be manually adjusted as any 
other sales transaction. The SA on the original RENTAL transaction will be automatically 
entered on the LATE sale transaction. 

 

No Shows 

Occasionally, rental orders are placed and the customer does not pick it up.  WinPOS© will tag 
those orders as NO SHOW.  The operator would simply return the order via this WinTPOS© 
form from the main menu.  Since the order status would be RECEIVED, WinTPOS© would mark 
the order as a NO SHOW order.  The operator may want to adjust the ticket balance down to 
zero (done by visiting the ticket & creating an adjustment).  NO SHOW would be displayed on 
the Orders ->Order Tab underneath the order status.  In addition the Orders Report and Rental 
Pricing report provide options to list NO SHOW orders. 

Once a order is a No Show, a financial decision has to be made concerning the charges made 
to the customer's ticket for that rental.   

1. Should the customer be forced to pay for the rental?  If this is the policy then nothing 
has to be done to the ticket. 

2. Should the customer lose any percentage of a partial payment made onto the ticket for 
that order and be forgiven for any remaining balance?  If YES, then adjust the rental 
charge down to the amount the customer would be responsible for.  If the payments on 
the ticket equal that amount you are done.  However, give a refund for the partial 
payment paid that exceeds amount the customer is responsible for.  Ultimately, the 
ticket balance must equal zero.   

3. Should the customer lose only the SECURITY DEPOSIT placed on the ticket for the 
order?  If YES, Adjust & Cancel the rental charge,  the system will display a message 
that the order cannot be cancelled.  That is OK, just click OK/Yes to the message, 
Refund any partial payments made and FORFEIT the security deposit paid. Tickets 
may also contain a DAMAGE WAIVER sale transaction and if so, this charge should be 
adjusted/ cancelled as well.   The idea is for all charges related the rental order to be 
adjusted to the proper amount and to force the ticket balance to zero. 

Fields 

Serial number...Enter the ID/serial number of an item to be returned. All of the rental items on 
that order will be displayed. This only works when the ID/Serial number was captured at 
check in or when the Rental Production module is installed and ID numbers used. 

Order number...Enter the actual order number being returned. 

Customer number...Enter the customer number. If the customer has any orders of status 
“Picked Up”, they are displayed in the upper list.  

Confirmation number...Enter the confirmation number that was assigned to the order . The 
system will display the order that has that confirmation number assigned.  If more than 
one order has the same confirmation number the system will allow the operator to choose 
a single order. 

Event number...Enter the event number. All the orders for that event will be displayed so you can 
select the correct one. 

Item list...WinPOS® displays all the rental items on the selected order. Check Present? for the 
items being returned, leave it unchecked for the items that are missing. 

Check All button...Will check the Present? flag for all items. A shortcut for fast entry. 

Un-Check All button… Will UNcheck the Present? flag for all items.  
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Save button...Updates the items status to “Returned”.  If the customer has a balance the 
customer's ticket will be automatically displayed. 

 

Ship Back Rental Order 

Switchboard: Main->Ship Back  

Menu: Rental->Ship Back 

Action: SHIPBACK 

This form is used to mark orders as shipped back to the supplier or SC/Plant. This form is only 
available when the “Automatically ship back orders on return” flag is unchecked in System/Store 
Setup – Rental Tab. 

Orders list...WinPOS® displays all the orders of status “Returned”. The operator would check or 
uncheck the Ship check box to indicate if the order is being shipped back or not. 

Check All button...Checks the Ship check box for all orders. 

Uncheck All button ...Un-checks the Ship check box for all orders. 

Ok button...Updates the order statuses to “Shipped Back” 

Report & Support Data 

Item Types 

Switchboard: Main->Housekeeping->Inventory Setup->Item Types  

Menu: Setup->Rental Inventory->Item Types 

Action: ITEMTYPE 

 

Overview 

Item Type is a classification of rental items.  Examples are COAT, PANT, SHIRT, VEST  .etc. 
 Each type may have characteristics that will determine how processed during order entry, 
production and reporting.  The simple presence of an Item Type on a inventor style indicates to 
the software that is a rental inventory style and allows for additional rental information to be 
added, as rental prices, replacement cost and bar-ode serial numbers (it it a tracked item type) 

The Item Type maintenance form allows a user to defined types and their characteristics. Item 
Types indicate to the system how to process rental inventory styles. Item Types are also utilized 
for event rental member registration, inventory, order entry, order returning, production ticket 
printing and rental order reporting.   A item type of COAT is REQUIRED by the system to 
determine with or without coat pricing. 

Fields 

Type description...A unique code for this item type.  One item type of COAT is required. 

Late fee...The daily late fee for this item. Charged at return time if the item is overdue, and the 
Late fee method is Daily in System/Store Setup – Rentals Tab. 

Accessory? (checkbox)...Is this item an accessory? Checked means YES. Used by rental order 
price reports and the package pricing module. 

Tracked? (checkbox)...Should this type item be required to be assigned a ID/serial number? If 
checked, WinPOS® will required the entry of inventory ID/serial numbers (when 
Production Management is installed). See rental inventory for more information. Bar-
codes may be used for order assembly,  return from customers or laundry. 
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Companies who receive orders from a wholesale supplier will use this option to allow 
ID/Serial numbers to be optionally assigned to the inventory of these type items entered on 
orders when they are assembled.  

Adjustable? (checkbox)...When enabled, a operator will be allowed to enter an adjustment code 
on a rental order for each item.  This is a tool to the service center to indicate if the size 
entered can substituted to a different size if needed. If checked, WinPOS® will allow the 
user to specify Up/Down/None on the Order form as a suggestion for substitution. 

Disabled, the system will not allow for a adjust code to be entered  

 

Line number...Line numbers are utilized within two WinTPOS/TPS forms. 1) The Events – Rental 
Tab-> Register Members button. 2) The Order Entry - Items tab and may be used in fixed 
format production tickets. 

This line number is the actual order in which the type will appear on the order form. For 
example, line item 1 will appear on the first line of the order. These numbers should be 
unique. In other words there should only be one 1 entered among all other item types.  

Item types with a blank or zero are allowed. Item types with blank & zero line numbers will 
not display on the event register members form or within the rental order entry grid. 
However, order entry will allow styles assigned to the item types to be entered when the 
System Set-up - Rental Tab ‘Allow additional items to be added to fix format rental orders’ is 
checked. 

Size caption...You can specify an alternate caption/Label for the size field for this item type on 
the Orders form. When the size is being entered for a style with this Item Type assigned, 
WinPOS® will display the caption entered here instead of the standard caption “Size” . 

Auto-Launder item?…This setting is used by the optional WinTPS® software module. When a 
style of this item type is returned from a customer, it will automatically be marked for 
laundry and be set to a WAIT LAUNDRY status. 

System defined?...If checked, this is a system defined item type. WinPOS® requires certain item 
types to operate correctly. If this is checked WinPOS® limits the changes you can make 
to this item type. They should not be Deleted! 

Requires a Dash-Size?... Enabled will force the user to enter a dash in the size on the order 
entry form for this item type.  The DASH within a size is a tool to provide additional size 
information to the service center.  Typically, for example, with item type PANT the service 
center may require the outseam to be included with the size, a DASH may be used to 
accomplish this task, i.e. 34R-37.  WinPOS validates the size to the left of the dash 
against the sizes found within the inventory.  It does NOT validate the size information to 
the right of the dash, thus allowing any information.  The maximum length for a size is 7 
alphanumeric characters.  Due to this limited space the Order Entry form also allows a 
reference for each style on the order with up to 20 alphanumeric characters.  In addition, 
each order has a spot for production notes where additional order details may be 
entered. 

Print pick tickets separately?...Indicates that this is a "special" item type.  If checked, styles of 
this item type will not automatically be included on picking tickets.  On the picking ticket 
print form there is a checkbox, "Include "special" item types?"  If this is left unchecked, 
then the pick tickets will not include these item types.  If checked, they will.  This is used 
for special item types, such as top hats or canes, that are not normally picked with the 
rest of the rental order.  

Event Types 

Switchboard: Main->Housekeeping->General Setup->Event Types  

Menu: Setup->General Setup->Event Types 
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Action: EVT_TYPE 

Wedding, school, and social are event types. The term “event” refers generically to an event 
that occurs on a specific date. Events also has members. Members are customers who are 
purchasing or renting items. The event become the method to access those customers & their 
purchases in an efficient method.   

Fields 

Event type...A unique descriptive name for the event type. 

Pre-days...When automatically computing the pickup date, subtract this many days from the 
event date.  Used with option WinTPS© & WTPOS© modules 

Post-days...When automatically computing the return date, add this many days to the event 
date.Used with option WinTPS© & WTPOS© modules. 

Allow Overbook (checkbox)?...Set the default rental order Overbook permission on new orders. 
  When checked, operators may over book rental inventory.  Use in conjunction with the 
System Setup->Rental Tab->Force rental orders option enabled by default?.   

Like a... A drop down selection box used when adding a new event type.  It must mimic the event 
registration form behavior of one of  the default system event types of Wedding, School 
or Social.  Each of these formats the Event form in it's unique way.  Add a new event 
using each one of these event types to see the formatting differences. 

Order Types 

Switchboard: Main->Housekeeping->General Setup->Order Types  

Menu: Setup->Rental Setup->Order Types  

Action: ORDERTYP 
 

Used in the WinTPS® or WinTPOS® optional software modules. This form allows new Order 
Types to be created or modified. The Formalwear type is a system required type & should not 
be deleted. 

Order types are used by the Orders form to group like kinds of orders within reports. The order 
type also controls which accounting class is used to account for the deposits/AR, sales taxes 
and revenue for a rental order via the WinPOS® revenue report. 

The default Order Types included with WinPOS® are are Gown & Formalwear for retail pricing.  

WinPOS® will default to the Formalwear type for the Pickup/Receiving store/account’s (enter in 
the Pickup store field of the rental order) pricing type for all new orders.  

Fields 

Order type...A unique descriptive name for the order type. 

Accounting class...The revenue WinPOS®/GL account number, deposits GL account number, 
etc. from this accounting class will be used for rentals of this type. 

For account type…Controls which order types are available for entry on an order. 
Stores/Accounts may be assigned one of two available pricing/types. Retail or with the 
optional WinTPS production management module with wholesale support, Wholesale. 
This is accomplished in the the Store/Account form.  

 Left Blank: both Retail & Wholesale account types can see the order type. 

 Retail: only retail account types can can see the order type. 

 Wholesale: only wholesale account types can can see the order type. 
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System defined?...If this is checked this is an order type used by WinPOS® that cannot be 
edited. 

Size Conversions 

Switchboard: Main->Housekeeping->Rental Setup->Size Conversions  

Menu: Setup->Rental Inventory->Size Conversions 

Action: SIZECONV 

The Size Conversion feature utilizes conversion definition tables that will allow the system to 
convert a customer’s measurements entered on a rental order into a size code that will match 
the size code entered in the inventory. 

It is easier & less error prone for most operators to enter in size measurements on orders. 
However, in most rental warehouses it is simplier to utlize size codes on rental inventory. The 
conversion feature is designed to convert measurements into size codes. 

A size conversion will automatically convert one notation into another notation. A Rental style 
must be assigned a size conversion table for it to be used during order entry.  

The name(s) of the tables must be entered on the Inventory - Rental Tab form for a specific 
style code. Conversions can convert a size as a whole, or ones that convert the left and right 
sides of a size separately (left & right sides are separated by a hyphen). 

See How to enter exact measurements for more information. 

Some examples: 
 

A conversion table called CoatSize 

Min  Max  Convert To 

20 25 A 

26 30 B 

31 35 C 

36 40 D 

A coat size of 21 would be converted to A. A coat size of 31 is converted to C. 
 

Assume now you have a two conversions 

PantWaist 

Min Max  Convert to 

20 30  1 

31 40  2 

41 50  3 
 

PantOutseam 

Min Max  Convert to 

20 30  A 

31 40  B 

41 50  C 
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And a style code in inventory uses PantWaist for it’s left side conversion, and PantOutseam for 
it’s right side conversion. 

Measurements entered of 21-32 would become 1B. Measurements of 42-30 would become 3A. 
 

Conversion name...A unique descriptive name for the conversion. 

Conversion list...Each entry in this list specifies a minimum and maximum value, and what to 
convert to.  

If the size falls in the min, max range specified, it is converted to the specified value assigned to 
the range. Don’t overlap the ranges, if you do, WinPOS® will use the first range it finds.  

The values must be numeric and the measurements to be converted must be numeric also. 

To add a new range, click the Add Item button. A blank entry will appear at the end of the list. 
Click on the blank entry and enter the min, max, and convert to value. To remove a 
range, select the range in the list and click Delete Item. 

Catalog Codes 

Switchboard: Main->Housekeeping->Inventory Setup->Catalog Codes  

Menu: Setup->Rental Inventory->Catalog Codes 

Action: CATALOG 
 

Optional WinTPOS rental point of sale or WinTPS production management system feature. 

Catalog codes provide a convenient way to create common order packages easily (also called 
‘As Pictured’). You first create a unique catalog code (cannot be the same code as any other 
style or catalog code), then specify the rentable style codes that comprise the code.  

Catalog codes may be used for retail customers. It may also be used with wholesale accounts 
when the Rental Production Management module (WinTPS©) is installed. 

A user may enter the catalog code on a order at the style prompt. WinPOS© will recognize the 
code as a catalog code and automatically enter ALL the styles that comprise the code onto the 
order. The system will list the original prices for each style and finally apply a discount, if the 
catalog price entered during the catalog code entry is less than the sum of the individual style 
prices. 

Catalog Code prices are strictly enforced by the system.  The Catalog price will override any 
price group discounts (if they are used). 

A catalog code may be specified for an event when creating the event. Once specified 
WinPOS® will ask to use the catalog code when creating member’s orders. Catalog Codes are 
a data entry tool that speeds up order creation drastically! 

The Catalog Code price may be set by store when using BBL’s optional MultiStore software 
module or the optional WinTPS© wholesale module . This pricing feature allows management to 
set code prices on a store by store basis. The View/Change Base Price button displays the 
standard package price, and the Store Pricing button lets the user set the pricing for specific 
store. If a store specific price is not set, the base price for the code will be utilized. If the catalog 
code price is zero, then the order price will be zero if the catalog code is used. 
 
Catalog codes cannot have the same code as any style codes within inventory. 
 

Fields 

Catalog code...A short, unique code. 

Description...A longer descriptive name for this catalog code. 
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Style list...The list of styles that make up this catalog code. To add a new style code, click the 
Add Item button. A blank entry will appear at the end of the list. Click on the blank entry 
and enter the style code. To remove a style code, select the style code in the list and 
click Delete Item button. 

• Style: The style code from rental inventory. You can look up a style code byslecting 
the style cell &  pressing F2. 

• Description: The description from retail inventory. 

Buttons 

Click the View/Change Base price button to enter a retail and wholesale base price for the 
package.  

The Catalog Code price may be set by store when using BBL’s MultiStore software module. 
This pricing feature allows management to set prices on a store by store basis. The 
View/Change Base Price button displays the standard package price, and the Store 
Pricing button lets the user set the pricing for a specific store. If a store specific price is not 
set, the base price for the code will be utilized. 

 

Auto Size Suggestion 

Switchboard: Main->Housekeeping->Rental Setup->Auto Size Suggestion  

Menu: Setup->Rental Inventory->Auto Size Suggesion 

Action: AUTOSIZE 

Auto-sizing is used during wholesale rental order entry so that WinTPS© can suggest a size for 
each style entered on the order based upon the customers height and weight.  This feature is 
available for orders placed for wholesale accounts via the Store/Account form. 

Usually the weight is an indication of girth/size, for example with a coat, weight could indicate 
size of 46 and the height would indicate length, for example L for long. 

Height/Weight suggestion tables are set-up  for each item type to trigger WinTPS© to suggest a 
size. First, enter the Minimum weight or height and Maximum weight or height that corresponds 
to a Low, Normal, and High size range for the height weight combination entered on an order. 
 Any Weight or Height that equals the Min or Max values or falls between the two will default to 
that row's low/normal/high size. 

   

Note:  The Min or Max values entered should not overlap or equal any other row's Min or 
Max value.  Also, sizes do not have to be real sizes, they made be codes or numerical 
numbers.  Because once the system suggests a size it will then perform a size conversion 
which could take a size code & convert into a more meaningful size.  Some size 
converstions may dictate the need for a size conversion. 

Inventory styles will default to the Normal size specified unless a different Size Suggestion has 
been selected for the inventory item on the Rental tab of the Inventory form. Some items do not 
run true and will be either smaller or larger in size, thus it must be indicated on the style to use 
the LOW or HIGH size instead of the normal (default) size. 

 

 

Fields 

Height/Weight....The auto-size table will apply to either height or weight so select the one you 
wish to edit/review. 

Item type....Select the item type the table applies to. 
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Height/Weight Size Table...A list of height/weight ranges. For each range, specify the correct 
size for Min, Normal, and Max. To add a new row, click the Add Item button. A blank 
entry will appear at the end of the list. Click on the blank entry and enter the details. To 
remove a row, select the row in the list and click Delete Item button. 

• Min size: The size code to use if the Size Suggestion for the inventory item is set to 
Low. 

• Normal size: The size code to use if the Size Suggestion is not set, or set to Normal. 

• Max size: The size code to use if the Size Suggestion for the inventory item is set to 
High. 

• Min: The minimum height/weight. 

• Max: The maximum height/weight 

Package Pricing for Rental Orders 

 

Introduction 

This is a WinTPS® & WinTPOS® feature only. 

Package pricing is a marketing tool to provide package rental order pricing to the rental 
operation for their retail stores and wholesale accounts.  Typically the package would cost less 
than "a la cart" pricing, i.e per rental style.   

Package pricing is good tool to attempt to up sale customers on more expensive rental items 
and/or as special price incentives to drive them to the store.  Advertised promotions and/or 
coupons can be a great motivator to drive customers to the store and to request the special 
pricing.  When the customer asks for the special priced packages, the clerk can simply apply the 
package to a new or existing rental order from the order entry form.  Package pricing codes 
requires frequent updating to insure it is in step with the current active promotions.  This tool 
makes it easy for clerks to get the pricing correct! 

Catalog Codes (as pictured codes)  is another simple type of Package Pricing but cannot handle 
complex rental style combinations.  A good practice is to NOT use Catalog Code discounts and 
Group Package pricing on the same order.  Catalog Code markdowns are applied to the rental 
order and remain unless manually removed by the clerk.  If both are used the rental order price 
may be too low. 

Group Package Pricing is NOT required for rental orders.  Many companies pricing 
requirements are satisfied with the WinTPS/TPOS standard with coat or without coat pricing 
found in inventory setup. 

Package Pricing is accomplished by creating Price Group codes for coats and accessories, 
each with a retail and optional wholesale (used with WinTPS optional Accounts Receivable 
module)  package price.  Once created, accessory price group codes are linked to coat price 
group codes   Finally, the Package Pricing codes are assigned to their appropriate inventory 
rental styles.  Rental accessory styles must be classified as ACCESSORY rental item types 
before they can be linked to an accessory price group.  This is accomplished via the Item Type 
form. 

Package Pricing works hand in hand with the style's price with coat and price without coat 
inventory rental pricing.  By default the order is created utilizing the standard pricing.  An 
operator may choose to apply a package price to the order by checking the Apply Package 
Price checkbox found on the Order-> Items tab.  (Package Pricing may be removed as well by 
un-checking the box). When checked the  per item rental price displayed on the order 
dynamically adjusts to reflect the package price. 

Any changes to rental order pricing after the order is initially created results in an adjustment 
transaction being automatically placed upon the order's ticket.  Toggling the order's Package 
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Pricing setting after the order is saved will activate the order change logging when it is enabled 
within System settings-> rental tab-> Keep Order Change History. 

A coat must be on the order with a package price code assigned to have access to any special 
package pricing.  Steps to implement: 

1) Create Coat Package price group codes with retail/wholesale prices.  Any coat style linked to 
the code will be rented for the entered price when the package is applied on the rental order. 

2) Create Accessory Package price group codes with prices.  Each accessory style linked to the 
Accessory code will be rented for the entered price when the package is applied on the rental. 
 Mixed item types, ie pants, shirts, vest, ties ..etc may be linked to the same accessory package 
code.  Usually accessory styles of the same type, ie vests are linked to a particular Accessory 
Package Code. 

3)  Link Accessory Package price group codes to Coat package codes.  A Coat Package code 
may have multiple accessory codes linked.  ie SPG12SHOEG,  SPG12VESTG 

4) Assign the appropriate COAT or ACCESSORY Package Price Group Code to each style (a 
style is NOT required to have a price group code assigned) 

5)  Each COAT or ACCESSORY package price code has it's standard default retail/wholesale 
price, but as an option each may have store specific pricing as well.  Example, a store located in 
a more affluent area may have higher package pricing than the rest of the store since prices 
may not be as sensitive.  Create store specific pricing as necessary. 

6) Create rental orders and check the Apply Package Price checkbox found on the order entry 
form to apply the package price. 

The Package Price Group price applied, i.e. Retail or Wholesale) is determined by the Pickup 
Location assigned to the rental order and it's Pricing/Type setting, Wholesale or Retail, in the 
 Store/Accounts form.  

Group Package Pricing allows for many combinations.   

Tip 

Start with writing down your rental order pricing strategy.  Price packages may not be 
required for your needs.  Do NOT include references to the codes package  price within it's 
name. Pricing may change and you would not want to create new codes for the new prices. 
 This way when prices for packages change the code name will not have to change too. 

Coat and Accessory price codes must be unique.  They cannot have the same name.   

A accessory style or coat style can only be assigned to one Package Price code at a time.  It 
can be changed, but only one is allowed per style.  

 

Example Package Codes 

 Example Package Price Code used on styles and orders 

   

Coat  

Price 
Group 

Code 

Accessory  

Price 
Group 
Code 
linked 

to the coat 
code 

Package 
price 

Retail or 
Wholesale 

Code 
Type 

COATTIER1  $124 Coat 
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 ACCBASIC $0 Accessory 

COATTIER2  $149 Coat 

 ACCSHOE $5 Accessory 

 ACCBASIC $0 Accessory 

COATTIER3  $179 Coat 

 ACCSHOE $5 Accessory 

 ACCVEST $0 Accessory 

 ACCPLAT $5 Accessory 

 

 

Example application of Codes to Inventory Rental Styles 

 

Styles Price 
Group 

Price 
assigned 
to 
Package 
code 

Style's 
Standard 

 Inventory 
Price 
w/coat 

Style's 
Standard 
Inventory 
Price 
without 
coat 

COAT 
STYLES 

    

C100 COATTIER1 $124 $110 $0 

C110 COATTIER2 $149 $135 $0 

C120 COATTIER3 $179 $150 $0 

C130   $140 $0 

     

SHIRT 
STYLES 

    

S100 ACCBASIC $0 $0 $10 

S105 ACCPLAT $0 $5 $15 

S110   $10 $25 

     

PANT 
STYLES 

    

P100   $0 $15 

     

VEST 
STYLES 

    



Optional  Modules 

523 

V100 ACCBASIC $0 $25 $30 

V110 ACCVEST  $35 $45 

     

SHOE 
STYLES 

    

H100 ACCSHOE $5 $25 $30 

H110   $30 $35 

     

 

Package Pricing Applied to orders 

 

Styles Package 
Code 

Package 
Price 

Standard 
Pricing 
(No 
package 
price 
applied) 

Order 
1 

   

C100 COATTIER1 $124 $110 

S100 ACCBASIC $0 $0 

P100  $0 $0 

V100 ACCBASIC $0 $25 

H100  $25 $25 

  $149 $160 

Order 
2 

   

C110 COATTIER2 $149 $135 

S105  $5 $5 

P100  $0 $0 

V100 ACCBASIC $0 $25 

H100 ACCSHOE $5 $25 

  $159 $190 

Order 
3 

   

C120 COATTIER3 $179 $150 

S105 ACCTPLAT $5 $5 
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P100  $0 $0 

V110 ACCVEST $0 $35 

H100 ACCSHOE $5 $25 

  $189 $215 

Order 
4 

   

S100  N/A $10 

V110  N/A $45 

H100  N/A $30 

   $85 

 

Rental - Production 

Rental Production Overview 
 

The Windows Point of Sale (WinPOS™) Reservation Production module known as Tuxedo 
Profit System (WinTPS®) is designed to manage the reservation & production of rental 
items/garments.  It is important to note that this system can reserve inventory on a day by day 
basis instead of a week by week period. 

The software can easily support company owned rental stores providing ‘real time’ rental item 
availability. Wholesale account support is also available via the optional Accounts 
Receivable/Invoicing module. 

WinTPS™ can provide real-time item availability for any day in the future. Day basis reservation 
is defined as follows: An order’s items will be reserved against inventory for the exact number of 
days needed. Unlike other reservation systems which reserve items for a week and allow only 
52 rental opportunities, day base reservation can allow more rental turns by providing 365 
possible rentals. 

The software allows an operator to know the status & availability of any rental inventory item, to 
create and edit records of rental orders via a retail Point of Sale ticket or Rental Order Entry 
Module, to manage the production/assembly, location, sub-renting and laundry status of 
inventory. Numerous reports are offered for tracking rented and sub-rented items, receivables, 
current orders, inventory, etc. 

WinTPS© can reserve specific items for any day of any year, and will tell you when items are 
overbooked. Inventory can be controlled to the specific item level via the utilization of item 
Serial/ID numbers. Also, inventory items may be non-tracked eliminating a scanning 
requirement, yet WinTPS™ will maintain their availability also. 

Production tickets may be printed on laser printers or thermal printers. 

Knowing the performance of the rental inventory is very important.  This information allows 
decisions to be made when a garment should be retired, when more quantity should be 
purchased and how well the investment has preformed.  This is accomplished via the tracking of 
turns (the number of times the item has been sent out) & revenue (value of the orders the 
garment was assigned to).  Turns & revenue are incremented automatically by WinTPS©.  For 
orders going to  non Company owned stores, the turns/revenue are incremented when the item 
is SHIPPED.  For company owned stores (Company owned  stores are entered with the 
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WinPOS© Multi-Store option via the System Set-up form) turns/revenue are updated when the 
order is PICKED UP by the customer. 

 

Rental Production Diagram 
 
 

 
 
 

The primary process steps for production management are: 
 

A) Enter reservation order via WinTPOS Point of Sale or within the Production Order entry 
module 
 

B) Order/sub-rent overbooked items by use date range via reviewing the on screen report of 
overbooked items, then indicating to the computer that they have been ordered and from 
whom. 
 

C) Receive Sub-Rented Inventory 
 

D) Print Production tickets for period and/or location 
 

E) Assemble orders. Scan barcodes of tracked items during QC. 
 

D) Ship rental order to account/remote store by entering/scanning orders being shipped. 
 

F) Print Packing Slips and/or Invoice 
 

G) Return rental items from account/remote store by scanning all item barcodes or entering 
order number. 
 

H) Send to laundry dirty items 
 

I) Return items from laundry 

Getting Started 
 



WinPOS Version 11 

526 

BBL has provided some basic default information to speed setup.  Please review & modify to fit 
your business needs.  The first time Start-Up steps for WinTPS© Production Management are 
listed here: 
 

* Enter System General Set-Up data. WinTPS provides options to customize how some features 
work. Enter your preferences in the System Setup module. 

 Hint:  

WinTPS offers three types of Order Entry screen formats.  

 

Free Format provides a BLANK order entry screen. The data entry operator will be able to enter 
rental items on a order in any combination. Multiple items of the same type are allowed on the 
order. To utilize this order entry method assign 00 to the line numbers of each Item Type and 
enable System Set-up->Rental Tab->’Allow additional Items to be added to fix format rental 
orders’. 

Fixed Format allows the rental “Item Types” to be also used as prompts on the screen for the 
operator. A entry slot tagged by a item type only permits that type of item to be entered. This 
allows the owner to control the order in which items are entered and useful as a reminder of 
items omitted from the order. As a option, additional rental items can be added to the order in a 
free format method also. This allows multiple like item types to be added to the same order as 
multiple shirts or pants. To utilize this order entry method assign a number (01,02,03 ..etc) to 
the line numbers of each Item Type and disablee System Set-up->Rental Tab->’Allow additional 
Items to be added to fix format rental orders’. 

Mixed Format allows Item Types to be utilized as prompts on the order entry screen. After the 
last item type prompt operators may enter additional rental items in any order. Duplicate item 
types are allowed. To utilize this order entry method assign a number (01,02,03 ..etc) to each 
line numbers of the Item Type that will be used as prompts on the order entry screen. Assign 00 
to those item types that should not display as prompts and enable System Set-up->Rental Tab-
>’Allow additional Items to be added to fix format rental orders’. 
 

 * Enter rental Item Types. WinTPS and/or WinTPOS allows the owner to customize the types of 
items rented and their description. Review those included and modify as needed. This is 
accomplished in the Item Type maintenance module. 

 * Enter non business days (optional), i.e. the days a location is closed. This allows for a more 
accurate reservation when the system knows what days the operation is closed and thus not 
able to ship or receive rentals. 

 * Size Conversion charts (optional). This advanced feature allows operators to enter the actual 
customer measurements items rented. The system will automatically convert the measurements 
into a size to match the size code entered into the computer’s inventory. For example a operator 
could enter pant measurements of 40 waist, 38 out-seam (40-38) and the computer could 
automatically convert it to a 40R. Without size conversion the operator would simply enter the 
item’s actual size as it is entered within the inventory. 

* Inventory Item status. WinTPS allows for user defined inventory item statuses. These 
descriptive statuses will be given to inventory items by an operator from time to time and 
reported upon, REPAIR, DISPLAY, LOST are examples of inventory item statuses. 

* Create Size Charts for Rental items. WinTPS utilizes size charts to quickly create the size 
scales within rental inventory. The user should create the size chart for the type of item, i.e. 
coats, pants, shirtsOdd, shirteven, shirtexact ..etc, then when an inventory style is added, 
assign the proper size chart to it. Finally on the Inventory Rental Tab select Create Sizes from 
chart button to add the size scale to inventory from the chart. 



Optional  Modules 

527 

 * Enter/Assign Rental Inventory Any style created within the inventory system may be selected 
as a rentable style. Once a style is selected as rentable, by assigning an item type to the item 
on the inventory Rental Tab, the manager must indicate the maximum quantity available to rent 
and enter the id numbers/bar-codes of the tracked rental inventory that will utilize them. Not all 
item types have to be tracked with a barcode. This is determined by the Item Types defined/set-
up in an earlier step. BBL recommends that each rental item entered within the inventory be 
assigned a meaningful code, for example: LWCT001R. Which could translate to Lord West, 
Coat, their number 001, rental. 

 * Create Default Shipping Methods. This is easy particularly when your primary shipping 
method is a Van, however in some cases there may be a need for UPS, Fedex & others. Once 
the default shipping methods & ship times are created in Rental System Set-up the system will 
allow for exceptions on a per store/account bases. When stores/accounts are created just 
indicate any differences in shipping methods and/or times within the store/account form. 

 * Enter Stores/Accounts, remember to adjust Shipping Methods from the defaults if needed for 
each store’s setting within the Stores maintenance. 

 * Enter Suppliers for sub-renting. Accomplished within the Vendor File Maintenance module. 
This will allow a operator to assign a vendor to inventory being sub rented and lets operators 
know where to expect inventory to be delivered from and the amount of business being done 
with supplier. 

 * Create Rental Order Types. Order types allow operators to classify the type of rental order 
being taken at order entry. These types are user defined and can be utilize to analyze the 
amount and type of rental business being won. 

* Create Catalog (as pictured) Codes and other Special pricing strategies (optional). These 
advanced features allow for faster data entry, but is not required for operation. 

A catalog code lets the owner create a group of rental items (jacket, pants, tie and 
cummerbund, for example) under one code and to assign a package price to that code. A 
catalog code will be utilized by an operator at order entry to automatically fill the order with the 
styles & price previously entered with the catalog code as a means of FAST order entry.  

Price Group package pricing may be created for groups of rental items. Package names are 
created with the discount rules & pricing of the package. A package group may be assigned to 
any rental item.  This is an advanced feature & may be created at any future time. 

Each individual store/account may have rental pricing that is different from other store/accounts. 
This alternate pricing may be on the item and is setup via the inventory forms. Alternate pricing 
may be at the catalog/as pictured price level and is set up from the catalog maintenance screen. 

 Hint:  

Discounts may be manually applied to rental orders at anytime on the rental order entry screen. 
Catalog codes/pricing, individual store pricing and package discounts are optional. 
 

* Existing orders should be entered starting with the earliest week. All new orders being placed 
should be input directly into the WinTPS/TPOS system while new orders are being entered in 
real time. 

Production Concepts 

Order Item STATUS 
 

Items on a rental order are automatically given a STATUS description as they are processed 
thru the software. The Rental Order will also display a STATUS description which is derived 
from the status of the items on that order. The order’s status will always reflect the status of the 
item that is the earliest in the production process.  
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Hint: For example, assume an order contains two rental items. Item #1 has been processed 
thru Assembly/QC and has a status of WAIT SHIP, item #2 has a status of IN ASSEMBLY. 
The Order’s status will be IN ASSEMBLY since that status is ‘earlier’ in the production cycle 
than WAIT SHIP. 
 

Item/Order Status will be auto assigned a STATUS as orders and items are created in the 
WinTPS system. The STATUS will change as the items are processed within the production 
software modules. The STATUS becomes a fast & easy method to learn where an item is, i.e. 
Waiting on assembly, In Assembly, In Laundry and DONE (Done = item returned from 
customer/account and thru laundry) are example statuses. 

 

The STATUS may be seen on the screen by simply recalling the order within an order entry 
form. Order item STATUS may also be reviewed via reports and screen forms. The order 
STATUS tracking feature is invaluable in managing the production cycle. 
 

Order 
Status 

Description (WinTPS = 
Production WinTPOS = 
Point of Sale) 

Missing 
size(s 

WinTPS or WinTPOS 
status. Order has one or 
more items that do not have 
sizes entered 

Wait for 
confirm 

WinTPS or WinTPOS order 
that contains one or more 
items of this status. 
Happens when the style and 
size have been entered, but 
the order has not been 
saved. Once the order is 
saved the order & items 
become Confirmed 

Confirmed WinTPS or WinTPOS Order 
has been saved with each 
item on order containing a 
size 

In 
Assembly 

WinTPS status that a 
production ticket has been 
printed for the order 

Wait Ship WinTPS status indicating all 
the items on the order have 
been processed thru 
assembly/Quality Control 

Shipped The order has been marked 
shipped thru WinTPS 
module 

Received WinTPOS Optional step. 
Status of order has been 
marked received at a POS 
location 
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Picked up WinTPOS status of order 
once marked/processed as 
picked up by customer at a 
store 

Returned WinTPOS status. The order 
has been marked received 
from the POS customer 

Shipped 
Back 

Optional Step. WinTPOS 
Order marked as being 
shipped from store to 
production warehouse  

Wait 
Laundry 

WinTPS Optional Step. 
Status of order when all 
items have been 
received/returned from 
remote locations. The status 
can automatically be set at 
return time based upon the 
‘Item Type’ set ups. Also a 
item may be manually set to 
be cleaned 

Laundry WinTPS Optional Step: User 
marks/processes items to 
cleaner.  

Lost WinTPS status that order 
has been marked lost 

Cancelled The order is cancelled. 

Done Final order status that every 
item has been returned from 
the account/store and 
returned from (optional) 
laundry. 

 

On Hold Order has been created, but 
the user choose to hold the 
order for some reason and 
not allow further production 

Exchange  Appears on a line item of an 
order. It indicates the line 
item has been exchanged 
for a new line item that 
appears on another order. 

 
 

 

Rental Order Status Diagram 
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Rental Inventory Status 
 

WinTPS® software only feature. 

Specific tracked rental Inventory items may be assigned a status. The statuses are user defined 
and created by the system owner. Once the statuses are defined they may be applied to any 
tracked rental item. In addition, the item can be marked as unavailable, which means it cannot 
be used for fulfilling/assembly of a rental order. An example of this may be a specific (bar-
coded) tuxedo coat that is never returned from a order. That coat can be given a status of LOST 
and marked as unavailable, meaning it cannot be used on any future rental order. Of course, 
status may be removed anytime and the unavailability reversed.  

It is a good idea to maintain the statistics of LOST and SOLD rental inventory for at least 12 
months. This practice will preserve the statistical information for the item/style which is a great 
management tool. Statistical information is removed from the system when inventory items are 
deleted. 

Benefits 

Benefits of WinTPS Production Management include: 

• Reduction in the labor workers spend on managing the rental process. This 
translates into increased profitability. 

• Because you know exactly what items are where at any time during the day or week 
(overbooked, overdue, lost, sold retired, damaged ..etc), you’ll see an increase in 
the rental returns of your inventory, and therefore an increase in revenue. 

• TPS notifies you immediately when inventory is lost, late or overbooked, so you can 
take quick corrective action. Profits are thus increased. 

• The Accounts Receivable module manages your billing, helping you increase cash 
flow and reduce lost charges and other account management problems. 

• An extensive selection of reports lets you manage your business the way you want, 
printing reports to track business information of interest to you. 

• A wholesale account history lets you offer discounts and incentives to your best 
customers, thus increasing sales. 



Optional  Modules 

531 

• Rental Inventory Management provides detail information on item revenue and 
turns. This provides instant ability to see which styles/items are profitable and which 
need to be sold/retired. 

• Sub-Rental Management features are included to provide inventory information to 
your operation to minimize this expensive method of filling orders. However, when 
orders are filled this way TPS allows for the tracking of these sub-rented items 
through the process. 

• TPS tracks your sub-rental purchase history with suppliers, providing you with 
important information especially for price contract negotiation. 

What is Availability 
 

WinTPS® software only feature. 

Two types of rental inventory are added to the WinTPS:  

1. Un-Tracked items, meaning ID/Serial numbers are not assigned. Only the 
total quantity entered in rental inventory for the style/size can be used on 
rental orders and are counted as available.. 

2. Tracked items, meaning ID/Serial numbers are assigned to each item of a 
style/size combination. In addition, the user must indicate that each item is 
available for for use on rental orders. Sometimes rental items become 
unavailable, i.e. on display, in repair ..etc. The available status is manually 
turned on or off for each tracked inventory item.  The total tracked items 
entered and checked as available are counted for availability.  

The inventory styles, sizes and quantities required to fulfill an order are allocated/reserved once 
an order is saved from the order entry module. Once inventory is allocated WinTPS removes 
those items, style, size for the time period reserved, from availability. The system will allocate 
inventory items on a order from the order’s Assembly Date to it’s Back Date (inclusive).  

Items are not available when the total quantity determined by the system to be on hand for a 
specified time period is equal to or less than the number of orders that require the same items 
(style & size)  for assembly.  

Items on an order are reserved from Assembly Date to Back Date (date inclusive) and the 
inventory style/size quantity for assembly is deducted for that time period each time a order is 
confirmed. 

The system will automatically determine an order’s Assembly Date & Back Date. The operator is 
only required to enter a Use Date (also known as Event Date). The methodology used to 
compute the dates is defined as: 

Operator will enter only the Use/Event Date: 

 

Use on date = Manually entered on a order. Date calculations will treat a Sunday use date as 
Saturday. 

Pickup Date = Use date – Event Pre days.  If the pickup date is entered is a "Non-Business" 
date the system will sub-tract a day and repeat if necessary)until the date does not appear in 
Non-Business days. 

Return Date = Use Date + Event Post Days.   If the return date is entered is a "Non-Business" 
date the system will add a day (and repeat if necessary) until the date does not appear in Non-
Business days. 
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Assembly date = PickUp Date - Asm Days.  If the Assembly/Ship date is entered is a "Non-
Business" date the system will sub-tract a day and repeat if necessary)until the date does not 
appear in Non-Business days. 

Back Date = Return date + RetDays + Laundry Days.   

 

Definitions 

 

 Use Date: This is date the rental order will be used. Often referred to as the event date. This 
date is entered by the operator. 

 Event Pre Days: This is the number of days prior to the Use Date defined within the event setup 
that is a customer is allowed to receive the rental order. This number is entered on the Event 
Type form & is automatically used by the system. 

 Pick Up Date: This is a system calculated date used to indicate when the rental order will be 
available in the store/account for the customer to pick up. 

 Event Post Days: This is the number of days after the Use Date defined within the event setup 
that is a customer is allowed to keep the rental order. This number is entered on the Event Type 
form & is automatically used by the system. 

 Return Date: This is a calculated date that indicates the last date the rental order is due from 
the customer. 

 Asm Days: This is the number of days required to assemble and ship the order to the account. 
It is defined within the Shipping Methods (found in System Setup - Rental and Stores/Accounts). 
The system automatically applies the ASM days when an order entry operator chooses a 
shipping method for the order.  

 Assembly Date: This is a calculated date used to indicate the last date when the order should 
go into assembly/production. 

 Laundry Days: This is a user defined time frame entered in General Set-Up-> System Setup-> 
Production Tab-> Laundry Days to indicate how long all items that are cleaned, on average, 
require before available for assembly again. The system automatically uses this number.  

 RetDays: This is the number of days required to receive the order from the account, including 
shipping, time after the Return Date. It is defined within the Shipping Methods (found in System 
Setup – Rental and Stores/Accounts).  

 Back Date: This is the estimated date that all items on an order will be available for new order 
assembly. This is automatically calculated by the system. 

Any calculated dates may be manually overwritten by the order entry operator on the order entry 
form with adequate security privileges, if necessary. 

Note: 

A special program automatically executes each time WinPOS© starts that reviews each 
rental order.  When a order contains any items with a status of Picked-Up, Lost, Shipped or 
POS Returned (meaning it is not in the Service Center, ready to go out on another order as it 
was scheduled) it will set the order's Back date to the current date of the computer.   

This may affect the company's ability to fulfill future orders that could required the inventory 
items not returned.  The Check Overbooking function should be ran each day for the 
upcoming week to make sure you have the inventory you & the system expected you to 
have to fulfill those orders. 

 

Check Availability  
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There exists several ways to learn the availability of inventory.  

1. The Order entry Item tab will alert the operator when an item is NOT available for the 
time requested by the order when the item is entered onto the grid. 

2. The Check Availability function from the main menu (Locate->Check Availability (F3)). 
 This powerful function will allow a operator to enter a Style & Size, Style only or Size 
only and Date Range.  WinTPS© display the quantity of inventory available for the 
information entered. 

3. Via Forecast Report 

What is a Invoice 

A invoice is created within the optional WinTPS© Rental Production software for wholesale type 
store/accounts. 

A rental order is comprised of rental inventory items that each have assigned wholesale pricing 
on the Inventory Rental tab. A order will compute a total rental price after any package 
discounts & promotions. The total rental price of the order is transferred to a sales ticket. There 
is a one to one relationship between a rental order and sales ticket, i.e. one ticket to one rental 
order. 

WinTPS® will allow multiple orders to be shipped within a shipping batch. Multiple shipping 
batches may be processed before the next invoice is printed for an account. 

Shipping charges may be entered for a shipping batch. Shipping charges entered for a batch of 
orders will be equally distributed to each sales ticket. For example, five orders are being 
shipped in a batch with a UPS shipping charge of $20. Each order would automatically receive a 
shipping transaction of $4.00. 

Sales of services and retail or use rental inventory to a wholesale account will also create a 
sales ticket. 

A Invoice, when created for the wholesale account, will be consolidated of all the sales ticket 
transactions from the last time an invoice was created. The total due for the invoice will be the 
sum of all the  ticket transactions. 

All manual adjustments that effect the price of any ticket transaction will be applied to the same 
invoice that the original ticket transaction was assigned. 

Invoices may also be created for rental and sales tickets for Retail type customers via the Retail 
Invoicing function. 

 

Auto Processing 

Each day, when the WinTPS® system is first started it performs automated housekeeping 
processing.  The task performed is: 

1. Updates order 'back date' on all overdue rental orders to the end of time (assuming 
item may not every be returned).  For example, say the system is being started for 
8/01/2011.  Orders exists that were due to be back in prior to August 1st.  As a result 
the system believes it will have inventory available to fulfill future orders because it 
was expecting inventory items to be returned.  The system will automatically change 
the 'Back Date' to the "end of time" on those overdue orders.  Availability reports will 
not include the inventory of overdue orders when determining if enough inventory 
quantities are available to fulfill future orders. Review the 'What is Availability' topic 
for more info. 

See topic Close Out Old Rental Orders for additional maintenance processing. 

Production Setup & Inventory 

System Setup - Rental Tab 
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This tab is only enabled for WinTPS/WinTPOS© software installations.  
 

Allow store credits on rental tickets.. If checked, WinPOS will allow a Ticket that contains a 
rental to also have a store credit. Normally, WinPOS will force the user to refund the store 
credit, or otherwise use it before allowing the Ticket to be closed.  

Create new ticket for retail late and lost fees?… If checked, WinPOS will create a new Ticket 
for late fee charges resulting from a rental order being returned late. If not checked, 
WinPOS will simply add a late fee charge to the existing rental order ticket. Late fees are 
actually a sale of style code LATE FEE.  This optiona applies only to Retail customers. 
 WinTPS Wholesale accounts will always have a new ticket/invoice for Late or Lost fees. 

Auto-run sat/sun closing reports?...If checked, WinPOS® will run the following reports 
automatically when the store is closed. 
 
On Saturday: Rental Orders Upgrade (RP_RENTUPG), Revenues By Associate 
(RP_REVASC), Rental Registrations (RP_RENTREG), Formalwear Sales Pricing 
(RP_FWSALPRI), Invitation Sales Pricing (RP_INVSALPRI), Rental Orders Pricing 
(RP_RENTORDPRI) 
 
On Sunday: Rental Orders Upgrade (RP_RENTUPG) 

 

Allow “No charge for order” to be used…If checked, the “No charge for order” on the Rental 
Order form and “Free” checkbox on the Member Wizard cannot be used. When creating 
a rental order, there are two ways to make it a free order. The user can check the “No 
charge for order” checkbox on the Rental Order form, or the “Free” checkbox on the 
Member Wizard. Or, they can use a markdown to adjust the price to zero. If this box is 
checked, the user must use an adjustment to mark the price down to zero. This is 
normally done to establish an audit trail, since markdowns can be reported and queried 
on easily. 

Deny sales on tickets containing a rental… When checked, users cannot add a Sale 
transaction to a ticket containing a rental order transaction. 

Always recap rental on ticket?...WinTPS will always include the rental details on the receipt 
printed from the Ticket form. 

 

No order change history for exchanges…If checked, WinPOS will not prompt for the reason a 
rental order is being changed when performing an exchange. 

Visit price field on order entry…If checked, the cursor will jump to the Price field on the Rental 
Order form when the user is tabbing from field to field during entry of the style/size on the 
Items tab of the Rental Order form. This would be enabled if the rental prices need to be 
overridden often. Otherwise it will slow down data entry. 

 

Allow additional items to be added to fixed format rental orders...On a fixed format rental 
order there are slots for each item type, and at the bottom are extra slots for more style 
codes. If this option is checked, the user will be able to add extra style codes in these 
slots. If this option is not checked, the user cannot add any extra items to the rental order. 

Force rental orders option enabled by default?...If checked, the force rental order check box 
on a rental order will be checked by default. 
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Require confirmation numbers for orders...A WinTPOS featured.  Should be utilized when the 
optional WinTPS production management software is not installed.  If checked, 
WinTPOS® will confirm rental orders when the confirmation number is entered not when 
created.  The feature will force new rental orders to be saved to a WAIT CONFIRM 
status. The orders are confirmed once an confirmation number is manually assigned to 
the order.   Confirmation numbers may be entered directly onto the Rental Orders-> 
Orders tab or via the Enter Confirmation Numbers form. 

Add damage waivers to free rentals...If checked, WinTPOS© will add a damage waiver sale 
transaction to the ticket containing the rental charge for orders marked FREE on the 
Event - Register Members form.  Unchecked, the system will not automatically add a 
Damage Waiver to orders marked FREE. 

WinTPOS© will automatically default to adding a DAMAGE WAIVER charge to each rental 
order when a Price 1 - Base Price amount is entered for the Inventory style code DMG 
WAIVER. 

Note  

For Damage Waivers are automatically added to RETAIL customer rental orders created via 
the Customer form and Event - Rental tab (the operator may Cancel the charged if needed) 
when the system is configured to do so.    See the Damage Waiver topic for additional 
configuration information. 

WinTPS production management with the optional accounts receivable feature may have 
damage waivers added to wholesale account orders for inclusion on invoices by checking 
the 'Damage Waiver?' checkbox on the Order - Items tab when the order is created/saved 
the first time.  

Keep order change history...If checked, the user must enter change comments to a rental order 
each time it is changed after it has been created.  A change history entry is not created 
when the order is created or when any item on the order does not have a size and a size 
is entered. 

Detail level… options are: High or Low. When set to HIGH a prompt for Sales Associate and 
reason is required for any change to a rental order.  

A LOW setting requires Sales Associate and reason when dates, pickup locations, styles or 
sizes are modified. 

A Blank setting never requires Sales Associate and reason for modifications. 

No quick-fill on style code on Rental Order...If checked, the quick fill will be disabled when 
entering a style code on the Items tab of the Rental Order form.  Quick-fill automatically 
tries to complete the style code as it is entered. 

 

Allow any size on rentals...If checked, WinPOS® will not validate the size on rental orders 
against the WinTPS rental inventory. If integrated using the Link and the rental order has 
for "Confirm order regardless of availability" option checked, and the Auto Add Sizes 
option is enabled in TPS Link, then the size will be automatically added to the TPS Plant 
inventory, and the item will be set for sub-rental. If the "Confirm order regardless of 
availability" is not checked, or the Auto Add Sizes option is not enabled, the order will be 
rejected by the TPS Link and not confirmed. 

Role is required on Rental Order...Checked the user must enter a Customer role on a rental 
 order.  A order created from the WinTOPS® event registration will default to the 
customer's role. 

Put bride first on event/prospect card...If checked, the bride will be first on the event & 
prospect forms when new events or prospects are created.. If not checked, the groom will 
come first. 
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Adjustment code is required to save event…If checked, the user must enter an Adjust amount 
and Adjust code on an event before it can be saved. That adjustment code is then 
automatically applied to all rental orders for that event. 

Sort by Names on Rental Tab of Event form…If checked, WinPOS will organize the members 
of the event on the Rental Tab by name. Otherwise they will be sorted by role. 

Leave SA blank on new rental created from event… Checked, this option will NOT 
automatically copy any of the possible two Sales Associate (SA) assigned to an event on 
a newly created member’s rental order. It forces the operator to enter an SA code on 
each rental order created for the event.   

Checked, this option will carry over a Sales Associate's code form the Event Card.  The 
Event Card contains two Sales Associate's codes, SA (bridal SA) & Rental SA.  The setting 
allows one or the other to be carried over to the rental order.  Please choose the one to 
move over via the drop down. 

Go to Rental when create order from Rental tab of Event?...When the Create Order button is 
used on the Rental tab of the Event form, WinTPS can either go to the newly created 
Customer form, or the Rental Order form. If this option is checked WinTPS will go to the 
rental order. If unchecked, WinTPS will go to the Customer form. 

Show event wizard styles on Rental tab of Event even if order present?...If a member of an 
event has a rental order and also had styles entered on the Event Wizard, WinTPS will 
display the styles from the event wizard instead of the actual styles on the rental order. 

Every x formalwear order is free...If non-zero, every xth order on an event will be free. This 
option will only work when using the Register Wedding (or Register Members) form from 
the Event form to enter multiple event members. The “no charge for order” option will be 
checked on the rental order, which shows in the Free column on the Register Wedding 
form.  Main Menu-> Reports-> Customer/Event/Prospect-> Rental Event report provides 
options to audit Free orders. 

Deny changes for statuses...WinTPOS/TPS© will not allow for a order to be modified once it's 
status has become PICKED UP, RETURNED, SHIPPED BACK, WAIT LAUNDRY, 
LAUNDRY, DONE, LOST  or CANCELLED.  This may be limited even more by entering 
additional order STATUSES in this field.  The REVSTAT security setting allows a user to 
override the statuses and make changes to the order. Check the Order item Status topic 
for more information on rental statuses and a list of available statuses. 

 

Automatically save order check-in...If checked, WinPOS® will check-in a rental order as soon 
as the order number is entered. If not checked, the user must click the Save button on 
the Check-In form to actually check-in the order. 

Require serial numbers on order check-in...If checked, WinPOS® will force entry of a serial 
number for every tracked item on a rental order when the rental order is checked in using 
the Check-In form (CHECKIN).  

Check-in exchange order automatically?...Checked,  ALL exchange orders associated with a 
order will be checked in automatically when the order with the exchange orders 
associated is entered/scanned 'checked-in'. 

 

Go to payment window on pickup...If checked, and a customer picks up a rental order with a 
balance, the user will be taken to the payment screen. 

Print pickup receipt?...If checked, WinTPS will print a pickup receipt for each order as it’s 
picked up using the Pickup form (PICKUP). The receipt recaps the order and includes the 
return receipt Document Terms. 
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Confirm pickup of order...If checked, WinPOS® will display a confirmation message each time 
a rental order is picked up. 

Pick up all orders using Pickup from Event?...There is a Pickup Order button on the Rental 
tab of the Event form.  If this option is checked, using that button will pickup all rental 
orders for the event that are ready for pickup.  If this option is not checked, only the order 
selected on the grid will be picked up. 

 

Automatically ship back orders on return...If checked, orders will be marked as shipped back 
at return time. If not checked, orders are marked as returned at return time. You will then 
need to use the Ship Back form to actually ship the orders back to the service center. 

Serial numbers must be scanned to ship back…If checked, the user must scan the serial 
numbers of each item to enter it into the Ship Back form (used to ship items back from a 
retail POS location to the plant.) If not checked, all items that are ready to be shipped 
back are automatically shipped back when the user chooses Ship Back. 

Print return receipts...If checked, WinPOS® will print a return receipt as orders are returned. 

Serial numbers must be scanned for Return...When using the Return form (RETURN) the user 
must scan the serial number for each tracked item. The user can check the Present? 
checkbox for non-tracked items, however. 

 

No quick-fill on checkin/pickup/returns/ship back…If checked, the user will have to enter the 
entire order number on the Check-In, Pickup, Return, and Ship Back forms, instead of 
WinPOS©automatically completing a partial entry for the user. This can be turned on if 
order numbers are normally scanned instead of being entered to speed scanning. 

Suppress late fees cancelled from revenue report?...By default WinTPS/TPOS© will print a 
Late Fee cancellation details when the revenue report is printed.  This is for the audit of 
these cancellations.  This option will suppress this portion of the report. 

 

Charge for extra rental periods...WinTPS can automatically add a markup to orders where the 
term exceeds a standard rental term. 
 
For example, assume the standard rental period is 3 days, and the adjust amount is 30%. 
For an $89.95 rental with a rental term of 4 days, a $26.99 markup will be added to the 
rental ticket (1 extra term @ 30% of 89.95) If the rental term were 7 days, the markup 
would be $53.97 ($26.99 times 2 additional rental periods) 
 
The adjust amount can be a percentage (10%), or a fixed markup (10) In either case the 
amount is added to the rental order, rather than being deducted.  

• Standard rental period…Enter the standard rental period in days. 
• Markdown code for adjustment…The markdown code to be added to the rental ticket. 
• Adj amount for each addtl. period…The actual adjustment amount to be added to the 

rental ticket for each additional rental term. 

 

Maximum order line items…The total number of line items that can be added to a rental order. 
Defaults to 99. 

Late fee method...The method used to compute late fees for rental orders. It is used for WinTPS 
Plant Production and WinTPOS Point of Sale software modules. Late fee transactions 
are automatically created when the item(s) on a order are returned.  
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Daily – By Order. A late fee transaction is created upon return of the last item of a order, if the 
order was returned past it’s stated return date [shown on order entry screen]. The late fee 
is added to the sales ticket in WinTPOS or to a unprinted invoice in WinTPS. The 
calculation is: daily late fee amount times the number of days the order was late (actual 
return date – order return date). 

Retn – By item. Late fees are charged on individual items at return time and are added to the 
sales ticket or unprinted invoice. Late fees for individual Item Types are entered on the 
Item Type Maintenance form. The calculation is: Item Type late fee amount times the 
number of days the item was late (actual return date – order return date). 

None – No late fees transactions are created for late orders. 

Daily late fee for Retail orders...The daily late fee for retail rental orders, used if the Late fee 
method is Daily. 

Daily late fee for Wholesale orders...The daily late fee for wholesale rental orders, used if the 
Late fee method is Daily.  This option is only utilized with the optional Production 
Management software with the Accounts Receivable wholesale rental order module. 

 

When saving an order...When a rental order is created and saved the shop may want the 
system to perform a specific task to reduce the operator's key clicks.  The options are:  

Prompt: Ask the operator what they would like to do next 

Save:  Save the order and exit the order form 

Hold:  Mark the order as HOLD and exit the form. 

Payment: Display the payment form so a partial payment may be applied to the order's ticket 

Security Deposit:  Display the payment form for a security deposit 

Minimum    _______     $ _______ ...The shop may require a minimum financial transaction be 
made on a order's ticket, before it is considered an valid order.  This financial transaction 
may be in the form of a partial PAYMENT or SECURITY DEPOSIT.  In addition a 
minimum dollar amount may be enforced, i.e. $20.  The order is not valid until the 
minimum dollar amount is received. 

Reports or Views that indicate whether a security deposit has been paid will enforce the 
minimum security deposit rule set here, even if the net price of the rental order is $0.00  For 
minimum price setting, the payment must be equal the min payment set here or equal the 
price of rental order, whichever is  lower for the order to be considered valid. 

The payment form will automatically ask the user apply a portion of a payment to a security 
deposit when a security deposit (in this option) is required and the order's ticket does not 
contain a security deposit.  For example, a rental order is created for $100 and the business 
requires a $20 security deposit.  When the order is SAVED the operator requests the 
payment form and enters a $50 cash payment.  The payment form would then ask the 
operator if they would like to apply $20 of the payment to the security deposit, if the operator 
answers YES then the $50 payment would be $30 partial payment on the order's ticket and 
a $20 security deposit. 

 

System Setup - Rental Production Tab 

This tab is only enabled for WinTPS software installations.  
 

Prompt for tracking number at shipping… Will ask for the shipper’s tracking number for the 
shipment batch. The trqcking number can be manually entered or scanned. The tracking 
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number will be automatically entered for each order within the shipment and is available 
to see on the rental order details screen. 

Prompt for location at laundry return… Defaults the Return Items from Laundry "Prompt for 
Location?" to enabled.  This prompt allows the printing of Laundry id tags and the 
changing of the item's location information. .  The laundry tag is a ID tag that contains the 
style, size ID/Serial number, Location 1 & Location 2 plus any comments. The tag can be 
attached to items as they are returned from laundry. Useful for production clerks to see 
the proper location of the item in the warehouse. The comments are good for current 
measurement information or other helpful details.  , i.e. warehouse location and/or 
outseam length etc.   

Check on-hand qty for pick tickets…At picking ticket print time the system can check to insure 
the quantity of items printed on pick tickets is currently in inventory available for 
assemble. If not, the pick ticket will not print when this option is enabled. 

Print sub-rental return packing slips…WinTPS can track the serial/control numbers of sub-
rented items that have been returned to vendors, via the Sub-Rental Return form 
(SUBRET form). If this option is checked, WinTPS will print a packing slip each time a set 
of items is returned using the Sub-Rental Return form 

Print pick ticket from order form?.. WinTPS feature. Controls whether WinTPS asks to auto-
assemble an order on the Rental Order form (RESVMAST) If saving a rental order on the 
Rental Order form (RESVMAST), and the order is to be assembled within 7 days, and the 
status is Confirmed, WinTPS will prompt to print a picking ticket for the order. 

Allow Rental Qty to greater than on-hand qty?... A rule of the system is that Rental inventory 
quantity on hand should equal or be less than the quantity in the inventory SCW form for 
each size. WinPOS will display a message and stop the user with this setting unchecked 
when a larger quantity is entered for the rental size.  Checked this rule may be ignore and 
the user is not stopped.  It is important, for inventory value computations, to manually 
synch the quantities to insure they match via the Rental Inventory synch in Inventory 
Maintenance. 

Apply late fees to retail accounts when returning in production?... Enabled, WinTPS will 
charge late fees to retail store customers when Returning an order from the production 
switchboard via Return by Serial or Return by Order, and the orders pickup location is a 
retail store/account. 

User must enter rental order number on wholesale orders?... Normally, WinTPS 
automatically generates all rental order numbers in a sequence. When this option is 
enabled the user will be prompted to enter the rental order number for wholesale orders 
when a new wholesale order is created from the Production Wholesale Order Entry form. 
 This number will automatically be pre-pended with the wholesale account's account 
number, an account with number 300 would result in a order # of 300-XXXXXX.  Order 
numbers may be a maximum of 19 alpha-numeric characters including the account 
number.  Wholesale order entry is an optional feature of the WinTPS production software. 

Retail accounts can view wholesale orders via the Orders form?... Checked, a user using a 
register assigned to any Retail type store can view rental orders with a Wholesale 
store/account type assigned as the Pickup location via the Rental Orders form found on 
the main menu.  The Store/Account type is set within the Housekeeping-> General 
Setup-> Stores-> Rental tab-> Pricing/Type field.  This setting is usually utilized by single 
store operators. 

Use DOW picking ticket printers?... This option, when checked will allow a operator to setup up 
to seven (7) printer destinations for the printing of Production Tickets, i.e. a printer for 
each Day Of the Week.  Some operators like to print a different color Production Ticket 
for each day as a tool to manage the warehouse production. 
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Print Laundry Return Report ? (drop down)… This option allows for a audit report to be printed 
of all items returned within the WinTPS production module via the Return by Item function 
during a single session. 

Never – Never print a report. 

Prompt – Prompt the user to print the report. The user can choose not to print. 

Always – Always print the report.  

 

Sort Pick Tickets… WinTPS feature. Allows production picking tickets to be sorted by a 
specified bit of information. Use the fields drop down to locate and select the sort order of 
all production tickets. Use to more efficiently perform production. 

Laundry Days…WinTPS feature. The number of days the system needs to use for reserving the 
inventory items on rental orders. See What is Availability for more information. 

Payment terms (days) for statement aging...The number of days used for aging on wholesale 
account statements. For example enter 30 for:, Current, 30 days, 60 days, 90 days aging 
on statement or 15 for: Current, 15 days, 30 days, 45 days aging. 

 

 

Invoice…WinTPS feature. Selects the invoice format to use. By default, WinTPS uses Standard. 

Invoice copies... Place a default value for the number of invoice copies needed with printing 
wholesale account invoices. 

Packing slip copies...Place a default value for the number of packing slip copies needed with 
printing packing slips during the process of shipping rental orders. 

Recap rental order on invoice... Enabled, each order's detail  is recapped on the invoice that 
contains that order.  The order's style, description, serial number assigned and size are 
printed. 

 

Statement…WinTPS feature. Selects the statement format to use. By default, WinTPS uses 
Standard.  

 
The standard statement when printed from the menu Rental Production->Print Statements 
batch function will automatically print in detail and include the Invoice number, rental order 
numbers on each invoice and the rental items contained on each order.  However a 
Summary statement is printed when the Standard Statement is printed from the Rental 
Production->Store/Accounts->Invoices->Reprint Statement function.  This summary DOES 
NOT include the rental items contained on each order. 
 
Also available are Aging, and Age/Paid.  Aging shows outstanding invoices, aged according 
to the number of days set in Payment terms (days) for statement aging.  Age/Paid does the 
same, but includes invoices with a zero balance. 

Picking ticket…Used to select an alternate picking ticket, if alternate picking tickets are installed. 
By default WinTPS uses “Built-In Single Page.“ 
 
Alternate picking tickets are installed in the WinPOS data USER folder. They consist of 
two files, where the filenames start with RP_PICK and one file has an extension of FRT 
and the other FRX.  
 
For example, a 2 per page picking ticket might consist of the two files: 
RP_PICK_TWO_PER_PAGE.FRT and RP_PICK_TWO_PER_PAGE.FRX. 
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A fixed format picking ticket will have a –F at the end of the filename, for example: 
RP_PICK_FIXED-F.FRT and RP_PICK_FIXED-F.FRX.  Fixed format picking ticket has a 
specific line position for rental item types.  For example the COAT may always appear 
first on the picking ticket, no matter what position is shows on the on-screen rental order. 

 

Shipping Methods… WinTPS feature. Rental orders are shipped to stores/accounts by some 
method, i.e. Van, UPS, FedEx, Greyhound bus ..etc. These methods and ship times need 
to be defined so WinTPS can compute how long a rental order’s inventory items will not 
be available for other orders.  Asm is  total days needed to assembly a order including 
days in transit to reach a account for a specific ship method.  Ret days is the total time, 
including shipping, to receive the order back from the store/account.   

Ship methods may also be entered for each specific store/account on the Stores form.  Ship 
methods entered on the store/account form for an store/account  override these system ship 
methods.  Please see the What is Availability topic for additional information. 

Description: A name for the shipping method. 

Asm Days: This is the number of days required to assemble and ship the order to the 
account. The system automatically applies the ASM days when an order entry operator 
chooses a shipping method for the order.  

RetDays: This is the number of days required to receive the order from the account, 
including shipping, time after the Return Date.  

Default: Only one method can be checked. All rental orders, when first created, will first 
have the default shipping method automatically entered.  The user may select a 
different shipping method while on the order if needed. 

Sat:  Can this ship method be used on Saturday shipping?  Enabled it can. 

Sun: Can this ship method be used on Sunday shipping?  Enabled it can. 

Stores/Accounts 

Switchboard: Main->Housekeeping->General Setup->Stores 

Menu: Setup->General Setup->Stores 

Action: STORES 
 

Overview 

The Store/Account form twos three purposes.   

1) Create and maintain a location code and setup information for every company owned store. 
 Even REQUIRED for one location implementations. 

2) Create and maintain a location codes and account  information for rental wholesale accounts. 
 This feature is needed with the OPTIONAL WinTPS rental production software module with 
accounts receivable. 

Information needed are tax rates, address, integration options and other operational data. 

This form must contain an entry for each store location owned. Use of this Stores/Accounts form 
can be restricted via the RESVCHNG security.  

Note 

For WinTPS implementations.  It is HIGHLY recommended that Service Center/Warehouse 
Registers (workstations) should be set to the Service Center/Warehouse production 
store/account location code created in this form and this store/account location should be set 
to a Pricing/Type of WHOLESALE.  This is to allow the Service Center to have it's own 
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inventory, notably the rental inventory.  Additionally some forms (programs)  behavior is 
altered when the register/workstation performing the task is set to a location with a 
Type/Pricing setting of WHOLESALE.  See Type/Pricing field definition within this topic for 
more information. 

 

Retail Info 

The information on the form's Detail and Options tab must be completed for retail only stores 
even if you have only one location. Rarely will this information have to be modified once this 
information is entered.  So visits to this form will be infrequent.  Ignore all rental information if 
the WinTPOS or WinTPS options were not purchased. 

 

Rental Info 

Stores are company owned retail locations that sale and/or rent inventory items to retail 
customers that may or may not be part of events and pay via retail sales tickets. Accounts are 
other companies that rent or purchase inventory items and pay via invoice or COD (wholesale). 
In addition, this form will contain those retail customers whom are invoiced for their rentals and 
purchases. 

The information on the form's Detail, Rental, Rental Addresses and Options tab must be 
completed. 

Creating a rental order requires the order PICKUP store/account (where order needs to be sent 
for the customer to pickup) and order ORDERED AT store/account (the location that took the 
rental order) to be entered. The PICKUP and ORDERED AT store/accounts may be different 
locations and are selected from the store/accounts created within this form. 

The Pickup store/account entered for an rental order controls the characteristics of the order, 
i.e. pricing, shipping methods, status changes, rental taxes etc. 

Hint: 

Rental Orders may be created for company owned stores by the Service Center or by the 
store itself via the optional WinTPOS Point of Sale software or by just entering them in the 
included Rental Order entry form from the main menu.  

BBL recommends wholesale Account rental orders to be entered from the Stores/Accounts 
form (this form being described within this topic). 

Wholesale Account Support 

The Stores/Accounts form will be the screen for ALL wholesale order entry and wholesale 
account management. The form allows existing invoices to be viewed & printed/re-printed, 
sales to be created, existing rental orders to be reviewed, new rental orders created and 
payments processed. This form becomes the central focal point for wholesale account 
customer service. 

Use of the Stores/Accounts form can be restricted via the RESVCHNG security. A user can 
click the New Sale, New Rental, or View Rentals button without any special security. 
However, it requires RESVCHNG security to click Payments or Invoice, and to make any 
changes to the store/account information. 

Field Definitions 

 

List tab 

Lists all the stores/accounts entered within the system and provides the mechanism to locate & 
highlight the needed location. By default the location can be found by typing in it’s name. 
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Optionally the Account number may be used to locate the store/account by double 
clicking and it moving to the leftmost column. Once the desire store/account is highlighted 
the form’s tabs displays that accounts information. 

  

Details tab 

Store number...A unique code that identifies this store or account that is manually created by the 
operator. 

Store name…The name of the store/account 

Address 1 & 2, City, State, Zip…The mailing address of the store/account. 

Phone… Phone number 

Fax… Fax number 

Contact name…The primary contact’s name. 

Email… The primary contact email address. Double click the email address to automatically bring 
up your computer’s defined email client software with the email address already entered 
in the TO field. 

PO Ship to Address 1 & 2, City State, Zip… Option for optional multi-store module. The 
shipping address for this store location that will be printed on Purchase Orders as they 
are created within the system. 

Account/routing number...Enter the bank account and routing number that you want to print on 
the deposit slip. The deposit slip is for reference only, a bank cannot actually use it to 
make the deposit. 

Store open cutoff time...If the store is opened for a particular Business Date, and it’s after the 
time specified here, WinPOS® will warn you that you may have forgotten to close the 
store for the prior date. 
 
For example: The store is open for a Business date of 1/15/2001, and the store open 
cutoff time is set to 3:00 (3am). If you start WinPOS® at 3:25a on 1/16/2001, the program 
would warn you that the store is still open for the Business date of 1/15/2001. If you start 
WinPOS® at 1:30am it would not warn you because it is not yet 3am. 

Disable open Close for this store? (checkbox)...This settings will not require this store to 
perform a store Open/Close routine irregardless of the system's open/close setup 
requirements as defined in the System Setup - Options Tab. 

Notes Button…A place to type in any information about the store or account. 

Region...Region is a geographical code that may be assigned to this store.  Some reports may 
be filtered by Region code, which would includes data for all stores that are assigned to 
that Region code. Optionally a Region may be assigned to a store.  See Region Topic for 
more information. 

Group... Group is a tool of the optional multi-store module to relate a group of stores (like a 
franchise).  Stores of an assigned group can view, edit and sell inventory of the same 
group.  Employee Time Clock entries can be edited from Store Registers of the same 
group register where the employee clocked in.  See Store Groups Topic for more 
information. 

Taxes, Retail 1, Retail 2, Rental 1, Rental 2, Wholesale 1, Wholesale 2...Enter up to two tax 
rates for retail sales or rental orders (only available for WinTPOS or WinTPS modules) or 
Wholesale (only available for WinTPS) module.  When two rates are entered both tax 
rates will be applied to sales.  Taxes collected/charged are shown on the Revenue 
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Report and Sales Tax report.   
 
For each retail tax rate entered, the program creates a tax rate record, where the name is 
the store id, plus R1 or R2 for retail rate 1 or 2 respectively.  For rental, it is N1 or N2, and 
for wholesale it's W1 or W2.  It also creates a GL account with the same name, and links 
the GL account to the tax record. 

Note: 

Additional rates (more than two) may be created via WinPOS Tax Rate and Tax Group 
forms.  Please contact BBL for assistance in setting these up when needed. 

Special Tax selection..  Several states have special tax requirements and  WinPOS can handle 
those when needed.  Currently MA, NY & VT has special routines for sales tax.  All 
others would select NONE. 

None:  No special tax computations 

Massachusetts:  only computes tax on the portion of the sales price greater than $175. 

New York:  will not charge tax on any item with a sale price of less than $110. Tax will be 
calculated on the full amount of the selling price for an item sold for $110 or more. 

Vermont:  will not charge tax on any item with a sale price of less than $110. Tax will be 
calculated on the full amount of the selling price for an item sold for $110 or more. 

See the topic Tax Rates for information on specialized sales tax computations. 

  

Rental Tab 

Pricing/Type.… Rental order pricing. Options are: Retail or Wholesale.  

Pricing is set for each item within Inventory - Details tab and the Catalog Codes (As 
Pictured) setup. WinTPS/TPOS allows for two rental price levels to be assigned to Inventory 
styles and Catalog Codes, described as Retail and Wholesale.  

The option selected in this field determines which price is applied to the order, Retail or 
Wholesale for this specific store/account. 

The assumption is that Retail will be for company owned stores who typically are renting to 
retail customers whom will be paying via a retail ticket. Wholesale is normally considered for 
accounts that are invoiced for their rentals & purchases, however you may setup a 
store/account that will be charge at retail pricing and invoiced for the rentals/purchases.  For 
example, the rental shop may have an relationship with a local hotel that sends employees 
over to rent or purchase items from time to time and wished to be invoiced for those 
purchases.   Typically you may charge the hotel retail and provides a markdown at invoicing. 
 This can be easily handled thru this setup. 

Additional discounts may be automatically applied to invoiced store/accounts via the 
Markdown codes & percentages described later in this topic. 

The pricing applied on an rental order is determined by the Pick-Up location entered on the 
rental order. NOT the location where ordered. 

The retail pricing is determined by the register's store id where the retail sale was created. 
 Store retail pricing on rentals is set via Inventory Rental Tab & Store Rental Pricing forms. 

 

Class… The class is the field that is used to categorize stores/accounts. Classes must first be 
defined using housekeeping-> General Setup-> Store/Account Classes.  Used with some 
reports and the printing of Picking Tickets. 
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Retail Invoicing checkbox)?... Enabled allows rental orders and sales to be created via the 
WinTPOS© Main menu-> Retail Invoicing option  to these designated store/accounts. 
This is ideal for allowing retail sales personnel to create rental orders and retail sales to 
accounts that will be invoiced. As with all invoiced accounts the terms must be set and 
cannot be TICKET or NONE.  The pricing type may be WHOLESALE or RETAIL. 

Assemble orders to… WinTPS feature. Status that rental orders will become for the pickup 
location of the order when last item on the order is assembled. Stores that are co-located 
with the Production Warehouse will usually assemble to Received because the orders do 
not need to be shipped.  This status is assigned based upon the Pickup Location.  For 
example, if this store is indicated as the Pickup Location, then the orders status will 
become what is entered in this field. 

Ship orders to… WinTPS feature. Status that rental orders will become when they are shipped 
to the pickup location of the order. A feature used for a co-located retail store that allows 
store personnel to skip the order receiving/QC step. This status is assigned based upon 
the Pickup Location.  For example, if this store is indicated as the Pickup Location, then 
the orders status will become what is entered in this field. 

Return order to… WinTPS feature. This setting applies to the location where items are being 
returned and is the Status that rental orders will become when they are returned.  The 
Register/Workstation performing the actual return is assigned to a store in the Register 
form.  This store code controls what status the rental order will become when returned. 

There exists two status selection options within this field that require explanation. They are: 
Laundry by Type & Wait Laundry by Type. Each of these options will check the Item Type of 
the item being returned and determine if the item should be cleaned upon returned from a 
order. When the Item Type laundry setting Auto-Launder item? Checkbox is enabled 
(checked), WinTPS will modify the order status of the item being returned to Wait Laundry or 
Laundry, depending on the selection otherwise the status will become Done. 

 The other status options for this prompt will force the item’s status to the status entered. 

Hint: The Store/Account where the terminal/PC is located that is performing the item 
return will determine the Return to status of the item(s) being returned. WinTPS looks 
up the Return to rule for the location of the terminal/PC performing the return.  For 
example, if register PROD1 is assigned to store/acct 01 and that register is returning an 
order, then the status setting for the order being returned is set to the RETURN 
ORDERS TO status defined for store/acct 01 

Print pack slip?…If checked, WinTPS will automatically print a packing slip when rental orders 
are shipped to this store/account (pick-up location on a rental order).  

Print Invoice at Ship time?… If checked, will print an invoice when rental orders are shipped to 
this store/account. Accounts with COD, Cash Only terms and accounts whom have 
exceeded their credit limit automatically print invoices at shipping. Enabled, this option 
will print the invoice at shipping irregardless of the terms or credit limit. 

Require Customer Card for orders, checkbox… Only Stores/Accounts assigned terms of 
Ticket or NONE can have this option checked. Rental Orders cannot be created without 
assigning an existing customer to the order. Assigning an Event is optional.  Terms of 
Ticket require Customer Cards and this option will automatically be enabled by 
WinTPS/TPOS  

Force return date to Mon if pickup, Wed, Thr, Fri, Sat. on single rental orders… This feature 
when enabled by checking will default all rental order Return date to Monday following 
the USE weekend if the pickup is Wednesday or after. 

Damage Waiver (checkbox)...  Checked (enabled) a damage waiver will be charged to each 
rental order placed to a Wholesale pricing type store/account.  Used in WinTPS for 
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optional wholesale accounts. See the Damage Waiver topic for more information on the 
setup & use of damage waivers. 

Terms…Terms indicate how the store/account will be charged for the rental and sales 
transactions. Invoice, Retail Ticket or None (no financial transaction). 

Invoice Terms creates invoices for store/accounts that include descriptive information about 
prompt payment discounts & due dates (wholesale) OR  

Ticket creates retail sale tickets (for on-line retail stores with optional multi-store module) and 
REQUIRES "Require customer cards for orders?" option to be enabled (checked). 

None will not create any financial transactions (used for remote stand alone stores manually 
entering their own rental orders). 

The terms that will create Invoices are: 

Cash Only (COD), COD, Credit Card (processed like Cash or COD), Net, X% EOM, Net 10 
EOM, Net 30, X% net 30,  

X% 10 Net 30, X% 20 Net 30, Custom 

 

WinTPS prints the payment terms on the invoice will age open balances on the Accounts 
Receivable Statement per the terms.  

Cash Only & COD Terms will create & automatically print a invoice when any rental order 
shipment is processed for the store/account.  

The Term None will indicate to WinTPS to NOT create a Sales Ticket & financial transation 
for a rental order. This is typically utilized for company owned stores where their rental 
orders are manually entered. This scenario is where the store is creating paper based rental 
orders. Operators would eventually enter the orders into WinTPS, but will not utilize it’s 
customer tracking capabilities. 

The Term Ticket is for company stores using WinTPOS software for customer tracking. This 
option will create the Sales Ticket and order transaction used to process payments and 
additional sales. 

 

Days… … Used by WinTPS for the Custom terms option. Prints the payment term days on the 
invoice for the account & uses the day for aging the statements. 

Discount… Used by WinTPS for the Custom and X% terms options. Prints the payment term 
discount on the invoice for the account. 

Credit Limit… WinTPS wholesale feature that allows a maximum credit limit to be created for 
this account. Once created the system will monitor and not allow shipping to continue to 
the account if the credit limit is exceeded.  

Rental markdown/Rental adj amt … The markdown code and adj. amt entered will be applied to 
every rental created for this store/account. The markdown will be applied when the 
invoice is created for the customer. The markdown code/adj amt is optional.  Leave blank 
for no discounts. 

Applies to... Options are Sales, Rentals or Both.  Instructs the system to what type of invoice 
transactions to apply the markdown discount to. 

Linked to Customer...(hidden) WinPOS© automatically creates a customer card for a 
Store/Account when the Store/Account is created.  This card may be viewed and 
modified by double clicking the displayed number code.  In most cases the customer 
record should be left un-changed. 

Credit (Display Only)… WinTPS© wholesale feature. This is the total credits due the account. 
This happens when the account has paid more that what they owe. Typically it appears 
when an adjustment was made to an invoice that was already paid. The credit can be 
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used via the Payments form to apply the credit to other invoice balances or given as a 
refund to the account. 

Un-invoiced...WinTPS© wholesale feature. The total charges for all transactions that have not 
been invoiced.  This includes future rental orders that has not been shipped. 

Invoiced total...WinTPS© wholesale feature. The total amount of all invoices on file for this 
store/account. This total includes invoices paid as well as un-paid/open invoices. 

Invoice balance...WinTPS© wholesale feature. The total amount open on invoices from the 
store/account.   

Balance (Display only)…WinTPS© wholesale feature. This is the total amount of all rental 
orders and retail sales that may or may not be delivered yet. The total includes rental 
orders not shipped. 

Total Retail purchases (Display only)…WinTPS wholesale feature. The total of all retail sales 
to this account since it’s creation. 

YTD Retail purchases (Display only)… WinTPS wholesale feature. The total of all YTD retail 
sales (a year is defined as Jan 1 to Dec 31) to this account. 

Last retail sale (Display only)… WinTPS wholesale feature. The last retail sales date to this 
account. 

Total rental (Display only)… WinTPS wholesale feature. The total of all rental revenue to this 
account since it’s creation. 

YTD rental (Display only)… WinTPS wholesale feature. The total of all YTD rental reveneue (a 
year is defined as Jan 1 to Dec 31) to this account. 

Last rental (Display only)… WinTPS wholesale feature. The last rental order created for this 
account.  

 

Shipping Method Grid … How will rental orders be transported to each store or wholesale 
account?  The shipping grid must contain the valid ship methods with the transit duration 
(in days) and whether the method may be utilized on Saturday or Sunday. 

Based upon pickup account, WinTPS will go to the shipping methods defined for the pickup 
account and select the method checked as the default.  When a default method is not 
defined, the user must select the shipping method from the list of methods entered in this 
grid for the pickup account.   

Once a ship method is selected WinTPS takes the order's pickup date and subtracts the 
assembly days defined for the shipping method to arrive at a order's Asm/Ship on date (this 
is the date the order must leave the service center to arrive at the store/account to meet the 
order's Pickup date (the date the customer will be taking the order)). When the Asm/Ship 
on date is a Saturday or Sunday, WinTPS will look at the shipping method's Sat & Sun 
settings.  When the Sat or Sun shipping method is disabled,  WinTPS will begin subtracting 
days from the Asm/Ship on date until it reaches a Non Saturday or Non-Sunday date. 
WinTPS next looks at the Non-Business Days defined (Non-business days are the dates that 
shipping will NOT take place) and continues backing up the Asm/Ship on date until the date 
is a good working date. 

When a store/account does NOT have any shipping methods defined within this grid the 
WinTPS system will check to see if system wide shipping methods are set.   System wide 
shipping methods to may be created in System Setup - Rental Tab.  

Shipping Method Grid 

Description: A name for the shipping method. 
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Asm Days: This is the number of days required to assemble and ship the order to the 
account. The system automatically applies the ASM days when an order entry operator 
chooses a shipping method for the order.  

RetDays: This is the number of days required to receive the order from the account, 
including shipping, time after the Return Date.  

Default: Only one method can be checked. All rental orders, when first created, will first 
have the default shipping method automatically entered.  The user may select a 
different shipping method while on the order if needed. 

Sat:  Can this ship method be used on Saturday shipping?  Enabled it can. 

Sun: Can this ship method be used on Sunday shipping?  Enabled it can. 

Grid Buttons 

Add Item button (Shipping Grid)…Allows a new shipping method to be created. 

Delete Item button (Shipping Grid)…Allows a shipping method to be deleted. 

 

Rental Addresses Tab 

 
Packing slip ship-to 
 
The address that will appear on a packing slip printed for this store/account. 
 
Address1,1 City, State, Zip...Enter the complete address info. 
 
Invoice remittance 
 
The address that will appear on a invoice as the remittance address when/if this store/account 

prints an invoice. 
 
Address 1,2,City, State, Zip...  The complete invoice remittance address. 

  

Options Tab 

Optional setup.  Used when electronic payments, like credit card processing, are integrated with 
WinPOS. 

 

Fields 

Credit card processing...The software you are using for credit card processing, only applicable 
if you have the credit card processing integration. Select IC-Verify, IC-Verify3 (if you are 
using IC-Verify version3 or later), or Go (PC Charge) or IPCharge/Payware Connect or 
Authorize.net.  Otherwise, select None. 

 

IC-Verify and IC-Verify3 

Processor...Select your processor from the list.  Additional processor codes may be added to the 
system when needed from the Credit Card Processors form. 

Merchant ID...RIFY by default. 
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Credit card processing path...The PCCharge folder location where PCCharge is configured to 
look for it’s request and response files. Typically this is in the \PROGRAM FILES\PCCW 
folder. 

 

GO (PC Charge) 

PC Charge is installed locally and processes credit cards on behalf of the Profit System. 

Processor...Select your processor from the list.  Additional processor codes may be added to the 
system when needed from the Credit Card Processors form. 

Merchant ID...Enter your merchant ID.  

Credit card processing path...The folder where IC-Verify looks for request files. 

Cashier...The cashier user name from PC-Charge 

Password...The cashier password from PC-Charge. 

Req file prefix...By default, the integration will create a request file called STA[work station 
number].INX.  For example, if the workstation number is 1, then the request file name is 
STA1.INX.  This setting allows the STA prefix to be replaced.  Enter the alternate prefix 
(such as USER) 
 
In PC-Charge the request file name must match a username.  So, if the request file name 
was STA1.INX, then there must be user STA1 in PC-Charge.  If, however, the user in 
PC-Charge was USER1, then this field should be set to USER, so the request file name 
would be USER1.INX 

Test CC integration...For ICVerify & PCCharge software integration testing.  The credit card 
integration should be tested after it is set up for the first time, or if any changes are made. 
 This button will test the integration by sending a credit card charge to the processing 
software.  If successful, a message will appear: "RESPONSE:", followed by the actual 
response from the processing software.  The credit card will actually be declined because 
it is invalid.  However, if the response is received it means that the communication 
between WinPOS and the processing software is working.  If a "NO RESPONSE:" 
message is shown, it means that the request file created by WinPOS is not being 
processed by the processing software. 
 
WinPOS will display a message as it is waiting for a response from the processing 
software, once it creates the request file.  This message will show the path where the 
request file is created.  This is useful to troubleshoot problems. 

 

IPCharge (Payware) 

IPCharge is an internet based payment service and it requires login information.  These fields of 
information will be provided by the bank processor and should be completed for each store that 
will be using IPCharge for electronic payments. 

User Name... 

Password... 

Merchant ID... 

Merchant Key... 

 

Auth.Net (Authorize.net) 
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Obtain your account by signing up for service at this url: 
 http://reseller.authorize.net/application/?id=5555631     Authorize.net can provide a merchant 
account or you may use an existing merchant account.   When selecting an account type select 
CARD NOT PRESENT account.  The provides several benefits  1) you may use authorize.net 
for WinPOS to process cards in the store  2)  You may use the account on a eCommerce site to 
process cards and 3) You may save customer credit cards for later use by adding the Customer 
Information Manager option to the service. 

Authorize.Net is an internet based payment service and it requires login information.  These 
coded fields of information can be retrieved from the Authorize.net web console.    Once Logged 
in, choose Accounts-> Settings-> API Login ID and Transaction key to acquire the needed 
info.    

Login... 

Trans Key... 

 

Shipping Tab 

Optional setup.  The ProfitSystem can ship directly with UPS, and through ShipRush for UPS or 
Fedex. 

 

UPS Integrated Shipping 

UPS Registration...This will bring up the UPS Shipping Registration form.  UPS requires 
registration via this form in addition to having an existing UPS shipping account and shipper 
number.  Once the process is completed shipments can be created via UPS Integrated 
shipping. 

 

ShipRush 

BBL offers the optional capability to interface directly with the UPS & Federal Express carrier’s 
computer systems. This interface requires the installation of the Shiprush Fedex & UPS 
software modules. The account numbers assigned to the shop/company by the Shipper (Fedex 
or UPS) and the Shiprush license code  numbers must be entered here for this software module 
to properly operate. 

The Shiprush software must be installed and setup on the shipping station that is also running 
the WinPOS© software.  The Shiprush software must be running and visible within the 
computers task tray.  WinPOS© will talk directly to the Shiprush software when shipments are 
processed via the WinPOS© shipping module. 

Once the optional Shiprush software module is purchased (two separate modules, one for 
Fedex & one for UPS) you will be provided a license code and serial number for each.  Install 
the Shiprush software, during which it will prompt for the serial number.  Once install enter it's 
license code number here.  Start the Shiprush software module, (Fedex or UPS) on the 
computer were the actual shipping will be performed and configure the software via it's setup 
menu.  Restart WinPOS© and attempt to process a shipment.  When all are properly configured 
the Shiprush system will display a shipping record (requests address, weight, service ..etc) 
 when WinPOS© is processing a shipment via the WinPOS© Shipping module.  

The Shiprush software requires an annual renewal.  This entitles the user to available Shiprush 
updates which includes carrier shipping rate modifications. 

Your  company must have a valid shipper’s account number with UPS and/or Federal Express 
to ship packages. Please contact those companies directly to sign up for account numbers.   
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Note 

Remember to close the daily shipments via Shiprush's own management console, 
accessible via right clicking the Shiprush program in your computer's task tray. 

UPS Shipper number…Company’s account number with UPS. 

Fedx Shipper number… Company’s account number with Federal Express. 

UPS Shiprush serial number…Serial/Code number for Shiprush UPS software. 

Fedx Shiprush serial number… Serial/Code number for Shiprush Fedx software. 

Prompt for declared value checkbox…The Shipping module will prompt for the shipment’s 
declared value when the SHIP button is clicked. The value will default to the value 
entered within the optional Ship Rush module.  

 Third party package insurance is available at a significant rate savings over the carrier’s 
insurance offering. The operator should not enter a declared value with the optional ShipRush 
software when third party insurance is utilized. This is because the carrier (UPS or Fedex) will 
automatically bill for the insurance when entered into the ShipRush module.   However, a value 
must be entered when prompted by WinPOS©.  This value will print on the WinPOS© shipping 
report which would be provided to the third party insurance company for computing a premium 
payment. 

Hint:  

The company should not use the ShipRush multi shipment feature when sending multiple 
packages to the same destination and using third party insurance. Each package must have 
a individual shipment entry within WinPOS®. This allows each shipment to have a separate 
tracking number and declared value within WinPOS® which satisfies the Third Party 
Insurance reporting requirements. 

  

Internet Tab 

 

Email Integration 

Optional setup.  Used when email is integrated with WinPOS. 

This section of the form accepts the company’s internet connection and mail service 
information. These details must be completed before the email features of WinPOS® will 
operate properly.  Email is an optional feature & must be activated by BBL prior to it's use. 

To test the information once entered, simply send a email letter to an employee’s (yours) 
personal email account and check to make sure the email was received properly. To this from 
the Word Processor form. 

SMTP mail server…The server address/name of your email service provider.  An example could 
be mail.bblsystems.com. 

Sender name…The name that should appear on the emails being set. Can be the company 
name. 

Sender email…The return email address of the sender. Some services providers require a valid 
sender email address, as an anti-spam control. 

Username…The log in name of the email account being used. 

Password…The password of the email account being used. 

Port... The port your email server works with.  The default is 25. 
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Use SSL?... The ProfitSystem will use SSL to connect to the SMTP server. 

PO sender email... An alternate sender (from) email address used when emailing purchase 
orders. 

 

SMS Integration 

The ProfitSystem sends SMS message via email.  Normally, the email addresses will come from 
the sender name and email address above, under Email integration.  If the SMS 
message should come from another email account, enter those details here.  If these 
fields are left blank, the ProfitSystem will use the Email integration settings. 

Sender name…The name that should appear on the emails being set. Can be the company 
name. 

Sender email…The return email address of the sender.  

Username…The log in name of the email account being used. 

Password…The password of the email account being used. 

 

Enable on-line MyInfo?…Turns the MyInfo integration on or off.  When checked, the 
ProfitSystem will send event and customer updates to the MyInfo data warehouse via the 
CM program running locally. 

Bridesmaids Self-Register URL?....The fully qualified URL to the bridesmaids self-registration 
page.  This can inserted into emails using the RegisterURL merge code for Customer 
emails.  This URL, when clicked, will allow the recipient to enter the members for their 
event.  Usually sent to the bride to register the bridesmaids.  The ProfitSystem 
automatically adds URL variables as follows: 
eventid=[base64 encoded event id number] 
bstyle=[BM style as specified on Extra tab of event form] 
bcolor=[BM color as specified on Extra tab of event form] 
 
This URL can be created by the shop, or hosted at BBL Systems, Inc. 

 

Buttons  

Delete Button...Deletes the selected store/account with the invoice balance is zero.  It’s linked 
customer record remains as well as orders and tickets/invoices for the deleted 
store/account.  Delete the linked customer record to delete orders & invoices. 

Add button…Allows a new store/account to be created. 

Save...  Save any edits made to the form. 

Cancel... Discartds any edits made to the form. 

Done button…Exits the form and returns to the previous screen. 

 

Inventory - Rental Tab 

Switchboard: Main->Rental Production->Inventory->Inventory->Rental Tab and Main-
>Housekeeping->Rental Setup->Inventory->Rental Tab 

Menu: Rental Inventory->Rental tab->Rental Sizes button  

Action: RETLINV 
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Overview 

The rental tab is available with the optional WinTPS and WinTPOS software rental modules. 

Any style entered into inventory may used as a rental and/or a retail inventory.  However it is 
STRONGLY suggested that inventory used for RENTAL inventory should have a different style 
code than inventory used for RETAIL, even if the same inventory item is both used for retail and 
rental.  It would be a best practice to set aside an a quantity for retail entered for the retail code 
then the quantity reserved for rental under the rental style code.  This implementation is easier 
for your personnel to manage and to keep the quantities organized.  

Hint 

When necessary management can allow the retail sale of used rental inventory using the 
current Rental style code. 

Three inventory set-up actions must be in place to activate a style as a rental: 

1. The inventory style can only have sizes entered within the SCW form (omit colors & 
widths).  

Hint: 

The style code can represent a style & color combination. For example, say there exists a 
Blue Vest style 100. The style code entered into the inventory could be V100B and it’s sizes 
could be S, M, L, XL, XXL. 

2. The rental tab must be completed with the minimum information,i.e. item type and 
base rental price 

3. This step is only available/required with WinTPS Production Management module. 
The quantity available to rent must be entered. For tracked items (those that are being 
assigned ID/Serial numbers) the ID/Serial numbers for each item available for rental 
must be entered into the Rental SIZES form. 

Fields 

Item type...You must enter an item type for this style code. You can create your own item types 
using the Item Type form. Some item types are system defined and cannot be deleted. 
Style codes with item types can be used for rental orders. 

Default catalog code...If this style code is normally sold as part of a package, create a catalog 
code for that package and enter the catalog code here. Then, when the user enters this 
style code on the order form WinTPS will automatically stop when the style is typed on to 
a order and suggest to the operator hat the catalog code may be used instead.  The user 
may accept and the remaining styles of the catalog )if any) will be added to the order 
along with the catalog price OR reject it's use to continue entering each style manually. 

Price group code... Assign a optional package price group code for this field.  Assign a COAT 
Package price code to coat item types and an accessory package code to non-coat item 
types.  Package pricing is assigned to Package Codes and provide flexible pricing 
options.  The package price is displayed when a code is assigned and is the price that 
will be applied to a rental order when the item qualifies for package pricing. The Package 
discount codes with it's style contents is created via the Coat & Accessory Price Group 
forms. 

Replacement cost...The cost to charge a customer if they lose the item.  Replacement costs 
may be automatically applied to retail customers when items are not returned. 

Size conversion for whole size...You can specify a size conversion that applies to sizes for this 
item created during order entry.. If you enter a size conversion chart name within this 
field, WinPOS® will take the size entered on the actual order and try to convert it as a 
whole. If you specify this conversion, you cannot specify a left/right conversion. 
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Size conv. for left of hyphen...WinPOS® will take the part of the size to the left of the hyphen 
and convert it using this size conversion. It will also convert the right side of the size 
(using Size conversion. for right of hyphen), and concatenate the results to create the 
converted size. 
 
For example: 32-34 could become M4, if the left side conversion converts 32 to M, and 
the right side converts 34 to 4. 

Size conv. for right of hyphen...The conversion for the right side of the size entry field on a 
order entry screen. 

Swap sizes on conversion? (checkbox)...If checked, WinPOS® will take the results of the size 
conversion and swap them before concatenation. 

Example: 32-34 could become M4, if the left side conversion converts 32 to M, and the right 
side converts 34 to 4. With this option enabled the system would swap the two sides and the 
size would become 4M. 

 

Total, YTD, MTD Revenue...The dollars earned for rentals of this style code. Total dollars refers 
to the total revenue from this item since it was entered into WinPOS®. The MTD and 
YTD counters are reset automatically by WinPOS® at the start of each month and year, 
respectively. 

Total, YTD, MTD times used...The rental turns for this style code. Total times used refers to the 
total rentals from this item since it was entered into WinPOS®. The MTD and YTD 
counters are reset automatically by WinPOS® at the start of each month and year, 
respectively. 

 

Rent Price w/coat…Display only. This calculated field takes the base price entered for the rental 
style and applies any specific stores pricing. It displays for the logged in store & displays 
the retail or wholesale price determined by the Price/Type field setting in the 
Stores/Accounts form. 

Rental Price w/o coat…Display only. This calculated field takes the base prices entered for the 
rental style and applies any specific stores pricing. It displays for the logged in store & 
displays the retail or wholesale price determined by the Price/Type field setting in the 
Stores/Accounts form. 

 

View / Change Base Prices 

These four price fields appear when the View/Change Base Prices function button is clicked. 

 

Rent price w/coat...The rental price for this item to a customer if on a rental order that includes a 
style that is a COAT item type OR if the style being edited is a Item Type of COAT. 

Hint: 

The COAT item type is system defined and cannot be modified within the item type 
maintenance form.  If modified the with w/ coat, w/o coat pricing will NOT work! 

Rental price w/o coat... The rental price charged to a customer for this item if it is on a rental 
order that does not include a style that is a COAT item type.  Is the PRICE of a coat when 
no other rental items are on the order (Coat only price). 

Wholesale price w/coat… Available only for WinTPS Production Management installations with 
wholesale accounts. The rental price charged to a WHOLESALE account for this item if 
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on a rental order that includes a style that is a COAT item type. If the item being edited is 
rental item of COAT, this field is the rental price for this item.  

 See Store/Accounts Maintenance form section for more information. 

Wholesale price w/o coat… Available only for WinTPS Production Management installations 
with wholesale accounts. The rental price charged to a WHOLESALE account for this 
item if it is on a rental order that does not include a style that is a COAT item type.  

 

Important Pricing Note: 

Rental Orders that contain only a COAT can utilize Coat Only pricing.  Orders with only a 
Coat rental will use the price in the without (w/o) price field for the coat's rental price.  When 
the order contains a coat and any other rental item(s) the price field with (w/ ) Coat will be 
used for the coat rental price. 

 

Buttons 

Rental Sizes button...Displays the Rental Sizes form for this style code. The Rental Sizes form 
shows the rental quantities and rental statistics for each rentable size. The form also 
allows deletions of Rental Sizes, be careful because a deletion will permanently remove 
all rental history for that size. In addition, items of tracked item types, will have the 
ID/Serial numbers listed for each rentable size.  

Access to rental statistics for each ID/Serial number is available from the form. 

The entry of quantities and ID/Serial numbers is for the use of the WinTPS Production 
Management module only! 

Creating rental sizes is optional for WinTPOS ONLY! The “Allow any size on rentals” option 
in System/Store Setup - Rentals Tab must be checked when no sizes are identified as 
rentable. In this case, WinPOS® will allow any size to be entered on the Rental Order form. 

Store Pricing button… Available with multistore or Wholesale optional software modules. This 
feature allows for each store/account to have different prices for the same rental style. 
See Store Pricing for more information. 

View/Change Base Prices…Displays and allows edits of the retail and wholesale pricing for the 
rental style. The user must have adequate security privileges to edit.  Four fields appear. 

Create Sizes from Chart button...This option is used to add inventory size scales quickly. It will 
create a size and a single receive history entry for every size in the size chart entered for 
this style. The QOH will be set to zero for the new sizes added. Click the Rental Sizes 
Button to add rental quantities OR Barcode/ID numbers for the new sizes.  This function 
can be re-used when new sizes are added to a Size chart.  It will only add the new sizes 
to the SCW & Rental Size forms.   

Save... Save edits. 

Cancel... Cancels / Discards edits. 

Delete... Deletes the selected style and ALL associated information.  CAUTION:  Data is deleted 
and cannot be recalled. 

Add... Add a new style. 

Done... Exits this form and displays previous form. 

 

 

Inventory - Rental Sizes Form 
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Switchboard: Main->Rental Production->Inventory->Inventory->Rental tab->Rental Sizes button 
and Main->Housekeeping->Rental Setup->Inventory-> Rental tab->Rental Sizes button  

Menu: Inventory->Rental Inventory->Rental tab->Rental Sizes button  

Action: RENTSCW 
 

This form is for WinTPOS and WinTPS optional software modules only. 

The Rental Sizes form shows the rental quantities and rental statistics for each size created 
within the Inventory SCW form. 

Two classifications of rentable inventory is supported, 1) Tracked 2) Non-Tracked. The Item 
Type assigned to this Inventory item indicates it’s classification.  

Non-tracked inventory will be assigned a rentable quantity to each size. This quantity is the 
maximum number available for the assembly of orders. 

Tracked inventory is assigned Serial/ID numbers to each piece for each size. The total pieces 
entered for each size and marked available will become the maximum number available for 
assembly of orders. 

This form allows additions, deletions and modifications to the quantities available for tracked & 
non-tracked inventory. 

The entry of quantities or ID/Serial numbers is for the use of the WinTPS Production 
Management module only! This module requires the entry of sizes and quantities. 

WinTPOS only users do not have to be concerned with the quantity available for order 
assembly. 

Creating rental sizes is optional for WinTPOS ONLY!  The “Allow any size on rentals” option in 
System/Store Setup - Rentals Tab must be checked when no sizes are identified as rentable. In 
this case, WinPOS® will allow any size to be entered on the Rental Order form. 
 

Fields 

Quantity available for rental… This feature is used with the WinTPS Production Management 
software module only.  

This number represents to the WinTPS™ production management software the total number 
of units for the style & size that are available to be assembled at one time. 

For non-tracked (defined in Item Type maintenance) rental item type, the total quantity 
available for rental is manually entered.  

For tracked rental item type inventory, the total quantity available for rental is is a total of 
items entered within the View Serial Numbers from that is marked Available.  

The total quantity shown must equal the current on hand quantity of the size (found in the 
Inventory SCW form). If the total quantity for the style/size entered does not match the total 
style/size quantity found on the SCW form then WinTPS will enforce this rule and 
automatically make an adjustment entry within the newest RECEIVE HISTORY entry in 
order to make the quantities match.  If no receive history entries exist for the style/size then 
the  system will automatically create one. The system utilizes the quantity on hand total 
within the Inventory SCW form for many reports and inventory valuation. Inventory value is 
available on printed inventory reports and in the Inventory Maintenance->Display Inventory 
Value function. 
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WinTPS™ offers the Rental Inventory w/Low QOH report as a tool to help insure the 
quantities showing here are equal or less than the total found on the Inventory SCW form. 
This report can produce a list of styles & sizes where the rental total exceeds the Inventory 
SCW total. It would be up to management to determine why the discrepancy appears and to 
adjust either the Inventory SCW quantity of rental quantity accordingly. 

Hold back... Allows a user to enter a hold back % (fractions allowed) or whole number.  When a 
fraction is used,  the system would compute the holdback quantity). The holdback Qty is 
deducted from that style/size availability quantity. So when users request availability via 
the Availability lookup or during order entry the holdback quantity is deducted from the 
total quantity.  Example, own 50, holdback is 10%, and then availability to rent is 45. 
 (Only used for quick avail and availability from rental form).  This is a tool to help 
manage the rental inventory, allowing a buffer for late order returns and other over 
booking requirements.   

The Check Overbookings form would ignore the HOLDBACK in determining the inventory 
items overbooked.  Why, you would not want to show overbooked and then purchase or sub-
rent, when inventory quantity exists to fill orders. 

Allow sale of rental items? Checkbox…WinTPS users may sale tracked rental inventory by 
entering the item’s serial/ID number into the style field on a ticket. This is allowed when 
this option is enabled by checking. 

Note: 

Rental Items sold by scanning serial/ID number will be automatically marked as unavailable 
for rental/assembly, Sold will be entered into the status field and the current date will be 
placed in the date retired field of the View Serial/ID numbers form. Attempting to sell a rental 
inventory item via the 'Store Style' code INSTEAD of the serial/ID will not update the rental 
status and quantity. 

 

Total, YTD, MTD Revenue...The dollars earned for rentals of this specific size. Total dollars 
refers to the total revenue from this size since it was entered into WinPOS®. The MTD 
and YTD counters are reset automatically by WinPOS® at the start of each month and 
year, respectively. 

Total, YTD, MTD times used...The rental turns for this specific size. Total times used refers to 
the total rentals from this size since it was entered into WinPOS®. The MTD and YTD 
counters are reset automatically by WinPOS® at the start of each month and year, 
respectively. 

 

Grids 

Size Grid...The size gride lists the sizes entered within the Inventory SCW form.  

Serial Numbers Grid… This feature is used with the WinTPS Production Management software 
module only. For a tracked rental item type, the total quantity available for rental is 
computed by summing the ID/Serial numbers entered on the Rental Size Serial Number 
Form.  

This quantity can equal or be less than the current on hand quantity of the size. Once entered the 
WinTPS production management software will utilize the number for computing 
availability for each style/size. 

 

Buttons 

View Serial Numbers button…Available for tracked Rental inventory. It Displays the Serial/Id 
form. 



WinPOS Version 11 

558 

Delete Size button…Permanently deletes the selected size in it’s entirety. Data deleted includes 
Inventory SCW information, Store Transfers and Serial/Id numbers and all statistics. 
Once deleted it cannot be retrieved. It is always a good practice to back up data prior to 
making permanent deletions. 

Print... Prints a laundry tag for the currently selected serial number. 

Add New Rental Sizes... Displays the Inventory SCW -> Receive History form and allows a new 
Style / Size entry to be created.  The Rental Sizes form can immediately utilize the new 
style / size created. 

Done button….Exits the form and returns to the calling form. 

Inventory - Rental Size Serial Numbers 

Switchboard: Main->Rental Production->Inventory->Inventory->Rental Sizes button->View 
Serial Numbers and Main->Housekeeping->Rental Setup->Inventory-> Rental Sizes button-
>View Serial Numbers  

Menu: Inventory->Rental Inventory->Rental Sizes button->View Serial Numbers  

Action: RENTITEM 
 

Overview 

This form is available only to the WinTPS software module. 

This form is utilized to maintain the ID/Serial numbers for the tracked rental inventory.  

ID/Serial numbers are assigned to inventory of a specific style & size combination. The available 
rental quantity available for rent by a tracked style/size is determined by the number of ID/Serial 
numbers entered and that also are checked as ‘Currently Available’.  

For example: 15 ID/Serial numbers entered & checked ‘Currently Available’ will produce 15 
available to rent. Un-checking the ‘Currently Available’ checkbox of three of the entered items 
will indicate to the system that only 12 of the 15 are available for rental. See the What is 
Availability topic for more information. 

Grid 

The ID/Serial # grid automatically displays the ID/Serial number, Rent? (Available, checked = 
YES) and Status description that are manually entered in the form’s fields. The grid becomes a 
fast & easy reference for the entered information. The grid automatically sorts the ID/Serial 
numbers to easily locate a ID/Serial number for review. 
 

Fields 

Style Code… The selected inventory style code that is displayed automatically by the system. 

Size Code… The selected size code displayed automatically by the system. 

Serial… The ID/Serial number of the inventory item.  

Hint: 

A ID/Serial Number can be any unique code to identify a item. Tuxedo rental garments, 
like coats, traditionally have bar-code tags included by the manufacturer. These tags 
are typically eight character numbers (utilizing the interleave 2 of 5 bar-code 
symbology) and usually do not overlap numbers provided by other manufacturers. 
However, these tags do not have to be used. Many companies enter their own ID 
numbers or replace tags with new ones if/when they fall out of the item. 

ID/Serial numbers can also be written into the item. Many call this a Control Number. 
They do not have to be bar-codes.  
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However, bar-codes are preferred since they speed up the production process and 
reduce errors by allowing the utilization of bar-code scanning equipment eliminating the 
need for manually entry. 

Hint: 

Double-Click the ID/Serial number field to enter into ‘Edit’ mode. This will allow 
for any data on the screen to be edited, including the ID/Serial numbers & Control 
numbers.  When a serial number is modified/changed the software system 
automatically logs this change, so if ever necessary, a user could determine the 
previous bar-code/serial number of a tracked inventory item. 

 

Control…Control numbers are unique numbers like a ID/Serial number. This feature is optional 
for tracked items but many companies find the feature useful when they are using bar-
code tags that may separate from the item attached to. When this problem occurs, a 
operator finds it almost impossible to identify the item. A control number is traditionally 
hand written onto the item and can be used during the production process in place of the 
ID/Serial number. Once the item is identified a new bar-code tag could be applied and the 
number in WinPOS® modified to match the new ID/Serial number on the new label. 

Currently available, checkbox?… This checkbox is manually checked as an indication to the 
system that the item may be rented and counted for availability. If unchecked the item is 
NOT counted as available for rental. Situations may arise when an item may be in the 
system, but cannot be rented. Examples of not available for rental situations are in repair, 
lost, sold, retired ..etc.  

Comment…A 20 character note field which allows any information to be entered. May be used 
action notes, for example, do not delete prior to a date, what item requires for repair ..etc. 

Status…A description of the items’s status. The descriptions have to be pre-created by 
management during system set-up and are used as visual reference and reporting. 
Example statuses are display, repair, lost, sold, retired.. etc. See the Item Status topic for 
more information. 

Hint:  

The operator should check or un-check the Currently available? selection to indicate to the 
system a status that is available or not for rental. 

 Hint:  

Items may be LOST or RETIRED (and possibly other statuses), but should not be 
immediately deleted from the system. BBL recommends items to be kept in the system for a 
minimum of 12 months to preserve the statistical information. 

Date Retired…Date manually entered by a operator indicating the item was retired from further 
rentals. The Currently available? checkbox should be unchecked. WinTPS offers an 
Rental Inventory Purge feature that is based upon the Retired Date. 

Location 1… Rail position 1. Will be printed on Laundry Tag to identify where item should be re-
hung. Great for temporary workers who may not be familiar with warehouse layout. 

Location 2… Rail position 2. Will be printed on Laundry Tag to identify where item should be re-
hung. 

Tag Description… Printed on Laundry tag. Description may be entered during laundry return of 
item. Example of a description: the out-seam of pants. Makes for faster assembly when 
clerk can pull pants hemmed to correct length. 
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Created… The date the item was added into inventory. This date is automatically filled in by the 
system. 

Last rented…Automatically entered by system when item is assembled on a order and shipped.  

Last Location…The Store/Account code of the last location to receive this item as part of a 
rental order. 

Last Order… The last order number this item was assembled onto. 

Last Status…The current status of the line item on the last order this item was assigned to.  

Last Physical...The date of the last rental physical update that included/counted this serial/ID. 

Life, YTD, MTD Revenue...The dollars earned for rentals of the highlighted serial number. Life 
dollars refers to the total revenue from this size since it was entered into WinPOS®. The 
MTD and YTD counters are reset automatically by WinPOS® at the start of each month 
and year, respectively. 

Life, YTD, MTD times used...The rental turns for this specific serial number highlighted within 
grid. Life times used refers to the total rentals from this size since it was entered into 
WinPOS®. The MTD and YTD counters are reset automatically by WinPOS® at the start 
of each month and year, respectively.  WinBPS automatically maintains the turns of a 
rental garment and increments/decrements when it is assigned to a order.  Turns may be 
re-calculated if ever needed via the Inventory maintenance - Recalculate Rental 
MTD/YTD function. 

 

Buttons 

Add…This button will add a new item for the Style and Size selected on the Retail Sizes Form.  

Add by Scanning...Is a fast way to enter multiple new Serial/ID numbers for the selected rental 
item.  Select this function and start scanning, one after another.  Once the last item is 
scanned, click the Cancel button. 

Delete…This function will delete the displayed item and all of it’s information including statistics.   

Done…Exits the form and returns to the calling form. 

Print…Prints a laundry tag for the current tracked item. 

Letters, Tags, Mailing Labels 

Switchboard: Main->Housekeeping->Letters, Tags, Mailing Labels 

Menu: Setup->Letters, Tags, Mailing Labels 

Action: LETTERS 

 

WinPOS provides for  the use of  form text letters with data/merge, price tags / labels & mailing 
address labels to be utilized throughout the system.  In addition, with the BBL WinPOS 
marketing option, users may generate email letters utilizing the form text letters with data merge 
and HTML (Hyper Text Markup Language). Users may create new documents or edit existing 
ones to meet unique needs. 

Letters/Emails, tags and mailing labels are printed for customers, prospects, mailing list entries, 
appointment prospects and inventory. Tags are printed for retail, rental (laundry tag) and pickup 
inventory. You can create as many letters, HTML(eMail)  pages, tags, and mailing labels (also 
called documents) as you like. 

• Mailing labels are printed for customers and prospects. 
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• Customer letters/emails/sms are used to communicate important information to 
customers and prospects. 

• Prospect letters/emails/sms are used to draw prospects back into the store. 

• Appointment letters/emails/sms are used to qualify, confirm and remind appointment 
prospects. 

• Garment/Price tags are printed to tag retail inventory.  

• Pickup tags are printed to tag pickup (or layaway) inventory. 

• Laundry Tags are printed by the optional WinTPS application during the laundry 
return of tracked items. This can be feature may turned off/on with the System/Store 
Set-up – Rental Production Tab. 

• Custom Fitting tags are printed within the optional BBL Custom Fitting module to be 
attached to item being altered.  

To print labels or letters for a single customer or prospect, click the Print button on the Customer 
form or Prospect form. WinPOS® will display a list of all the letters and labels defined with a 
source of Customer or Prospect, respectively. To print a garment tag, click the Print button on 
the SCW (size/color/width) form. To print a pickup tag, click the Print button on the Pickup 
Inventory form. To print a Fitting ticket select Print from the Custom Fitting form. Laundry Tags 
will print automatically, when the option is enabled within the WinTPS module, when items with 
Serial/ID codes are returned from laundry. 

A tag, letter or label is comprised of two parts.  

1. The WinPOS definition. This component defines what & where the Tag Label or Letter 
will be used. It is the Source, Type, Description & Subject (for emails). To create a new 
WinBPS definition click on the Add form button and enter the information. Once 
entered click Save and the information will display within the grid.  

2. The Tag/Label or Letter content definition. This is the actual content/information that 
will be the output. To create a new ‘content file’ highlight a Tag, Letter or Label within 
the grid and click the file button – Create Letter/Tag/Label. WinPOS® will prompt for a 
file name. Once the name is saved entered the Label Designer will be displayed for 
Labels & Tags or the Word Processor will display for Letters. The operator will create 
the desired content within the editor. 

Form Fields 

Source...Select the source from where a document will be used in WinPOS®.  When a user is in 
the SOURCE form, i.e. Prospect or Customer or Appointment  ..etc) 
letters/labels/tags/emails/SMSs available will be displayed for that source so the user 
may select there one to use.  If only one entry for that source is created then WinPOS© 
will automatically select it.  Each source can be used with specific letter/tag types which 
are documented below.  A email/sms/label/tag will not perform properly when the source 
or type is not correctly set.. 

• Customer  (printer/(type: Letter or Labe, email or SMSl) Printed for customer.data 

• Prospect: (printer/(type: Letter or Label, email or SMS) Printed for a prospect. 

• Retail style (InvHeader) (printer/ type: Tag) DISCONTINUED FEATURE, SHOULD 
NOT USE 

• Retail size (InvDetail) (printer/type: Tag): Printed from the SCW (size/color/width) form, 
printed for a style, size, and color. Most shops use this source for garment tags. 

• Pickup (printer/type: Tag): Printed for an item in pickup inventory. 

• Retail Store (printer/type: Tag): Available for printing from View Store Statistics 
inventory form and required for Print Tag mass tag printing with optional multi-store 
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feature turned on.  It can include store specific information as quantity and store 
statistics. 

• Fitting  (printer/(type: Tag): Available with the optional Custom Fitting software module. 
This source would make the document available thru the print option of the Fitting 
software. 

• Laundry (printer/(type: Tag): Available with the optional WinTPS Plant software 
module. This document would automatically print when items are returned from 
laundry (option must be enabled when WinTPS is installed). 

• Mailing (printer/ type: Letter or Label, eMail Printed for contacts contained within a 
mailing list. 

• Appoint (printer/type: Letter or Label, eMail or SMS)  Available with optional BBL 
Appointment module.  Users can send followup communication from the appointment 
form to the customer of the appointment. These documents  

Printer/Type...The printer field instructs WinPOS for the type of editor to utilize for 
add/modifications as well as the printer to use.  Printers for documents are setup in the 
Printer form within Housekeeping.  The document's printer defines which dedicated 
printer to use for printing for letters, tags and labels. Printers have to be assigned to each 
terminal/PC (in multi-user installations) for specific print job types in Housekeeping-
>Printers. 

• Letter: A mail-merge letter or Email (with optional email integration).  This will allow 
editing with the built-in WinPOS  word processor. It does default to a particular printer. 

• Tag: A pickup inventory ID tag, fitting ticket, WinTPS™ laundry or retail inventory 
garment tag are the examples of software  features that utilize labels. It will use the 
WinPOS built-in label/tag editor for modifications.  Ttags automatically print to the TAG 
printed defined in the Printer form. . 

• Label: A mailing label for a customer or prospect.  It will use the WinPOS built-in 
label/tag editor for modifications.  Labels automatically print to the LABEL printer 
defined in the Printer form. . 

• eMail: A HTML page for sending eMail messages directly from within WinPOS to 
prospects or customers or appointments.  With this printer/ type selected,  WinPOS 
will turn on it's WYSIWYG HTML editor for the creation of the document.  It will use the 
WinPOS built-in HTML editor for modifications.  eMail does not automatically print to 
any  printer. eMails created here will become templates when choosing to send eMail 
to customers and may be chosen from the editor when sending the eMail from the top 
right template dropdown. 

• SMS: Maximum 160 characters of text.  The created SMS text becomes a template for 
the chosen source.  When requesting to send a SMS the user may type in any text 
then select the template text to be appended.  The templates are available from a 
dropdown in the top right corner of the form. 

Description...A descriptive name for the document. 

Subject (email)…Letters & eMail types may be sent as emails via the BBL Marketing option. 
 They will be sent with the subject entered here. 

File...Labels, tags, and letters are actually stored in separate files.  Letters have the HED 
extension and labels are two files with the FRX (the file selected for this form) & FRT 
extensions. These files should be saved in the WinPOS data USER folder. This field will 
display the name of the separate file selected for the highlighted Tag, Label or Letter. 

The system can also accept a file with the HTM or HTML extension.  This is a internet type 
HTML file that can be created with a program like Microsoft Frontpage to be used for eMails. 
 This file can contain graphics that are hosted at a web site and look like any other web 
page.  This file must also be stored in the WinPOS data USER folder. 
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Emails sent from letters edited in WinPOS© will be converted to a TEXT only message with 
the font being Courier 10, underlining, bolding & other formatting ..etc will be lost when 
delivered to the recipient. 

 

File Buttons 

Select tag button...Use this button to select an existing Tag, Label or Letter file to be used for 
the highlighted WinPOS definition. This button will display a Windows file select dialog. 
Locate the content file to use and select it. It’s name will then appear in this field. 

Create tag/letter button...To create a new tag, letter or label file, click this button and enter a file 
name. Use a short, descriptive name such as ProspectOneMonth.   Once entered you 
will be taken to the Word Processor to create the letter or the Label Designer for Tags & 
Labels. 
 
Once a new tag, label or letter is created and saved it’s name should display within the 
FILE field. If it does not, select it via the Select Tag button for it to be inserted for use 
within the highlighted tag, label or letter. 

Edit tag button...Edits the highlighted Tag, Label, Letter or eMail content file. For labels, this will 
take you to the Label Designer to edit the label or tag. For letters, this will show the Word 
Processor to edit the letter. For TXT format letters, it will start the appropriate editor on 
the computer. For HTML documents the system will start the WinPOS HTML editor.  See 
the HTML manual for specific instructions on use.  

WinPOS will display a menu when creating a new eMail HTML page.  Once the Add/Edit 
button is clicked the system will present a sub-menu asking for a selection.  The options are 
designed to allow the new email to be created from an existing email page whereby the user 
could just do the minimum edits 

Existing eMail:  The system will display a Selector box of all the existing eMail documents 
to allow for the user to pick an existing eMail.  Once selected it's copied contents will be 
displayed within the WinPOS HTML editor whereby the user would edit appropriately. 

HTML File:  The system will display a Windows File Selector box allowing the user to 
navigate to any HTML file.  Once selected it will be copy the contents of the file and 
displayed them within the WinPOS HTML editor whereby the user would edit appropriately. 
 Merge codes may be inserted into the HTML email. 

No Template:  This option will display the HTML editor with a BLANK page, allowing the 
user to create any page required. 

Graphic Note 

Graphics for HTML pages are stored on internet web servers.  Web servers include the 
server that hosts a bridal shop's web-site and also include servers from services like 
Shutterfly, Google Picasa and many others (many free, some paid).  Any that allow you to 
link to a stored image will work within the eMail document created from the WinPOS HTML 
editor. 

 

In versions up to WinPOS v9, a letter could be a HTML file.  In v10 and after this is not 
suggested.  The type of those Letters should be changed from Letter to eMail.  Once done, 
click Edit, the program will copy the HTML file from the hard drive into the eMail table and 
store it internal HTML page.  If will then rename the HTML file on the hard drive by adding 
.BAK to the filename.  (TrunkShow.HTML becomes TrunkShow.HTML.BAK)  Also, the field 
"File" is cleared on the Letters record so it's not confusing. 

 

Review the Special instructions for tag printing topic for more details on label & tag content. 
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Form Buttons 

Delete…Deletes the highlighted WinPOS® tag, label or letter definition. Does not delete the 
content definition file. 

Add… Creates/Adds a new WinPOS® tag, label or letter definition. Does not add/create a 
content definition file. 

Done…Exits the screen. 

Store Pricing 

Switchboard: Main->Rental Production->Inventory->Inventory->Rental Tab->Store Pricing and 
Main->Housekeeping->Rental Setup->Inventory-> Rental Tab->Store Pricing  

Menu: Inventory->Rental Inventory->Rental Tab->Store Pricing 

Action: RENTPRIC 
 

Overview 

Use with optional multi-store integration and allows for store specific pricing on each rental item. 

The Store Pricing function allows for multi-store store/account specific pricing be created. This 
form is utilized each time a rental order is created. The system will attempt to locate the order’s 
‘Pick-Up at’ store/account location within this form. When found the pricing on the record will be 
used instead of the standard Retail & Wholesale pricing found on the inventory rental tab. 

There should only be one entry for each store/account and the pricing displayed is controlled 
the Pricing/Type field setting on the Store/Accounts-> Rental tab.  For example, a location set to 
WHOLESALE pricing will see the wholesale price with & without coat on this form. 

Fields 

Style… The inventory style is automatically entered. 

Store… The specific store/account the prices entered will apply for. 

Rent price w/ coat...The rental price for this item to a customer if on a rental order that includes 
a style that is a COAT item type. If the item being edited is rental item of COAT, this field 
is the rental price for this item.  

Hint: 

The COAT item type is system defined and cannot be modified within the item type maintenance 
form. 

Rental price w/o coat... The rental price charged to a customer for this item if it is on a rental 
order that does not include a style that is a COAT item type.  

Wholesale price w/coat… Available only for WinTPS Production Management installations with 
wholesale accounts. The rental price charged to a WHOLESALE account for this item if 
on a rental order that includes a style that is a COAT item type. If the item being edited is 
rental item of COAT, this field is the rental price for this item.  

 See Store/Account Maintenance form topic for more information. 

Wholesale price w/o coat… Available only for WinTPS Production Management installations 
with wholesale accounts. The rental price charged to a WHOLESALE account for this 
item if it is on a rental order that does not include a style that is a COAT item type.  

Damage Waiver 

Damage Waiver is a term to indicate a special add-on charge to rental orders.  WinTPS/TPOS© 
incorporates specific features to facilitate the successful add-on of this charge.  Sales Reports, 
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like Sale by Vendor Style or Orders Reports like Late Fees/Dmg Waiver, may be utilized to list 
the number sold & and sales volume for a selected date range.  Damage Waivers may be sold 
to customers in WinTPOS© and Wholesale accounts in WinTPS©.  

 

Setup 

WinPOS© has a default Inventory Item for damage waivers with a Style Code of DMG WAIVER, 
Vendor Style of DMGWAIVER & category of DW.  The style code will be utilized by 
WinTPOS/TPS© to insert this add-on charge on to customers/accounts tickets/invoices.  This 
style may NOT be modified.  The pricing entered on this style will be the standard charge for 
damage waivers applied to all retail orders.  With the optional WinTPS and wholesale support, 
wholesale store/account orders may also be charged a damage waiver. 

To begin charging Damage Waivers, three steps must be complted: 

1. Enter the Damage Waiver selling price for the Inventory Style Code:.DMG WAIVER. 
 See description below on which prices to create. 

2. Enable the  Housekeeping-> Rental Setup-> Stores-> Rental Tab->Default to damage 
waiver? checkbox for each store/account where Damage Waivers should be charged. 

3. Insure the Damage Waiver? checkbox found on the Order - Items tab is checked 
when a order is created.  This Damage Waiver setting is automatically checked for 
Retail customers when 1 & 2 above are completed. 

The Inventory ->Rental tab base prices for the DMG WAIVER style code should be entered, 
Rental with coat (for retail customers), as well as, Wholesale with coat (for optional WinTPS 
production module with A/R when doing orders to wholesale accounts and the service center 
wishes to charge damage waiver to them)..   

Additionally, a feature is offered in multi-store implementations or a service center scenario that 
accepts wholesales orders to multiple accounts, where the damage waiver price may be 
different for each account.  This multi-store pricing is set in the Inventory-> Rental tab-> Store 
Pricing form.  Setting multi-store pricing is optional.  When not utilized, the system will use the 
base price. 

There are two type of stores or accounts that may be created in the Store / Account form.  1) 
Those that are assigned RETAIL pricing and those that are assigned WHOLESALE pricing 
(available via the optional WinTPS accounts receivable module).  This is determined by the 
store's Pricing/Type field setting in the Store setup-> Rental tab form.   

Stores set to RETAIL pricing will charge the retail Damage Waiver price and those accounts set 
to WHOLESALE pricing will charge the wholesale price.   

Each order, when created, will have a Pickup Location set.  In single store implementations this 
will always be the that store.  In multi-store implementations or wholesale account 
implementations the pickup location could be any of the stores or accounts.  The Pickup 
location instructs the system to charge the Damage Waiver price set  for that location. 

Retail Customers entered via the Customer Module & Event - Rental tab will automatically 
receive the DMG WAIVER pricing in inventory.  By simply setting a DMG WAIVER price 
indicates to WinTPOS© that each customer should, by default, be charged the Damage Waiver 
fee.  A operator would have to manually stop the charging of the Damage Waiver for the order 
by un-checking the Damage Waiver? checkbox found on the Order - Items tab or to manually 
adjust and cancel it off a ticket once the fee has been charged. 

 

Application 

Insure the Damage Waiver? checkbox found on the Order - Items tab is checked when a order 
is created to automatically charge the waiver fee..  When registering events enable (check) or 
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Disable (uncheck) the Damage Waiver? checkbox on the Event's Register Members Wizard 
prior to creating the rental order.  In case of error where the waiver was charged or not charged, 
a operator may visit the ticket that contains the rental charge and sale - ring up the waiver 
charge to add or adjust-cancel the waiver charge to remove. 

There exists system setting, System Setup - Rental Tab- > Add Damage Waiver to FREE 
rentals?.  Un-checked the system will not automatically charge a Damage Waiver to customers 
that were marked FREE on the Events - Register Members Wizard. 

WinTPS© does not default to adding a Damage Waiver charge to orders entered via the 
optional  Wholesale Order Entry form unless the Damage Waiver checkbox is enabled for that 
store/account.  The Pickup location on the order controls the damage waiver  price being 
charged.   

Damage waiver charges are created if the Damage Waiver? checkbox found on the Order - 
Items tab is checked when the order is originally created/saved.  The Damage Waiver is 
simply a sales transaction that will appear on a customer's ticket or wholesale invoice.  This 
charge may be manually adjusted when needed. 

 

Reports 

Report Late Fees/Dmg Waiver, Rental Orders/Upgrade, Sales by Vendor Style & Sales by 
Category are some of the standard reports that provide information regarding the sale of 
Damage Waivers. 

Item Status 

Switchboard: Main Menu->Housekeeping->Rental Setup->Item Statuses  

Menu: Setup->Rental Inventory->Item Statuses  

Action: ITEMSTAT 
 

WinTPS® software only feature. 

Specific Rental Inventory items may be assigned a status. The statuses are user defined and 
created by the system owner. Once the statuses are defined they may be applied to any rental 
item. In addition, the item can be marked as unavailable, which means it will not be used for 
fulfilling a rental order. An example of this may be a specific (bar-coded) tuxedo coat that is 
never returned from the customer. That coat can be given a status of LOST and marked as 
unavailable, meaning it cannot be used on any future rental order. Of course, status may be 
removed anytime and the unavailability reversed.  

 

Item Status…The status description. Used in the Rental Serial Number Form. 

Catalog Codes 

Switchboard: Main->Housekeeping->Inventory Setup->Catalog Codes  

Menu: Setup->Rental Inventory->Catalog Codes 

Action: CATALOG 
 

Optional WinTPOS rental point of sale or WinTPS production management system feature. 

Catalog codes provide a convenient way to create common order packages easily (also called 
‘As Pictured’). You first create a unique catalog code (cannot be the same code as any other 
style or catalog code), then specify the rentable style codes that comprise the code.  

Catalog codes may be used for retail customers. It may also be used with wholesale accounts 
when the Rental Production Management module (WinTPS©) is installed. 
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A user may enter the catalog code on a order at the style prompt. WinPOS© will recognize the 
code as a catalog code and automatically enter ALL the styles that comprise the code onto the 
order. The system will list the original prices for each style and finally apply a discount, if the 
catalog price entered during the catalog code entry is less than the sum of the individual style 
prices. 

Catalog Code prices are strictly enforced by the system.  The Catalog price will override any 
price group discounts (if they are used). 

A catalog code may be specified for an event when creating the event. Once specified 
WinPOS® will ask to use the catalog code when creating member’s orders. Catalog Codes are 
a data entry tool that speeds up order creation drastically! 

The Catalog Code price may be set by store when using BBL’s optional MultiStore software 
module or the optional WinTPS© wholesale module . This pricing feature allows management to 
set code prices on a store by store basis. The View/Change Base Price button displays the 
standard package price, and the Store Pricing button lets the user set the pricing for specific 
store. If a store specific price is not set, the base price for the code will be utilized. If the catalog 
code price is zero, then the order price will be zero if the catalog code is used. 
 
Catalog codes cannot have the same code as any style codes within inventory. 
 

Fields 

Catalog code...A short, unique code. 

Description...A longer descriptive name for this catalog code. 

Style list...The list of styles that make up this catalog code. To add a new style code, click the 
Add Item button. A blank entry will appear at the end of the list. Click on the blank entry 
and enter the style code. To remove a style code, select the style code in the list and 
click Delete Item button. 

• Style: The style code from rental inventory. You can look up a style code byslecting 
the style cell &  pressing F2. 

• Description: The description from retail inventory. 

Buttons 

Click the View/Change Base price button to enter a retail and wholesale base price for the 
package.  

The Catalog Code price may be set by store when using BBL’s MultiStore software module. 
This pricing feature allows management to set prices on a store by store basis. The 
View/Change Base Price button displays the standard package price, and the Store 
Pricing button lets the user set the pricing for a specific store. If a store specific price is not 
set, the base price for the code will be utilized. 

 

Size Conversions 

Switchboard: Main->Housekeeping->Rental Setup->Size Conversions  

Menu: Setup->Rental Inventory->Size Conversions 

Action: SIZECONV 

The Size Conversion feature utilizes conversion definition tables that will allow the system to 
convert a customer’s measurements entered on a rental order into a size code that will match 
the size code entered in the inventory. 
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It is easier & less error prone for most operators to enter in size measurements on orders. 
However, in most rental warehouses it is simplier to utlize size codes on rental inventory. The 
conversion feature is designed to convert measurements into size codes. 

A size conversion will automatically convert one notation into another notation. A Rental style 
must be assigned a size conversion table for it to be used during order entry.  

The name(s) of the tables must be entered on the Inventory - Rental Tab form for a specific 
style code. Conversions can convert a size as a whole, or ones that convert the left and right 
sides of a size separately (left & right sides are separated by a hyphen). 

See How to enter exact measurements for more information. 

Some examples: 
 

A conversion table called CoatSize 

Min  Max  Convert To 

20 25 A 

26 30 B 

31 35 C 

36 40 D 

A coat size of 21 would be converted to A. A coat size of 31 is converted to C. 
 

Assume now you have a two conversions 

PantWaist 

Min Max  Convert to 

20 30  1 

31 40  2 

41 50  3 
 

PantOutseam 

Min Max  Convert to 

20 30  A 

31 40  B 

41 50  C 
 

And a style code in inventory uses PantWaist for it’s left side conversion, and PantOutseam for 
it’s right side conversion. 

Measurements entered of 21-32 would become 1B. Measurements of 42-30 would become 3A. 
 

Conversion name...A unique descriptive name for the conversion. 

Conversion list...Each entry in this list specifies a minimum and maximum value, and what to 
convert to.  

If the size falls in the min, max range specified, it is converted to the specified value assigned to 
the range. Don’t overlap the ranges, if you do, WinPOS® will use the first range it finds.  
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The values must be numeric and the measurements to be converted must be numeric also. 

To add a new range, click the Add Item button. A blank entry will appear at the end of the list. 
Click on the blank entry and enter the min, max, and convert to value. To remove a 
range, select the range in the list and click Delete Item. 

Item Types 

Switchboard: Main->Housekeeping->Inventory Setup->Item Types  

Menu: Setup->Rental Inventory->Item Types 

Action: ITEMTYPE 

 

Overview 

Item Type is a classification of rental items.  Examples are COAT, PANT, SHIRT, VEST  .etc. 
 Each type may have characteristics that will determine how processed during order entry, 
production and reporting.  The simple presence of an Item Type on a inventor style indicates to 
the software that is a rental inventory style and allows for additional rental information to be 
added, as rental prices, replacement cost and bar-ode serial numbers (it it a tracked item type) 

The Item Type maintenance form allows a user to defined types and their characteristics. Item 
Types indicate to the system how to process rental inventory styles. Item Types are also utilized 
for event rental member registration, inventory, order entry, order returning, production ticket 
printing and rental order reporting.   A item type of COAT is REQUIRED by the system to 
determine with or without coat pricing. 

Fields 

Type description...A unique code for this item type.  One item type of COAT is required. 

Late fee...The daily late fee for this item. Charged at return time if the item is overdue, and the 
Late fee method is Daily in System/Store Setup – Rentals Tab. 

Accessory? (checkbox)...Is this item an accessory? Checked means YES. Used by rental order 
price reports and the package pricing module. 

Tracked? (checkbox)...Should this type item be required to be assigned a ID/serial number? If 
checked, WinPOS® will required the entry of inventory ID/serial numbers (when 
Production Management is installed). See rental inventory for more information. Bar-
codes may be used for order assembly,  return from customers or laundry. 

Companies who receive orders from a wholesale supplier will use this option to allow 
ID/Serial numbers to be optionally assigned to the inventory of these type items entered on 
orders when they are assembled.  

Adjustable? (checkbox)...When enabled, a operator will be allowed to enter an adjustment code 
on a rental order for each item.  This is a tool to the service center to indicate if the size 
entered can substituted to a different size if needed. If checked, WinPOS® will allow the 
user to specify Up/Down/None on the Order form as a suggestion for substitution. 

Disabled, the system will not allow for a adjust code to be entered  

 

Line number...Line numbers are utilized within two WinTPOS/TPS forms. 1) The Events – Rental 
Tab-> Register Members button. 2) The Order Entry - Items tab and may be used in fixed 
format production tickets. 

This line number is the actual order in which the type will appear on the order form. For 
example, line item 1 will appear on the first line of the order. These numbers should be 
unique. In other words there should only be one 1 entered among all other item types.  
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Item types with a blank or zero are allowed. Item types with blank & zero line numbers will 
not display on the event register members form or within the rental order entry grid. 
However, order entry will allow styles assigned to the item types to be entered when the 
System Set-up - Rental Tab ‘Allow additional items to be added to fix format rental orders’ is 
checked. 

Size caption...You can specify an alternate caption/Label for the size field for this item type on 
the Orders form. When the size is being entered for a style with this Item Type assigned, 
WinPOS® will display the caption entered here instead of the standard caption “Size” . 

Auto-Launder item?…This setting is used by the optional WinTPS® software module. When a 
style of this item type is returned from a customer, it will automatically be marked for 
laundry and be set to a WAIT LAUNDRY status. 

System defined?...If checked, this is a system defined item type. WinPOS® requires certain item 
types to operate correctly. If this is checked WinPOS® limits the changes you can make 
to this item type. They should not be Deleted! 

Requires a Dash-Size?... Enabled will force the user to enter a dash in the size on the order 
entry form for this item type.  The DASH within a size is a tool to provide additional size 
information to the service center.  Typically, for example, with item type PANT the service 
center may require the outseam to be included with the size, a DASH may be used to 
accomplish this task, i.e. 34R-37.  WinPOS validates the size to the left of the dash 
against the sizes found within the inventory.  It does NOT validate the size information to 
the right of the dash, thus allowing any information.  The maximum length for a size is 7 
alphanumeric characters.  Due to this limited space the Order Entry form also allows a 
reference for each style on the order with up to 20 alphanumeric characters.  In addition, 
each order has a spot for production notes where additional order details may be 
entered. 

Print pick tickets separately?...Indicates that this is a "special" item type.  If checked, styles of 
this item type will not automatically be included on picking tickets.  On the picking ticket 
print form there is a checkbox, "Include "special" item types?"  If this is left unchecked, 
then the pick tickets will not include these item types.  If checked, they will.  This is used 
for special item types, such as top hats or canes, that are not normally picked with the 
rest of the rental order.  

Non Business Days 
 

Switchboard: Main Menu->Housekeeping->Rental Setup->Non-Business Days  

Menu: Setup->General Setup->Non-business days 

Action: NonBus 
 
Overview 

Non Business Day maintenance allows for the entry of days that the company is NOT open for 
business and cannot process rental orders.  WinTPS handles date calculation processing 
automatically and will not allow the Pickup on or Return on or Asm/Ship on dates to fall on a 
NON-BUSINESS date.  The system will subtract one day at a time for Pickup on and Asm/Ship 
on or add one day at a time for Return on until the date is a good date. 

Sunday 

By default Sunday is considered a non-business day.  In many companies retail stores are 
open on Sunday and will accept order Use on dates for Sunday, but the service center is 
not.  WinTPS will allow the entry of a Sunday use date on a order but automatically 
considers Sunday as Saturday and preform the Asm/Ship on and Back in inventory date 
calculations based upon a Saturday date. 
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See What is Availability topic for specific date definitions and use of Non Business days. 

To utilize this feature any date(s) that the company cannot process rental orders should be 
added to this form, i.e. Dates the service center or retail store cannot ship, receive, accept 
customer returns or allow customer pickups. 

The entry is accomplished within the grid. 
 
Buttons 

Add Button…Click Add to add a new date. The system will add a blank line to the grid and 
highlight the blank date field within the grid for entry of the date 

Delete Button…The operator should highlight the date to delete and click the delete button. 

Date…The date that the company cannot ship or receive orders. 

Note…A optional description about the date. 

Order Types 

Switchboard: Main->Housekeeping->General Setup->Order Types  

Menu: Setup->Rental Setup->Order Types  

Action: ORDERTYP 
 

Used in the WinTPS® or WinTPOS® optional software modules. This form allows new Order 
Types to be created or modified. The Formalwear type is a system required type & should not 
be deleted. 

Order types are used by the Orders form to group like kinds of orders within reports. The order 
type also controls which accounting class is used to account for the deposits/AR, sales taxes 
and revenue for a rental order via the WinPOS® revenue report. 

The default Order Types included with WinPOS® are are Gown & Formalwear for retail pricing.  

WinPOS® will default to the Formalwear type for the Pickup/Receiving store/account’s (enter in 
the Pickup store field of the rental order) pricing type for all new orders.  

Fields 

Order type...A unique descriptive name for the order type. 

Accounting class...The revenue WinPOS®/GL account number, deposits GL account number, 
etc. from this accounting class will be used for rentals of this type. 

For account type…Controls which order types are available for entry on an order. 
Stores/Accounts may be assigned one of two available pricing/types. Retail or with the 
optional WinTPS production management module with wholesale support, Wholesale. 
This is accomplished in the the Store/Account form.  

 Left Blank: both Retail & Wholesale account types can see the order type. 

 Retail: only retail account types can can see the order type. 

 Wholesale: only wholesale account types can can see the order type. 

System defined?...If this is checked this is an order type used by WinPOS® that cannot be 
edited. 

Import DOS TPS Data 

Switchboard: Main Menu->Housekeeping->System Maintenance->Import TPS Data 

Menu: Setup->Import Data->Import TPS Data 

Action: TPSCONVERT 
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This feature is designed as an upgrade tool to users of BBL’s DOS TPS Plant software. It will 
import the data from BBL’s DOS TPS Plant software without the company having to retype any 
information.  

It will import rental inventory, accounts, item types, shipping methods, AR balances, and rental 
orders. 

WinPOS requires each inventory item to have an accounting class and inventory category. 
Therefore, WinPOS will prompt for an accounting class, inventory category, and optionally a 
sub-category for the import, and assign them to each imported inventory item. 

Style codes used in DOS TPS Plant cannot duplicate style codes used in WinPOS. Before the 
import, WinPOS will check for duplicate styles. If duplicates are found, they will be listed and the 
import will be stopped. The styles will have to be updated in DOS TPS Plant to make them 
unique, and the import restarted. 

The import process performs the following steps: 

1. Check for duplicate style codes between WinPOS and DOS TPS Plant. Stop import 
if duplicates are found. 

2. Import shipping method tables. 

3. Import Accounts from DOS TPS Plant. If the account number already exists in 
WinPOS, then the details of the account in WinPOS are overwritten with the details 
from DOS TPS Plant. If the billing is set to NB in DOS TPS Plant, then the billing will 
be None in WinPS. If the billing is B1, B2, or B3, then the billing is set to Net 30 in 
WinPOS. Finally, if the billing is C1, C2, C3, C4, or C5 then the billing is set to COD 
in WinPOS. If the Price Code (R/W) is set to R in DOS TPS Plant, then the 
Pricing/Type is set to Retail in WinPOS, otherwise the Pricing/Type is Wholesale.  
 
A single customer record is created for each imported account, along with one ticket 
containing the AR balance for that account. 

4. Import rental inventory from DOS TPS Plant. Style and SCW records are created 
automatically, and a single Receive History record is created for each size in DOS 
TPS Plant. The serial numbers for tracked items are also imported, and made 
available for rental if the status is IN LAUN, IN, WT LAUN, IN ASM, ALTER, OUT, or 
DISPLAY. 

5. If the option is checked to “Import Orders from TPS” all current orders in WinPOS 
are erased. Then, the orders from DOS TPS Plant are imports and the Asm/Ship On 
and Back in Inventory dates are computed automatically. If the option to “Import 
Orders from TPS” is not checked, the only process is that the Asm/Ship On and 
Back in Inventory dates are set for any orders already in WinTPS. 

6. The Inventory style with coat price will be populated with the DOS without coat price 
if the with coat price is empty in DOS Plant (this is based on DOS TPS price setting) 

7. Finally, when the import is finished the following message is displayed “Restart 
WinTPS now, then run Recompute Qty Avail to Rent” Exit from WinTPS and re-start 
it. Go to Main->Housekeeping->Inventory Setup->Inventory Maintenance-
>Recompute Rental Qty. 

Once the import is complete, the data will need to be reviewed for accuracy. Particularly the 
Store/Accounts information where additional details will have to be completed about each 
store/account. 

Auto Size Suggestion 

Switchboard: Main->Housekeeping->Rental Setup->Auto Size Suggestion  

Menu: Setup->Rental Inventory->Auto Size Suggesion 

Action: AUTOSIZE 
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Auto-sizing is used during wholesale rental order entry so that WinTPS© can suggest a size for 
each style entered on the order based upon the customers height and weight.  This feature is 
available for orders placed for wholesale accounts via the Store/Account form. 

Usually the weight is an indication of girth/size, for example with a coat, weight could indicate 
size of 46 and the height would indicate length, for example L for long. 

Height/Weight suggestion tables are set-up  for each item type to trigger WinTPS© to suggest a 
size. First, enter the Minimum weight or height and Maximum weight or height that corresponds 
to a Low, Normal, and High size range for the height weight combination entered on an order. 
 Any Weight or Height that equals the Min or Max values or falls between the two will default to 
that row's low/normal/high size. 

   

Note:  The Min or Max values entered should not overlap or equal any other row's Min or 
Max value.  Also, sizes do not have to be real sizes, they made be codes or numerical 
numbers.  Because once the system suggests a size it will then perform a size conversion 
which could take a size code & convert into a more meaningful size.  Some size 
converstions may dictate the need for a size conversion. 

Inventory styles will default to the Normal size specified unless a different Size Suggestion has 
been selected for the inventory item on the Rental tab of the Inventory form. Some items do not 
run true and will be either smaller or larger in size, thus it must be indicated on the style to use 
the LOW or HIGH size instead of the normal (default) size. 

 

 

Fields 

Height/Weight....The auto-size table will apply to either height or weight so select the one you 
wish to edit/review. 

Item type....Select the item type the table applies to. 

Height/Weight Size Table...A list of height/weight ranges. For each range, specify the correct 
size for Min, Normal, and Max. To add a new row, click the Add Item button. A blank 
entry will appear at the end of the list. Click on the blank entry and enter the details. To 
remove a row, select the row in the list and click Delete Item button. 

• Min size: The size code to use if the Size Suggestion for the inventory item is set to 
Low. 

• Normal size: The size code to use if the Size Suggestion is not set, or set to Normal. 

• Max size: The size code to use if the Size Suggestion for the inventory item is set to 
High. 

• Min: The minimum height/weight. 

• Max: The maximum height/weight 

Synch Rental Qty with QOH 

Switchboard: Main->Housekeeping->System Maintenance->Inventory Maintenance-> Synch 
Rental Qty with QOH  

Menu: Setup->Inventory Maintenance->Synch Rental Qty with QOH  

Action: SYNCRENT 

 

Available with optional Tuxedo Rental production module. 



WinPOS Version 11 

574 

This utility will correct an error situation between your Rental Inventory quantity on hand totals 
found on the Inventory SCW form and the Rental Sizes form.  For inventory rental styles, the 
SCW quantity for a SIZE should equal the RENTAL SIZE quantity on hand. A error situation 
exists when these two quantities do not equal. 

WinTPS automatically keeps these on hand quantities equal by modifying the newest PO 
RECEIVE history entry for a style size. 

This utility will modify Inventory Total QOH found within the Inventory-> SCW form of styles 
marked as rental inventory. This utility program will make the SCW style's total QOH per size 
equal to the Rentable availability quantity of each size for that style.   

In WinTPS© the Total QOH shown on the Inventory Style Color Width (SCW) form (RETLINV) 
is the total units owned.  The SCW quantity on hand is automatically updated as SIZES are 
entered on the Rental Size form  

Rental quantities can be entered before the actual inventory has been received via Receive 
History function of inventory. When this happens the rental qty can be greater than the total 
inventory QOH.  Typically it is recommended that inventory is received from Purchase Orders 
via the style's SCW form, then the rental details of the style update, ie. bar-codes scanned, 
rentable quantities entered. 

During inventory creation many companies find it is faster to enter the rental quantities within 
the Rental SIZE form prior to receiving the total quantities owned in the style's SCW form, 
particularly during the initial inventory load.  

The system uses the total quantity on hand in the SCW form for inventory value computations 
making this number an important bit of information. 

 

Rental Package Pricing 

Package Pricing for Rental Orders 

 

Introduction 

This is a WinTPS® & WinTPOS® feature only. 

Package pricing is a marketing tool to provide package rental order pricing to the rental 
operation for their retail stores and wholesale accounts.  Typically the package would cost less 
than "a la cart" pricing, i.e per rental style.   

Package pricing is good tool to attempt to up sale customers on more expensive rental items 
and/or as special price incentives to drive them to the store.  Advertised promotions and/or 
coupons can be a great motivator to drive customers to the store and to request the special 
pricing.  When the customer asks for the special priced packages, the clerk can simply apply the 
package to a new or existing rental order from the order entry form.  Package pricing codes 
requires frequent updating to insure it is in step with the current active promotions.  This tool 
makes it easy for clerks to get the pricing correct! 

Catalog Codes (as pictured codes)  is another simple type of Package Pricing but cannot handle 
complex rental style combinations.  A good practice is to NOT use Catalog Code discounts and 
Group Package pricing on the same order.  Catalog Code markdowns are applied to the rental 
order and remain unless manually removed by the clerk.  If both are used the rental order price 
may be too low. 

Group Package Pricing is NOT required for rental orders.  Many companies pricing 
requirements are satisfied with the WinTPS/TPOS standard with coat or without coat pricing 
found in inventory setup. 
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Package Pricing is accomplished by creating Price Group codes for coats and accessories, 
each with a retail and optional wholesale (used with WinTPS optional Accounts Receivable 
module)  package price.  Once created, accessory price group codes are linked to coat price 
group codes   Finally, the Package Pricing codes are assigned to their appropriate inventory 
rental styles.  Rental accessory styles must be classified as ACCESSORY rental item types 
before they can be linked to an accessory price group.  This is accomplished via the Item Type 
form. 

Package Pricing works hand in hand with the style's price with coat and price without coat 
inventory rental pricing.  By default the order is created utilizing the standard pricing.  An 
operator may choose to apply a package price to the order by checking the Apply Package 
Price checkbox found on the Order-> Items tab.  (Package Pricing may be removed as well by 
un-checking the box). When checked the  per item rental price displayed on the order 
dynamically adjusts to reflect the package price. 

Any changes to rental order pricing after the order is initially created results in an adjustment 
transaction being automatically placed upon the order's ticket.  Toggling the order's Package 
Pricing setting after the order is saved will activate the order change logging when it is enabled 
within System settings-> rental tab-> Keep Order Change History. 

A coat must be on the order with a package price code assigned to have access to any special 
package pricing.  Steps to implement: 

1) Create Coat Package price group codes with retail/wholesale prices.  Any coat style linked to 
the code will be rented for the entered price when the package is applied on the rental order. 

2) Create Accessory Package price group codes with prices.  Each accessory style linked to the 
Accessory code will be rented for the entered price when the package is applied on the rental. 
 Mixed item types, ie pants, shirts, vest, ties ..etc may be linked to the same accessory package 
code.  Usually accessory styles of the same type, ie vests are linked to a particular Accessory 
Package Code. 

3)  Link Accessory Package price group codes to Coat package codes.  A Coat Package code 
may have multiple accessory codes linked.  ie SPG12SHOEG,  SPG12VESTG 

4) Assign the appropriate COAT or ACCESSORY Package Price Group Code to each style (a 
style is NOT required to have a price group code assigned) 

5)  Each COAT or ACCESSORY package price code has it's standard default retail/wholesale 
price, but as an option each may have store specific pricing as well.  Example, a store located in 
a more affluent area may have higher package pricing than the rest of the store since prices 
may not be as sensitive.  Create store specific pricing as necessary. 

6) Create rental orders and check the Apply Package Price checkbox found on the order entry 
form to apply the package price. 

The Package Price Group price applied, i.e. Retail or Wholesale) is determined by the Pickup 
Location assigned to the rental order and it's Pricing/Type setting, Wholesale or Retail, in the 
 Store/Accounts form.  

Group Package Pricing allows for many combinations.   

Tip 

Start with writing down your rental order pricing strategy.  Price packages may not be 
required for your needs.  Do NOT include references to the codes package  price within it's 
name. Pricing may change and you would not want to create new codes for the new prices. 
 This way when prices for packages change the code name will not have to change too. 

Coat and Accessory price codes must be unique.  They cannot have the same name.   

A accessory style or coat style can only be assigned to one Package Price code at a time.  It 
can be changed, but only one is allowed per style.  
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Example Package Codes 

 Example Package Price Code used on styles and orders 

   

Coat  

Price 
Group 

Code 

Accessory  

Price 
Group 
Code 
linked 

to the coat 
code 

Package 
price 

Retail or 
Wholesale 

Code 
Type 

COATTIER1  $124 Coat 

 ACCBASIC $0 Accessory 

COATTIER2  $149 Coat 

 ACCSHOE $5 Accessory 

 ACCBASIC $0 Accessory 

COATTIER3  $179 Coat 

 ACCSHOE $5 Accessory 

 ACCVEST $0 Accessory 

 ACCPLAT $5 Accessory 

 

 

Example application of Codes to Inventory Rental Styles 

 

Styles Price 
Group 

Price 
assigned 
to 
Package 
code 

Style's 
Standard 

 Inventory 
Price 
w/coat 

Style's 
Standard 
Inventory 
Price 
without 
coat 

COAT 
STYLES 

    

C100 COATTIER1 $124 $110 $0 

C110 COATTIER2 $149 $135 $0 

C120 COATTIER3 $179 $150 $0 

C130   $140 $0 

     

SHIRT 
STYLES 

    



Optional  Modules 

577 

S100 ACCBASIC $0 $0 $10 

S105 ACCPLAT $0 $5 $15 

S110   $10 $25 

     

PANT 
STYLES 

    

P100   $0 $15 

     

VEST 
STYLES 

    

V100 ACCBASIC $0 $25 $30 

V110 ACCVEST  $35 $45 

     

SHOE 
STYLES 

    

H100 ACCSHOE $5 $25 $30 

H110   $30 $35 

     

 

Package Pricing Applied to orders 

 

Styles Package 
Code 

Package 
Price 

Standard 
Pricing 
(No 
package 
price 
applied) 

Order 
1 

   

C100 COATTIER1 $124 $110 

S100 ACCBASIC $0 $0 

P100  $0 $0 

V100 ACCBASIC $0 $25 

H100  $25 $25 

  $149 $160 

Order 
2 

   

C110 COATTIER2 $149 $135 
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S105  $5 $5 

P100  $0 $0 

V100 ACCBASIC $0 $25 

H100 ACCSHOE $5 $25 

  $159 $190 

Order 
3 

   

C120 COATTIER3 $179 $150 

S105 ACCTPLAT $5 $5 

P100  $0 $0 

V110 ACCVEST $0 $35 

H100 ACCSHOE $5 $25 

  $189 $215 

Order 
4 

   

S100  N/A $10 

V110  N/A $45 

H100  N/A $30 

   $85 

 

Coat Package Price Group Codes 

Switchboard: Main->Housekeeping->Inventory Setup->Coat Price Group Codes  

Menu: Setup->Rental Inventory Setup->Coat Price Group Codes  

Action: PRICEGRP 

 

Set-Up 

Coat Package price group codes are created on this Coat price group form and Accessory price 
group codes are created in the Accessory price group form. 

Once a code is created assign the code to the appropriate inventory styles.  Assigning styles to 
codes may be accomplished from the coat or accessory form or by visiting each style within 
Inventory and assign the package code on the rental tab.  See Package Pricing for Rental 
Orders topic for operational features. 

 

Coat package price group form 

Fields 

Coat Price group... This is the 10 character alpha numeric code for this specific price group. 
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Wholesale... The default price to charge for store/accounts set to Pricing/Type of WHOLESALE. 
 The rental order's pickup location determines the pricing used when store specific pricing 
is utilized. 

Retail... The default price to charge for store/accounts set to Pricing/Type of RETAIL.   The rental 
order's pickup location determines the pricing used when store specific pricing is utilized. 

Coat price Group GRID... See all the coat price groups created within the grid.  Use the Search 
For field to locate a coat price group name within the grid.  Select the desired coat price 
group and the field data within all of the form's grids (Accessory, Store Pricing and Style 
grids) apply to that coat price group. 

Buttons 

Save... Saves any changes made to the data of a form. 

Cancel... Throws away any changes made to the data of a form. 

Delete... Deletes the current displayed data.  Deleted data cannot be recalled.  Cannot be 
selected while data changes are pending.  Data changes must be SAVED or 
CANCELLED before. 

Add... Adds a new set of information to the form.   Cannot be selected while data changes are 
pending.  Data changes must be SAVED or CANCELLED before. 

Done... Exits the form and returns to the previous form or menu.   Cannot be selected while data 
changes are pending.  Data changes must be SAVED or CANCELLED before. 

 

Store Pricing Grid 

Fields 

Store...The store/account location code that the entered store price applies to.  

Price... The price for the coat package price code.  The order's pickup location entered 
store/account code sets the price for the order. 

Buttons 

Add Item... Adds a new line to the grid.  Click into the cell and type in the desired information. 

Delete Item... Deletes selected grid line item. 

 

Accessory Groups for Coat Grid 

Fields 

Use F2 for lookup. 

Accessory group code... Accessory codes and their prices are created on the Accessories 
Package Price Group form.  Use this grid to assign the  Accessory Price Groups to this 
Coat price group.  Press F2 to perform a lookup of all available accessory codes. 
 Multiple accessory groups may be assigned. 

Buttons 

Add Item... Adds a new line to the grid.  Click into the cell and type in the desired information. 

Delete Item... Deletes selected grid line item. 

 

Styles Grid 

Use F2 for lookup. 
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Fields 

Styles... Coat package price groups must be assigned to styles.  This can be accomplished from 
the Inventory-> Rental tab and also from this grid. Enter the Styles to assign this coat 
price group to. 

When a inventory item is discontinued, it will not be listed in inventory style lookups for entry 
onto rental orders, however the style may be manually entered.  Multiple coat styles may be 
entered/linked to the code. 

Buttons 

Add Item... Adds a new line to the grid.  Click into the cell and type in the desired information. 

Delete Item... Deletes selected grid line item. 

 

 

 

Accessory Package Price Group Codes 

Switchboard: Main->Housekeeping->Inventory Setup->Coat Price Group Codes  

Menu: Setup->Rental Inventory->Coat Price Group Codes 

Action: PRICEGRP 

Set-Up 

Accessory Package price group codes are created on the Accessory price group form (this 
form)  and Coat price group codes are created in the Coat price group form. 

Once the codes are created assign the codes to the appropriate inventory styles and link the 
Accessory code to Coat Package price codes.  Assigning styles to codes may be accomplished 
from the  accessory form or by visiting each style within Inventory and assign the package code 
on the rental tab.  See Package Pricing for Rental Orders topic for operational features. 

Note 

A accessory group code is linked to coat price group codes.  A coat must be found on a 
rental order with a coat price group code assigned, before any price packages can be 
applied.  Accessory Package price codes are assigned to Coat Package Price Codes on the 
Coat Package Price group form. 

 

Accessory package price group form 

Fields 

Accessory Price group... This is the code for this specific group.  Code names must be unique. 

Wholesale... The default price to charge for store/accounts set to Pricing/Type of WHOLESALE. 
 The rental order's pickup location determines the pricing used when store specific pricing 
is utilized. 

Retail... The default price to charge for store/accounts set to Pricing/Type of RETAIL.   The rental 
order's pickup location determines the pricing used when store specific pricing is utilized. 

Accessory price Group GRID... See all the accessory price groups created.  Use the Search 
For field to locate a accessory price group name within the grid.  Select the desired 
accessory price group and the field data and data within the Store Pricing and Style grids 
apply to that coat price group. 

Buttons 
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Save... Saves any changes made to the data of a form. 

Cancel... Throws away any changes made to the data of a form. 

Delete... Deletes the current displayed data.  Deleted data cannot be recalled.  Cannot be 
selected while data changes are pending.  Data changes must be SAVED or 
CANCELLED before. 

Add... Adds a new set of information to the form.   Cannot be selected while data changes are 
pending.  Data changes must be SAVED or CANCELLED before. 

Done... Exits the form and returns to the previous form or menu.   Cannot be selected while data 
changes are pending.  Data changes must be SAVED or CANCELLED before. 

 

Store Pricing Grid 

Fields 

Store...The store/account location code that the entered store price applies to. 

Price... The price for the accessory package price code.  The order's pickup location entered 
store/account code sets the price for the order. 

Buttons 

Add Item... Adds a new line to the grid.  Click into the cell and type in the desired information. 

Delete Item... Deletes selected grid line item. 

 

Styles Grid 

Fields 

Use F2 for lookup. 

Styles... Accessory package price groups must be assigned to styles.  This can be accomplished 
from the Inventory-> Rental tab and also from this grid. Enter the Styles to assign this 
accessory price group to. 

When a inventory item is discontinued, it will not be listed in inventory style lookups for entry 
onto rental orders, however the style may be manually entered.  Styles of multiple item types 
may be entered.  Usually styles of the same item type is entered for simplicity.  When utilized 
on a rental order each style linked to this code will be rented for the accessory price entered. 
 Example, if a pant, shirt, vest & shoe was linked to a single accessory code and the price 
was set to $5, then each of the items would be priced to $5 each when the package price is 
applied. 

Buttons 

Add Item... Adds a new line to the grid.  Click into the cell and type in the desired rental style 
code. 

Delete Item... Deletes selected grid line item. 

 

 

 

Close Out Old Rental Orders 

Switchboard:  

Menu:  
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Action: CLOSEOLD 
 
This utility is deprecated and is no longer included in modern versions of the program.  This 
topic appears for historical reference only. 

Used in the WinTPS® or WinTPOS® optional software modules.  This utility cleans up the 
statuses on old rental order line items.  Normally, a rental orders final status is Done, once it's 
been returned and laundered.  However, a line item can end up with another status if steps are 
skipped during the production process.  A particular serial number can be rented out, returned, 
and used on another rental order, even though the first order was never returned.  In this case, 
the serial number can appear on two rental orders, both with statuses of Out, for example.  The 
system attempts to correct these statuses as inventory is processed for future orders.  However 
situations may occur where this is not possible for all inventory. 

This utility scans all the rental orders and set the status of older line items to Done and may be 
ran often to insure proper statues are assigned. 

 Please review the "Order Item Status" topic for more information on order line item statuses. 

 

Rental Inventory Physical 

Rental Physlcal Overview 

The Rental Physical Inventory forms are found on Housekeeping->Rental Setup->Rental 
Physical. 

Every rental operation needs to perform a physical count of their inventory periodically to 
maintain accurate inventory quantities.  These tools are designed for the counting of tracked 
rental inventory items (items with Serial/Barcode IDs). 

WinPOS® offers tools for performing a physical inventory count, reconciling the physical count 
prior to posting and then permanently posting the count to the inventory 

Rental physical counts are performed for the entire inventory, or a specific item type, or a 
specific style. In any case, only tracked items (those with barcodes/ID numbers) are counted 
thru the WinPOS® Rental Physical tools.   

A rental physical is normally performed over a period of days, while production operations are in 
progress. The inventory on-hand (in the warehouse) is counted manually.  Then as items are 
assembled, returned, and returned from laundry they are automatically added to the physical 
count file by the system. A Physical should span several days, long enough for the inventory run 
a complete cycle, then closed and the tracked inventory permanently updated.  

Rental items that do not appear in the physical count are marked as UNAVAILABLE for rental. 
 If the inventory status of the item is empty WinPOS will also change the status description to 
LOST otherwise it will NOT alter the status description.  Some operators may place items on 
DISPLAY within stores.  A few operators will mark these items as AVAILABLE for rental while 
others may mark them UNAVAILABLE.  Operators whom mark them available must remember 
to count those items or WinPOS© will mark them UNAVAILABLE during this physical process..   

Optionally, via the Mark Found items to available for rental checkbox, items that do appear 
(i.e. Counted) in the physical count but may have been previously marked as unavailable for 
rental can be returned to use.  Normally this option is checked (ENABLED) to make those items 
available when counted, for example, items that were previously marked LOST but are now 
counted will be marked IN & available for renting.   

Care should be exercised to NOT count rental inventory items currently marked unavailable for 
rental in the system that should remain marked unavailable.  For example RETIRED inventory 
items.  Usually the status should remain RETIRED and remained marked UNAVAILABLE for 
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rental.  The solution is to not to count/scan those type of items.  Items marked UNAVAILABLE 
for rental prior to the physical will not be altered when not counted/scanned during the physical. 

Note: 

The rental physical update affects the statues of rental items and their rental availability. 
 The physical update program will also force the Inventory SCW on hand quantity for a rental 
style to equal the rental availability quantity.  The synchronism of the SCW quantity on hand 
to the renal availability count may be manually performed without performing a physical 
count via the Sync Rental Quantity with QOH function. 

 

Proper counts are vital for vlaue reporting and rental inventory reservation availability. The 
Rental Inventory Report prints a inventory value.  This value is Quantity on Hand * Average Unit 
cost.  This is why it is important to maintain accurate Quantity on hand counts and to enter 
invoice costs as new stock is received.  Average unit cost is calculated for the SCW Receive 
form. 

A Physical take must be set in the Rental Physical Inventory form.  Multiple physical counts 
spanning multiple styles/items types may be in progress at the same time. 

There are three different methods for performing the actual physical. 

1) Manually entered 

This method has three steps. 

  Step 1: 

a) A shop’s employees manually counts each item, document the item’s serial or control 
number on paper. 

b) Start WinPOS©, navigate to the Physical Inventory Form, Add a new Physical by 
entering the Start/End dates and the type, or style to be counted & click the Physical 
button.  Now bring each garment to a terminal with a barcode scanner and scan the 
item. 

Step 2: 

This step is required for a manually entered physical (no barcode readers used) Start 
WinPOS©, navigate to the Physical Inventory Form, Create/Add a new Physical by entering 
the Start/End dates and the item type, or style to be counted & click the Physical button. 
 Now the operator must key in each of the barcode numbers.  

Step 3: 

Run Exception reports (Exception Report - Items in inventory not found in physical count) 
and then permanently post (Update function) counts to inventory. 

 

2) Scanned via hand-held Portable Scanner - Batch (equipment is available thru BBL) 

This method involves three steps. 

  Step 1: 

A employee will walk around the business with a portable bar-code scanner. Each 
item’s serial/control number is scanned. 

  Step 2: 

The Scanner is then attached to the appropriate PC and the serial/control numbers are 
automatically uploaded like being typed at a keyboard. This method is much faster and 
accurate than performing the count manually. However, this method does not validate 
the serial/control numbers scanned, meaning erroneous items can be introduced when 
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barcodes do not scan properly. This bad data must be adjusted for when a test 
inventory posting is performed. 

  Step 3: 

Run Exception reports (Exception Report - Items in inventory not found in physical count) 
and then permanently post (Update function) counts to inventory. 

 

3) Import a serial number count from a ascii text file.  Within the file each inventory items 
serial/barcode should appear on a separate line. Example 

12345678 

87654321 

89898989 

... etc 

This method involves three steps. 

  Step 1: 

A employee counts the inventory by entering each item’s serial/control number. With it 
inputted into a ASCII text file. 

  Step 2: 

Import the text file physical count into the system. 

  Step 3: 

Run Exception reports (Exception Report - Items in inventory not found in physical count) 
and then permanently post (Update function) counts to inventory. 

 

 

 

Rental Physical Process 

The steps to perform a physical are as follows: 

1. Start a new Physical, using the Rental Physical form, located at Main-
>Houskeeping->Rental Setup->Rental Physical->Physical Inventory (PHYSEDIT) 
click Add, Enter the Start and End dates, and optionally an Item type or Style. 

2. Either scan and upload or manually enter the serial/control numbers of the items 
counted, via the Physical  button located on the Physical Inventory (PHYSEDIT) 
form. 

3. Allow the Physical to remain open long (enough time via the Start/End date range) 
 enough for the OUT (not in warehouse)  items to be returned. These items, as 
Returned, are added to the physical file automatically. 

4. Run a Rental Inventory Report for any inventory items  that will be considered part of 
a Physical, but will not be scanned/entered into the physical count due to some 
circumstance.  Example1, items may have a inventory item status of DISPLAY and 
are not in the warehouse & will not be returned during the Physical timeframe.  The 
serial/ID numbers of these items must be entered into the physical count of the 
Physical.  Otherwise the Update function will uncheck the Currently Available? 
setting and change the item status to LOST.  
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5. Run a QUERY for OUT Orders between a date range for the style the Physical is 
being completed for (Contact BBL for help with this report).  Any items on the report 
that will not be RETURNED during the Physical date range should be manually 
added to the physical count for that Physical.  Otherwise the Update function will 
uncheck the Currently Available? setting and change the item status to LOST. 

6. Run the Exception report for the Physical in progress. It will list ALL items not 
counted (not in the physical count file).. If more items are appearing than would be 
expected, check to make sure that  parts of the inventory were not missed during 
scanning. Also insure that the physical has been open long enough for items to 
cycle back through production. 

7. Run the Physical Listing report.  It will show all items counted (contained in the 
physical count file).  It is particularly useful to catch data entry mistakes.  It will list 
barcodes/ID numbers as unknown if it can't find a match in the rental inventory. 

8. Finally, use the Update Inventory (UPDRINV) form, located at Main->Housekeeping-
>Rental Setup->Rental Physical to actually update inventory.  Select the Physical 
you want to apply and click OK. 

This function will permanently update the rental inventory.  It will un-check the Currently 
Available? setting (indicating the item cannot be rented) and make the item status LOST if 
it's barcode was not entered in the physical count file and the current setting for the 
inventory item is Currently Available for rental with NO STATUS entered.    The function will 
NOT overwrite previously entered statuses. 

If “Mark items found as available for rental?” is checked at the beginning of the Update 
function, then any items counted are currently unchecked as Currently Available? will be 
checked allowing them to be rented. 

Rental Physical Inventory 

Switchboard: Main->Housekeeping->Rental Setup->Rental Physical->Rental Physical Inventory  

Menu: Setup->Rental Physical Inventory->Rental Physical Inventory  

Action: PHYSEDIT 

This form is used to start a new or edit an existing rental Physical count file. A rental physical 
count has a start and end date, and optionally an item type or style. 

Grid 

Select the Rental Physical to work with from the grid.  Once the correct physical work file is 
selected simply click the Physical Button to add/edit bar-codes scanned for that physical. 

Physicals may be searched for by their ID.  A ID is automatically created by WinTPS© when the 
physical is created by the user.  A manual Log of the physical may be maintained to help users 
to identify the correct physical count work file for processing. 

A new Physical should be created when an appropriate existing Physical work file does not 
exist. 

 

Fields 

Physical ID....The ID number for the physical, automatically assigned byWinTPS© 

Start/End....The starting and ending dates for this physical. As items are assembled, returned, 
and laundered, they will automatically be added to this physical if they are assembled, 
returned, or laundered within this date range. 

Item type....Optionally limit this physical to the specified item type. 

Store style....Optionally limit this physical to the specified store style number. 
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Buttons 

Batch Physical…Displays the Physical Item form, used by the operator to  enter the bar-
code/serial or control numbers for this rental Physical.  Items can be scanned or manually 
entered in this area.  Barcodes/ID numbers are not validated against the inventory when 
entered.  The counts for the currently selected Inventory ID/work file. 

Validated Serial Entry... Displays the Physical Item form, used by the operator to  enter the bar-
code/serial or control numbers for this rental Physical.  Items can be scanned or manually 
entered in this area.  Barcodes/ID numbers are Validated against the inventory when 
entered helping to protect against bad bar-code scans.  Once an tracked item is scanned 
previous order statuses are updated when needed.  It will change item's order status to 
DONE when status is picked up, shipped back or shipped to wholesale.  The counts for 
the currently selected Inventory ID/work file. 

Text File Import... Allows the user to navigate to a text file that contains barcodes/serial numbers 
of the counted inventory.  Multiple imports may occur.  Each import is added to the 
previous.  The counts are for the currently selected Inventory ID/work file. 

Delete...Deletes the selected Physical information and all scanned items associated to that 
physical work file. 

Add...Creates a new physical work file.  The new Physical take created must be saved before 
rental inventory can be scanned/entered. 

Done...Exits the form and returns to the calling form. 

Save...Saves any changes made to the data. 

Cancel...Cancels all changes made to the data. 

Update Rental Inventory 

Switchboard: Main->Housekeeping->Rental Setup->Rental Physical->Update Rental Inventory  

Menu: Setup->Rental Physical Inventory->Update Rental Inventory 

Action: UPDRINV 

 

Use this function to permanently apply the count of a Physical to the inventory once the actual 
physical count of a Physical has been completed, i.e. all items are entered into the physical 
count file.  When the Update button is clicked, WinTPS© will mark any items not counted as 
unavailable for rental, and set their status to LOST. It will only process items of the correct item 
type or style, if the physical was set up to be limited to an item type or style. 

Once the inventory file is UPDATED the system will insert the current system date into the 
Physical work file.  A user may re-Apply an physical count.  They system will warn the user if the 
rental physical work file as been previously applied. 

 

Criteria 

Physical....Use the lookup button to select a rental physical. 

Mark found items as available for rental?…If checked, then items scanned that were 
previously marked as unavailable for rental will be marked available for rental. 

 

Rental Physical Listing Report 
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Switchboard: Main->Houskeeping->Rental Setup->Rental Physical->Physical Inv Listing  

Menu: Setup->Rental Physical Inventory->Physical Inv Listing 

Action: RP_RPHYS 

This report lists all the serial/control numbers counted for a particular Physical, including the 
item type, style, description, and size. Any serial/control numbers that cannot be found in the 
Rental Inventory are shown as Unknown.  This could be a result of BAD scans of the barcode 
or that the inventory was not put into the system. 

This report is useful to audit the serial/control numbers actually counted.  Verify the proper items 
are showing on the report, i.e. Item type and/or Style.  Use the report as a worksheet tot Delete 
any incorrect items from the physical count file of the Physical.. 

Criteria 

Physical ID...Enter the ID of the Physical Work file to compare inventory against. 

Sort by Item Type...Sort by the rental inventory Item Type, i.e. COAT where all coats will be 
listed together. 

OR 

Sort by Order of Scan...Sort by the order in which the items were scanned into the work file. 
 This is a good method to locate items after being scanned that may have not been put 
into the system.  In this case the system has no information about the item,i.e. no 
description or item type and it is hard to locate them without this information.  These type 
items will be listed on the report as Unknown. 

Rental Physical Exceptions Report 

Switchboard: Main->Houskeeping->Rental Setup->Rental Physical->Exceptions Reports  

Menu: Setup->Rental Physical Inventory->Exceptions Reports  

Action: RP_RPHYSEX 

This report lists all the serial/control numbers in inventory that were NOT counted in the physical 
count file. The user must first choose the physical to report on. This report is useful as a 
worksheet to insure that portions of the inventory were not missed during the physical count 
process.  An rental physical work file may be modified when the Exception report identifies any 
errors to the user.  This report should always be checked prior to permanently updating the 
rental inventory with the count.  Any inventory checked as 'Service/not inventoried?' will not be 
included on physical exception reports. 

Production Process 

Rental Production Work Flow 

The actual day to day operation of the WinTPS© production system will commence once it’s 
operational set-up is complete.  

The Production work flow is outlined within this topic. Operation of the WinTPS© system 
requires discipline. Each step within the work flow should be completed before the following 
step can be started. Trying to shortcut or skip steps will result in the system not providing the 
increased work efficiency it is designed for.  
 

1. Order Entry: There exists two methods to create orders, a) via the 
Point of Sale features of WinTPOS© for retail end-user customers and 
b) from the Wholesale Order Entry form for wholesale only type 
accounts.  
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2. Check Overbookings: WinTPS© will allow production management to 
see into the future those rental inventory items that are overbooked. A 
operator should enter the quantity to sub-rent or purchase new 
inventory.  

3. Print Production Tickets for the desired period & store/accounts.  

4. Assemble/QC the orders contained on the Production Tickets 

5. Ship the Orders for wholesale accounts and remote stores (optional 
for local store) 

6. Return items from orders. Retail customers Return items from Orders 
via the WinTPOS© customer return functions. Return items from 
wholesale accounts and/or remote stores via the WinTPS© 
Production Return module. 

7. Send to Laundry those items that need cleaning (optional step) 

8. Return from laundry those items coming back (required if send to 
Laundry was used) 

9. Follow-up with late orders, via the Late Order Report.  

10. Mark orders Lost and charge the customer/wholesale account the 
replacement cost. Automatically done via the WinTPOS© customer 
return function for retail customers. Use the Process Lost Orders 
function to convert wholesale account late items to Lost & to ring up 
replacement charges on invoices. 

11. Maintain proper inventory on-hand levels via Rental Inventory 
maintenance. Receive/Add new inventory, add serial/id numbers for 
tracked items or quantities for non-tracked items. Mark tracked 
inventory available/not available for rental as needed. 

Production Documents 
 

WinTPS Plant prints several documents during the production management process.  

These production documents include: 

 

Document/Report Description 

Rental Order 
Receipt 

Available in WinTPS© 
& WinTPOS©. Use as 
order audit trail until 
next backup and/or as a 
retail customer rental 
receipt 

Picking/Production 
Ticket 

WinTPS© document 
that is used as a 
worksheet for pulling an 
rental order’s items. It is 
a recap of the order. 
Several formats are 
available to meet 
different production 
requirements. Contact 
BBL for more 
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information. 

Packing Slip Optionally printed by 
WinTPS© at order ship 
time. It will contain a list 
of all the orders in that 
shipment. 

Invoice Optionally printed by 
WinTPS© at order ship 
time or may be printed 
on demand. It will 
contain a list of all 
charges created for the 
account, including 
rental orders shipped, 
since the last invoice 
printing. 

In Laundry List Printed for a specific 
bag/batch number or by 
items with Wait Laundry 
status grouped by Item 
Type, Style & size 

From Laundry ‘ID 
Tag’ 

Optional document 
printed by WinTPS© 
when a serialized/bar-
coded item is returned 
from laundry. It can 
contain the item’s 
storage location, style, 
size and bar-coded 
serial number making it 
easier to identify the 
next time needed for an 
order. 

 

Other production reports are available via the Production Reports menu. 

Wholesale Order Entry 

 

Switchboard: Main->Rental Production->Wholesale Order Entry  

Menu: Rental->Production->Wholesale Order Entry  

Action: ORDRENTY 
 

Overview 

The Wholesale Order Entry form provides a centralized and easy to use form to provide 
customer service and order entry support to accounts that sub-rent rental inventory or purchase 
new retail inventory.  Security is available for this form via the ORDRENTY setting.     

This form contains business information pertinent  to wholesale rental accounts ((WinTPS© 
wholesale support is via Accounts Receivable, an optional module), additionally easy access  to 
each company owned store's orders is available. 
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This form must contain an entry for each store location owned and each wholesale account. 
 Store's and account's information is created and maintained via the Housekeeping-> General 
Setup-> Stores form. 

Note 

Service Center/Warehouse Registers (workstations) should be assigned  to a Service 
Center/Warehouse production store/account location code that could be created in the 
Store/Account form and this store/account location should be set to a Pricing/Type of 
WHOLESALE within that form   

 

Note 

Orders created to be shipped to accounts set to a Pricing/Type of WHOLESALE within the 
Store/Account form are defined as WHOLESALE Orders.  These orders cannot be viewed 
by registers assigned to Store/Accounts set to a Pricing/Type of RETAIL. 

 

The Wholesale Order Entry form is comprised of one data screen.  Select the Store or Account 
line in the grid.  The location number or location name may be searched.  Click the column 
heading to for it to be placed in the leftmost column, thus making it the active search column. 

Wholesale Account Support 

This Wholesale Order Entry form will be the screen for ALL wholesale order entry and 
wholesale account management. The form allows existing invoices to be viewed & 
printed/re-printed, sales to be created, existing rental orders to be reviewed, new rental 
orders created and payments processed. This form becomes the central focal point for 
wholesale account customer service. 

A user can click the New Sale, New Rental, or View Rentals button without any special 
security. However, it requires RESVCHNG security to click Payments or Invoice, and to 
make any changes to the store/account information. 

 

Field Definitions 

Store number...A unique code that identifies this store or account that is manually created by the 
operator. 

Store name…The name of the store/account 

Shipping Address 1 & 2, City, State, Zip…The shipping address of the store/account. 

Bill to button... Show the selected account's billing information including address & phone 
numbers. 

Contact name…The primary contact’s name. 

Email… The primary contact email address. Double click the email address to automatically bring 
up your computer’s defined email client software with the email address already entered 
in the TO field. 

Notes Button…A place to type in any information about the store or account. 

Credit Card / Update Credit Card Button... With the optional integration with Payware 
Connect/IP Charge credit card processing software operators are able to save each 
account's credit cards online so they may be retrieved quickly and securely for payments. 

Pricing/Type.… Rental order pricing. Options are: Retail or Wholesale.  
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Pricing is set for each item within Inventory - Details tab and the Catalog Codes (As 
Pictured) setup. WinTPS/TPOS allows for two rental price levels to be assigned to Inventory 
styles and Catalog Codes, described as Retail and Wholesale.  

The option selected in this field determines which price is applied to the order, Retail or 
Wholesale for this specific store/account. 

The assumption is that Retail will be for company owned stores who typically are renting to 
retail customers whom will be paying via a retail ticket. Wholesale is normally considered for 
accounts that are invoiced for their rentals & purchases, however you may setup a 
store/account that will be charge at retail pricing and invoiced for the rentals/purchases.  For 
example, the rental shop may have an relationship with a local hotel that sends employees 
over to rent or purchase items from time to time and wished to be invoiced for those 
purchases.   Typically you may charge the hotel retail and provides a markdown at invoicing. 
 This can be easily handled thru this setup. 

Additional discounts may be automatically applied to invoiced store/accounts via the 
Markdown codes & percentages described later in this topic. 

The pricing applied on an rental order is determined by the Pick-Up location entered on the 
rental order. NOT the location where ordered. 

The retail pricing is determined by the register's store id where the retail sale was created. 
 Store retail pricing on rentals is set via Inventory Rental Tab & Store Rental Pricing forms. 

 

Class… The class is the field that is used to categorize stores/accounts. Classes must first be 
defined using housekeeping-> General Setup-> Store/Account Classes.  Used with some 
reports and the printing of Picking Tickets. 

 

Terms…Terms indicate how the store/account will be charged for the rental and sales 
transactions. Invoice, Retail Ticket or None (no financial transaction). 

Invoice Terms creates invoices for store/accounts that include descriptive information about 
prompt payment discounts & due dates (wholesale) OR  

Ticket creates retail sale tickets (for on-line retail stores with optional multi-store module) and 
REQUIRES "Require customer cards for orders?" option to be enabled (checked). 

None will not create any financial transactions (used for remote stand alone stores manually 
entering their own rental orders). 

The terms that will create Invoices are: 

Cash Only (COD), COD, Net, X% EOM, Net 10 EOM, Net 30, X% net 30,  

X% 10 Net 30, X% 20 Net 30, Custom 

 

WinTPS prints the payment terms on the invoice will age open balances on the Accounts 
Receivable Statement per the terms.  

Cash Only & COD Terms will create & automatically print a invoice when any rental order 
shipment is processed for the store/account.  

The Term None will indicate to WinTPS to NOT create a Sales Ticket & financial transation 
for a rental order. This is typically utilized for company owned stores where their rental 
orders are manually entered. This scenario is where the store is creating paper based rental 
orders. Operators would eventually enter the orders into WinTPS, but will not utilize it’s 
customer tracking capabilities. 

The Term Ticket is for company stores using WinTPOS software for customer tracking. This 
option will create the Sales Ticket and order transaction used to process payments and 
additional sales. 
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Days… … Used by WinTPS for the Custom terms option. Prints the payment term days on the 
invoice for the account & uses the day for aging the statements. 

Discount… Used by WinTPS for the Custom and X% terms options. Prints the payment term 
discount on the invoice for the account. 

Credit Limit… WinTPS wholesale feature that allows a maximum credit limit to be created for 
this account. Once created the system will monitor and not allow shipping to continue to 
the account if the credit limit is exceeded.  

Rental markdown/Rental adj amt … The markdown code and adj. amt entered will be applied to 
every rental created for this store/account. The markdown will be applied when the 
invoice is created for the customer. The markdown code/adj amt is optional.  Leave blank 
for no discounts. 

Applies to... Options are Sales, Rentals or Both.  Instructs the system to what type of invoice 
transactions to apply the markdown discount to. 

 

Credit (Display Only)… WinTPS© wholesale feature. This is the total credits due the account. 
This happens when the account has paid more that what they owe. Typically it appears 
when an adjustment was made to an invoice that was already paid. The credit can be 
used via the Payments form to apply the credit to other invoice balances or given as a 
refund to the account. 

Un-invoiced...WinTPS© wholesale feature. The total charges for all transactions that have not 
been invoiced.  This includes future rental orders that has not been shipped. 

Invoiced total...WinTPS© wholesale feature. The total amount of all invoices on file for this 
store/account. This total includes invoices paid as well as un-paid/open invoices. 

Invoice balance...WinTPS© wholesale feature. The total amount open on invoices from the 
store/account.   

Balance (Display only)…WinTPS© wholesale feature. This is the total amount of all rental 
orders and retail sales that may or may not be delivered yet. The total includes rental 
orders not shipped. 

 

Total Retail purchases (Display only)…WinTPS wholesale feature. The total of all retail sales 
to this account since it’s creation. 

YTD Retail purchases (Display only)… WinTPS wholesale feature. The total of all YTD retail 
sales (a year is defined as Jan 1 to Dec 31) to this account. 

Last retail sale (Display only)… WinTPS wholesale feature. The last retail sales date to this 
account. 

 

Total rental (Display only)… WinTPS wholesale feature. The total of all rental revenue to this 
account since it’s creation. 

YTD rental (Display only)… WinTPS wholesale feature. The total of all YTD rental reveneue (a 
year is defined as Jan 1 to Dec 31) to this account. 

Last rental (Display only)… WinTPS wholesale feature. The last rental order created for this 
account.  

 

Buttons  
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New Sale button… This feature will create a new sales transaction for this account and allow 
any inventory item(s) to be sold. A receipt/pulling document may be printed for 
warehouse personnel to use to ship the items OR the item may be marked to be shipped 
via the integrated Shipping module. The next invoice printed will be include the sales 
transactions on the invoice.  Access may be limited this function via the NEWSALE 
security action. 

New Rental button… This feature will create a new rental order for this account.  It will display 
the Order Entry form defaulting the Pickup location to the selected store/account.  Review 
the rental Order Entry topics for more information on the order entry forms.  By default 
the  system will create a new rental order for any new orders created.  A user may 
manually enter a order alphanumeric number for new wholesale orders when the Main-> 
Housekeeping-> General Set-up-> System Set-up->Production tab-> User must enter 
rental order number on wholesale orders? is enabled. 

Rentals by Pickup... Filters all orders to where the selected store has been entered as the 
pickup location. Orders displayed may be limited/filtered by criteria located across the top 
of form to help quickly find a specific order. 

Buttons on View Rentals Form 

Print...Prints a rental receipt/agreement for the selected rental order. 

Print Pick Ticket...Prints a production ticket for the selected rental order 

Delete...Deletes the selected rental order. 

Add Same...Creates a new rental order by copying data from the highlighted order, like styles. 

Add...Creates a new blank rental order. 

Done...Exits and returns to the previous form. 

 

 Hint:  REMEMBER to re-set the store number when any of the filter conditions are changed at 
the top of screen, so if you ask for status SHIPPED BACK make sure you set the store ID 
too, otherwise all orders for all stores/accounts will be displayed. 

 

Rentals by Bill-to... Filters to all orders that are invoiced to the selected store/account.  Orders 
are invoiced once they are shipped. 

 

Invoices button… WinTPS wholesale feature. Will display the Invoice form showing invoices for 
this account. This form is comprised of a List - tab and Details - tab.  Double clicking a 
invoice number on the List -tab will display the Detail tab with transactions that comprise 
the charges.  

Detail - tab Buttons 

View Ticket...Will display the ticket that contains the highlighted transaction for review or where 
the operator may make adjustments, i.e. increase/decrease the charge or to cancel the 
transaction. 

View Order...Select a rental transaction first.  This button will display the rental order that created 
the rental transaction. 

Common Buttons 

Re-Print Invoice...Will re-print the invoice of the selected invoice. 
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Print Statement...Will print a statement of open invoices for the account.  The operator can enter 
a transaction cutoff date that will only include transactions with a date equal to or before 
the entered date. 

Invoice Utilities...A menu appears with a set of functions that affect invoices.  These should be 
used in specific situations under the direction of BBL support. 

Link Line Items...Tickets contain the transactions that compose a invoice.  All transaction on 
the same ticket should be assigned to the same invoice.  In a circumstance where 
some ticket transactions appear on a different invoice number this utility will make all 
transactions the same invoice number.  This utility insures all line items are on the 
same invoice by taking the invoice number assigned to the first ticket transaction and 
making the remaining transactions the same. 

Link Ticket...Assign a selected ticket with it's transactions to the selected invoice. 

Re-Calc Line Items...Recomputes the displayed invoice total. 

Change Account... Assign the selected invoice to a different Store/Account. 

Cancel...Exits and returns to the previous form. 

Delete...Will delete the invoice & clear the invoice on the transactions that it was assigned to.  The 
next time a new invoice is created for the store/account, the transactions will be included 
on the new invoice.  The transactions may be adjusted by visiting the ticket that contains 
them. 

Done...Exits and returns to the previous form. 

Note  

WinTPS© shows the packing slip number in the Code column on the Details tab of the 
Invoice form. 

 

Payments button… WinTPS© wholesale feature. Will display the payment tendered form and 
allow a tender type and payment amount to be entered.  
 
The Invoice is a document representing charges to wholesale accounts. The charges are 
tickets that hold the cost for rental orders. There is one ticket to each rental order and a 
invoice can contain multiple tickets. 
 
Once the amount of the payment is entered a list of open invoices will be displayed. 
Select the invoices to apply the payment to. 
 
An overpayment on in invoice will result in a store credit for the account in question. The 
store credit can be applied to a future invoice. When making an overpayment, be sure to 
apply the overpayment to an invoice. WinPOS will not allow the payments form to be 
closed until the entire payment (including overpayment) is applied to an invoice. 

Done button…Exits the form and returns to the previous screen. 

 

 

Check Overbookings 

Switchboard: Main Menu->Rental Production->Check Overbookings  

Menu: Rental->Production->Check Overbookings  

Action: OVERBOOK 
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WinTPS® software only feature. 

Overview 

This function will display rental inventory items were a inventory shortage (overbooking) exists, 
i.e. more quantity is needed for orders assembled in the period than exists within inventory. The 
system considers each order’s inventory requirement for the entire time period it is needed, i.e. 
order's assembly date to back date. 

WinTPS© will not allow the Assembly & Back date on a rental order to be more than 42 days 
apart.  The Check Overbookings module will complain and display the order numbers of orders 
that have dates more than 42 days.  It will ignore those orders in it's processing and display the 
order numbers to the operator if any are found, EACH time the Check Overbookings is ran. 

Each day WinPOS is started it extends the backdate to the current system date for past due 
orders, i.e. orders with a backdate in prior to the current system date.  This could change your 
production inventory requirements since the system was expected the late order(s) inventory to 
be available for the production of current orders. 

The Check Overbookings function also allows an operator to view AND edit orders that contain 
overbooked items in the assembly date range entered. The sub-rental order requirement may 
be reduced since some overbooked styles and/or sizes may be substituted for other items. 
WinTPS™ provides the tools in this form to manage the entire process. 
 
Inventory quantities of items on orders within the production assembly date range entered on 
the this form are considered Unavailable for fulfilling new order quantities unless it marked as 
being sub-contracted (not our inventory) OR the items has one of the following order statuses 
assigned: 

• Cancelled 

• Returned 

• Wait Confirm 

• Laundry 

• Wait Laundry 

• Missing Sizes 

• Done 

See How to handle Overbookings for more information. 

 

Operation 

The user will enter a assembly date range & click search.  

Note 

BBL suggests the assembly date period entered covers the normal time period that rentals 
are shipped and returned, say Tuesday to Monday (weekly period) as an example. 

Each style/size combination being assembled within the date range that is overbooked will be 
displayed. An item is overbooked when the quantity owned plus the sub-rented quantity 
scheduled to be on-hand is not enough for the orders. 

The OVERBOOKED qty column displays the highest overbooked quantity for a single date 
within the assembly range entered. 

The operator may select an item within the grid and display the orders that fall within the time 
period for the opportunity of making substitutions on those orders. 
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Finally, the user can make a decision for each item to sub-rent the additional inventory required. 
The operator would enter the quantity to sub rent in the Sub-rent qty column for all style/sizes 
listed and click the Sub-Rent button. 

Sub Rent Order processing is performed from the View Sub Orders form and the user is 
automatically taken to the form by clicking the sub-rent button. 

Filter 

Assembly date between… Enter the assembly date range of the orders to be checked for 
overbookings. 

Show stock orders? Checkbox… Enabled, the system will search purchase orders for POs 
containing the overbooked styles and sizes.  When any POs are found the system will 
display the quantity on open orders.  This helps the operator to determine if they should 
sub-rent a overbooked style/size.  This option increases processing time.  This option 
adds a new 'On Order' column to the grid that will total the quantity of this style/size on 
order via a stock purchase order.  For a stock order to qualify, the store style and size 
must match. 

Search button… Searches the rental orders for the assembly date range entered and displays 
the total overbookings as a ‘roll-up’ or ‘daily’, based on the checkbox. 

 

Search 

Search for…Allows a particular style to be found within the grid. Enter the style code and the 
system will perform a incremental search. 
 
 
Header buttons 

Sub-Rent all button… Will auto-fill in the Sub Rent Qty column of the grid with the quantity 
shown as overbooked in the Overbooked field after the search button is clicked. 

Sub-Rent None button… Will reverse the order all button and replace all the Sub Rent Qty 
column with zero. 

 

Grid 

Style…The style code of a overbooked item. 

Size…The size of the overbooked item. 

Overbook…The difference between what is available in rental inventory and the number 
appearing on orders for the assembly dates entered (total avail - total to asm). 

Sub Rent Qty…manually enter the number of items to sub-rent in this column. 

To asm... The total number of items needed for order. 

In Use... The number of items on orders 

Owned…The number of items available in rental inventory. 

Date… Displays when the ‘Show totals for each day’ is checked. The overbooked quantity in the 
overbooked cell is the number overbooked for that date. 

 

Footer Buttons 

Print…Will print an over booked report of the information contained within the grid. 
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Auto Sub-Rent button… Will mark the number of item(s) on orders entered as being sub-
rented.  For example.  Suppose the business owns 12 of coat Style XYZ in size 44R.  During a 
period the operator booked 15 orders for coat style XYZ in size 44R, leaving them overbooked 
by 3.  Their choice is to purchase 3 more units OR to sub-rent the required quantity in from 
another supplier.  To sub-rent, simple enter a quantity of 3 in the sub-rent field and click the 
Auto Sub-Rent button.  WinTPS© will automatically mark 3 items on orders as being sub-rented. 
The newest orders are marked to be sub-rented, i.e. last orders in will be marked to be sub-
rented. Once the sub-rent items have been processed the operator may click View Sub-Orders 
to see the orders containing items to be Sub-Rented.  From that form the sub-rent vendor may 
be optionally assigned and confirmations numbers added by the operator allowing for detail 
tracking & sub-rental vendor usage information. 

Select Sub-Rent button... Automatically displays the  View Sub-Orders form.  The forms grid 
will contain ALL the orders for the entered  assembly date range and allows a operator to 
choose the orders and inventory items to be sub-rented.  Any ordered within the date range may 
be selected. 

Booked Orders button… Will display all the orders that must be assembled within the 
assembly date range that contain the style & size of the selected item. The order details may be 
viewed or edited. 

In Use Orders... Will display all the orders  that contain the style & size of the selected item and 
are not returned. Meaning this this item is associated to that order and has not been returned to 
the service center. The order details may be viewed. 

Done button…Exits the form and saves any changes. 

 

View Sub-Orders 

Switchboard: Main Menu->Rental Production->View Sub Orders  

Menu: Rental->Production->View Sub Orders  

Action: SUBORD 
 

WinTPS® software only feature. 

Overview 

This module is a tool to help production personnel manage the ordering of items on rental 
orders where the on-hand inventory quantity AND previously sub-rented/ordered quantities are 
not adequate to produce all the rental orders needed in the selected assembly time period. 

The function provides maintenance tools to 1) Add or Remove sub-rent status on rental order 
items 2) Edit/Modify the details of sub-rental supplier info for each item and 3) Print worksheets. 

This management step is not required, but by using this form and entering confirmation 
numbers production personnel can know which items are ordered & from whom.  This is 
especially important when those items need to be cancelled or modified due to customers 
changing their minds.  It also provides ordering details making it a fast process to follow-up with 
suppliers. 

The first step is to limit the display to the needed information.  Once the desired information is 
displayed, the form becomes a easy to use and fast worksheet for editing the item details. 

Items on rental orders are automatically marked to be SUB-RENTED by the Overbooking 
module when the user tells the system how many items will be ordered in.  Via this View Sub-
Orders form, items may be Un-Marked OR Marked for sub-rental.  For example if a coat on an 
rental order is automatically marked for sub-renting by the Overbooking module the user may 
elect to mark the entire order to be sub-rented when the supplier offers special pricing 
incentives to rent complete outfits. 
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Supplier info like confirmation number, order date, & name may be applied to multiple items in 1 
step as a time saver.  Entering a confirmation number indicates to the system that the item has 
been ordered. 

Rental Order line items that are marked as being sub-rented via the Check Overbooking or this 
View Sub-Orders form will be highlighted on the Production Picking Ticket when printed for the 
order and on the Assembly/QC form when the ordered is displayed.   

 

User Interaction 

The sub-rent fields (explain later in this topic)  may be edited for a single selected item OR 
multiple selected items.  To select item(s) simply double click it which instructs the system to 
place a checkmark within it's selection box.  Any information entered within the sub-rent fields 
will be applied to all selected items, erasing any prior entered data.  Double click the order detail 
line to quickly select all items of the order.  To un-select item(s) just double click it again to 
remove the check. 

 

Operation 
1. View the Check Overbookings function to learn what inventory item quantities will be 

short for a production period. From the Overbookings form create Sub-Orders for the 
style & sizes needed.  

2. Check Overbookings daily for the upcoming production week to insure the quantities 
ordered are still ok. Occasionally rental order styles are changed or cancelled, items 
are not returned on time and the original quantities ordered are not valid.   

3. Also periodically check items being sub-rented.  An item on a order could have been 
changed/cancelled and the original quantity sub-rented is not needed.  WinTPS© will 
print a Change Sub-Rental receipt from the order form when a confirmed sub-rented 
item on an rental order is cancelled or modified.  It will also make an entry into the 
system log which can be printed via the Sub-Rental Mods report. 

4. When orders are Assembled/QCed the operator may optionally assign the suppliers 
serial/id number in the item onto the rental order.  This helps track the item and makes 
it easier to return from the rental. 

5. Finally, the sub-rented item's serial/id number could be entered into the Return Sub-
Rentals form and a packing slip printed.  This provides a detailed audit trail of the 
items returned.   

Grid Display Criteria 

Assemble date between….Filter the grid to show only rental orders requiring assembly within 
the date range entered. 

Sub-Rentals  

Not ordered ... Will show rental orders containing 1 or more items marked to be sub-rented, but 
not ordered. 

OR  

Ordered  ... Will show rental orders containing 1 or more items marked to be sub-rented that have 
been marked ordered from supplier via the entry of a confirmation number.. 

OR  

All (Selection) ... Will show rental orders containing 1 or more items marked to be sub-rented that 
are ordered and also those NOT ordered. 

Show Orders 

With subs?...  selected the filter only shows orders with any style/size marked to be sub-rented. 
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ALL orders?...  selected, by-passes above Not Ordered, Ordered, ALL selections and will list 
ALL rental orders found within the assembly date range irregardless of the fact if they 
have items marked sub-rented or NOT. 

Vendor ...Limits the display to items ordered from the entered vendor.  Leave black for ALL 
items. 

Style Code ... Limits display to items of the entered inventory Style Code.  Leave blank for ALL 
items. 

Search button…Displays the rental orders within the grid based upon the criteria entered. 

 

Order Columns 

Displays when the Order line is highlighted 

Order #… The rental order number. 

Customer Name… The name of the customer on the rental order. 

Assemble Date… The assemble by date of the order. 

Pickup Date… The date the customer will pick up the rental order. 

Use… The date of use for the rental order. 

Pickup Account… The account/store account code of where the order will be picked up. 

Order Status… The current status of the order. 

 

Item Columns 

Displays when the Item line is highlighted 

Sub-Rent Code...  The code SUB will appear when the item has been marked for sub-rental. 

Item Type...  The rental item type of the item. 

Description... The inventory description of the item. 

Size... The size of the item. 

Vendor...The vendor the sub-rented item was indicated as being sub-rented from. 

Conf #… The confirmation number provided by the supplier for the sub rental order. 

Vendor Style... The vendor style as it was entered within inventory for the item. 

 

Sub Rent Fields 

Sub-Rent? (checkbox)… Checked /enabled indicates the selected item(s) are marked to be 
sub-rented.  Items may be marked & unmarked as being sub-rented. 

Vendor…The supplier of the items on this sub-order. Vendors/Suppliers are entered within the 
systems vendor maintenance form. Vendors/Suppliers of sub-rented items are marked 
via the ‘Sub-Rent?’ checkbox on that form. 

Confirmation number…The confirmation number provided by the supplier for the sub rental 
order. 

Date Ordered…The date the sub rental order was placed with the supplier. 

PO Number…A in house generated tracking number. 

Cost…The cost of the sub rental order. 
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SA ID…The sales associate/employee code whom modified the information. 

 

Buttons 

Show Event…Displays the event the customer of the order is a member of.  The button will do 
nothing if the customer is NOT a member of an event. 

Show Order…Will display the rental order entry form of the highlighted order. 

Show Ticket… Shows the ticket/invoice of the highlighted order. 

Inv. Notes… Displays the notes from the rental inventory for the selected item.  Additional details 
such as alternate vendor style codes can be placed in the notes in the inventory, and 
viewed here at ordering time. 

Print …Prints the information of the sub-orders currently contained within the grid. 

Done …Exits the form and cancels any un-SAVED edits. 

Save ... After any edit the Save button will display.  Click this button to save ALL changes.  After 
clicking the SAVE button it will disappear until new edits are made. 

 

Return Sub-Rentals 

Switchboard: Main->Rental Production->Return Sub-Rentals  

Menu: Rental->Production->Return Sub-Rentals 

Action: SUBRET 

Sub-rentals are rental items that have been ordered from suppliers and used to produce rental 
orders. WinTPS© can track the shipments of these items back to the suppliers. This is usually 
done so a audit/paper trail is available as to the return ship dates, tracking numbers, etc. 

Items are returned in a batch to a selected vendor. 

To review the items that have been returned to a vendor, go to the Vendors form (located at 
Main->Housekeeping->Inventory Setup->Vendors->Detail Tab. Click the Sub-Rental Returns 
button to view the list of serial/control numbers sent back. 

A packing slip can optionally be printed as items are returned. The packing slip can be enabled 
on the Rental Production tab of the System/Store Setup form, “Print sub-rental return packing 
slip?” 

When the optional ShipRush Integration is enabled, WinTPS© will display the shipping label 
pre-filled with the destination vendor address information. If both UPS and FedEx are active, 
WinTPS© will prompt for the carrier to use. Otherwise it will default to the only carrier. Fill in the 
package weight and the UPS/FedEx shipping label will be automatically printed. The tracking 
number will automatically be transferred back to the shipping record. 

Fields 

Vendor....The vendor that items are being returned to. 

Clerk…The SA whose is actually returning the items. 

Serial number…Enter or scan the serial/control number of the item to be returned. The item is 
added to the list and the field is cleared for entry of the next serial/control. 

Remove from List button…Removes the currently selected serial/control number from the list. 

Return button…Actually marks all the items as returned. WinTPS prompts for an optional 
tracking number, then clears the list, ready for the next set of items to be returned. 
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Print Picking Tickets 
 

Switchboard: Main Menu->Rental Production->Print Picking Tickets 

Menu: Rental->Production->Print Picking Tickets 

Action: PICK 
 

This is a WinTPS Production Management feature. 

Print Production Tickets will print a document used as a worksheet to begin the assembly of a 
rental order. It will contain the critical information necessary to assemble the rental order, 
including event names, customer name, pickup date, styles, sizes notes, picking ticket number 
& optionally a Store / Account / Week / sequence number.  Example store/account 105, year 
2012, week 30 order sequence 6 (say the account for the week has 75 orders, and the order 
being printed is the 6th one printed, so the sequence is 6).  The order's pickup date determines 
the week number. = 1051230-6 

The Production ticket printed format may be modified by BBL to meet specific requirements. 
Contact BBL for more information on available formats. 

Production tickets may be printed on Laser Printers, Dot Matrix printers (not recommended due 
to slow speed) and special tag printers, like the Zebra models. The default format is set for a 
laser printer and will print a single production ticket per 8.5” x 11” size paper.  

Every rental order needs to be produced and shipped by a certain date (assembly date) to 
reach the account/store and customer in time for the order’s use date. WinTPS automatically 
arrives at the assembly date using the use date and assembly time information (see what is 
availability for more information). The assembly date is displayed on each rental order. 

To help manage the production process the operator may selectively print the Picking Tickets. 

 

Print Criteria 

First, a assembly date range will be requested.  

Next, the Stores(s) that the production warehouse may want to assemble first (leave blank for 
all stores/accounts) a 

Shipping method of the orders. For example, orders with a shipping method called UPS Red 
with assembly date of today could be requested to get those produced first.  

A maximum number of picking tickets to print may be specified. For example, there could be 
1000 orders that match & 1000 picking tickets need to print. A laser printer with a 500 sheet 
paper drawer is used to print the tickets. The maximum number to print can be set to 500 so the 
printer drawer may be refilled. The system will print 500 tickets then stop. The operator would 
repeat the selection critera to print the remaining 500. 

A store class can be optionally specified. Each Store/Account may have store class, selected on 
the Rental tab of the Stores/Accounts form. This can be used to group stores/accounts and print 
tickets only for a certain group. For example, stores might be classified as Platinum, Gold, or 
Standard accounts. Picking tickets for the Platinum stores would be printed first, followed by 
Gold, and finally Standard. 

An item type can be optionally specified. Only matching item types will be assigned picking 
ticket numbers and printed. For example, if an order contains a coat and shoes, and “shoes” is 
entered as the item type, then the picking ticket printed will contain only the shoes, and the coat 
will not be assigned a picking ticket number. 
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Print tickets only if items are on-hand? will only print picking tickets for orders where the ALL 
items contained on the order are actually in inventory. This option will not print pick tickets for 
items that are not in inventory for assembly. When this option is checked the system will re-
display the total orders per day that have rental inventory available to assemble onto the orders. 
 It is aware of items that have been marked for sub-rental and allows those items to be printed 
irregardless of quantity on-hand in inventory.   This option could be utilized early in the 
production period so the production tickets printed can be fully assembled. Later, the option may 
be turned off so ALL remaining order picking tickets will print. WinTPS checks each item's total 
inventory quantity available for rental, deducts items already out or assembled, deducts items 
used on picking tickets already printed, and if the items needed for this picking ticket are still 
available, it will print the ticket. This option is checked or unchecked by default based on the 
System Set-up - Rental Tab option, Check on-hand Qty for pick Tickets.  

Include "special" item types?  If this is left unchecked, then the pick tickets will not include 
item types with the "Print pick tickets separately?" option checked. If it is checked, they will. 
 This is used for special item types, such as top hats or canes, that are not normally picked with 
the rest of the rental order.  

Once all criteria is entered click the SEARCH button. 

All orders found that match will be displayed within the grid. The grid will have a assembly date 
and a number next to it. The number represents the total orders that need to be 
produced/assembled and shipped on that date. Most production operations will begin 
assembling the orders prior to the date to avoid last minute rushes.  The operator may 
selectively choose which dates to print by clicking each one and placing a check next to the 
day(s) to print. If all dates with their corresponding orders are to be printed, simply click the 
Select all button. 

When ready click the Print button  

Printer Notes 

The Printer assigned to print Picking Tickets within WinPOS© is defined in the  Main-
>Housekeeping->General Setup->Printers form.  This setting may be overwritten by 
inserting a weekday name within the name of the printers available to the station printing 
Picking tickets.  When a printer is available that contains a weekday in it's name WinPOS© 
will print the Picking Tickets to that printer WHEN the day of assembly matches the weekday 
name of the printer.  For example, say the operator is printing Picking tickets for the 
upcoming week.  Picking Tickets are being printed for a Monday assemble date.  WinTPS© 
will automatically  print those production tickets to an installed printer where it's name 
contains MONDAY.  WinTPS© will do this for each day of the week.  WinTPS© will print to 
the printer defined in the Printer Form when printers DO NOT contain the day of week within 
their name for the day being printed. 

The Day of Week option may be overwritten via the NoDOWPickPrint=YES setting in 
TPSWINS.INI file.  It will not use the day of the week printer with this setting. 

 

The system will automatically assign picking ticket sequence numbers to each rental order and 
store it with the order before printing the Picking tickets. It will also display the starting and 
ending numbers assigned prior to printing. These numbers should be written down. This would 
be helpful in case of a printer jam and all of the tickets do not print. The un-printed tickets could 
be reprinted by number range using the RePrint Picking Ticket function.  This sequence number 
is also printed on the Orders Report for easy reference. 

The picking ticket number will also be printed on the actual Picking Ticket. The picking ticket 
number for a order can be found on the rental order for review. Also, the Status of each item on 
the order will be changed to ‘In Assembly’. 

Hint 
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Orders that have not met the minimum Security Deposit or partial Payment rules set in the 
System Setup-> Rental Tab will not print.  Unless the order's "No sec dep/payment req? 
checkbox is checked, thus bypassing the rules.  

Click the Done button to exit the form. 

RePrint Picking Tickets 

Switchboard: Main Menu->Rental Production->Re-Print Picking Tickets 

Menu: Rental->Production->Re-Print Picking Tickets 

Action: none 

WinTPS® software only feature. 

This feature will allow for the entry of a Picking Ticket range. The picking tickets within that 
range will be printed. Enter the first and last picking tickets to print. For example, to re-print 
picking tickets 00000010, 00000011, 00000012, 00000013, and 00000014, enter 00000010 and 
00000014.  

If a picking ticket is reprinted the same day it will not show REPRINT at the top. Otherwise, 
reprinted picking tickets will show REPRINT at the top.  

See Print Picking Tickets for more information. 

Assemble Orders 

Switchboard: Main Menu->Rental Production->Assemble Orders 

Menu: Rental->Production->Assemble Orders 

Action: ASSEMBLE 

 

This is a WinTPS© software function. 

Assemble Orders, also known as Quality Control (QC) accomplishes three important tasks.  

1. It will update the order status of the assembled item (status depends on ASSEMBLE 
ORDERS TO system/store setting of the pickup store/account of the order).  

2. The operator performs a quality check to insure the correct items are pulled for the 
order. WinTPS® helps with this when ID/Serial numbers are utilized. For example, 
when a ID/Serial number is entered or scanned, WinTPS® will determine it’s style & 
size. If that style & size does not appear on the order or if it is already assembled on 
the order the system will complain to the operator that a problem exists. The 
operator should correct the issue before moving on.  

3. Via the utilization of ID / Serial numbers, WinTPS® is capable of maintaining rental 
statistics for each tracked item. This is helpful with decision making concerning 
inventory buys, inventory retirement and profitability.  

4. Allows bar-code/serial numbers of sub-rented items to be associated to the order. 

5. Corrects inventory status and/or LAST order status of tracked item being assembled 
when necessary 

6. Update Rental Inventory turns for items when necessary (Assemble to RECEIVED 
status) 

Type or scan in the order number to begin the process. All items of the order will be displayed 
within the grid. Each row will contain a style & size matching the line items on the order. 

RED rows indicate items NOT Assembled / OK’d.  

White rows indicate items Assembled / OK’d.  
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A ID / serial number must be entered for the TRACKED items on a reservation. Simply scan, 
type or select the ID/serial number of a tracked item. A tracked item’s ID/serial number of a 
Style & Size that DOES NOT match a item on the reservation will NOT be accepted. Rental 
inventory Control numbers and ID/Serial numbers may be used interchangeably. 

All ID/serial numbers of the highlighted Style & Size may be displayed and one selected instead 
of manually entering or scanning.  

The row will change color to white as ID/serial numbers for items on the order are entered. 

It is possible for a item on an order to be modified, i.e. with new style or size, after the order's 
production ticket has been printed.  As an aid to help an assembly operator catch a potential 
wrong item being assembled to the order, the WinTPS system will highlight the order as being 
modified on this assembly form.  Until a new Production Ticket is printed for the order the item 
within the assembly grid will display with the code CH so the operator will be able to identify 
modified item(s).  Once a new Production ticket is printed the CH code will disappear, but the 
order will continue to show a change alert message on the assembly form. 

Note: 

A user may scan/enter an item serial number directly onto a customer Order for a selected 
style/size on the order.  The serial number entered must match the selected item for style & 
size or it will not be accepted.  The turn statistical information is reduced for the previous 
rental style's serial number when one was entered. This feature facilitates quick rental style 
& size exchanges/additions at Point of Sale eliminating the need to step thru the Picking 
Ticket & Assemble functions.  A user would need RESVCHANG security  The status of the 
item after the serial number entry is determined by the store/account setting of Assemble 
orders to. Also see the Exchange information under the Rental Orders Form - Items Tab 
 topic.  

Some items contained on orders may had been marked for Sub-Renting during the 
overbooking (via Check Overbooking or View Sub-Orders forms)  process.  Those un-
assembled items will display SUB or the Supplier's id (when assigned to a Wholesale Supplier 
via the View Sub-Orders) on the right of grid next to the item in the Sub-Rent column.  This 
setting  may be overwritten at Assemble in two ways by users with SUBASM security authority: 
 1) Simply select the item within the grid & scanning the serial/ID number of an existing 
inventory item owned.  This will automatically UN-MARK the item as being sub-rented. 2) 
 Selecting the item within the grid and clicking the Remove Sub-Rental button.   Conversely, a 
item on a rental order not marked for Sub-Renting can be changed to a sub-rental state from 
the assembly form by selecting the line item within the grid and clicking the  Sub-Rent button 
and then optionally entering the supplier's bar-code/serial number.  

For un-assembled items on orders marked for sub-renting the supplier's Serial/ID number may 
be optionally entered by simply highlighting the item and clicking the Sub-Rental Serial button. 
 Assigning the sub-renter's bar-code/serial number is optional, but faster when returning and 
tracking when sent back to the supplier. 

 

When the tracked inventory item being assembled has been previously marked Un-Available for 
rental in inventory, the process of assembling it to a order will mark it available and clear any 
inventory status entered, i.e. LOST, REPAIR, DISPLAY ..etc.  The assemble also checks for 
this item being out on a past order and will change the STATUS to DONE if not already set to 
DONE, except for a order with a status of LOST.  It skips lost as a reminder that the order was 
returned lost.  There are no messages displayed to the operator. 

 

Fields 

Order number… The order number to review/assemble. 
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Serial number…TheID / Serial number of ANY tracked item on the order. Control numbers may 
be used interchangeably. See Inventory - Rental Size Serial Numbers for more 
information.   

NOTE 

An alert message will appear  if the serial number scanned is shown by the system to be in 
use on another order (a order status of other than DONE).  A answer of YES to proceed with 
the assembly of this serial to this order will cause the system to mark the item's order status 
to DONE.  In addition, the system checks the inventory status of the item.  The system will 
automatically clear the inventory status and force the item AVAILABLE when the item was 
marked NOT AVAILABLE.  

 

Grid 

Grid… Unassembled Style & Sizes will display in RED.  Assembled will be in WHITE.  

 

Buttons 

Mark Assembled button… Once only non-tracked items are left unassembled within the grid 
(ones that have no ID/serial numbers) the operator would simply click the Mark 
Assembled button indicating to the system those untracked item are OK. This will mark 
the selected untracked item as assembled. This is also used to mark sub-rented items as 
assembled. 

F7 – Mark All Non-Tracked Assembled button… This is fast method to mark assembled all 
remaining ‘non-tracked’ items assembled on the displayed order. The operator may press 
the F5 key or click the button. 

F8 - Save Order... A quick method to save a order in it's current state, .ie. all items may not be 
assembled.  Entering the letter sequence of NEWORDER within the serial number field 
will also save the order in it's current state.  This character sequence may be bar-coded 
so the operator can simply scan the bar-code to SAVE the order.   

A scannable bar-code for the term NEWORDER.  Print and tape to the assembly monitor. 

*NEWORDER* 
 

Hold order button… Reservations may be Held by clicking the Hold button. The system will 
request a reason that will become available on the Order screen in the Hold reason field 
and printed reports. 

Swap Item button… Occasionally Items may have to be swapped for a different Style or Size. 
This is accomplished by the operator without having to change to the Order Entry form. 
The operator would highlight the item to be swapped within the grid and click the Swap 
Item button. The Check Availability (see the description within the Title bar  menu topic 
for field information)  form will display allowing different Style & size combinations to be 
entered for availability checks. Click the Select button once the desired style & size 
combination is found, otherwise click Cancel to stop the swapping process.  This function 
allows items marked to be sub-rented to be swapped to in-house inventory. 
 
A log entry is creating during a swap, using key ASMSWAP. 

Enter Sub-Rental Serial button… The Sub-Rental Serial button is used to enter a serial/control 
number for a sub-rented item as it is being assembled onto this order. Highlight the item 
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previously marked to be sub-rented and click the Sub Rent Serial button. The item must 
have been marked for sub-rental via the Overbooking form or View Sub-Rental form. 
 Entry of the serial/control number for a sub-rented item is optional. 

Un-Assembled button… The Un-Assemble button will un-assemble an item marked as 
assembled within the grid. Highlight the item and click the Un-Assemble button. 

Done button… Click Done to exit the Assemble screen. 

 

Sub Rent Item button… This function allows the operator to indicate to the system that the 
highlighted item is being assembled with a sub-rented inventory item. Optionally the 
item’s ID/Serial Number can be scanned/entered as an aid during order return.  

Done button…Exits the screen. 

 

Shipping Orders 

Ship Orders 

Switchboard: Main Menu->Rental Production->Ship Orders 

Menu: Rental->Production->Ship Orders 

Action: SHIP 
 

Overview 

This is a WinTPS software module function only. 

The Ship Orders function will mark items OUT (or the status setup for SHIPPED orders for the 
store/account being shipped to) to the store/account entered on the order as the Pick-Up 
account. During this step the system can automatically print packing slips and invoices for the 
shipments. A shipment tracking number may be entered which allows easy tracking by 
customer service. The optional shipping integration feature may be utilized that will produce a 
UPS or Fedex Label & to auto insert the tracking number onto the order. 

Hint: 

Stores/account information contains a setting for printing packing slips. Enable the setting for 
packing slips to print for specific accounts. Packing slips are assigned a packing slip number 
and may be individually reprinted with the Reprint Packing slip function. 

Invoices are for wholesale type accounts only. These accounts will have payment Terms 
other than TICKET or NONE. Invoices will automatically print during shipping when Cash 
only or COD Terms are in effect, or when an open invoice account has reached it’s credit 
limit, or when an open invoice account ‘Print invoice at ship time’ option is enabled, 
otherwise the invoices print when Print New Invoices function is selected.  

To start a shipment, the operator must enter/scan an order number.  

The system will set the store/account to the Pick-Up store/account on the order first order 
entered. The shipping method will also be set to the shipping method on this order. Once these 
two details are set (both are displayed in top right hand corner of screen), only orders going to 
the same store/account via the same ship method will be accepted in this shipment. 

Un-Shipped orders that have been marked into Ship Hold can be removed from Ship Hold by 
re-entering them is this grid.  Enter or scan the order number and the system will prompt to 
remove it from ship hold, answer YES to remove and ship in this session.  Answer NO to skip 
the order. 
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The shipment grid contains one row for each ordered entered. The grid has Order number, 
Customer Name, Event name, Pickup date and Days old. Days old is the difference between 
the order created date and the shipping date. 

If the store/account has a credit limit set and the shipment would cause that credit limit to be 
exceeded, then WinTPS© displays message to ship the orders COD, and will treat the entire 
shipment as if the terms for the store/account were COD. 

WinTPS also offers a Ship Hold capability to incrementally select orders for shipping as they 
come out of production via the Ship Hold method.  Orders that are was previously set to Ship 
Hold cannot be shipped via this form unless they are released from Ship Hold.  See the Ship 
Hold topic for more information. 

Grid 

Ship All Orders button… Click to ship on orders within the grid. Once clicked.  WinTPS® will 
mark all the items out (Status depends on setting in Store/Account maintenance, clear 
the grid and request Ship/COD charges for invoiced customers. The charges entered will 
be added to the invoice that will eventually be printed. In addition, WinTPS will prompt for 
a shipment tracking number. The user can enter or scan a tracking number that will be 
stored on every order for future reference. 

A packing slip number will be generated and stored to each order shipped, and also saved to 
the Reference field of the rental transaction on the Ticket for the order. The packing slip 
number is always generated, but the packing slip is only printed if the Print pack slip? option 
is checked for the ship-to store within the Store/Account form.  The packing slip lists the 
order numbers, customer names, and barcodes each order number. 

WinTPS will also print an invoice if the store/account is set for COD or Cash Only terms, or 
the option “Print invoice at ship time?” is checked on the Store/Accounts form. 

For wholesale accounts that are COD terms, the system displays the invoice total of the 
orders being shipped.  This easily allows for COD amounts to be entered in the shipping 
system software.  Or if the account has a credit card on file allow the card may be charged. 
 When card is declined go back to shipping form, if approved mark orders shipped.  With 
integrated shipping active, the shipping waybill appears with Ship to auto completed.  Enter 
weight, service and any other details then receive the shipping label and packing 
slip/invoice.  The tracking number will automatically be transferred back to each rental order 
shipped. 

Un-Ship Item button… This function removes the highlighted order from the grid. 

Done button… Exits the form, discarding un-shipped orders contained within the grid. 

Ship Hold 

Switchboard: Main Menu->Rental Production->Ship Hold 

Menu: Rental->Production->Ship Hold 

Action: SHIPHOLD 
 

Overview 

Ship Hold is a production feature to mark orders as being complete and awaiting shipping. 
 Typically, service centers complete rental orders in no particularly store/account order fashion 
 Even when rental orders are sorted by store/account at the beginning of production not all 
orders can be assembled in a timely manner due to inventory availability or marrying processes. 
As a result most orders randomly complete assembly.  So WinTPS provides a SHIP HOLD 
function to allow the random orders to be electronically resorted for shipping. 

The user would select the Ship Hold function and scan orders into it's grid as each complete 
assembly.  The last order number scanned is displayed for operator reference. Once the orders 
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are scanned and production completed for the period, the operator would  then pack for 
commercial shipping or load onto a delivery van.  Once a cut-off for a particular shipping method 
is reached, a operator would select within the Ship Hold form the store/account(s) for that 
shipping method and Ship them.  WinPOS would create a packing slip for each store/account 
for the orders processed and a invoice when appropriate.  Finally it would mark each order as 
shipped. 

Orders may be manually added or removed from Ship Hold via the Main Menu-> Order tab-> 
Ship Hold button. 

Operation 

Scan or enter the order number  in the Order Number field to have it marked for Ship Hold. 
 Once orders are in Ship Hold they may be selected by store/account and shipping method for 
shipping. 

For wholesale accounts that are COD terms, the system displays the invoice total of the orders 
being shipped.  This easily allows for COD amounts to be entered in the shipping system 
software.  Or if the account has a credit card on file allow the card may be charged.  When card 
is declined go back to shipping form, if approved mark orders shipped.  With integrated shipping 
active, the shipping waybill appears with Ship to auto completed.  Enter weight, service and any 
other details then receive the shipping label and packing slip/invoice.  The tracking number will 
automatically be transferred back to each rental order shipped. 

 

Grid 

Select? checkbox... Checked, selects that account and ship method for order display or 
shipping. 

Pickup ... The store/account the order is being shipped to (the order's pickup location) 

Ship Method... The ship method assigned to the order 

Orders... Number of orders marked Ship Hold for the store/account ship method. 

 

Buttons 

Check all... Checks the select checkbox for all store/accounts for all ship methods. 

UnCheck all... Clears (UnChecks) the select checkbox for all store/accounts for all ship methods. 

View Orders... Displays a list of orders marked for Ship Hold for the highlighted store/account 
and ship method row within the grid. 

Ship Orders... Ships all the orders 

Ok... Exits the form and returns to previous screen. 

 

Re-Print Packing Slips 

Switchboard: Main Menu->Rental Production->Re-print Packing Slips  

Menu: Rental->Production->Re-print Packing Slips 

Action: RP_PACKSLIP 

WinTPS® software only feature. 

Packing slips that print during shipping are assigned a sequencial number may be individually 
reprinted. This function will allow a packing slip number to be entered for reprint.  
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The packing slip number for a rental order can be located on the order’s Items Tab page of the 
order entry screen via the Rental Orders Detail button.  

Return/Launder by Item 

Switchboard: Main Menu->Rental Production->Return by Item 

Menu: Rental->Production->Return/Launder by Item 

Action: RETSERIAL 

Overview 

The return by item function is a WinTPS® function that allows for one of two tasks to be 
accomplished- 

1. Items are marked returned from stores/accounts/customers. The item’s order status 
will be changed to Laundry, Wait Laundry or Done. The status depends upon the 
Return to setting within the Stores/Accounts maintenance form and Auto-Launder 
item? checkbox setting for the Item Type being returned.  

2. Items NOT out on orders (tracked & non-tracked, see Item Types for more 
information) can be tagged for Laundry. Simply enter the serial number of tracked 
items or the Style & size of non tracked items. The status will become Laundry or 
Wait Laundry. The status depends upon the Return to setting within the 
Stores/Accounts maintenance form and Auto-Launder item? checkbox setting for the 
Item Type being returned.  

Hint: The Store/Account where the terminal/PC is located that is performing the item return 
will determine the Return to status of the item(s) being returned. WinTPS looks up the 
Return to rule for the location of the terminal/PC performing the return. 

Hint: Items given a Wait Laundry status must be sent to Laundry via the Send to Laundry 
function. 

Returning 

To return items from orders, simply enter any ID/Serial number of any tracked item on the order. 
It's status on the order must be one of the following: Shipped, Received, Picked up, Returned or 
Shipped Back, otherwise WinTPS© will complain & not allow the item to be processed. Once 
entered & auto accepted, that item and ALL non-tracked items (if any) on the same order will be 
marked returned automatically and will be given a status of Wait Laundry, Laundry or Done.  

The system will alert the operator to Items that have been marked with a RETIRED date in 
inventory and unavailable for rental.  This allows the operator to properly handle the item. 
 These items do not necessarily have to have been on an order. 

Also, when items in inventory have been marked unavailable for rental and DO NOT have a 
RETIRED DATE, the system will prompt the user to clear the inventory status and make the 
item available for rental.  This is useful in situations where the item may have been placed on 
store display and is now being returned. 

Note   

Item Statues are determined by system setting in the Store/Account form and the Item type 
form.   

Note: 

In WinTPS Plant Production only (No WinTPOS)  software installations that have a locally 
own store (not a WHOLESALE account) insure the Store/Account setting: "Ship orders to:" is 
set to SHIPPED  (not received) so the NO SHOW flag is not triggered when the order is 
eventually Returned in the WinTPS production system. 

Note 
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In larger service centers, multiple stations may be performing returns concurrently.  When a 
item on a order is scanned concurrently on multiple workstations the system will display the 
scanned tracked item and all non-tracked items found on the order.  There is no negative 
side-effects of this behavior.  The first station to actually complete the return will be 
successful at marking those items back in and they will be listed only on that stations 
Return/Laundry report when optionally printed. 

Orders with ALL non-tracked items (those without ID/Serial numbers) must be returned via the 
Return by Orde (production)r function. 

Occasionally, items being returned are needed immediately for orders that are being 
assembled. These items are considered HOT. Hot items returned will display HOT within the 
grid’s note column. The operator should expedite those items thru laundry so they can quickly 
be made available for the new orders being assembled.  

WinTPS utilizes a formula for determining which items should be tagged as HOT: Total number 
rentable of style/size in inventory (TotRentable) – total number that cannot be assembled to a 
new order (NoAssembly) ( items with status of Wait Shipped, Shipped, Received, Picked Up, 
Shipped Back, Wait Laundry or Laundry cannot be assembled) – Total number of style/size with 
status of In Assembly (InAsm), i.e. (TotRentable – NoAssembly) – InAsm = difference. A 
positive difference indicates there is sufficient inventory to assemble onto new orders and a 
negative difference indicates a shortfall. A shortfall will cause WinTPS© to display the HOT 
message for the item. 

Items being returned from orders are tagged for laundry when the ‘Return to’ Store/account 
setting is set to Laundry, Laundry by Type, Wait Laundry or Wait Laundry by Type.  

The Laundry by Type and Wait Laundry by Type settings will first cause WinTPS to check the 
Item Type laundry setting Auto-Launder item? Checkbox to see if it is enabled (checked). 
Enabled, WinTPS will modify the order status of the item being returned to Wait Laundry or 
Laundry. 

Items with a Wait Laundry Status must be sent to Laundry via the Send to Laundry function. 
Items in Laundry must be returned via the Return from Laundry function. 

Any older orders also containing the tracked item are set to status Done if they are not already 
marked Done. If the item being returned is marked as not available for rental in the inventory it 
is marked as available and the inventory status is cleared. 
 
Lost Fees 
 

This function does not create LOST fees.  Items are assumed to be Late until they are 
marked returned via this form.   

At some point Production management may wish run a report of all past due Orders, via the 
Orders Report->Orders.  The status of the non-returned items on the order can manually be 
marked LOST and a LOST ITEM sales transaction in the amount of item's replacement cost 
can be manually added to that order's original ticket.  The next time an invoice is printed for 
a wholesale account that has had new transactions created,i.e. LOST fees, the invoice will 
contain the fees/charges. 

At some point service center management must manually mark the inventory items LOST. 
 Reports & dunning letters for wholesale accounts are provided by WinTPS© to help 
management make the LOST decisions. 

Late Fees 

If an item is returned late, and the late fee method is set to Retn (set in System/Store Setup 
– Rental Tab) WinPOS® computes a late fee as the daily late fee charge for the item type 
(on the Item Type form) times the number of days late. For Wholesale store/accounts the 
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shipping Ret Days is added to the order's Return Date & not counted in the lost fee 
calculation. 

If the late fee is set to Daily, then the late fee is computed when the entire order is returned, 
and is the total number of days late times the daily late fee, as set in System/Store Setup – 
Rental Tab).  For Wholesale store/accounts the shipping Ret Days (set on the Shipping 
Method) is added to the order's Return Date). 

Late fees are Sales transactions with a Store Style called “Late Fee” and are automatically 
created.  Late Fee transactions obey the System Setting-> Rental Production-> Apply late 
fees to retail accounts when returning in production?  Unchecked, Returning by Order 
(Production or Return by Serial, the system will NOT charge late fees for orders with RETAIL 
pricing/type Pickup at Store/Account.  Check it will calculate and apply late fees to retail 
customer tickets.   

Late Fees are entered onto the order’s ticket for the customer/account to pay. Of course a 
Late Fee may be manually adjusted as any other sales transaction.  Late Fees for 
store/accounts with Pricing/Type of wholesale will be invoiced for the fees the next time a 
invoice for the account is printed. 

No Shows 

Occasionally, rental orders are placed and the customer does not pick it up.  WinPOS© will tag 
those orders with a NO SHOW  when returned with status of RECEIVED.   

Mark Items for laundry 

Track & Non Tracked Items NOT out on orders may be marked for cleaning as well. Just scan 
tracked items ID/Serial numbers or enter non-tracked items style, size & quantity. Those items 
entered will display within the grid. They will be given a Laundry or Wait Laundry status 
determined by the Item Type setting and the Store/Account of the terminal/PC location used for 
processing the return. 
 

Batch/Bag Numbers 

Batch/Bag numbers are a tracking & data entry tool allowing for items being returned from 
orders and/or send to Wait Laundry/Laundry to be grouped together. 

Batch/Bag numbers can be manually entered or computer generated.  

Computer generated numbers are always unique and fulfills a service center’s need to 
distinguish between each time a group of items are returned. 

Manually assigned Batch/Bag numbers may be reused and thus are NOT unique. WinTPS™ 
appends the current date as an aid to distinguish between manually assigned numbers, but 
numbers re-used on the same date cannot be distinguished between each other. This is not an 
problem for most service centers. 

Some companies will use laundry bags with imprinted numbers. Bag numbers can be changed 
while items are being entered on the grid. This is required if physical bags are being utilized and 
they become full. A new bag number can be entered and the items entered after the change will 
be assigned the new bag number. 

Items may be sent to laundry by batch/bag number, see Send to Laundry topic for more 
information. Reports may be generated by batch/bag number that list the items contained within 
that batch/bag. See the Laundry Report for more information. Batch/Bag lookups are offered to 
the user and will display the batch/bag number and the date it was used. 

Upon conclusion of an Return by Item session a Return report can be generated. The System 
Setting- Rental Production Tab “Print Return Report” determines if/when a return report is ran. 
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Return Date & Laundry Date 

An item on a order ‘return date’ is automatically assigned by WinTPS® when the item is 
returned within the Return by Item or Return by Order functions. 

An item’s laundry date is set to the current date during the physical return of the item when it’s 
status is set to Done or Laundry (determined by the Store/Account ‘Return to’ setting). The 
laundry date of an item with a Wait Laundry status is set to the current date when it is sent to 
Laundry via the Send to Laundry function. 
 

Grid 

Lists the items returned during this session. 

Fields 

Return from Orders/Launder from Inventory…This drop-down selects what WinTPS© will do 
as serial #’s are scanned.  
 
If Return from Orders is selected then serial numbers from orders that are out must be 
scanned. If a serial number is scanned then WinTPS will locate the most recent order out 
that has that item. If more than one order is out that has the item, the older orders are 
automatically changed to status Done. The most recent order is then added to the grid. If 
a serial number is entered that is not out on an order then WinTPS will display an error 
message. 
 
If Launder from Inventory is selected then serial numbers must be scanned directly from 
inventory. As they are scanned they are taken from inventory and added to the bag for 
laundering. If a serial number is scanned that is out on an order then an error message is 
displayed and the item is not added to the grid. 

Current Batch/Bag…Users have the option to assign a tracking number, called a batch/bag 
number, to a batch of items going to laundry. Batch/Bag numbers can save time when 
the items are being returned. The operator could enter only a batch/bag number to return 
every item from Laundry/Dry cleaning that was in that bag/batch. Batch/Bag numbers 
could be a method to audit laundry activity, which is particularly useful when using off site 
laundry services. 

New Batch/Bag Number button…Allows the operator to create or change the bag number for 
the items to be returned.  

The system will prompt for the number when a session is started and the user forgot to add 
one first. A user does not have to manually enter a number in when prompted. A blank 
prompt will cause the system to automatically create one. 

Pressing this button during a session will allow for the creation of a new batch/bag number 
and all items entered after the change will have the new number. 

Tracked Items 

Serial Number…Enter the serial number of the item to return or send to laundry.  System will 
display an alert and wait for user confirmation if scanned bar-code is invalid. 

Non Tracked Items going to laundry 

Style code…style number of non tracked item 

Size code…size code of non-tracked item 

Qty…quantity to send to laundry 

General Info about number of Items returned 

Tracked Items Entered… display only and shows total of tracked items entered in grid. 
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Non-Tracked Items Entered…display only and shows total of non tracked items entered in grid. 

Buttons 

Un-Return Item… This function will remove the highlighted item from the return grid. 

Return All Items…Completes the return process and marks all the items in the grid as returned, 
updating the status as outlined above and will print a Return Report based upon the 
System Setup Rental Return Report setting entered. A Return Report will list all items by 
batch/bag and item type returned including sub-rented items.  

Done Button…Exits the form. The user is warned if items were scanned but Return All Items has 
not been pressed. 

Return by Order (Production) 

Switchboard: Main->Production->Return by Order and Main Menu->Return 

Menu: Rental->Production->Return by Order 

Action: RETURN 
 

WinTPSOS/TPS® software only feature. 

This form is used to mark orders as returned for any store/accounts..  The order's status must 
be Received, Picked Up, Shipped, or Lost before it may be returned. Once an order is selected, 
 the rental items are displayed in the grid. A operator can check or un-check each item to 
indicate if it is present. 

This functions is used: 

1) Not for Retail store locations to return customer rental orders  ( BBL recommends the user 
utilizes the customer Order Return function found on the main menu of TPOS when returning 
customer orders),  or  

2) A Service Center location that does not track any rental inventory with serial/ID numbers. 

This method of order return is the preferred method when inventory ID/Serial numbers are not 
used extensively. It is dependent on the operator doing a thorough check to insure all rental 
items are back. If the “Serial numbers must be scanned for Return?” option is checked on the 
Rental tab of the System/Store Setup form, then user must scan the serial number for each 
tracked item. The user can check the Present? checkbox for non-tracked items, however. 

Operation 

Once the order is entered, it will display ALL rental items on the order. The operator would 
simply indicate to the system which items were returned by checking it’s Present? checkbox or 
scanning a serial number of a item on the displayed order..  

Note on Set-up 

Service Center/Warehouse Registers (workstations) should be set to the Service 
Center/Warehouse production store/account location code created in the Store/Account form 
and this store/account location should be set to a Pricing/Type of WHOLESALE. 

The system setting: System/Store Set-up->Rental Tab->Serial numbers must be scanned for 
Return? controls the exact behavior of this form.  With this option:  

SET/Checked, it forces a operator to scan/enter all tracked inventory serial/ID numbers to 
return. 

Entering a Order #, Customer or Event displays all items on the order.  Scanning a serial 
ID number will return & display that tracked item only and display other Non-Tracked items 
on the order. 
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Scanning a serial ID number will return that tracked item and all the non-tracked items that 
were on the order.  The user cannot manually check the Present? box for any other 
tracked item that may show on the order.  A tracked item's Serial/ID number must be 
entered for it to be marked present. 

UnSet/UnChecked, Entering a Order #, selecting a Customer or Event or 
entering/scanning a Serial/ID number of any item on a order displays all items on the order. 
 Once the order's items are displayed the operator may indicate which items are Present? 
by checking the Present? box next to each item.   

Any items NOT checked as Present? will be marked as LOST for a order with Pickup at 
location that is a retail pricing type store/account (this assumes a company owned retail 
store). 

If an item is marked Present,  the status is changed to the status specified for “Return 
order to” on the Stores form-Rental Tab for the store actually performing the return. It can 
be Returned, Shipped Back, Laundry, Wait Laundry, or Done.  

The status of returned items (those marked Present?)  will be changed to Laundry, Wait 
Laundry or Done. The status depends upon the Return to setting within the 
Stores/Accounts maintenance form for the Register location processing the return.  Return 
to Status may be Returned, Shipped Back, Laundry, Wait Laundry, or Done.   

Status Hint:   

The Store/Account where the Terminal/PC is logged in as that is performing the item return 
will determine the Return To status of the item(s) being returned. WinTPS© lookups the 
Return To rule for the location of the Terminal/PC performing the return. For example, if the 
Workstation/Register performing the actual return is assigned to store/account 300.  WinTPS 
will look in the Store/Accounts form for account 300's RETURN TO setting and use that 
status for returned order items. 

 

Lost Items 

Lost Fees Hint: 

The Store/Account where the Terminal/PC is logged in as that is performing the item return 
will determine how LOST fees are processed when items on the order are being returned.   

Retail vs Wholesale Store/Accounts 

Returning at a Workstation/Register assigned to  Retail pricing/type Store/Accounts 

The assumption is the order is being returned when the customer is present thus allowing for 
collection. 

Order Items that are not present have their inventory status changed to “Lost” and Currently 
Available? for rental in un-checked. If an order is returned where items are already marked 
Lost, those items can be checked on this form to indicate they are present and their order 
status will be changed to RETURN and inventory status cleared from LOST.  Also they will 
become Available for rental again. 

As items are marked to Lost, a sale transaction with style code “LOST ITEM” is added to the 
customer ticket associated with the order and the sales price is set to the replacement cost 
entered in inventory of the item lost. This is charging the customer/store/account for the lost 
item. When/if the lost item is returned the original charge on the ticket must be manually 
adjusted and canceled by the operator. 

 

Returning at a Workstation/Register assigned to WHOLESALE pricing/type Store/Accounts 

This function does not create LOST fees.  Items are assumed to be Late until they are 
marked returned via this form.   
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At some point Production management may wish run a report of all past due Orders, via the 
Orders Report->Orders.  The status of the non-returned items on the order can manually be 
marked LOST and a LOST ITEM sales transaction in the amount of item's replacement cost 
can be manually added to that order's original ticket.  The next time an invoice is printed for 
a wholesale account that has had new transactions created,i.e. LOST fees, the invoice will 
contain the fees/charges. 

Note 

During the WinTPS Production (when installed) Assembly when a item marked LOST is 
scanned onto a new order the system also checks the inventory status and clears it and 
makes sure it is set to available for rental.  The assemble also checks the orders and will 
change the STATUS to DONE if not already set, except for a order with a status of LOST.  It 
skips lost as a reminder that the order was returned lost.   

 

Late Fees 

Late fees are charged for retail & wholesale store/accounts based upon the LATE FEE 
calculation settings found in System/Store Setup – Rental Tab. 

WinPOS® computes a late fee as the daily late fee charge for the item type (on the Item 
Type form) times the number of days late. For Wholesale store/accounts the shipping Ret 
Days is added to the order's Return Date. 

If the late fee is set to Daily, then the late fee is computed when the entire order is returned, 
and is the total number of days late times the daily late fee, as set in System/Store Setup – 
Rental Tab).  For Wholesale store/accounts the shipping Ret Days (set on the Shipping 
Method) is added to the order's Return Date 

Late fees are Sales transactions with a Store Style called “Late Fee” and are automatically 
created.  Late Fee transactions obey the System Setting-> Rental Production-> Apply late 
fees to retail accounts when returning in production?  Unchecked, Returning by Order 
(Production or Return by Serial, the system will NOT charge late fees for orders with RETAIL 
pricing/type Pickup at Store/Account.  Check it will calculate and apply late fees to retail 
customer tickets.   

Late Fees are entered onto the order’s ticket for the customer/account to pay. Of course a 
Late Fee may be manually adjusted as any other sales transaction.  Late Fees for 
store/accounts with Pricing/Type of wholesale will be invoiced for the fees the next time a 
invoice for the account is printed. 

This Return by Order for automatically creates a bag/batch return number which is assigned to 
each returned item for tracking purposes.  Items are marked Wait Laundry status based on the 
PC/Terminal and it's store/account assigned and it's RETURN ORDER TO setting and may be 
sent to laundry via the Send to Laundry function.  

It does not support the Hot item alert feature that the Return by Item function supports.  

Any older order(s) containing the same tracked item being returned will be automatically set to 
status of Done ( if they are not already marked Done). If the TRACKED item being returned is 
marked as not available for rental in the inventory, the system marks as available and the 
inventory status is cleared.  Status updates occur on the Inventory->Rental tab-> Rental Sizes-> 
Serial Number form. 

 

No Shows 

Occasionally, rental orders are placed and the customer does not pick it up.  WinPOS© will tag 
those orders with a NO SHOW  when returned with order status of RECEIVED.   

Fields 
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Only one of the following data options is required to display the order. 

Serial number...Enter the ID/serial number of an item to be returned. All of the rental items on 
that order will be displayed. This only works when the ID/Serial number was captured at 
check in or when the Rental Production module is installed and ID numbers used. 

Order number...Enter the actual order number being returned. 

Customer number...Enter the customer number. If the customer has any orders of status 
“Picked Up”, they are displayed in the upper list.  

Confirmation number...Enter the confirmation number that was assigned to the order . The 
system will display the order that has that confirmation number assigned.  If more than 
one order has the same confirmation number the system will allow the operator to choose 
a single order. 

Event number...Enter the event number. All the orders for that event will be displayed so you can 
select the correct one. 

 

Grid 

Item list...WinPOS® displays all the rental items on the selected order. Check Present? for the 
items being returned, leave it unchecked for the items that are missing. 

Operation 

Once the order is found, it’s items are display within the grid. The grid shows the item’s 
description, ID/Serial number (if any), Present? checkbox for the operator to indicate if the item 
is returned or not, Sub? field displaying the sub contractors vendor code (if the item was sub 
rented). 

Check All button…Will check all of the item’s Present? checkbox indicating they are returned. 

Un-Check All button… Will un-check all of the item’s Present? checkbox indicating they are not 
returned. 

Return button... Updates the items that are checked to status of “Returned”.  

Cancel button... Throws away the data with no updates. 

OK button…Exits the form. 

 

Return Items from Laundry 

Switchboard: Main Menu->Rental Production->Return Items from Laundry 

Menu: Rental->Production->Return Items from Laundry 

Action: LAUNDRET 
 

WinTPS® software only feature. 

This function will return tracked & non-tracked items from Laundry/Dry Cleaning. The status of 
items on orders will be switched to Done. 

Three methods may be used to select items for return from laundry. 

1. By Serial number. Enter a tracked item’s serial number and it will be displayed within 
grid. 

2. By Bag number, Style code, Size and quantity. This method is used for non tracked 
items (those not using ID/Serial numbers) and requires a batch/bag number. 
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3. By Batch/Bag number. All items assigned to the Batch/Bag number still shown with 
status of in laundry will be displayed within grid. 

The Send to Laundry may be utilized for auditing items in laundry. It can print items that were 
laundered within a Batch/Bag even when the items have been returned. 

Use the lookup button to select the correct Bag/Batch number and launder date. Since a 
Bag/Batch number can be reused, the launder date is used as well to identify the Bag/Batch. 

 
 

Laundry Grid 

The grid displays the items selected for return from laundry. 

Tracked Items 

Serial Number…Enter the serial number of the item to return from laundry.  

Laundry Tags 

Laundry Tags may be edited within the Letters, Tags Mailing Label editor. 

Prompt for location ? checkbox.. This option controls whether a ID/Laundry tag is printed 
for the item being returned from laundry.  

Checked/enabled, the WinTPS system will display the Laundry Tracked Item location form, 
after entering a tracked item's bar-code/serial id.  This form asks for the item's location fields 
found within inventory's rental sizes form, i.e. Location 1, Location 2 and description.  The 
user may confirm or modify the correct information and click the OK button to have it 
marked for tag printing.  Tor discard printing a tag for the item, click the Cancel button when 
the form appears or leave the form's fields blank (empty) and click the OK button. 

Prompt for location ? checkbox.. Disabled, Laundry ID/Tags are NOT PRINTED. 

Finish entering the all items being returned from laundry.  When complete, click the  Return 
all Items button, causing all the ID Tag(s) for the batch to be printed, that have 
location/description information confirmed. 

 

Non Tracked Items returning from laundry 

Batch/Bag Number…Enter the bag number containing the items being returned (if any). The 
Batch/Bag number is required. 

Style code…style number of non tracked item 

Size code…size code of non-tracked item 

Qty…quantity to returning from laundry 

Batch/Bag Number 

Batch/Bag Number… Enter the number. The system will display all items with status Laundry 
assigned to the batch/bag number. 

 

General Info about number of Items returned 

Tracked Items Entered… display only and shows total of tracked items entered in grid. 

Non-Tracked Items Entered…display only and shows total of non tracked items entered in grid. 

Buttons 

Un-Return Item button… Deletes the highlighted item form the grid. 
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Return All Items… This function will mark all items within the grid returned from laundry and 
switch their order status to Done.  This function will print Laundry Tagf is system is set to 
do so. 

Done… Exits the form and discards any items within the grid.  

Send to Laundry 
 

Switchboard: Main Menu->Rental Production->Send to Laundry  

Menu: Rental->Production->Send to Laundry 

Action: LAUNDER 
 

WinTPS® software only feature. 

This feature will change the status of all or by Batch/Bag number items with a Wait Laundry 
status to Laundry and print a report of all the items with Laundry status grouped by batch/bag 
number. 

Items returned from customers via Return by Item or Return by Order may be assigned a Wait 
Laundry status. The status is determined by the ‘Return to’ status setting in the Store/Account 
form for each retail store or wholesale account. 

Fields 

All bags/items that are Wait Laundry…WinTPS will process all items with a status of Wait 
Laundry. 

All bags with no bag/batch number… WinTPS will process all items with a status of Wait 
Laundry, and that have no bag/batch number assigned. A bag/batch number can be 
optionally assigned during the return process. 

Single bag/batch…Used when only one bag/batch is to be sent to laundry. In this case, a 
bag/batch number must be specified. 

Item Type…If an item type is selected then only matching item types will be sent to the laundry. 

Button 

Launder button… Prompts for a bag/batch number and changes Wait Laundry status of items 
selected to Laundry and prints a Laundry report of the items sent to Laundry this time by 
batch/bag number. Laundry Batch/Bag Reports may be reprinted by the Laundry Report. 
Every item sent to laundry is assigned to the bag/batch number entered, even if it already 
had a bag/batch number. 

Cancel button… Exits the form and does not change any statuses. 
 

Print Statements 

Switchboard: Main Menu->Rental Production->Print Statements 

Menu: Rental->Production->Print Statements 

Action: PRINTSTATE 
 

WinTPS® software only feature.  

This feature will print statements for store/accounts with invoice balances. The user may enter a 
transaction cutoff date so only invoices created prior to the date will be included within the 
statement. The actual statement format is controlled by the Statement setting on the Rental 
Production tab of the System/Store Setup form. 
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The statements printed may be limited to selected stores, instead of all. 

The statement is printed on standard 8.5” x 11” paper and can be folded to fit in a windowed 
envelope. 

Limit to stores…Leave blank to print invoices for all stores, or select one or more stores to limit 
invoice printing to those stores. 

Include transactions on or before…Only transactions that occurred prior to the date specified 
will be included. 

Include transaction details on statement…Detail of each transaction (rentals, sales, 
adjustments, payments) will be included if checked. If not checked, only the totals for each 
invoice will be printed. 

Print New Invoices 

Switchboard: Main Menu->Rental Production->Print New Invoices 

Menu: Rental->Production->Print New Invoices 

Action: PRINTINV 
 

WinTPS© software only feature.  

 

WinPOS utilizes the word INVOICE in two software modules  1)  Accounting Integration optional 
module, the invoice term is used to indicate INVOICES for the receipt of special order or stock 
merchandise.  This invoices will be paid by the operation 2) In the WinTPS optional Accounts 
Receivable module, where the service center creates invoices to Retailed Invoices customers 
and/or Wholesale type Accounts.  These invoices will be paid by them and the outstanding 
balance of these invoices is the operation's receivable. 

This feature will print all un-printed invoices for store/accounts with invoice terms (any terms 
except None or Ticket). The Terms are set in the Store/Account maintenance form. 

WinTPS© computes the invoice due date based upon the Stores/Account Terms and inserts it 
onto the invoice. 

The system will assign a sequential number (invoice number) to each invoice produced. The 
invoice will contain all the un-invoiced ticket sale transactions that have been created (this 
includes LOST or LATE fee transactions) that have a TAKEN status and tickets of rental orders 
shipped since the last invoice was produced for a store/account.  See Ticket - Details Status for 
more information on STATUS.  

Invoices are 8.5” x 11” and do not require pre-printed forms.  Codes used on some invoice 
formats are: PD = Pickup Date, SD = Shipped date, PS = Packing Slip number. 

Note: 

Tickets with Rental transactions for wholesale store/account types cannot have Sales 
transactions on the same ticket & this rule is enforced by the system.  LOST & LATE fees 
when added by WinTPS© will be automatically placed on a newly created ticket and appear 
on the next new invoice.  Price Adjustments or Cancellations to previously invoiced rental or 
sales transactions will be placed on the invoice originally created for those transactions.  

 

Criteria 

Limit to stores…Leave blank to print invoices for all stores, or select one or more stores to limit 
invoice printing to those stores. 
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Re-Print Invoices 

Switchboard: Main Menu->Rental Production->Invoices->Re-Print Invoice Button 

Menu: Rental->Production->View Invoices->Re-Print Invoice Button 

Action: RP_Invoice 
 

WinTPS® software only feature. 

This function will re-print a selected invoice.  

View Invoices 

Switchboard: Main Menu->Rental Production->View Invoices 

Menu: Rental->Production->View Invoices 

Action: AR 

 

WinTPS wholesale feature. Will display the Invoice form showing all invoices. This form is 
comprised of a List - tab and Details - tab.  Double clicking a invoice number on the List -tab will 
display the Detail tab with transactions that comprise the charges.  

Fields 

Search for... Enter the invoice number to locate within the grid. 

 

Buttons 

 

Detail - tab Buttons 

View Ticket...Will display the ticket that contains the highlighted transaction for review or where the 
operator may make adjustments, i.e. increase/decrease the charge or to cancel the 
transaction. 

View Order...Select a rental transaction first.  This button will display the rental order that created the 
rental transaction. 

 

Common Buttons 

Re-Print Invoice...Will re-print the invoice of the selected invoice. 

Print Statement...Will print a statement of open invoices for the account.  The operator can enter a 
transaction cutoff date that will only include transactions with a date equal to or before the 
entered date. 

Invoice Utilities...A menu appears with a set of functions that affect invoices.  These should be used 
in specific situations under the direction of BBL support. 

Link Line Items...Tickets contain the transactions that compose a invoice.  All transaction on the 
same ticket should be assigned to the same invoice.  In a circumstance where some ticket 
transactions appear on a different invoice number this utility will make all transactions the 
same invoice number.  This utility insures all line items are on the same invoice by taking 
the invoice number assigned to the first ticket transaction and making the remaining 
transactions the same. 

Link Ticket...Assign a selected ticket with it's transactions to the selected invoice. 

Re-Calc Line Items...Recomputes the displayed invoice total. 
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Change Account... Assign the selected invoice to a different Store/Account. 

Cancel...Exits and returns to the previous form. 

Delete...Will delete the invoice & clear the invoice on the transactions that it was assigned to.  The 
next time a new invoice is created for the store/account, the transactions will be included on 
the new invoice.  The transactions may be adjusted by visiting the ticket that contains them. 

Done...Exits and returns to the previous form. 

 

 

 

WinTPS - How To 

How to enter a size on a order that is not owned 
 

WinTPS® & WinTPOS® software only features. 
 

There are two techniques available to handle entering rental items on orders that the company 
does not own. 

Both methods require the inventory system to contain a style for the item being rented. 

1) Without Validation: WinTPS/TPOS has the option to allow entry of any size on an order (no 
validation) via the System Setup->Rental tab->”Allow any size on rental’. Enabled, a ‘not owned’ 
size is entered WinTPS will check availability and complain that the size is NOT available. The 
user would then indicate to the system to SAVE the order forcing it into an Overbooked 
condition. Any size could be entered onto a order this way. 

 2) With Validation: Pre enter sizes in inventory with no quantity. Operators could only enter 
sizes that exists in the inventory. WinTPS will check availability and complain that the size is 
NOT available. The user would then indicate to the system to SAVE the order forcing it into an 
Overbooked condition. Only sizes pre entered into the inventory could be added to a order when 
the System Setup->Rental tab->”Allow any size on rental’ is disabled. 

 Item sizes entered not owned or not available may be immediately viewed via the Overbooked 
report by the Production manager. This will provide the manager the tools to order the items 
from a supplier or to purchase additional inventory to fulfill the order. 

How to Perform an item Exchange 

WinTPS® & WinTPOS® software only features. 

It is inevitable that a customer will receive a rental item that is unsatisfactory for some reason, 
i.e. does not fit or wrong color ..etc. This situation can be easily processed thru the system, 
assuming adequate time to receive a replacement item. 

There are three methods utilized to accomplish this task: 

 

1) Order Exchange 

The order exchange method will create a new order for the item being exchanged. This will 
require the printing of a Production ticket for the new exchange order, and the new item 
assembled and possibly shipped. This is the preferred method for wholesale accounts & remote 
stores. This method has a complete audit trail of the changes made to a order.  This audit train 
is the primary reason for this exchange approach. 



WinPOS Version 11 

622 

Status of items that are marked to be exchanged on a order is not changed.  It maintains it's 
current status.  When the order is RETURNED in WinTPOS the items on the order tagged as 
exchanged will be updated to the store's RETURN to status setting.   

All associated exchange orders linked to the original order will display and also have their item's 
statuses updated as well. 

To perform a exchange:   

Locate the customer’s order and display the order's details on the screen. 

Highlight the item that requires a exchange and click the exchange button on the Items Tab.. 
The system will automatically create a new order for the customer entering all the order’s 
details. The system also creates the a new order number using the existing order’s number as 
the basis and then appending the letters EX to the end. For example, a order has the number 
1000 assigned. It has five rental items on it. One item needs to be exchanged, the system will 
create a new order with the number 1000EX. Once the new order is created the operator can 
simply add the correct item to the order and Save it. The rental price on the ticket will be 
adjusted to reflect the difference (if any) between the exchanged and new items. 

Once the new exchange order is created a picking ticket may be generated, then assembled 
and shipped via plant service center workers via the Production area of the WinTPS program. 

The order can also be assembled from the order form.  Simply select the order, click Print Pick 
Ticket, then click Assemble Order.  This set of features allow store personnel to quickly 
assemble a exchange order when they have adequate inventory to do so, all with a solid audit 
trail. 

 

2) Order Item Swap/Exchange 

The system will allow an item on a order to be swapped when they have security permission 
RESVCHNG enabled. The user simply displays the order via the order entry form, highlights the 
item to be swapped, & double clicks the serial/barcode number field so the cursor will appear. 
 The user enters a new serial/barcode.  This new item inherits the status of the item being 
swapped and the program will take care of reversing & adding  rental statistics all behind the 
scenes for both items. 

 

3) Assembly Form Item Swap 

The WinTPS© system will allow an item to be swapped via the Assembly/QC form. The 
operator simply displays the order, highlights the item to be swapped and clicks the Swap Item 
button. The system will allow the operator to choose a new style and/or size for the item and to 
enter it’s serial/id number (if necessary). 

 

Either swap method can be accomplished via a minimum number of steps (thus faster), but 
does not have as complete audit trail as the #1 exchange method described earlier. 

 

How do I speed up Check Overbookngs 

A rental order that has a wide date range span i.e. pick-up date and return date is a wide time 
span, usually a data entry mistake, will cause the ‘Check Overbookings’ to take a long time to 
process, since the computer has to work a lot more.   

Run a orders report to look for the order, or if you are familiar with Query create a query report 
for the Rental Order Master file listing the order #, Ship Date & Back date.  Browse the results 
looking for any order that the two dates are far apart. 
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WinTPS© will not allow the Assembly & Back date on a rental order to be more than 42 days 
apart.  The Check Overbookings module will complain and display the order numbers of orders 
that have dates more than 42 days.  It will ignore those orders in it's processing. 

How to handle rental inventory Overbookings or Shortages 

WinTPS® software module requirement. 

Circumstances arise where there will not be enough rental inventory available to produce the 
rental orders needed, called ‘Over Booked’. This shortage can be a result of several factors, 
including:  

1. The operator forced a order to CONFIRM status. Even though the system 
warned them that it was unavailable 

2. Items on orders were not returned by their ‘Back Date’ (late orders). See a 
list of overdue orders via the Late Orders by Account report. 

3. Rental Inventory was sold after orders were placed. WinTPS© will 
automatically update inventory availability when tracked rental items are 
sold.  Tracked rental inventory is sold via the serial/id number assigned to 
the item or manually marked sold within inventory. 

4. Rental Inventory statuses were changed in inventory, i.e. lost, retired, in 
repair, on display ..etc and marked ‘un-available’ by un-checking the 
'Currently Available?' field.. It is very important for the rental inventory 
availability to be accurately maintained when items are lost, retired by 
production management.  

Management must constantly monitor the production inventory requirements because of these 
circumstances. WinTPS® offers the Check Overbookings tool to monitor the inventory. 

This tool can be executed any time to see what specific inventory styles & sizes are overbooked 
by assembly date range. Management can decide to sub-rent or to purchase additional 
inventory. WinTPS® has a very detailed sub-rent tracking capability. Production management 
operators would simply indicate to WinTPS® what inventory is being sub-rented OR add 
additional rental inventory in the Inventory module to meet the production needs. The needed 
items shown by the Overbooked module will disappear as new inventory is added or items are 
indicated that they are to be sub-rented (items can be marked to be sub-rented via the Over 
Bookings module). 

How to check Inventory Availability 
 

WinTPS® software only features. 
 

A user can determine the availability of an inventory item in two ways: 

 1) Create a rental order with the item in question. When entering the item WinTPS will warn the 
user if the item requested is not available and display alternate items 

 2) Selecting Locate->Check Availability or hitting the F3 key. This function will display the Quick 
Availability form and allow an operator to enter a style & size, a style only, or a size only with the 
time frame needed. The system will display the items and total number available. This is the 
fasted method to check availability. 

Review the Title Bar Menu topic Check Availability for more information. 

How to enter exact measurements for a style on a rental order 
 

The size field may contain up to seven alphanumeric characters. The size may consist of one 
to two parts. Two part sizes have a hyphen entered to separate part one from part two.  
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A Size may be validated against size codes entered into inventory for a style. A option may be 
set for the system NOT to validate sizes entered on a order against those in inventory. 
 

With size validation active, only part one of a size has to match the size entered in inventory. 
Part two does not. Part two may be free form. An example could be a pant size: 36R-39, where 
36R is a size entered in inventory and represents the waist size & rise. Part two of the size is 
the person’s outseam and is not in inventory. This example does not utilize WinPOS® size 
conversion features. 
 

Another size entry technique is the utilization of size conversion tables. This is simpler for a 
user but requires more steps to the one time setup of the system. See Size Conversion and 
Inventory for more information. Even when using size conversions the user can still enter the 
size code as it appears in inventory. 
 

With size conversion WinPOS® allows exact measurements to be entered for a style on a 
order. An exact measurement can consists of one part or two parts. With two part sizes the 
parts may be viewed as part 1 - width & part 2 - length.  
 

WinPOS® would recognize this by two numbers separated by a hyphen. For example:  
 

For a shirt, measurements would be neck then sleeve represented by: 17.5-36 or a pant would 
be waist & outseam: 36-39 

How do I sell rental inventory 

Tracked Items 

There are three possible approaches available for selling rental tracked (those with Serial/Id 
numbers) inventory items to customers. 

1. Manually, An inventory manager would locate the rental style and size, then the 
specific serial number and change it’s status to SOLD, enter the current date as the 
Retired date and un-check the Available? checkbox indicating to the system that it 
cannot be assembled for future orders. Finally create a sales ticket to the customer 
entering the style and size of the item being sold. 

2. Via the Sales Ticket, create a sales ticket for the customer purchasing the item.  

For TRACKED inventory enter the item’s serial number for the Style/Sku code. WinTPS™ 
will locate the tracked item and automatically change it’s status to SOLD, enter the current 
date as the Retired date and un-check the Available? checkbox indicating to the system that 
it cannot be assembled for future orders. The sale transaction can have a status of Taken 
(pickup now) or In (pickup later) or TRANSFER (for transferring from Service Center).  IN or 
TRANSFER  will required the item to be eventually marked as taken as soon as the 
customer takes delivery of the item. 

For NON-TRACKED inventory enter the item’s style & size.  This will decrement the on-
hand quantity in the SCW form and Rental sizes form.  The sale transaction can have a 
status of Taken (pickup now) or In (pickup later) or Order (special ordered).  In or Order will 
required the item to be eventually marked as taken as soon as the customer takes delivery 
of the item. 

Hint  

Inventory->Rental->Rental Sizes. ‘Allow Sale of Rental items? Checkbox’ must be checked 
before rental items may be sold on sales tickets. 

Multi-Store Implementation 

Multi-store implementations offers an additional sale status since often times the rental 
inventory is located at a remote service center.  The remote service center must be notified 
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that the rental item sold must be "transferred" to the requesting store.  This is accomplished 
via the TRANSFER status applied to the sales transaction when it is being created. 

a) Adds a Sale transaction to a ticket using the Rental Style and Size OR Serial/bar-code . 
 For the status, request a TRANSFER IN.  This will display a transfer form.  On the transfer 
in the notes field put the customer name and any info that would be helpful when the service 
center reviews the transfer and it will also be printed on the printed form. 

b) The Service Center should check TRANSFER requests everyday.  Print the Transfer 
form when they exists, pull the item(s) and attach/sign form to the actual items being 
transferred. 

c) Service Center performs the transfer by filling out the quantity shipped and method on the 
on-screen form.  Scan the item's serial/bar-code number into the transfer form when the 
item is a TRACKED rental item.  This will automatically mark it sold. make it un-available for 
rental and enter a retire date. 

d) Store should check for it's outgoing/incoming transfers each day.  When the vans show 
up with a transfer they must receive it.  This puts the item in that store's pickup inventory. 
 Notify the customer and when picks up mark it taken on the ticket. 

3. Special Ordered, create a sales ticket to the customer purchasing the item. For the 
style enter the item’s style & size. The sale transaction must have a status of Special 
order. A PO will be generated by the store and given to the service center. A inventory 
manager will decide which specific TRACKED Serial/ID item will be delivered, change 
it’s status to SOLD, enter the current date as the Retired date and uncheck the 
Available? checkbox indicating to the system that it cannot be assembled for future 
orders.  UNTRACKED items the inventory manager should decrement the on-hand 
quantity. The store should RECEIVE the PO when the item arrives which would 
automatically place the item in Pickup/Lay-away.  The receive process can print an ID 
tag and itt should be attached to the item, notify the customer and mark the item taken 
when delivered. 

Non-Tracked Rental Items 

1. Via the Sales Ticket, create a sales ticket for the customer purchasing the item.  

Enter the Style & size and quantity being sold.  This will decrement the on-hand quantity in 
the SCW form and Rental sizes form.  The sale transaction can have a status of Taken 
(pickup now) or In (pickup later) or Order (special ordered).  In or Order will required the 
item to be eventually marked as taken as soon as the customer takes delivery of the item. 

Special Order status does NOT decrement on-hand quantities. 

 

 

How to take a Order OFF HOLD 

Find the order & display it to the screen.  

To ‘Un-Hold’ an order, a change should be made to the order (a blank space could even be 
added to any field, WinPOS© sees any modification as a change).  

Click the SAVE button to save changes, WinPOS© will ask the operator to “Take the order off 
Hold, Yes or No”. Answer Yes and the order is automatically taken off HOLD. Un-Held orders 
with all confirmed items will print on Production Tickets. 

How to charge sales taxes for rental orders 
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WinTPS® & WinTPOS® can easily compute sales taxes for rental orders. If you have upgrade 
from an older version to version 9 please review the Prior to WinPOS version 9 section.  If this is 
a new version 9 or later install, please review the WinPOS version 9 & later section. 

 

WinPOS version 9 & later 

Please visit the store/accounts details tab to enter tax rates. 

 

Prior to WinPOS version 9 

Please review the topics of: Tax Rates & Tax Groups. 

There are some set-up details that are important to diagram for multi-store and/or wholesale 
production users of WinPOS®. These details are important when sale taxes should be totaled 
separately for each store/account to facilitate reporting to the government agencies. 

WinTPS® & WinTPOS® utilized rental order Order Types to identify the kind of order that is 
being created. From this information WinPOS® can determine the tax (if any) to apply.  

Data entry operators assign a user defined order type to the rental order when it is created.  

Rental Order Set-up Flow chart is: 

Step 1: A WinPOS® account number is created in the Chart of Accounts for each sales tax total 
that needs to be reported 

Step 2: A Sales Tax Rate is created in Taxes for each WinPOS® account number in Step 1. The 
account number is assigned to the Tax rate. 

Step 3: A Tax Group for each store/account requiring tax reporting is created and the tax rate is 
assigned to the group. The Tax Group name for each store/account can be the same. 

Step 4: An Accounting Class code is created or an existing Accounting Class could be used if 
available. The Tax Group created in Step 3 is assigned to the accounting class. 

Step 5: A rental Order Type is defined (or an existing one used) for each type of order being 
created that requires separate tax reporting. The defaults shipped with WinPOS® are are 
Gown & Formalwear for retail pricing. Accounting Classes created in Step 4 must be 
assigned to each order type. 

Step 6: Operators may assign the correct Order Type to new rental orders. WinTPS® & 
WinTPOS® will default to Formalwear for the pricing type assigned to the Store/Account. 
See Store/Accounts form for a pricing types explanation. 

Sales taxes will appear on the Revenue Report & the Sales Tax report automatically. Set-up for 
these reports are not required. 

How to force a sub-rental 

Scenarios will surface that may require the use of sub-rented inventory item(s)to be utilized on 
an order, even though the production warehouse has sufficient inventory to cover the need. 

To force the use of sub-rented inventory simply create a ‘Sub-Rental Order’ for the style/size in 
the time period wanted via the View Sub-Orders form using the ADD button. Once the 
style/size is added Assign it to the rental order via the Assign to Orders button of the View 
Sub-Orders form. 

WinTPS© will allow the use of the sub-rented item(s) during Assembly of the order in which 
the style/size was assigned to above. 

How do I apply Late Fees 
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WinTPS© & WinTPOS©  will automatically create SALE transactions on tickets for the items 
being returned late.  Late charges for wholesale store/accounts will  be invoiced the next time 
the Print New Invoice function is ran.   

See Help Topics  

Return by Item  

Return by Order POS 

Return by Order Production 

for more information. 

How do I enter Rental Inventory 

 

Rental Inventory is entered via the Inventory Rental Tab.    

BBL recommends that Rental inventory Style codes are coded differently than Retail inventory 
style codes, even for the same inventory item.  This difference is not required, but makes it easy 
for a operator to distinguish between a rental item and a retail item by simply reading the style 
code. 

The most demanding step of WinTPOS/WinTPS system setup is the entering all the existing 
inventory.  This can be a very tedious and time consuming task.   BBL has created some 
software shortcuts to help speed up this process.  

Begin by enabling the Housekeeping-> General Setup->System Setup-> Rental Production tab-
>   Allow rental qty to be greater than on-hand qty? option.  Typically inventory entry 
procedure is to add a SCW entry with a current on hand quantity owned, then designate a 
quantity equal to or less than the on hand quantity for rental.  Manually adding the SCW record 
with a quantity as the first action is tedious step when the operators are working hard to quickly 
add all the rental inventory.  This setting in conjunction with the Create Sizes from Chart 
function, described later in this topic, allows the SCW entry step to be skipped.  

First, setup the inventory support files prior to entering any rental inventory.   These support files 
are Housekeeping->Rental Setup->  ITEM TYPES, Housekeeping->Inventory Setup-> 
CATEGORIES, Housekeeping->Inventory Setup->VENDORS & Housekeeping->Inventory 
Setup->SIZE CHARTS 

BBL has created several default rental size charts.  Next, modify each chart based upon the 
range of sizes carried in each rental ITEM_TYPE.  The default Size charts are: 

Included Size Charts 

COAT               ADJ_PANT                 FIX_PANT                MENSHOE 

SHRTEVEN      SHRTEXAC                SHRTODD               VEST_FA 

VEST_FB          FITALL                       EXACT/CONT           TIE 

 

Once the size charts are finalized begin entering the inventory via Housekeeping-> Inventory 
Setup.  Start by creating a Style with it's required detail, then insert the correct Size chart for the 
rental item type used.  Click the Inventory-> Rental Tab-> Create Sizes from Chart button 
which will quickly create Inventory sizes without quantities for the style in the Inventory SCW 
form.  An additional size may be easily added via the Housekeeping-> Inventory Setup-> Rental 
Tab-> Rental Sizes-> Add New Rental Sizes button if was not in the Size chart.  Remember: 
 Rental Sizes cannot contain a color or width.  The Create Sizes from Chart button may be 
clicked multiple times without causing a problem.  The function will not overwrite existing SCW 
sizes, only add a size when the Size Chart contains a size that is not presently entered in the 
SCW form. 
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A rental inventory item that is a non-tracked item will have only a rental quantity entered.  The 
operator should select the size and enter the correct quantity. 

A tracked rental item must have it's bar-codes/serial entered.  For multiples of the same 
style/size this entry can be done via Housekeeping-> Inventory Setup-> Rental Sizes-> View 
Serial Numbers -> Add by Scanning button to save time.  Click this function and begin 
scanning each item.  This function places the form in ADD mode after each scan.  When the 
FINAL item for the size is scanned in the session, the user clicks the CANCEL button to discard 
the last ADD. 

Once the inventory is entered the Housekeeping-> Rental Setup-> Sync Rental Qty with QOH 
button function may be used.  This utility program will quickly make the Inventory-> SCW form 
style's  Quantity On Hand for each size match the rentable quantity of the same size for that 
style, thus completing the inventory data entry.  This function should only be used once after the 
initial inventory load of a new system OR  when the retail inventory and rental inventory share 
the same style code.  When the retail & rental style codes are different, the function may be 
used as often as needed. 

For example, say a style code, C100,  exists for a COAT that is sold at retail and is also rented. 
 The store currently has in stock a total of 25 size 44R and this is found in the Inventory-> SCW 
form.  Now, 10 are for sale and 15 are set as rental inventory so the 15 is found in the Rental 
Sizes form.  Using the Sync Rental Qty with QOH function, in this example, would force the on 
hand quantity to 15 losing the 10 for retail sales, an undesirable result. 

 

How do I rent styles or sizes not owned 

To rent styles or sizes not owned you have a couple of approaches that may be implemented to 
get the process accomplished. 

1)  Enter the styles and sizes into rental inventory without quantities.  These styles & sizes 
would become visible in lookups from the order form and allow for easy selection.  This is a 
great approach when the same not owned styles are rented frequently.  

Each time one of these styles are entered onto a order the NOT AVAILABLE message would 
appear and the user would have to FORCE the order to a confirmed status by checking the 
order's "Confirm order regardless of availability"  setting.  Service Center would see these 
items show on their Over bookings form whereby they can purchase or sub-rent the needed 
items. 

 

2) Enter a generic style for each rental item type.  For example.  For a generic COAT style add 
cSub style and assign standard coat sizes.  Do the same for Vests, vSub and Shoes sSub. 
 Repeat for each item type rented. 

A user may enter a generic style on a order once these generic Styles are created.  The user 
can enter the REAL style and into the item's reference field. 

Each time one of these styles are entered onto a order the NOT AVAILABLE message would 
appear and the user would have to FORCE the order to a confirmed status by checking the 
order's "Confirm order regardless of availability"  setting.  Service Center would see these 
items show on their Over bookings form whereby they can purchase or sub-rent the needed 
items. 

 

Time Clock 

Time Clock Integration 



Optional  Modules 

629 

The WinPOS® Time Clock Integration offers easy to use features which allow a shop to 
efficiently keep track of employee’s hours and print time cards and pay reports. Sales-per-hour 
reports for the employee and shop may be printed as well. 

Hint 

As added security protection the company can implement fingerprint readers that available from 
BBL. When installed the system prompt for the user to supply his/her fingerprint instead of a 
password. This insures only the user can clock themselves in/out. 

 

The Store Group feature of the optional Multi-Store module, allows Stores to be assigned a 
Store GROUP code, then Registers are assigned to Stores. When implemented   Employee 
Time Clock entries can be edited from a Store Register assigned to a store of the same Store 
Group as the Store Register store where the employee clocked in. 

Clock In/Out 

Switchboard: Main->Clock In/Out and Main->Housekeeping->Time Clock->Clock In/Out 

Menu: Time Clock->Clock In/Out 

Action: none 
 

Once selected the user is prompted for their SA ID and password. WinPOS® will automatically 
clock the user in if they are not clocked in, and clock them out if you are. WinPOS® will then 
display a confirmation dialog with the sales associates name and clock in/out time. 

The store id of the terminal being used to clock in is automatically tagged to the employee’s time 
(useful in muti-store installations). 

If you thought you were clocking out and WinPOS® clocked you in, it means that you forgot to 
clock-in last time. If you thought you were clocking in and WinPOS® clocked you out instead, 
you forgot to clock out last time. Use Edit Time Cards to correct your clock-in and out times. 

A user may Print or View their own time card for review each time they clock in or out.  The 
feature may be disabled/enabled via the Housekeeping-> General Setup-> System Setup-> 
Options-> User can review and print time card at clock in/out?. 

 

Clock All Out 

Switchboard: Main->Housekeeping->Time Clock->Clock All Out  

Menu: Time Clock->Clock All Out  

Action: CLOCKALL 
 

This show you each employee who is clocked in so you can manually clock them out. You 
would use this at the end of the day to check and see who forgot to clock out. 

Limit to stores… In muti-store installations the store numbers to check for employees clocked 
in may be entered. 

Display SA Clocked In button...This shows the employee name(s) and the date/time they 
clocked in. 

 

Clock out at...Enter the time that they should have been clocked out. 

Clock Out button...Saves the clock-out time and displays the next employee. When the final 
employee is clocked out the message: ‘No one is currently clocked in’ will appear. 



WinPOS Version 11 

630 

 

Show Clocked Out 

Switchboard: Main->Housekeeping->Time Clock->Show Clocked Out  

Menu: Time Clock->Show Clocked Out  

Action: SHOWALL 
 

This form will show you all the employees who clocked out on a specific day. You would use this 
at the end of the day to see who worked. 

Limit to stores… In muti-store installations the store numbers to check for employees clocked 
out may be entered. 

Show for date...Enter the date you want to check. 

Show all button...Clicking this will display all the employees who clocked out on that date. 

Show Clocked In 

Switchboard: Main->Housekeeping->Time Clock->Show Clocked In  

Menu: Time Clock->Show Clocked In  

Action: SHOWALL 
 

This form will show you all the employees who clocked in on a specific day and are currently 
clocked in. 

Limit to stores… In muti-store installations the store numbers to check for employees clocked 
in may be entered. 

Show for date...Enter the date you want to check. 

Show all button...Clicking this will display all the employees are clocked in for that date. 

Edit Time Cards 

Switchboard: Main->Housekeeping->Time Clock->Edit Time Cards  

Menu: Time Clock->Edit Time Cards  

Action: TIMEDIT 
 

This form is used to edit clock-in and clock out times.  Security is available for this form where 
only authorized managers may edit.  Changes to time cards are logged  and can be viewed on 
the Log form.  The log entries use the key type is EDIT, and the Log form can be filtered to 
show only these log entries. 

 

Criteria 

Select sales associate to edit...Enter the SA ID to edit, or use the binoculars to search for one. 

Limit to store… In multi-store installations the store number where the employee clocked in/out 
may be entered. 

Clock in/out time list...This list shows you all the clock-in and out times. 

• Time in: The date and time the SA clocked in. Note that the date and time are 
entered together. You must enter the time in 12 hour format, with the AM/PM. 
 Editable.. 
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• Time out: The date and time the SA clocked out. Editable. 

• Duration: This is calculated automatically by WinPOS®. It will be shown as hours 
and minutes (8H 12M), or fractions of hours (3.75). This is controlled by the “Show 
time as decimal on time clock reports” setting in System Setup - Options Tab. Auto 
calculated. 

• Edit?: If this is checked, this time card entry has been edited and changed.  Non-
Editable. 

• Store ID: The store ID of where the employee clocked in & out. Editable. 

• Time Code: The time code for the hours worked.  Editable.  Validated against the 
available time codes.  If there are any time codes defined, then this field must be 
filled in. 

• Name: the name of the employee. Editable. 

 

Time Cards 

Switchboard: Main->Housekeeping->Time Clock->Time Cards 

Menu: Time Clock->Time Cards 

Action: RP_TIMECARD 
 

This prints time cards for employee. It is only available if you have the Time Clock integration. 

Only include time from xxx to yyy...Only print time cards for the dates between the dates 
specified. 

For sales associate...You can print the time cards for a single sales associate by selecting them 
here. 

Department...Each employee is assigned a department on the Employee form. You can print 
timecards by department by entering it here. Leave blank for all departments. 

Print one time card per employee...If you don’t check this you’ll get one long report, sub-totaled 
by employee 

Limit to stores… In muti-store installations the store numbers where the employee(s) were 
clocked in/out may be entered. 

Time Codes 

Switchboard: Main->Housekeeping->Time Clock->Time Codes  

Menu: Time Clock->Time Codes 

Action: TIMECODE 
 

This form is used to create a time code & description.  Time codes may be added to clock in/out 
times via the Time Edit form to indicate the class of time it is.  For example a manager may want 
to enter the time an employee was on vacation and assign it a vacation time code. 

Time codes will appear with the hours on employee time cards. If any time codes are defined, 
then a time code must be selected when editing time cards. 

Buttons 

Add...Allows for a new 10 character code to be created. 

Delete...Deleted the highlighted code. 

Done...Exits the form and returns to the previous menu. 
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Save...Saves all edits made. 

Cancel...Discards all edits. 

Hourly Pay Report 

Switchboard: Main->Reports->Daily Mngmnt Reports->Hourly Pay Report and Main-
>Housekeeping->Time Clock-> Hourly Pay Report (RP_CLKHR) 

Menu: Reports->Financial Reports->Hourly Pay Report and Time Clock->Hourly Pay Report 

Action: RP_CLKHR 

 

Overview 

This report is available with the optional  Time Clock integration module. 

The WinPOS timeclock program is not a payroll system, but makes working with payroll 
systems easier.  It prints hours worked and optionally can multiple the hours worked & an hourly 
rate to provide a payroll budget..  It helps management by allowing employee time to analyzed 
and prints time saving hourly time reports.  It is designed to be used by management as an 
analysis tool for maximizing the shops profit via more efficient labor distribution. It contains a 
general idea to payroll costs and does not take  into consideration, payroll taxes, insurance or 
benefits. 

The report prints the total time and pay for employees. It prints a single line per employee. Use 
the Time Card report for "time Cards" by employee.  Overtime is considered hours over 40 in 
the date range asked for. 

The report runs as two reports.  The first report provides the calculations for hours, 8am to 2 
pm.  The second report includes the hours of 3pm to 9pm. 

Grouped by department and day, the report provides the total employees that worked the full or 
portion of the hour.  Exact total time of all employees working within the hour and the sales 
divided by the time worked, thus providing an accurate sales per hour total. 

 

Criteria 

Only include time from xxx to yyy...Only print time cards for the dates between the dates 
specified. 

For sales associate...The report may be limited to a specific sales associate by entering the 
employee code.   Leave blank for all. 

Department...Each employee is assigned a department on the Employee form. Print time cards 
by department by entering the department code.  Leave blank for all departments. 

Limit to stores… In multi-store installations the store locations where the employees were 
clocked in/out may be entered.  Leave blank for all locations. 

 

 

Dept. Hour Totals Report 

Switchboard: Main->Housekeeping->Time Clock->Dept Hour Totals Report  

Menu: Time clock->Dept Hour Totals Report  

Action: RP_DEPHR 
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This report totals time for each department. It is only available if you have the Time Clock 
integration. 

Only include time from xxx to yyy...Only print time cards for the dates between the dates 
specified. You must enter a date range. 

Department...Each employee is assigned a department on the Employee form. You can print the 
total for a single department by entering it here. Leave blank for all departments. 

Limit to stores… In muti-store installations the store numbers where the employee(s) were 
clocked in/out may be entered. 

Appointments 

Appointment Form 

Appointments Overview 

With the WinPOS® Appointment Integration, you can create and manage customer 
appointments in WinPOS®.  

 

To begin utilizing the BBL Appointment module several set-up steps are required.  The setup 
steps are: 

1. Create Skills: Skills indicate to the system what the Resource/SA can do.  For 
example, Sales Associates skills might include FIRSTVST (they can handle a 
customer on their first visit), or BM (the Sales Associate can perform bridesmaid 
consultations). 

2. Create the Resources: Resources are created in the Sales Associates form.  Usually 
these resources are Sales Associates.  However, resources could also mean 
dressing rooms, equipment or anything that requires reservation of it's time.  Skills 
should be assigned.  A SA/Resource may have multiple skills.  The Skill entered first 
for the SA/Resource will be their primary skill. 

3. Set Appointment types: For example, you might have an appointment type 
FIRSTVST or BM. Then, for each appointment type, you specify the employee skills 
needed to perform that appointment. For our example here, the FIRSTVST 
appointment type would requite the FIRSTVST skill. 

4. Availability Codes: Optional step.  WinPOS© offers several standard codes.  Create 
the availability codes and assign it a specific color. 

5. Resource/SA schedule:  Input the standard work schedule for each 
employee/resource, indicating at what times they are available for appointments. 
 This setup if  for each day of the week (Sunday – Saturday.) You must also specify 
what skills each employee has (which then controls which appointment types you 
can book for the SA.) 

6. Resource/SA Exception Schedule:  A Resource/SA may be unavailable for specific 
future date, i.e. vacation, sick day ..etc.  These exceptions to the standard work 
schedule must be entered for each.  

7. Appointment Alerts/Scripts: This is an optional step.  The creation of an appointment 
can cause the Alert/Script message to display for the time frame of the Alert/Script. 
 Only one Alert/Script may be active. 

8. Skill Rankings: This step is optional for single store installations & is not supported in 
Multi-Store installations.  This provides the capability to rank each employee for 
each skill.  Like a batting order, when an employee lookup list is provided for 
assigning an appointment to the SA/Resource, the list will be sorted in order of the 
Skill ranking of the skill to fulfill the appointment type being scheduled.  Those 
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ranked higher & available will be at the top of the list. (not available with the optional 
multi-store module) 

Once the steps are completed appointments may be created.  Click the View/Edit 
Appointments function, then Add appointment.  Enter/Select a date and Appointment Type. 
 WinPOS® can then display the Resource/SAs that are available and have the skills for the 
appointment type entered, OR show you how many “time slots” you have available, based on 
the number of employees that are working and have the skills for the appointment.  

If an appointment is changed after it has been created, the changes are logged in the system 
log, under APPTEDIT. 

The following function Buttons are common to all forms of the View/Edit Appointment function 
and affect the selected/displayed appointment. 

Appointment Button functions 

Rebook…Used to rebook and existing appointment. This will change the status of the current 
appointment to Rebook, make the time available again for another appointment and 
display the Add Appointments form to create/book a new appointment. The appointment 
details of the selected appointment (customer info, appointment type, etc.) will be carried 
over to the new appointment automatically. 

Page…Used to send a page via an in-house paging system that may be supplied by BBL. 
Requires that the PageLink software is configured and running on your pager server 
computer, and that WinPOS® is correctly configured with the Pager path in System/Store 
Setup. When you click this button there are three menu options. 

• Page SA: Prompts you for the message text, then sends a page to the SA specified 
in the Appt With field. 

• Assign Pager to Cust: Prompts you for the pager ID of a pager that you will give to 
the customer. The pager ID is then stored with the appointment. 

• Page Cust: Prompts you for the message text, then sends a page to the customer. 

No-Show... Marks the selected not COMPLETED appointment as a No Show.  The appointment 
status must be NEW or CONFIRMED before it may be tagged as a no show. 

Arrived and Waiting…Press this when the customer arrives for their appointment. Sets the 
appointment status to Waiting and inserts the current time into the Arrived field. This step 
is important because WinPOS® uses these statuses to track how effective your SA’s are 
and how well your appointments are going. 

Appointment Started…Press this when the appointment starts. Sets the appointment status to 
Started and inserts the current time into the Started field.  

Appointment Complete…Press this when the appointment is completed. Sets the appointment 
status to Complete and inserts the current time into the Completed field. This step is very 
important because WinPOS® will then automatically create a prospect card for this 
customer if one does not already exist.  

Customer Walkout…Press this if the customer leaves before the appointment starts. Sets the 
appointment status to Walkout. 

Appointment Confirmed…Used if you have called the customer to confirm the appointment. 
Sets the appointment status to Confirmed and inserts the current date / time into the 
Confirmed field. 

Appointment Cancelled…Used if customer has cancelled the appointment (not rebooked it) 
Sets the appointment status to Cancelled and inserts the current date / time into the 
Cancelled field. 
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Add…Displays the Add Appointment form to select an appointment date/time, appointment type 
and optionally a Sales Associate. 

Add Walk-In Customer…Creates an appointment for a walk-in customer. The appointment time 
is set to the current time, and the status is set to Waiting. The Waiting status is 
highlighted on the Appointment list if they are a Walk-In. Once you give that customer to 
a SA, click the Appointment Started button. 

Add Same Customer…Creates a new appointment for the selected/displayed appointment and 
carries over the customer name, address, etc. to the new appointment. 

Print... Clicking this function button will display a menu of additional options.   

Report... Prints a worksheet recapping the appointment details on a single page for the 
highlighted appointment. 

SMS Bride... With the optional eMail marketing enabled a SMS/text message may be sent to the 
customer contained within bride section of the appointment details tab.  For this to work 
the email marketing option must be activated and the customer's cell phone provider and 
cell phone number must be completed on the appointment form. 

SMS Groom...With the optional eMail marketing enabled a SMS/text message may be sent to the 
customer contained within groom section of the appointment details tab.  For this to work 
the email marketing option must be activated and the customer's cell phone provider and 
cell phone number must be completed on the appointment form. 

Email both... Send a email to the email addresses entered on the appointment for both the bride 
and groom.  When selected the system will look for email appointment email templates 
created in the letters/tags/mail label module of the program. 

 

For more details review topics: 

Appointment Form - List Tab 

Add Appointment Form 

Appointment Form - Details Tab 

Appointment Form - Extra Tab  

 

Appointments Form - List Tab 

Switchboard: Main->Appointments->View Edit Appointments->List Tab 

Menu: Appointments->Appointments->List tab 

Action: none 

 

The list tab displays a grid that contains ALL of the appointments in WinPOS®, past & future.. 
WinPOS® will automatically highlight the next appointment that is to occur, based on the 
system's current date and time. 

At the top of the list tab is a set of search fields. You can fill in one or more of these fields and 
press the LIMIT button. WinPOS® will then filter the list to show only the appointments that 
match the data in the fields entered. To again show all appointments, press the Clear button 
which removes any filter in effect. 

WinPOS® will automatically highlight the next appointment based on start time, or the first 
Walk-In appointment. 

The rows are color-coded based on the appointment status: 
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Cancelled, Walkout, No-Show is pink 

Rebook is orange 

Waiting is green 

Started is blue 

 

Criteria 

Only show active appointments? (checkbox)…If checked, Only shows appointments for today 
and after, that are status New, Confirmed, Waiting, or Started.  When this checkbox is 
unchecked, it clears all other criteria as well. 

Show appointments for this store only? (checkbox)…Only visible if you have the WinPOS® 
Multi-store. If checked, WinPOS® will only display appointments for the store assigned to 
the register the user is logged in on that is displaying this List. 

Appt date…Appointment date.  Enter a start and end date. Only appointments between these 
two dates will be shown when the LIMIT button is clicked. 

Created date…Enter a start and end date. Only appointments created between these two dates 
will be shown when the LIMIT button is clicked. 

Appt type…Enter or select an appointment type. Only appointments of this type will be shown 
when the LIMIT button is clicked. 

Last name…Enter all or part of the customers last name. Only appointments where the 
customers last name matches or partially matches will be shown when the LIMIT button 
is clicked. For example, if you enter Jones, Jone will match but Joneses will not. 

Appt with…Enter or select a SA ID and only appointments with the SA will be shown when the 
LIMIT button is clicked. 

Appt status…Select an appointment status. Only appointments with that status will be shown 
when the LIMIT button is clicked. 

Buttons 

Limit button…This button will filter the list to show only appointments that match your fields. 

Clear button…Clears the filter and shows all appointments. 

 

Appointments Form - Details Tab 

Switchboard: Main->Appointments->View Edit Appointments->Details Tab 

Menu: Appointments->Appointments->Details Tab 

Action: none 

The tab shows all the details of an appointment. 

 

 

Fields 

Details Section 

Appt with…The SA ID of the clerk who will meet with the customer. If you display the lookup 
form (by clicking the binoculars or pressing F2) the list if SA’s will be filtered to show only 
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the SA’s who have the skills to perform the selected appointment type. You can check an 
option on the lookup form to display all SA's. 

Type…The appointment type. 

Starts…The date and time the appointments starts. 

Duration…The duration in minutes.  This may default based upon the appointment type 
definition. 

Ends…The time the appointment ends.   

Status…As an appointment is created, confirmed, and completed, it’s status changes 
automatically. You don’t normally need to manually change the status. You can tell at a 
glance what is happening with an appointment by looking at its status. The status can be 
one of the following: 

• New: This appointment has been created. 

• Confirmed: The customer has been contacted to confirm the appointment. You can 
press the Appointment Confirmed button on this form to set this status. 

• Cancelled: The customer has cancelled this appointment and has not rebooked it. 
You can press the Appointment Cancelled button on this form to set this status. 
You will be prompted to confirm that you are canceling the appointment. If the 
customer cancelled this appointment to rebook it at another time, click the Rebook 
button to set the appointment status to Rebook, and create a new appointment. 

• Waiting: The customer has arrived and is waiting for their appointment. You can 
press the Arrived and Waiting button on this form to set this status.  

• Started: The appointment has started and the customer is with the sales associate. 
You can press the Appointment Started button on this form to set this status.  

• Complete: The appointment is done. You can press the Appointment Completed 
button on this form to set this status. You can only complete appointments on the 
day they are scheduled. When you complete an appointment, WinPOS requires it to 
be linked to a customer or prospect. If the appointment is not already linked, 
WinPOS will prompt you for a phone number to search for a prospect to link it to, or 
to add a new prospect to link it to. 

• Walkout: The customer left while waiting for their appointment to start. You can 
press the Customer Walkout button on this form to set this status. 

• No-show: The customer never arrived for their appointment. This status is set 
automatically when you run the Process No-Show Appts (APPTNSHOW) option 
nightly, located at Main->Appointments->Process No-Show Appts. 

Created by... The SA who created the appointment. 

Bride Section 

Primary Phone... Cell/Primary phone number entered for the person the appointment is with. 

SMS Alerts?... Enter the person's cell phone number within the primary phone field and then 
choose the carrier within this field.  The presence of a carrier indicates that it is OK to 
send SMS/Text messages to the customer's cell phone.  With many cell carriers this 
service is an additional fee paid by the customer. 

First... First name of person the appointment is with. 

Last... Last name of person the appointment is with.  A last name is required to save the 
appointment. This last name OR the groom's last name must be entered. 

Address, phone #s... Additional optional contact info for person appointment is being made for. 
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Zip code…If you enter the zip code before the city and state, WinPOS® will check to see if that 
zip code has been entered before. If so, WinPOS® will insert the correct city and state 
automatically. 

Event date... Date of the event (wedding or social)  

Walkin (checkbox)... Checked when this appointment is created via the walk-in appointment 
button.  

Customer source...The customer source represents an activity (advertising) (i.e., yellow pages, 
word of mouth, etc.) that caused the customer to visit your shop. By using this code, you 
will be able to generate analysis reports that will provide information indicating your most 
powerful form of advertising. You can define your sources using Main->Housekeeping-
>General Setup->Customer Sources.  

E-mail…The customers email address. You can double-click to create a new email message. 

Notes button…You can enter any notes for the appointment here. 

 

Groom Section 

Primary phone... Phone number for a groom (optional).  

SMS Alerts?... Enter the person's cell phone number within the primary phone field and then 
choose the carrier within this field.  The presence of a carrier indicates that it is OK to 
send SMS/Text messages to the customer's cell phone.  With many cell carriers this 
service is an additional fee paid by the customer. 

Groom First...  Groom's first name. 

Groom Last... Groom's last name. 

Alternate phone, Work phone, email... Additional optional contact info for the groom. 

 

Bottom Section 

Script button…Displays the script from the appointment type. 

Comment... Short notes for the appointment.  For longer noe details use the NOTES button. 

Location…The location of the appointment. 

Misc 1-4… Area for optional fields of data to collect when making an appointment and are 
defined by the Appointment Type. 

 

Add Appointment Form 

Switchboard: Main->Appointments->View Edit Appointments->Add button 

Menu: Appointments->Appointments->Add button 

Action: none 

This form is displayed when you click the Add button on the Appointments form This form is 
used to create a new appointment.  

The system will first prompt for a requested appointment date, then the appointment type. 
WinPOS® will, by default, display the duration and allowed start times defined by the 
appointment type setup. The system will process and automatically display 
schedules/appointments by Sales Associate or By Time Slot.  
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By SA Tab… WinPOS® will display a list of the sales associates who can perform that 
appointment type and who are working on that day. If no sales associates are available, 
WinPOS® displays “No Appointments Found” 
 
Each column in the list represents an hour: 9am, 10am, 11am, etc. Each hour is broken 
down into four blocks, which are 15-minute increments. If the SA is available during a 15 
minute block, that block is shown in green. Any other color means the employee is not 
available during that time frame. 
 
To create an appointment, double-click on the block that represents the start time for the 
appointment. WinPOS® will display the Appointment form so you can fill in the details of 
the new appointment and save it. Note that the list actually shows all hours of the day, 
from 12am to 11pm. You can therefore create an appointment for any time of the day. 
You can specify the time of day when your first appointment starts in System/Store Setup 
(SETUP) and WinPOS® will automatically display that time first in the list. 

By Time Slot Tab… WinPOS® will list the times during the day when the appointment can start 
down the left side of the grid. Each column in the grid will be a day, starting with the day 
specified above. In each cell in the grid will appear the word YES or NO. A YES means 
that an appointment can be scheduled at that time. To schedule an appointment double-
click on a cell in the grid and WinPOS® will display the Appointment form so you can fill 
in the details of the new appointment and save it.  

• Show all time slots?: Normally, WinPOS® only shows times when the appointment 
is allowed to start (based on the allowed start times in the Appointment Type) Check 
this box to show all possible times. You will then have to click Find Appointments to 
re-display the slots. 

• Show detail for each slot?: WinPOS® can display the detail for each slot, rather than 
just YES or NO. WinPOS® displays the number of appointments available / total 
number of appointments / number of appointments already booked. 

 

Buttons 

Find Appointments... Once the requested appointment date and Appointment type are 
entered, click this button to instruct the system to process and locate the schedules & 
appointments by SA/Resource and Timeslot. 

Done... Exits the form and returns to the previous form. 

Previous Day... Moves back one day of the current appointment date and refreshes the form. 

Next Day... Moves forward one day of the current appointment date and refreshes the form. 

 

Appointment Form - Extra Tab 

 

Created…The date and time this appointment was created. 

Confirmed…The date and time this appointment was confirmed. You cannot enter this directly, 
you confirm the appointment by pressing the Appointment Confirmed button. 

Arrived…The time the customer arrived. This is set automatically when you press the Arrived 
and Waiting button on this form. 

Started…The time the appointment started. This is set automatically when you press the 
Appointment Started button on this form. 

Completed…The time the appointment was completed. This is set automatically when you press 
the Appointment Complete button on this form. 
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Cancelled…The date and time this appointment was cancelled. You cannot enter this directly, 
you confirm the appointment by pressing the Appointment Cancelled button. 

 

Last modified…The date and time this appointment was last changed. You cannot enter this 
directly, it is set automatically when the appointment is changed. 

Modified by…The SA ID of the person who modified this appointment last. 

Show History button... Show history of specific status edits & their date/times made to this 
appointment and by which user.  This is displayed from the log file.  Edit Tracking  does 
not require any security setting or setup, it is automatic and requires a user to enter a 
user name & password.  The edits that are tracked / logged are status changes to 
CANCELLED, WALKOUT, NO-SHOW or to any status if the status was CANCELLED, 
WALK-OUT or NO-SHOW. 

Appointment ID…This the appointment ID automatically generated by WinPOS®. The first part 
of the number is your store number (as set in Main->Housekeeping->General Setup-
>System/Store Setup->Setup Tab) followed by a sequence number. You cannot change 
this number. 

Pager ID... With the optional local paging hardware, the customer may be paged that the sales 
associate is ready.  This is the ID of the pager with the customer. 

Prospect number…If this appointment was created from the Prospect Form, the prospect ID 
number is shown here. When an appointment is completed, a prospect card is 
automatically created and the prospect ID is shown here. You can double-click on the 
prospect ID to show the Prospect form. 

Customer number…If this appointment was created from the Customer form, the customer ID 
number is shown here. You can double-click on the customer ID to show the Customer 
form. 

Previous appointment ID…This appointment could have been a re-booked appointment, i.e. a 
re-booked from an previous appointment meaning the rebook button was clicked.  In that 
case  this is the appointment ID of the appointment re-booked. 

 

Show History button... When clicked this function will display a list (log) of edits to the 
appointment including date, time and Clerk/SA. 

Add Credit Card button... Visible when the optional credit card integration is activated with 
IPCharge integration.  Allows credit card information to be entered and saved along with 
this event when using the WinPOS credit card/electronic payment option with IPCharge. 
 The customer card information is actually store in IPCharge which is a Visa/Mastercard 
security certified application. . A credit card can be swiped, or the account number and 
expiration date can be entered manually. This is typically done to keep a credit card on 
file for an appointment to charge the customer for a missed appointment.. A user needs 
VIEWCARD security to be able to perform this function. 

Charge Credit Card... Visible when the optional credit card integration is activated with IPCharge 
integration.  Allows the saved credit card to be charged.  It will create a customer record 
for the appointment, if one does not already exist. It will then display the Ticket form for 
the customer to allow a sale and payment to be rung up. 

Charge Credit Card button... When clicked this function will display a list (log) of edits to the 
appointment including date, time and Clerk/SA. 

 

SA Schedule Exceptions 
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Switchboard: Main->Appointments->SA Schedule Exceptions 

Menu: Appointments>SA Schedule Exceptions 

Action: EMPSCHED 

Each employee has a work schedule, which shows their availability for a work week, set up 
using the SA Work Schedule form, located at Main->Appointments->SA Work Schedule. You 
use the SA Schedule Exceptions form to enter exceptions to that schedule. 

To set up the Exceptions schedule, first enter a date in date prompt at the top of the form. 
WinPOS® will adjust the date to the nearest Sunday and display the actual work week in the 
schedule grid. Then, enter a start and end time, and select their availability for that time frame. 
Finally, click Set Availability. The color coding in the grid will change to indicate their availability. 
For example, if the SA works from 9 to 5 M-F, you would first select Monday in the grid. Then, 
enter 9am in the Start field, 5pm in the end field, then select Available from the Availability field, 
and finally click Set Availability. The grid changes from Red to Green on Monday from 9-5. The 
next day of the week is automatically selected, so if they are working the same hours you can 
just clock Set Availability again. 

Start…Start time to set the availability. 

End…End time to set the availability. 

Availability…The SAs availability from the start to end time. You can create your own availability 
codes using the Availability Codes form, located at Main->Appointments->Availability 
Codes (WORKCODE) 

Set Availability button…Actually updates the schedule grid with the start, end, and availability 
selected. 

Reset Schedule…Used when you change a SA’s default schedule and you want to update their 
displayed exception schedule to match. Only dates where you have not changed the 
exception schedule will be reset back to their default schedule. 

Schedule Grid…Shows the SAs availability for a specific work week. The date is shown on the 
left. There is one column for each hour during the day. There are actually columns for 24 
hours, 12am to 11pm. WinPOS® shows you the schedule grid starting at your 
appointment start time specified in System Setup Other Settings Tab.  
 
Each column contains 4 blocks, each representing 15 minutes. The color of the blocks 
tells you the employee’s availability. Green means that the employee is available, any 
other color means they are not. You can configure your own availability codes and 
customize the colors. See Availability Codes form, located at Main->Appointments-
>Availability Codes (WORKCODE). 
 
You can double-click on a block to see the description of the availability. 

Process No-Show Appointments 

Switchboard: Main->Appointments->Process No-Show Appointments 

Menu: Appointments->Process No-Show Appointments 

Action: APPTNSHOW 

This option scans through the appointments and sets the status to No Show for any 
appointments where the customer did not show up. You should run this option nightly. 

Purge Old Appointments 

Switchboard: Main->Appointments->Purge Old Appointments 

Menu: n/a 
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Action: none 

The appointments purge is now found in the Purge form. 

You will need to purge old appointments periodically. You will want to keep old appointments in 
WinPOS® for a certain period of time (a year perhaps) but delete any appointments older than 
that. This purge feature lets you purge appointments older than a date you specify. You should 
always make a backup before purging, and retain that backup until you are sure the purge was 
successful.  

View Schedule 

Switchboard: Main->Appointments->View Schedule 

Menu: Appointments->View Schedule 

Action: ADDAPPT 
 

This form will show you the work schedule for each SA, for the date you specify. The schedule 
is color coded according to the settings in Availability Codes (WORKCODE). 

The Print button on the right side of the form will print the schedule.  Instead of color codes it 
will use letters to indicate availability. 

Appt date...The date to display. 

Appointment Setup 

SA Work Schedule and SA Exception Schedule 

Switchboard: Main->Appointments->SA Work Schedule  

Menu: Appointments->SA Work Schedule  

Action: EMPSCHED 

Employees have a standard work schedule AND a exception schedule.  The standard work 
schedule shows their normal availability for a work week. A standard work schedule is for one 
full week, from Sunday to Saturday and consist of an employee's typical hours for a week. For 
example, an employee may work from 9am to 1pm, then take a 30 minute lunch break from 
1pm to 1:30pm, then work from 1:30pm to 5:30pm. Once you have set up a standard work 
schedule for an SA, it automatically applies for all future work weeks.   Work Schedules may be 
modified anytime.  Modifications to work schedules after appointments have been taken may 
effect those appointments and an Appointment Exception report should be ran to identify any 
problems.  For reference, WinPOS totals and displays the total hours of the work week 
scheduled for the employee. 

Work exceptions to the standard schedule, i.e. not standard day, off for doctor visit or vacation,, 
are entered the SA Schedule Exceptions form.  This form displays the dates of each day, 
allowing for an work exception or availability code change for any future date. 

To set up a SA's standard Schedule, first select a day of the week in the grid. Then, enter a start 
and end time, and select their availability for that time frame. Finally, click Set Availability. The 
color coding in the grid will change to indicate their availability. For example, if the SA works 
from 9 to 5 M-F, you would first select Monday in the grid. Then, enter 9am in the Start field, 
5pm in the end field, then select Available from the Availability field, and finally click Set 
Availability. The grid changes from Red to Green on Monday from 9-5. The next day of the week 
is automatically selected, so if they are working the same hours you can just clock Set 
Availability again. 

The form totals available time as entered for the employee.  The availability code must defined 
as AVAILABLE. 



Optional  Modules 

643 

New availability codes may be created or existing one edited in the Availability Codes form, 
examples of codes may be VACATION, DOCTOR, FLOAT, AVAILABLE, SICK, etc.  Colors for 
availability codes may be defined within that form as well. 

 

Fields 

Start…Start time to set the availability. 

End…End time to set the availability. 

Availability…The SAs availability from the start to end time. You can create your own availability 
codes using the Availability Codes form, located at Main->Appointments->Availability 
Codes (WORKCODE) 

Set Availability button…Actually updates the schedule grid with the start, end, and availability 
selected. 

Schedule Grid…Shows the SAs availability for a standard work week. The days of the week are 
shown on the left. There is one column for each hour during the day. There are actually 
columns for 24 hours, 12am to 11pm. WinPOS® shows you the schedule grid starting at 
your appointment start time specified in System Setup Other Settings Tab. 

Each column contains 4 blocks, each representing 15 minutes. The color of the blocks tells 
you the employee’s availability. Green means that the employee is available, any other color 
means they are not. You can configure your own availability codes and customize the colors. 
See Availability Codes form, located at Main->Appointments->Availability Codes 
(WORKCODE). 
 
You can double-click on a block to see the description of the availability. 

 

Reset Schedule button... Resets the exception work schedule for the selected employee back to 
that employee's standard schedule. 

Done button... Exits the form and returns to the previous form. 

 

SA Skills 

Switchboard: Main->Appointments->SA Skills  

Menu: Appointments->SA Skills  

Action: EMPSKILLS 

SA skills used to control which employees can perform which appointment types. You specify 
an employees skills on the Employee form, and the skills needed for an appointment on the 
Appointment Type form. 

Skill…A unique name for the skill. 

Description…A longer description. 

System defined…If checked, this skill is used by the system and cannot be changed or 
removed. 

Availability Codes 

Switchboard: Main->Appointments->Availability Codes  

Menu: Appointments->Availability Codes  

Action: WORKCODE 

Availability codes are used when creating employee schedules and schedule exceptions. 
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Name…A unique name for the work code. 

Code…A single letter code that uniquely identifies the availability code. You would normally used 
the first letter of the name. 

Color…The color code to use when displaying this availability. Click the binoculars to select a 
color. 

System defined…If checked, this code is used by the system and cannot be changed or 
removed. 

Appointment Type 

Switchboard: Main->Appointments->Appointment Types  

Menu: Appointments->Appointment Types  

Action: APPTTYPE 

Appointment types define details of new appointments. You must create an appointment types 
before you can create appointments. 

Type…A unique name for the appointment type. 

Description…A longer description for this type. 

Starts, Ends…If this appointment type only applies to a certain time frame, enter the dates here. 

Always active?…If this appointment type applies all the time, check this box. You cannot check 
this box and have a start and end date. 

Sales Type Appointment?… Can this appointment type be considered a opportuninty to sale to 
the customer? The optional Sales Performance report module counts sales type 
appointments for calculating close ratios. 

Script…The script that the user should read when creating the appointment. The text entered 
here can be displayed be pressing the Script button on the Appointment form. 

Skills…The SA skill required to perform this appointment. 

Start times…Enter times separated by commas. These are the times that this appointment is 
allowed to start. For example, if you enter 9am,10am,11am,12pm it means that the 
appointment should only start on one of those times. 

Duration…The appointments duration in minutes. 

Captions for Misc fields on Appointment 1-4…The captions specified here will be carried over 
to the four Misc fields on the Appointment form. You would use these if you want to enter 
special information specific to an appointment type on the appointment form. 

Appointment Alerts/Scripts 

Switchboard: Main->Appointments->Appointment Alerts/Scripts  

Menu: Appointments->Appointment Alerts/Scripts  

Action: APPTALRT 

This is feature used to alert users whom create appointments of special information for a 
specified time frame and for a specified appointment type.  Once an alert is created it will be 
automatically displayed when a user creates an appointment within the time frame for an 
appointment type that matches those set-up for the alert. 

 

Fields 

Description…A description of the alert. 
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Start date...The date this alert should begin appearing 

End Date...The date this alert should stop appearing 

Store ID...The store for which this alert should appear for.  This is only active for multi-store 
installations. 

Appointment Type Grid...Enter the appointment types this alert should appear for. 

Add Item..Add an appointment type to the grid 

Delete Item...Delete an appointment type from the grid. 

Buttons. 

Script Button...This function allows a user to enter a detailed script for the displayed/selected 
Alert 

Delete Button...This deletes the selected Alert 

Add Button...This feature allows an new Alert to be created 

Done Button...This button exits the form 

Save Button...This saves all modified data on the form. 

Cancel Button...This feature reverts to the data prior to any changes. 

 

 

 

 

 

Set Skill Rankings for SA 

Switchboard: Main->Appointments->Set Skill Rankings for SA  

Menu: Appointments->Set Skill Rankings for SA  

Action: SARANK 

Each SA has a skill ranking that applies to their first skill. When you assign a SA to an 
appointment, the SA with the higher skill ranking appears first on the list. This form allows you to 
set the SA ranking more easily than setting it via the Employee form. 

No two sales associates can have the same ranking for the same skill.  

This form is not available in multi-store. 

Show only skill...You can select a skill and only employees with that skill will be shown. 

Appointment Reports 

Appointments By SA Report 

Switchboard: Main->Appointments->Appointments By SA Report  

Menu: Appointments->Appointments By SA Report  

Action: RP_APPTSA 

This report shows appointments, with a separate page(s) for each SA. 

For purchase & purchase percentage calculations the customer or prospect linked to the 
appointment does not have to have purchased on the same date as the appointment. 

Hint 
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Do not change an appointments status directly using the status drop down.  Change an 
appointment's status by utilizing the status buttons found on the bottom of the form. 

 

Criteria 

Limit to sales associate...Only print appointments for the selected sales associate SA. 

Appointments between...Only show appointments that occurred between the dates specified. 

Department: Sales Associates may be assigned to departments.  Select a department to view all 
SA appointments assigned to the department. 

Total by Day (checkbox): A multi-day period may be requested for the report.  A multi-day may 
be subtotaled for each day when checked. 

Limit to store(s): For multi-store installations, the report will count create appointment statistics 
for each store selected. 

Include cancelled appointments? (checkbox)... By default cancelled appointments are not 
included in report calculations.  Enabled, this option will include those type of 
appointments. 

Appointments By Date Report 

Switchboard: Main->Appointments->Appointments By Date Report  

Menu: Appointments->Appointments By Date Report  

Action: RP_APPTDATE 

This report shows appointments, with a separate pages for each date. 

Appointments between...Only show appointments between the dates specified. 

Limit to sales associate...Only print appointments for the selected SA. 

SA Work Calendar 

Switchboard: Main->Appointments->SA Work Calendar  

Menu: Appointments->SA Work Calendar  

Action: RP_EMPCAL 

This report shows the employees work schedule. 

Schedule between...Only show work days between the dates specified. 

Limit to sales associate...Only print the schedule for the selected SA. 

Appointment Exceptions 

Switchboard: Main->Appointments->Appointment Exceptions  

Menu: Appointments->Appointment Exceptions Report 

Action: RP_APPTEX 

This report shows appointments that have problems. Appointments that are scheduled for SAs 
who are not working will be shown. If an appointment is scheduled for a SA that does not have 
the skills to perform it, it will be shown. If two appointments conflict, they will be shown. 

Appointments between...Only show appointments between the dates specified. 

Limit to sales associate...Only print appointments for the selected SA. 

Closing Ratio by SA w/ Sales 

Switchboard: Main->Appointments->Closing Ratio by SA w/ Sales  
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Menu: Appointments->Closing Ratio by SA w/ Sales Report 

Action: RP_APPTSALE 

This report computes many details concerning appointments by entered period and optionally 
selected Sales Associate. 

It includes statistics indicating sales, units and unique customers. 

Appointments must be linked to a prospect card & to a customer record for report purchase 
totals to be counted. 

This report totals for each day within the period selected.  The counts are for the specific time 
period. 

Headings 

Date:  The totals for this date within the date period entered. 

Total # Appointments: Total appointments assigned to SA during period for appointment types 
marked as SALE appointments.  Total appointments could be for the same or different 
customers.  A single customer could have multiple appointments in the requested period. 

Note:   

Total appointments is the sum of all appointments entered for the period, appointment status 
is not considered. 

 

Appointments Completed The total  appointments within the period with a status of COMPLETE 
or WALK-OUT .   

   Percentage #:  Appointments completed / total # of appointments.  This percentage should be 
as close to 100% as possible which would indicate appointments are being completed. 
 Run the Appointment Results report to see a breakdown of appointment statuses. 

Units sold from Appointments : The quantity of items sold to the customer on the day of the 
appointment.  The appointment should linked to a  prospect, then prospect to customer, 
then customer to ticket with a SALE on the SAME day of the appointment.  Quantity will 
also be counted for customers that are linked to the appointment as long the customer is 
linked to a ticket with a SALE on the same day as the appointment. 

       Percentage:  Units Sold / # completed appointments 

Total Sales for Appointments: the net retail value of the units sold from appointments.  Sales 
must have occurred on the same date as the appointment to be counted. 

Unique Appointments:  Multiple appointments linked to the same prospect would be counted as 
one unique appointment.  The appointment must be linked to a prospect with a created 
date within the report's time period. 

Customers who purchased: Of total appointments for date range how many of the customers 
were unique, i.e. had not been in on any previous appointment.  And must have 
purchased on the same date as the appointment. 

Hint: 

A customer linked to the appointment or linked to a prospect that is linked to an appointment 
are counted, i.e. appt-> customer or appt->prospect->customer. 

Unique appt. w/cust who purchased / Appt completed Percentage:  customers purchased / 
appointments completed.  This percentage illustrates how many total appointments in the 
date range did it take to sale the customers who purchased.  Example, the same 
customer has five appointments to purchase one gown.  This percentage would show 5 
customer appointments / 1 unique customer sale = 20% 
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Unique appt w/cust who purchased / unique appointments Percentage:  customers 
purchased / unique appointments completed.  This percentage is designed to remove 
duplicate appointments (multiple appointments of the same customer) and to give you the 
unique appointment to customer ratio.  Example, the same customer has five 
appointments to purchase one gown.  This percentage would show 1 unique customer 
appointment / 1 unique customer sale = 100% 

Total Unique Customers:  The total number of unique customers within the total number of 
appointments for the day.  These customers may OR may not have purchased anything 
on the same day as the appointment. 

Percentage: Unique appt w/cust who purchased / total unique customer 

 

Report Criteria 

Appointments between...Only analyze appointments between the dates specified. 

Limit to sales associate...Only analyze appointments for the selected SA. 

Appointment Result Statistics Report 

Switchboard: Main->Appointments->Appointment Result Statistics Report  

Menu: Appointments->Appointment Result Statistics Report  

Action: RP_APPTSTAT 
 

This report shows how the total appointments each sales associate has had by appointment 
status.  

It shows how many of those appointments resulted in sales.  A sales is counted when the 
appointment is linked to a prospect, then prospect to a customer and customer to a ticket with a 
sale.  The sale must be on the same day as the appointment.  A sale may also be counted 
when the appointment is linked to a customer and customer linked to a ticket with a sale taken 
on the same day as the appointment. 

Also listed is the dollar value of the appointments that resulted in sales. 

Note 

The sales are not UNIQIUE appointment sales.  Example, a customer makes three 
appointments and purchases some item from each appointment.  The report would count the 
three appointments and count three appointments resulting in sales.  The dollar value would 
be the total of the sales made on the same day as each appointment. 

Criteria 

Limit to sales associate...Only print appointments for the selected sales associate SA. 

Appointments between...Only show appointments that occurred between the dates specified. 

Department: Sales Associates may be assigned to departments.  Select a department to view all 
SA appointments assigned to the department. 

Limit to store(s): For multi-store installations, the report will count create appointment statistics 
for each store selected. 

 

Appointment Alert Report 

Switchboard: Main->Appointments->Appointment Alerts  

Menu: Appointments->Appointment Alerts 
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Action: RP_APPTALRT 

This is report will list/print all alerts that are/were active for the entered date range. 

Criteria 

Date Range...This will limit the listing to Alerts that had a date range or portion that was/is active 
during the entered the date range.  

Fittings/Alterations 

Fittings/Alterations Overview 

Switchboard: Main->Housekeeping->Fittings/Alterations 

Menu: Sales->Fittings 

Action: none 

The Fittings/Alterations System tracks all customer items being custom fitted. Whether the job is 
being conducted on or off site, it is a valuable software tool to help manage the entire process. 

Fitting tickets are associated to items sold on tickets that are owned by customers who may be 
a member of an event. It becomes an easy customer service process to see all the fittings an 
item has been thru and the charges for each, all from the customer’s sales ticket. 

The tight integration also reduces errors. Many times a busy employee may forget to add the 
custom fitting charges to a customers ticket in a manual system. However, with the BBL Custom 
Fitting module it becomes almost impossible to miss this step. The system will automatically 
insert the charge on the ticket with the item! 

Start using this optional feature by first creating task codes with prices for each type of work that 
can be done on a garment (hem, taking in, letting out, bead work, etc.) Then, you can create a 
fitting/alteration ticket that contains all the details of the alteration, and the total price. The total 
price is automatically transferred to the customers ticket. 

The system maintains a Fitting STATUS to help see the location of an item. Once created a 
fitting/alterationstatus is set to New. When the item is sent to the tailor, you click the Item Sent 
to Tailor button to change it’s status to Out. When the item is Complete, click Complete. It’s 
important that you update WinPOS® as the item moves around so that the audit reports will be 
accurate. 

Fittings batch scan out 

Switchboard: Main->Housekeeping->Fittings/Alterations->Batch Scan Out 

Menu: Sales->Fittings->Batch Scan Out 

Action: none 

A quick way to mark fittings OUT. Simply enter/scan the fitting number and this function will 
change the fitting status to OUT and enter the current date into the OUT date field automatically. 

Fittings batch scan complete 

Switchboard: Main->Housekeeping->Fittings/Alterations>Batch Scan Complete 

Menu: Sales->Fittings->Batch Scan Complete 

Action: none 

A quick way to mark fittings COMPLETED. Simply enter/scan the fitting number and this 
function will change the fitting status to IN and enter the current date into the Completed date 
field automatically. 

Fittings Form 
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Switchboard: Main->Housekeeping->Fittings/Alterations->View/Edit Fittings  

Menu: Sales->Fittings->Fittings 

Action: FITTING 

This form shows all the fittings/alterations on file. 

List Tab 

The List tab will display key information fields or each fitting in the system. Highlight the desired 
fitting and click the Details tab to see more information OR press one of the status buttons to 
change it’s status OR press ADD to create a new fitting. 

Show open fittings only…When checked, you will only see fittings that are currntly out with 
tailors. 

Show fittings for this store only…Only visible with the WinPOS® Multi-store integration. When 
checked, you will only see fittings for this store. 

 

Detail Tab 

Fitting number…This the fitting ID automatically generated by WinPOS®. The first part of the 
number is your store number (as set in Main->Housekeeping->General Setup-
>System/Store Setup->Setup Tab) followed by a sequence number. You cannot change 
this number. Find the fitting by this number. 

Created by…The SA who created the fitting, followed by the date and time it was created. 

Status…As a fitting is created, confirmed, and completed, it’s status changes automatically. You 
don’t normally need to manually change the status. You can tell at a glance what is 
happening with a a fitting by looking at its status. The status can be one of the following: 

• New: This fitting has been created. 

• Out: The garment is out with the tailor. You can press the Item Out to Tailor button 
on this form to set this status. The total charge for the fitting/alteration is transferred 
to the ticket at this point. If the customer has no ticket, one is created. If the 
customer has more than one ticket, you are prompted for the ticket to add the 
charge to. 

• Complete: The fitting/alteration is done. You can press the Item Complete button on 
this form to set this status. 

• Cancelled: The customer has cancelled this fitting/alteration. You can press the 
Cancelled button on this form to set this status.  

Tailor…The SA who is doing the tailoring. 

Customer…The customer for the fitting. 

Due…The date the item is due to be completed for a customer re-try. 

Out…The date the item was taken out by pressing the Item Out to Tailor button. 

Complete…The date the item was completed by pressing the Item Complete button. 

Cancelled…The date the item was cancelled be pressing the Cancelled button. 

Ticket number…When you click the Item Out to Tailor button, the charge is automatically added 
to the ticket. The ticket number is shown here. You can double-click to view the ticket 
itself. 

Pickup item number…If this is a fitting/alteration of a pickup inventory item, the item number 
appears here. If you select a pickup item, the style/size/color/width are filled in 
automatically. 
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Style code/size/color/width…If the item to be fitted/altered if it comes from retail inventory, enter 
the style/size/color/width here. If you enter the style/size/color/width you cannot enter a 
pickup item number. 

Description…You can manually enter an item description here. 

Style for charge on ticket…Enter the style code to use when inserting a charge on the ticket. 
This allows you to have a different style code in inventory for each tailor, so you can track 
the sales for each tailor separately via the sales reports, and inventory statistics for each 
style. 

Comment button…Enter any comments related to the fitting here. 

Task grid…This grid lists the tasks that are to be performed on garment. You can add a new task 
by pressing the Add Task button. The Task Comment button lets you enter comments for 
the selected task. Delete Task deletes the selected task. The columns in the grid are as 
follows: 

• Task Code: The task code from Task Codes 
form. You press F2 to pop up a list of task 
codes to choose from. 

• Description: The description from the Task 
Code. 

• Comment: The comment entered via the Task 
Comment button. 

• Price: The price for the task from the Task 
Codes form. You can override the price by 
typing over it. 

• Task Comment button: Enter an unlimited 
amount of information about the highlighted 
task. Each task can have different comments. 

• Add Task button: Add a new task to the fitting. 

• Delete Task button: Delete the highlighted task 
from the task grid. 

Item Out to Tailor button…Sets the status to Out, inserts the current date into the Out field, and 
transfers the total charge for the fitting/alteration to the ticket. If the customer has no 
ticket, one is created. If the customer has more than one ticket, you are prompted for the 
ticket to add the charge to. 

Item Complete button…Sets the status to Complete and inserts the current date into the 
Complete field. 

Cancelled button…Sets the status to Cancelled and inserts the current date into the Cancelled 
field. 

Create Appointment button…Creates an appointment for this customer. You could schedule 
fittings via the Appointment system. 

Add Same Fitting button…Creates a new fitting for the same customer, for the same item. Used 
for re-fits. 

Add button… 

Print button… 

Task Codes 

Switchboard: Main->Housekeeping->Fittings/Alterations->Task Codes  
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Menu: Sales->Fittings->Task Codes 

Action: TASKCODE 

Task codes are used on fittings to indicate the type of work performed and to provide a basis for 
pricing. 

Task code…A unique code to represent the work to be done. 

Description…A description of the work. 

Price…The price to be charged on the ticket. 

Fittings by Tailor Report 

Switchboard: Main->Housekeeping->Fittings/Alterations->Fittings by Tailor  

Menu: Sales->Fittings->Fittings by Tailor Report 

Action: RP_FITTAIL 

This report shows the fittings/alterations, sorted by tailor. You can enter selection criteria to filter 
the report. 

Status…You can select all if you want to see all statuses. 

Limit to tailor…If you enter a tailor, only fittings for that tailor will be shown. 

Select fittings selection – between…You can select one of the available date ranges and 
enter a date range. Only fittings within that date range will be shown. 

Print line items? (checkbox)... When checked fitting tasks and their details are included. 

Limit to stores… In muti-store installations the store numbers where the custom fittings were 
created may be entered. 

Fittings By Status Report 

Switchboard: Main->Housekeeping->Fittings/Alterations->Fittings by Status  

Menu: Sales->Fittings->Fittings by Status Report 

Action: RP_FITSTAT 

This report shows the fittings/alterations, sorted by status. You can enter selection criteria to 
filter the report. 

Status…Select all to see all statuses. 

Limit to tailor…If you enter a tailor, only fittings for that tailor will be shown. 

Select fittings – between…You can select one of the date ranges and enter a date range and 
only fittings within that date range will be shown. 

Print line items? (checkbox)... When checked fitting tasks and their details are included. 

Limit to stores… In muti-store installations the store numbers where the custom fittings were 
created may be entered. 

Electronic Payment Integration 

Electronic Payment Integration 

WinPOS® offers the ability to directly integrate to your bank’s credit card processor which saves 
time, reduces employee training and improves customer service. It eliminates the need for stand 
alone credit card terminal. 

WinPOS® credit card integration works with your existing bank (however, BBL can help improve 
your credit card processor rate. Contact BBL for more information).  
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The integration will allow a operator to swipe or manually enter a credit card's information, i.e. 
account number, expiration, name ..etc. Then using processing software from ICVerify (older 
versions), Verifone's PCCharge or IPCharge/Payware Connect, WinPOS® will automatically 
acquire an approval code via a modem or the internet. Finally, it will automatically print a 
detailed receipt including a signature block for the user to sign authorizing the credit card 
charge.  

In multi-user environments credit card integration can be utilized to allow each station to 
concurrently process credit cards. 

Security concerns exists when credit card numbers are stored electronically.  Recently Visa and 
Mastercard have implemented stringent security rules that EACH merchant must abide by or 
risk large expensive fines!  Visit Visa and Mastercard websites to see details of these 
regulations.   

WinPOS version 9 & later does NOT store customer credit card info thus making it compatible 
with these regulations.  However, thru the use of Verifone's IPCharge/Payware Connect, 
WinPOS can store customer credit card info for later use.  The credit card information is actually 
stored in Payware Connect/IPCharge which is a Visa/Mastercard CISP, PABP and PCI DSS 
compliant software/network environment. 

 

Electronic Payment Integration Options 

Which Card Swipes should be used 

WinPOS supports any keyboard wedge credit card swipe that can read track 1 and track 2.  

The swipe should be set to read track 1 & track 2 OR track 2 only.  Track 1 will auto insert the 
card holder's name.  Track 2 contains the card number and expiration.  Keyboard wedge and 
USB (that acts as keyboard input)  swipes will function properly. 

Debit Card Payment Integration 

 

The acceptance of Debit cards requires the utilization of PIN PADS.  Pin pads provide the 
customer a device for them to securely enter their personal pin as authorization for the funds to 
be deducted from their bank account. 

Pin Pads must be programmed by the electronic payment processor, i.e. Paymentech or First 
Data ..etc  with a SECURITY KEY that encrypts the customer pin data on it's transmission to the 
processor for approval. 

WinPOS supports the Verifone 1000SE pin pads in either  COM PORT or USB versions.  With 
either version the Pin Pad communicates to WinPOS via a com port address, i.e. com3 or com4 
...etc.  The Pin Pad com port address is assigned to each WinPOS workstation/terminal via the 
WinPOS Housekeeping-> General set-up-> Register Setup-> Pin Pad com port field. 

Debit payment tender type must be activated within the Housekeeping-> Accounting Setup-> 
Accounting Setup form so the Debit payment tender method will be available from the WinPOS 
payment form. 

 

Com Port or USB Pin Pad Interface 

The Pin Pad USB or Com port versions can be installed when WinPOS is installed and running 
on each PC like in a typical Windows Peer to Peer network installation.  The interface chosen 
depends on the availability of USB or Com ports on the PC.  Most modern PCs have USB ports, 
but no com (communication) ports so USB will be the most popular choice for this 
implementation. 
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The COM PORT version of the 1000SE with com port servers should ALWAYS be used when 
WinPOS is running in a Windows terminal server implementation.  This is because the WinPOS 
application is installed and executing on a single centralized application server.  WinPOS 
controls the interface to the Pin Pad and thus must have direct access to the Pin Pad via a com 
port.  Terminal Services does not currently offer access to a terminal/workstation's com or usb 
ports and for this reason Com Port servers must be utilized.   Com port servers allow the 
application server to have direct access to the pin pad.  BBL has tested and worked with com 
servers from EasySynch LTD, model ES-E-1001-M. 

 

Special USB Verifone Debit Pinpad Instructions 

Download the driver: 

1. Click the following link or navigate with your browser to the VeriFone Support Site to 
download the correct driver. 

 

For a 32-bit computer, click the following link or navigate with your browser to the VeriFone 
Support Site at: 

http://www.verifonedevnet.com/VeriFone/Attachment/20080116/PP1000se_PCI_USB_Driver.zi
p. 

 

For a 64-bit computer, click the following link or navigate with your browser to the VeriFone 
Support Site at: 

http://bblsystems.com/downloads/verifonex64_PP1000SE_USB-UART.zip 

 

2. Click Save in the resulting pop-up window(s) until receipt is verified. Be careful to note where 
the file is being saved on your local PC. 

3. Double-click the file you just downloaded and extract the enclosed .INF file. 

 

Driver installation: 

1. Connect the 4 pin "phone handset" end of your USB cable into the corresponding connector 
on the VeriFone device. This port is marked with the universal USB symbol. 

2. Plug the USB end of the cable into an available USB port on the computer. 

3. In a few moments, the PINpad should be detected. Windows will then present you with the 
"Found New Hardware Wizard". (If, for some reason, the device is not recognized and the 
Wizard does not start check the section below on "Debugging the driver installation". 

4. Check the radio button indicating that you want to "Install from a list or specific location" and 
click NEXT. 

5. Check the radio button indicating "Don't search. I will choose the driver…" and click NEXT. 

6. Click the "Have Disk" button and "Browse" to the location where you placed the .INF file 
extracted from the .ZIP in the section above. 

7. Select the INF file to OPEN then click OK. 

8. At this point you may get warnings that "This driver is not digitally signed" and/or "has not 
passed Windows Logo testing". Just ignore it and click NEXT and "Continue Anyway". 

9. Finally, click "Finish" and your driver should now be installed and functional. 
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Check the COM port for XP 

1. Right click on My Computer and choose Properties. 

2. Click on the Hardware tab, then click the Device Manager button. 

3. Click on Ports (COM & LPT) to expand it. 

4. Look for PP1000SE under Ports, it will show the COM port number. 

 

Check the COM port for Vista 

1. Right click on Computer and choose Properties. 

2. Click the Device Manager link 

3. Click on Ports (COM & LPT) to expand it. 

4. Look for PP1000SE under Ports, it will show the COM port number. 

 

Changing the serial port used by the pin pad: 

1. Once you've installed the driver, you may set the assigned Serial Port (COMx) number and 
operating parameters by using the Windows Device Manager (usually accessed via the System 
Icon in Control Panel). 

2. Click on the "Ports (COM & LPT)" entry and expand the list of ports by clicking on the "+" 
symbol. 

3. Right-Click on the COMx entry (newly added since installing your driver), then click 
"Properties" in the drop-down menu. 

4. Click on the "Port Settings" tab. The default Baud Rate and Protocol settings can be changed 
here. 

5. Click on the "Advanced" button. The COM Port number can be set to something that may be 
more to your liking. (Make sure it is not a COM port that is already in use on the PC/ECR). 
 VeriFone recommends leaving the FIFO settings at their installed default values. 

 

Debugging the driver installation: 

1. In the event the PINpad is unrecognized and the New Hardware wizard does not start, you 
may correct this by selecting "Add Hardware" from the Windows Control Panel. Once the Add 
Hardware Wizard starts, select NEXT. 

2. Click the radio button indicating that "Yes, I have already connected the hardware". 

3. Select "Add a new hardware device" from the bottom of the list of available devices and click 
NEXT. 

4. Click the radio button to indicate "Install the hardware that I manually select from a list" and 
click NEXT. 

5. Select "Show all devices" and click NEXT. 

6. Click on "Have Disk" and "Browse" to the file INF file  that was extracted from the .ZIP above. 

7. Select "Communications Port" and click NEXT twice. 

8. You may get warnings that "This driver is not digitally signed" and/or "has not passed 
Windows Logo testing" at this point. Just ignore it and click NEXT and "Continue Anyway". 
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9. Finally, click "Finish" and your driver will now be installed and functional. 

 

Enable debit cards in the ProfitSystem: 

1. Go to Main->Housekeeping->General Setup->Stores->Options tab 

2. Make sure the electronic payment integration is set up and working (IPCharge or 
Go/PCCharge.) Save and close. 

3. Go to Main->Housekeeping->Accounting Setup->Accounting Setup->Setup tab 

4. Check the Debit checkbox.  Save and close. 

5. Go to Main->Housekeeping->General Setup->Register Setup, locate the register with the pin 
pad.  On the Details tab, select the correct pin pad port. Save and close. 

6. Restart the ProfitSystem and test the pin pad by taking a small debit payment on a register 
set with a PinPad com interface.  You must swipe the debit/check card to use debit.   

The ProfitSystem is now configured to accept debit cards. 

 

How to Integrate with ICVerify  

Configuring IC-Verify with WinPOS 

 

IC-Verify has two separate programs that are used with WinPOS. 

• IC-Verify: This is the main IC-Verify program that you can use to process credit-cards, 
close the daily batch, run reports, etc. 

• IC-Verify Multi-User: This program allows WinPOS to communicate with IC-Verify so 
WinPOS can process credit cards.  This program must be running all the time on only 
one computer within the network.  DO NOT run this program on more than one 
computer.  The computer used with the program should internet access or a modem 
with phone line for communications to the credit card processing company. 

Steps to install IC-Verify and configure WinPOS to use it (assumes VIsta operating system): 

1. Install the IC-Verify master station on your server computer and configure IC-Verify for your 
processor, merchant ID, modem or internet, etc.  Refer the manual that came with IC-Verify or 
call Ic Verify tech support for help.  BBL support cannot help you with installing IC Verify. 

Multi-Store Note:  A new IC Verify setup file must be created for multistore installations 
where each store will have a different merchant number.  Each setup file name will should 
start with ICVE, so examples would be, store 1- ICVERIFY, store 2- ICVER02, store 3- 
ICVER03 ..etc 

2. Confirm that credit cards can successfully be processed directly from within IC-Verify. 

3. Create a sub-directory in the \ProgramData\ProfitSystem folder on your server called 
REQDIR.  This directory, \ProgramData\ProfitSystem, is where WinPOS will create its “request” 
files for IC-Verify. 

4. Run the IC-Verify Multi-User program and configure as follows: 

a. In the Request Directory field, type the full path to the REQDIR directory on your server. 
 For example, if the \ProgramData\ProfitSystem folder is on your C: drive on your server, the 
full path would be C:\ProgramData\ProfitSystem\REQDIR 

b. In the Process Files field, type 3 

5. Exit from IC-Verify Multi-User by clicking the Cancel button. 
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6. Create a shortcut to the IC-Verify Multi-User program and place it in the Startup program 
group on the computer that will run it.  Modify the shortcut and add the following command line 
parameter /A.  For example: {install directory}\icvmlt32.exe /A. Refer to the IC-Verify 
documentation for more information. 

7. Run WinPOS and go to Main->Housekeeping->General Setup->Stores-> Options Tab. 
 Configure as follows: 

a. In the Credit-card Integration field, select IC-Verify 

b. In the Merchant ID field, type RIFY for store 1.  For multi-store setup each Store's option 
tab must contain the matching name of the IC Verify setup file (mentioned in multi-store note 
above), i.e. ICVERIFY, ICVER01 ..etc. 

c. In the Credit-card processing path, type the full UNC path to the REQDIR directory 
created in step 3.  The UNC path should of the form \\{SERVER NAME}\{SHARE 
NAME}\ProgramData\ProfitSystem\REQDIR\.   

Substitute the name of your server computer for {SERVER NAME}, and the share name for the 
C drive for {SHARE NAME}.  For example, if your server name is MAIN, and the C: drive is 
shared as C, then the full UNC path to REQDIR is 
\\MAIN\C\ProgramData\ProfitSystem\REQDIR\ 

Use a UNC path because this path is used by both the server and workstations, and a path of 
C:\ProgramData\ProfitSystem\REQDIR would not be correct for a workstation. 

8. Go to Main->Housekeeping->General Setup->Register Setup.  Make sure each register has a 
unique IC Verify ID (starting at 1) and that the highest IC Verify ID is less than or equal to the 
total number of IC Verify station licenses.   

The Register may have credit card settings that over ride those set in the System/Store setup 
file.  These optional settings are Merchant Number and Credit Card Processing path.  These 
setting provide the option to allow the Register to have a different merchant number than the 
rest of the store.   The merchant field must contain the matching name of the IC Verify setup file 
(mentioned in multi-store note above), i.e. ICVERIFY, ICVER01 ..etc.  When these credit card 
fields are blank the data in the System/Store setup file will be used. 

9. Exit from WinPOS and restart it. 

10. Ring up a test sale for 1 cent and take a credit card payment for it.  When you click the Save 
Payment button, WinPOS will prompt you to swipe the credit card.  If you don’t have a card 
swipe, click Enter Acct # and Date and manually type the account number and expiration date. 
 Click the Process button. 

11. WinPOS will begin a countdown as it waits for IC-Verify to process the credit card.  The 
system running ICMulti will communicate with the processor and you will see an Approval or Not 
Approved message from WinPOS. 

 

Troubleshooting 

Make sure IC-Verify standalone works: Manually process a credit card using the IC-Verify 
standalone program.  It should dial the modem and get a decline or approve response back.  If 
the IC-Verify standalone program can't process a card WinPOS won't be able to. 

Make sure WinPOS is creating the request file:  Put WinPOS in development mode (create 
CONFIG.CPV in the TPSWINW directory, start WinPOS, make sure it says Development in the 
main window title bar)  Stop the IC-Verify multi-user requestor.  Run WinPOS and ring up a sale 
for .01.  Take a credit card .01 payment.  Swipe or manually enter the credit card info and press 
Process.  WinPOS should display the path and filename of the request file to be created.  Click 
the mouse and WinPOS should start the timer waiting for the response file.  Look in the 
REQDIR and see if the file was created (ICVER{ID number}.REQ.  If it is not created, check the 
Credit card processing path in WinPOS. 
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Make sure IC Verify multi-user requester is finding and can read the file:  Make sure there are 
no REQ files in the REQDIR directory.  Start the IC-Verify multi-user requester and make sure 
it's initialized.  Process a test credit card in WinPOS.  Watch the IC-Verify multi-user requester 
and make sure it finds the file, dials the phone, etc.  If not, check the path where it is looking for 
files. 

If cards are always declined, capture the request and response files and check them:  Create a 
batch file called CAPTURE.BAT in the REQDIR folder, containing the following lines: 

COPY ICVER*.* \ 

CAPTURE.BAT 

At the command prompt, type CAPTURE.  The batch file should start looping with a file not 
found message.  Make sure the Multi-user requester is running and process a credit card in 
WinPOS.  Once you get the decline message from WinPOS, look in the root directory of the 
drive.  There should be at least two files ICVER{ID number}.REQ, ICVER{ID number}.RES. 
 Examine the contents of the files to make sure they appear valid. 

How to Integrate with PC Charge 

 

Configuring Go Software PC-Charge Pro with WinPOS 

 

NOTE:  Before attempting to set up WinPOS for use with PC-Charge, make sure that the 
PC-Charge software is installed and configured first.  You must be able to successfully 
process a credit card directly through the PC-Charge application.  If you cannot successfully 
process a credit card directly through the PC-Charge application,you will not be able to 
process a credit card charge through WinPOS.   

The PC Charge setup includes the creation of users & cashiers.   The number of user 
accounts setup in PCCharge should match the user level purchased.  For example if a 10 
user license of PCCharge was purchased, then you should add ten user accounts.  Users 
should be given names within PCCharge like, USER01, USER02, USER03 ..etc.  Use this 
naming convention tor successful  WinPOS integration. 

PCCharge version 5.8 and newer requires another user type created called Cashiers. 
 Cashiers are given permissions to perform tasks in PCCharge, like to process card credit 
cards.  Cashiers must be given secure passwords that are PCI compliant and changed every 
90 days (automatically enforced by PCCharge software).  PCCharge requires a Cashier to 
be created called SYSTEM.  This cashier cannot charge credit cards.  They also suggest 
optionally a cashier called MANAGER which has all security turned off so that the SYSTEM 
Cashier can perform any task.  For WinBPS integration we recommend a Cashier be created 
called APICASHIER &  given permissions to perform any electronic payment function. 
 WinBPS only requires one Cashier for all registers and this APICASHIER username and 
password will be entered into WinPOS in a single location - see below the instructions. 

To configure WinPOS to process credit card Sale and Credit transactions with Go Software’s 
PC-Charge Pro, follow these steps: 

Step 1  

From the WinPOS Main Menu, choose Main->Housekeeping->General Setup->Stores-> 
Options Tab.(for multistore implementations this must be completed for each store)  On the 
Options  tab" 

Locate Credit Card Processing from list – Choose GO (Go Software, makers of PCCharge 
was acquired by Verifone) 

Locate Bank Processor – Choose from processors in the list 

Locate Merchant ID – Enter the same merchant ID that was put into PC-Charge 
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Locate Credit Card Processing Path – Enter the folder path location where PC-Charge will 
look for the *.INX file that WinPOS will create whenever a credit card payment is taken.  This 
is usually the same folder that PC Charge was installed to. 

• For multi-users, we recommend using a UNC-type path to the PC-Charge program 
(example: \\PROGRAM FILES\PCCW\).  Note: This assumes your PC-Charge folder 
has been shared on your computer and has been configured with full read-write 
accessibility. 

• For single-users, the direct path may be used (example: C:\PROGRAM FILES\PCCW\) 

Cashier: Cashier name, sent in request file if it's non-empty. Required for  PC Charge 5.8 or 
newer.  For older versions leave blank 

Password: Cashier password, sent in request file if it's non-empty.   Required for  PC Charge 
5.10. For older versions leave blank 

Req file prefix: If this field is left blank, request file will be named STA[credit card ID].INX. 
 This is compatible with older versions of WinBPS and PC Charge.  For new installations, it 
should be set to USER This will cause the request file to be called User[Credit card ID] 
which will match the users created within PC Charge. 

 

Note 

The Credit Card ID mentioned above is set for each register in the Register setup form 
described below.  Credit Card IDs must be unique for each WinPOS register and cannot 
exceed the total user license purchased for PCCharge, i.e. you purchased a 10 user license 
of PCCharge you cannot enter or provide a Register credit card ID of 11, 12,13 etc. 

. 

Step 2 

Before exiting and restarting WinPOS, click on the Register Setup button.  Housekeeping-
>General Setup->Register. 

Here, a Credit Card ID must be entered for each register within WinPOS.  Chances are Credit 
Card IDs will appear but all should be reviewed to determine if correct.   To do this: 

Click on a register name to highlight it on the list tab.  Next click the Details tab at the top. 
 Locate the field labeled Credit Card ID found in the upper-right corner of the form and enter a 
 number you wish to use for the register’s ID.  For example 1, 2, 3 ..etc.  This number should 
equal or be less than the number of users you have licensed/purchased for PC Charge. 

Each station number must be unique for each register.  Click the Save button.  Click on the List 
tab at the top, select the next register name and set the Credit Card ID number for that register. 
 Continue until all WinPOS registers have unique IDs set.  When complete, exit out of the 
WinPOS program, then re-start. 

When a credit card is processed in WinPOS, a request file will be created in the directory path 
that was specified in Step 1 above.  WinPOS will prepend the letters set within the Req. file 
prefix field in step 1 above.  If blank WinPOS will prepend STA for backward compatibility with 
older WinPOS/PCCharge installations.  In addition, if the Credit card ID from the register file 
setup is a single-digit number, a “0” will be prepended to the number when the request file is 
created.  Below are two examples: 

1. A credit card is processed on a register configured as Credit Card ID 1, WinPOS will create a 
request file named STA01.INX. 

2. When a credit card is processed on a register configured as Credit Card ID 10, WinPOS will 
create a request file named STA10.INX. 
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PCCharge is set to look for requests files that instructs the software to perform specific payment 
tasks.  When completed PCCharge will give WinPOS back a response file with the payment 
results. 

 

Note 

The Test Credit Card integration button tests the specified integration PATH.  Two tests are 
performed.  1)  To insure the path is valid, ie it exits, 2) That the user currently logged into 
WinPOS can write to the path.  Wether or not a user can write to a folder in the entered path 
is a operating system permissions setting.  If the tests fail then you may need the help of a 
network IT person to help increase the permissions of all users / registers that will be 
performing electronic payments. 

 

How to Integrate with IPCharge 

 

Configuring IPCharge 

IPCharge is a electronic payment service offered via the internet.  It is a secure site and 
application that is certified by Visa & Mastercard to meet stringent security standards.  IPCharge 
may be manually accessed via a web address (URL) that may be typed into a compatible 
browser.  The web address is: 

https://ipcharge.com/nma/MC 

Accessing IPCharge directly via a web browser will display a log-in form.  Once logged in, the 
IPCharge starts and presents a payment form where an electronic payment may be accepted. 
 In addition, a menu of it's other maintenance and reporting functions is available as well.. 

WinPOS, when properly configured, will automatically process electronic payments via 
IPCharge. 

Sign up with  BBL for a IPCharge account.  Once accepted a IPCharge Merchant Number, 
Merchant Code, User ID & Password will be provided with a detailed welcome kit.  A new 
WinPOS user should be created  following the steps within this topic. 

Log into IPCharge via the web address above once this information is received and follow the 
steps listed here  

Step 1 

From the top menu, select Account Admin-> User Manager  

Click New to create a new user with the following details: 

User ID: APIUSER 

Full Name: API user 

Password:    (a password must be created following IPCharge's rules (rules of Visa & 
Mastercard) 

Note 

To help you remember the password we recommend a pass phrase which is two related 
words separated by numbers.  The  password must contain uppercase and lowercase 
letters, and numbers, example BLUE4sky2 

Visa & Mastercard REQUIRE for passwords to be change every 90 days and IPCharge 
enforces this rule.  Log-in to IPCharge to modify the password.  In addition, the six previous 
passwords may not be reused. 



Optional  Modules 

661 

Enable debit: checked 

Role: select Administrator 

Scroll  down to Select Transaction types and click Check All. 

Click Save 

Step 2  

Go to Account Admin->API Key Management. 

Click Select Key to Copy button and type Ctrl-C to copy the key to your computer's Windows 
clipboard.   Key field. 

Also, write the key down on a piece of paper.  This key will be used in WinPOS and uniquely 
identifies this shop to IPCharge when processing electronic payments thru WinPOS.  This may 
be immediately pasted into the WinPOS Merchant Key field, described in WinPOS setup below. 

NOTE:   

Before attempting to set up WinPOS for use with IPCharge, make sure that the IPCharge 
software is properly configured by processing a credit card for $1 via it's web terminal. 
 Choose Transaction Processing-> Web Terminal and process a charge. Contact the 
merchant vendor for technical support if IPCharge cannot process the charge. 

click Log Out to close IPCharge 

 

Configuring Go Software IPCharge with WinPOS 

Configure WinPOS to process credit card Sale/Credit & debit card  transactions with Verifone’s 
IPCharge.  

From the WinPOS Main Menu, choose Main->Housekeeping->General Setup->Stores-> 
Options Tab.(for optional multi-store implementations this must be completed for each store) 
 On the Options  tab" 

Credit Card Processing – Choose IPCharge 

Merchant ID (code) – Enter the store's merchant ID/code 

Login Information - Complete the following log-in fields with the information provided by 
IPCharge 

User Name... 

Password... 

Merchant ID (code)... 

Merchant Key... This is the key that was written down and copied to your Windows clipboard. 
 Perform a Ctrl P to paste it in this field. 

That is it. Test by creating a WinPOS ticket and running a small charge through.  

The IPCharge integration provides an additional feature over PCCharge/ICVerify integration.  It 
allows credit card information to be saved for customers. 

The option to save Credit Card may be disabled.  This is accomplished in: Housekeeping-> 
General Setup-> System Setup-> Options Tab-> "Don't allow credit card to be saved?". Check 
this setting to turn off the ability to save credit card info. 

Credit card information may be saved from the customer form, event form, or during a credit 
card payment.  Saving a credit card from the customer form or during a Credit Card payment 
will instruct WinPOS to store the details for the customer (it will save the credit card information 
during a payment to the customer who owns the ticket the payment is being applied to), and can 
be used again by that customer.  Any member of an event can use the event's credit card 
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information to make a payment if credit card information is saved with an Event via the Event-> 
Event tab.  Of course this is controlled by the WinPOS clerk and should be utilized after 
authorization of the credit card's owner. 

To save credit card information directly to a customer the user visits the Customer card, Main-> 
Customer-> Details tab-> Add Credit Card.   To save credit card information directly to a 
customer the user visits the Customer card, Main-> View/Change Event-> Event tab-> Add 
Credit Card.  After choosing "Add a Credit Card" The user may swipe a credit card or manually 
enter the acct #, exp date, address and zip,  The credit card information is actually stored with 
the IPCharge computers. 

Accepting a credit card payment for a customer or event with saved credit card info will cause 
WinPOS to present an option to use the saved credit card.  This may be accepted.  If not 
accepted the user may choose to use a different credit card by swiping or entering the credit 
card info. 

 

Upgrading 

WinPOS version 8 and earlier would save a customer's credit card information in it's own 
database.  This is not allowed by new Visa/Mastercard regulations. 

When WinPOS version 9 or a newer software version is first started it will check to see if there's 
any saved credit cards in event, customer, or the ticket file.  If there are, it saves the current 
system date and provides 60 days for the store to perform any store tasks concerning the credit 
cards (like writing them down or processing any charges .etc) . WinPOS will ask at each startup, 
as a reminder, for permission to allow it process the card information.  At the end of 60 days it 
will automatically process the saved card information. 

Note 

IMPORTANT, when IPCharge is/will be utilized by the store, insure it is setup and 
functioning prior to allowing WinPOS to process the stored card information. 

WinPOS will process the saved card information in this manner. 

As each customer/event's and ticket saved card information is cleared the information is 
archived into a text/csv file called CARDS.TXT and placed in the 
\ProgramData\ProfitSystem\User folder.  The format of this file is Name, Card #, Expiration date, 
Address, Zip.   

Credit Card information stored on tickets is converted to *****[last 4 digits] and the expiration 
date becomes **/**.. 

With IPCharge integration, customer/event credit card information will be exported to IPCharge 
as a Contract when each is cleared in WinPOS.  Customer credit card information will be 
created under a Contract ID of "CU" + customer number.  Event credit card information will be 
exported using a contract ID of "EV" + event number.  Future credit cards for customers and 
events will follow this same convention. 

To see customers & events with saved credit cards log-in to the IPCharge account via the web 
address.  From the menu choose, Recurring Billing-> Dashboard-> Add-On contracts. 
 Double click a customer name to review/edit additional details. This information cannot 
currently be deleted.  Review the IPCharge manual to see how add-on contracts may be further 
utilized. 

 

Add IPCharge to Quick launch 

Set up a WinPOS Quick Launch selection to the on-line IPCharge console when your WinPOS 
version does not have  the selection.  Housekeeping-> General Setup-> Actions/Transfer table. 
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Technical Details 

Verifone maintains two separate credit card processing servers, a primary and backup.  The 
Profit System first tries to connect to  

https://IPCharge.net/IPCHAPI/rh.aspx  

to process the credit card.  If that connection fails, it tries  

https://ipcharge2.net/ipchAPI/RH.aspx instead 

 

 

Credit Card form / Electronic Payment form 
 

The Electronic Payment form becomes available with the installation of  the optional BBL credit 
card/ integration.  From the WinPOS Enter Payments form, once a operator, selects a Credit 
Card or Debit tender type, enters the amount of payment and clicks SAVE, WinPOS displays a 
Electronic Payments form  prompting for the required information to process the electronic 
payment.   For credit cards the form needs the number and expiration date as a minimum, 
where a debit card needs only for the PIN number entry. 

Once the form is complete, the system will communicate with the credit card processor and 
display the results to the operator. If approved, the sales receipt will include a credit card section 
or Debit tender payment that has the payment amount, approval code, credit card terms ( 
entered in the Document Terms form) and signature block for the charge. 

The Acct#, expiration and amount data fields are completed automatically when a card is 
swiped via a card swipe attached to the station. 

Note 

A store receives the lowest cost processing fee when a credit card is swiped thru a hardware 
credit card swipe. The is considered a qualified credit card. Cards that are manually keyed in 
will result in the business being charged the most expensive credit card processing fee. 



WinPOS Version 11 

664 

When businesses receive alot of call in credit card payments the credit card bank processor 
may required the business to enter the customer’s billing information, i.e. street address & 
zip  and card’s CVV/CWV code as a security measure. When this is done the processor fee 
will improve, but still not be as good as a qualified card. 

Some situations may arise where the communications to the credit card company is 
unavailable, but yet the shop still must take credit card payments.  This is handled via a 
phone call and the receipt of a verbal approval from the card processing company.  The 
agent will provide the user with an 'Approval Code'  and this code must be typed into this 
form.   Enter the card information as normal in WinPOS©, except on the Credit Card form 
manually type in the 'Approval Code' received in the Approval field.  Once the approval code 
is in, click the Process/Force button.  This is called a FORCED transaction and WinPOS© 
records that fact on the ticket transaction. 

Data Fields 

Required Data to Process 

Acct#, Exp Date...The credit card account number and expiration date. If you are swiping the 
card, this is filled in automatically. The expiration date in 4 digits. Two for month and two 
for year, i.e. May 2010 would be entered 05/10. The operator may manually enter the 
number and expiration as well. 

Amount...The amount to charge. This is filled in automatically from the payments form. 

Approval...The approval code from the processor will automatically be completed. The operator 
will have to manually enter an approval code when the computer cannot process a credit 
card request.  

The operator having to manually enter an approval code is usually due to a communications 
failure to the bank processor. In this circumstance the operator would call the processor to 
receive a voice approval and code. The operator would then manually enter the approval 
code here. The Process button would change to a Force button, indicating the approval was 
manually entered and the payment will be forced in. This is automatically handled by the 
bank processor when the credit card payments are settled. 

 WinPOS® will NOT attempt to process a credit card request when there exists an 
approval code within this field. 

Last 4 digits…The system will request the operator to enter the last 4 digits of the credit 
card only when the card is swiped. This insures the credit card was read properly by the 
swipe reader. The system will require the card to be swiped again if the manually entered 4 
digits do not match. 

 

Optional Data 

Save Credit Card Info checkbox…Only visible with the IPCharge integration. WinPOS® 
provides this feature as a customer service enhancement. With it, customer’s credit card 
information can be saved to IPCharge, a Visa/MasterCard security compliant environment. 
 So, the next time a credit card payment is made by this customer, the charge can be 
completed via their saved details, thus saving time and providing a improved customer 
service experience.. 

This feature is helpful when the customer authorizes a credit card payment without being in 
the store. When the customer and their card are present for the payment, the operator 
should re-swipe the card. This insures the shop is receiving the lowest available processing 
fee from the bank. 

The ability to SAVE credit card information  may be disabled from the System/Set-up - 
Options tab-> "Don't allow credit card to be saved" option. 

Saving Credit Card Information 
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Credit Card information may be SAVED in three ways.  1) On the Customer form-> Detail 
Tab-> Add Credit Card  2) Event Form-> Event tab-> Add Credit Card  3) Via this Credit 
Card form, when prompted for credit card information, check this Save Credit Card Info 
checkbox. 

Using Saved Credit Card Information 

Saved credit card information may be utilized in these two situations,  

 1) A member of an event is making a Credit Card Payment and the event has a SAVED 
credit card assigned or 2) when the member/customer has a credit card SAVED on their own 
customer file.  When either of these two scenarios exists the Saved Credit Card Message 
Selection Box will be displayed and request the user to choose an option. 

Options 

A message displays: "Customer Name" has a credit card ending with XXXX saved with 
IPCharge 

Customer Card button... click this button to use the Customer card info for the charge. 

"Eventr Name" has a credit card ending with XXXX saved with IPCharge 

Event Card button... click this button to use the Event's card info for the charge 

Use Different Card button... click this button to use an another card.  Once clicked the 
(this) Credit Card payment form will appear allowing a new card to be entered.  

Cancel... returns to tender form 

Note 

Checking the Save Credit Card Info checkbox within this form will cause the Customer's 
credit card information to be over written or new card info saved with this current card's 
information. 

Logging for debugging charge errors may be turned on by depressing the Shift F10 keys 
while on this form  

 

Name on Card…The name on the card. 

Address…The card’s billing address. The street number is all that is needed. 

Zipcode…The card’s billing address zipcode. 

CVV/CW2…These are three digits on the back of the credit card. Ask your bank processor for 
more information on the location of these numbers. 

Process/Force button...This button will save and process the card information entered. If 
approved, the payment will be applied to the ticket. 

Cancel button...Cancel this credit card entry and return to the payments form. 

 

Note on Logging 

Situations may arise where the payment processing transaction should be logged for later 
analysis.  This can be enabled or disabled from the payment form by pressing a key 
sequence of Shift-F10. 

Shipping Integration 

Shipping Integration to UPS & Fedx 
 

BBL provides a optional Shipping integration feature that will interface directly with the carrier’s 
computer systems via a third party product named ShipRush. 
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The feature saves time and improves efficiency. Three benefits are obtained by using the 
integration. 

Integration Benefits  

1. The shipment address, phone number, reference, weight, and email are 
automatically transferred to the carrier without the need to retype any of the 
information. 
 
Hint Declared value should be entered directly with the Shipping Integration module 
when the shipper’s insurance is utilized. Third party insurer’s requires that the 
declared value is $0 with the shipper and the true value is entered within Winos®. 
This feature is controlled in the System Setup - Integration tab. See Shipping 
Insurance for more information about third party insurance.  

2. The carrier’s tracking number, service used, weight, shipping cost, value, reference 
and ship date will automatically be inserted into the WinPOS® shipment record. The 
tracking number in WinPOS® allows for WinPOS® users whom have internet 
access to quickly obtain shipment status/details directly from the carrier. 
 
The tracking number is checked as it is inserted into WinPOS®. If the tracking 
number has already been used in the last 90 days a warning message is displayed 
to the user. In this case, the shipment should be cancelled via UPS/FedEx and the 
cause of the duplicate tracking number should be investigated.  

3. The city and zip code of the shipment receipent is automatically validated via the 
internet thru UPS. This capability will reduce the possibility of incorrect address 
information being entered and thus shipments being returned. This feature is 
activated via the Register set-up for each Terminal/PC and is automatically when 
shipment detail is Saved  

ShipRush is acquired via BBL and  should be installed on the workstation that will perform the 
shipping.  Shiprush will provide license codes and these codes should be inserted in the 
WinPOS Housekeeping-> Housekeeping-> General Setup-> Stores-> Option Tab-> ShipRush 
Section  

Maintenance Hints 

Common integration issues may be identified by activating integration logging.  Turn on 
logging by creating a TXT file in the WinPOS program folder with the name of 
SHIPRUSHDEBUG.TXT.   Messages will be written to this file.  Delete the file to turn off 
logging. 

ShipRush is updated frequently and will issue a new version number, i.e. version 3 or 4 or 6 
..etc.  WinPOS should be set to use any new ShipRush version which is accomplished via a 
TPSWIN.INI setting, example:  ShipRushVersion=SR6 

Shipping Insurance 
 

BBL provides a optional shipping insurance service that may used instead of the carrier’s 
insurance. This policy can be up to a 60% savings of the carrier’s rates which result in a 
significant amount of money for most companies. 

Contact BBL for policy and rate information. The declared value reported to the carrier is zero 
($0.00). The declared value of the shipment will be entered within the WinPOS®’s shipment 
record. Monthly, a WinPOS® shipment report will be ran and submitted with the premium 
payment to the insurance company. The report will provide a declared value total for the 
shipments within the date range specified. See the Shipping topic for more information on how 
to print the report. 
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